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Préface





À qui s’adresse ce livre ?

LibreOffice est une suite bureautique riche en fonctionnalités, libre et open source. Elle comporte 
plusieurs applications puissantes dédiées au traitement de texte, aux classeurs, présentations, 
dessins, bases de données et à l’édition de formules. Writer est l’application dédiée au traitement 
de texte. Elle est compatible avec une large gamme de formats de documents, dont ceux de 
Microsoft Word (*.doc et *.docx) et vous permet d’exporter vos travaux sous plusieurs formats, 
dont le format PDF

Quiconque désire progresser rapidement dans l’utilisation de LibreOffice trouvera ce Guide de Dé-
marrage précieux, qu’il soit débutant ou déjà familiarisé avec une autre suite bureautique.

Que contient ce livre ?

Ce livre présente certaines des fonctionnalités principales de Writer, l’élément composant traite-
ment de texte de LibreOffice et explique comment les utiliser.

Première partie : Fondamentaux

1. Introduction à Writer.
2. Travailler avec le texte : les bases.
3. Travailler avec le texte : approfondissements.
4. Mettre le texte en forme.
5. Mettre les pages en forme : les bases.
6. Mettre les pages en forme : approfondissements.
7. Imprimer, exporter, envoyer par courriel.
8. Introduction aux styles.
9. Travailler avec les styles.

10. Travailler avec les modèles.

Deuxième partie : Suppléments

11. Images et objets graphiques.
12. Travailler avec les listes.
13. Travailler avec les tableaux de données.
14. Le publipostage.
15. Tables des matières, index et bibliographies.
16. Les documents maîtres.
17. Travailler avec les champs.
18. Utiliser les formulaires.
19. Feuilles de calcul, diagrammes et autres objets.
20. Paramétrer Writer.
21. Personnaliser Writer.

Prérequis minimum pour utiliser LibreOffice 6.0

Pour une liste détaillée des exigences préalables et des systèmes d’exploitation utilisables, voyez 
le site web de LibreOffice, https://fr.libreoffice.org/get-help/system-requirements/.
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À qui s’adresse ce livre ?

Comment obtenir LibreOffice

Les versions de LibreOffice pour Windows, Linux et macOS peuvent être téléchargées gratuite-
ment à https://fr.libreoffice.org/download/libreoffice-stable/. Vous pouvez aussi télécharger le logi-
ciel avec un client de téléchargement peer-to-peer comme BitTorrent, à la même adresse.

Les utilisateurs de Linux trouveront aussi LibreOffice inclus dans beaucoup des dernières distribu-
tions ; Ubuntu n’est qu’un exemple.

Les utilisateurs de macOS peuvent aussi acheter LibreOffice Vanilla à partir de l’App Store.

Les autres versions et les versions portables de LibreOffice sont indiquées sur la page de téléchar-
gement. Les versions Linux, Vanilla et d’autres peuvent présenter quelques différences par rapport
à quelques fonctionnalités décrites dans ce livre.

Comment installer le logiciel

Vous pouvez trouver ici des informations sur l’installation et la configuration de LibreOffice sur les 
différents systèmes d’exploitation supportés : https://fr.libreoffice.org/get-help/install-howto/.

Paramétrer et personnaliser LibreOffice

Vous pouvez modifier les paramètres par défaut (options) de LibreOffice pour qu’ils s’adaptent à 
vos préférences. Pour cela, sélectionnez Outils > Options dans la barre de Menu. Les para-
mètres sont décrits dans L’Aide et au chapitre 2, Configurer LibreOffice du Guide du Débutant. 
Certains paramètres d’un intérêt particulier pour les utilisateurs de Writer sont présentés au Cha-
pitre 20 Paramétrer Writer, page 545.

Conseil

De nombreux paramètres s’adressent aux utilisateurs expérimentés et aux programmeurs. 
Si vous ne comprenez pas ce que fait une option, nous vous recommandons de lui laisser 
sa valeur par défaut sauf si des instructions présentes dans ce livre recommandent dans ce 
livre de la modifier.

Dans LibreOffice, vous pouvez personnaliser les menus, les barres d’outils et les raccourcis cla-
vier, lui ajouter des nouveaux menus et de nouvelles barres d’outils et affecter des macros aux 
évènements. Voyez le Chapitre 21 Personnaliser Writer page 567, pour plus de détails.

Extensions et modules complémentaires

Vous pouvez ajouter des fonctionnalités à LibreOffice avec des extensions et des modules complé-
mentaires. Plusieurs sont installés avec le programme et vous pouvez en obtenir d’autres au dépôt
officiel des extensions, à l’adresse https://extensions.libreoffice.org/, et depuis d’autres sources. 
Voyez le Chapitre 21 Personnaliser Writer page 567, pour plus d’informations sur l’installation des 
extensions et des modules complémentaires.
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À qui s’adresse ce livre ?

Où trouver de l’aide supplémentaire ?

Ce livre, les autres guides de l’utilisateur de LibreOffice, les systèmes d’Aide intégrée et de support
aux utilisateurs supposent que vous êtes familiarisé avec votre ordinateur et ses fonctions de base
telles que le lancement d’un programme, l’ouverture et l’enregistrement de fichiers.

Système d’aide

LibreOffice propose un système d’Aide étendu qui est votre première ligne de soutien dans l’utilisa-
tion du logiciel. Les utilisateurs de Windows et de Linux peuvent télécharger et installer une aide 
intégrée utilisable sans être connecté à Internet ; celle-ci est installée avec le programme sous ma-
cOS.

Pour afficher le système d’Aide, appuyez sur la touche F1 ou cliquez sur Aide de LibreOffice 
dans le menu Aide. Si vous n’avez pas installé l’aide intégrée sur votre ordinateur, votre naviga-
teur par défaut s’ouvrira à une page du wiki de LibreOffice si vous êtes connecté à Internet.

Le menu Aide propose des liens vers d’autres fonctions d’information et de soutien de LibreOffice.

Remarque

Les options marquées du symbole ↕ dans la liste suivante ne sont accessibles que si votre 
ordinateur est relié à internet.

• Qu’est-ce que c’est ? Pour une brève information, placez le pointeur de la souris au-dessus
d’une des icônes pour faire apparaître une petite boîte (« Infobulle ») donnant une courte ex-
plication de la fonction de cette icône. Pour une information plus détaillée, cliquez sur Aide >
Qu’est-ce que c’est ? et placez le pointeur au-dessus de l’icône. En supplément, vous pou-
vez activer les Infoballons donnant une aide plus étendue en cochant l’option correspon-
dante dans la page LibreOffice > Général qui s’ouvre en cliquant sur le menu Outils > Op-
tions (LibreOffice – Préférences sous macOS).

• Guides utilisateur… ↕ Ouvre votre logiciel de navigation par défaut à la page de Documen-
tation du site web de LibreOffice https://documentation.libreoffice.org/fr/documentation-en-
francais/. Vous y trouverez les Guides de l’utilisateur (à télécharger gratuitement sous forme 
de fichiers PDF) et d’autres informations utiles.

• Obtenir de l’aide en ligne… ↕ Ouvre votre logiciel de navigation à la page Poser une ques-
tion sur le forum d’aide de la communauté de LibreOffice https://fr.libreoffice.org/get-help/po-
ser-une-question.

• Envoyer un retour… ↕ Ouvre votre logiciel de navigation à la page Retour d’expérience du 
site web de LibreOffice https://fr.libreoffice.org/get-help/feedback/ d’où vous pourrez signaler 
un bogue, suggérer de nouvelles fonctionnalités et communiquer avec les autres membres 
de la communauté de LibreOffice.

• Redémarrer en mode sans échec… Ouvre une boite de dialogue qui vous permet de redé-
marrer LibreOffice en lui redonnant ses paramètres par défaut.

• Faire un don à LibreOffice ↕ Ouvre votre logiciel de navigation par défaut à la page Support
LibreOffice https://fr.libreoffice.org/donate/ où vous pouvez faire un don pour soutenir 
LibreOffice.
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• Informations de licence Affiche les licences sous lesquelles LibreOffice est mis à votre dis-
position.

• Vérifier les mises à jours… ↕ Ouvre une boite de dialogue et cherche sur le site web de 
LibreOffice si des mises à jours sont disponibles pour votre version du logiciel.

• À propos de LibreOffice Ouvre une boite de dialogue qui affiche des informations sur la 
version de LibreOffice et le système d’exploitation que vous utilisez. Celles-ci seront souvent 
nécessaires si vous demandez l’aide et l’assistance de la communauté pour le logiciel. Sous 
macOS, cette entrée se trouve sous LibreOffice dans la barre de menu.

Support en ligne gratuit

La communauté de LibreOffice ne se contente pas de développer le logiciel, mais elle offre aussi 
un support gratuit basé sur le volontariat. Voyez le Tableau 1 et cette page web : https://fr.libreof-
fice.org/get-help/feedback/

Les utilisateurs peuvent obtenir de l’aide en ligne de la Communauté via la liste d’entraide : https://
fr.libreoffice.org/get-help/mailing-lists/

Vous pouvez obtenir un soutien complet en ligne de la communauté par les listes de discussion et 
le site web Ask LibreOffice, https://ask.libreoffice.org/en/questions/ (en Anglais). D’autres sites web
gérés par des utilisateurs offrent aussi des conseils et des tutoriels gratuits. Ce site offre un sup-
port pour LibreOffice parmi d’autre programmes : https://forum.openoffice.org/fr/forum/.

Tableau 1: Support gratuit pour les utilisateurs de LibreOffice

Support gratuit pour LibreOffice

Poser une question
Questions et réponses de la communauté des utilisateurs
https://fr.libreoffice.org/get-help/poser-une-question

Documentation
Guides de l’utilisateur, tutoriels et autre documentation https://wiki.docu-
mentfoundation.org/FR/La_documentation_de_l'utilisateur
https://wiki.documentfoundation.org/Documentation/Publications/fr

FAQ Réponses aux questions souvent posées
https://wiki.documentfoundation.org/FR/FAQ

Listes de discussion
Un soutien gratuit de la communauté est offert par un réseau d’utilisa-
teur expérimentés : 
https://fr.libreoffice.org/get-help/mailing-lists/

Support international

Le site web de LibreOffice en français :
https://fr.libreoffice.org/
Les sites web de LibreOffice en divers langues
https://www.libreoffice.org/community/nlc/
Listes de diffusions en langues maternelles
https://wiki.documentfoundation.org/Local_Mailing_Lists

Options d’accessibilité
Informations sur les options d’accessibilité disponibles https://fr.libreof-
fice.org/get-help/accessibility/

Support et formations payants

Vous pouvez aussi acheter un support par des contrats de service auprès d’un revendeur ou d’une
société de consultants spécialisés dans LibreOffice : https://fr.libreoffice.org/get-help/professional-
support/.
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Ce que vous voyez est peut-être différent

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et macOS, chacun d’eux 
possède plusieurs versions et peut être personnalisé par les utilisateurs (polices, couleurs, 
thèmes, gestionnaires de fenêtres).

Illustrations

Les illustrations de ce guide proviennent essentiellement de la version fonctionnant sous Windows 
10 (64 bits) avec le jeu d’icônes Colibre. Certaines ne ressembleront donc pas exactement à ce 
que vous voyez sur l’écran de votre ordinateur.

Icônes

La communauté de LibreOffice a créé plusieurs ensembles d’icônes : Breeze, Elementary, Galaxy, 
High Contrast, Sifr, Colibre et Tango. Les icônes utilisées pour illustrer certains des nombreux ou-
tils disponibles dans LibreOffice peuvent être différentes de celles utilisées dans ce guide. Celles-
ci ont été extraites d’une installation de LibreOffice qui a été configuré pour afficher le jeu d’icônes 
Colibre.

Pour changer le jeu d’icônes utilisés, allez à la page LibreOffice > Affichage en cliquant sur Outils 
> Options. Dans Interface utilisateur, sélectionner Colibre parmi les options disponibles dans la 
liste déroulante Style d’icône.

Remarque

Certaines distributions Linux incluent LibreOffice comme élément de l’installation et peuvent 
ne pas comporter tous les jeux d’icônes indiqués ci-dessus. Vous devriez pouvoir téléchar-
ger d’autres jeux d’icônes à partir du dépôt logiciel de votre distribution Linux si vous désirez
les utiliser.

Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage
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Comment s’appellent toutes ces choses ?

Les termes utilisés dans LibreOffice pour la plupart des éléments de l’interface utilisateur (les par-
ties du programme que vous voyez et utilisez par opposition au code qui fait réellement le travail 
en coulisse) sont les mêmes que pour la plupart des programmes.

Une boîte de dialogue est un type de fenêtre particulier qui a pour but de vous informer ou de vous
demander de saisir quelque chose ou les deux. Elle offre des contrôles qui vous permettent de 
préciser comment réaliser une action. Les noms techniques des contrôles communs sont indiqués 
sur la Figure 1. Dans la plupart des cas, nous n’utiliserons pas les termes techniques dans ce livre,
mais il est utile de les connaître, car l’Aide et les autres sources d’information les utilisent souvent.

Figure 1 : Dialogue (depuis Calc) montrant les contrôles courants

 1) Page à onglet (n’est pas strictement parlant un contrôle).

 2) Boutons radio (un seul peut être sélectionné à la fois).

 3) Cases à cocher (plusieurs peuvent être sélectionnées à la fois).

 4) Sélecteur numérique (cliquer sur les flèches pour modifier le nombre qui apparaît dans la 
boîte de texte à côté d’elles ou tapez-y directement le nombre voulu).

 5) Miniature ou vignette.

 6) Liste déroulante pour sélectionner un élément.

 7) Boutons poussoirs.
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Dans la plupart des cas, vous ne pouvez interagir qu’avec le dialogue (pas le document lui-même) 
tant que celui-ci reste ouvert. Quand vous refermez le dialogue après utilisation (habituellement cli-
quer sur OK ou un autre bouton enregistre vos modifications et ferme le dialogue), vous pouvez de
nouveau travailler sur votre document.

Certains dialogues peuvent rester ouverts pendant que vous travaillez, pour vous permettre de 
faire des aller-et-retours entre ceux-ci et votre document. Le dialogue Rechercher & Remplacer en 
est un exemple.

Qui a écrit ce livre ?

Ce livre a été écrit par des bénévoles de la communauté LibreOffice comme indiqué sur la page de
Copyright. Les profits provenant de la vente de l’édition imprimée seront utilisés au bénéfice de la 
communauté.
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Traducteurs

Jean-Luc Vandemeulebroucke

Relecteurs

Evelyne Tenaerts François Olivier

Questions fréquentes

Puis-je distribuer LibreOffice à tout le monde ? Puis-je le vendre ? Puis-je utiliser 
LibreOffice dans mon travail ?

Oui.

Sur combien d’ordinateurs puis-je l’installer ?

Autant que vous voulez.

LibreOffice est-il disponible dans ma langue ?

LibreOffice a été traduit (localisé) en 51 langues, donc la vôtre est probablement supportée. 
En plus, il existe plus de 70 dictionnaires orthographiques, de coupure de mot ou de syno-
nymes pour les langues et les dialectes qui n’ont pas d’interface de programme traduite. Les 
dictionnaires sont disponibles sur le site web de LibreOffice à : www.libreoffice.org.

Comment pouvez-vous le faire gratuitement ?

LibreOffice est développé et entretenu par des bénévoles et il a le soutien de plusieurs orga-
nisations.

Comment puis-je contribuer à LibreOffice ?

Vous pouvez aider au développement et au soutien aux utilisateurs de LibreOffice de nom-
breuses façons, et vous n’avez pas besoin d’être programmeur. Pour commencer, regardez 
cette page web : https://fr.libreoffice.org/community/get-involved/

Puis-je distribuer le PDF de ce livre ou en imprimer et en vendre des copies ?

Oui, tant que vous remplissez les conditions d’une des licences de la déclaration de copy-
right au début de ce livre. Vous n’avez pas besoin de demander une permission spéciale. En 
plus, nous demandons que vous partagiez avec le projet une partie des profits que vous tirez
de la vente des livres, en contrepartie de tout le travail que nous avons effectué pour les pro-
duire.
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Qu’est-ce que Writer ?

Writer est le module de traitement de texte de LibreOffice. En plus des fonctions habituelles d’un 
traitement de texte (vérification orthographique, dictionnaire des synonymes, coupure des mots, 
auto-correction, recherche et remplacement, génération automatique de tables des matières et 
d’index, publipostage et autres), Writer propose ces fonctions importantes :

• la saisie, l’édition et la mise en forme du texte (chapitres 2, 3 et 4) ;

• le suivi des modifications durant les révisions (chapitre 4) ;

• des méthodes de mise en page parmi lesquelles les styles, les cadres, les colonnes et les ta-
bleaux (chapitres 5 et 6) ;

• l’exportation au format PDF, y compris les repères de texte, ePub (chapitre 7) ;

• les modèles et les styles (chapitres 8, 9 et 10) ;

• les images et les outils graphiques (chapitre 11) ;

• les listes (chapitre 12 ;

• les tableaux de données (chapitre 13) ;

• le publipostage (chapitre 14) ;

• les tables des matières et les index automatisés (chapitre 15) ;

• les documents-maîtres pour grouper une collection de fichier en un document unique (cha-
pitre 16) ;

• les champs et les formulaires (chapitres 17 et 18) ;

• l’intégration des bases de données, y compris une base de données bibliographique (cha-
pitres 14, 15 et 18) ;

• la liaison ou l’incorporation de classeurs, d’équations et d’autres objets (chapitre 19) ;

• et bien plus encore.

Éléments de la fenêtre principale de Writer

Les fonctions de l’espace de travail principal de Writer (voir Figure 1.1) sont décrites dans cette 
section.

Barre de titre

La barre de titre, située en haut de la fenêtre de Writer, affiche le nom de fichier du document ac-
tif. Lorsqu’un document vient d’être créé, le nom du document apparaîtra comme Sans nom X, où 
X est un numéro.

Menus

La barre des menus est située juste en dessous de la barre de titre. Lorsque vous cliquez sur 
l’un des menus, un sous-menu se développe afin de vous proposer plus d’options telles que :
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Barre 
d’état

Espace de travail

Barre 
de titre

Barre de 
menu

Barre d’outils 
standard

Barre d’outils 
formatage

Volet 
latéral

Barre 
d’état

Figure 1.1 : L’espace de travail principal de Writer (avec le thème d’icônes “Colibre”).

• des commandes exécutables comme Fermer ou Enregistrer qui se trouvent dans le menu Fi-
chier ;

• des commandes (représentées par le nom de la commande suivie de pointillés) pour ouvrir 
des boîtes de dialogue telles que Rechercher… ou Collage spécial… qui se trouvent dans le 
menu Édition ;

• des sous-menus (indiqués par une flèche pointant vers la droite) comme pour les  Barres
d’outils et le Zoom qui se trouvent dans le menu Affichage.

Le volet latéral

Le Volet latéral de Writer est ouvert par défaut sur le bord droit de la fenêtre de Writer, comme on 
le voit sur la Figure 1.2. Si nécessaire, sélectionnez Affichage > Volet latéral dans la barre de 
menu pour l’afficher. Il est muni d’un bouton permettant de le masquer ou de l’afficher comme le 
montre la Figure 1.2. Quand il est fermé, il peut être ouvert en cliquant sur ce bouton qui se trouve 
alors à l’extrémité droite de la fenêtre.

Le volet latéral de Writer est composé de cinq pages par défaut : Propriétés, Page, Styles et for-
matage (ou simplement Styles), Galerie et Navigateur. Chaque page est représentée par une 
icône, située à droite du volet latéral, qui vous permet de passer d’une page à l’autre en cliquant 
sur l’une d’elles.

Il existe deux pages supplémentaires qui ne sont pas activées par défaut : Ébauche et Gérer les 
modifications. Voir page 17 ci-dessous pour toute information supplémentaire.

Chaque page affiche sa barre de titre ainsi que les différentes options disponibles classées par 
panneaux. Les barres d’outils et certains panneaux du volet latéral partagent de nombreuses fonc-
tions. Par exemple, les boutons pour mettre du texte en gras ou en italique sont présents aussi 
bien dans la barre de formatage que dans le panneau Caractère de la page Propriétés.
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Configuration du 
volet latéral

Barre de titre

Bouton plus d’options

Onglets

Contenu de l’onglet

Titre de panneau

Contenu du panneau

Bouton 
Afficher/
Masquer

Figure 1.2 : L’onglet Propriétés du volet latéral

Certains panneaux disposent d’un bouton Plus d’options  qui ouvre une boîte de dialogue vous 
proposant un plus grand choix de fonctions. Quand cette boîte de dialogue est ouverte, elle em-
pêche toute modification du document jusqu’à sa fermeture.

Configuration du volet latéral

Figure 1.3 : Menu de configuration du volet latéral

Pour ajuster la largeur du volet latéral, placez le curseur de la souris sur sa bordure gauche. 
Lorsque celui-ci prend la forme d’une flèche horizontale double, cliquez et tirez vers la gauche ou 
la droite. Quand les pages Propriétés, Gérer les modifications ou Ébauche sont ouvertes, le volet 
latéral possède une largeur minimum. Quand une autre page est ouverte, il peut être réduit à la 
largeur de sa barre d’onglets. Pour libérer le volet latéral et le rendre flottant, ou pour arrimer un 
volet latéral flottant, utilisez le menu déroulant de Configuration du volet latéral au-dessus de la 
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barre d’onglets (voir la Figure 1.3) Dans ce même menu, vous pouvez choisir les éléments à in-
clure dans le volet latéral.

Les onglets du volet latéral

Les onglets sont décrits ci-dessous :

Propriétés 

Affiche des outils relatifs au formatage direct dans le document. Par défaut, les outils sont divisés 
en trois panneaux pour l’édition de texte.

• Styles. Permet de modifier le style du paragraphe en cours de créer ou de mettre à jour un 
nouveau style à partir du paragraphe sélectionné.

• Caractère. Permet de modifier la police, la taille, la couleur, le style ou l’espacement du 
texte.

• Paragraphe. Permet de modifier l’alignement, les puces et numérotations, la couleur d’ar-
rière-plan, le retrait ou l’espacement du paragraphe.

Si un objet image est sélectionné, d’autres panneaux s’affichent dans la page Propriétés.

• Zone. Permet de modifier le mode de remplissage de l’arrière-plan de l’objet et de détermi-
ner le type de transparence.

• Image. Permet de modifier la luminosité, le contraste, le mode de couleur ou la transparence
de l’objet.

• Adaptation du texte. Permet de déterminer comment l’objet doit se comporter vis-à-vis du 
texte contenu dans le document.

• Position et taille. Permet de modifier la hauteur et la largeur de l’objet. Les fonctions Rota-
tion et Retourner sont disponibles.

Si un objet de dessin est sélectionné, les panneaux suivants sont disponibles.

• Zone. Permet de modifier le remplissage et la transparence de l’objet.

• Ligne. Permet d’éditer le style, la largeur, la couleur et les extrémités des lignes ainsi que 
leur transparence.

• Position et taille. Permet de modifier la position et la rotation de l’objet et de lui appliquer 
une symétrie horizontale ou verticale.

Si un cadre est sélectionné, la catégorie Adaptation du texte s’affiche mais certaines fonc-
tions peuvent être grisées en raison de leur incompatibilité avec le type de cadre.

Page 

Contient des outils pour mettre directement en forme la page. Elle possède quatre pan-
neaux :

• Format. Modifie la taille, la largeur, la hauteur, l’orientation et les marges de la page ;

• Styles. Modifie le style de numérotation de la page, l’arrière-plan, la disposition et le nombre 
de colonnes :
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• En-tête. Active ou désactive l’en-tête et modifie ses marges, son espacement et son conte-
nu ;

• Pied de page. Active ou désactive le pied de page et modifie ses marges, son espacement 
et son contenu.

! Attention

Soyez conscient que si vous modifiez les options de la catégorie Page, vous modifierez le 
style de page utilisé. Cela n’affectera pas seulement la page en cours, mais toutes les 
pages utilisant le même style de page.

Styles et formatage 

Cet onglet peut aussi avoir pour titre Styles. Il permet de gérer les styles utilisés dans le do-
cument, d’appliquer d’autres styles existants, d’en créer des nouveaux ou de les modifier. 
Cette page peut être transformée en fenêtre flottante si elle est détachée. Vous pouvez y ac-
céder également via le menu Format > Styles et formatage ou en appuyant sur la touche 
F11. Pour plus d’informations, voir le Chapitre 8 Introduction aux styles page 201et le Cha-
pitre 9 Travailler avec les styles page 231.

Galerie 

Permet d’ajouter des images disponibles dans la Galerie. La Galerie se divise en deux sec-
tions. La première répertorie tous les thèmes par leur nom (arrière-plans, flèches, formes de 
base, etc.) et la seconde affiche les images du thème sélectionné. Pour créer un nouveau 
thème, cliquez sur le bouton Nouveau thème… Pour insérer une image dans un dossier ou 
ajouter une image à un nouveau thème, recherchez les images sur votre ordinateur puis 
faites un glisser-déposer de cette image jusqu’à la galerie. Cette page peut être transformée 
en fenêtre flottante si elle est détachée. Vous pouvez y accéder également via le menu Affi-
chage > Galerie ou en cliquant sur le bouton Galerie de Média et Open Clip Art de la barre
d’outils standard. Pour plus d’informations, voir le Chapitre 11 Images et objets graphiques 
page 277.

Navigateur 

Permet de naviguer dans le document et de réorganiser son contenu en sélectionnant diffé-
rentes catégories, telles que les titres, les tableaux, les cadres ou les objets. Pour plus d’in-
formations, voir « Utiliser le navigateur » page 34.

Gérer les modifications 

Affiche toutes les modifications effectuées dans le document depuis l’activation du mode En-
registrer les modifications. Cet onglet est une alternative à la boîte de dialogue Gérer les 
modifications qui peut être ouverte par Édition > Suivi des modifications > Gérer les mo-
difications dans la barre de menu. Cet onglet n’est disponible que si l’option Activer les 
fonctions expérimentales a été cochée dans la page LibreOffice > Avancé de la boîte de dia-
logue Options (sélectionnez Outils > Options.dans la barre de menu). Pour plus d’informa-
tions, voir le Chapitre 2 Travailler avec le texte : les bases page 41.
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Ébauche 

Offre un accès rapide aux thèmes (polices et couleurs) et styles prédéfinis. Cet onglet n’est 
disponible que si l’option Activer les fonctions expérimentales a été cochée dans la page 
LibreOffice > Avancé de la boîte de dialogue Options (sélectionnez Outils > Options.dans la
barre de menu) et s’il est sélectionné dans Paramètres de la barre latérale > Personnali-
sation.

Barres d’outils

LibreOffice dispose de deux types de barres d’outils : ancrée (à emplacement fixe) ou flottante. 
Les barres d’outils ancrées peuvent être déplacées à différents emplacements ou rendues flot-
tantes, et les barres d’outils flottantes peuvent être ancrées.

Afficher ou masquer les barres d’outils

Pour afficher ou masquer des barres d’outils, ouvrez le sous-menu Affichage > Barres d’outils 
sur la barre de menu puis cliquez sur le nom d’une barre d’outils dans la liste déroulante. Une 
barre d’outils active affiche une coche à côté de son nom. Les barres d’outils créées à partir de pa-
lettes d’outils n’apparaissent pas dans le menu Affichage.

Pour fermer une barre d’outils, sélectionnez Affichage > Barres d’outils sur la barre de menu et 
décochez-la ou faites un clic droit à l’intérieur de la barre d’outils et choisissez Fermer la barre 
d’outils dans le menu contextuel.

Barres d’outils les plus utilisées

Dans l’installation par défaut de LibreOffice (voir Figure 1.1), la première barre d’outils ancrée, 
juste sous la barre de menu, est appelée barre d’outils Standard. Elle est cohérente à travers 
toutes les modules de LibreOffice.

La deuxième barre d’outils, dans l’installation par défaut de LibreOffice, est la barre de Formatage. 
Elle dépend du contexte : elle affiche les outils en rapport avec la position courante du curseur ou 
avec l’objet sélectionné. Par exemple, quand le curseur est dans du texte, les outils permettent la 
mise en forme  de ce dernier ; quand le curseur est sur une image, la barre Formatage propose 
des outils spécifiques pour la mettre en forme.

Il est, dans certains cas, pratique de réduire le nombre de barres d’outils affichées pour laisser da-
vantage de place au document. LibreOffice offre une barre d’outils unique comme alternative aux 
deux barres installées par défaut. Elle contient les commandes les plus utilisées. Pour l’activer, sé-
lectionnez Affichage > Barres d’outils > Standard (simple) et désactivez Affichage > Barre 
d’outils > Standard et Affichage > Barres d’outils > Formatage.

D’autres barres d’outils peuvent être affichées par le menu Affichage > Barres d’outils. Parmi les
plus couramment utilisées, on trouve les barres d’outils Rechercher, Dessin, Suivi des modifica-
tions et Puces et numérotations. Elles sont présentées, ainsi que les autres, dans les chapitres 
concernés de ce livre.

Sous-menus et palettes d’outils

Les icônes d’une barre d’outils qui revêtent un petit triangle lié à leur droite, affichent des sous-me-
nus, des palettes d’outils ou d’autres méthodes pour sélectionner les éléments selon l’icône.

Les palettes d’outils sont des collections d’outils regroupés qui peuvent être transformées en 
barres d’outils flottantes. La Figure 1.4 montre un exemple de palette d’outils de la barre d’outils 
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Dessin transformée en barre d’outils flottante. Une fois détachée de sa barre d’outils parente, une 
palette affiche une barre de titre. Les palettes d’outils peuvent être flottantes ou ancrées le long 
d’un des bords de l’écran ou dans une des zones des barres d’outils existantes.

Cliquez et tirez ici pour 
transformer la palette en barre 
d’outils flottante

Palette d’outils Barre d’outils flottante

Figure 1.4 : Exemple de détachement d’une palette d’outils

Déplacer les barres d’outils

Les barres d’outils ancrées peuvent être détachées et déplacées à une nouvelle position d’ancrage
ou laissées flottantes. Pour détacher une barre d’outils :

 1) Placez le pointeur de la souris au-dessus de la poignée de la barre
d’outils qui est la petite barre verticale à la gauche d’une barre
d’outils ancrée et encadrée sur la Figure 1.5

 2) Maintenez le bouton gauche de la souris enfoncé et tirez la barre
d’outils jusqu’à son nouvel emplacement. Elle peut être ancrée
dans une nouvelle position en haut, sur les côtés ou en bas de la
fenêtre principale ou laissée flottante.

 3) Relâchez le bouton de la souris.

Pour déplacer une barre d’outils flottante, cliquez sur sa barre de titre et tirez-la jusqu’à sa nouvelle
position ou ancrez-la en haut ou en bas de la fenêtre principale.

Remarque

Vous pouvez aussi ancrer une barre d’outils flottante en maintenant enfoncée la touche 
Ctrl pendant que vous effectuez un double clic sur sa barre de titre.

Barres d’outils flottantes

LibreOffice propose plusieurs barres d’outils supplémentaires qui apparaissent par défaut flot-
tantes en réponse à la position courante du curseur ou à la sélection. Vous pouvez les ancrer en 
haut ou en bas de la fenêtre principale ou les repositionner sur l’écran de votre ordinateur (voyez 
« Déplacer les barres d’outils » ci-dessus).

Certaines de ces barres d’outils supplémentaires dépendent du contexte et apparaîtront automati-
quement en fonction de la position du curseur. Par exemple, quand le curseur se trouve dans un 
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tableau, la barre d’outils Tableau apparaît et, lorsqu’il est positionné dans une liste numérotée ou à
puces, la barre d’outils Puces et numérotation apparaît.

Personnaliser les barres d’outils

Vous pouvez personnaliser les barres d’outils de plusieurs manières, y compris en choisissant les 
icônes visibles et en verrouillant la position d’une barre ancrée. Vous pouvez aussi ajouter des 
icônes et créer de nouvelles barres d’outils, comme il est décrit au Chapitre 21 Personnaliser 
Writer page 567.

Pour accéder aux options de personnalisation d’une barre d’outils, faites un clic droit sur une icône
de celle-ci pour ouvrir un menu contextuel puis choisissez parmi les options suivantes :

• pour afficher ou masquer les icônes définies pour la barre d’outils sélectionnée, cliquez sur 
Boutons visibles. Les icônes visibles dans la barre d’outils sont marquées par un contour 
ou un fond bleu (Figure 1.6) ou par une coche à côté de celles-ci selon votre système d’ex-
ploitation. Sélectionnez ou désélectionnez les icônes pour les masquer ou les afficher dans 
la barre d’outils ;

Boutons visibles 
dans la barre 
d’outils

Boutons 
masqués dans 
la barre d’outils

Figure 1.6 : Sélection des boutons visibles dans une barre d’outils

• cliquez sur Ancrer toutes les barres d’outils pour ancrer toutes les barres flottantes ;

• cliquez sur Personnaliser la barre d’outils pour ouvrir la boîte de dialogue Personnaliser : 
voyez le Chapitre 21 Personnaliser Writer page 567 pour plus d’informations ;

• cliquez sur Ancrer la barre d’outils pour ancrer toutes les barres flottantes. Par défaut, une 
barre d’outils s’ancre en haut de l’espace de travail. Vous pouvez la repositionner à un an-
crage différent. Voyez « Déplacer les barres d’outils » à la page 19 ;

• cliquez sur Bloquer la position de la barre d’outils pour verrouiller la position d’ancrage 
d’une barre ;

• cliquez sur Fermer la barre d’outils pour fermer la barre sélectionnée.

Règles

La règle horizontale en haut de l’espace de travail est visible par défaut mais pas la règle verticale.
Pour l’afficher, choisissez Affichage > Règles > Règle verticale dans la barre de menu ou ouvrez
la page LibreOffice Writer > Affichage de la boîte de dialogue Options (Outils > Options dans la 
barre de menu) et cochez l’option Règle verticale. Pour afficher/masquer rapidement les deux 
règles, utilisez la combinaison de touche Ctrl+Maj+R.
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Conseil

La règle horizontale possède un bouton marqué commentaires à son extrémité droite qui 
permet d’afficher ou masquer rapidement les commentaires.

Barre d’état

La barre d’état se situe en bas de l’espace de travail. Elle donne des informations sur le document 
et s’avère un moyen pratique pour modifier rapidement quelques caractéristiques. Elle peut être 
masquée en décochant son entrée dans le menu Affichage.

Numéro de page

Affiche le numéro de séquence de la page active, le nombre total de pages du document et 
le numéro de page actuel (si différent de son numéro de séquence). Par exemple, si vous 
avez redémarré la numérotation des pages à 1 à la troisième page d’un document de 6 
pages, le numéro de page est 1, le numéro de séquence est 3 et le nombre total de page est
6 (voir la Figure 1.7).

Nombre et 
numéro de page

Nombre de mots 
et de caractères

Langue

Mode d’insertion

Style de 
page

Mode de 
sélection

Document modifié

Signature 
électronique

Information 
sur l’objet

Agencement 
de l’affichage

Réglage 
du zoom

Pourcentage 
de zoom

Figure 1.7 : Exemple de barre d’état de Writer

Si des repères de texte ont été définis dans le document, un clic droit sur ce champ permet 
d’en afficher la  liste complète ; cliquez sur l’un d’eux pour vous rendre à son emplacement.

Pour sauter à une page spécifique dans le document, double-cliquez sur ce champ. Le Navi-
gateur s’ouvre (voir « Utiliser le navigateur » page 34). Cliquez dans le champ Numéro de 
page dans le Navigateur et tapez le numéro de séquence de la page voulue. Ce numéro 
peut être différent du numéro de page si vous avez recommencé la numérotation des pages 
à un ou plusieurs endroits du document. Validez par Entrée, la page choisie s’affiche.

Compteur de mots et de caractères

Affiche le nombre de mots et de caractères contenus dans le document. Le compteur est mis
à jour tout au long de l’édition du document. Si vous sélectionnez une partie de texte dans le 
document, le compteur indiquera les informations relatives à cette sélection.
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Pour afficher les statistiques plus détaillées (par exemple, le nombre de caractères excluant 
les espaces), double-cliquez sur le compteur de mots et de caractères dans la barre d’état 
ou cliquez sur le menu Outils > Statistiques.

Vous pouvez aussi voir le nombre de mots et de caractères (ainsi que d’autres informations, 
y compris le nombre de pages, de tableaux et d’images) dans le document tout entier en sé-
lectionnant l’onglet Statistiques de la boîte de dialogue Fichier > Propriétés.

Style de page

Affiche le style de la page active. Pour modifier le style de page, faites un clic droit sur ce 
champ. Une liste des styles de page s’affiche ; choisissez un style différent en cliquant sur 
celui-ci. Pour éditer le style de page, double-cliquez sur ce champ. La boîte de dialogue 
Style de page s’ouvre.

! Attention

Modifier le style de page à cet endroit peut affecter les styles des pages suivantes, selon la 
façon dont ceux-ci sont définis. Voir les chapitres 8 et 9 pour plus de détails sur les styles.

Langue

Affiche la langue du texte où le curseur se trouve ou du texte sélectionné. Cette fonction est 
utilisée pour la vérification orthographique, la césure des mots et les synonymes.

Cliquez pour ouvrir un menu où vous pouvez choisir une autre langue pour le texte sélection-
né ou pour le paragraphe dans lequel le curseur est situé. Vous pouvez également choisir 
Aucune (pas de vérification orthographique) pour exclure le texte de la vérification ortho-
graphique ou Rétablir la langue par défaut. Choisissez Plus… pour ouvrir la boîte de dia-
logue Caractère. Voir le Chapitre 2 Travailler avec le texte : les bases page 41 pour plus d’in-
formations.

Mode de frappe

Cette zone est vide lorsque le mode Insertion est actif. Double-cliquez sur cette zone pour 
basculer vers le mode Écraser. Faites un simple clic gauche pour retourner au mode Inser-
tion. Vous pouvez aussi appuyer sur la touche Insér de votre clavier pour basculer entre 
les modes. En mode Insertion, le texte situé après le curseur se décale pour laisser l’espace
au texte que vous tapez. En mode Écraser, le texte situé après le curseur est remplacé par 
le texte que vous tapez. Cette fonction est désactivée lorsque l’enregistrement des modifica-
tions (Édition > Modifications > Enregistrer) est activé.

Mode de sélection

Cliquez pour choisir un mode de sélection. L’icône ne change pas, mais lorsque vous placez 
le curseur de la souris au-dessus de cette icône, une infobulle vous indique quel est le mode 
actif.

Lorsque vous cliquez sur l’icône, un menu contextuel affiche les modes de sélection dispo-
nibles.

Mode Effet

Sélection standard Cliquez dans le texte, là où vous souhaitez positionner le curseur 
de la souris. Cliquez sur un élément pour faire de lui l’élément ac-
tif. Toute autre sélection est alors désactivée.

22 | Guide de LibreOffice Writer Éléments de la fenêtre principale de Writer



 Chapitre 1 Introduction à Writer

Mode Effet

Sélection étendue (F8) Cliquez dans le texte pour étendre ou réduire la sélection active.

Sélection avec ajout 
(Maj+F8)

Une nouvelle sélection est ajoutée à une sélection existante. Il 
s’agit d’une sélection multiple.

Sélection par bloc 
(Ctrl+Maj+F8)

Un bloc de texte peut être sélectionné.

Sous le système d’exploitation Windows, vous pouvez maintenir enfoncée la touche Alt de 
votre clavier pendant que vous sélectionnez un bloc de texte. De cette façon, vous n’aurez 
pas besoin de définir le mode de sélection par bloc.

Modifications non enregistrées

L’icône  est remplacée par l’icône  si les modifications du document n’ont pas été enre-
gistrées. Cliquez sur l’icône indiquant que les modifications n’ont pas été enregistrées pour 
sauvegarder le document.

Signature numérique

Si le document a été signé numériquement, l’icône  apparaît sinon la zone est vide. Pour 
signer le document ou voir le certificat, cliquez sur l’icône. Voir le Chapitre 7 Imprimer, expor-
ter, envoyer par courriel page 173 pour plus d’informations.

Informations sur la section ou l’objet

Quand le curseur est dans une section, un titre, un élément de liste, ou quand un objet 
(comme une image, un tableau) est sélectionné, des informations à propos de l’élément s’af-
fichent dans ce champ. Double-cliquez dans cette zone pour ouvrir la boîte de dialogue cor-
respondante.

Objet Informations affichées Boîte de dialogue ouverte

Image Taille et position Image

Élément de liste Niveau et style de liste Puces et numérotation1

Titre Niveau de numérotation dans le plan Puces et numérotation1

Tableau Nom ou numéro et référence de la cellule 
où est le curseur

Propriétés du tableau

Section Nom de la section Éditer les sections

Autre (Vide) Champs

Disposition des pages

Cliquez sur l’icône appropriée pour modifier la disposition des pages : page simple, côte à 
côte ou livre (voir Figure 1.8). Vous pouvez éditer le document dans n’importe quel affichage.
Les paramètres du Zoom interagissent avec la disposition des pages sélectionnées pour dé-
terminer combien de pages seront visibles dans la fenêtre du document.

1 Si un style de liste a été utilisé avec un élément de liste ou un titre, aucune boîte de dialogue ne 
s’ouvre.
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Figure 1.8 . Disposition des pages (page simple, côte à côte, livre).

Zoom

Pour modifier le grossissement de l’affichage, faites glisser le curseur du zoom ou cliquez sur
les signes + et –. Vous pouvez également faire un clic droit sur le pourcentage du zoom pour
sélectionner une valeur de grossissement ou un clic gauche pour ouvrir la boîte de dialogue 
Zoom & disposition des pages. Les paramètres du zoom interagissent avec la disposition 
des pages sélectionnées pour déterminer combien de pages seront visibles dans la fenêtre 
du document.

Menus contextuels

Les menus contextuels offrent un accès rapide à de nombreuses fonctions. On les ouvre par un 
clic droit sur un paragraphe, une image ou un autre objet. Quand un menu contextuel s’ouvre, les 
fonctions et options disponibles dépendront de l’objet qui a été choisi. Un menu contextuel peut 
s’avérer le chemin le plus simple pour atteindre une fonction, surtout si vous n’êtes pas certain de 
son emplacement dans les menus et barres d’outils.

Boîtes de dialogue

Une boîte de dialogue est un type particulier de fenêtre qui a pour but de vous donner une informa-
tion, de vous demander une saisie ou les deux. Elle vous offre la possibilité de contrôler la façon 
dont une action est effectuée.

Dans la plupart des cas, vous n’avez accès qu’à la boîte de dialogue (pas au document lui-même) 
tant qu’elle reste ouverte. Quand vous refermez la boîte de dialogue (habituellement en cliquant 
sur OK ou un bouton semblable, vos modifications sont enregistrées puis la boîte se ferme ; en cli-
quant sur Annuler, vos modifications sont abandonnées puis la boîte se ferme) vous pouvez de 
nouveau travailler avec le document.
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Certaines boîtes de dialogue peuvent rester ouvertes pendant que vous travaillez pour vous per-
mettre d’aller et venir de l’un à l’autre. C’est par exemple le cas de la boîte de dialogue Recher-
cher & remplacer.

Affichage du document

Writer offre trois vues sur un document : l’affichage Normal, l’affichage Web et l’affichage Plein 
écran. Pour changer de vue, déroulez le menu Affichage et cliquez sur la vue désirée.

Vous pouvez aussi choisir Affichage > Zoom > Zoom… dans la barre de menu pour ouvrir la 
boîte de dialogue Zoom & disposition des pages, où vous pourrez définir les mêmes options que 
dans la barre d’état.

Vous pouvez aussi utiliser Fichier > Aperçu pour visualiser le document, mais cette vue ne per-
met pas sa modification. Voir « Aperçu des pages avant impression » au Chapitre 7 Imprimer, 
exporter, envoyer par courriel page 173.

Affichage Normal

L’affichage Normal est l’affichage par défaut de Writer. Il montre l’aspect du document quand vous 
l’imprimerez ou en ferez un fichier PDF. Dans cette vue, vous pouvez utiliser le curseur de Zoom et
les icônes de Disposition des pages de la barre d’état pour modifier l’agrandissement.

Dans la vue normale, vous pouvez masquer ou afficher les en-têtes et pieds de page ainsi que les 
espaces entre les pages. Pour les masquer, choisissez Affichage > Masquer les espaces vides 
depuis la barre de menu. Une coche apparaît en face de l’option. Quand elle est activée, les es-
paces vides, les en-têtes et pieds de page sont aussi masqués dans la vue Plein écran.

Affichage Web

L’affichage Web montre l’aspect que prendra le document dans un navigateur Web ; cela est utile 
quand vous créez des documents HTML. En mode de vue Web, vous ne pouvez utiliser que le 
curseur de Zoom. Les boutons de Disposition des pages de la barre d’état sont désactivés et la 
plupart des choix de la boîte de dialogue Zoom & disposition des pages ne sont pas disponibles.

Affichage plein écran

Dans ce mode de vue, aucune barre d’outils n’est affichée pas plus que le volet latéral ; le docu-
ment occupe toute la surface disponible, en utilisant le niveau de zoom et la disposition des pages 
préalablement choisis. Pour quitter le mode Plein écran et revenir au mode Normal ou au mode 
Web, appuyez sur la touche Échap, ou cliquez sur le bouton Plein écran de la barre d’outils flot-
tante en haut à gauche de l’écran. Vous pouvez aussi utiliser la combinaison de touches 
Ctrl+Maj+J pour entrer dans le mode Plein écran ou le quitter.

Créer un nouveau document

Dans Writer, vous disposez de plusieurs moyens pour créer un nouveau document vide. Si un do-
cument est déjà ouvert dans LibreOffice, le nouveau s’ouvrira dans une nouvelle fenêtre.
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Depuis le Centre de Démarrage

Quand LibreOffice est ouvert mais sans aucun document, il affiche le Centre de Démarrage. Cli-
quez sur le bouton Document Writer dans la rubrique Créer pour créer un nouveau document 
texte avec le modèle par défaut, ou cliquez sur le bouton Modèles pour choisir un autre modèle 
pour votre nouveau document.

Figure 1.9 : Le Centre de Démarrage de LibreOffice

À partir du menu du système d’exploitation

Vous pouvez ouvrir le centre de démarrage de LibreOffice ou le module Writer depuis le menu du 
système d’exploitation, de la même manière dont vous démarrez les autres programmes. Quand 
LibreOffice est installé sur votre ordinateur, dans la plupart des cas, une entrée de menu pour 
chaque module est ajoutée à votre menu système. Sous macOS, vous devriez voir l’icône 
LibreOffice dans le dossier Applications. Quand vous double-cliquez sur cette icône, LibreOffice 
s’ouvre sur le centre de démarrage (Figure 1.9).

À partir de la barre des menus, d’une barre d’outils ou du clavier

Quand LibreOffice est ouvert, vous pouvez également créer un nouveau document de l’une des fa-
çons suivantes :

• appuyez sur les touches Ctrl+N de votre clavier ;

• cliquez sur Fichier > Nouveau > Document texte dans la barre des menus ;

• cliquez sur le bouton Nouveau dans la barre d’outils Standard.
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À partir d’un modèle

Vous pouvez utiliser des modèles pour créer de nouveaux documents dans Writer. Un modèle est 
un ensemble de styles et formatages prédéfinis. Les modèles servent de fondement à un en-
semble de documents, pour être sûr qu’ils auront tous une mise en page similaire. Par exemple, 
tous les documents du Guide Writer sont basés sur le même modèle. En résultat, tous les docu-
ments se ressemblent ; ils ont tous les mêmes en-têtes et pieds de page, utilisent la même police, 
etc.

Lorsque LibreOffice vient d’être installé, peu de modèles sont disponibles. Il est possible d’ajouter 
de nouveaux modèles à votre installation et de les utiliser pour les nouveaux documents. De nom-
breux modèles sont téléchargeables sur https://extensions.libreoffice.org/templates et d’autres 
sites. Ceci est expliqué dans le Chapitre 10 Travailler avec les modèles page 263.

Pour ouvrir la boîte de dialogue Modèles où vous pourrez choisir celui que vous allez utiliser pour 
créer votre document, effectuez une des actions suivantes :

• appuyez sur Ctrl+Maj+N ;

• choisissez Fichier > Modèles > Gérer les modèles dans la barre de menu ;

• choisissez Fichier > Nouveau > Modèles dans la barre de menu ;

• cliquez sur la flèche vers le bas à droite du bouton Nouveau dans la barre d’outils Standard 
et choisissez Modèles dans la liste déroulante.

L’exemple présenté en Figure 1.10 utilise un modèle du dossier Mes modèles. Sélectionnez-le, 
puis cliquez sur le bouton Ouvrir. Un nouveau document est créé, basé sur les styles et formatage
définis dans le modèle.

Figure 1.10 : Créer un document depuis un modèle
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Ouvrir un document existant

Vous pouvez aussi ouvrir un document existant de l’une des façons suivantes :

Si aucun document n’est ouvert :

• cliquez sur Ouvrir un fichier ou sur Fichiers distants dans le Centre de Démarrage ;

• choisissez Fichier > Ouvrir… ou Fichier > Ouvrir un fichier distant… dans la barre de 
menu ;

• appuyez sur la combinaison de touches Ctrl+O ;

• faites un double clic sur la vignette d’un des documents récemment ouverts affichés dans le 
Centre de Démarrage. Vous pouvez faire défiler la liste de haut en bas pour localiser le docu-
ment que vous cherchez.

Si un document est déjà ouvert, vous pouvez :

• choisir Fichier > Ouvrir… dans la barre de menu ;

• cliquer sur le bouton Ouvrir  dans la barre d’outils Standard ;

• cliquer sur le petit triangle à droite du bouton Ouvrir et sélectionnez un document dans la 
liste déroulante des documents récemment ouverts ;

• cppuyer sur les touches Ctrl+O de votre clavier ;

• utiliser Fichier > Derniers documents utilisés pour afficher les 25 derniers fichiers qui ont 
été ouverts par l’un des modules de LibreOffice.

Dans tous les cas, la boîte de dialogue Ouvrir apparaît. Sélectionnez le fichier que vous désirez, 
puis cliquez sur Ouvrir. Si un document est déjà ouvert dans LibreOffice, le second document 
s’ouvrira dans une nouvelle fenêtre.

Dans la boîte de dialogue Ouvrir, vous pouvez restreindre la liste des fichiers en sélectionnant le 
type de fichier que vous recherchez. Par exemple, si vous choisissez Documents Texte comme 
type de fichier, vous ne verrez que les documents que Writer peut ouvrir (dont les formats *.odt, 
*.doc, *.txt). Cette méthode permet d’ouvrir les fichiers Word (*.doc et *.docx) aussi bien que les fi-
chiers LibreOffice et d’autres formats.

Vous pouvez aussi ouvrir un document Writer existant de la même façon que vous ouvrez les 
autres documents de votre système d’exploitation.

Si vous avez associé les formats de fichier Microsoft Office à LibreOffice, vous pouvez également 
ouvrir ces fichiers en faisant un double clic sur ceux-ci. Voir l’aide pour plus d’informations sur les 
associations de fichiers.

Enregistrer un document

Vous pouvez enregistrer un document en utilisant soit la commande Enregistrer, soit la commande
Enregistrer sous.

Commandes Enregistrer

Enregistrer un nouveau fichier ou un fichier précédemment sauvegardé

Effectuez une des opérations suivantes :
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• appuyez sur la combinaison de touches Ctrl+S ;

• choisissez Fichier > Enregistrer dans la barre de menu ;

• cliquez sur le bouton Enregistrer  dans la barre d’outils Standard.

Si le fichier n’a encore jamais été enregistré, une boîte de dialogue Enregistrer sous s’ouvre à la 
suite d’une des trois actions précédentes. Saisissez le nom du fichier, vérifier son type et son em-
placement puis cliquez sur Enregistrer.

Si le fichier a déjà été enregistré auparavant sous le même nom, avec le même type et au même 
emplacement, il n’y a rien de plus à faire.

Enregistrer sur un serveur distant

À utiliser si votre document est déjà stocké sur un serveur distant ou si vous voulez le faire. Choi-
sissez Fichier > Enregistrer sur le serveur distant… Quand la boîte de dialogue Enregistrer 
sous apparaît, saisissez ou vérifier le nom, le type et l’emplacement puis cliquez sur Enregistrer.

Voir « Ouvrir et enregistrer des fichiers sur des serveurs distants » page 32 pour plus d’infor-
mations.

Enregistrer une copie

À utiliser si vous désirez conserver le document ouvert pour en continuer l’édition tout en enregis-
trant une copie séparée de sa version actuelle.

Choisissez Fichier > Enregistrer une copie… Quand la boîte de dialogue Enregistrer sous appa-
raît, saisissez ou vérifier le nom, le type et l’emplacement puis cliquez sur Enregistrer. La copie 
n’est pas ouverte et le fichier d’origine reste ouvert et actif.

Tout enregistrer

À utiliser pour enregistrer tous les fichiers ouverts lors de la session de LibreOffice en cours.

Choisissez Fichier > Tout enregistrer. Tous les fichiers ouverts seront enregistrés sans change-
ment de nom, de type ni d’emplacement.

Commande Enregistrer sous

À utiliser si vous désirez enregistrer la version actuelle comme nouveau document en changeant le
nom, le type du fichier, ou l’emplacement où il est enregistré sur votre ordinateur.

Choisissez Fichier > Enregistrer sous…, ou utilisez Ctrl+Maj+S pour ouvrir la boîte de dialogue
Enregistrer sous dans laquelle vous pourrez modifier le nom, le type ou l’emplacement du fichier, 
puis cliquez sur Enregistrer.

Si vous voulez préserver le fichier d’origine, commencez par l’enregistrer comme décrit ci-dessus.

Remarque

LibreOffice utilise le terme « Exporter » pour certaines opérations sur les fichiers qui im-
pliquent un changement de format, comme les formats PDF et ePub. Voir le Chapitre 7 Im-
primer, exporter, envoyer par courriel page 173 pour plus d’informations.
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Enregistrement automatique d’un document

Writer peut enregistrer automatiquement, dans un dossier temporaire, votre document à intervalles
réguliers. L’enregistrement automatique, comme l’enregistrement manuel, écrase le dernier enre-
gistrement du fichier cible dans le dossier temporaire.

L’enregistrement automatique permet à LibreOffice, en cas d’arrêt brutal du programme (coupure 
de courant, plantage…), de recharger votre document dans un état proche de celui qui était le sien
au moment où LibreOffice s’est arrêté de manière impromptue. Cette option ne vous dispense 
donc pas de faire des enregistrements manuels régulièrement.

Pour activer l’enregistrement de fichier automatique :

 1) Sélectionnez Outils > Options > Chargement/enregistrement > Général. (Voir aussi le 
Chapitre 20 Paramétrer Writer page 545)

 2) Cliquez sur Enregistrer les informations de récupération automatique toutes les et choisissez
l’intervalle de temps. La valeur par défaut est de 10 minutes. Entrez la valeur de votre choix 
en la tapant ou en cliquant sur les flèches haut/bas.

 3) Vous pouvez aussi cocher l’option Toujours créer une copie de sauvegarde si vous le sou-
haitez.

 4) Cliquez sur OK pour enregistrer les modifications des paramètres.

Enregistrer comme un document Word

Dans le cas où votre correspondant ne peut vraiment pas ouvrir vos fichiers, vous pouvez enregis-
trer votre document en tant que fichier Word (*.doc ou *.docx).

 1) Important – Enregistrez tout d’abord votre document dans le format utilisé par LibreOffice
Writer (*.odt). Si vous ne le faites pas, toutes les modifications effectuées depuis votre der-
nier enregistrement apparaîtront uniquement dans la version Microsoft Word du document.

 2) Cliquez sur Fichier > Enregistrer sous… dans la barre des menus.

 3) La boîte de dialogue Enregistrer sous apparaît. Dans le menu déroulant Type (ou Enregistrer
comme type), sélectionnez le type de format Word qui vous convient. Vous pouvez aussi mo-
difier le nom du fichier.

 4) Cliquez sur Enregistrer.

! Attention

À partir de ce moment, toutes les modifications que vous apporterez au fichier auront lieu 
uniquement dans le document Microsoft Word. Vous avez changé le nom et le type de fi-
chier de votre document. Si vous voulez revenir en arrière pour travailler avec la version 
*.odt de votre document texte, vous devez l’ouvrir à nouveau.
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Conseil

Pour que Writer enregistre par défaut vos documents dans un format Microsoft Word, cli-
quez sur Outils > Options pour ouvrir la boîte de dialogue Options puis choisissez la page 
Chargement/enregistrement – Général. Dans la section intitulée Format de fichier par dé-
faut et paramétrages ODF, sous Type de document, sélectionnez Document texte, puis 
sous Enregistrer systématiquement sous, sélectionnez un format Microsoft Word (.doc).

Protection par mot de passe

Writer fournit deux niveaux de protection de document : protection en lecture (le fichier ne peut 
être visualisé sans mot de passe) et protection en écriture (le fichier peut être affiché en mode lec-
ture seule, mais ne peut être modifié sans mot de passe). Ainsi, vous pouvez rendre le contenu ac-
cessible en lecture pour un groupe de personnes ainsi qu’en lecture et en écriture pour un autre 
groupe. Ce comportement est compatible avec la protection de fichier Microsoft Word.

Pour protéger un document par des mots de passe :

 1) Utilisez Fichier > Enregistrer sous… pour enregistrer le document. (Vous pouvez égale-
ment utiliser Fichier > Enregistrer la première fois que vous enregistrez un nouveau docu-
ment.)

 2) Dans la boîte de dialogue Enregistrer sous, tapez le nom du fichier, cochez l’option Enregis-
trer avec mot de passe et cliquez sur Enregistrer (voir Figure 1.11).

Figure 1.11. Enregistrer avec un mot de passe.

 3) La boîte de dialogue Définir le mot de passe s’ouvre (voir Figure 1.12).

Vous avez ici plusieurs options :

 a) pour protéger le document en lecture, tapez un mot de passe dans les deux champs en 
haut de la boîte de dialogue,

 b) pour protéger le document en écriture, cliquez sur le bouton Options et cochez l’option 
Ouvrir le fichier en lecture seule.

 4) Pour protéger le document en écriture mais permettre à certaines personnes de le modifier, 
cochez l’option Ouvrir le fichier en lecture seule et tapez un mot de passe dans les deux 
champs de la partie Mot de passe de partage de fichier de la boîte de dialogue.

 5) Cliquez sur OK pour enregistrer le fichier. Si l’une des paires de mots de passe n’est pas co-
hérente, vous recevrez un message d’erreur. Fermez alors la boîte de message pour retour-
ner à la boîte de dialogue Définir le mot de passe, entrer à nouveau le mot de passe, puis 
confirmez-le.
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! Attention

LibreOffice utilise un mécanisme de cryptage très puissant qui rend le contenu presque im-
possible à retrouver si vous perdez le mot de passe.

Figure 1.12. Deux niveaux de protection par mot de passe.

Modifier le mot de passe d’un document

Lorsqu’un document est protégé par un mot de passe, vous pouvez modifier ce mot de passe pen-
dant que le document est ouvert. Choisissez Fichier > Propriétés > Général et cliquez sur le bou-
ton Modifier le mot de passe.

Ouvrir et enregistrer des fichiers sur des serveurs distants

LibreOffice peut ouvrir et enregistrer des fichiers stockés sur des serveurs distants (c’est-à-dire qui
ne sont ni dans votre ordinateur, ni dans votre réseau local). Cette fonctionnalité vous permet de 
travailler sur un document au bureau et d’y avoir accès chez vous ou ailleurs. Stocker les fichiers 
sur un serveur distant effectue aussi une sauvegarde des documents en mettant les données à 
l’abri de la perte de l’ordinateur ou de la panne du disque dur. Certains serveurs ont aussi la possi-
bilité de vérifier les fichiers qui entrent et qui sortent et donc de contrôler leur utilisation et leur ac-
cès.

LibreOffice est compatible avec de nombreux serveurs de documents qui utilisent des protocoles 
réseau bien connu, tels que FTP, WebDav, Windows share et SSH. Il reconnaît aussi des services 
populaires comme Google Drive et Microsoft OneNote, ainsi que les serveurs commerciaux et 
open source qui implémentent le standard CMIS d’OASIS.

Pour établir une liaison avec un serveur distant, utilisez une de ces méthodes :
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• cliquez sur le bouton Fichiers distants dans le Centre de Démarrage ;

• sélectionnez Fichier > Ouvrir un fichier distant… dans la barre de menu ;

• sélectionnez Fichier > Enregistrer le fichier distant… dans la barre de menu.

Puis cliquez sur le bouton Ajouter un service (Figure 1.14) dans la boîte de dialogue Fichiers dis-
tants pour ouvrir la boîte de dialogue Services de fichiers.

Selon le type de service que vous choisissez dans la liste déroulante Type, différents paramètres
sont  nécessaires  pour  qualifier  pleinement  la  connexion  au  serveur  distant  (Figure  1.13).  Ils
doivent vous être donnés par le fournisseur de service.

Figure 1.13 : Configuration du serveur distant

Une fois la connexion définie, cliquez sur OK pour vous connecter. La boîte de dialogue s’estompe
jusqu’à ce que la connexion avec le serveur soit établie. Une boîte de dialogue peut s’ouvrir pour
vous demander votre nom d’utilisateur et votre mot de passe avant de vous donner l’autorisation
d’accès au serveur. Saisissez-y vos références.

Figure 1.14 : La boîte de dialogue Fichiers distants connectée à un serveur

La boîte de dialogue Fichiers distants (Figure 1.14) qui apparaît possède plusieurs parties. La liste
déroulante Service contient la liste des serveurs distants que vous avez précédemment définis. La
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ligne sous cette liste montre le chemin d’accès au dossier. À gauche se trouve la structure des
dossiers de l’espace utilisateur sur le serveur. Le panneau principal affiche les fichiers dans le dos-
sier distant. Cliquez sur le bouton Ouvrir ou Enregistrer selon le cas.

Renommer et supprimer des fichiers

Vous pouvez renommer ou supprimer des fichiers depuis les  boîtes de dialogue de LibreOffice,
tout comme dans un gestionnaire de fichiers. Sélectionnez un fichier puis faites un clic droit pour
ouvrir  un menu contextuel.  Sélectionnez soit  Supprimer soit  Renommer à  votre convenance.
Vous ne pouvez cependant ni copier ni coller des fichiers depuis les boîtes de dialogue comme
vous le feriez dans un gestionnaire de fichiers.

Utiliser le navigateur

En plus du champ Numéro de page de la barre d’état (voir page 21), Writer propose d’autres fa-
çons de se déplacer rapidement à travers un document et de trouver des éléments spécifiques en
utilisant les nombreuses fonctionnalités du navigateur, de la barre d’outils Navigation et des icônes
correspondantes.

Dans l’installation par défaut de  LibreOffice, le navigateur fait partie du  volet latéral. Il répertorie
tous les titres, tableaux, cadres de texte, images, repères de texte, et autres objets contenus dans
un document.

Figure 1.15 : Le Navigateur dans le volet latéral

Pour ouvrir le Navigateur, effectuez une des actions suivantes :

• cliquez sur l’onglet du Navigateur dans la barre d’onglets à la droite du volet latéral ;

• cliquez sur l’icône  dans la barre d’outils Standard ;

• appuyez sur la touche F5 de votre clavier ;
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• cliquez sur Affichage > Navigateur dans la barre des menus ;

• double-cliquez sur le champ Numéro de page dans la barre d’état.

Cliquez sur la marque (+ ou triangle) à côté d’une catégorie pour afficher la liste des objets qu’elle 
contient.

Pour masquer la liste des catégories et afficher uniquement la barre d’outils en haut, cliquez sur 

l’icône Afficher/Masquer la zone de liste . Cliquez de nouveau sur l’icône pour afficher la 
zone de liste. Cette icône n’apparaît pas dans le navigateur ancré dans le volet latéral.

Le Tableau 2 répertorie les fonctions des icônes du haut du Navigateur.

Remarque

Dans un document maître, le Navigateur possède des fonctions différentes. Voir le Chapitre 
16 Les documents maîtres, page 445.

Tableau 2 : Fonctions des icônes dans le Navigateur

Navigation. Ouvre la barre d’outils Navigation (voir page 36).

 

Précédent – Suivant. Saute à l’élément précédent ou suivant dans la catégorie sélec-
tionnée (page, image, hyperlien, commentaire, etc). Pour sélectionner une catégorie 
d’éléments, voir la section « Utiliser la barre d’outils Navigation » page 36.

Numéro de page. Saute au numéro de page indiqué dans le champ. Saisissez le nu-
méro de page ou sélectionnez-le en utilisant les flèches haut/bas.

Mode glisser. Choisissez Insérer comme hyperlien, Insérer comme lien ou Insérer 
comme copie. Voir la section « Choisir un mode glisser » page 38 pour plus de dé-
tails.

 
Déplacer d’un chapitre vers le haut/bas : déplace les titres et le texte dans le docu-
ment. Voir « Réorganiser des chapitres en utilisant le Navigateur » page 37.

Afficher/masquer la zone de liste. Affiche ou masque la liste des catégories dans la 
fenêtre du Navigateur. Cette icône n’apparaît pas dans le Navigateur ancré dans le vo-
let latéral.

Affichage du contenu. Bascule entre l’affichage de toutes les catégories ou de celle 
sélectionnée seulement.

Définir un pense-bête. Insère un pense-bête (voir page 38).

 
En-tête/Pied de page. Navigue entre la zone de texte et l’en-tête ou le pied de page (si
la page en contient).

Ancre <-> Texte. Navigue entre l’ancre d’une note de bas de page et la note de bas de 
page correspondante.

Niveaux de titres affichés. Choisissez le nombre de niveaux de titres affichés.

 
Hausser/abaisser un niveau : modifie de façon rapide les niveaux des titres dans le 
document. Voir « Réorganiser des chapitres en utilisant le Navigateur » page 37.

Se déplacer rapidement dans un document

Le Navigateur propose plusieurs méthodes pour se déplacer facilement dans un document et y re-
trouver des éléments.
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• Pour se rendre à une page spécifique dans le document, tapez le numéro de séquence dans
la case en haut du Navigateur et appuyez sur la touche Entrée. Ce numéro peut être diffé-
rent du numéro de page si vous avez recommencé la numérotation des pages à un ou plu-
sieurs endroits du document.

• Quand la liste des éléments d’une catégorie est affichée, double-cliquez sur un élément pour
vous rendre directement à son emplacement dans le document. Par exemple, vous pouvez 
vous rendre directement à un titre, une image, ou un commentaire en utilisant cette méthode.

• Pour afficher le contenu d’une seule catégorie, mettez en surbrillance cette catégorie et cli-
quez sur l’icône Affichage du contenu . Cliquez de nouveau sur l’icône pour afficher 
toutes les catégories. Vous pouvez également modifier le nombre de niveaux de titre affichés
lors de l’affichage des titres.

• Utilisez les icônes Précédent et Suivant pour atteindre les autres objets du type sélectionné 
dans la barre de navigation (Voir page 36 pour plus de détails.)

Remarque

Une section cachée (ou tout autre objet caché) dans un document apparaît grisée dans le 
navigateur et affiche le mot « caché » en infobulle. Pour plus d’informations sur les sections 
cachées, référez-vous au Chapitre 6 Mise en page : approfondissements page 143.

Conseil
Les objets sont plus simples à trouver si vous leur avez donné un nom lors de leur création, 
au lieu de garder les noms par défaut de LibreOffice – comme Image1, Image2, Tableau1, 
Tableau2, etc. – qui ne correspondent pas toujours à leur position réelle dans le document.

Vous pouvez aussi renommer les objets après les avoir insérés. Par exemple, pour renom-
mer une image, faites un clic droit sur son nom dans le Navigateur, Choisissez Image dans 
le menu contextuel puis Renommer. La vue saute à l’image en question (de cette façon 
vous pouvez voir de laquelle il s’agit) et une petite boîte de dialogue s’affiche. Tapez un nou-
veau nom pour l’image puis cliquez sur OK pour l’enregistrer.

Vous pouvez aussi faire un clic droit sur l’image et sélectionner Propriétés dans le menu 
contextuel. Dans la boîte de dialogue Image, ouvrez l’onglet Options, modifiez le nom et cli-
quez sur OK.

Utiliser la barre d’outils Navigation

Pour afficher la barre d’outils Navigation (voir Figure 1.16), cliquez sur l’icône Navigation  
(icône en haut à gauche du navigateur, voir Figure 1.15).

Figure 1.16 : Barre d’outils Navigation
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La barre de navigation affiche les icônes de tous les types d’objets affichés dans le Navigateur, 
plus quelques extras (par exemple, le résultat de la commande Rechercher). Voir la Figure 1.16.

Cliquez sur une icône pour sélectionner le type d’objet. Après cette manipulation, les icônes Pré-
cédent et Suivant (dans le Navigateur lui-même, dans la barre de Navigation et dans la barre 
d’outils Rechercher) atteindront le prochain objet du type sélectionné. C’est particulièrement pra-
tique pour trouver des éléments comme les entrées d’index qui peuvent être difficiles à voir dans le
texte. Les noms des icônes (affichés dans les infobulles) sont modifiés pour correspondre à la ca-
tégorie sélectionnée ; par exemple Image suivante ou Repère de texte suivant.

Tableau 3 : Boutons de la barre d’outils Navigation

Tableau Cadre de texte Images Objet OLE

Page Titres Pense-bête Dessin

Contrôle [Formu-
laire]

[Objet] Précédent Section Repère de texte

Sélection
Note de bas de 
page

Commentaire
Répéter la re-
cherche

Entrée d’index
Formule de ta-
bleau

Formule de ta-
bleau erronée

[Objet] Suivant

Réorganiser des chapitres en utilisant le Navigateur

Vous pouvez réorganiser des chapitres et déplacer les titres dans le document en utilisant le Navi-
gateur.

 1) Cliquez sur l’icône Affichage du contenu  pour développer les titres, si nécessaire.

 2) (Facultatif) Si vous avez plusieurs niveaux de sous-titres, vous trouverez plus facilement les 
titres recherchés en modifiant le nombre de niveaux de titres affichés à 1 ou 2 niveaux de 
titres.

 3) Cliquez sur le titre du bloc de texte que vous souhaitez déplacer et tirez le titre à son nouvel 
emplacement dans le Navigateur. Ou cliquez sur titre dans la liste du Navigateur, puis cli-
quez sur l’icône Déplacer d’un chapitre vers le haut  ou Déplacer d’un chapitre vers 
le bas . Tout le texte et les sous-sections sous le titre sélectionné se déplacent avec lui.

Pour déplacer uniquement le titre sélectionné et non les sous-titres associés, maintenez la touche 
Ctrl enfoncée, puis cliquez sur l’icône Déplacer vers le haut ou Déplacer vers le bas.

Pour modifier rapidement le niveau hiérarchique d’un titre :

• Pour modifier le niveau hiérarchique d’un titre et des sous-titres associés, sélectionnez le 
titre dans le Navigateur et cliquez sur l’icône Hausser d’un niveau  ou Abaisser d’un ni-
veau . Cette action ne modifie pas l’emplacement du titre, seulement son niveau.

• Pour modifier le niveau hiérarchique du titre sélectionné uniquement, et non des sous-titres 
associés, maintenez la touche Ctrl enfoncée et cliquez sur l’icône Hausser d’un niveau ou
Abaisser d’un niveau.

Remarque

Les utilisateurs de MS Office Word noteront la similitude entre cette fonctionnalité et le mode
Plan dans Word.
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Définir un pense-bête

Une des fonctionnalités peu connues de Writer que vous pourrez trouver très utile est la possibilité 
de naviguer parmi des pense-bêtes. Les Pense-bêtes vous permettent de marquer des emplace-
ments de votre document auxquels vous voulez pouvoir revenir plus tard, pour ajouter ou corriger 
une information, faire d’autres changements, ou simplement marquer l’endroit où vous avez stoppé
l’édition. Les utilisations possibles des pense-bêtes ne sont limitées que par votre imagination.

Pour définir un pense-bête à l’emplacement actif du curseur, cliquez sur l’icône Définir un pense-
bête  dans le Navigateur. Vous pouvez définir jusqu’à 5 pense-bêtes dans un document. En dé-
finir un sixième entraîne la suppression du premier.

Les pense-bêtes ne sont pas mis en évidence dans le document, ni listés dans le Navigateur. Par 
conséquent, vous ne pouvez pas voir où ils sont, excepté en naviguant de l’un à l’autre – la posi-
tion du curseur montre alors la position du pense-bête.

Pour naviguer entre les pense-bêtes, sélectionnez d’abord l’icône Pense-bête dans la barre d’ou-
tils Navigation. Cliquez ensuite sur les icônes Précédent et Suivant. Les pense-bêtes ne sont pas 
enregistrés avec le document.

Choisir un mode glisser

Sélectionnez les options de cliquer-glisser (le cliquer-glisser est également appelé le cliquer-dépo-
ser) dans le menu Mode glisser  pour insérer des éléments (comme d’autres documents, 
images, etc.) dans un document en utilisant le Navigateur.

Insérer comme hyperlien

Crée un hyperlien lorsque vous cliquez sur un élément et que vous le faites glisser dans le 
document actif.

Insérer comme lien

Insère l’élément sélectionné comme un lien là où vous le faites glisser dans le document ac-
tif. Quand l’élément d’origine est modifié, le changement est reporté dans le document en 
cours. Inversement, l’élément copié est protégé et ne peut pas être modifié directement dans
ce document. Notez que vous ne pouvez pas créer de liens pour des images, des objets 
OLE, des références, ou des index en utilisant cette méthode.

Insérer comme copie

Insère une copie de l’élément sélectionné là où vous le faites glisser dans le document. Vous
ne pouvez pas insérer de cette manière des copies d’images, d’objets OLE, ou d’index.

Annuler et rétablir des modifications

Lorsqu’un document est ouvert, vous pouvez annuler la/les modifications la/les plus récente(s) de 
plusieurs manières :

• appuyez sur les touches Ctrl+Z de votre clavier ;

• dans la barre d’outils Standard, cliquez sur l’icône Annuler  ;

• cliquez sur Édition > Annuler dans la barre des menus.

Le menu Édition affiche les dernières modifications qui peuvent être annulées (voir Figure 1.17).
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Figure 1.17 : Menu Édition : Annuler la dernière action

Cliquez sur le triangle à droite de l’icône Annuler pour obtenir la liste des actions qui peuvent être 
annulées. Vous pouvez sélectionner plusieurs changements et les annuler en même temps (voir
Figure 1.18).

Figure 1.18 : Liste des actions qui peuvent être annulées.

Après l’annulation de modifications, la fonction Rétablir devient active. Vous pouvez rétablir la/les 
modification(s) de plusieurs manières :

• appuyez sur les touches Ctrl+Y de votre clavier ;

• dans la barre d’outils Standard, cliquez sur l’icône Rétablir  ;

• cliquez sur Édition > Rétablir dans la barre des menus.

Comme pour la fonction Annuler, cliquez sur le triangle à droite du bouton Rétablir dans la barre 
d’outils Standard pour obtenir la liste des modifications qui peuvent être rétablies.

Recharger un document

Il se peut que vous désiriez abandonner toutes les modifications faites depuis le dernier enregistre-
ment du document. Mais annuler chaque changement et se souvenir de leurs emplacements peut 
être une tâche difficile. Si vous êtes certain de ne pas vouloir conserver les modifications effec-
tuées depuis le dernier enregistrement, vous pouvez recharger celui-ci. Une copie stockée dans le 
système de fichier est chargée. Le document revient à l’état où il a été enregistré pour la dernière 
fois.

Pour recharger un document, sélectionnez Fichier > Recharger sur la barre de menu. Une boîte 
de dialogue de confirmation vous avertit que vous allez abandonner toutes les dernières modifica-
tions. Dans ce cas, la boîte de dialogue Ouvrir ne s’ouvre pas, car le fichier est déjà sélectionné.
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Fermer un document

Si un seul document est ouvert et que vous voulez le fermer, sélectionnez Fichier > Fermer sur la 
barre de menu ou cliquez sur la croix à droite ou à gauche de celle-ci. Sous Windows et Linux, le 
document se ferme et le Centre de démarrage de LibreOffice s’ouvre. Sous Mac OS X, le docu-
ment se ferme et la barre de menu reste seule en haut de l’écran.

Si plusieurs documents sont ouverts et que vous désirez en fermer un, sélectionnez Fichier > Fer-
mer sur la barre de menu ou cliquez sur le X sur la barre de titre de la fenêtre de ce document. Ce 
X peut être situé à l’extrémité droite ou gauche de la barre de titre. Quand seul le dernier docu-
ment reste ouvert, le X de la barre de menu disparaît.

Si le document n’a pas été enregistré depuis la dernière modification, une boîte de message s’af-
fiche. Choisissez d’enregistrer ou d’abandonner vos changements.

! Attention

Si vous n’enregistrez pas votre document, vous risquez de perdre les modifications récentes
ou, encore pire, tout le fichier.

Fermer LibreOffice

Pour fermer complètement LibreOffice sous les systèmes d’exploitation Windows et Linux, sélec-
tionnez Fichier > Quitter LibreOffice sur la barre de menu. Sous un système d’exploitation Mac, 
sélectionnez LibreOffice > Quitter LibreOffice sur la barre de menu.

Quand vous fermez le dernier document grâce au X sur la barre de titre de la fenêtre, LibreOffice 
se ferme complètement. Le système d’exploitation des MacOS n’a pas cette fonction ; à la place, il
faut utiliser LibreOffice > Quitter LibreOffice.

Vous pouvez aussi utiliser un raccourci au clavier comme ceci :

• sous Windows et Linux – Ctrl+Q ;

• sous Mac OS X – Commande ⌘+Q.

Si un document n’a pas été enregistré depuis la dernière modification, une boîte de message s’af-
fiche. Choisissez d’enregistrer ou d’abandonner vos changements.
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Introduction

Ce chapitre présente les bases du travail avec le texte dans Writer, le module de traitement de 
texte de LibreOffice. Il suppose que vous êtes familiarisé avec l’utilisation de la souris et du clavier 
et que vous avez lu dans le Chapitre 1 Introduction à Writer, ce qui concerne les menus, les barres
d’outils et les autres sujets présentés.

Nous vous recommandons aussi d’activer les aides à la mise en forme, telles que les marques de 
fin de paragraphe, les tabulations, les sauts et autres éléments dans la page LibreOffice Writer – 
Aides au formatage de la boîte de dialogue Options (cliquez sur Outils > Options dans la barre de
menu). Voir le Chapitre 20 Paramétrer Writer page 545 pour plus d’informations.

Quand vous aurez lu ce chapitre, vous devriez savoir comment :

• sélectionner, couper, copier, coller et déplacer du texte ;

• chercher et remplacer du texte ;

• insérer des caractères spéciaux ;

• vérifier l’orthographe et la grammaire, utiliser le dictionnaire des synonymes et choisir les op-
tions de coupure de mots ;

• utiliser l’autocorrection, l’insertion automatique, l’AutoTexte et les fonctions changement de 
casse.

Vous trouverez, au chapitre 3, d’autres outils et techniques relatifs au travail avec le texte et, au 
chapitre 4, les méthodes de mise en forme du texte.

Sélectionner du texte

Avant que vous ne puissiez faire quoi que ce soit avec du texte, vous devez le sélectionner. La sé-
lection du texte dans Writer s’effectue de la même manière que la sélection dans les autres appli-
cations. Vous pouvez le faire en tirant le pointeur de la souris sur le texte ou par des clics multiples
pour sélectionner un mot (double clic), une phrase (triple clic) ou un paragraphe (quadruple clic).

Vous pouvez aussi cliquer dans le texte, appuyer sur la touche F8 pour entrer en mode « Sélection
étendue » puis utiliser les touches fléchées du clavier pour sélectionner un bloc contigu de texte.

En plus de sélectionner des blocs de textes, vous pouvez sélectionner des éléments qui ne sont 
pas consécutifs et des colonnes (blocs verticaux) de texte.

Une façon de changer le mode de sélection consiste à utiliser l’icône de la barre d’état  (voir
Barre d’état  dans le chapitre 1 page 21). Quand vous cliquez sur celle-ci, un menu contextuel af-
fiche les options disponibles : sélection Standard, sélection Étendue (F8), Ajout à la sélection 
(Maj+F8) et Sélection par bloc (Ctrl+Maj+F8).

Sélectionner des éléments disjoints

Pour sélectionner des éléments disjoints (voir Figure 2.1) en utilisant le clavier et la souris :

 1) Sélectionnez le premier morceau de texte.

 2) Maintenez la touche Ctrl enfoncée et utilisez la souris pour sélectionner le morceau de 
texte suivant.

 3) Répétez l’opération autant de fois que nécessaire.
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Vous pouvez travailler avec le texte sélectionné (le copier, le supprimer, en changer le style, etc.).

Pour sélectionner des éléments disjoints en utilisant uniquement le clavier :

 1) Sélectionnez le premier morceau de texte. Pour sélectionner du texte à l’aide du clavier, 
maintenez la touche Maj enfoncée et utilisez les flèches de direction. (Pour plus d’informa-
tions sur la sélection de texte au clavier, voir l’article « Navigation et sélection à l’aide du cla-
vier » dans l’Aide de LibreOffice (F1)).

 2) Appuyez sur les touches Maj+F8 de votre clavier afin d’activer le mode Ajout à la sélection 
de Writer.

 3) Utilisez les touches de direction de votre clavier pour vous déplacer au début du morceau de
texte suivant à sélectionner. Maintenez la touche Maj enfoncée et sélectionnez le morceau 
de texte suivant.

 4) Répétez l’opération autant de fois que nécessaire.

Pour quitter le mode Ajout à la sélection, appuyez sur les touches Maj+F8 ou la touche Échap de 
votre clavier.

Figure 2.1 : Sélectionner des éléments qui ne sont pas proches les uns des autres

Sélectionner un bloc de texte vertical

En utilisant le mode Sélection par bloc, vous pouvez sélectionner un bloc vertical ou une “colonne” 
de texte qui est séparée par des espaces ou des tabulations (comme on peut le rencontrer dans le
texte collé depuis des courriels, des listings ou d’autres sources). Pour activer le mode Sélection 
par bloc, cliquez sur le menu Édition > Mode sélection > Zone de bloc, ou sur l’icône Sélection

dans la barre d’état (voir Figure 2.2). Vous pouvez également appuyer sur les touches 
Ctrl+Maj+F8 de votre clavier.
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Icône de sélection

Figure 2.2 : Activer le mode de sélection par bloc grâce à la barre d’État

Vous pouvez maintenant mettre en surbrillance la sélection en utilisant la souris ou le clavier (voir
Figure 2.3).

Figure 2.3 : Sélectionner un bloc de texte vertical

Couper, copier et coller du texte

Couper et coller du texte dans Writer s’effectue de la même manière que dans les autres pro-
grammes. Vous pouvez copier/déplacer du texte à l’intérieur d’un même document, ou d’un docu-
ment vers un autre document, en glissant le texte, en utilisant les sélections du menu, les icônes
ou les raccourcis  clavier.  Vous pouvez également copier  du texte provenant  d’autres sources,
telles que des pages Web, et les coller dans un document Writer.

Pour déplacer (couper et coller) le texte sélectionné en utilisant la souris, cliquez sur le texte sélec-
tionné et faites-le glisser vers son nouvel emplacement. Pour copier le texte sélectionné en utili -
sant la souris, maintenez enfoncée la touche Ctrl de votre clavier pendant que vous faites glisser
le texte vers son nouvel emplacement. Le formatage du texte copié est préservé.

Après avoir sélectionné du texte, vous pouvez également le couper, le copier et coller du texte de 
l’une des manières suivantes.

Couper : utilisez le menu Édition > Couper ou le raccourci clavier Ctrl+X ou l’icône 
Couper de la barre d’outils Standard.

Copier : utilisez le menu Édition > Copier ou le raccourci clavier Ctrl+C ou l’icône Co-
pier de la barre d’outils Standard.

Coller : utilisez le menu Édition > Coller ou le raccourci clavier Ctrl+V ou l’icône Coller 
de la barre d’outils Standard.

Le résultat d’une opération de collage dépend de la source du texte à coller. Si vous cliquez sim-
plement sur l’icône Coller, quel que soit le formatage du texte (tel que gras ou italique), il est pré-
servé.  Le texte collé  des sites Web ou d’autres sources peut  également  être placé dans des
cadres ou dans des tableaux. Si le résultat ne vous paraît pas satisfaisant, cliquez sur l’icône An-
nuler ou appuyez sur Ctrl+Z).

Pour que le texte collé hérite du style du paragraphe au point d’insertion :

• cliquez sur le menu Édition > Collage spécial ;

• cliquez sur le triangle situé à droite de l’icône Coller dans la barre d’outils Standard ;
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• cliquez sur l’icône Coller sans relâcher le bouton gauche de la souris ;

• appuyez sur les touches Ctrl+Maj+V de votre clavier.

Cliquez ensuite sur Texte non formaté dans la boîte de dialogue ou le menu déroulant.

L’étendue des choix dans le menu Collage spécial varie en fonction de l’origine et du formatage 
du texte (ou des autres objets) à coller. Voir la Figure 2.4 pour un exemple de texte du presse-pa-
piers.

Figure 2.4 : Menu et boîte de dialogue Collage spécial.

Rechercher et remplacer du texte et du formatage

Writer propose deux méthodes pour trouver du texte dans un document : la barre d’outils Recher-
cher pour une recherche rapide et la boîte de dialogue Rechercher & Remplacer. Dans la boîte de 
dialogue Rechercher & Remplacer, vous pouvez :

• trouver et remplacer des mots ainsi que des phrases ;

• utiliser les caractères génériques et les expressions régulières pour affiner la recherche (voir 
le chapitre 3 page 75) ;

• rechercher et remplacer des formatages spécifiques (voir le chapitre 3 page 75) ;

• rechercher et remplacer des styles de paragraphe (voir le chapitre 3 page 74).

Utiliser la barre d’outils Rechercher

Si la barre d’outils Rechercher n’est pas visible, vous pouvez l’afficher en cliquant sur le menu Affi-
chage > Barres d’outils > Rechercher ou en appuyant sur les touches Ctrl+F de votre clavier. 
Par défaut, la barre d’outils Rechercher est ancrée au bas de la fenêtre de LibreOffice, juste au-
dessus de la barre d’état (voir Figure 2.5). Vous pouvez également la rendre flottante ou l’ancrer à 
un autre endroit. Pour plus d’information sur les Barres d’outils flottantes et ancrées, référez-vous 
au chapitre 1, Introduction à Writer, page 19.

46 | Guide de LibreOffice Writer Rechercher et remplacer du texte et du formatage



 Chapitre 2 Travailler avec le texte : les bases

Figure 2.5 : La barre d’outil Rechercher en position ancrée par défaut

Pour utiliser la barre d’outils Rechercher, cliquez dans le champ et saisissez le texte à rechercher. 
Appuyez ensuite sur la touche Entrée de votre clavier pour trouver l’occurrence suivante du texte 
saisi. Cliquez sur les boutons Rechercher le précédent  ou Rechercher le suivant  en 
fonction de vos besoins.

Cliquez sur le bouton Tout rechercher pour sélectionner toutes les occurrences de texte conte-
nues dans le document. Cochez l’option Respecter la casse pour rechercher uniquement les oc-
currences qui correspondent strictement au terme recherché en termes de majuscules et de mi-
nuscules. Cliquez sur le bouton Rechercher & remplacer à droite de l’option Respecter la casse 
pour ouvrir la boîte de dialogue Rechercher & remplacer.

Déroulez la liste Naviguer par pour vous déplacer dans le document en passant d’un élément à 
l’autre en cliquant sur les boutons [Élément] précédent  ou [Élément] suivant . Les élé-
ments parmi lesquels vous pouvez naviguer sont Titres, Pense-bête, Dessin, Contrôle, Section, 
Repère de texte, Sélection, Note de bas de page, Commentaire, Répéter la recherche, Entrée d’in-
dex, Formule de tableau et Formule de tableau erronée.

La barre d’outils Rechercher peut être fermée en cliquant sur la croix rouge à gauche  ou en ap-
puyant sur la touche Échap de votre clavier lorsque le curseur se trouve dans la zone de re-
cherche. Le raccourci Ctrl+F affiche et masque alternativement la barre d’outils.

Utiliser la boîte de dialogue Rechercher & remplacer

Pour afficher la boîte de dialogue Rechercher & remplacer, cliquez sur le menu Édition > Recher-
cher & remplacer, appuyez sur les touches Ctrl+H de votre clavier ou cliquez sur le bouton Re-
chercher & remplacer ( ) dans la barre d’outils Rechercher ou la barre d’outils Standard. Pour 
obtenir plus d’options, cliquez sur le bouton Plus d’options de la boîte de dialogue (voir Figure 
2.6). Des choix supplémentaires s’affichent quand les options Asiatique et Mise en page de texte 
complexe ont été cochées dans la page Paramètre linguistiques – Langues de la boîte de dialogue
Options (cliquez sur Outils > Options dans la barre de menu pour l’ouvrir).

Pour utiliser la boîte de dialogue Rechercher & remplacer :

 1) Saisissez le texte que vous souhaitez trouver dans le champ Rechercher.

 2) Pour remplacer le texte recherché avec un texte différent, saisissez le nouveau texte dans le
champ Remplacer.

 3) Vous pouvez sélectionner des options telles que  Respecter la casse,  Mots entiers unique-
ment ou Rechercher des similarités.

L’utilisation des autres options est décrite au chapitre 3 page 72.

 4) Lorsque vous avez défini votre recherche, cliquez sur le bouton Rechercher le suivant. 
Pour remplacer le texte, cliquez sur le bouton Remplacer.
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Conseil

Si vous cliquez sur le bouton Tout rechercher, Writer sélectionne toutes les occurrences du
texte recherché dans le document. De la même façon, si vous cliquez sur le bouton Tout 
remplacer, Writer remplace toutes les occurrences, sans vous en demander confirmation à 
chaque fois.

! Attention

Utilisez le bouton Tout remplacer avec précaution ; vous pourriez provoquer des erreurs 
embarrassantes. Une erreur avec le bouton Tout remplacer peut nécessiter une recherche 
manuelle, mot par mot, pour la corriger si elle n’est pas découverte à temps pour l’annuler.

Figure 2.6 : La boîte de dialogue Rechercher & remplacer avec les options supplémentaires.

Insérer des caractères spéciaux

Un Caractère spécial  est  un caractère qui  n’est  pas présent  sur  un clavier  standard de votre
langue. Par exemple, © ¾ æ ç Ł ñ ö ø ¢ sont des caractères spéciaux. Pour insérer un caractère
spécial :

 1) Placez le curseur de la souris à l’endroit où vous souhaitez insérer le caractère spécial dans 
votre document.

 2) Cliquez sur le menu Insertion > Caractères spéciaux…  ou sur l’icône Insérer un carac-
tère spécial ( ) dans la barre d’outil principale pour ouvrir la boîte de dialogue Caractères 
spéciaux (voir Figure 2.7).

 3) Pour insérer plusieurs caractères, faites un double clic sur les caractères (de n’importe 
quelle police ou sous-ensemble) que vous souhaitez insérer pour qu’ils apparaissent dans le 
document. Les caractères sélectionnés apparaissent aussi dans la liste des Caractères ré-
cents en bas à gauche de la boîte de dialogue. Un clic droit sur l’un des caractères récents 
permet de le supprimer ou d’effacer totalement l’historique.
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Pour insérer un caractère et refermer la boîte de dialogue, cliquez sur celui-ci puis sur le 
bouton Insérer.

Conseils
Pour visualiser les détails d’un caractère, faites un simple clic sur celui-ci ; il apparaît dans la 
zone d’aperçu à droite de la boîte de dialogue avec ses codes numériques.

Différentes polices incluent différents caractères spéciaux. Si vous ne trouvez pas un carac-
tère spécial particulier, essayez de changer la Police.

La commande Rechercher & Remplacer permet l’accès aux caractères spéciaux par un clic 
droit dans les zones Rechercher et Remplacer par.

Figure 2.7 : La boîte de dialogue Caractères spéciaux

Insérer des espaces et des tirets insécables

Espaces insécables

Afin d’éviter que deux mots ne soient séparés à la fin d’une ligne, appuyez sur les touches 
Ctrl+Maj de votre clavier lorsque vous saisissez l’espace entre les deux mots.

Tirets insécables

Vous pouvez utiliser un tiret insécable dans le cas où vous ne souhaitez pas que le trait 
d’union apparaisse à la fin d’une ligne (par exemple : dans un nombre tel que 123-4567). 
Pour insérer un tiret insécable, appuyez sur les touches Ctrl+Maj+signe moins de votre 
clavier numérique.
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Les espaces et les tirets insécables peuvent également être insérés via le menu Insertion > 
Marque de formatage.

Insérer des tirets cadratins et demi-cadratins

Pour saisir des tirets cadratins (tirets longs) et demi-cadratins (tirets), vous pouvez utiliser l’option 
Remplacer les tirets (active par défaut) dans l’onglet Options de la boîte de dialogue Options 
d’AutoCorrection (cliquez sur Outils > Options d’AutoCorrection dans la barre de menu). Cette 
option remplace deux tirets sous certaines conditions par le tiret correspondant.

– est un tiret demi-cadratin qui a la largeur de la lettre « n » dans la police utilisée. Tapez au 
moins un caractère, un espace, un ou deux signes moins, un deuxième espace et au moins 
une lettre supplémentaire. Le(s) signe(s) moins sera (seront) remplacé(s) par un tiret demi-
cadratin.

— est un tiret cadratin qui a la largeur de la lettre « m » dans la police utilisée. Tapez au moins 
un caractère, deux signes moins et au moins un caractère supplémentaire. Les signes moins
seront remplacés par un tiret cadratin. Exception : si les caractères sont des chiffres, comme 
dans un intervalle de dates ou de temps, les deux signes moins sont remplacés par un tiret 
demi-cadratin.

Dans le Tableau 4 ci-après, A et B représentent du texte en lettres de A à Z ou des chiffres de 0 à 
9.

Tableau 4 : Insérer des tirets

Texte que vous saisissez Résultat

A - B (A, espace, signe moins, espace, B) A – B (A, espace, tiret demi-cadratin, espace, B)

A -- B (A, espace, signe moins, signe moins, es-
pace, B)

A – B (A, espace, tiret demi-cadratin, espace, B)

A--B (A, signe moins, signe moins, B) A—B (A, tiret cadratin, B)

1--2 (chiffre, signe moins, signe moins, chiffre) 1–2 (chiffre, tiret demi-cadratin, chiffre)

A-B (A, signe moins, B) A-B (inchangé)

A -B (A, espace, signe moins, B) A -B (inchangé)

A --B (A, espace, signe moins, signe moins, B) A –B (A, espace, tiret demi-cadratin, B)

Il est également possible d’insérer des tirets cadratins ou demi-cadratins à partir de la boîte de dia-
logue Caractères spéciaux (voir page 48). Sélectionnez-y le caractère U+2013 ou U+2014 (dans le
sous-ensemble Ponctuation générale).

Une troisième méthode utilise les raccourcis claviers. Ces raccourcis varient suivant votre système
d’exploitation.

Conseil

Vous pouvez aussi enregistrer des macros pour insérer des tirets demi-cadratins et cadra-
tins et assigner ces macros à des combinaisons de touches non utilisées, par exemple 
Ctrl+Maj+N et Ctrl+Maj+M. Pour plus d’informations sur les macros, référez-vous au 
chapitre 21, Personnaliser Writer, page 575.
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Windows

Sur la plupart des versions non asiatiques de Windows, maintenez enfoncée l’une des 
touches Alt de votre clavier et tapez sur le clavier numérique 0150 pour un tiret demi-cadra-
tin ou 0151 pour un tiret cadratin. Le tiret apparaît quand vous relâchez la touche Alt.

Astuce
Sur un clavier sans pavé numérique, utilisez la touche Fn (Fonction) en combinaison pour ta-
per les chiffres (la touche Fn est habituellement à la droite de la touche Ctrl gauche du cla-
vier).

Par exemple, sur un clavier français, la combinaison pour un tiret demi-cadratin serait 
Alt+Fn+,ji, et pour un tiret cadratin Alt+Fn+,jij.

Linux

Maintenez enfoncée la touche Compose de votre clavier et tapez deux tirets et un point pour 
un tiret demi-cadratin ou trois tirets pour un tiret cadratin. Le tiret apparaît lorsque vous relâ-
chez la touche Compose.

Conseil

La touche qui opère comme Compose varie suivant les distributions Linux. Elle est habituel-
lement l’une des touches Alt ou Win, mais peut être une autre touche choisie par l’utilisateur.

Mac OS X

Maintenez la touche Option (Alt) et tapez un tiret pour un tiret demi-cadratin. Pour un tiret 
cadratin utilisez Maj+Option+tiret.

Vérification orthographique et grammaticale

Orthographe

Writer fournit un vérificateur orthographique qui contrôle chaque mot du document par rapport à 
ceux enregistrés dans le dictionnaire. Cela signifie que certains mots (par exemple, les noms 
propres), même s’ils sont correctement orthographiés, peuvent être signalés comme mal écrits, car
ils ne sont pas disponibles dans le dictionnaire. Writer fournit également un vérificateur grammati-
cal qui peut être utilisé séparément ou en combinaison avec le vérificateur orthographique (voir les
sections « Orthographe et grammaire » et « Grammaire » en pages 53 et 55).

Si elle est activée avant de commencer la saisie, la fonction Vérification automatique vérifie 
chaque mot pendant la frappe. Si la fonction est activée après la saisie, tout le texte déjà présent 
dans le document est vérifié. Les mots non reconnus sont soulignés par des vagues rouges.

La fonction Vérification automatique peut être activée en cliquant sur l’icône  dans la barre 
d’outils Standard (elle peut ne plus être affichée par défaut), en sélectionnant Outils > Correction 
orthographique automatique dans la barre de menu ou via le menu Outils > Options pour ouvrir
la boîte de dialogue Options puis en choisissant la page Paramètres linguistiques – Linguistique et 
en cochant l’option Vérifier l’orthographe au cours de la frappe dans la liste Options.
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Faites un clic droit sur un mot non reconnu pour ouvrir un menu contextuel (voir Figure 2.8). Cli-
quez ensuite sur l’une des suggestions dans le haut du menu pour remplacer le mot souligné par 
celui que vous avez choisi.

Si le suivi des modifications est activé, ce menu contextuel offre des options supplémentaires en 
rapport avec les modifications du texte.

Figure 2.8 : Le menu contextuel de correction orthographique

Plusieurs choix sont disponibles dans le centre du menu contextuel dédié à la correction orthogra-
phique.

Ignorer

Le mot souligné sera ignoré tant que le document sera ouvert. Si le même mot est présent 
ailleurs dans le document, il demeurera souligné. Ce paramètre n’est pas stocké avec le do-
cument.

Tout ignorer

Tous les mots identiques à celui souligné seront ignorés et le mot sera ajouté à la liste Tout 
ignorer du dictionnaire personnalisé de l’utilisateur.

Ajouter au dictionnaire

Le mot est ajouté au dictionnaire personnalisé de l’utilisateur. Si un seul dictionnaire est acti-
vé, aucun choix n’est possible et le mot est par défaut ajouté au dictionnaire Standard.

Orthographe et grammaire

Cette fonction ouvre la boîte de dialogue Orthographe et Grammaire. Pour plus d’informa-
tions sur cette boîte de dialogue, consultez la section suivante « Orthographe et gram-
maire » en page 53.
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Remarque

Si aucun dictionnaire grammatical n’est installé sur votre ordinateur, la boîte de dialogue Or-
thographe et Grammaire s’intitulera Orthographe. Vous pouvez installer un dictionnaire 
grammatical via le menu Outils > Langue > Dictionnaires supplémentaires en ligne. 
Pour plus d’informations sur l’installation de dictionnaires ou d’extensions, référez-vous au 
chapitre 20, Paramétrer Writer, page 563.

Toujours corriger en

Ouvre un sous-menu qui reprend les suggestions du haut du menu. Le fait de sélectionner 
un mot de remplacement dans ce sous-menu stocke le mot en question dans la table de 
remplacement (qui se trouve dans l’onglet Remplacer de la boîte de dialogue Options d’Au-
toCorrection qui s’ouvre via le menu Outils > AutoCorrection > Options d’AutoCorrec-
tion). Par conséquent, lorsque vous saisirez le mot mal orthographié dans n’importe quel do-
cument, il sera automatiquement remplacé, car le mot mal orthographié et son équivalence 
correcte seront enregistrés dans la table de remplacement. Par exemple, si vous saisissez le
mot “voulior”, il sera automatiquement remplacé par “vouloir”.

Options d’Autocorrection

Ouvre la boîte de dialogue AutoCorrection (voir page 60), où vous pouvez ajouter vos 
propres corrections et modifier celles proposées par LibreOffice.

Dans la troisième partie du menu contextuel dédié à la correction orthographique, vous pouvez dé-
terminer les paramètres linguistiques. Ces derniers peuvent s’appliquer au texte sélectionné, au 
paragraphe ou au document entier.

Orthographe et grammaire

Pour effectuer une vérification simultanée de l’orthographe et de la grammaire du document (ou 
d’une sélection), cliquez sur l’icône Orthographe et grammaire  de la barre d’outils Standard, 
sélectionnez Outils > Orthographe et grammaire dans la barre de menu, ou appuyez sur la 
touche F7 de votre clavier. Afin de procéder à cette vérification, les dictionnaires appropriés 
doivent être installés. Par défaut, quatre dictionnaires sont installés : un vérificateur orthogra-
phique, un vérificateur grammatical, un dictionnaire de césure et un dictionnaire des synonymes.

Pour le français, l’extension Grammalecte prend en charge la vérification grammaticale. Cette ex-
tension, toujours en développement, est disponible à cette adresse : https://extensions.libreof-
fice.org/extensions/grammalecte.

Si aucun texte n’est sélectionné, la vérification orthographique et grammaticale commence à l’en-
droit où le curseur est placé Si des mots non reconnus par le(s) dictionnaire(s) sont trouvés ou 
qu’une règle grammaticale n’est pas respectée, la boîte de dialogue Orthographe et grammaire 
s’ouvre (voir Figure 2.9). Lorsque la vérification est terminée, un message s’affiche pour vous pro-
poser de recommencer la vérification depuis le début du document
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Figure 2.9 : La boîte de dialogue Orthographe et grammaire

Les éléments de la boîte de dialogue Orthographe et grammaire sont décrits ci-après.

Langue du texte

La langue à utiliser pour la vérification orthographique et grammaticale peut être définie de-
puis cette liste. Si la vérification orthographique est disponible pour cette langue, une coche 
est affichée en face du nom de la langue.

Absent du dictionnaire

La phrase contenant l’erreur est affichée dans le champ. Le mot non reconnu par le diction-
naire est affiché en rouge.

Si une erreur grammaticale est remarquée, elle est indiquée en bleu (voir Figure 2.10). La 
phrase ou le mot peut être directement modifié dans le champ.

Suggestions

Ce champ contient les suggestions permettant de remplacer le mot mal orthographié. Sélec-
tionnez un mot et cliquez ensuite sur Modifier ou Tout modifier pour le remplacer.

Pour les erreurs grammaticales, il n’existe pas de choix multiple. Cliquez, si possible, sur 
Modifier pour accepter la suggestion.

Ignorer une fois, Tout ignorer et Ajouter au dictionnaire

Cliquer sur l’un de ces boutons a le même effet que de cliquer sur l’option AutoCorrection 
dans le menu contextuel dédié à la correction orthographique (voir la section « Ortho-
graphe » en page 51).

Ignorer la règle

Pendant la vérification de la grammaire, vous pouvez choisir d’ignorer la modification propo-
sée.
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Corriger

Remplace le mot non reconnu par le mot suggéré. Si la phrase a été éditée, l’intégralité de la
phrase est modifiée.

Pour la grammaire, le remplacement proposé est utilisé pour corriger le texte.

Tout corriger

Remplace dans le document tous les mots identiques à celui en rouge par le mot choisi dans
les suggestions.

Toujours corriger

Le bouton Toujours corriger de la boîte de dialogue Orthographe et grammaire se comporte
de façon similaire à l’option Toujours corriger en du menu contextuel dédié à la correction 
orthographique (voir la section « Orthographe » en page 53). Cependant, le mot n’est pas 
remplacé dans le document et vous devez donc recourir au bouton Corriger ou au bouton 
Tout corriger.

Annuler

Ce bouton devient actif lorsqu’une modification a été effectuée dans la phrase, ce qui vous 
permet d’annuler le changement. Ce bouton n’est pas disponible si vous utilisez le bouton 
Corriger ou le bouton Tout corriger pour remplacer un mot.

Options

Ouvre la boîte de dialogue Options dans laquelle vous pouvez sélectionner les dictionnaires 
et définir les paramètres de vérification orthographique et grammaticale.

Remarque

Il est conseillé d’exécuter deux fois pour le même document la vérification orthographique et
grammaticale. Un problème mineur du logiciel peut empêcher la détection de toutes les er-
reurs grammaticales en un seul passage.

Grammaire

Par défaut, la fonction Vérifier la grammaire au cours de la frappe est activée dans la page Para-
mètres linguistiques – Options de la boîte de dialogue Options (qui s’ouvre via le menu Outils > 
Options). La vérification orthographique doit être activée et un vérificateur grammatical doit être 
installé (voir page 53) pour que la vérification grammaticale fonctionne.

Si des erreurs sont détectées, elles sont soulignées par des vagues bleues. Effectuez un clic droit 
sur l’erreur afin d’ouvrir un menu contextuel semblable à celui affiché à la Figure 2.10 et à la Figure
2.11.

La première entrée du menu vous renseigne sur la règle grammaticale suspectée de ne pas être 
respectée.

Dans l’exemple de la Figure 2.10, la seconde entrée du menu Explications ouvre votre navigateur
internet et vous présente un site web qui vous donne de plus amples informations sur l’erreur com-
mise.
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Figure 2.10 : Correction d’une erreur grammaticale

La deuxième section du menu vous suggère des corrections possibles. Cliquez sur l’une de ces 
suggestions pour modifier l’erreur par ladite suggestion. Dans l’exemple de la Figure 2.11, cette 
section est vide, mais vous pouvez cliquer sur cette ligne vide pour supprimer le double espace 
responsable de l’erreur.

Figure 2.11 : Correction d’une erreur typographique

Dans la troisième section du menu, vous pouvez choisir d’ignorer l’erreur indiquée ou ouvrir le véri-
ficateur orthographique et grammatical.

Figure 2.12 : La boîte de dialogue Orthographe et grammaire donnant des informations sur l’erreur
grammaticale commise.

56 | Guide de LibreOffice Writer Vérification orthographique et grammaticale



 Chapitre 2 Travailler avec le texte : les bases

La Figure 2.12 montre la boîte de dialogue Orthographe et grammaire expliquant l’erreur gramma-
ticale commise. L’exemple montre l’infobulle du lien vers la page qui donne plus d’informations sur 
l’erreur décelée.

Dans la section suivante du menu, vous pouvez paramétrer la langue pour la sélection ou le para-
graphe.

Vous pouvez également ajouter des correcteurs grammaticaux supplémentaires en ajoutant des 
extensions via le Gestionnaire des extensions (via le menu Outils > Gestionnaire des exten-
sions).

Utiliser le dictionnaire des synonymes

Vous pouvez obtenir une courte liste des synonymes possibles via le menu contextuel (voir Figure 
2.13) :

 1) Effectuez un clic droit sur un mot ou une phrase sélectionnée afin d’ouvrir le menu contex-
tuel. Placez le curseur de la souris sur Synonymes dans le menu contextuel pour dévelop-
per le sous-menu dans lequel s’affichent des propositions alternatives au mot ou à la phrase.

 2) Cliquez sur un mot ou une phrase pour remplacer le mot ou la phrase concerné dans votre 
document.

Figure 2.13 : Synonymes disponibles dans le menu contextuel.

Le Dictionnaire des synonymes fournit une liste plus étoffée de mots et de phrases alternatifs. 
Pour utiliser le Dictionnaire des synonymes :

 1) Sélectionnez un mot ou une phrase dans votre document. Cliquez ensuite sur le menu Ou-
tils > Langue > Dictionnaire des synonymes, ou appuyez sur les touches Ctrl+F7 de 
votre clavier, ou faites un clic droit sur la sélection et choisissez Synonymes > Dictionnaire 
des synonymes dans le menu contextuel.

 2) La boîte de dialogue Dictionnaire des synonymes s’affiche. Cliquez sur un mot ou une 
phrase dans la liste des alternatives pour la sélectionner.

 3) Cliquez sur le bouton Remplacer pour effectuer la substitution.

Par exemple, si vous souhaitez remplacer le mot Gestionnaire, le Dictionnaire des synonymes pro-
posera de nombreuses significations et alternatives (voir Figure 2.14).
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Figure 2.14 : La boîte de dialogue Dictionnaire des synonymes.

Remarque

Si un Dictionnaire des synonymes n’est pas installé pour la langue active, cette fonction est 
désactivée.

Coupure des mots

Vous avez plusieurs choix en ce qui concerne la coupure des mots : laisser Writer le faire automa-
tiquement (grâce à son dictionnaire de coupure des mots), insérer manuellement des tirets condi-
tionnels où vous le souhaitez, ou ne pas couper les mots du tout. Chaque choix présente des 
avantages et des inconvénients.

Coupure des mots automatique

Cette option l’emporte sur les choix effectués dans Outils > Options.

Pour (dés)activer la coupure automatique des mots :

 1) Cliquez sur l’onglet Style et formatage du Volet latéral pour ouvrir l’onglet Style et formatage. 
Dans l’onglet Styles de paragraphe, faites un clic droit sur le Style par défaut pour ouvrir un 
menu contextuel. Cliquez ensuite sur Modifier.

Figure 2.15 : Modifier un style de paragraphe.
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 2) Dans la boîte de dialogue Style de paragraphe, ouvrez l’onglet Enchaînements.

Figure 2.16 : Activer la coupure des mots automatique.

 3) Sous la section Coupure des mots, (dé)cochez l’option Automatiquement.

 4) Cliquez sur le bouton OK pour enregistrer les modifications.

Remarque

Activer la coupure des mots pour le style de paragraphe par défaut affecte tous les para-
graphes basés sur le Style par défaut. Les styles non basés sur le style par défaut, un style 
de titre par exemple, ne sera pas affecté par cette modification, à moins que vous ne para-
métriez également son style de paragraphe. Pour plus d’informations sur les styles de para-
graphe, référez-vous aux chapitres 8 et 9 de ce guide.

Vous pouvez configurer les paramètres de coupure des mots via la page Paramètres linguistiques
– Linguistique de la boîte de dialogue Options (Outils > Options > dans la barre de menu). Dans
la section Options, recherchez les paramètres relatifs à la coupure des mots.

Figure 2.17 : Paramètres relatifs à la coupure des mots.

Pour modifier le nombre minimum de caractères pour la coupure des mots ou le nombre minimum 
de caractères avant/après la séparation, sélectionnez l’élément concerné puis cliquez sur le bou-
ton Éditer.

Coupure automatique

Indique qu’il ne vous sera jamais demandé de couper manuellement les mots non reconnus 
par le dictionnaire de coupure des mots. Si cette case n’est pas cochée, lorsqu’un mot ne 
sera pas reconnu, une boîte de dialogue s’ouvrira afin que vous réalisiez la coupure manuel-
lement.
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Coupure des zones spéciales

Indique que la coupure des mots sera également réalisée dans les notes de bas de page, les
en-têtes et les bas de page.

Les options inhérentes à la coupure des mots paramétrées dans la page Paramètres linguistiques 
– Linguistique sont effectives uniquement si la coupure des mots est activée dans les styles de pa-
ragraphe.

Coupure des mots manuelle

Lors d’une coupure des mots manuelle, n’utilisez pas un tiret normal. Ce dernier resterait visible 
même si le mot coupé n’est plus trop long en raison d’un ajout ou d’une suppression de texte, 
d’une modification des marges ou de la taille de la police. Utilisez plutôt un Tiret conditionnel.

Pour insérer un tiret conditionnel à l’intérieur d’un mot, cliquez dans le mot à l’endroit où vous sou-
haitez que celui-ci apparaisse et appuyez ensuite sur les touches Ctrl+Signe moins (du pavé 
numérique) de votre clavier ou cliquez sur le menu Insertion > Marque de formatage > Tiret 
conditionnel. Le mot sera coupé à l’endroit choisi lorsqu’il se retrouvera à la fin d’une ligne, même
si la coupure des mots automatique est désactivée pour le paragraphe.

Utiliser l’AutoCorrection

Les options d’AutoCorrection de Writer constituent une longue liste de fautes d’orthographe ou de 
frappe courantes et d’erreurs typiques qui peuvent être corrigées automatiquement. Par exemple, 
“dse” sera remplacé par “des”. Elles comportent aussi des codes qui permettent d’insérer des ca-
ractères spéciaux, des émojis ou d’autres symboles.

Les options d’AutoCorrection sont activées par défaut. Pour les désactiver, décochez l’option via le
menu Outils > AutoCorrection > Pendant la frappe.

Pour ouvrir la boîte de dialogue AutoCorrection (Figure 2.18), cliquez sur le menu Outils > Auto-
Correction > Options d’AutoCorrection. Vous pouvez y définir quels sont les mots à corriger, le 
texte de remplacement et le format à utiliser. À noter que de nombreuses entrées sont déjà dispo-
nibles.

Afin que Writer arrête de remplacer un mot mal orthographié, cliquez sur l’onglet Remplacer de la 
boîte de dialogue AutoCorrection. Sélectionnez le mot mal orthographié et son remplaçant, puis 
cliquez sur le bouton Supprimer.

Pour ajouter un nouveau mot à la liste, saisissez sa version mal orthographiée dans le champ 
Remplacer ainsi que son remplaçant dans le champ Par. Cliquez ensuite sur le bouton Nouveau.

N’hésitez pas à également consulter les autres onglets de la boîte de dialogue AutoCorrection afin 
de découvrir toutes les autres options disponibles et, éventuellement, de les régler à votre conve-
nance.

Astuce
L’AutoCorrection peut être utilisée comme un moyen rapide d’insérer des caractères spé-
ciaux. Par exemple, (c) sera remplacé automatiquement par ©. Vous pouvez également 
ajouter d’autres caractères spéciaux à la liste.

Un clic droit dans les champs Remplacer et Par permet d’accéder aux caractères spéciaux.
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Figure 2.18 : L’onglet Remplacer de la boîte de dialogue AutoCorrection.

Voir le Chapitre 4 Mettre le texte en forme, page 110, pour une présentation des pages Options et 
Options linguistiques de cette boîte de dialogue.

Utiliser l’insertion automatique

Si l’Insertion automatique est activée, Writer tente de déterminer quel est le mot que vous saisis-
sez et vous propose de compléter le mot pour vous. Pour accepter la suggestion du logiciel, ap-
puyez sur la touche Entrée de votre clavier. Si la suggestion ne vous convient pas, continuez à sai-
sir le mot.

Pour désactiver l’Insertion automatique, cliquez sur le menu Outils > AutoCorrection > Options 
d’AutoCorrection puis décochez l’option Activer l’insertion automatique dans l’onglet Insertion au-
tomatique.

Il est possible de personnaliser l’insertion automatique via l’onglet de même nom de la boîte de 
dialogue AutoCorrection.

• Ajouter un espace automatiquement après le mot que vous venez d’accepter.

• Afficher sous forme d’infobulle la suggestion plutôt que de l’afficher dans le texte que vous 
saisissez.

• Collecter les mots lorsque vous travaillez dans un document et les garder en mémoire afin 
de les utiliser dans d’autres documents. Toutefois, vous pouvez décider de supprimer la liste 
des mots lorsque vous fermerez le document.
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• Modifier le maximum d’entrées à enregistrer pour l’insertion automatique ainsi que la lon-
gueur minimum et maximum des mots à sauvegarder.

• Supprimer certaines entrées de la liste des mots disponibles pour la complétion.

• Modifier la touche qui vous permet d’accepter la suggestion. Les touches possibles sont : 
Flèche vers la droite, Fin, Entrée, Barre espace et Tabulation.

Figure 2.19 : L’onglet Insertion automatique de la boîte de dialogue AutoCorrection

Remarque

L’insertion automatique s’active si vous avez saisi au moins deux fois le même mot dans un 
même document.

Utiliser l’AutoTexte

Les AutoTextes permettent d’enregistrer du texte, des tableaux, des champs ainsi que d’autres élé-
ments que vous utilisez de manières récurrentes. Vous pourrez les lier à des raccourcis qui facilite-
ront leur récupération.

Par exemple, au lieu de chaque fois saisir la formule de politesse “Je vous prie d’agréer, Madame, 
Monsieur, mes salutations distinguées.” dans un courrier, vous pouvez paramétrer un AutoTexte 
afin de simplement saisir le raccourci “sd” et appuyer sur la touche F3 pour insérer la phrase com-
plète dans votre document.
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Les AutoTextes sont particulièrement utiles lorsqu’ils sont affectés à des champs. Pour plus d’infor-
mation sur les champs, référez-vous au Chapitre 17 Travailler avec les champs, page 469.

Créer un AutoTexte

Pour enregistrer du texte comme AutoTexte :

 1) Saisissez le texte dans votre document.

 2) Sélectionnez le texte.

 3) Cliquez sur le menu Outils > AutoTexte (ou appuyez sur les touches Ctrl+F3 de votre cla-
vier).

 4) Dans la boîte de dialogue AutoTexte, saisissez un nom pour l’AutoTexte dans le champ Nom.
Dans le champ Raccourci, Writer vous suggérera un raccourci que vous pourrez éventuelle-
ment modifier.

 5) Dans la liste en dessous des champs Nom et Raccourci, choisissez la catégorie dans la-
quelle enregistrer l’AutoTexte. Par exemple, optez pour la catégorie Mes AutoTextes.

 6) En bas de la boîte de dialogue, cliquez sur le bouton AutoTexte et sélectionnez, dans le 
sous-menu, soit Nouveau (si vous souhaitez que votre AutoTexte conserve son formatage, 
peu importe l’endroit où il sera inséré), soit Nouveau (texte seulement) (si vous souhaitez 
que votre AutoTexte s’imprègne du formatage de l’emplacement où il sera inséré).

 7) Cliquez sur le bouton Fermer pour retourner au document.

Figure 2.20 : Définir une nouvelle entrée d’AutoTexte.
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Conseil

Si la seule option possible dans le sous-menu du bouton AutoTexte est Importer, soit vous 
n’avez pas donné un nom à l’AutoTexte, soit aucun texte n’a été sélectionné dans le docu-
ment.

Pour enregistrer un tableau comme AutoTexte :

 1) Créez un tableau et formatez-le comme vous le souhaitez.

 2) Sélectionnez le tableau.

 3) Cliquez sur le menu Outils > AutoTexte (ou appuyez sur les touches Ctrl+F3 de votre cla-
vier).

 4) Dans la boîte de dialogue AutoTexte, saisissez un nom pour l’AutoTexte dans le champ Nom.
Dans le champ Raccourci, Writer vous suggérera un raccourci que vous pourrez éventuelle-
ment modifier.

 5) En bas de la boîte de dialogue, cliquez sur le bouton AutoTexte et sélectionnez, dans le 
sous-menu, l’option Nouveau, car vous souhaitez préserver le formatage du tableau.

 6) Cliquez sur le bouton Fermer pour retourner au document.

Insérer un AutoTexte

Pour insérer un AutoTexte, saisissez le raccourci dans votre document et appuyez ensuite sur la
touche F3 de votre clavier.

Si, lors de la création de votre AutoTexte, vous avez coché l’option  Lors de la saisie, afficher le
nom complet sous forme d’infobulle (voir Figure 2.20), saisissez le nom de l’AutoTexte et une info-
bulle fera son apparition. Dès que vous la verrez, appuyez sur la touche Entrée de votre clavier
pour insérer l’AutoTexte.

Conseil

Il est possible d’insérer une image dans une entrée d’AutoTexte, à la condition que celle-ci 
soit précédée et suivie d’un caractère, une espace, par exemple.

Imprimer une liste des entrées d’AutoTexte

Pour imprimer une liste des entrées d’AutoTexte :

 1) Cliquez sur le menu Outils > Macros > Gérer les macros > LibreOffice Basic.

 2) Dans la liste Macro de, cliquez sur Macros LibreOffice > Gimmicks > AutoTexte.

 3) Cliquez sur le bouton Exécuter. Une liste des entrées d’AutoTexte disponibles sera générée 
dans un nouveau document que vous pourrez ensuite imprimer.
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Figure 2.21 : Imprimer une liste des entrées d’AutoTexte via les macros.

Modifier la casse du texte sélectionné

Pour modifier rapidement la casse d’un texte, sélectionnez-le, puis cliquez sur le menu Format >
Texte. Choisissez ensuite l’une des possibilités suivantes :

• MAJUSCULES pour que toutes les lettres soient écrites en majuscules ;

• minuscules pour qu’aucun mot (sauf les noms propres) ne soit écrit en majuscules ;

• Changer de casse en boucle (Maj+F3) qui met successivement en boucle les mots sélec-
tionnés en majuscules, en minuscules ou avec une majuscule à chaque mot.

• Casse de phrase pour que seule la première lettre du premier mot de la phrase (en plus des
noms propres) soit en majuscule ;

• Majuscule À Chaque Mot pour que la première lettre de chaque mot du texte sélectionné 
soit en majuscule ;

• bASCULER LA CASSE pour que chaque lettre soit écrite dans la casse opposée.

D’autres options sont disponibles uniquement lorsque la prise en charge pour les langues asia-
tiques est activée. Dans ce cas, il ne s’agit pas vraiment de modification de la casse, mais plutôt 
de remplacer les caractères par des formes légèrement différentes des mêmes lettres.

Writer n’offre aucune méthode automatique pour obtenir une « Casse de titre » où tous les mots 
sont en majuscules sauf certains sous-ensembles définis par des règles qui ne sont pas recon-
nues universellement. Pour obtenir cet effet, vous pouvez utiliser Majuscule À Chaque Mot puis 
rétablir les mots qui n’ont pas été correctement mis en majuscules.

Vous pouvez aussi modifier la casse du texte grâce à la boîte de dialogue Caractères ou à un style
de caractère. Choisissez Format > Caractère, cliquez sur l’onglet Effets de caractère puis choisis-
sez le type de casse quand la liste déroulante Effets. Majuscules met toutes les lettres en majus-
cules. Minuscules les met toutes en minuscules. Petites majuscules les met toutes en majus-
cules mais en réduit la taille.
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Figure 2.22 : Choix de la casse dans la boîte de dialogue Caractère
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Chapitre 3
Travailler avec le texte :
Approfondissements





Introduction

Ce chapitre présente les outils plus perfectionnés qui vous permettront de travailler avec le texte 
dans Writer.

• Les outils linguistiques intégrés.

• Les techniques perfectionnées de recherche et remplacement, y compris les jokers.

• Le suivi des modifications et l’insertion de commentaires.

• Les notes de bas de page et de fin de document.

• La liaison avec d’autres parties d’un document.

• La numérotation des lignes.

Ce chapitre suppose que vous êtes familiarisé avec les techniques de base concernant le texte dé-
crites dans le  Chapitre 2 Travailler avec le texte : les bases, page 41. Nous vous recommandons 
aussi d’afficher les aides au formatage telles que les marques de fin de paragraphe, les tabula-
tions, les sauts et les autres éléments de la page LibreOffice Writer – Aides au formatage de la 
boîte de dialogue Options (qui s’ouvre en cliquant sur Outils > Options dans la barre de menu).

Pour plus d’informations sur la mise en forme du texte (caractères, paragraphes, listes), voyez le 
Chapitre 4 Mettre le texte en forme, page 93.

Utiliser les outils linguistiques intégrés

Writer fournit quelques outils qui pourraient faciliter votre travail si vous utilisez plusieurs langues 
dans un même document ou si vous rédigez des documents dans de nombreuses langues :

• la sélection des styles de paragraphes et de caractères ;

• les fonctions disponibles via le menu Outils > Langue ;

• les paramètres linguistiques dans les options ;

• les fonctions proposées dans la barre d’état.

Le principal avantage de modifier la langue pour une sélection réside dans le fait que vous pouvez 
ensuite utiliser les dictionnaires adéquats afin de vérifier l’orthographe et la grammaire, appliquer 
les tables de remplacement de l’AutoCorrection, les synonymes ainsi que les règles de césure 
adaptés à la langue définie.

Vous pouvez également définir la langue pour un paragraphe ou un groupe de caractères sur Au-
cune (pas de vérification orthographique). Cette option est utile dans le cas où vous saisissez 
du texte tel que des liens internet ou du langage de programmation.

Utiliser les styles de paragraphes et de caractères

La meilleure méthode consiste à paramétrer la langue pour les styles de caractères et de para-
graphes. En effet, l’utilisation des styles différents pour chaque langue permet une meilleure ges-
tion des langues et facilite les éventuelles modifications de celles-ci.

Dans la fenêtre Styles et formatage (onglet Styles de paragraphe), vous pouvez définir quels se-
ront les (quelques) paragraphes rédigés dans une langue différente de celle paramétrée pour le 
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reste du document en changeant celle-ci dans l’onglet Police de la boîte de dialogue Style de pa-
ragraphe (voir Figure 3.1).

Vous pouvez aussi faire vérifier certains paragraphes dans une langue différente de celle du reste 
du document en y plaçant le curseur avant d’en modifier la langue dans la barre d’état.

Figure 3.1 : Définir une langue pour un style de paragraphe.

Pour plus d’informations sur la façon de paramétrer la langue d’un style, référez-vous au Chapitre 
9 Travailler avec les styles, page 241.

Utiliser le menu Outils > Langue

Grâce au menu Outils > Langue, vous pouvez définir la langue pour tout le document, pour 
quelques paragraphes ou certains mots et caractères.

Pour la sélection

Appliquer la langue choisie au texte sélectionné. Si la langue que vous désirez utiliser n’ap-
paraît pas dans la liste, choisissez Plus…

Pour le paragraphe

Appliquer la langue choisie au paragraphe où le curseur de la souris se situe. Si la langue 
que vous désirez utiliser n’apparaît pas dans la liste, choisissez Plus…

Pour tout le texte

Appliquer la langue choisie à tout le document, y compris au texte saisi après avoir détermi-
né la langue. Si la langue que vous désirez utiliser n’apparaît pas dans la liste, choisissez 
Plus…

Plus…

Ouvre la boîte de dialogue Caractère où vous pourrez choisir la langue que vous désirez 
dans l’onglet Police. Quand une langue a été appliquée à une sélection ou un paragraphe du
document, elle apparaît dans la liste des langues pour la sélection, le paragraphe ou tout le 
texte.
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Figure 3.2 : Choix d’une langue dans le menu Outils > Langue.

Notez l’option Rétablir la langue par défaut dans le sous-menu. C’est le moyen le plus rapide pour 
rendre à une sélection, un paragraphe ou à tout le texte la langue par défaut définie dans Outils > 
Options (voir ci-dessous).

Utiliser les paramètres linguistiques dans les options

Il est possible de modifier la langue pour le document entier grâce à la page Paramètres linguis-
tiques – Langues de la boîte de dialogue Options (qui s’ouvre via le menu Outils > Options). 
Dans la section Langues par défaut des documents (voir Figure 3.3), vous pouvez choisir une 
langue qui s’appliquera au texte auquel vous n’avez pas explicitement appliqué une langue propre.

! Attention

Contrairement à l’option de la barre de menu qui applique la modification à un document in-
dividuel, un changement effectué dans la section Langues par défaut des documents de 
la boîte de dialogue Options s’applique à tous les documents en cours ainsi qu’à tous ceux 
qui seront créés dans le futur, car il s’agit d’un paramètre général de LibreOffice. Si vous 
souhaitez modifier la langue pour le document actif uniquement, assurez-vous d’avoir bien 
coché l’option Uniquement pour le document actif (voir Figure 3.3).

Figure 3.3 : Choix de la langue du document dans les paramètres linguistiques.

Remarque

La vérification orthographique et grammaticale fonctionne uniquement avec les langues qui 
sont indiquées avec le symbole  dans la liste (voir Figure 3.3). Si vous ne voyez pas ce 
symbole à côté de la langue choisie, il vous est possible d’installer les dictionnaires néces-
saires via le menu Outils > Langue > Dictionnaires supplémentaires en ligne.

Utiliser la barre d’état

La langue utilisée pour la vérification orthographique et grammaticale est également indiquée dans
la barre d’état, à droite du style de page utilisé. Via la barre d’état, il vous est possible de modifier 
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la langue pour un paragraphe ou pour le document entier. Pour ce faire, cliquez sur la langue dans
la barre d’état afin d’ouvrir un menu contenant les différents choix disponibles.

Figure 3.4 : Choix de la langue dans la barre d’état.

À noter que l’option Rétablir la langue par défaut est disponible aussi bien dans le menu (docu-
ment entier) que dans le sous-menu (paragraphe). Il s’agit de la façon la plus rapide afin de réta-
blir, pour le document entier ou pour un paragraphe, la langue par défaut paramétrée dans la page
Paramètres linguistiques – Langues de la boîte de dialogue Options (cliquez sur Outils > Options 
dans la barre de menu).

Techniques évoluées de recherche et remplacement

En plus de la recherche et du remplacement de mots et de phrases (décrits au chapitre 2, page
46), vous pouvez utiliser la boîte de dialogue Rechercher & remplacer de Writer pour effectuer ces 
opérations sur des attributs de texte, des mises en forme et des styles de paragraphe. Avec l’ex-
tension Recherche alternative (https://extensions.libreoffice.org/extensions/alternative-dialog-find-
replace-for-writer) vous pouvez aussi rechercher et remplacer des styles de caractère et réaliser 
d’autres recherches élaborées.

Rechercher et remplacer des attributs de texte et des mises en forme

Figure 3.5 : La boîte de dialogue Rechercher & remplacer avec les options supplémentaires.
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Pour rechercher des attributs de texte comme l’alignement, l’arrière-plan, la couleur de police, l’in-
terligne qui ont été modifiés à partir de leurs valeurs par défaut. Tout texte qui possède un attribut 
police codé directement et tout texte où un style change l’attribut police sont trouvés.

 1) Dans la boîte de dialogue Rechercher & remplacer (avec les Autres options affichées, voir
Figure 3.5), cliquez sur le bouton Attributs…

 2) Sélectionnez l’attribut que vous désirez rechercher dans la liste de la boîte de dialogue Attri-
buts et cliquez sur OK. Les noms des attributs sélectionnés apparaissent sous la zone de 
saisie Rechercher. Par exemple, pour rechercher le texte dont la couleur de police a été mo-
difiée, cochez l’attribut Couleur de police.

Cliquez sur Rechercher le suivant ou sur Tout rechercher pour effectuer une recherche dans le 
document.

Pour rechercher un formatage précis comme gras, italique ou une taille de police, ouvrez la boîte 
de dialogue Rechercher & remplacer en affichant les autres options.

 1) Pour trouver un texte avec une mise en forme précise, tapez le texte dans la zone de saisie 
Rechercher. Pour ne rechercher qu’une mise en forme précise, effacez tout texte dans cette 
zone de saisie.

 2) Cliquez sur le bouton Format… pour ouvrir la boîte de dialogue Format de texte (Recher-
cher). Les onglets de cette boîte de dialogue sont les mêmes que ceux des boîtes Para-
graphe et Style de paragraphe.

 3) Choisissez les formats que vous voulez rechercher puis cliquez sur OK. Les noms des for-
mats choisis apparaissent sous le champ Rechercher. Vous pouvez, par exemple, recher-
cher tout le texte en Times New Roman, gras, 14 points. L’option Styles de paragraphe de-
vient Y compris les styles.

Figure 3.6 : Rechercher un format

 4) Pour remplacer le format, cliquez dans le champ Remplacer, choisissez le format à utiliser 
puis cliquez sur OK. Le format choisi sera affiché sous cette zone de saisie. Pour remplacer 
un texte en même temps que sa mise en forme, tapez le texte de remplacement dans la 
boîte de saisie.

Figure 3.7 : Remplacer un format

Pour rechercher un texte précis avec un formatage défini (par exemple, le mot bonjour en 
gras), précisez le formatage, tapez le texte dans le champ Rechercher et laissez vide la 
boîte de saisie Remplacer.

Pour supprimer un formatage de caractère particulier, cliquez sur le bouton Format…, sélec-
tionnez l’onglet Police puis choisissez-y le format opposé (par exemple, Pas de gras). Le 
bouton Aucun format de la boîte de dialogue efface tous les formats précédemment sélec-
tionnés.

Guide de LibreOffice Writer Techniques évoluées de recherche et remplacement | 73



 Chapitre 3 Travailler avec le texte : Approfondissements

 5) Cliquez sur le bouton Rechercher le suivant, Tout rechercher, Remplacer ou Tout rem-
placer.

! Conseil

Sauf si vous prévoyez de rechercher d’autres textes avec les mêmes attributs, cliquez sur le
bouton Aucun format pour supprimer les attributs une fois votre recherche effectuée. Si 
vous l’oubliez, vous pourriez vous demander pourquoi votre prochaine recherche ne trouve 
pas des mots que vous savez être présents dans le document.

Rechercher et remplacer des styles de paragraphes

Si vous copiez et collez du texte provenant de différentes sources (sans avoir recours à la fonction 
Collage spécial > Texte non formaté), vous vous rendrez compte que les styles ont également 
été copiés dans votre document. Il est possible de modifier les différents styles des paragraphes 
en un style propre à votre document :

 1) Dans la boîte de dialogue Rechercher & remplacer (avec le bouton Autres options activé, 
comme montré sur la Figure 3.5), cochez l’option Styles de paragraphe (si vous avez défini 
des attributs, voir la section « Rechercher et remplacer des attributs de texte et des 
mises en forme » en page 72, cette option s’appellera Y compris les styles. Cliquez sur le 
bouton Aucun format pour supprimer tous les attributs et ramener l’option à Styles de para-
graphe.). Les champs Rechercher et Remplacer contiennent désormais la liste des styles 
disponibles.

 2) Sélectionnez les styles que vous souhaitez rechercher et remplacer.

 3) Cliquez sur les boutons Rechercher le suivant, Tout rechercher, Remplacer ou Tout rem-
placer en fonction de vos besoins.

Répétez les étapes 2 et 3 pour chaque style que vous souhaitez modifier.

Rechercher et remplacer des styles de caractères

La boîte de dialogue Rechercher & remplacer n’offre aucun moyen simple pour retrouver et rem-
placer des styles de caractère. Vous pouvez envisager l’installation de l’extension Recherche alter-
native, qui comporte cette fonctionnalité et d’autres qui sont décrites sur cette page : https://exten-
sions.libreoffice.org/extensions/alternative-dialog-find-replace-for-writer.

Une fois l’installation de l’extension terminée, vous devrez fermer LibreOffice et le rouvrir avant 
qu’elle apparaisse dans le menu Édition. Les instructions d’utilisation sont fournies par l’extension 
elle-même (cliquez sur le bouton ?).

Rechercher et remplacer des caractères spéciaux

Pour saisir des caractères spéciaux dans les zones de saisie Rechercher et Remplacer, placez le 
curseur dans la zone voulue puis appuyez sur la combinaison de touches Ctrl+Maj+S. Choisis-
sez les caractères désirés dans la boîte de dialogue Caractères spéciaux puis cliquez sur OK. 
Cette version de la boîte de dialogue ne permet de choisir qu’un seul caractère et n’autorise pas le
choix de la police de caractères.
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Utiliser la recherche des similarités

La recherche des similarités permet de trouver des termes semblables à celui saisie dans le 
champ Rechercher. Par exemple, elle peut trouver des mots qui n’en diffèrent que par deux carac-
tères.

Dans les autres options, cochez la case Rechercher des similarités puis cliquez sur le bouton Si-
milarités… pour ouvrir une boîte de dialogue où vous pourrez préciser le nombre de caractères 
échangés, ajoutés ou supprimés du texte recherché (voir Figure 3.8).

Figure 3.8 : La boîte de dialogue de recherche des similarités.

Échanger les caractères

Saisissez le nombre de caractères dans le terme recherché qui peuvent être différents dans 
le terme trouvé. Par exemple, si vous indiquez 2 caractères échangés, « exporter » et « im-
porter » sont considérés comme similaires.

Ajouter des caractères

Saisissez le nombre maximum de caractères qu’un mot peut contenir en plus du terme re-
cherché.

Supprimer des caractères

Saisissez le nombre maximum de caractère qu’un mot peut contenir en moins du terme re-
cherché.

Combiner

Rechercher les termes qui correspondent à n’importe quelle combinaison des paramètres de
recherche de similarités.

Utiliser des métacaractères et des expressions régulières

Un métacaractère est un caractère spécial qui remplace un ou plusieurs caractères non définis. Ils 
permettent d’effectuer une recherche plus large, mais moins affinée. En outre, il vous est possible 
de recourir à des combinaisons de caractères, appelées expressions régulières, afin de faire des 
recherches plus poussées qu’avec les métacaractères, même si celles-ci restent moins précises 
qu’une chaîne de caractères littérale. Les expressions régulières s’avèrent très puissantes mais 
peu intuitives. Elles peuvent vous faire gagner du temps et vous épargner bien des efforts si vous 
les combinez lors d’une seule et même recherche.

Le Tableau 5 vous montre quelques-unes des expressions régulières utilisées par LibreOffice.
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Conseil

L’aide décrit bien plus d’expressions régulières et leur usage.

Tableau 5 : Exemples de métacaractères et d’expressions régulières

Pour rechercher…
Utilisez cette 
expression

Exemples et commentaires

N’importe quel caractère 
unique

. (un point) b.c trouve bec, bac et bic.

Un des caractères spécifiés [xyz] b[eo]n trouve ben et bon.

Tout caractère unique dans la
plage

[x-y] [r-t]oute trouve route, soute et toute ; les plages 
doivent être en ordre alphabétique ascendant.

Tout caractère unique sauf 
les caractères entre crochets

[^x] gr[^a]s trouve gros et grès, mais pas gras.

Le début d’un mot \<début \<log trouve logique et logistique, mais pas cata-
logue.

La fin d’un mot fin\> fact\> trouve artefact, mais pas facture.

Une marque de paragraphe $ Ne fonctionne pas comme caractère de remplace-
ment. Utilisez \n à la place.

Un saut de ligne \n Trouve un saut de ligne qui a été inséré avec les 
touches Maj+Entrée. Insère une marque de pa-
ragraphe quand elle est utilisée comme caractère 
de remplacement.

Pour utiliser les métacaractères et les expressions régulières lors d’une recherche et d’un rempla-
cement :

 1) Dans la boîte de dialogue Rechercher & remplacer (avec le bouton Autres options activé, 
comme montré sur la Figure 3.5), cochez l’option Expressions régulières.

 2) Dans le champ Rechercher, saisissez le texte à rechercher, y compris les métacaractères. 
Dans le champ Remplacer, saisissez le texte de remplacement si besoin. Toutes les expres-
sions régulières ne fonctionnent pas comme caractère de remplacement (par exemple, le 
saut de ligne \n).

 3) Cliquez sur les boutons Rechercher le suivant, Tout rechercher, Remplacer ou Tout rem-
placer (déconseillé dans ce cas) en fonction de vos besoins.

Remarque

Pour rechercher un caractère défini comme un métacaractère, saisissez devant le caractère 
une barre oblique inversée (\) afin d’indiquer à Writer que vous l’utilisez de façon littérale. 
Par exemple, pour rechercher le texte $5.00, vous saisirez \$5\.00).

Suivre les modifications apportées à un document

Plusieurs méthodes sont possibles afin de suivre les modifications apportées à un document.
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• Effectuez les modifications sur une copie du document (enregistrée dans un dossier différent
ou sauvegardée sous un autre nom). Utilisez ensuite Writer pour combiner les deux fichiers 
et vous montrer quelles modifications y ont été apportées. Pour ce faire, cliquez sur le menu 
Édition > Suivi des modifications > Comparer le document. Cette technique est particu-
lièrement pratique si vous êtes la seule personne à travailler sur le document. En effet, elle 
évite d’augmenter la taille du fichier et s’avère moins complexe que les autres méthodes.

• Enregistrez différentes versions du document (à des moments distincts) qui seront toutes 
stockées dans le fichier d’origine. Cette méthode peut toutefois entraîner des problèmes 
avec le document à cause de la taille du fichier, en particulier si vous sauvegardez de nom-
breuses versions. C’est pourquoi il vaut mieux, dans la mesure du possible, réserver cette 
méthode aux documents courts ou peu modifiés.

• Utilisez les marques de révision afin d’afficher clairement les modifications (ajout / suppres-
sion de texte et changement de formatage). Plus tard, une autre personne ou vous-même 
pourrez accepter ou rejeter les modifications apportées.

Remarque

Toutes les modifications ne peuvent pas être enregistrées. Par exemple, des modifications 
apportées à un taquet de tabulation (changer l’alignement à gauche en alignement à droite),
à des formules (équations) ou à des graphiques ne peuvent pas être mémorisées.

Préparer un document pour la révision

Lorsque vous envoyez un document à quelqu’un pour relecture ou édition, préparez-le afin que le 
destinataire n’ait pas à activer les marques de révision. Une fois que vous aurez protégé le docu-
ment, n’importe quel utilisateur devra entrer un mot de passe afin de désactiver les marques de ré-
vision et d’accepter ou rejeter les modifications.

 1) Ouvrez le document et assurez-vous qu’il ne contient pas plusieurs versions. Pour ce faire, 
cliquez sur le menu Fichier > Versions. Si plusieurs versions du document sont réperto-
riées, enregistrez la version actuelle séparément (par exemple, dans un nouveau dossier ou 
sous un nom différent) et utilisez ce nouveau document pour la révision.

 2) Dans le document destiné à la révision, assurez-vous que la fonction Enregistrer les modi-
fications soit bien activée. Vérifiez dans le menu Édition > Suivi des modifications > En-
registrer que l’icône soit en surbrillance à côté de l’option Enregistrer.

 3) Cliquez sur le menu Édition > Suivi des modifications > Protéger… Dans la boîte de dia-
logue Saisir le mot de passe, entrez un mot de passe, confirmez-le dans le second champ et
cliquez sur le bouton OK pour valider.

Astuce

Une alternative aux étapes 2 et 3 consiste à cliquer dans l’onglet Sécurité du menu Fichier 
> Propriétés. Cochez l’option Enregistrer les modifications puis cliquez sur le bouton Proté-
ger pour entrer le mot de passe.
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Enregistrer les modifications

Pour savoir comment modifier l’affichage des marques de révision, référez-vous au Chapitre 20 
Paramétrer Writer, page 559.

 1) Pour activer l’enregistrement des modifications, cliquez sur le menu Édition > Suivi des mo-
difications > Enregistrer. Pour afficher ou cacher les marques de révisions, cliquez sur le 
menu Édition > Suivi des modifications > Afficher.

Astuce
À l’aide de la souris, survolez une marque de révision afin d’afficher une infobulle. Cette der-
nière vous indiquera le genre de la modification, l’auteur, la date ainsi que l’heure à laquelle 
le changement a été effectué.

Si les infoballons sont activés, vous obtiendrez également tous les commentaires relatifs à 
la modification.

 2) Pour insérer un commentaire dans une zone de modification, sélectionnez le texte concerné 
à l’aide de la souris et cliquez ensuite sur le menu Édition > Suivi des modifications > 
Commentaire.

Figure 3.9 : Insérer un commentaire lorsque les modifications sont enregistrées.

En plus d’être affiché comme infoballon, le commentaire sera également visible parmi les 
éléments répertoriés dans la boîte de dialogue Gérer les modifications (voir Figure 3.10).

Pour passer d’un commentaire à un autre, utilisez les touches fléchées de votre clavier. Si 
aucun commentaire n’a été enregistré pour une modification, le champ Texte sera vide.

 3) Pour arrêter l’enregistrement des modifications, cliquez à nouveau sur le menu Édition > 
Suivi des modifications > Enregistrer.

Conseil

Pour annoter du texte sans avoir recours au suivi des modifications, consultez la section 
« Ajouter d’autres commentaires » en page 81.
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Accepter ou rejeter les modifications

Pour accepter ou rejeter les modifications, utilisez l’une des méthodes suivantes :

• la barre d’outils Suivi des modifications ;

• le clic droit pour ouvrir un menu contextuel ;

• la boîte de dialogue Gérer les modifications ;

• l’onglet Gérer les modifications du volet latéral.

Les résultats d’une acceptation ou d’un rejet des modifications sont les suivants :

• accepter une modification l’incorpore au document, c’est-à-dire que du texte est ajouté / sup-
primé, et les marques de révision disparaissent ;

• rejeter une modification permet au document de retrouver son état d’origine et les marques 
de révision disparaissent.

Barre d’outils Suivi des modifications

Pour accepter ou rejeter vite et rapidement les modifications, vous pouvez utiliser la barre d’outils 
Suivi des modifications qui propose des boutons pour les fonctions qui apparaissent dans le sous-
menu Édition > Suivi des modifications. Pour afficher cette barre d’outils, cliquez sur Affichage 
> Barres d’outils > Suivi des modifications dans la barre de menu. Vous pouvez l’ancrer à un 
endroit qui vous convient ou la laisser flottante.

Menu contextuel via le clic droit

 1) Si les marques de révision ne sont pas visibles, cliquez sur le menu Édition > Suivi des mo-
difications > Afficher.

 2) À l’aide de la souris, survolez une marque de révision afin d’afficher une infobulle qui vous in-
diquera le genre de la modification, l’auteur, la date ainsi que l’heure à laquelle le change-
ment a été effectué.

 3) Faites un clic droit sur le texte modifié. Dans le menu contextuel, cliquez sur Accepter la 
modification ou Rejeter la modification.

Boîte de dialogue Gérer les modifications

 1) Cliquez sur le menu Édition > Suivi des modifications > Gérer pour ouvrir la boîte de dia-
logue Gérer les modifications (voir Figure 3.10). L’onglet Liste de cette dernière répertorie les
modifications qui n’ont pas encore été acceptées ou rejetées.

 2) Lorsque vous cliquez sur une modification dans la boîte de dialogue, ladite modification est 
surlignée dans le document. De cette façon, il vous est plus facile de visualiser le change-
ment dans son contexte.

 3) Cliquez sur le bouton Accepter ou le bouton Rejeter pour accepter / rejeter la modification 
sélectionnée. Vous pouvez aussi cliquer sur le bouton Tout accepter ou Tout rejeter si vous
ne souhaitez pas consulter les modifications une par une.

Dans la boîte de dialogue Gérer les modifications, l’onglet Filtre (voir Figure 3.11) permet d’afficher
les modifications selon des critères que vous déterminez (par exemple, les changements effectués
par une personne en particulier). Une fois les paramètres entrés, retournez à l’onglet Liste. Les 
modifications qui ne correspondent pas à vos réglages ne sont plus proposées.
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Figure 3.10 : L’onglet Liste de la boîte de dialogue Gérer les modifications.

Onglet Gérer les modifications du Volet latéral

L’onglet Gérer les modifications du Volet latéral offre les mêmes informations que la boîte de dia-
logue Gérer les modifications décrite ci-dessus.

Figure 3.11 : L’onglet Filtre de la boîte de dialogue Gérer les modifications.

Comparer des documents

Parfois, les relecteurs oublient d’activer la fonction Enregistrer les modifications. Pour pallier cette 
inattention, Writer vous permet de comparer des documents et de retrouver ainsi les différences.

Pour comparer le document original et le document modifié :

 1) Ouvrez le document modifié puis cliquez sur le menu Édition > Suivi des modifications > 
Comparer le document.
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 2) La boîte de dialogue Comparer à s’ouvre. Sélectionnez le document original et cliquez sur le 
bouton Ouvrir.

 3) Writer trouve et met en évidence les modifications. La boîte de dialogue Gérer les modifica-
tions s’ouvre. Vous pouvez alors accepter ou rejeter les modifications comme décrit dans les 
sections précédentes.

Fusionner les documents modifiés

Jusqu’à présent, les procédés exposés s’avèrent efficaces si les relecteurs travaillent chacun à 
leur tour. Cependant, il peut arriver que plusieurs relecteurs renvoient leurs corrections en même 
temps. Dans ce cas, il sera plus pratique de visualiser les corrections en une seule fois plutôt que 
de les examiner une par une. C’est pourquoi il est important de pouvoir fusionner les documents 
dans Writer.

Pour pouvoir fusionner les documents, la fonction Enregistrer les modifications doit être activée 
dans les copies du document original.

 1) Faites une copie du document à relire après vous être assuré que la fonction Enregistrer les 
modifications (via le menu Édition > Suivi des modifications > Enregistrer) ait bien été ac-
tivée.

 2) Envoyez la copie au(x) relecteur(s) qui vous la retournera(ont) corrigée.

 3) Ouvrez la copie et cliquez sur le menu Édition > Suivi des modifications > Fusionner le 
document.

 4) Dans la boîte de dialogue Fusionner avec, choisissez la copie renvoyée par le relecteur. Cli-
quez ensuite sur le bouton Ouvrir.

 5) Après la fusion des deux documents, la boîte de dialogue Gérer les modifications s’ouvre 
(voir Figure 3.10). Vous pouvez y visualiser les corrections apportées. Si vous souhaitez tou-
tefois fusionner d’autres documents avant d’accepter ou de rejeter les modifications, fermez 
la boîte de dialogue et répétez les étapes 3 et 4 jusqu’à ce que toutes les copies aient été fu-
sionnées avec le document original.

 6) Une fois que toutes les modifications auront été intégrées dans le document, il est vivement 
conseillé d’enregistrer le document sous un autre nom.

Ajouter d’autres commentaires

Writer propose un autre type de commentaires que l’on pourrait appeler “notes” ou « pense-
bêtes ». Les auteurs et les relecteurs l’utilisent fréquemment pour échanger des idées, faire des 
suggestions, poser des questions ou lors d’une réunion remue-méninges.

Un commentaire peut cibler un bloc de texte ou un seul point du document. Pour insérer un com-
mentaire, sélectionnez le texte concerné ou placez votre curseur à l’endroit où vous souhaitez faire
apparaître le commentaire. Ensuite, cliquez sur le menu Insertion > Commentaire ou appuyez 
sur les touches Ctrl+Alt+C de votre clavier.

Le point d’ancrage du commentaire est connecté par une ligne pointillée à un cadre situé à droite 
de la page et dans lequel vous pouvez saisir le texte du commentaire. Un bouton Commentaires 
est aussi ajouté à la droite de la règle horizontale (voir Figure 3.12) ; vous pouvez cliquer sur ce 
bouton pour afficher / masquer les commentaires.
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Figure 3.12 : Commentaires dans Writer.

Writer indique automatiquement au bas du commentaire le nom de l’auteur ainsi que le moment de
sa création. Pour modifier le nom d’auteur qui apparaît dans le commentaire, ouvrez la page 
LibreOffice – Données d’identité cde la boîte de dialogue Options en cliquant sur Outils > Options
dans la barre de menu.

La Figure 3.12 montre un document sur lequel des commentaires de deux auteurs différents ont 
été ajoutés. Si plus d’une personne édite le document, chaque auteur se voit allouer automatique-
ment une couleur de fond différente. Si un auteur sélectionne un texte qui chevauche le texte com-
menté par un autre auteur, le commentaire du second sera imbriqué dans celui du premier.

Cliquez n’importe où dans la page, ou appuyez sur la touche Échap de votre clavier, pour indiquer 
à Writer que vous avez terminé d’éditer le commentaire. Sinon, vous ne pourrez pas quitter le 
cadre du commentaire.

Faites un clic droit dans un commentaire afin d’ouvrir un menu déroulant dans lequel vous pourrez 
choisir de supprimer le commentaire actif, tous les commentaires d’un même auteur ou tous les 
commentaires du document. Cette partie du menu déroulant est également accessible en cliquant 
sur le bouton en bas à droite du commentaire. Depuis le menu déroulant, vous pouvez également 
appliquer quelques formatages basiques au texte du commentaire. Il vous est également possible 
d’utiliser les fonctions de la barre de formatage.

Pour passer d’un commentaire à un autre, ouvrez le Navigateur depuis la barre d’outils standard 
ou appuyez sur la touche F5 de votre clavier. Développez la section Commentaires et double-cli-
quez sur un des commentaires pour déplacer le curseur au point d’ancrage du commentaire. Vous 
pouvez éditer et supprimer un commentaire en faisant un clic droit sur celui-ci.

Vous pouvez également passer d’un commentaire à un autre en utilisant le clavier. Appuyez sur les
touches Ctrl+Alt+Page suivante pour passer au commentaire suivant ou sur les touches 
Ctrl+Alt+Page précédente pour revenir au commentaire précédent.

Les commentaires peuvent être imprimés dans la marge droite du texte comme ils apparaissent à 
l’écran. Chaque page est mise à l’échelle pour que l’ensemble puisse être imprimé sur la taille de 
papier sélectionné.

Utiliser les notes de bas de page et les notes de fin

Les notes de bas de page apparaissent au bas de la page sur laquelle elles sont référencées. Les 
notes de fin sont regroupées à la fin du document.

Pour travailler de manière efficace avec les notes de bas de page et les notes de fin, vous devez 
pouvoir :
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• insérer des notes de bas de page ;

• définir le format des notes de bas de page ;

• déterminer sur la page l’emplacement des notes, ainsi que la couleur et le style de ligne des 
séparateurs.

Insérer des notes de bas de page / de fin

Pour insérer une note de bas de page ou une note de fin, placez le curseur de la souris à l’endroit 
où vous souhaitez que l’ancre de note de bas de page / de fin apparaisse. Sélectionnez ensuite In-
sertion > Note de bas de page / de fin dans la barre de menu puis choisissez Note de bas de 
page ou Note de fin ou cliquez sur l’icône Insérer une note de bas de page ( ) ou Insérer une
note de fin ( ) dans la barre d’outils standard.

Une ancre de bas de page (ou de fin) est insérée dans le texte, et le curseur de la souris est dépla-
cé dans la zone de note de bas de page en bas de la page (ou à la zone de note de fin à la fin du 
document). Saisissez le contenu de la note de bas de page ou de fin dans cette zone.

Vous pouvez aussi passer par le menu Insertion > Note de bas de page / de fin > Note de bas 
de page / de fin… pour ouvrir la boîte de dialogue Insérer une note de bas de page / de fin (voir
Figure 3.13). Vous pouvez y choisir d’utiliser la séquence de numérotation automatique spécifiée 
dans les paramètres de la note de bas de page ou encore d’insérer l’élément comme une note de 
bas de page ou une note de fin.

Figure 3.13 : La boîte de dialogue Insérer une note de bas de page/de fin

Si vous utilisez l’icône ou le menu Insérer une note de bas de page ou Insérer une note de fin, 
la note (de bas de page ou de fin) prend automatiquement les attributs définis précédemment dans
la boîte de dialogue Paramètres des notes de bas de page / de fin (accessible via le menu Outils 
> Notes de bas de page/de fin).

Vous pouvez éditer une note de bas de page / de fin existante de la même façon que vous éditez 
tout autre texte.

Pour supprimer une note de bas de page / de fin, supprimez son ancre. Le contenu de la note de 
bas de page / de fin est supprimé automatiquement et la numérotation des autres notes de bas de 
page / de fin est ajustée automatiquement.

Définir le format des notes de bas de page / de fin

Pour formater automatiquement les notes de bas de page / de fin, cliquez sur le menu Outils > 
Notes de bas de page / de fin. Dans la boîte de dialogue Paramètres de notes de bas de page/
de fin (voir Figure 3.14), définissez vos préférences.

Guide de LibreOffice Writer Utiliser les notes de bas de page et les notes de fin | 83



 Chapitre 3 Travailler avec le texte : Approfondissements

Figure 3.14 : Définir le format d’une note de bas de page/de fin.

Définir l’emplacement d’une note de bas de page et le trait de 
séparation

Le style de page définit l’emplacement des notes de bas de page dans un document ainsi que la 
couleur et le style du trait de séparation. Si vous insérez des notes de bas de page dans un docu-
ment contenant des styles de pages différents, vous devez paramétrer l’emplacement des notes 
ainsi que le style du trait de séparation pour chaque style de page.

Figure 3.15 : Définir l’emplacement d’une note de bas de page et le trait de séparation.

Pour afficher la boîte de dialogue Style de page, cliquez sur le menu Format > Page. Vous pouvez
également effectuer un clic droit sur une page et choisir Page dans le menu contextuel. Une fois la
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boîte de dialogue Style de page ouverte, cliquez sur l’onglet Note de bas de page (voir Figure 
3.15) et définissez vos préférences.

Modifier les notes de bas de page en note de fin et vice versa

Pour modifier une note de bas de page en note de fin (et vice versa), faites un clic droit sur l’ancre 
de la note de bas de page / de fin et sélectionnez Note de bas de page / de fin dans le menu 
contextuel. Cela ouvre une boîte de dialogue dans laquelle des modifications peuvent être faites.

Créer un lien vers une autre partie du document

Dans un document, si vous faites référence à une autre partie du même document, les références 
peuvent facilement devenir inexactes si vous réorganisez l’ordre des chapitres, ajoutez ou suppri-
mez des éléments, etc. Que vos références redirigent vers le même document ou un document ex-
terne, Writer propose deux manières de vous assurer qu’elles seront mises à jour :

• les hyperliens,

• les renvois.

Quelle que soit la méthode utilisée, si vous faites Ctrl+clic sur le lien quand le document est 
ouvert dans Writer, vous serez redirigé vers la cible dudit lien. Ces deux méthodes ont toutefois 
des différences majeures :

• le texte d’un hyperlien n’est pas mis à jour automatiquement si vous modifiez le texte de 
l’élément ciblé (à moins que vous ne le modifiiez manuellement). Le texte d’un renvoi est ac-
tualisé ;

• si vous recourez à un hyperlien, le choix des cibles sera limité (tableaux, cadres, images, ob-
jets OLE, sections, titres, repères de texte). Vous n’aurez pas la possibilité de lui désigner 
une cible précise (par exemple, une page en particulier dans le document ciblé). En utilisant 
un renvoi, vous aurez bien plus de possibilités ;

• pour créer un hyperlien vers un objet (une image, par exemple) qui afficherait une informa-
tion explicite telle que « Figure 6 », vous devez modifier le nom par défaut (« Images 6 ») en 
celui qui sera visible dans le document. Il vous est également possible de recourir à la boîte 
de dialogue Hyperlien pour modifier le texte visible dans le document. En revanche, les ren-
vois vers des images contenant des légendes automatiques affichent directement un texte 
explicite. Et si ce dernier ne vous convient pas, vous avez le choix entre plusieurs variantes ;

• si vous sauvegardez un document Writer en HTML, les hyperliens demeureront actifs, mais 
pas les renvois automatiques. Par contre, tant les hyperliens que les renvois automatiques 
resteront actifs si le document est exporté au format PDF.

Utiliser les renvois

Pour vous assurer que les références de votre document seront mises à jour si, par exemple, vous
renommez un titre ou la légende d’une figure, utilisez les renvois automatiques. Pour plus d’infor-
mations, référez-vous au paragraphe « Utiliser les renvois automatiques » du Chapitre 17 Tra-
vailler avec les champs, page 479.
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Utiliser les repères de texte

Les repères de texte sont répertoriés dans le navigateur et dans le champ Numéro de page de la 
barre d’état (par un clic droit). Ils sont directement accessibles en un clic de souris. Dans les docu-
ments HTML, les repères de texte sont convertis en ancres accessibles à l’aide des hyperliens. 
Pour plus d’informations sur les repères de texte, référez-vous à la section « Utiliser les repères 
de texte » du Chapitre 17 Travailler avec les champs, page 482.

Utiliser les hyperliens

Lorsque vous saisissez du texte qui peut être utilisé en tant qu’hyperlien (par exemple : l’adresse 
d’un site internet ou d’un URL), appuyez sur la barre espace ou la touche Entrée pour que Writer 
crée automatiquement l’hyperlien et lui applique un format spécifique (habituellement, il s’agit 
d’une couleur et d’un soulignement).

Si l’hyperlien (n')est (pas) créé automatiquement, vous pouvez (dés)activer cette fonction via l’on-
glet Options de la boîte de dialogue Options d’AutoCorrection (Outils > AutoCorrection > Op-
tions d’AutoCorrection dans la barre de menu) et en (dé)cochant l’option Détecter les URL.

Si vous ne souhaitez pas que Writer convertisse un URL spécifique en hyperlien, cliquez sur le 
menu Édition > Annuler : AutoCorrection ou appuyez sur les touches Ctrl+Z immédiatement 
après l’application du formatage.

Vous pouvez également insérer des hyperliens en utilisant le navigateur et la boîte de dialogue 
Hyperlien. Dans cette dernière, vous pourrez modifier tous les hyperliens actifs dans le document.

Remarque
L’adressage des hyperliens peut être paramétré comme relatif ou absolu grâce à l’option En-
registrer les URL relatifs au système de fichiers / à internet de la page Chargement / enregis-
trement – Général dans la boîte de dialogue Options (menu Outils > Options).

L’adressage relatif à un système de fichiers est uniquement possible si la source du docu-
ment et le document de référence sont tous les deux sur le même disque. Vous devez créer 
sur votre disque dur la même structure de dossiers que celle qui s’appliquera sur le site web 
de destination.

Pour des raisons de lisibilité, LibreOffice affiche des chemins absolus. Par conséquent, 
lorsque vous passez la souris au-dessus d’un hyperlien, l’infobulle affiche la référence abso-
lue même s’il s’agit d’un hyperlien relatif.

Insérer des hyperliens en utilisant le Navigateur

Le moyen le plus facile pour insérer un hyperlien vers une partie d’un document est d’utiliser le na-
vigateur :

 1) Ouvrez le document contenant les éléments que vous souhaitez référencer.

 2) Ouvrez le navigateur (en cliquant sur l’icône dans la barre d’outils ou sur le menu Affi-
chage > Navigateur, sélectionnant son onglet dans le volet latéral ou en appuyant sur la 
touche F5 de votre clavier).

 3) Dans le navigateur, cliquez sur la flèche à côté de l’icône Mode glisser et cochez l’option In-
sérer comme hyperlien.
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 4) Dans la liste située au bas du Navigateur, choisissez le document contenant l’élément que 
vous souhaitez référencer.

 5) Dans la liste du navigateur, sélectionnez l’élément que vous souhaitez insérer en tant qu’hy-
perlien.

 6) Depuis le navigateur, glissez l’élément à l’endroit du document où vous souhaitez insérer 
l’hyperlien. Le nom de l’élément est inséré dans le document en tant qu’hyperlien actif.

Figure 3.16 : Insérer un hyperlien à l’aide du Navigateur.

Insérer des hyperliens en utilisant la boîte de dialogue

Pour afficher la boîte de dialogue Hyperlien (voir Figure 3.17), cliquez sur l’icône Hyperlien  
dans la barre d’outils Standard ou cliquez sur le menu Insérer > Hyperlien. Pour convertir un texte
existant en un hyperlien, sélectionnez le texte dont il est question avant d’ouvrir la boîte de dia-
logue Hyperlien.

Figure 3.17 : La boîte de dialogue Hyperlien affichant les détails pour les liens internet.

Guide de LibreOffice Writer Créer un lien vers une autre partie du document | 87



 Chapitre 3 Travailler avec le texte : Approfondissements

Dans la partie gauche de la boîte de dialogue Hyperlien, choisissez l’un des quatre types d’hyper-
lien :

• Internet : une adresse web commençant habituellement par http:// ou https://;

• Courriel : pour une adresse e-mail, par exemple :

• Document : cliquer sur l’hyperlien redirige vers une autre partie du même document ou vers 
un autre document ;

• Nouveau document : cliquer sur l’hyperlien lance la création d’un nouveau document.

La partie supérieure droite de la boîte de dialogue Hyperlien se modifie en fonction du type d’hy-
perlien que vous choisissez dans colonne de gauche. Une description complète de tous les choix 
et de leurs interactions va au-delà des explications de ce chapitre. Par conséquent, seul un résu-
mé des choix les plus courants sera exposé.

Pour un hyperlien de type Internet, choisissez l’une des propositions : Web ou FTP. Saisissez ou 
collez ensuite l’adresse internet (URL) requise.

Pour un hyperlien de type Courriels, précisez l’adresse de destination et le sujet.

Pour un hyperlien de type Document, indiquez dans le champ Chemin l’emplacement où se trouve 
le document (le bouton Ouvrir un fichier permet d’ouvrir le navigateur de fichiers). Laissez toute-
fois le champ Chemin vide si vous ciblez une autre partie du document actif (par exemple : un ren-
voi vers un tableau). Dans ce cas, cliquez sur le bouton Cible dans le document pour ouvrir le Na-
vigateur où vous pourrez sélectionner la cible. Si vous connaissez le nom de la cible, vous pouvez 
le saisir directement dans le champ Cible.

Pour un hyperlien de type Nouveau document, déterminez si le nouveau document créé doit être 
édité immédiatement (Éditer maintenant) ou simplement créé (Éditer ultérieurement). Indiquez 
également le type du document à créer (texte, classeur, présentation, dessin ou autre). Le bouton 
Sélectionner un chemin permet de choisir l’emplacement où sera enregistré le document créé 
avec le nom que vous aurez déterminé dans le champ Fichier.

La section Paramétrages supplémentaires, située dans la partie inférieure droite de la boîte de dia-
logue Hyperlien, est commune à tous les hyperliens. À noter que certains choix correspondent plus
à certains types de liens.

• Cadre. Paramétrez la valeur afin de déterminer la façon dont l’hyperlien s’ouvrira. Cette fonc-
tion s’applique aux documents qui s’ouvrent dans un navigateur internet.

• Formulaire. Spécifiez si le lien sera présenté sous la forme de texte ou d’un bouton.

• Texte. Spécifiez le texte que l’utilisateur verra.

• Nom. Champ applicable aux documents HTML. Il spécifie le texte qui sera ajouté comme 
l’attribut NAME dans le code HTML de l’hyperlien.

• Événements. Ce bouton sera activé pour permettre à LibreOffice de réagir aux événements 
pour lesquels l’utilisateur a écrit du code (macro). Cette fonction n’est pas abordée dans ce 
guide.

Éditer des hyperliens

Pour éditer un hyperlien, cliquez n’importe où dans le texte contenant l’hyperlien. Ensuite, ouvrez 
la boîte de dialogue Hyperlien en cliquant sur l’icône Hyperlien de la barre d’outils Standard ou en 
cliquant sur Édition > Hyperlien dans la barre des menus. Il est également possible d’ouvrir la 
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boîte de dialogue Hyperlien en effectuant un clic droit sur l’hyperlien puis en cliquant sur Éditer 
l’hyperlien dans le menu contextuel. Effectuez vos changements et cliquez sur le bouton Appli-
quer pour les valider. Si vous avez besoin d’éditer plusieurs hyperliens, vous pouvez laisser la 
boîte de dialogue Hyperliens ouverte jusqu’à ce que vous les ayez tous modifiés. Veillez seule-
ment à bien cliquer sur le bouton Appliquer pour chaque hyperlien. Lorsque vous avez terminé, 
cliquez sur le bouton Fermer.

Par défaut, LibreOffice permet de suivre les hyperliens en utilisant la combinaison Ctrl+clic 
gauche. Ce comportement peut être modifié en cliquant sur le bouton Options dans la page 
LibreOffice – Sécurité de la boîte de dialogue Options (menu Outils > Options). Il suffit de déco-
cher l’option Cliquer + touche Ctrl pour activer les hyperliens. Si un simple clic suffit pour activer 
vos hyperliens, vérifiez si cette option est bien décochée. Il est conseillé à l’utilisateur de conserver
les options par défaut pour des raisons de sécurité (déclenchement non intentionnel).

Pour changer la couleur des hyperliens, ouvrez la page LibreOffice – Couleurs de l’interface de la 
boîte de dialogue Options menu Outils > Options). Recherchez dans la liste de gauche les choix 
Liens non visités et Liens visités. Cochez-les, choisissez la nouvelle couleur puis cliquez sur le 
bouton OK pour valider votre choix. À noter que cette modification de couleur sera valable pour 
tous les hyperliens de tous les modules de LibreOffice.

Dans le module Writer, vous pouvez également modifier le style de caractère pour les liens internet
ou bien définir et appliquer de nouveaux styles aux liens sélectionnés.

Numérotation des lignes

La Numérotation des lignes permet de placer un numéro de ligne dans la marge du document en-
tier ou de paragraphes sélectionnés. Les numéros de lignes sont affichés à l’écran et sont égale-
ment imprimables. Vous pouvez aussi ajouter un séparateur entre les numéros de lignes. La Fi-
gure 3.18 montre un exemple de numérotation à chaque ligne.

Figure 3.18 : Exemple de numérotation des lignes.

Vous pouvez paramétrer le nombre de lignes à numéroter (par exemple, chaque ligne ou bien 
toutes les 10 lignes), le type de numérotation et si la numérotation doit recommencer à un sur 
chaque page. En outre, une ligne de séparation peut être définie sur différents niveaux de numéro-
tation (par exemple, toutes les 12 lignes).

Pour ajouter les numéros de lignes à un document entier :

 1) Cliquez sur le menu Outils > Numérotation des lignes et cochez l’option Afficher la numé-
rotation en haut à gauche de la boîte de dialogue Numérotation des lignes (voir Figure 3.19).

 2) Sélectionnez les options qui vous conviennent puis cliquez sur OK.
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Figure 3.19 : La boîte de dialogue Numérotation des lignes.

Pour ajouter des numéros de lignes à des paragraphes particuliers, il faut d’abord désactiver la 
fonction pour le document puis l’activer pour des paragraphes ou des styles de paragraphes spéci-
fiques.

Pour désactiver la numérotation de lignes pour le document, modifiez le style de paragraphe Style 
par défaut (car tous les styles de paragraphe sont basés sur celui-ci) :

 1) Dans le volet latéral, ouvrez l’onglet Styles et formatage et cliquez sur l’icône Styles de pa-
ragraphe.

 2) Faites un clic droit sur le Style par défaut et choisissez Modifier.

 3) Cliquez sur l’onglet Plan & numérotation (voir Figure 3.20).

 4) Dans la section Numérotation des lignes, décochez l’option Inclure les lignes de ce para-
graphe.

 5) Cliquez sur OK.

Figure 3.20 : Désactiver la numérotation de lignes pour un document
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Pour activer la numérotation de lignes pour certains paragraphes déterminés :

 1) Sélectionnez les paragraphes où vous voulez ajouter les numéros de lignes.

 2) Choisissez Format > Paragraphe et cliquez sur l' onglet Plan & numérotation.

 3) Cochez l’option Inclure les lignes de ce paragraphe.

 4) Cliquez sur OK.

Vous pouvez aussi créer un style de paragraphe qui inclut la numérotation des lignes et l’appliquer 
aux paragraphes que vous désirez. Par exemple, vous pouvez numéroter les lignes d’un exemple 
de code dans un document ; pour le code, vous utiliserez probablement une police ou une indenta-
tion différente de celles du texte normal. Pour préciser le numéro de ligne par lequel commencer :

 1) Cliquez dans le paragraphe et choisissez Format > Paragraphe.

 2) Dans l' onglet Plan & numérotation, vérifiez que l’option Inclure les lignes de ce paragraphe 
est cochée.

 3) Cochez la case Recommencer avec ce paragraphe et saisissez un numéro de ligne dans le 
champ Démarrer avec.

 4) Cliquez sur OK.
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Chapitre 4
Mettre le texte en forme





Introduction

Ce chapitre présente les bases de la mise en forme du texte dans Writer, le module de traitement 
de texte de LibreOffice :

• mise en forme des paragraphes et des caractères ;

• utilisation de la mise en forme automatique ;

• création de listes à puce, numérotées ou hiérarchiques.

Cela suppose que vous êtes familiarisé avec les techniques décrites au Chapitre 2 Travailler avec 
le texte : les bases, et au Chapitre 3 Travailler avec le texte : Approfondissements.

Nous vous recommandons aussi de suivre les suggestions présentées au Chapitre 20 Paramétrer 
Writer, page 556, concernant l’affichage des aides au formatage, telles que les marques de fin de 
paragraphe, et le choix des autres options de paramétrage.

La mise en forme des pages est présentée aux chapitres 5 et 6.

Il est recommandé d’utiliser des styles

Les styles sont au centre de Writer. Ils vous permettent de mettre facilement en forme un docu-
ment de façon cohérente et d’en changer le formatage avec un minimum d’efforts. Un style est un 
ensemble dénommé d’options de formatage. Quand vous appliquez un style, vous appliquez tout 
un groupe de formats en même temps.

En supplément, LibreOffice utilise les styles dans de nombreux processus dont vous n’avez peut-
être pas conscience. Par exemple, Writer s’appuie sur les styles de titres (ou d’autres styles choi-
sis par vous) pour compiler une table des matières. L’utilisation des styles de paragraphe est donc 
hautement recommandée à la place de la mise en forme manuelle des paragraphes, surtout pour 
des documents longs et standardisés. L’utilisation des styles de caractère à la place de leur forma-
tage manuel est aussi chaudement recommandée.

Pour plus d’informations sur les styles et leurs utilisations, voir les chapitres 8 et 9 de ce livre.

L’application des styles est rapide et facile si vous utilisez l’onglet Styles et formatage du volet laté-
ral.

! Attention

Le formatage manuel (aussi appelé mise en forme directe) prend le pas sur les styles et il ne
peut pas être supprimé en appliquant un style après lui.

Supprimer un formatage manuel

Pour supprimer une mise en forme manuelle, sélectionnez le texte puis choisissez Format > Effa-
cer le formatage direct dans la barre de menu, cliquez sur le bouton Effacer le formatage direct

 dans la barre d’outils Formatage ou utilisez la combinaison de touches Ctrl+M.

Remarque

Quand on efface un formatage direct, le texte reprend le style appliqué au paragraphe, non 
le style de paragraphe par défaut.
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Formater les paragraphes

Vous pouvez appliquer de nombreux formats aux paragraphes en utilisant les boutons de la barre 
d’outils Formatage et du panneau Paragraphe de l’onglet Propriétés du volet latéral (Affichage > 
Volet latéral). Tous les boutons de la barre d’outil ne sont pas visibles dans l’installation standard, 
mais vous pouvez la personnaliser pour y faire apparaître ceux que vous utilisez régulièrement 
(voir le  Chapitre 1 Introduction à Writer, page20). D’autres options de mise en forme sont offertes 
par la boîte de dialogue Paragraphe (voir page 100).

La barre d’outils Formatage offre, entre autres, les boutons et les formats suivants :

• définir le style de Paragraphe (liste déroulante Style sur l’onglet Propriétés du volet latéral) ;

• (dés)activer les puces (avec une palette de styles de puces) – voir page 112 ;

• (dés)activer la numérotation (avec une palette de styles de numérotations) – voir page 112 ;

• aligner à gauche, centrer horizontalement, aligner à droite ou justifier ;

• aligner en haut, centrer verticalement, aligner en bas ;

• définir l’interligne (choisir entre 1, 1,15, 1,5, 2 ou une valeur personnalisée) ;

• augmenter et diminuer l’espacement entre les paragraphes ;

• augmenter et diminuer l’indentation ;

• ouvrir la boîte de dialogue Paragraphe.

Aligner à gauche Centrer horizontalement

Aligner à droite Justifier

Puces Numérotation

Couleur d’arrière-plan

Augmenter l’espacement Diminuer l’espacement

Augmenter le retrait Diminuer le retrait

Passer en retrait négatif

Espacement au-dessus 
du paragraphe

Retrait avant le texte

Espacement en dessous
du paragraphe

Retrait après le texte

Interligne Retrait de première ligne

Figure 4.1 : Panneau Paragraphe de l’onglet Propriétés du Volet latéral.

Le volet latéral s’ouvre par défaut sur l’onglet Propriétés. Cliquez sur les symboles d’expansion (+ 
ou triangle) pour ouvrir les panneaux si nécessaire.

Le panneau Paragraphe de l’onglet Propriétés (Figure 4.1) propose la plupart des contrôles de 
mise en forme, y compris plusieurs qui ne se trouvent pas sur la barre d’outils Formatage. Cliquez 
sur la flèche vers le bas à côté d’un bouton offre des choix supplémentaires, tels que des inter-
lignes prédéfinis ou une palette de couleurs.

Cliquez sur le bouton Plus d’options  ouvre la boîte de dialogue Paragraphe, où d’autres para-
mètres sont accessibles (voir page 100). Changer la valeur d’un paramètre quelconque n’affecte 
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que le paragraphe où est situé le point d’insertion (curseur), ou tous les paragraphes sélectionnés 
le cas échéant. Si vous désirez modifier les valeurs des paramètres de nombreux paragraphes du 
même type, vous devriez utiliser un style de paragraphe.

Options d’alignement

Vous pouvez utiliser les quatre premiers boutons de la Figure 4.1 ( , , , ) pour définir 
l’alignement d’un paragraphe : à gauche, centré, à droite ou justifié. La Figure 4.2 montre des 
exemples des options d’alignement appliquées à un texte.

Figure 4.2 : Options d’alignement du texte

Quand on utilise un texte justifié, la dernière ligne est, par défaut, alignée à gauche. Vous pouvez 
cependant aussi aligner cette dernière au centre de la zone de paragraphe ou la justifier de sorte 
que des espaces sont insérés entre les mots pour remplir toute la ligne. Si vous sélectionnez l’op-
tion Étirer un mot seul, chaque fois que la dernière ligne d’un paragraphe justifié sera constituée 
d’un seul mot, celui-ci sera étiré en insérant des espaces entre les lettres pour qu’il occupe toute la
longueur de la ligne.

La Figure 4.3 montre un exemple de l’effet obtenu en choisissant tour à tour ces options avec une 
police de caractère classique. Dans la plupart des cas, il vaudra mieux laisser la configuration par 
défaut (aligné à gauche), mais, pour obtenir des effets spectaculaires (comme avec une police très
grande sur une affiche), vous préférerez peut-être un des autres choix.

Figure 4.3 : Exemples des choix pour la dernière ligne d’un paragraphe justifié.

Ces options sont définies dans l’onglet Alignement de la boîte de dialogue Paragraphe (Figure 
4.4), qui s’ouvre en choisissant Format > Paragraphe dans la barre de menu, en faisant un clic 
droit dans le paragraphe et en sélectionnant Paragraphe dans le menu contextuel ou en cliquant 
sur le bouton Plus d’options du panneau Paragraphe dans l’onglet Propriétés du volet latéral.
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Figure 4.4 : Options pour la dernière ligne d’un paragraphe justifié.

Espacement de lignes et de paragraphes

L’interligne (bouton , Figure 4.1) représente la distance entre une ligne de base (la ligne imagi-
naire en bas d’une lettre telle que « n » ou « m ») et la ligne de base suivante. Il est déterminé par 
la taille de la police.

Figure 4.5 : L’interligne est la distance entre deux lignes de base

Le menu déroulant Interligne est présenté dans la Figure 4.6.
Vous pouvez y faire votre choix parmi des interlignes standards
ou définir une valeur personnalisée : Proportionnel (par exemple,
110 %), Au moins (la valeur précisée dans le champ Valeur), En
début ou Fixe. Pour voir la différence entre ces choix, saisissez
quelques paragraphes d’exemple et modifiez leurs interlignes.
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Remarque

Toutes les options sauf Fixe et Au moins utilise la police par défaut. Ces deux dernières 
vous permettent de définir votre propre interligne, ce qui est particulièrement utile pour facili-
ter la lecture des polices de petite taille.

L’espacement des paragraphes concerne l’espace vertical entre un paragraphe et les paragraphes
situés au-dessus et en dessous. Comme le montre la Figure 4.1, les valeurs courantes sont pré-
sentées dans le champ Espacement au-dessus du paragraphe ( ) et Espacement en dessous 
du paragraphe ( ). Vous pouvez modifier ces paramètres indépendamment l’un de l’autre.

Conseil

L’espacement des paragraphes est souvent utilisé dans la documentation informatique, 
comme dans ce manuel. L’indentation des paragraphes (voir ci-dessous) est plus souvent 
utilisée dans les autres documents. Pour une mise en page correcte, utilisez l’un ou l’autre, 
mais pas les deux.

Retrait de paragraphe

Le bouton  sur la Figure 4.1 augmente le Retrait avant le texte de la valeur d’une tabulation par 
défaut. Celle-ci est définie dans la boîte de dialogue Options (Outils > Options), à la page 
LibreOffice Writer – Général grâce au champ Tabulation de la section Paramètres. Le bouton  
diminue ce retrait de la même valeur.

Le champ  détermine le Retrait avant le texte, c’est-à-dire entre celui-ci et la marge gauche, le 
champ  définit le Retrait après le texte, entre celui-ci et la marge de droite, et le champ  
donne la valeur du Retrait de première ligne qui s’ajoute au retrait avant le texte.

Le bouton , Passer en retrait négatif, laisse la première ligne à la marge de gauche (ou au re-
trait spécifié auparavant) et indente toutes les autres lignes de la valeur définie par le bouton  
ou dans la boîte de dialogue Paragraphe.

Figure 4.7 : Exemples de paragraphes avec Retrait de première ligne positif ou négatif.

Remarque

Dans les langues qui s’écrivent de droite à gauche, le comportement des retraits avant le 
texte et après le texte est inversé : « avant » concerne la marge de droite ; « après » s’ap-
plique à la marge de gauche.
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Couleur d’arrière-plan du paragraphe

Cliquez sur le bouton numéro  dans la Figure 4.1 pour ouvrir une palette dans laquelle vous 
pourrez choisir une couleur pour l’arrière-plan du paragraphe. Dans cette palette, vous pouvez 
aussi cliquer sur Couleurs personnalisées… pour ouvrir la boîte de dialogue Choisir une couleur 
où vous pouvez définir de nouvelles couleurs à ajouter à la palette.

Figure 4.8 : Choix de la couleur d’arrière-plan d’un paragraphe.

Remarque

Si le paragraphe a reçu un retrait avant ou après le texte, la couleur d’arrière-plan ne s’étend
qu’à la zone couverte par le paragraphe. Si vous désirez l’étendre jusqu’à la marge, vous 
devrez utiliser un cadre, un tableau ou une autre méthode : voir le Chapitre 6 Mise en page :
approfondissements, pages 148 et 153.

Paramètres de la boîte de dialogue Paragraphe

La boîte de dialogue Paragraphe contient plusieurs onglets supplémentaires : Tabulations (présen-
tée dans la section suivante « Définir des arrêts de tabulation et des retraits »), Bordures, Let-
trines, Arrière-plan (qui offre d’autres choix que la simple couleur), Transparence, Enchaînements 
et Plan & numérotation. Pour plus d’informations, voyez le Chapitre 8 Introduction aux styles et le  
Chapitre 9 Travailler avec les styles page 236 et suivantes.

Bordures

Les bordures sont utiles pour isoler un paragraphe du texte environnant, pour inclure une digres-
sion dans le sujet principal. Par exemple, les Remarques, Conseils et Attention de ce livre com-
portent une bordure sous le texte.

Vous pouvez ajouter des bordures à toute combinaison des côtés haut, bas, droit et gauche du pa-
ragraphe. Vous pouvez aussi choisir le style (continu, pointillé, tirets, double), la largeur et la cou-
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leur des lignes ; ces choix s’appliquent à toutes les bordures d’un paragraphe. L’espace entre 
chaque ligne et le contenu du paragraphe peut être défini individuellement pour les quatre côtés.

Figure 4.9 : Choix des bordures d’un paragraphe.

Dans cette boîte de dialogue, vous pouvez aussi appliquer une ombre au paragraphe ; « Dis-
tance » se rapporte à la largeur de l’ombre.

Cochez l’option Fusionner avec le paragraphe suivant pour supprimer les lignes du haut et du bas 
quand l’indentation, les bordures et l’ombre du paragraphe suivant sont identiques à celles du pa-
ragraphe courant.

Lettrines

Les lettrines sont des lettres agrandies qui marquent le début d’un nouveau chapitre ou d’une nou-
velle section. Pour améliorer la cohérence de la mise en page, il vaut mieux les définir dans un 
style de paragraphe que vous appliquerez aux paragraphes concernés. Voir le Chapitre 9 Tra-
vailler avec les styles, page 231, pour plus de détails.

Arrière-plan

L’arrière-plan (aussi appelé « fond » ou « zone ») offre cinq types de remplissage (fond) : couleur, 
dégradé, bitmap (image matricielle), motif et hachures. Sélectionnez un type de remplissage pour 
afficher les choix qu’il propose. Ceux-ci sont présentés en détail dans le Chapitre 5 Mise en page : 
les bases, page 137 et suivantes. Vous pouvez aussi créer vos propres fonds.

Figure 4.10 : Cinq types de fonds pour l’arrière-plan d’un paragraphe.
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Transparence

La transparence affecte l’arrière-plan du paragraphe. Elle est utile pour créer des filigranes ou 
rendre les couleurs et les images plus pâles (pour augmenter leur contraste avec le texte). Les 
choix possibles sont présentés au Chapitre 5 Mise en page : les bases, page 141, et, en détail, 
dans le Guide Draw.

Enchaînements

L’onglet Enchaînement (Figure 4.11) possède plusieurs sections. La coupure de mot est présentée
 Chapitre 2 Travailler avec le texte : les bases, page 58, et les sauts sont décrits au Chapitre 5 
Mise en page : les bases., page 120 et 130.

Figure 4.11 : Options d’enchaînement  : coupure de mots, sauts et maintien des paragraphes
ensemble.

Dans la section Options, vous pouvez préciser comment les paragraphes se comportent en bas 
des pages. Les deux options Ne pas scinder le paragraphe et Conserver avec le paragraphe sui-
vant sont suffisamment explicites. Les deux autres options vous permettent d’éviter une ligne iso-
lée en haut (une orpheline) ou en bas (une veuve) d’une page.

Plan & numérotation

L’onglet Plan & numérotation (Figure 4.12) de la boîte de dialogue Paragraphe offre le moyen de 
choisir le niveau de plan du paragraphe et son style de numérotation. S’il fait partie d’une liste nu-
mérotée, vous pouvez préciser que la numérotation doit recommencer à ce paragraphe, et avec 
quel numéro.

Cet onglet ne remplit pas les mêmes fonctions que la boîte de dialogue Numérotation des cha-
pitres (Outils > Numérotation des chapitres) mais le niveau de plan sélectionné ici est relié à la 
numérotation définie là-bas. Voir le Chapitre 8 Introduction aux styles, page 224, et le Chapitre 9 
Travailler avec les styles, page 245, pour une présentation de ces fonctions. La numérotation des 
lignes est présentée au Chapitre 3 Travailler avec le texte : Approfondissements, page 89.
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Figure 4.12 : Choix du niveau de plan, de la numérotation du paragraphe et de celle des lignes.

Définir des arrêts de tabulation et des retraits

La règle horizontale affiche la position des arrêts de tabulation. Tout arrêt que vous définissez sup-
prime les arrêts par défaut situés à sa gauche. Les positions des tabulations affectent l’indentation 
des paragraphes entiers (par les boutons Augmenter le retrait et Diminuer le retrait de la barre 
d’outils Formatage ou du panneau Paragraphe de l’onglet Propriétés du volet latéral) ainsi que 
celle de parties de paragraphe (en appuyant sur la touche Tabulation du clavier).

Conseil

De nombreux retraits, par exemple en début d’un paragraphe, peuvent être définis dans le 
style de paragraphe si bien que vous n’aurez pas besoin de la touche Tabulation pour les
activer.

Modifier l’espacement par défaut des tabulations peut poser des problèmes de mise en forme si 
vous partagez des documents avec d’autres personnes. Si vous utilisez l’espacement par défaut 
des tabulations et que vous envoyez votre document à quelqu’un qui a choisi un espacement par 
défaut différent, les positions des tabulations qu’il verra dans le document seront celles qu’il a défi-
nies et non celles définies par défaut ; il vaut mieux définir vos propres positions de tabulation 
comme il est décrit dans cette section.

Pour définir les paramètres d’indentation et de tabulation d’un ou plusieurs paragraphes sélection-
nés, faites un clic droit sur un paragraphe et choisissez Paragraphe… pour ouvrir la boîte de dia-
logue Paragraphe puis sélectionnez soit l’onglet Tabulations (Figure 4.13), soit l’onglet Retraits et 
espacements. Vous pouvez aussi ouvrir ce dernier onglet par un double clic sur la règle horizon-
tale.

Une meilleure stratégie consiste à définir les tabulations dans le style de paragraphe. Voyez les 
chapitres 8 et 9 pour plus d’informations sur les styles de paragraphes.

Conseil

L’utilisation des tabulations pour espacer des éléments du texte sur une page n’est pas re-
commandée. Selon ce que vous désirez obtenir, un tableau est souvent un meilleur choix.
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Figure 4.13 : Choix de l’emplacement des arrêts de tabulation et des caractères de remplissage.

Modifier l’intervalle de tabulation par défaut

! Attention

Toute modification du paramétrage par défaut des tabulations affectera les arrêts de tabula-
tion par défaut dans tout document que vous ouvrirez après cela, ainsi que tous ceux que 
vous insérerez après la modification.

Pour définir l’unité de mesure et l’intervalle par défaut entre deux tabulations, ouvrez la page 
LibreOffice Writer – Général de la boîte de dialogue Options (Outils > Options).

Figure 4.14 : Choix d’un intervalle de tabulation par défaut.

Vous pouvez aussi modifier directement l’unité utilisée pour les règles dans le document en cours 
en faisant un clic droit sur la règle. Dans le menu déroulant qui s’ouvre alors (Figure 4.15), sélec-
tionnez l’unité à appliquer uniquement à cette règle.

Figure 4.15 : Modification de l’unité de mesure d’une règle.

Formater les caractères

Vous pouvez appliquer de nombreux formats aux caractères grâce aux boutons de la barre d’outils
Formatage ou du panneau Caractères de l’onglet Propriétés du volet latéral. Tous les boutons ne 
sont pas visibles dans l’installation standard de la barre d’outils, mais vous pouvez la personnaliser
pour y inclure ceux que vous utilisez régulièrement. Voir le Chapitre 1 Introduction à Writer, page
20.

Parmi ces formats, on trouve :
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• nom et taille (en points) de la police ;

• gras, italique, souligné, double souligné, surligné, barré, contour ;

• exposant et indice ;

• majuscule et minuscule ;

• augmenter et diminuer la taille de la police ;

• couleur de la police (avec une palette de couleurs) ;

• couleur de l’arrière-plan (avec une palette de couleurs) ;

• couleur de mise en évidence (avec une palette de couleurs) ;

• caractère (pour ouvrir la boîte de dialogue Caractère.

Pour modifier les caractéristiques d’un paragraphe entier (par exemple, le nom, la taille ou la cou-
leur de la police) ainsi que pour de nombreuses autres opérations, il est chaudement recommandé
d’utiliser des styles au lieu de formater manuellement les caractères. Pour plus d’information sur 
les styles et leur utilisation, voyez les chapitres 8 et 9. L’application des styles est simple et rapide 
si vous utilisez l’onglet Styles et formatage du volet latéral.

La Figure 4.16 montre le panneau Caractère de l’onglet Propriétés du volet latéral. Cliquer sur la 
flèche vers le bas à côté d’un bouton ouvre une palette de choix pour le contrôle, comme la cou-
leur des caractères ou leur espacement. Cliquez sur le bouton Plus d’options  ouvre la boîte de
dialogue Caractère, où d’autres paramètres sont accessibles (voir page 106).

L’apparence des boutons peut varier selon votre système d’exploitation et les choix de style et de 
taille des icônes que vous avait faits dans la page LibreOffice – Affichage de la boîte de dialogue 
Options (Outils > Options) : ici Windows 10, style Colibre et taille automatique.

Gras Italique

Souligné Barré

Ombre

Augmenter la taille Diminuer la taille

Couleur de la police Couleur de mise en évidence

Espacement des caractères

Exposant Indice

Figure 4.16 : Le panneau Caractère de l’onglet Propriétés du Volet latéral.

Nom, taille et effets de police

Pour modifier le nom et la taille de la police utilisée pour les caractères sélectionnés, vous pouvez 
vous servir des listes déroulantes de la barre d’outils Formatage, du panneau Caractère du volet 
latéral ou de la boîte de dialogue Caractère.

De la même manière, vous pouvez appliquer les effets Gras, Italique, Souligné, Barré ou Ombre
aux caractères sélectionnés par l’intermédiaire de la barre d’outils Formatage, du panneau Carac-
tère du volet latéral ou de la boîte de dialogue Caractère. L’effet Souligné dispose d’un menu dé-
roulant qui propose plusieurs types de lignes (Figure 4.17). La barre d’outils Formatage comporte 
d’autres effets qui n’apparaissent pas dans le Volet latéral : surligné et double souligné ; ces bou-
tons peuvent ne pas être visibles dans l’installation par défaut.
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Pour choisir la couleur de la police ou de la mise en valeur, ou-
vrez la palette de couleur concernée (  ou  : identique à celle
présentée à la Figure 4.8). La couleur choisie pour la mise en va-
leur est placée au-dessus de celle qui est appliquée en arrière-
plan du paragraphe.

Pour augmenter ( ) ou diminuer ( ) rapidement la taille de la
police des caractères sélectionnés, vous pouvez cliquer sur le
bouton concerné dans la barre d’outils Formatage ou le panneau 
Caractère du volet latéral ; vous ne pourrez cependant pas
contrôler la valeur de la variation, qui est normalement de 2
points. Pour un contrôle plus précis, utilisez plutôt la liste dérou-
lante Taille de police.

Pour placer les caractères en exposant ( ) ou en indice ( )
(avec les valeurs par défaut pour la taille et la position), sélection-
nez-les et cliquez sur le bouton concerné de la barre d’outils For-
matage ou du panneau Caractère du Volet latéral. Pour un
contrôle plus précis, utilisez la boîte de dialogue Caractère.

Pour modifier rapidement l’espace entre les caractères, sélection-
nez-les et faites votre choix dans la liste déroulante Espacement
des caractères ( ) du volet latéral (Figure 4.18).

Paramètres de la boîte de dialogue Caractère

La boîte de dialogue Caractère possède six onglets présentés
dans cette section. La plupart sont identiques aux onglets de la
boîte de dialogue Style de caractère (voir le Chapitre 9 Travailler 
avec les styles, page 249).

Police et effets de caractère

Dans l’onglet Police (Figure 4.19) vous pouvez spécifier la famille
de police, le style (le choix varie avec la police, mais on y trouve
habituellement Normal, Gras et Italique), et la taille ; on peut aussi
y choisir une langue pour les caractères sélectionnés si elle diffère
de la langue du document. La zone en bas de la boîte de dialogue
affiche un aperçu correspondant aux choix effectués.
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Figure 4.19 : L’onglet Police de la boîte de dialogue Caractère.

Dans l’onglet Effets de caractère (Figure 4.20), vous pouvez choisir la couleur de la police et une 
gamme d’effets qui ne sont, pour beaucoup d’entre eux, pas adaptés aux documents normaux. La
Figure 4.21 montre les choix offerts pour certains effets dans des listes déroulantes.

Figure 4.20 : L’onglet Effets de caractère de la boîte de dialogue Caractère.
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Figure 4.21 : Choix de la casse, du relief, de la façon de barrer et du surlignage des caractères.

Position

L’onglet Position rassemble les options qui affectent la position du texte sur la page. Elle est parta-
gée en trois parties : Position, Rotation/Échelle et Espacement (Figure 4.22).

La section Position gère l’apparence des exposants et des indices.

La section Rotation/Échelle contrôle la rotation des caractères. Le champ Échelle de largeur 
contrôle le pourcentage de la largeur de police par lequel le texte pivoté sera comprimé ou étendu.

Figure 4.22 : L’onglet Position de la boîte de dialogue Caractère.

La section Espacement contrôle l’espacement entre les caractères individuels. L’option Paire de 
crénage (cochée par défaut) ajuste automatiquement l’espace entre certains caractères prédéfinis.
Le crénage n’est disponible que pour certains types de police et ne fonctionne à l’impression que 
si votre imprimante le gère.
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Hyperlien

L’onglet Hyperlien de la boîte de dialogue Caractère offre une alternative à l’utilisation de la boîte 
de dialogue Hyperlien (Insertion > Hyperlien). Il donne moins de choix et concerne spécifique-
ment les liens textuels (pas les boutons). Les hyperliens peuvent être dirigés vers d’autres parties 
du même document, vers d’autres documents ou vers des pages web.

Figure 4.23 : L’onglet Hyperlien de la boîte de dialogue Caractère.

Quand LibreOffice reconnaît qu’une chaîne de caractères pourrait être une URL (une adresse in-
ternet), il les remplace par un hyperlien formaté comme spécifié dans le style de caractère Lien In-
ternet. Dans cette boîte de dialogue, vous pouvez choisir un style de caractère différent (s’il a été 
défini auparavant) ou remplacer l’URL par un autre texte. Pour désactiver cette fonction, choisis-
sez Outils > AutoCorrection > Options d’AutoCorrection et ouvrez la page Options pour déco-
cher Détecter les URL.

Pour plus d’informations sur la création et l’édition des hyperliens, voyez l’Aide ou le chapitre 12 du
Guide de Démarrage.

Surlignage

L’onglet Surlignage contrôle la couleur d’arrière-plan des caractères sélectionnés. Elle remplit la 
même fonction que la palette de Mise en évidence (  sur la Figure 4.16).

! Attention

Dans la version francophone, la boîte de dialogue Caractère utilise le mot Surlignage à 
deux endroits dans deux sens différents : dans l’onglet Effets de caractère pour parler des 
caractères surmontés d’un trait (« surlignés » : voir la Figure 4.20 et la Figure 4.21) et dans 
l’onglet Surlignage pour parler de la couleur de fond des caractères comme s’ils étaient re-
couverts d’un trait de surligneur.

Bordures

L’onglet Bordures est identique à l’onglet de même nom de la boîte de dialogue Paragraphe. Voir 
page 100.
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Mise en forme automatique

Vous pouvez paramétrer Writer pour qu’il formate automatiquement des parties d’un document 
d’après les choix faits dans les onglets Options et Options linguistiques de la boîte de dialogue Au-
toCorrection (Outils > AutoCorrection > Options d’AutoCorrection).

Conseil

Si vous constatez des modifications inattendues dans la mise en forme de votre document, 
c’est là qu’il faut d’abord en chercher la cause.

L’Aide décrit tous ces choix et la façon d’activer les mises en forme automatiques. Parmi les modi-
fications de mise en forme inattendues ou non désirées, on trouve :

• les lignes horizontales. Si vous tapez trois tirets (---), tirets de soulignement (___) ou signes 
égal (===) ou plus en début de ligne avant d’appuyer sur la touche Entrée, le paragraphe 
est remplacé par une ligne horizontale de la largeur de la page. Cette ligne est en fait la bor-
dure inférieure du paragraphe précédent ;

• les listes à puces et numérotées. Une liste à puces est créée quand vous tapez un tiret (-), 
un astérisque (*) ou un signe plus (+) suivi d’un espace ou d’une tabulation au début d’un pa-
ragraphe. Une liste numérotée est créée quand vous saisissez un nombre suivi d’un point (.) 
puis d’un espace ou d’une tabulation au début d’un paragraphe. La numérotation automa-
tique n’est appliquée qu’aux paragraphes possédant le Style par défaut, le style Corps de 
texte ou le style Retrait de corps de texte.

Pour formater automatiquement le document avec les options que vous avez choisies, cliquez sur 
Outils > AutoCorrection et sélectionnez ou désélectionnez les éléments du sous-menu.

Pendant la frappe

Le document est automatiquement mis en forme pendant que vous tapez.

Appliquer

Le document est automatiquement mis en forme.

Appliquer et éditer les modifications

Le document est automatiquement mis en forme puis une boîte de dialogue s’ouvre pour 
vous permettre d’accepter ou de rejeter les modifications.

Options d’AutoCorrection

Ouvre la boîte de dialogue AutoCorrection (Figure 4.24 et Figure 4.25).

L’onglet Options linguistiques (Figure 4.25) contrôle le formatage des ponctuations doubles 
(point d’interrogation, point-virgule, deux-points, etc.), des apostrophes et des guillemets 
simples et doubles. La plupart des polices incluent des guillemets simples courbes, mais, 
dans certaines utilisations comme l’indication des minutes et des secondes d’angles, vous 
désirerez peut-être les conserver comme apostrophes droites.

Guillemets droits Guillemets typographiques

' ' " " ‘ ’ « »
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Conseil

La plupart des utilisateurs conservent le paramétrage des guillemets typographiques et uti-
lise la boîte de dialogue Caractères spéciaux pour insérer des guillemets droits quand ils 
sont nécessaires. Voir le Chapitre 2 Travailler avec le texte : les bases, page 48.

Figure 4.24 : Choix de mise en forme automatique dans l’onglet Options de la boîte de dialogue
AutoCorrection.
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Figure 4.25 : Choix de mise en forme automatique dépendant de la langue.

Formater des listes à puce ou numérotées

Vous pouvez formater des listes numérotées ou à puces de plusieurs façons :

• utiliser la mise en forme automatique décrite ci-dessus ;

• utiliser les styles de liste (Numérotation) comme cela est décrit aux chapitres 8, 9 et 12 de ce
livre ;

• utiliser la barre d’outils Puces et numérotation (voir Figure 4.26) ;

• utiliser les boutons Numérotation  et Puces  de la barre d’outils Formatage ou dans le 
panneau Paragraphe de l’onglet Propriétés du Volet latéral (voir Figure 4.27) ;

• utiliser la boîte de dialogue Puces et numérotation (voir Figure 4.28 et Figure 4.29).

Pour créer une liste à puces ou numérotée simple, sélectionnez les paragraphes qui vont compo-
ser la liste puis cliquez sur le bouton approprié dans le panneau Paragraphe du volet latéral.

Remarques
Le fait de commencer par taper le texte puis de le transformer en liste ou d’appliquer le for-
mat en liste à mesure que vous tapez est affaire de choix personnel.

Si une numérotation ou une puce a été appliquée automatiquement d’une façon que vous 
trouvez inappropriée, vous pouvez les désactiver temporairement en décochant Outils > 
AutoCorrection > Pendant la frappe.
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Utiliser la barre d’outils Puces et numérotation

Vous pouvez créer une liste imbriquée (où un ou plusieurs éléments de la liste possèdent une 
sous-liste comme dans un plan) en utilisant les boutons de la barre d’outils Puces et numérotation 
(Figure 4.26). Vous pouvez déplacer les éléments vers le haut ou le bas de la liste, créer des sous-
points, changer le style de puces, ajouter des paragraphes sans puce ni numéro (pour les élé-
ments d’une liste qui comportent plusieurs paragraphes) et accéder à la boîte de dialogue Puces 
et numérotation qui contient des contrôles plus détaillés.

Utilisez Affichage > Barres d’outils > Puces et numérotation pour afficher la barre d’outils.

Abaisser d’un niveau Hausser d’un niveau Abaisser d’un niveau 
(avec les sous-niveaux)

Hausser d’un niveau (avec
les sous-niveaux)

Déplacer vers le bas de la 
liste

Déplacer vers le haut de la
liste

Déplacer vers le bas (avec
les sous-niveaux)

Déplacer vers le haut 
(avec les sous-niveaux)

Insérer une entrée sans 
numéro

Recommencer la numéro-
tation

Ouvrir la boîte de dialogue
Puces et numérotation.

Figure 4.26 : La barre d’outils Puces et numérotation.

Conseil
Vous pouvez utiliser des raccourcis clavier pour abaisser ou hausser les paragraphes dans 
les niveaux de plan. Placez le curseur au début d’un paragraphe numéroté puis appuyez sur

─ la touche Tabulation pour descendre d’un niveau,

─ la combinaison Maj+Tabulation pour monter d’un niveau.

Pour insérer une tabulation au début d’un paragraphe numéroté (entre le numéro et le 
texte), appuyez sur Ctrl+Tabulation.

Si vous créez une liste imbriquée grâce aux boutons de la barre d’outils Puces et numérotation, 
tous les niveaux de la liste (jusqu’à 10) utilisent initialement le même format de numérotation ou de
puces. Vous voudrez cependant dans ce cas souvent utiliser une combinaison de formats de nu-
méros et de puces. De telles listes peuvent être configurées de la façon suivante :

• cliquez sur chaque élément de la liste puis sélectionnez un des choix dans les palettes dé-
roulantes sous les boutons Puces et Numérotation de la barre d’outils Formatage ou de 
l’onglet Propriétés du volet latéral comme décrit dans la section suivante ;

• utilisez la boîte de dialogue Puces et numérotation comme décrit dans « Utiliser la boîte de 
dialogue Puces et numérotation » ci-dessous.

Il est cependant bien préférable de définir et d’appliquer un style de liste tel que décrit au Chapitre 
12 Travailler avec les listes, page 325.
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Utiliser les palettes Puces et Numérotation du Volet latéral

Les palettes Puces et Numérotations du panneau Paragraphe dans l’onglet Propriétés du volet 
latéral peuvent être utilisées pour créer des listes imbriquées et accéder à la boîte de dialogue 
Puces et numérotation. Le volet latéral n’offre pas d’outils pour abaisser ou hausser les éléments 
d’une liste tels que ceux que l’on trouve dans la barre d’outils Puces et numérotation.

Figure 4.27 : Choix de puces et de numérotations sur l’onglet Propriétés du volet latéral.

Utiliser la boîte de dialogue Puces et numérotation

La boîte de dialogue Puces et numérotation possède six onglets. Quatre offrent des symboles et 
des suites à choisir dans Puces, Numérotation, Plan (huit suites standards de numérotation de 
plans) et Image (puces constituées d’une image). Deux onglets proposent des options détaillées 
qui permettent de définir vos propres listes : Position (Figure 4.28) et Personnaliser (Figure 4.29). 
Ces onglets sont identiques à ceux proposés pour les styles de listes présentés au Chapitre 12 
Travailler avec les listes, page 331 et suivantes.

Figure 4.28 : L’onglet Position de la boîte de dialogue Puces et numérotation.
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Figure 4.29 : L’onglet Personnaliser de la boîte de dialogue Puces et numérotation.

Guide de LibreOffice Writer Formater des listes à puce ou numérotées | 115





5
Chapitre 5
Mise en page : les bases
Styles de page et fonctions associées





Introduction

Writer offre plusieurs façons de contrôler la mise en page de votre document.

Ce chapitre décrit l’utilisation des styles de page et des fonctions associées.

• En-têtes et pieds de page.

• Numérotation des pages.

• Pages de titre.

• Notes en bas des pages et en fin de document.

• Bordures et arrière-plans.

Le Chapitre 6 Mise en page : approfondissements présente l’utilisation des colonnes, des cadres, 
tableaux et sections, ainsi le changement d’orientation des pages à l’intérieur d’un document.

Remarque

Dans Writer, toutes les pages d’un document sont basées sur des styles de page. Les 
autres méthodes de mise en page (décrites au chapitre 6) s’appuient sur le style de page 
sous-jacent.

Conseil

La mise en page est normalement plus simple à réaliser si vous sélectionnez les options 
pour afficher le texte, les objets, les tableaux et les limites de sections dans la page 
LibreOffice – Couleurs de l’interface de la boîte de dialogue Options (Outils > Options) et 
celles pour afficher les fins de paragraphes, les tabulations, les sauts et autres éléments 
dans la page LibreOffice Writer – Aides au formatage de la même boîte de dialogue.

Paramétrer la mise en page de base grâce aux styles

Dans Writer, les styles de page définissent la disposition de base de toutes les pages, y compris 
leur taille, les marges, la position des en-têtes et des pieds de page, les bordures et l’arrière-plan, 
le nombre de colonnes et ainsi de suite.

Writer est fourni avec plusieurs styles de page sur lesquels vous pouvez vous appuyer ou que 
vous pouvez modifier. Vous pouvez aussi définir de nouveaux styles personnalisés. Vous pouvez 
avoir un ou plusieurs styles de page dans un seul document. Si vous ne spécifiez pas de style par-
ticulier, Writer utilise le Style par défaut.

Pour modifier la disposition de pages individuelles, vous pouvez définir un nouveau style de page 
ou utiliser une des techniques (sections, cadres ou tableaux) présentées plus loin dans ce cha-
pitre.

Remarque

Certains changements de mise en page (comme la position des numéros de page et 
d’autres éléments sur des pages en regard) peuvent être définis dans un style de page 
unique.
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Ce chapitre décrit certaines utilisations des styles de page. Certaines autres sont présentées au  
Chapitre 8 Introduction aux styles, page 209 et suivantes. La boîte de dialogue Style de page est 
présentée en détail au Chapitre 9 Travailler avec les styles, page 253.

Conseil

Toute modification des styles de page, y compris le Style par défaut, ne s’applique qu’au do-
cument sur lequel vous travaillez. Si vous désirez que les modifications s’appliquent par dé-
faut à tous les documents, vous devez les mettre dans un modèle dont vous ferez le modèle
par défaut. Voir le Chapitre 10 Travailler avec les modèles, page 263, pour plus de détails.

Insérer un saut de page sans changer de style de page

Dans de nombreux documents (par exemple, un rapport sur plusieurs pages), vous désirez que le 
texte s’écoule d’une page à la suivante quand vous ajoutez ou enlevez des informations. Writer le 
fait automatiquement, sauf si vous détournez le flux de texte par une des techniques décrites dans 
ce chapitre.

Si vous désirez introduire un saut de page à un endroit précis, par exemple pour placer un en-tête 
en haut d’une nouvelle page, vous pouvez placer le curseur à l’endroit où vous voulez débuter la 
nouvelle page et sélectionner Insertion > Saut de page dans la barre de menu.

Il existe cependant d’autres méthodes pour placer un en-tête en haut d’une page. Vous pouvez, 
par exemple, définir un style de paragraphe pour un en-tête qui comporte un saut de page ; voyez 
« Options d’enchaînement des styles de paragraphe » dans le Chapitre 9 Travailler avec les styles 
(page 239) pour plus d’informations.

Insérer un saut de page et donner un autre style à la nouvelle page

Si vous désirez que la nouvelle page ait un style différent, par exemple pour passer du Style par 
défaut au style Première page, utilisez une des méthodes suivantes.

! Attention

N’essayez pas de modifier le style d’une page sans avoir inséré un saut de page, sinon le 
style de certaines ou de toutes les autres pages suivantes peut aussi être modifié.

Méthode 1

 1) Placez le curseur à l’endroit où vous voulez que la nouvelle page débute. Sélectionnez In-
sertion > Saut manuel…

 2) Dans la section Type de la boîte de dialogue Insérer un saut (Figure 5.1), Saut de page est 
déjà coché et Style vaut [Aucun(e)]. Dans la liste déroulante Style, sélectionnez le style de 
la page suivante et cliquez sur OK.
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Figure 5.1 : Insérer un saut de page manuel en changeant le style de page.

Méthode 2

 1) Placez le curseur dans la paragraphe que vous voulez situer au début de la nouvelle page. 
Faites un clic droit et choisissez Paragraphe dans le menu contextuel.

 2) Dans l’onglet Enchaînement de la boîte de dialogue Paragraphe (Figure 5.2), dans la section
Sauts, cochez les options Insérer et Avec le style de page. Dans la liste déroulante des 
styles, choisissez le style que vous désirez appliquer à la page suivante et cliquez sur OK.

Figure 5.2 : Insérer un saut de page manuel grâce à la boîte de dialogue Paragraphe.

Conseil

Voyez « Recommencer la numérotation des pages » page 132 pour plus d’informations 
sur l’utilisation des champs Numéro de page de cette boîte de dialogue.

Modifier les marges des pages

Vous pouvez modifier les marges d’une page des façons suivantes :

• grâce aux règles : rapide, facile, mais peu précis ;

• grâce à la boîte de dialogue Style de page : on peut définir les marges avec deux chiffres dé-
cimaux ;

• grâce à l’onglet Page du volet latéral.
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Remarque
Si vous modifiez les marges grâce aux règles ou au volet latéral, les nouvelles marges af-
fectent le style de page et toutes les pages qui l’utilisent. Les nouvelles marges apparaîtront 
dans la boîte de dialogue Style de page à l’ouverture suivante.

Si vous désirez modifier les marges de certaines pages mais pas des autres, vous devez 
utiliser un style de page différent.

Pour modifier les marges grâce aux règles :

 1) Les parties grisées des règles représentent les marges (voir Figure 5.3). Placez le curseur 
de la souris au-dessus de la ligne située entre la partie grisée et la partie blanche. Le poin-
teur se transforme en une double flèche et affiche les paramètres actuels en tant qu’info-
bulle.

 2) Cliquez sur le bouton gauche de la souris et glissez-la pour déplacer les marges.

! Attention

Les petits triangles grisés situés sur les règles sont utilisés pour les retraits de paragraphes. 
Ils se trouvent souvent au même endroit que les marges de la page. Par conséquent, soyez 
prudent lorsque vous déplacez les marges afin de ne pas modifier les retraits de para-
graphes. La double flèche montrée dans la Figure 5.3 indique que vous pouvez déplacer les
marges.

Figure 5.3 : Déplacer les marges en utilisant les règles.

Conseil

Une fois le changement effectué, si vous repassez la souris au-dessus des nouvelles 
marges, une infobulle vous indiquera sa nouvelle mesure.

Pour modifier les marges en utilisant la boîte de dialogue Style de page (Figure 5.4) :

 1) Faites un clic droit n’importe où sur la page et cliquez sur Page dans le menu contextuel.

 2) Dans l’onglet Page de la boîte de dialogue Style de page, indiquez la taille des marges sou-
haitée dans les champs correspondants.
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Figure 5.4 : Régler les marges dans l’onglet Page de la boîte de dialogue Style de page.

Pour modifier les marges en utilisant l’onglet Page du volet latéral :

 1) Si ce n’est déjà fait, affichez le volet latéral (menu Affichage > Volet latéral) et cliquez sur 
l’icône de l’onglet Page.

 2) Dans le panneau Format, déroulez la liste Marges et faites votre choix parmi les options pro-
posées. Si aucune ne vous convient, vous pouvez cliquer sur le bouton Plus d’options ( ) 
qui ouvre la boîte de dialogue Style de page où vous pourrez régler précisément les marges 
comme indiqué ci-dessus.

Créer des en-têtes et des pieds de page

Un en-tête est une zone qui apparaît en haut de la page, au-dessus des marges. Le pied de page 
est une zone qui apparaît au bas de la page, en dessous des marges. Dans LibreOffice, les en-
têtes et les pieds de page sont définis par les styles de page : toutes les pages de même style af-
fichent le même en-tête et le même pied de page, bien que leurs contenus puissent être différents.
Par exemple, l’en-tête ou le pied de la première page d’une section, d’un chapitre ou d’un docu-
ment peut contenir des informations différentes alors que le style de page reste le même.

Le chapitre 9 décrit la manière de mettre en forme un en-tête dans le cadre du formatage du style 
de page. Pour les besoins de notre exemple, nous allons insérer un en-tête dans les pages de 
Style par défaut grâce à un formatage manuel.

Pour insérer un en-tête (ou un pied de page), deux méthodes sont possibles. La plus simple 
consiste à cliquer au-dessus de la zone du texte, puis, quand le marqueur d’en-tête apparaît, à cli-
quer sur le symbole +. (Pour insérer un pied de page, cliquez en dessous de la zone de texte en 
bas de la page puis sur le signe +.)
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Figure 5.5 : Marqueur d’en-tête en haut de la zone de texte.

Les en-têtes peuvent aussi être insérés depuis le menu en cliquant sur Insertion > En-tête et 
pied de page > En-tête > [Style de page]. Le sous-menu propose la liste des styles de page utili-
sés dans votre document. Il offre, en supplément, l’entrée Tout qui active les en-têtes sur toutes 
les pages du document indépendamment de leur style. De la même manière, pour insérer un pied 
de page, sélectionnez Insertion > En-tête et pied de page > Pied de page > [Style de page].

Remarque

Le menu Insertion peut aussi servir à supprimer un en-tête ou un pied de page existant 
pour un style de page donné. Si ce style comporte une coche devant son nom, il contient un 
en-tête ou un pied de page. Si vous cliquez sur celui-ci, une boîte de message s’ouvre pour 
vous demander de confirmer ou non la suppression de l’en-tête ou du pied de page pour le 
style en question.

Pour notre exemple, sélectionnez la ligne de menu Style par défaut pour n’activer les en-têtes 
que sur les pages qui utilisent ce style. Une zone apparaît en haut ou en bas de la page (Figure 
5.6 : l’en-tête a, par défaut, un fond transparent ; pour l’exemple, il a été coloré afin de le rendre 
mieux visible).

Figure 5.6 : Une page avec un en-tête.

Insérer du contenu dans les en-têtes et pieds de page

D’autres informations telles que le titre du document ou du chapitre sont souvent placées dans les 
en-têtes et les pieds de page. Il est préférable de recourir aux champs pour ajouter ces renseigne-
ments. De cette façon, si une information est modifiée, les en-têtes et pieds de page seront adap-
tés automatiquement.

Les champs sont présentés au Chapitre 17 Travailler avec les champs, page 469, mais un 
exemple peut se révéler utile. Voici la procédure pour insérer, par exemple, le titre du document 
dans l’en-tête :

 1) Si ce n’est déjà fait, ouvrez l’onglet (Fichier > Propriétés) et saisissez le titre de votre docu-
ment puis cliquez sur OK pour refermer la boîte de dialogue.
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 2) Ajouter un en-tête à votre document (menu Insertion > En-tête et pied de page > En-tête >
Style par défaut).

 3) Placez le pointeur de la souris dans l’en-tête de la page.

 4) Cliquez sur le menu Insertion > Champs > Titre. Le titre s’affiche avec un arrière-plan grisé 
(qui n’apparaît pas à l’impression du document et peut être supprimé).

 5) Pour modifier le titre de tout le document, retournez dans l’onglet Description de la boîte de 
dialogue Propriétés.

Vous devez aussi utiliser un champ pour le numéro de page si vous voulez qu’il change d’une 
page à l’autre. Voir « Numérotation des pages » page 126.

Mise en forme des en-têtes et pieds de page

Dans Writer, les en-têtes et pieds de page sont des paragraphes : vous pouvez donc les formater 
en utilisant les mêmes techniques que pour le texte du corps principal du document. Voyez le Cha-
pitre 4 Mettre le texte en forme, page 96.

Vous pouvez aussi ajouter des images aux en-têtes et pieds de page grâce aux techniques dé-
crites au Chapitre 11 Images et objets graphiques, page 280, et vous pouvez disposer les informa-
tions en utilisant des tableaux comme décrit au Chapitre 6 Mise en page : approfondissements, 
page 153.

Conseil

Writer propose des styles de paragraphe pour les en-têtes et les pieds de page que vous 
pouvez modifier et utiliser de la même manière que les autres styles de paragraphe. Voir les
chapitres 8 et 9.

Pour formater manuellement la disposition des en-têtes et pieds de page :

 1) Utilisez une des méthodes suivantes pour ouvrir la page concernée de la boîte de dialogue 
Style de page :

─ cliquez n’importe où sur la page et choisissez Format > Page dans la barre de menu,

─ faites un clic droit sur la page et choisissez Page dans le menu contextuel,

─ cliquez tout en haut de la page. Quand le marqueur d’en-tête apparaît, cliquez sur la 
flèche vers le bas et sélectionnez Formater l’en-tête…

 2) Dans l’onglet En-tête ou Pied de page de la boîte de dialogue Style de page (Figure 5.7), 
vous pouvez modifier les marges, l’espacement et la hauteur.

 3) Cliquez sur Plus… pour ouvrir la boîte de dialogue Bordures/Arrière-plan (Figure 5.8) où 
vous pourrez ajouter des bordures, des couleurs ou des images d’arrière-plan à l’en-tête ou 
au pied de page.

! Attention

N’essayez pas d’utiliser les onglets Arrière-plan et Bordures de la boîte de dialogue Style de
page elle-même pour formater les en-têtes et pieds de page. Les choix de styles effectués 
dans ces onglets s’appliquent à la page entière.
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Figure 5.7 : L’onglet En-tête de la boîte de dialogue Style de page.

Figure 5.8 : boîte de dialogue Bordure/Arrière-plan pour un en-tête ou un pied de page.

Numérotation des pages

Cette section décrit les techniques qui permettent d’insérer des numéros de page et les informa-
tions associées dans les en-têtes et les pieds de page d’un document.

Vous devez placer un champ numéro de page dans un en-tête ou un pied de page pour que ce nu-
méro apparaisse sur chaque page et change d’une page à la suivante. Le numéro de page appa-
raît sur un fond gris qui indique qu’il s’agit d’un champ ; bien que visible à l’écran, ce fond n’est pas
imprimé.
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Astuces
Si vous désirez masquer le fond gris, choisissez Affichage > Trame de fond des champs 
(ou appuyez sur Ctrl+F8).

Si vous voyez les mots « Numéro de page » à la place du numéro, appuyez sur Ctrl+F9. 
Cette combinaison de touches fait alternativement afficher par Writer le nom du champ et 
son contenu (ici le numéro de la page).

Numérotation élémentaire des pages

Le cas le plus simple est constitué par un numéro en haut de chaque page et rien d’autre. Pour ob-
tenir cela, placez le curseur dans l’en-tête et sélectionnez Insertion > Numéro de page.

Figure 5.9 : Numéro de page inséré dans un en-tête.

Associer texte et numéro de page dans l’en-tête

Plusieurs variations intéressantes sur ce thème peuvent être appliquées sans connaissances sup-
plémentaires sur les styles de page. Voici quelques suggestions :

• alignez l’en-tête à droite pour que le numéro apparaisse en haut à droite de la page ;

• tapez le mot « Page » avant le champ Numéro de page en laissant un espace entre eux pour
que l’en-tête indique Page 1, Page 2, etc ;

• ajoutez le titre du document pour que l’en-tête indique, par exemple, Fables de Jean de LA 
FONTAINE, à gauche, puis Page x à droite, où x est la valeur du champ Numéro de page. 
Pensez à utiliser un arrêt de tabulation aligné à droite pour séparer le titre du numéro de 
page ;

• LibreOffice propose aussi un champ Nombre de pages (Insertion > Champ > Nombre de 
pages). Grâce à lui, votre en-tête peut, par exemple, indiquer Page 2 sur 12.

Ces possibilités sont illustrées sur la Figure 5.10
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Figure 5.10 : Variation sur la numérotation élémentaire des pages

Changer le format de la numérotation

De nombreuses autres variantes sont possibles. Par exemple, vous pouvez faire afficher les nu-
méros en chiffres romains. Pour cela, vous pouvez faire un double clic sur le numéro de page et 
choisir le format souhaité dans la boîte de dialogue qui s’ouvre alors. Une meilleure solution 
consiste cependant à définir le format des numéros dans le style de page comme expliqué ici.

Faites un clic droit dans la zone de texte de la page et sélectionnez Page dans le menu contextuel.

Dans l’onglet Page de la boîte de dialogue Style de page, dans la section Paramètres de mise en
page, sélectionnez « I, II, III, … » dans la liste déroulante Numéros de page pour une numérota-
tion en chiffres romains.

Figure 5.11 : Modifier le format de la numérotation des pages

! Attention

N’oubliez pas que tout changement dans le format des numéros s’appliquera à toutes les 
pages qui utilisent ce style de page, quelle que soit la méthode utilisée pour effectuer ce 
changement.

Numérotation des pages par chapitre

Les documents techniques ajoutent souvent le numéro de chapitre au numéro de la page soit dans
l’en-tête, soit dans le pied de page. Par exemple, 1-1, 1-2, 1-3, … ; 2-1, 2-2, 2-3, … Pour obtenir 
ce type de numérotation dans Writer, vous devez faire trois choses :

 1) Faire en sorte que tous les titres de vos chapitres soient identifiés par le même style de para-
graphe, par exemple, le style Titre 1.
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 2) Indiquer à Writer, grâce à Outils > Numérotation des chapitres, quel style de paragraphe 
vous servira de premier niveau de titre avec le type de numérotation « 1, 2, 3, … » (Figure 
5.12).

Figure 5.12 : Choix d’un style de paragraphe et de la numérotation des titres de chapitre.

 3) Insérer le numéro de chapitre dans le document. Pour cela :

 a) Placer le curseur dans l’en-tête ou le pied de page, juste avant le numéro de page que 
vous avez inséré auparavant, et choisir Insertion > Champ > Autres champs dans la 
barre de menu.

 b) Dans la boîte de dialogue Champs (Figure 5.13), allez à l’onglet Document, sélectionnez 
Chapitre dans la liste Type, Numéro de chapitre dans la liste Format et 1 dans le champ
Niveau puis cliquez sur Insérer.

Figure 5.13 : Insérer un champ numéro de chapitre.
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 c) Tapez un tiret ou tout autre signe de ponctuation entre les numéros de chapitre et de 
page.

Donner à la première page un numéro autre que 1

Il arrive parfois qu’on désire commencer un document avec un numéro de page plus grand que 1. 
Suivez les instructions ci-dessous pour y arriver. (Elles sont données pour un numéro placé en 
pied de page, mais vous pouvez utiliser l’en-tête à la place.)

 1) Cliquez dans le pied de page. Pour insérer le numéro de page, sélectionnez Insertion > 
Champ > Numéro de page. Le numéro de page sera 1.

 2) Cliquez sur le premier paragraphe dans la zone de texte. Choisissez Format > Paragraphe 
(ou faites un clic droit et sélectionnez Paragraphe dans le menu contextuel) pour ouvrir la 
boîte de dialogue Paragraphe.

 3) Dans l’onglet Enchaînement, à la section Sauts (Figure 5.14), cochez l’option Insérer puis 
sélectionnez Page dans la liste déroulante Type. Cochez l’option Avec le style de page et 
choisissez le style de page que vous utilisez pour la première page du document.

 4) Cochez l’option Numéro de page pour activer le champ et tapez-y le numéro de page par le-
quel vous désirez débuter. Cliquez sur OK pour refermer la boîte de dialogue.

Figure 5.14 : La section Sauts de l’onglet Enchaînement de la boîte de dialogue Paragraphe.

Conseil

Si vous commencez votre numérotation par un nombre pair, vous allez trouver une page 
blanche avant la première page. Vous pouvez cependant supprimer celle-ci quand vous im-
primerez le fichier ou quand vous l’exporterez au format PDF. Voir le Chapitre 7 Imprimer, 
exporter, envoyer par courriel , page 186, pour plus d’informations.

Définir une première page différente pour un document

De nombreux documents, tels que les lettres et les notes, ont une première page différente des 
autres. Par exemple, la première page d’une lettre possède un en-tête différent des autres, comme
on le voit sur la Figure 5.15, ou la première page d’un rapport peut n’avoir ni en-tête ni pied de 
page alors que les pages suivantes en ont.
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Figure 5.15 : Lettre à en-tête avec un en-tête différent pour la première page et les suivantes.

Avec le Style de page par défaut (ou tout autre style de page), vous pouvez ajouter un en-tête ou 
un pied de page à votre convenance sur la première page en décochant l’option Même contenu 
sur la première page de l’onglet En-tête/Pied de page de la boîte de dialogue Style de page puis 
en ajoutant l’en-tête ou le pied de page. Vous pouvez alors ajouter un en-tête ou un pied de page 
différent aux autres pages du document. Voir « Créer des en-têtes et des pieds de page » page
123 pour plus d’informations.

Ajouter des pages de titre

Writer dispose d’une méthode rapide et pratique pour ajouter une ou plusieurs pages de titre à un 
document en recommençant de façon facultative la numérotation à 1 pour le corps du document.

Commencez par choisir Format > Page de titre dans la barre de menu. Dans la boîte de dialogue 
Pages de titre (Figure 5.16), vous pouvez effectuer les choix suivants :

• convertir des pages existantes en pages de titre ou en insérer de nouvelles ;

• définir le nombre de pages à convertir ou à insérer ;

• préciser l’endroit où ces pages seront situées ;

• recommencer ou non la numérotation, où et par quel numéro ;

• définir le style à utiliser pour les pages de titre.

Guide de LibreOffice Writer Définir une première page différente pour un document | 131



 Chapitre 5 Mise en page : les bases

Figure 5.16 : Ajouter des pages de titre à un document

Grâce à cette technique, vous pouvez insérer plusieurs « pages de titre » en différents points de 
votre document, par exemple pour ajouter des pages décoratives entre les chapitres aussi bien 
que comme titre, déclaration de copyright et autres pages au début d’un livre.

Recommencer la numérotation des pages

Vous souhaiterez souvent recommencer la numérotation des pages à 1, par exemple, sur la page 
suivant une page de titre ou une table des matières. En supplément, de nombreux documents dé-
butent par des pages liminaires (par exemple, pour un sommaire) numérotées en chiffres romains 
alors que le corps du document est numéroté en chiffres arabes à partir de 1.

Si vous décidez de ne pas ajouter de pages de titre comme décrit ci-dessus, vous pouvez recom-
mencer la numérotation des pages de deux manières.

Méthode 1 :

 1) Placez le curseur dans le premier paragraphe de la nouvelle page (un titre est un para-
graphe).

 2) Choisissez Format > Paragraphe.

 3) Dans l’onglet Enchaînement de la boîte de dialogue Paragraphe, cochez l’option Insérer 
dans la section Sauts (Figure 5.14 page 130).

 4) Sélectionnez Page dans la liste déroulante Type.

 5) Dans la liste déroulante Position, sélectionnez Avant ou Après selon l’emplacement où vous
désirez insérer le saut de numérotation de page.

 6) Cochez l’option Avec le style de page et choisissez le style de page à utiliser.
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 7) Cochez la case Numéro de page pour activer le champ et tapez-y le numéro de page par le-
quel vous désirez débuter. Cliquez sur OK pour refermer la boîte de dialogue sans insérer de
nouvelle page.

Méthode 2 :

 1) Placer le curseur dans le premier paragraphe de la nouvelle page.

 2) Choisissez Insertion > Saut manuel.

 3) Saut de page est cochée par défaut dans la boîte de dialogue Insérer un saut (Figure 5.17)

 4) Choisissez le style de page nécessaire dans la liste déroulante Style.

 5) Cochez l’option Modifier le numéro de page.

 6) Précisez le numéro de départ puis cliquez sur OK. Aucune nouvelle page n’est insérée.

Figure 5.17 : Recommencer la numérotation de page après un saut de page manuel.

Exemple de redémarrage de la numérotation : une préface

Une préface classique présente les propriétés suivantes :

• les numéros des pages sont affichés en chiffres romains (i, ii, iii, iv,…) ;

• après la préface, le document débute par une page par défaut ;

• la numérotation des pages recommence à 1 et les numéros sont affichés en chiffres arabes 
(1, 2, 3, 4…).

Recommencer la numérotation demande des sauts de page.

Commencez par un travail préliminaire en créant le style Préface :

 1) Créer un nouveau style de page et nommez-le Préface.

 2) Donnez-lui Préface comme Style de suite dans l’onglet Gestionnaire de la boîte de dialogue 
Style de page, car une préface peut s’étendre sur plusieurs pages.

 3) Ajouter un en-tête au style Préface en cochant Activer l’en-tête dans l’onglet En-tête de la 
boîte de dialogue.
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 4) Réglez l’affichage du numéro de page en chiffres romains (i, ii, iii, iv,…) dans la liste Format 
de l’onglet Page de la boîte de dialogue (Figure 5.18). Cliquez sur OK pour fermer la boîte 
de dialogue. Insérez un champ Numéro de page dans l’en-tête de la page.

Figure 5.18 : Choix des chiffres romains pour numéroter les pages.

Quand la préface est écrite, vous êtes prêt à redémarrer la numérotation en chiffres arabes dans le
corps principal du document. Procédez de la façon suivante :

 1) Créez un paragraphe vide tout à la fin de la préface.

 2) Placez le curseur sur la ligne vide.

 3) Sélectionnez Insertion > Saut manuel.

 4) Cochez Saut de page et choisissez le Style par défaut.

 5) Cochez l’option Modifier le numéro de page et indiquez 1 comme nouvelle valeur. Cliquez 
sur OK pour refermer la boîte de dialogue.

Ces réglages sont visibles sur la Figure 5.17.

Remarque

Vous ne pouvez pas assigner un numéro impair à une page de gauche ni un numéro pair à 
une page de droite. LibreOffice suit rigoureusement la convention selon laquelle les pages 
impaires sont à droite et les pages paires à gauche.

Mettre en forme les notes de bas de page et de fin

Les notes peuvent apparaître en bas de la page où se situe leur référence ou être rassemblées à 
la fin du document.

Pour travailler efficacement avec les notes, vous devez savoir :

• insérer des notes de bas de page et en définir le format, si le format par défaut ne convient 
pas à vos besoins (voir le Chapitre 3 Travailler avec le texte : Approfondissements) ;

• définir l’emplacement des notes de bas de page sur celle-ci ainsi que la couleur et le style de
la ligne de séparation si leurs valeurs par défaut ne correspondent pas à vos besoins.
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Définir l’emplacement des notes de bas de page et l’aspect de la ligne 
de séparation

L’emplacement des notes sur la page ainsi que la couleur et le style de la ligne qui les sépare du 
texte sont définis dans le style de page. Si vous utilisez plusieurs styles de page qui peuvent 
contenir des notes, vous devez définir leur emplacement et les propriétés de la ligne de séparation
pour chacun d’eux.

Sélectionnez Format > Page dans la barre de menu ou faites un clic droit dans la page et choisis-
sez Page dans le menu contextuel pour ouvrir la boîte de dialogue Page. Cliquez sur l’onglet 
Notes de bas de page (Figure 5.19), effectuez vos modifications puis cliquez sur OK pour enregis-
trer les changements.

Si vous conservez le paramétrage par défaut, Hauteur maximale de la page, les notes de bas de 
page sont calculées automatiquement sur la base de leur nombre. Si vous préférez contrôler ma-
nuellement l’espace maximum qu’elles peuvent occuper, cochez l’option Hauteur maximale de la 
note et saisissez la mesure dans le champ voisin. Utilisez la deuxième partie de la page pour per-
sonnaliser le séparateur entre les notes et la zone principale de texte.

Figure 5.19 : Choix des paramètres des notes de bas de page

Paramétrer les bordures et l’arrière-plan

De nombreux éléments de Writer peuvent recevoir des bordures et un arrière-plan : les para-
graphes, les pages, les cadres, les sections, les styles de page, les styles de paragraphe et les 
styles de cadre peuvent en comporter. Les tables des matières et index n’admettent qu’un arrière-
plan. Une bordure peut être appliquée à du texte, soit caractère par caractère, soit à une sélection.

Les onglets des boîtes de dialogue concernant les bordures ou l’arrière-plan sont tous semblables.
Pour illustrer leur utilisation, nous allons définir une bordure et un arrière-plan d’un cadre.
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Astuce

L’arrière-plan des pages ne remplit que la zone entre les marges, y compris l’en-tête et le 
pied de page le cas échéant. Pour étendre l’image ou la couleur d’arrière-plan aux marges, 
créez un cadre de taille et de dimensions convenables, ancrez-le à la page ou à un para-
graphe et envoyez-le en arrière-plan. Pour plus d’informations sur les cadres, voyez le Cha-
pitre 6 Mise en page : approfondissements, page 148.

Ajouter une bordure

Commencez par sélectionner le cadre, faites un clic droit et choisissez Propriétés dans le menu 
contextuel. Sélectionnez l’onglet Bordures (Figure 5.20).

Les bordures offrent trois types de paramètres : leur emplacement, leur aspect et l’espace entre 
elles et le contenu.

• Disposition des lignes définit l’emplacement de la bordure. Writer propose cinq dispositions
par défaut, mais vous pouvez cliquer, dans le cadre Défini par l’utilisateur, sur la ligne que 
vous voulez personnaliser pour obtenir exactement ce que vous désirez. Chaque ligne peut 
recevoir une mise en forme propre.

• Ligne spécifie l’aspect de la bordure : son style, sa largeur et sa couleur. Chaque paramètre 
offre plusieurs choix. Les attributs sélectionnés s’appliqueront aux bordures mises en évi-
dence par une paire de flèches noires dans le cadre Défini par l’utilisateur à gauche de la 
boîte de dialogue.

• Espacement avec le contenu précise la distance à laisser entre la bordure et le contenu de 
l’élément. Elle peut être définie séparément dans les quatre directions ou être la même des 
quatre côtés en cochant la case Synchroniser.

• Les propriétés de la section Style d’ombre s’appliquent toujours à l’élément entier. Une 
ombre possède trois caractéristiques : sa position, la distance à laquelle elle est projetée et 
sa couleur.

Figure 5.20 : L’onglet Bordures de la boîte de dialogue Cadre.
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Ajouter une couleur à l’arrière-plan

Commencez par sélectionner le cadre, faites un clic droit et sélectionnez Propriétés dans le menu
contextuel. Dans la boîte de dialogue Cadre, cliquez sur l’onglet Zone2 (Figure 5.21) puis sur Cou-
leur.

Figure 5.21 : L’onglet Zone de la boîte de dialogue Cadre offrant un choix de couleurs.

Choisissez une couleur dans la palette ou créez-en une nouvelle puis cliquez sur OK pour l’appli-
quer à l’arrière-plan du cadre.

2 Cette page s’appelle Zone pour les cadres, mais Arrière-plan dans tous les autres cas.
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Ajouter un dégradé à l’arrière-plan

Figure 5.22 : L’onglet Zone de la boîte de dialogue Cadre offrant un choix de dégradés.

Pour ajouter un dégradé à l’arrière-plan, sélectionnez l’onglet Zone2 de la boîte de dialogue Cadre 
puis choisissez Dégradé. L’onglet affiche alors les options de dégradés (Figure 5.22) avec un 
exemple dans le panneau Aperçu. Choisissez le dégradé qui vous convient dans la liste ou créez 
un nouveau dégradé. Cliquez sur OK pour appliquer le dégradé à l’arrière-plan du cadre.

Ajouter un bitmap (image) à l’arrière-plan

« Bitmap » est un terme qui désigne les photos et autres images constituées de points colorés. 
Pour ajouter une image à l’arrière-plan, ouvrez l’onglet Zone2 et choisissez Bitmap. L’onglet af-
fiche alors les options d’images visibles sur la Figure 5.23.

Vous pouvez y choisir une des images proposées dans la liste de gauche ou y ajouter les vôtres.

Pour ajouter une image :

 1) Cliquez sur le bouton Ajouter/importer pour ouvrir la boîte de dialogue Import.

 2) Cherchez le fichier que vous désirez importer et cliquez sur le bouton Ouvrir. La boîte de 
dialogue Import se ferme et l’image choisie apparaît dans la liste des vignettes sur la gauche
et dans le panneau Aperçu sur la droite de l’onglet.

 3) Sélectionnez la nouvelle image dans la liste de gauche.

Dans la section Options au centre, choisissez la façon dont l’image doit apparaître puis cliquez 
sur OK pour l’appliquer à l’arrière-plan.
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Figure 5.23 : L’onglet Zone de la boîte de dialogue Cadre offrant un choix d’images.

Ajouter un motif ou des hachures à l’arrière-plan

L’ajout d’un motif ou de hachures est semblable à l’ajout d’un dégradé. Voir Figure 5.24 et Figure 
5.25.
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Figure 5.24 : L’onglet Zone de la boîte de dialogue Cadre offrant un choix de motifs.

Figure 5.25 : L’onglet Zone de la boîte de dialogue Cadre offrant un choix de hachures.
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Supprimer une couleur, un dégradé, une image ou tout autre arrière-
plan

Pour cela, cliquez sur Aucun en début de liste des options d’arrière-plan en haut de l’onglet Zone2 
de la boîte de dialogue Cadre.

Ajuster la transparence de l’arrière-plan

Figure 5.26 : L’onglet Transparence de la boîte de dialogue Cadre.

La transparence est utile pour créer des filigranes et rendre les couleurs d’une image plus pâles (et
augmenter le contraste avec le texte). Les choix disponibles sont présentés en détail dans le 
Guide Draw.

Guide de LibreOffice Writer Paramétrer les bordures et l’arrière-plan | 141





6
Chapitre 6
Mise en page : 
approfondissements
Utiliser les colonnes, les cadres, les tableaux et les 
sections





Introduction

Writer offre plusieurs méthodes pour vous permettre de contrôler la mise en page. Ce chapitre pré-
sente l’utilisation

• des colonnes,

• des cadres,

• des tableaux,

• des sections,

• et le changement d’orientation des pages à l’intérieur d’un document.

Le chapitre 5 décrit l’utilisation des styles de page et de certaines fonctions associées.

Remarque

Dans un document produit avec Writer, toutes les pages sont basées sur des styles 
de page. Les autres méthodes de mise en page décrites dans ce chapitre s’appuient toutes 
sur le style de page sous-jacent.

Conseil

La mise en page est normalement plus simple à réaliser si vous sélectionnez les options 
pour afficher le texte, les objets, les tableaux et les limites de sections dans la page 
LibreOffice – Couleurs de l’interface de la boîte de dialogue Options (Outils > Options) et 
celles pour afficher les fins de paragraphes, les tabulations, les sauts et autres éléments 
dans la page LibreOffice Writer – Aides au formatage de la même boîte de dialogue.

Choix d’une méthode de mise en page

La meilleure méthode de mise en page dépend de l’aspect que devra avoir le document final et du 
type d’informations qu’il va contenir. Voici quelques exemples. Toutes les techniques mentionnées 
ici sont décrites dans ce chapitre.

• Pour un livre semblable à ce guide de l’utilisateur avec une colonne de texte, certaines fi-
gures sans texte à côté d’elles et d’autres avec une description, utilisez les styles de page 
pour une mise en page de base et des tableaux pour placer les figures à côté du texte qui les
décrit là où c’est nécessaire.

• Utilisez des styles de page (à deux colonnes) pour un index ou tout autre document compor-
tant deux colonnes où le texte passe de la colonne de gauche à celle de droite puis à la page
suivante. Si le titre du document, sur la première page, en occupe toute la largeur, placez-le 
dans une section ne comportant qu’une seule colonne.

• Pour un bulletin d’information avec une mise en page complexe, deux ou trois colonnes sur 
la page et des articles qui se poursuivent d’une page à un autre endroit situé plusieurs pages
plus loin, utilisez les styles de page pour la mise en page de base. Placez les articles dans 
des cadres liés et ancrez les images à des positions fixes sur la page le cas échéant.
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Conseil

Pour un document destiné à être publié en HTML, ePub ou tout autre format pas encore dé-
finitivement fixé, utilisez des techniques de mise en page minimales. Certaines méthodes 
(colonnes, cadres, tableaux larges) sont souvent mal exportées dans ces formats.

Utiliser des colonnes pour la mise en page

La mise en page sur deux colonnes peut s’effectuer des façons suivantes :

• en définissant le nombre de colonnes et leur disposition sur une page grâce aux styles de 
page ;

• en changeant le nombre de colonnes d’un texte existant.

Définir les colonnes sur une page

C’est une bonne idée de paramétrer votre style de page de base (par exemple le Style par défaut) 
avec la mise en page la plus courante utilisée dans votre document, soit sur une colonne, soit sur 
plusieurs. Vous pouvez alors définir des styles de page supplémentaires pour celles qui auront un 
nombre différent de colonnes.

Remarque

Si vous désirez combiner des nombres différents de colonnes sur une même page, vous de-
vrez utiliser des sections (décrites dans « Utiliser des sections pour la mise en page » à 
partir de la page 156).

Pour définir le nombre de colonnes sur une page :

 1) Cliquez sur Format > Page ou sur le bouton Plus d’options ( ) de l’onglet Page dans le 
volet latéral pour ouvrir la boîte de dialogue Style de page. Ouvrez l’onglet Colonnes (Figure 
6.1).

 2) Dans la section Paramètres, Choisissez le nombre de colonnes et, dans les sections sui-
vantes, précisez l’espacement entre les colonnes et si vous désirez un trait de séparation 
entre celles-ci. Vous pouvez utiliser  les dispositions prédéfinies par Writer ou en créer une 
qui vous soit personnelle. La vignette de prévisualisation à droite de la section Paramètres 
vous montre l’aspect de la disposition choisie.

 3) Cliquez sur OK pour enregistrer les modifications.
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Figure 6.1 : Définir le nombre de colonnes sur une page.

Définir la largeur et l’espacement des colonnes

Cochez l’option Largeur automatique dans la section Largeur et espacement pour créer des co-
lonnes de largeurs égales.

Pour personnaliser la largeur et l’espacement des colonnes :

 1) Décochez l’option Largeur automatique dans la section Largeur et espacement.

 2) Saisissez la largeur des colonnes dans les champs de la ligne Largeur.

 3) Saisissez l’espace entre les colonnes dans les champs de la ligne Espacement.

Si vous définissez plus de trois colonnes, utilisez les boutons fléchés sur la ligne Colonne pour les 
faire défiler.

Formater les lignes de séparation

Pour afficher des lignes de séparation entre les colonnes :

 1) Dans la liste déroulant Style, sélectionnez le style de ligne parmi les trois disponibles.

 2) Dans le champ Largeur, choisissez la largeur de la ligne à utiliser entre 0,25 pt et 9,0 pt 
(1 pt = 1 point = 1/12 pica = 1/72 pouce = 127/360 mm = 0,3527 mm).

 3) À l’aide du  champ Hauteur, réglez la hauteur de la ligne en pourcentage de celle de la co-
lonne. Les valeurs possibles vont de 25 % à 100 %. Vous pouvez aussi saisir une mesure.

 4) Si vous avez choisi une hauteur inférieure à 100 %, utilisez la liste déroulante Position pour 
choisir l’alignement des lignes de séparation. Les choix possibles sont Haut, Centré et Bas.

 5) La couleur des lignes peut être choisie dans la liste déroulante Couleur.

Astuce

Pour saisir rapidement les valeurs maximale et minimale permises dans une boîte de saisie,
cliquez sur la valeur actuelle et appuyez respectivement sur les touches Page au-dessus 
et Page en dessous.
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Revenir à une mise en page à colonne unique

Pour revenir à un style de page présentant une seule colonne, dans la section Paramètres de la 
boîte de dialogue Colonnes, remettez 1 dans le champ Colonnes ou cliquez sur l’icône qui propose
une mise en page à une seule colonne.

Répartir le texte entre les colonnes

Quand vous ajoutez du texte à la section, celui-ci s’écoule d’une colonne à la suivante. La dernière
colonne peut être plus courte que les autres.

Si vous désirez répartir le texte entre les colonnes de telle façon qu’elles aient à peu près la même
hauteur, vous devez utiliser une section comportant plusieurs colonnes ; voir « Disposer la sec-
tion en plusieurs colonnes » à la page 160.

Utiliser des cadres pour la mise en page

Les cadres sont très utiles pour mettre en page des bulletins d’information ou tout autre document 
à la forme élaborée. Ils peuvent contenir du texte, des tableaux, plusieurs colonnes, des images et 
d’autres objets.

Utilisez des cadres quand vous devez :

• positionner quelque chose à un endroit précis sur une page, par exemple un logo ou un en-
cadré de type « dernières minutes » dans un coin de la page ;

• permettre au texte d’une page de continuer sur une autre plus éloignée que la page suivante,
en liant le contenu d’un cadre à un autre pour qu’il s’écoule entre eux quand vous le modi-
fiez ;

• disposer le texte autour d’un objet tel qu’une photographie.

Comme LibreOffice ne vous permet pas de définir des styles de page avec des cadres récurrents 
(sauf s’ils sont ancrés dans l’en-tête ou le pied de page), pensez à faire quelques rapides croquis 
de la disposition de base des pages dont vous aurez besoin en indiquant la position approximative 
des différents cadres et leur utilisation. Essayez de conserver un nombre de configurations aussi 
faible que possible pour éviter que l’ensemble devienne confus.

Apportez une attention particulière à la position des cadres. De nombreux styles prédéfinis pro-
posent par défaut un alignement centré. Bien que centrer tous les cadres puisse paraître raisonna-
blement bon dans la plupart des cas, c’est rarement le meilleur choix.

Une des méthodes les plus efficaces pour positionner un cadre consiste à aligner sa marge 
gauche avec celle du paragraphe qui le précède. Pour obtenir ce résultat, le cadre est inséré dans 
un paragraphe vide du même style que le précédent. Sélectionnez Insertion > Cadre > Cadre… ; 
dans la section Position de l’onglet Type, choisissez De gauche dans le champ Horizontal pour 
positionner le cadre exactement à l’endroit que vous désirez.

Pensez aussi à la façon dont le texte va entourer le cadre et à l’espace entre les deux. Plutôt que 
de placer le cadre près du texte, laissez un peu de place entre eux en utilisant l’onglet Adapter.

Vous pouvez formater les cadres individuellement ou définir des styles de cadre ; voyez le Cha-
pitre 9 Travailler avec les styles, page 250.
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Exemple : utiliser un cadre pour centrer le texte sur une page

Bien que l’on puisse centrer horizontalement le texte grâce à un style de paragraphe ou une mise 
en forme manuelle, cela n’est pas possible de cette manière pour un centrage vertical. Dans ce 
cas, il faut placer le texte dans un cadre ancré à la page ou à un paragraphe puis centrer le cadre 
verticalement sur la page. Voir « Ancrer les cadres » page 151.

Créer des cadres

Il est possible de créer un cadre de plusieurs manières selon les besoins.

• Choisir Insertion > Cadre > Cadre… pour créer un cadre vide. La boîte de dialogue Cadre 
(Figure 6.2) s’ouvre. Vous pouvez cliquer sur OK et revenir la personnaliser plus tard ou défi-
nir les propriétés du cadre à ce moment-là.

• Sélectionner du texte puis choisir Insertion > Cadre > Cadre… pour ouvrir la boîte de dia-
logue Cadre. Personnalisez le cadre (par exemple en ajoutant un espace entre le cadre et le 
texte) et cliquez sur OK. Le texte sélectionné est retiré du flux normal et inséré dans le 
cadre.

• Choisir Insertion > Cadre > Encadrer interactivement ou cliquez sur le bouton Encadrer 
interactivement ( ) de la barre d’outils Insérer (dans ce cas, vous pouvez choisir le 
nombre de colonne avant de tracer le cadre).Le pointeur de la souris devient un signe plus 
(+). Cliquez et tirez la souris pour dessiner un cadre vide. Si un texte était sélectionné, il sera
retiré du flux normal et inséré dans le cadre. Pour personnaliser le cadre, faites un clic droit 
et choisissez Propriétés… dans le menu contextuel.

• Insérer une formule ou un objet OLE en choisissant Insertion > Objet > [type d’objet]. 
L’élément est inséré dans un cadre. Pour personnaliser le cadre, faites un clic droit et choi-
sissez Propriétés… dans le menu contextuel.,

Pour ajouter un contenu à un cadre, commencez par le désélectionner en cliquant quelque part 
ailleurs dans la page, puis cliquez dans le cadre pour y placer le curseur de texte et ajoutez votre 
contenu comme vous le feriez sur la page principale. Quand vous avez terminé, désélectionnez le 
cadre.

Remarque

L’entrée de menu Insertion > Cadre > Cadre flottant… concerne les documents HTML.

Changer la position, la taille et les attributs d’un cadre

Quand un objet est ajouté dans un document, Writer le place automatiquement dans un cadre d’un
type prédéfini. Celui-ci détermine la position de l’objet sur la page ainsi que la façon dont il interagit
avec les autres éléments du document. Vous pouvez éditer le cadre en changeant le style qu’il uti-
lise ou en le formatant manuellement quand il est ajouté au document. Les styles de cadre sont 
présentés au Chapitre 9 Travailler avec les styles, page 250.

Pour modifier la taille ou la position d’un cadre, commencez par le sélectionner puis utilisez soit la 
souris, soit la boîte de dialogue Cadre (Figure 6.2). L’utilisation de la souris est plus rapide mais 
moins précise. Vous pourrez l’utiliser pour dégrossir la mise en page puis vous servir de la boîte de
dialogue pour un ajustement précis.
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Vous pouvez modifier manuellement la taille d’un cadre en cliquant sur les carrés verts (poignées 
de dimensionnement) et en les tirant jusqu’à la taille voulue, en ajoutant du contenu au cadre (la 
taille du cadre s’adaptera automatiquement si, par exemple, vous lui ajoutez une grande image) ou
en revenant à la boîte de dialogue pour y définir la taille et d’autres propriétés.

Pour modifier l’emplacement du cadre avec la souris, cliquez et tirez un de ses bords ou placez le 
pointeur quelque part dans le cadre. Le curseur en forme de barre se transforme en quadruple 
flèche quand il est en bonne position pour débuter le mouvement.)

Pour modifier la taille d’un cadre avec la souris, tirez une des poignées de redimensionnement. 
Celles des côtés modifient le cadre dans une seule dimension, celles des coins le modifient dans 
deux dimensions.

Ces actions changent les proportions du cadre. Pour qu’il conserve les mêmes proportions, ap-
puyez sur la touche Maj en tirant une des poignées.

Figure 6.2 : La boîte de dialogue Cadre.

Vous pouvez ouvrir la boîte de dialogue Cadre à tout instant en sélectionnant le cadre, en faisant 
un clic droit et en choisissant Propriétés… dans le menu contextuel.

Pour supprimer la bordure par défaut d’un cadre qui vient d’être créé, ouvrez la boîte de dialogue 
Cadre, allez à l’onglet Bordures (Figure 6.3) et cliquez sur le premier préréglage (Définir sans bor-
dure) dans la section Disposition des lignes. Vous pouvez aussi affecter un style sans bordure 
au cadre ; voyez le Chapitre 9 Travailler avec les styles, page 250 et suivantes, pour plus d’infor-
mations sur les styles de cadre.

Remarque

Ne confondez pas la bordure d’un cadre avec les limites du texte qui sont rendues visibles 
grâce au menu Affichage (en sélectionnant Affichage > Délimitations du texte).
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Figure 6.3 : Supprimer la bordure d’un cadre.

Ancrer les cadres

Avec la boîte de dialogue Cadre, ou par un clic droit en sélectionnant Ancre, vous pouvez ancrer 
un cadre à une page, à un paragraphe, à un caractère ou l’ancrer comme un caractère.

À la page

Le cadre conserve la même position par rapport aux marges de la page. Il n’est pas déplacé 
quand vous ajoutez ou supprimez du texte. Cet ancrage est utile quand le cadre n’a pas be-
soin d’être visuellement associé à un élément particulier du texte.

Au paragraphe

Le cadre est associé à un paragraphe et se déplace avec lui. Il peut être placé en marge ou 
à un autre emplacement. Cet ancrage est une alternative utile à un tableau pour positionner 
une icône à côté des paragraphes. Il est aussi utilisé pour centrer un texte sur une page d’un
document qui sera utilisé comme document maître (les cadres ancrés aux pages dispa-
raissent des documents maîtres).

Au caractère

Le cadre est associé à un caractère mais ne se trouve pas dans la séquence de texte. Il se 
déplace avec le paragraphe, mais il peut être positionné dans la marge ou à un autre empla-
cement. Cet ancrage est semblable à l’ancrage à un paragraphe.

Comme caractère

Le cadre est placé dans le document comme n’importe quel autre caractère et affecte donc 
la hauteur de la ligne de texte et le saut de ligne. Il se déplace avec le paragraphe quand 
vous ajoutez ou supprimez du texte avant celui-ci. Cet ancrage est utile pour ajouter une pe-
tite icône à l’intérieur d’une phrase. C’est aussi la meilleure méthode pour ancrer un objet 
graphique à un paragraphe vide pour éviter qu’il ne se déplace dans la page de façon impré-
vue.
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Lier les cadres

Vous pouvez lier des cadres l’un à l’autre, même s’ils sont sur des pages différentes d’un docu-
ment. Le contenu s’écoulera automatiquement de l’un au suivant. Cette technique se révèle très 
utile dans la conception des bulletins d’information où des articles peuvent devoir se poursuivre sur
une page différente.

Remarque

Il est impossible de lier un cadre à plus d’un autre cadre.

Pour lier un cadre à un autre :

 1) Sélectionnez le cadre d’où partira la liaison.

 2) Cliquez sur le bouton Enchaîner les cadres ( ) dans la barre d’outils Cadres.

 3) Cliquez sur le cadre suivant dans la suite de cadres (il doit être vide).

Quand un cadre lié est sélectionné, les liens existants sont indiqués par une fine ligne de 
connexion comme on le voit sur la Figure 6.4. Les cadres peuvent être séparés en cliquant sur le 
bouton Annuler l’enchaînement des cadres ( ) de la barre d’outils Cadres.

Figure 6.4 : Cadres liés.

La hauteur du cadre à l’origine du lien est fixée : vous pouvez la modifier manuellement ou avec la 
boîte de dialogue Cadre, mais elle ne s’ajuste plus automatiquement à la hauteur du contenu (l’op-
tion Taille automatique est désactivée pour la hauteur). Seul le dernier cadre de la chaîne peut 
adapter sa hauteur à son contenu.

L’onglet Options de la boîte de dialogue Cadre (Figure 6.5) affiche le nom du cadre sélectionné et 
de ceux auxquels il est relié. Vous pouvez y modifier ces informations. Dans cet onglet, vous trou-
verez aussi les options pour protéger le contenu, la position et la taille du cadre.

Les onglets Adapter, Bordures, Zone, Colonnes, Transparence et Macro de la boîte de dialogue 
Cadre sont les mêmes que ceux des styles de cadre. Voyez le Chapitre 9 Travailler avec les 
styles, page 252, pour plus de détails.
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Figure 6.5 : L’onglet Options de la boîte de dialogue Cadre.

Utiliser des tableaux pour la mise en page

Dans Writer, les tableaux ont plusieurs fonctions : contenir des données comme on peut le voir 
dans une feuille de calcul, aligner des éléments et créer des mises en page plus complexes. Pour 
toute information sur l’utilisation des tableaux de données, voyez le Chapitre 13 Travailler avec les 
tableaux de données, page 345.

Le sujet abordé ici concerne la réalisation de mises en page courantes à l’aide de tableaux.

Positionner des informations dans les en-têtes et pieds de page

À la place de tabulations, vous pouvez utiliser un tableau dans un en-tête ou un pied de page pour 
positionner différents éléments tels qu’un numéro de page, le titre du document, son auteur, et ain-
si de suite. Ces éléments sont souvent insérés par l’intermédiaire de champs qui sont décrits au  
Chapitre 17 Travailler avec les champs, page 469.

Créer des titres en marge

Les titres et notes en marge sont couramment utilisés dans des documents, des curriculum vitae 
aux guides de l’utilisateur. Le corps principal du texte est décalé pour laisser un espace vide (nor-
malement du côté gauche) où sont placés les titres et notes en marge. Le premier paragraphe est 
aligné à côté du titre en marge comme sur la Figure 6.6.

Remarque

Les titres en marge peuvent aussi être créés en plaçant le texte dans un cadre de style pré-
défini Note en marge comme décrit au Chapitre 9 Travailler avec les styles, page 252.
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Exemple de 
titre en marge

Dans certains cas, vous désirerez peut-être ne placer qu’un ou deux para-
graphes dans le tableau lui-même et le reste du texte et des images dans des 
paragraphes ordinaires (formatés pour s’aligner avec ceux du tableau) de fa-
çon que le texte et les images s’écoulent plus facilement d’une page à l’autre 
quand vous ajoutez ou supprimez quelque chose.

Dans d’autres cas, vous placerez chaque paragraphe dans une ligne diffé-
rente du tableau en autorisant son fractionnement sur plusieurs pages.

Figure 6.6 : Exemple de titre en marge.

Exemple

Pour créer un tableau en vue d’y placer des titres en marge :

 1) Placez le curseur à l’endroit où doit se trouver le tableau et choisissez Tableau > Insérer un 
tableau… (Ctrl+F12).

 2) Dans la boîte de dialogue Insérer un tableau (Figure 6.7), créez un tableau possédant une 
ligne, deux colonnes, sans en-tête ni bordure. Cliquez sur Insérer pour afficher le tableau.

Figure 6.7 : Créer un tableau à deux colonnes, sans en-tête ni bordure.

 3) Faites un clic droit dans le tableau et sélectionnez Propriétés du tableau… dans le menu 
contextuel. Dans l’onglet Colonnes de la boîte de dialogue Propriétés du tableau, donnez les
largeurs désirées aux colonnes.
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Figure 6.8 : Réglage de la largeur des colonnes pour aligner verticalement le texte avec un
décalage de 3,30 cm.

 4) Dans l’onglet Tableau de la boîte de dialogue Propriétés du tableau (Figure 6.9), dans la sec-
tion Espacement, donnez aux champs Au-dessus et En dessous les mêmes valeurs que 
vous avez définies pour l’espacement au-dessus et en dessous des paragraphes ordinaires. 
Vous pouvez aussi donner un nom au tableau dans la section Propriétés. Cliquez sur OK 
pour enregistrer vos paramétrages.

Figure 6.9 : Définir l’espace au-dessus et en dessous du tableau.

Conseil
Pour retrouver l’espace au-dessus et en dessous des paragraphes ordinaires :

1) Positionnez le curseur dans un paragraphe et appuyez sur F11 (inutile si l’onglet Styles et
formatage du volet latéral est déjà ouvert. Affichez le panneau des styles de paragraphe 
dans l’onglet Styles et formatage (premier bouton en haut à gauche).

2) Le style courant devrait être mis en valeur. Sinon, sélectionnez Tous les styles dans la 
liste déroulante en bas de la fenêtre. Faites un clic droit sur ce style et choisissez Modi-
fier dans le menu contextuel.

3) Allez à l’onglet Retraits et espacement et notez les valeurs des champs Au-dessus du pa-
ragraphe et Sous le paragraphe dans la section Espacement.
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Il peut être utile de désactiver la reconnaissance des nombres pour que Writer ne les formate pas 
alors que vous désirez les conserver tels qu’ils sont. Pour désactiver la reconnaissance des 
nombres :

 1) Faites un clic droit dans le tableau et sélectionnez Format numérique dans le menu contex-
tuel.

 2) Dans la boîte de dialogue Formater le nombre, assurez-vous que la catégorie sélectionnée 
est Texte et cliquez sur OK.

Figure 6.10 : Désactiver la reconnaissance des nombres.

Conseil

Si vous utilisez souvent ce format de tableau, vous pouvez l’enregistrer comme AutoTexte 
tel que cela est décrit au Chapitre 2 Travailler avec le texte : les bases., page 63. Sélection-
nez le tableau (pas seulement son contenu) pour lui affecter un raccourci.

Utiliser des sections pour la mise en page

Une section est un bloc de texte qui possède des attributs et un formatage spéciaux. Vous pouvez 
utiliser une section pour :

• protéger un texte contre les modifications,

• cacher un texte,

• insérer de façon dynamique le contenu d’un autre document,

• ajouter des colonnes, des retraits de marge, une couleur ou une image d’arrière-plan à une 
partie de votre document,

• personnaliser les notes de bas de page et de fin pour une partie de votre document.

Créer des sections

Pour créer une section :

 1) Placez le curseur dans votre document à l’endroit où vous désirez insérer une nouvelle sec-
tion, ou sélectionnez le texte que vous voulez placer dans la nouvelle section.

 2) Dans la barre de menu, sélectionnez Insertion > Section. La boîte de dialogue Insérer une 
section (Figure 6.11).
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Figure 6.11 : Insérer une section à l’aide de la boîte de dialogue de même nom.

 3) Choisissez à votre convenance les paramètres sur chaque onglet de la boîte de dialogue.

 4) Cliquez sur Insérer.

La boîte de dialogue Insérer une section possède cinq onglets. Utilisez :

• l’onglet Section pour définir les attributs de la section ;

• l’onglet Colonnes pour définir le nombre et le paramétrage des colonnes ;

• l’onglet Retraits pour définir le retrait à droite et à gauche de la section par rapport aux 
marges ;

• l’onglet Arrière-plan pour ajouter une couleur ou une image à l’arrière-plan de la section ;

• l’onglet Notes de bas de page/de fin pour personnaliser les notes de la section.

À tout moment avant d’avoir refermé la boîte de dialogue, vous pouvez redonner à un onglet ses 
paramètres par défaut en cliquant sur le bouton Réinitialiser. Notez cependant que vous ne pou-
vez pas le faire pour l’onglet Section : si vous désirez défaire les changements dans cet onglet, 
vous devait le faire manuellement.

Nommer les sections

Writer propose automatiquement un nom pour la section dans le champ Nouvelle section de la 
boîte de dialogue. Pour le modifier, sélectionnez-le et remplacez-le. Ce nom est affiché dans la ca-
tégorie Sections de la fenêtre du navigateur. Si vous donnez aux sections des noms significatifs, 
vous pouvez plus facilement retrouver celles-ci qui vous intéressent.

Lier les sections

Il est possible d’insérer le contenu d’un autre document dans la section de façon que Writer le 
mette à jour chaque fois que ce document est modifié. Cela s’appelle lier la section à l’autre docu-
ment.
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Pour lier la section à un autre document, suivez ces étapes :

 1) Dans la section Lier de la boîte de dialogue, cochez l’option Lier (Figure 6.12).

Figure 6.12 : Lier des sections.

 2) Cliquez sur le bouton Parcourir… à la droite du champ Nom de fichier pour ouvrir la boîte 
de dialogue Insérer.

 3) Recherchez et sélectionnez le document que vous désirez insérer puis cliquez sur le bouton 
Insérer. La boîte de dialogue se referme et le nom du document choisi apparaît dans le 
champ Nom de fichier.

 4) Si vous désirez n’insérer qu’une section du document, sélectionnez-la dans la liste dérou-
lante Section.

Remarque

La section doit déjà exister dans le document choisi. Vous ne pouvez pas créer de section 
dans ce document à ce stade.

Vous pouvez mettre les liens à jour automatiquement ou manuellement. Voir « Actualiser les 
liens » page 165.

Protéger les sections contre les modifications

Pour protéger la section de façon que son contenu ne puisse pas être modifié, cochez l’option Pro-
téger dans la section Protection en écriture (Figure 6.13).

Figure 6.13 : Protéger les sections contre les modifications.

Remarque

La protection ne s’applique qu’au contenu de la section, pas à ses attributs ni à son format.

Protection par mot de passe

! Attention

Prenez bien soin de vous souvenir ou de noter le mot de passe parce qu’il ne pourra pas 
être retrouvé sans outils perfectionnés.
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Pour éviter que les attributs et le format de la section soient modifiés, vous pouvez protéger en 
supplément la section avec un mot de passe de la manière suivante :

 1) Cochez l’option Avec mot de passe. La boîte de dialogue Saisir le mot de passe s’ouvre (Fi-
gure 6.14).

 2) Tapez un mot de passe dans le champ voulu puis confirmez-le en le retapant dans le champ 
Confirmer.

 3) Cliquez sur OK pour refermer la boîte de dialogue. Le mot de passe sera demandé à qui-
conque tentera de modifier les attributs ou le format de la section.

Figure 6.14 : Protéger une section par un mot de passe.

Masquer les sections

Vous pouvez cacher la section pour qu’elle ne soit ni affichée à l’écran, ni imprimée. Vous pouvez 
aussi spécifier des conditions pour cela. Vous pouvez, par exemple, ne cacher la section qu’à cer-
tains utilisateurs.

Remarque

Vous ne pouvez pas masquer une section qui est le seul contenu de la page ni si elle se 
trouve dans un en-tête, un pied de page, une note de fin ou de bas de page, un cadre ou 
une cellule d’un tableau.

Pour cacher une section, cochez l’option Masquer dans la section de même nom de la boîte de 
dialogue (Figure 6.15).

Figure 6.15 : Masquer une section.

Pour ne masquer la section que sous certaines conditions, saisissez celles-ci dans le champ Sous
condition. La syntaxe et les opérateurs utilisés pour saisir les conditions sont les mêmes que ceux 
que vous utilisez pour saisir des formules. Pour la syntaxe et une liste d’opérateurs, voyez l’Aide 
de Writer à la rubrique Conditions : champs et sections. Voir aussi le Chapitre 17 Travailler avec 
les champs, page 486.

Si la section est protégée contre les modifications par un mot de passe, celui-ci doit être saisi pour 
masquer ou faire apparaître le texte.
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Remarque

Cacher le texte n’est pas une méthode très sûre pour empêcher quelqu’un de le lire. Elle ar-
rêtera le lecteur ordinaire mais n’empêchera pas celui qui désire vraiment découvrir ce que 
vous avez masqué, même avec une protection par mot de passe.

Disposer la section en plusieurs colonnes

Vous pouvez disposer certaines parties d’une page sur une colonne (par exemple un gros titre) 
suivies d’autres parties sur deux colonnes ou plus (par exemple l’article).

Conseil

Cette méthode ne permet pas de disposer sur une seule colonne un texte sélectionné sur 
une page formatée en deux colonnes. Vous devez partir d’une page comportant une co-
lonne unique puis sélectionner le texte de vous voulez disposer sur la page dans une sec-
tion comportant deux colonnes.

Utiliser l’onglet Colonnes de la boîte de dialogue Insérer une section (Figure 6.16) pour formater la 
section sur deux colonnes.

Figure 6.16 : Choix d’une répartition régulière entre les colonnes.

Quand vous ajoutez du texte à la section, celui-ci s’écoule d’une colonne à la suivante. Vous pou-
vez répartir le texte entre les colonnes d’une des deux façons présentées sur la Figure 6.17 :

• régulièrement : Writer ajuste la longueur des colonnes à celle du texte pour qu’elles aient à 
peu près la même hauteur. Celle-ci s’ajuste quand vous ajoutez ou supprimez du texte ;
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• type journal : Writer remplit les colonnes l’une après l’autre en commençant par la première. 
La dernière colonne peut être plus courte que les autres.

Pour répartir régulièrement le texte entre les colonnes, cochez l’option Répartition régulière du 
contenu sur toutes les colonnes dans la section Paramètres (Figure 6.16). Décochez-la si vous 
désirez une répartition du texte comme dans un journal.

Conseil

Activez l’affichage des fins de paragraphes (¶) en sélectionnant Affichage > Marques de 
formatage ou en appuyant sur Ctrl+F10. Un comportement inattendu des colonnes est 
souvent dû à des paragraphes supplémentaires normalement invisibles mais qui occupent 
de la place.

Figure 6.17 : Répartition régulière (à gauche) ou de type journal (à droite) entre les colonnes.

Mettre la section en retrait par rapport aux marges

Utilisez l’onglet Retraits (Figure 6.18) pour définir les retraits de la section par rapport aux marges 
de gauche et de droite.

Saisissez le retrait de gauche dans le champ Avant la section et celui de droite dans le champ 
Après la section. Le panneau d’aperçu à droite de l’onglet vous montre l’aspect de la section une 
fois les retraits appliqués.
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Figure 6.18 : Mettre une section en retrait.

Modifier l’arrière-plan de la section

Utilisez l’onglet Arrière-plan pour ajouter une couleur ou une image à l’arrière-plan de la section 
courante. Cet onglet est semblable aux onglets Arrière-plan des boîtes de dialogue des para-
graphes, des cadres3. Pour plus d’informations, voir le Chapitre 5 Mise en page : les bases, page
137 et suivantes.

Personnaliser les notes de fin et de bas de page d’une section

Figure 6.19 : Paramétrer les notes de bas de page et de fin d’une section

3 Cet onglet s’appelle Zone pour les cadres mais Arrière-plan dans tous les autres cas.

162 | Guide de LibreOffice Writer Utiliser des sections pour la mise en page



 Chapitre 6 Mise en page : approfondissements

Utilisez l’onglet Notes de bas de page/de fin pour personnaliser les notes de la section courante 
(Figure 6.19).

Personnaliser les notes de bas de page

Si vous désirez que les notes de bas de page de la section apparaissent séparément des autres 
notes de bas de page du document, cochez l’option Regrouper en fin de texte dans la zone Notes 
de bas de page.

Pour numéroter les notes de bas de page de la section à part des autres notes de bas de page du 
document et formater la numérotation, effectuez les étapes suivantes :

 1) Dans la zone Notes de bas de page, vérifiez que Regrouper en fin de texte est cochée.

 2) Cochez Recommencer la numérotation.

 3) Si vous désirez que la numérotation des notes de bas de page de la section commence à un
autre numéro que 1, saisissez le numéro désiré dans le champ Commencer avec.

 4) Cochez l’option Format personnalisé.

 5) Dans la liste déroulante des formats personnalisés, choisissez celui qui vous convient.

Pour ajouter un texte au format de numérotation choisi, utilisez les champs Avant et Après. Par 
exemple, si vous désirez que le numéro de la note de bas de page soit précédé du mot « Note » et
suivi d’un caractère deux-points, complétez ces champs comme sur la Figure 6.19

Personnaliser les notes de fin

Si vous désirez que les notes de fin de la section apparaissent à part des autres notes de fin du 
document, cochez l’option Regrouper en fin de section dans la zone Notes de fin.

Pour numéroter les notes de bas de page de la section à part des autres notes de bas de page du 
document et formater la numérotation, appliquez la procédure décrite ci-dessus aux paramètres de
la zone Notes de fin.

Enregistrer une nouvelle section

Pour enregistrer une nouvelle section et qu’elle apparaisse dans votre document, cliquez sur le 
bouton Insérer. La boîte de dialogue Insérer une section se referme et la nouvelle section apparaît
dans votre document.

Modifier et supprimer des sections

Pour modifier une section, effectuez les actions suivantes :

 1) Sélectionnez Format > Sections dans la barre de menu. La boîte de dialogue Éditer les 
sections s’ouvre (Figure 6.20).

 2) Choisissez la section que vous désirez modifier en cliquant sur son nom dans la liste.
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Figure 6.20 : La boîte de dialogue Éditer les sections.

Éditer les attributs de la section

Pour modifier le nom de la section sélectionnée, il suffit de taper le nouveau nom à la place de 
l’ancien dans la boîte de saisie.

Depuis cette boîte de dialogue, vous pouvez aussi

• éditer le lien vers la section sélectionnée (voir « Lier les sections » page 157),

• la protéger contre les modifications (voir « Protéger les sections contre les modifica-
tions » page 158),

• et la masquer (voir « Masquer les sections » page 159)

Modifier le format de la section

Pour modifier la mise en forme de la section sélectionnée, cliquez sur le bouton Options…

La boîte de dialogue Options possède quatre onglets, Colonnes, Retraits, Arrière-plan, Notes de 
bas de page/de fin, dont l’utilisation est décrite ci-dessus :

• Disposer la section en plusieurs colonnes page 160 ;

• Mettre la section en retrait par rapport aux marges page 161 ;

• Modifier l’arrière-plan de la section page 162 ;

• Personnaliser les notes de fin et de bas de page d’une section page 162.

Pour remettre un onglet dans l’état où elle se trouvait quand la boîte de dialogue a été ouverte, cli-
quez sur le bouton Réinitialiser.
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Pour enregistrer vos paramètres et revenir à la boîte de dialogue Éditer les sections, cliquez sur le 
bouton OK.

Supprimer des sections

Pour supprimer la section sélectionnée, cliquez sur le bouton Supprimer. Cette action ne sup-
prime pas le contenu de la section qui devient partie intégrante du document. Si le contenu était 
lié, il est alors incorporé.

Remarque

Writer ne vous demandera pas de confirmer la suppression de la section.

Actualiser les liens

Vous pouvez configurer Writer pour qu’il mette automatiquement à jour les sections liées et vous 
pouvez aussi le faire manuellement.

Actualisation automatique des liens

Pour que Writer mette les liens à jour sans vous en avertir, ou pour désactiver la mise à jour auto-
matique, effectuez les actions suivantes :

 1) Ouvrez la page LibreOffice Writer – Général de la boîte de dialogue Options (Outils > Op-
tions) qui propose les options d’actualisation des documents texte.

 2) Dans la section Actualiser les liens lors du chargement, choisissez une des trois options 
suivantes :

─ Toujours si vous désirez que Writer mette automatiquement les liens à jour, sans vous le 
demander, chaque fois que vous ouvrirez un document qui contient des liens.

─ Sur demande si vous désirez que Writer vous prévienne avant de mettre les liens à jour.

─ Jamais si vous désirez que Writer ne mette jamais les liens à jour.

 3) Cliquez sur OK pour enregistrer votre configuration.

Actualisation manuelle des liens

Une section protégée ne peut pas être mise à jour manuellement. Il faut d’abord la déprotéger.

Pour mettre manuellement un lien à jour :

 1) Ouvrez le document qui contient le lien.

 2) Sélectionnez Édition > Liens. La boîte de dialogue Éditer les liens s’ouvre (Figure 6.21).

 3) La liste proposée par cette boîte de dialogue affiche les noms de tous les fichiers liés au do-
cument en cours d’édition. Cliquez sur celui qui correspond au lien que vous désirez mettre à
jour.

 4) Cliquez sur le bouton Actualiser. Le contenu le plus récemment enregistré du fichier lié ap-
paraît dans le document courant.

 5) Pour refermer la boîte de dialogue, cliquez sur Fermer.
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Figure 6.21 : La boîte de dialogue Éditer les liens.

Supprimer des liens

Pour supprimer la liaison avec un fichier, ouvrez la boîte de dialogue Éditer les liens (voir ci-des-
sus), sélectionnez sur le fichier correspondant au lien que vous désirez supprimer puis cliquez sur 
le bouton Déconnecter. Cette action incorpore le contenu du fichier lié au document en cours 
d’édition.

Modifier l’orientation d’une page à l’intérieur d’un document

Un document peut comporter des pages orientées de façons différentes. Un cas courant est 
constitué par une page orientée en mode paysage au milieu d’un document où les autres pages 
sont en mode portrait. Voici comment obtenir ce résultat.

Paramétrer un style de page en mode paysage

 1) Si vous désirez conserver les mêmes marges que sur les autres pages, notez leur configura-
tion pour le style de page courant. (Vous trouverez les valeurs des marges dans la boîte de 
dialogue Style de page, à l’onglet Page comme on le voit sur la Figure 6.23.)

 2) Dans l’onglet Styles et formatage du volet latéral, faites un clic droit sur Paysage dans la 
liste des styles de page et choisissez Modifier dans le menu contextuel.

 3) Dans l’onglet Gestionnaire de la boîte de dialogue Style de page (Figure 6.22), vérifiez que 
le champ Style de suite contient bien Paysage (pour pouvoir placer plusieurs pages en 
mode paysage à la suite).
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Figure 6.22 : Définir le style de page Paysage comme style de suite

 4) Dans l’onglet Page de la boîte de dialogue (Figure 6.23), vérifier que l’orientation choisie est 
bien Paysage. Modifiez les marges pour qu’elles correspondent à celle des pages en mode 
portrait : la marge du haut en mode portrait devient la marge de gauche en mode paysage, 
et ainsi de suite.

 5) Cliquez sur OK pour enregistrer les modifications.

Figure 6.23 : Définir l’orientation et les marges d’une page en mode paysage

Insérer une page en mode paysage dans un document en mode portrait

Maintenant que le style de page Paysage est défini, voici comment l’appliquer.

 1) Placez le curseur dans le paragraphe ou le tableau au début de la page qui doit être orientée
en paysage. Faites un clic droit et sélectionnez respectivement Paragraphe… ou Propriétés
du tableau… dans le menu contextuel.
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 2) Dans l’onglet Enchaînement de la boîte de dialogue Paragraphe (Figure 6.24) ou de la boîte 
de dialogue Propriétés du tableau (Figure 6.25), cochez les options Insérer (Saut pour le ta-
bleau) et Avec le style de page. Dans la liste déroulante, sélectionnez le style de page Pay-
sage. Cliquez sur OK pour refermer la boîte de dialogue et appliquer le nouveau style de 
page.

Figure 6.24 : Créer un saut vers une page en mode paysage avant un paragraphe.

Figure 6.25 : Créer un saut vers une page en mode paysage avant un tableau.

 3) Pour revenir au mode portrait, effectuez la même opération en sélectionnant le style de page
qui était utilisé avant le passage en mode paysage.

En-tête en mode portrait sur pages en mode paysage

Quand on définit un en-tête ou un pied de page sur une page en mode paysage, ils sont alignés le 
long des grands côtés. Si cette page est insérée entre des pages en mode portrait, il peut être pré-
férable qu’ils s’alignent le long des petits côtés pour que le résultat final imprimé donne l’impres-
sion que le contenu des pages en format paysage a été pivoté de 90 degrés par rapport aux pages
en mode portrait.

Vous pouvez positionner les en-têtes et pieds de page sur les pages en mode paysage grâce à 
une astuce qui utilise des cadres. La mise en place est un peu laborieuse mais, une fois réalisée, 
vous pouvez copier le résultat sur les autres pages en mode paysage. Elle ne peut pas être incor-
porée au style de page en mode paysage lui-même. Dans l’exemple qui va suivre, nous désirons 
insérer une page orientée en paysage dans notre document imprimé, en lui donnant le même en-
tête, le même pied de page et les mêmes marges que nos pages orientées en portrait. Nous allons
utiliser une taille de papier A4.

Pour placer des en-têtes et des pieds de page en mode portrait sur des pages en mode paysage :
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 1) Notez les valeurs des marges de la page en mode portrait qui occuperait l’emplacement de 
la page en mode paysage ; par exemple, pour une page de droite en mode paysage, ceux 
d’une page de droite en mode portrait (voir le tableau).

Il faut ensuite augmenter les marges de droite et de gauche en mode paysage de 1 cm par 
rapport aux marges du haut et du bas en mode portrait. Cette différence va offrir un espace 
supplémentaire qui sera utilisé par l’en-tête et le pied de page en mode paysage (0,5 cm 
pour l’en-tête ou le pied de page lui-même et 0,5 cm d’espace vide en celui-ci et le corps du 
document).

 2) Appliquez ces valeurs des marges au style de page orientée en paysage.

Page en mode portrait (page de droite) Page en mode paysage (page de droite)

Marge de gauche (interne) 2,8 cm Marge du haut 2,8 cm

Marge de droite (externe) 1,8 cm Marge du bas 1,8 cm

Marge du haut 1,5 cm Marge de droite 2,5 cm

Marge du bas 1,5 cm Marge de gauche 2,5 cm

 3) Copiez et collez le pied de la page en mode portrait dans un paragraphe vide du texte. Col-
lez-le ou déplacez-le dans la page en mode paysage. Ce texte aura le style de paragraphe 
Pied de page si bien que la police, sa taille et la position des tabulations seront les bonnes.

Figure 6.26 : Copiez, collez et sélectionnez le pied de page.

 4) Sélectionnez le texte que vous venez de coller. Choisissez Format > Caractère. Dans la 
boîte de dialogue Caractère, ouvrez l’onglet Position et cochez l’option 270 degrés dans la 
section Rotation/Échelle. Cliquez sur OK.

Figure 6.27 : Faire pivoter le texte du pied de page de 270°

 5) Le texte étant toujours sélectionné, choisissez Insertion > Cadre > Cadre… Dans la boîte 
de dialogue Cadre, ouvrez l’onglet Type (Figure 6.28) et saisissez la largeur, la hauteur et les
positions horizontale et verticale du pied de page. Décochez, le cas échéant, les options 
Taille automatique pour la largeur et pour la hauteur.
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─ La largeur du cadre est celle du pied de page paramétrée dans l’onglet Pied de page du 
style de page en mode portrait.

─ La hauteur du cadre est obtenue par calcul. La largeur d’une page A4 est 21 cm moins la 
somme des marges du haut (2,8 cm) et du bas (1,8 cm) : 21 – (2,8+1,8) = 16,4 cm.

─ La position horizontale est la marge du bas de la page en mode portrait.

─ La position verticale est la marge du haut de la page en mode paysage.

 6) Si le pied de page est séparé du corps du texte par une ligne, comme dans ce livre, ouvrez 
l’onglet Bordures, supprimez toutes les bordures sauf celle de droite et donnez-lui la même 
largeur (épaisseur) de celle du pied de page en mode portrait. Mettez à 0 tous les champs 
de la section Espacement avec le contenu sauf celui de droite auquel vous donnez la 
même valeur que l’espacement du pied de page en mode portrait avec texte. Cliquez sur le 
bouton Plus de l’onglet Pied de page du style de page orientée en portrait pour trouver ces 
valeurs.

 7) Cliquez sur OK pour enregistrer cette configuration. Le pied de page apparaît alors à la 
bonne position et avec la bonne orientation. Tous les champs se mettront à jour automatique-
ment.

 8) Comme les arrêts de tabulation ont été supprimés, placez le curseur dans le cadre, à la fin 
du texte, là où était l’arrêt de tabulation, et insérez autant d’espace que nécessaire pour que 
la disposition s’accorde avec celle de la page en mode portrait.

Répétez ces étapes (avec les valeurs convenables) pour paramétrer l’en-tête de la page en mode 
paysage.

Figure 6.28 : Définir la taille et la position du cadre du pied de page

170 | Guide de LibreOffice Writer Modifier l’orientation d’une page à l’intérieur d’un document



 Chapitre 6 Mise en page : approfondissements

! Attention

N’oubliez pas de revenir au paragraphe du document où vous avez fait pivoter le texte et de 
remettre l’orientation à 0 degré sous peine d’y voir orienté verticalement tout texte que vous 
y saisirez.

Le pied de page en mode portrait

Le pied de page en mode paysage

Figure 6.29 : Les pieds de page pour les deux orientations
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7
Chapitre 7
Imprimer, exporter,
envoyer par courriel





Introduction

Ce chapitre décrit plusieurs manières d’imprimer ou d’exporter des documents depuis Writer, sous 
forme de papier ou électronique, ainsi que les options permettant de paramétrer ces méthodes.

Impression rapide

Cliquez sur l’icône Imprimer directement  pour envoyer la totalité du document à l’imprimante 
par défaut définie pour votre ordinateur.

Remarque

Vous pouvez modifier l’action de l’icône Imprimer directement pour envoyer le document à 
l’imprimante définie pour celui-ci au lieu de l’imprimante par défaut de l’ordinateur. Ouvrez la
page Chargement/enregistrement – Général de la boîte de dialogue Options (Outils > Op-
tions)et cochez l’option Charger les paramètres d’impression avec le document.

Impression contrôlée

Pour un contrôle plus poussé de l’impression, utilisez la boîte de dialogue Imprimer (Fichier > Im-
primer ou Ctrl+P).

Figure 7.1 : La boîte de dialogue Imprimer.

Remarque

Les options sélectionnées dans la boîte de dialogue Imprimer ne s’appliquent qu’à l’impres-
sion du document courant.

Impression contrôlée | 175



 Chapitre 7 Imprimer, exporter, envoyer par courriel

Pour spécifier des paramètres d’impression par défaut pour LibreOffice, ouvrez les pages 
LibreOffice – Impression et LibreOffice Writer – Impression de la boîte de dialogue Options 
(Outils > Options). Voir le Chapitre 20 Paramétrer Writer, pages 548 et 557, pour plus de 
détails.

La boîte de dialogue Imprimer possède quatre onglets où vous pouvez choisir une série d’options 
décrites dans les sections suivantes.

Choix des options générales d’impression

Dans l’onglet Général de la boîte de dialogue Imprimer, vous pouvez choisir :

• l’Imprimante (parmi les imprimantes disponibles). L’imprimante Imprimer dans un fichier est 
maintenant toujours disponible et produit un fichier que vous enregistrez sur votre disque ;

• les pages et le nombre de copies à imprimer et s’il faut assembler les copies (section Plage 
et exemplaires) ;

• l’ordre dans lequel les pages seront imprimées (parfois utile pour qu’elles sortent de l’impri-
mante dans le bon ordre) ;

• s’il faut imprimer les commentaires contenus dans le document et où le faire.

Certaines sections peuvent ne pas être toujours accessibles. Par exemple, si le document ne 
contient aucun commentaire, la liste déroulante Imprimer – Commentaires ne s’ouvre pas.

Figure 7.2 : Choix de l’impression des commentaires.

Cliquez sur le bouton Propriétés pour afficher la boîte de dialogue des propriétés de l’imprimante 
sélectionnée où vous pourrez choisir l’orientation portrait ou paysage, le bac à papier utilisé et la 
taille du papier.

Dans l’onglet Options de la boîte de dialogue Imprimer, vous pouvez choisir d’autres options pour 
l’impression.

Figure 7.3 : Options générales d’impression.
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Imprimer plusieurs pages sur une seule feuille de papier

Vous pouvez imprimer plusieurs pages d’un document sur une seule feuille de papier. Pour cela :

 1) Dans la boîte de dialogue Imprimer, ouvrez l’onglet Mise en page (Figure 7.4).

 2) Dans la section Mise en page, choisissez dans la liste déroulante le nombre de pages à im-
primer par feuille. La vignette à gauche de la boîte de dialogue Imprimer montre l’aspect 
qu’aura le document imprimé.

Figure 7.4 : Imprimer plusieurs pages sur une feuille de papier.

 3) Quand vous imprimez plus de 2 pages par feuilles, vous pouvez choisir l’ordre dans lequel 
elles sont imprimées sur la feuille (Figure 7.5).

Figure 7.5 : Choix de l’ordre dans lequel les pages seront imprimées.

 4) Dans la section Côtés des pages, choisissez d’imprimer toutes les pages ou seulement cer-
taines d’entre elles.

 5) Cliquez sur le bouton OK.
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Conseil

Dans Writer, pour imprimer deux pages face à face par feuille (mise en page livre), imprimez
plutôt depuis l’Aperçu d’impression. Voir page 181.

Sélectionner ce que l’on veut imprimer

En plus d’imprimer un document dans sa totalité, vous pouvez choisir d’imprimer des pages, des 
plages de pages ou une sélection du document comme cela est décrit dans cette section.

Pour imprimer une seule page :

 1) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctrl+P.

 2) Dans la boîte de dialogue Imprimer, sélectionnez la page à imprimer.

 a) Dans la section Plage et exemplaires de l’onglet Général, cochez l’option Pages. La 
boîte de saisie affiche le numéro de la page en cours.

 b) Saisissez le numéro de séquence de la page que vous désirez imprimer. Il peut être diffé-
rent du numéro de page si vous avez recommencé la numérotation des pages à l’intérieur
du document. La zone d’aperçu change pour montrer la page choisie.

 3) Cliquez sur OK.

Pour imprimer un groupe de pages :

 1) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctrl+P.

 2) Dans la boîte de dialogue Imprimer, sélectionnez le groupe de pages à imprimer.

 a) Dans la section Plage et exemplaires de l’onglet Général, cochez l’option Pages.

 b) Saisissez la suite des numéros de pages à imprimer (par exemple, 1-4 ou 1,3,7,11).

 3) Cliquez sur OK.

Pour imprimer une sélection du texte :

 1) Dans le document, sélectionnez les éléments (texte et graphiques) à imprimer.

 2) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctrl+P.

 3) La section Plage et exemplaires de la boîte de dialogue Imprimer comporte maintenant une
option Sélection et la zone d’aperçu montre les éléments sélectionnés. Voir la Figure 7.6.

 4) Cliquez sur OK.
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Figure 7.6 : Imprimer une sélection de texte.

Imprimer une brochure

Dans Writer, vous pouvez imprimer un document avec deux pages de chaque côté de la feuille de 
papier, disposées de telle manière que, une fois les feuilles imprimées pliées en deux, les pages 
sont dans le bon ordre pour former un livret ou une brochure.

Conseil

Préparez votre document pour qu’il ait un aspect satisfaisant une fois imprimé à l’échelle ré-
duite : prévoyez des marges, des tailles de polices, etc. appropriées. Il faudra peut-être faire
quelques essais.

Pour imprimer une brochure sur une imprimante qui n’imprime que sur une seule face :

 1) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctrl+P.

 2) Dans l’onglet Général de la boîte de dialogue Imprimer, cliquez sur le bouton Propriétés.

 3) Vérifiez que l’orientation de l’imprimante (portrait ou paysage) est la même que celle des 
pages de votre document. Ordinairement, cela n’a pas d’importance sauf pour les brochures.
Cliquez sur OK pour revenir à la boîte de dialogue Imprimer.

 4) Ouvrez l’onglet Mise en page dans la boîte de dialogue Imprimer.

 5) Cochez l’option Brochure.

 6) Dans la section Côtés des pages, choisissez l’option Verso / pages de gauche dans la liste
déroulante Inclure. Cliquez sur OK.
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Figure 7.7 : Brochure : sélection des pages à imprimer.

 7) Sortez les pages imprimées de l’imprimante, retournez-les et remettez-les dans l’imprimante 
dans le sens convenable pour imprimer le côté vierge. Vous devrez peut-être faire quelques 
essais pour trouver la disposition qui convient à votre imprimante.

 8) Dans la boîte de dialogue Imprimer, dans la section Côtés des pages, choisissez l’option 
Recto / pages de droite dans la liste déroulante Inclure. Cliquez sur OK.

Conseil

Si votre imprimante permet d’imprimer automatiquement des deux côtés de la feuille, choi-
sissez Toutes les pages.

Imprimer en noir et blanc (avec une imprimante couleur)

Il peut arriver que vous souhaitiez imprimer des documents en noir et blanc sur une imprimante 
couleur. Plusieurs solutions sont possibles. Notez que certaines imprimantes en couleurs peuvent 
imprimer en couleurs indépendamment des paramètres que vous définissez.

Modifier la configuration de l’imprimante pour imprimer en noir et blanc ou en niveaux de gris :

 1) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctrl+P.

 2) Cliquez sur Propriétés pour ouvrir la boîte de dialogue de Propriétés de l’imprimante. Les 
choix possibles varient d’une imprimante à l’autre, mais vous devriez trouver des options de 
paramétrage des couleurs. Voyez l’aide ou le guide de l’utilisateur de votre imprimante pour 
plus d’informations.

 3) Parmi les choix possibles, vous pouvez trouver noir et blanc ou niveaux de gris. Sélectionnez
celui qui vous convient.

 4) Cliquez sur OK pour confirmer votre choix et revenir à la boîte de dialogue Imprimer.

 5) Cliquez sur OK pour imprimer le document.

Conseil

Il vaut mieux choisir les niveaux de gris si votre document contient des éléments gra-
phiques.

Modifier la configuration de LibreOffice pour imprimer les textes et figures en couleur en niveaux 
de gris :
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 1) Sélectionnez Outils > Options pour ouvrir la boîte de dialogue Option puis choisissez la 
page LibreOffice – Impression.

 2) Cochez l’option Convertir les couleurs en niveaux de gris. Cliquez sur OK pour enregistrer la 
modification.

 3) Ouvrez la boîte de dialogue Imprimer (Fichier > Imprimer ou Ctrl+P)

 4) Cliquez sur OK pour imprimer le document.

Modifier la configuration de LibreOffice Writer pour imprimer en noir tous les textes en couleurs et 
tous les éléments graphiques en niveaux de gris :

 1) Sélectionnez Outils > Options pour ouvrir la boîte de dialogue Option puis choisissez la 
page LibreOffice Writer – Impression.

 2) Dans la section Contenus, cochez l’option Texte en noir. Cliquez sur OK pour enregistrer la 
modification.

 3) Ouvrez la boîte de dialogue Imprimer (Fichier > Imprimer ou Ctrl+P)

 4) Cliquez sur OK pour imprimer le document.

Aperçu des pages avant impression

La vue normale dans Writer montre quel sera l’aspect imprimé de chaque page et vous permet de 
modifier celles-ci. Si vous concevez un document à imprimer sur deux faces, vous pouvez voir l’as-
pect de chaque face. Writer offre deux façons de le faire :

• la disposition des pages (vue éditable) : utilisez le bouton Affichage livre (Pages face à face) 
dans la barre d’état :

• l’aperçu avant impression (vue non éditable).

Pour utiliser l’aperçu avant impression :

 1) Choisissez Fichier > Aperçu, cliquez sur le bouton Aperçu  dans la barre d’outils Stan-
dard ou appuyez sur Ctrl+Maj+O. Writer affiche alors la barre d’outils Aperçu à la place de 
la barre d’outils Formatage.

Figure 7.8 : La barre d’outils Aperçu

 2) Cliquez sur l’icône d’aperçu désiré : Aperçu une page ( ), Aperçu deux pages ( ), 
Aperçu Livre ( ) ou Aperçu plusieurs pages ( ).

 3) Pour imprimer le document à partir de cette vue, cliquez sur l’icône Imprimer ( ) pour ou-

vrir la boîte de dialogue Imprimer. Choisissez les options d’impression et cliquez sur le bou-
ton OK.

Imprimer des enveloppes

L’impression d’enveloppes se fait en deux étapes : le paramétrage et l’impression proprement dite.
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Pour paramétrer une enveloppe à imprimer seule ou avec un document :

 1) Cliquez sur Insertion > Enveloppe dans la barre de menu.

 2) Dans la boîte de dialogue Enveloppe, commencez par l’onglet Enveloppe (Figure 7.9). Véri-
fiez, ajoutez ou modifiez les informations dans les boîtes Destinataire et Expéditeur.

Vous pouvez taper directement les informations dans les boîtes de saisie Destinataire et Ex-
péditeur ou utiliser les listes déroulantes à droite de la boîte de dialogue pour sélectionner 
une base de données ou une table d’où vous pourrez obtenir les informations nécessaires à 
l’enveloppe. Voir le Chapitre 14 Le publipostage, page 392, pour plus de détails sur la ma-
nière d’imprimer les enveloppes à partir d’une base de données.

Figure 7.9 : Choix des informations sur le destinataire et l’expéditeur d’une enveloppe.

 3) Dans l’onglet Format (Figure 7.10), vérifiez et modifiez la position des informations sur le 
destinataire et l’expéditeur. La zone d’aperçu en bas à droite montre les effets de vos modifi-
cations.
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Figure 7.10 : Choix de la position et de la taille des éléments sur l’enveloppe.

 4) Pour formater le texte de ces blocs, cliquez sur les boutons Éditer sur la droite. Dans la liste 
déroulante, vous avec deux choix pour chaque bouton : Caractère ou Paragraphe.

─ Sélectionnez Caractère pour ouvrir une boîte de dialogue Caractère, semblable à la boîte
standard mais sans l’onglet Bordures, où vous pouvez définir le format des caractères.

─ Sélectionnez Paragraphe pour ouvrir une boîte de dialogue Paragraphe, semblable à la 
boîte standard mais sans l’onglet Plan & numérotation, vous pouvez définir les attributs du
paragraphe.

 5) Dans le bas à gauche de l’onglet, la section Taille vous permet de choisir le format de l’enve-
loppe dans une liste déroulante. La largeur et la hauteur de l’enveloppe sélectionnée s’af-
fichent dans les champs sous le format. Si vous choisissez un format existant, il suffit de véri-
fier ces dimensions. Si vous choisissez Personnalisé dans la liste, vous pouvez y saisir les 
dimensions de votre enveloppe.

Conseil

À ce niveau, il est seulement possible de modifier la position des points d’origine (coins su-
périeurs gauches) des cadres qui contiendront l’adresse de l’Expéditeur et du Destinataire, 
mais, une fois l’enveloppe créée, vous pourrez ajuster librement leurs tailles et leurs posi-
tions.

 6) Une fois la mise en forme effectuée, ouvrez l’onglet Imprimante (Figure 7.11) pour choisir les 
options de l’imprimante telles que l’orientation de l’enveloppe et son décalage. Il faudra peut-
être quelques essais pour trouver les meilleurs réglages pour votre imprimante.
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Vous pouvez aussi choisir une imprimante différente ou un autre paramétrage de votre impri-
mante (par exemple, pour préciser le bac qui contient les enveloppes) pour cette impression 
en cliquant sur le bouton Configuration et en faisant un choix dans la boîte de dialogue Pa-
ramétrage de l’imprimante.

Figure 7.11 : Choix des options d’imprimante pour l’enveloppe.

 7) Quand vous avez terminé la mise en forme et que vous êtes prêt à imprimer, cliquez soit sur 
le bouton Nouveau document, soit sur le bouton Insérer. Nouveau document ne crée 
qu’une enveloppe et ouvre un nouveau document pour celle-ci. Insérer place l’enveloppe 
dans votre document existant en tant que page 1.

Pour ne pas imprimer cette enveloppe, cliquez sur le bouton Annuler ou appuyez sur la 
touche Échap. Pour annuler les modifications et retrouver l’état initial de la boîte de dia-
logue, cliquez sur Réinitialiser.

L’enveloppe est maintenant contenue dans le même fichier que le document. Enregistrez celui-ci 
avant de faire quoi que ce soit d’autre.

Pour imprimer l’enveloppe :

 1) Sélectionnez Fichier > Imprimer dans la barre de menu.

 2) Dans la boîte de dialogue Imprimer, à la section Plage et exemplaires, sélectionnez Pages 
et tapez 1 dans la boîte de saisie. Cliquez sur OK pour lancer l’impression.
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Imprimer des étiquettes

On utilise couramment des étiquettes pour imprimer des listes d’adresses (avec une adresse diffé-
rente sur chaque étiquette), mais on peut aussi s’en servir pour réaliser plusieurs copies d’une 
seule étiquette, par exemple pour un autocollant portant une adresse de retour ou pour une éti-
quette de CD/DVD.

L’impression des étiquettes, comme celle des enveloppes, passe par deux étapes : le paramétrage
et l’impression. Ce sujet est traité en détails dans le Chapitre 14 Le publipostage, page 387.

Exportation au format PDF

LibreOffice peut exporter des documents au format PDF (Portable Document Format). Ce format 
de fichier standard est idéal pour envoyer le fichier à quelqu’un qui le visionnera avec Adobe Rea-
der ou un autre lecteur de PDF.

! Attention

Un document au format PDF n’est pas protégé par défaut contre les altérations et les modifi-
cations. Son contenu peut être édité par des outils logiciels spécialisés, y compris 
LibreOffice Draw.

Conseil

Contrairement à la commande Enregistrer sous, la commande Exporter écrit une copie du
document en cours dans un nouveau fichier au format choisi mais conserve le format qu’il a 
dans LibreOffice.

Exportation rapide en PDF

Cliquez sur l’icône Exporter au format PDF ( ) pour exporter la totalité du document avec les 
paramètres que vous avez choisis dans la boîte de dialogue Options PDF (voir ci-dessous). Il vous
est demandé de saisir le nom et l’emplacement du fichier PDF, mais vous n’avez pas l’occasion de
choisir une plage de pages, la compression des images ni les autres options.

Contrôler le contenu et la qualité du PDF

Pour un meilleur contrôle du contenu et de la qualité du PDF obtenu, utilisez Fichier > Exporter 
vers > Exporter au format PDF… La boîte de dialogue Options PDF s’ouvre. Elle possède six on-
glets (Général, Vue initiale, Interface utilisateur, Liens, Sécurité et Signatures numériques). Choi-
sissez les paramètres appropriés puis cliquez sur Exporter après quoi vous devrez saisir l’empla-
cement et le nom du fichier PDF à créer et de cliquer sur Enregistrer pour exporter le fichier.

Remarque

Il est aussi possible de choisir Fichier > Exporter pour ouvrir la boîte de dialogue Exporter. 
Sélectionnez le format PDF, saisissez un nom et un emplacement pour le fichier et cliquez 
sur Exporter. La boîte de dialogue Options PDF s’ouvre alors. Cliquez sur Exporter quand 
tous les réglages ont été effectués.
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La boîte de dialogue Options PDF – onglet Général

Dans l’onglet Général (Figure 7.12), vous pouvez choisir les pages à inclure dans le PDF, le type 
de compression à utiliser pour les images (qui affecte leur qualité dans le PDF) et d’autres options.

Figure 7.12 : L’onglet Général de la boîte de dialogue Options PDF.

Section Plage

• Tout : exporte la totalité du document en PDF.

• Pages : pour exporter un intervalle de pages, utilisez le format 3-6 (pages de 3 à 6). Pour ex-
porter des pages individuelles, utilisez le format 7 ; 9 ; 11 (pages 7, 9 et 11). Il est aussi pos-
sible d’exporter une combinaison d’intervalles et de pages individuelles en utilisant un format 
comme 3-6 ; 8 ; 10 ; 12.

• Sélection : exporte tout ce qui est sélectionné.

Section Images

• Compression sans perte : les images sont incorporées sans aucune perte de qualité. Avec 
des photographies, il peut en résulter de gros fichiers. Cette option est recommandée pour 
les autres types d’images ou d’objets graphiques.

• Compression JPEG : elle offre une qualité plus ou moins grande. Une qualité de 90 % est 
bien adaptée aux photographies (petite taille de fichier, perte de qualité à peine perceptible).

• Réduire la résolution des images : les images à faible DPI (Dot Per Inch : point par pouce) 
ont une qualité plus faible. Pour les regarder sur l’écran d’un ordinateur, une résolution de 
72 dpi (sous Windows) ou 96 dpi (sous GNU/Linux) est généralement suffisante, alors que 
pour l’impression il est souvent préférable d’utiliser au moins 300 ou 600 dpi selon les possi-
bilités de l’imprimante. Une valeur élevée des DPI augmente fortement la taille du fichier ex-
porté.
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Remarque

Les images EPS (Encapsulated PostScript) ne sont exportées que sous forme d’aperçus si 
elles en contiennent un, sinon elles sont exportées sous forme d’emplacements vides.

Section Filigrane

• Signer avec un filigrane : quand cette option est cochée, une couche transparente conte-
nant le texte que vous saisirez dans la boîte Texte apparaîtra sur chaque page du PDF.

Section Général

• PDF hybride (fichier ODF incorporé) : cochez cette option pour exporter le document 
comme fichier PDF contenant deux formats de fichiers : PDF et ODF. Dans les lecteurs de 
PDF, il se comporte comme un fichier PDF normal et il reste totalement modifiable dans 
LibreOffice.

• Archive PDF/A-1a (ISO 19005-1) : PDF/A est un standard ISO pour la conservation à long 
terme des documents en y incorporant toutes les informations nécessaires à une reproduc-
tion fidèle (telles que les polices) et en excluant d’autres éléments (y compris les formulaires,
la sécurité et l’encodage). Les balises PDF sont écrites. Si vous cochez PDF/A-1a, les élé-
ments interdits sont grisés (non disponibles).

• PDF marqué (ajouter la structure du document) : les PDF marqués contiennent des infor-
mations sur la structure du contenu du document. Cela peut aider à afficher ce document sur
des appareils possédant des écrans différents ou si on utilise un logiciel de lecture d’écran. 
Parmi les marques exportées, il y a la table des matières, les hyperliens et les contrôles. 
Cette option peut augmenter de façon significative la taille des fichiers.

• Créer un formulaire PDF – Format d’envoi : choisissez le format des formulaires envoyés 
depuis le fichier PDF. Ce paramètre l’emporte sur la propriété URL du contrôle que vous défi-
nissez dans le document. Il n’y a qu’un seul paramétrage commun valable pour tout le docu-
ment PDF : PDF (envoie tout le document), FDF (envoie le contenu du contrôle), HTML et 
XML. Vous choisirez le plus souvent le format PDF.

Autoriser les doublons de noms de champs : si cette option est cochée, le même nom 
peut être utilisé pour plusieurs champs dans le fichier PDF produit. Dans ce cas, vous pou-
vez saisir des données dans la première occurrence du champ et tous ceux qui ont le même 
nom recevront ce que vous avez saisi. Sinon, les noms de champs seront exportés avec des
noms uniques générés à cette fin.

• Exporter les repères de texte : exporte les titres du document en tant que « signets » (une 
table des matières est affichée par la plupart des lecteurs de PDF, y compris Adobe Reader).

• Exporter les substituants : exporte des substituants sous forme de texte au lieu de substi-
tuants vides.

• Exporter les commentaires : exporte les commentaires sous forme de notes PDF. Ce n’est 
peut-être pas ce que vous désirez !

• Exporter les pages vides insérées automatiquement : si cette case est cochée, les pages
vides insérées automatiquement sont exportées dans le PDF. Cela est préférable si vous im-
primez le PDF en double face. Par exemple, les chapitres des livres commencent toujours 
sur une page impaire (de droite). Quand le chapitre précédent finit lui aussi sur une page im-
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paire, LibreOffice insère une page vide entre ces deux pages impaires. Cette option déter-
mine si celle-ci est exportée.

• Afficher le PDF après export : votre lecteur de PDF par défaut va s’ouvrir pour afficher le fi-
chier PDF qui vient d’être exporté.

La boîte de dialogue Options PDF – onglet Vue initiale

Dans l’onglet Vue Initiale (Figure 7.13), vous pouvez choisir comment le PDF s’ouvre par défaut 
dans le lecteur PDF. Les choix devraient se comprendre d’eux-mêmes.

Figure 7.13 : L’onglet Vue initiale de la boîte de dialogue Options PDF.

Si l’option Mise en page de texte complexe est activée (dans la page Paramètres linguistiques – 
Langues de la boîte de dialogue Options : Outils > Options), une option supplémentaire est dis-
ponible sous Côte à côte : Première page à gauche (normalement, la première page est à droite 
avec l’option Côte à côte).

La boîte de dialogue Options PDF – onglet Interface utilisateur

Dans l’onglet Interface utilisateur (Figure 7.14), vous pouvez choisir d’autres options pour contrôler
la façon dont le fichier sera affiché par un lecteur de PDF. Certains de ces choix sont particulière-
ment utiles si vous créez un PDF destiné à une présentation ou une borne interactive.

Figure 7.14 : L’onglet Interface utilisateur de la boîte de dialogue Options PDF.
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Section Options de fenêtre

• Redimensionner la fenêtre selon la page initiale : provoque l’adaptation de la fenêtre du 
lecteur de PDF aux dimensions de la première page du fichier.

• Centrer la fenêtre à l’écran : centre la fenêtre du lecteur de PDF sur l’écran de l’ordinateur.

• Ouvrir en mode plein écran : ouvre le lecteur de PDF en plein écran au lieu du mode fenê-
tré.

• Afficher le titre du document : affiche le titre du document dans la barre de titre du lecteur 
de PDF.

Section Options d’interface utilisateur

• Masquer la barre de menu : masque la barre de menu par le lecteur de PDF.

• Masquer la barre d’outils : masque la barre d’outils par le lecteur de PDF.

• Masquer les contrôles de la fenêtre : masque les autres contrôles de la fenêtre par le lec-
teur de PDF.

Repères de texte

Permet de choisir combien de niveaux de titres sont affichés comme repères de texte si Ex-
porter les repères de texte est coché dans l’onglet Général.

La boîte de dialogue Options PDF – onglet Liens

Dans l’onglet Liens (Figure 7.15), vous pouvez définir la manière dont les liens sont exportés dans 
le PDF.

Figure 7.15 : L’onglet Liens de la boîte de dialogue Options PDF.

Exporter les repères de texte comme destinations nommées

Si vous avez défini des repères de texte sous Writer, cette option les exporte en tant que 
« destinations nommées » auxquelles les pages Web et les documents PDF peuvent se réfé-
rer.

Convertir les références de document en cibles PDF

Si vous avez défini des liens vers d’autres documents avec une extension OpenDocument 
(comme.odt,.ods ou.odp), cette option remplace ces extensions par.pdf dans le document 
PDF exporté.
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Exporter les URL relatives au système de fichier

Si vous avez défini des liens relatifs dans un document, cette option les exporte dans le PDF.

Liens entre documents

Cett option définit le comportement des liens sur lesquels vous cliquez dans les fichiers PDF.
Choisissez une option parmi les suivantes :

─ Mode par défaut : les liens PDF seront gérés comme il est spécifié dans votre système 
d’exploitation.

─ Ouvrir avec un lecteur de PDF : utiliser l’application qui a servi à afficher le document PDF
pour ouvrir les documents PDF liés.

─ Ouvrir avec un navigateur Internet : utiliser le navigateur Internet par défaut pour afficher 
les documents PDF liés.

La boîte de dialogue Options PDF – onglet Sécurité

L’exportation des PDF comporte des options pour encoder le PDF (pour qu’il ne puisse pas être 
ouvert sans mot de passe) et appliquer une gestion de certains droits numériques.

• Quand un mot de passe d’ouverture est défini, le PDF ne peut être ouvert qu’avec celui-ci. 
Une fois ouvert, l’utilisateur n’est soumis à aucune restriction sur ce qu’il peut faire (par 
exemple, l’imprimer, le copier ou le modifier).

• Quand un mot de passe d’autorisation est défini, le PDF peut être ouvert par n’importe qui, 
mais son utilisation peut être soumise à restrictions. Voir la Figure 7.16. Quand vous avez 
défini un mot de passe d’autorisation, les autres options de l’onglet Sécurité deviennent ac-
cessibles.

• Si les deux types de mots de passe sont définis, le PDF ne peut être ouvert qu’avec le mot 
de passe correct et son utilisation peut être restreinte.

Figure 7.16 : L’onglet Sécurité de la boîte de dialogue Options PDF.
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Remarque

Le paramétrage des autorisations n’a d’effet que si le lecteur de PDF de l’utilisateur le res-
pecte.

La Figure 7.17 montre la boîte de dialogue qui s’affiche quand vous cliquez sur le bouton Définir 
les mots de passe dans l’onglet Sécurité de la boîte de dialogue Options PDF.

Figure 7.17 : Définir un mot de passe pour encoder un fichier PDF.

La boîte de dialogue Options PDF – onglet Signatures numériques

Cet onglet contient les options qui concernent l’exportation de PDF signés numériquement.

Les signatures numériques permettent d’assurer que le PDF a réellement été créé par son auteur 
initial (vous) et qu’il n’a pas été modifié depuis lors.

L’exportation de PDF signés utilise les clés et certificats X.509 déjà stockés dans votre dépôt de 
certificats par défaut ou sur une carte à puce. Sous Linux ou Mac OS le dépôt à utiliser peut être 
sélectionné en dans la page LibreOffice > Sécurité > Chemin du certificat de la boîte de dialogue 
Options (cliquez sur Outils > Options > dans la barre de menu) ; sous Windows, le dépôt de certi-
ficats par défaut est toujours utilisé. Si vous utilisez une carte à puce, elle doit être déjà configurée 
pour être utilisée par votre dépôt. Cela se fait normalement pendant l’installation de son logiciel. 
Les détails concernant l’utilisation de ces propriétés sortent du cadre de ce chapitre.

Figure 7.18 : L’onglet Signatures numériques de la boîte de dialogue Options PDF.
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• Utiliser ce certificat pour signer numériquement les documents PDF : cliquez sur Sélec-
tionner pour ouvrir la boîte de dialogue Sélectionner le certificat où tous les certificats trou-
vés dans le dépôt sélectionné sont affichés. Si ce dépôt est protégé par un mot de passe, il 
vous est demandé. Quand vous utilisez une carte à puce protégée par un code PIN, celui-ci 
vous est aussi demandé.

Sélectionnez le certificat à utiliser pour signer numériquement le PDF exporté puis cliquez 
sur OK. Tous les autres champs de l’onglet ne sont accessibles qu’après le choix d’un certifi-
cat.

• Mot de passe du certificat : saisissez le mot de passe utilisé pour protéger la clé privée as-
sociée au certificat choisi. C’est habituellement le mot de passe du dépôt. Si celui-ci a déjà 
été saisi dans la boîte de dialogue Sélectionner le certificat, le dépôt peut déjà être déver-
rouillé et ne pas redemander le mot de passe.

Si vous utilisez une carte à puce, entrez ici le code PIN. Certains logiciels de cartes à puce 
vous demanderont de nouveau ce code avant de signer.

• Emplacement, Information de contact, Raison : vous pouvez saisir des informations sup-
plémentaires facultatives concernant la signature numérique qui sera appliquée au PDF. 
Celles-ci seront incorporées dans les champs appropriés du PDF et visibles par quiconque 
ouvrira le fichier. Tout ou partie de ces trois champs peut être laissé vide.

• Autorité d’horodatage : vous pouvez choisir l’URL d’une Autorité d’horodatage (Time 
Stamping Authority : TSA). Pendant le processus de signature du PDF, la TSA sera utilisée 
pour obtenir la date et l’heure signées numériquement qui seront incorporées à la signature. 
Si quelqu’un ouvre le PDF, il pourra utiliser cette information pour vérifier quand le document 
a été signé.

La liste des URL des autorités d’horodatage qui peuvent être choisies est conservée sous 
Outils > Options > LibreOffice > Sécurité > Autorités d’horodatage (TSA). Si aucune 
URL d’une autorité d’horodatage n’est sélectionnée (cas par défaut), la date et l’heure de la 
signature ne seront pas certifiées mais seront celles de votre ordinateur local.

Exporter en EPUB

Nouveauté de LibreOffice 6.0

LibreOffice peut désormais exporter des fichiers EPUB sans extension supplémentaire.

Le format EPUB est un format de livre électronique (e-book) qui peut être téléchargé et lu sur des 
dispositifs comme des téléphones portables (smartphones), des tablettes, des ordinateurs ou 
autres lecteurs adaptés. C’est le format basé sur XML (contrairement à PDF), indépendant du ven-
deur, qui est le plus largement répandu.

L’exportation au format EPUB est limitée dans LibreOffice 6.0. Un document ne contenant que du 
texte est généralement bien exporté, mais certains contenus (tels que les illustrations, les ta-
bleaux, les renvois) peuvent ne pas être exportés correctement. Ces fonctions devraient être ajou-
tées ou largement améliorées dans les futures versions de LibreOffice.
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Exportation rapide en EPUB

Sélectionnez Fichier > Exporter vers > Exporter directement au format EPUB pour exporter le 
document tout entier avec les paramètres EPUB que vous avez choisis le plus récemment dans la 
boîte de dialogue Export EPUB (voir ci-dessous). Il vous est demandé de saisir le nom et l’empla-
cement du fichier EPUB, mais vous ne pouvez pas effectuer de sélection parmi les autres options.

Exporter en EPUB

Pour un meilleur contrôle du contenu et de la qualité du fichier EPUB produit, sélectionnez  Fichier
> Exporter vers > Exporter au format EPUB… La boîte de dialogue Export EPUB s’ouvre (Fi-
gure 7.19). Elle est assez simple.

• La liste déroulante Version offre le choix de la version du fichier exporté en EPUB 2.0 et 
EPUB 3.0.

• La liste déroulante Méthode de scission permet de sélectionner la méthode de découpage du
document pour la pagination. Le choix En-tête partage les pages au niveau des paragraphes
de style Titre 1 ou Chapitre, alors que le choix Saut de page essaie de suivre la pagination 
d’origine du document.

Figure 7.19 : la boîte de dialogue Export EPUB.

Conseil

Parmi les autres logiciels qui permettent d’exporter des fichiers de Writer (*.odt) en format 
EPUB, Calibre est un gestionnaire de livres électroniques open source qui fonctionne sous 
Windows, macOs et Linux. Il offre de nombreuses fonctions de conversion et permet la mo-
dification du résultat. Adresse du site : https://calibre-ebook.com/fr.

Exporter en d’autres formats

LibreOffice utilise le terme « exporter » pour certaines opérations sur les fichiers qui impliquent un 
changement de type. LibreOffice peut exporter des fichiers en XHTML, EPUB et d’autres formats. 
Des formats supplémentaires peuvent être disponibles par l’intermédiaire d’extensions.

Sélectionnez Fichier > Exporter… Dans la boîte de dialogue Exporter, précisez le nom du docu-
ment exporté, sélectionnez le format souhaité dans la liste Type puis cliquez sur le bouton Expor-
ter.
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Figure 7.20 : Formats d’exportation de fichiers.

Envoyer des documents Writer par courriel

LibreOffice propose plusieurs moyens pour envoyer rapidement et facilement des documents 
comme pièces jointes à des courriels dans un des trois formats : *.odt (OpenDocument : format par
défaut de Writer), *.doc (format de Microsoft Office) ou *.pdf.

Remarque

Les documents ne peuvent être envoyés à partir du menu de LibreOffice que si un profil a 
été défini dans la page LibreOffice Writer – E-mail de publipostage de la boîte de dialogue 
Options (Outils > Options).

Pour envoyer le document en cours au format *.odt :

 1) Sélectionnez Fichier > Envoyer > Document par courriel ou Fichier > Envoyer > En-
voyer par e-mail sous forme de texte OpenDocument… Writer ouvre votre programme de
courrier électronique par défaut. Le document est attaché en pièce jointe.

 2) Dans ce programme, indiquez le destinataire, le sujet et ajoutez le texte que vous désirez 
puis envoyez le courriel.

Si vous choisissez Envoyer par e-mail sous forme de document Word…, Writer commence par 
créer un fichier *.doc puis ouvre votre programme de courrier électronique avec ce fichier en pièce 
jointe.

De la même manière, si vous choisissez Envoyer par e-mail en PDF…, Writer ouvre la boîte de 
dialogue Options PDF où vous pouvez choisir les paramètres qui vous conviennent, crée un PDF 
puis ouvre votre programme de courrier électronique avec le fichier *.pdf en pièce jointe.

Envoyer un document à plusieurs destinataires

Pour envoyer un document par courriel à plusieurs destinataires, vous pouvez utiliser les proprié-
tés de votre programme de courrier électronique ou les capacités de mailing de LibreOffice pour 
extraire les adresses mail d’un carnet d’adresses.

Vous pouvez utiliser le publipostage de LibreOffice pour envoyer des courriels de deux façons :

• utiliser l’Assistant Mailing pour créer le document et l’envoyer. Voir le Chapitre 14 Le publi-
postage, page 397, pour les détails ;

• créer le document dans Writer sans utiliser l’Assistant puis vous servir de celui-ci pour l’en-
voyer. C’est la méthode qui est décrite ici.
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Pour utiliser l’Assistant Mailing pour envoyer un document Writer déjà créé :

 1) Ouvrez le document dans Writer. Cliquez sur Outils > Assistant Mailing. Sur la première 
page de l’assistant, cochez Utiliser le document actif et cliquez sur Suivant (Figure 7.21).

Figure 7.21 : Choix du document de base.

 2) Sur la deuxième page, cochez Message e-mail et cliquez sur Suivant (Figure 7.22).

Figure 7.22 : Choix du type de document.

 3) Sur la troisième page, cliquez sur le bouton Sélectionner une liste d’adresses. Choisissez 
la liste d’adresses désirée (même s’il n’y en a qu’une) puis cliquez sur OK (Figure 7.23) (Si 
la liste d’adresse dont vous avez besoin n’apparaît pas ici, vous pouvez cliquer sur Ajouter 
pour la rechercher et l’ajouter à la liste.)
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Figure 7.23 : Choix d’une liste d’adresses.

 4) De retour à la page Sélection d’une liste d’adresse, cliquez sur Suivant. Dans la page Créer 
une salutation, décochez Ce document devrait contenir des salutations (Figure 7.24).

Figure 7.24 : Ne pas créer de salutations

 5) Cliquez sur le bouton Terminer.

 6) Dans la barre d’outil Mailing qui s’est ouverte en même temps que l’assistant, cliquez sur le 
bouton Envoyer les messages e-mail.

 7) La boîte de dialogue Envoyer le document fusionné par courriel s’ouvre (Figure 7.25). Dans 
le champ À, sélectionnez AdresseEmail dans la liste déroulante et tapez le sujet de votre 
courriel dans le champ Sujet puis cliquez sur le bouton Envoyer les documents.
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Figure 7.25 : Envoyer le document comme message électronique.

Envoyer un fax

Pour envoyer un fax directement depuis LibreOffice, vous avez besoin d’un modem fax et d’un pi-
lote qui permettent aux applications de communiquer avec celui-ci.

 1) Ouvrez la boîte de dialogue Imprimer (Figure 7.1) en sélectionnant Fichier > Imprimer (ou 
Ctrl+P) et choisissez le pilote de fax dans la liste des imprimantes.

 2) Cliquez sur OK pour ouvrir la boîte de dialogue de votre pilote de fax où vous pourrez choisir
le destinataire.

Vous pouvez définir un bouton dans une barre d’outils pour envoyer par fax le document ouvert 
d’un simple clic. Voyez comment faire dans le Chapitre 21 Personnaliser Writer, page 571.

Signature numérique des documents

Pour signer numériquement un document, vous avez besoin d’une clé personnelle appelée aussi 
certificat. Celle-ci est stockée sur votre ordinateur sous forme d’une combinaison d’une clé privée, 
qui doit être gardée secrète, et d’une clé publique, que vous ajoutez à votre document quand vous 
le signez. Vous pouvez obtenir un certificat d’une autorité de certification qui peut être une société 
privée ou une institution gouvernementale.

Quand vous appliquez une signature numérique à un document, une sorte de somme de contrôle 
est calculée à partir du contenu du document et de votre clé personnelle. Cette somme de contrôle
et votre clé publique sont stockées ensemble dans le document.

Quand quelqu’un ouvre par la suite le document sur n’importe quel ordinateur avec une version ré-
cente de LibreOffice, le programme recalcule la somme de contrôle et la compare à celle qui est 
stockée. Si les deux sont identiques, le programme vous signale que vous voyez le document ori-
ginal non modifié. En supplément, il peut vous montrer les informations de la clé publique à partir 
du certificat. Vous pouvez comparer la clé publique avec celle qui est publiée sur le site web de 
l’autorité de certification. Dès que quelqu’un modifie quelque chose dans le document, le change-
ment casse la signature numérique.

Sous les systèmes d’exploitation Windows, les fonctions de validation de signature de Windows 
sont utilisées. Sous Linux, les fichiers qui sont fournis par Thunderbird, Mozilla ou Firefox sont utili-
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sés. Pour une description plus détaillée de la façon d’obtenir et de gérer un certificat et une valida-
tion de signature, voyez « À propos des signatures numériques » dans l’Aide de LibreOffice.

Pour signer un document :

 1) Choisissez Fichier > Signatures numériques > Signatures numériques… Si vous avez 
configuré LibreOffice pour vous avertir quand le document contient des commentaires (voir 
« Supprimer les données personnelles » ci-dessous), une boîte de message peut appa-
raître pour vous demander si vous voulez continuer la signature du document.

 2) Si vous n’avez pas enregistré le document depuis la dernière modification, un message ap-
paraît. Cliquez sur Oui pour enregistrer le fichier.

 3) La boîte de dialogue Signatures numériques s’ouvre. Cliquez sur Signer le document pour 
ajouter une clé publique au document.

 4) Dans la boîte de dialogue Sélectionner le certificat, choisissez votre certificat et cliquez sur 
OK pour revenir à la boîte de dialogue Signatures numériques.

 5) Le certificat utilisé s’affiche dans la boîte de dialogue précédé d’une icône qui indique l’état 
de la signature numérique :

─ Une icône avec un sceau rouge ( ) indique que le document a été signé et le certificat 
validé.

─ Une icône avec un panneau d’avertissement jaune sur un sceau rouge ( ) indique que le
document est signé mais que le certificat n’a pas pu être validé.

─ Une icône avec un panneau d’avertissement jaune ( ) indique une signature numérique 
incorrecte.

 6) Cliquez sur Fermer pour appliquer la signature numérique.

Un document signé affiche une icône dans la barre d’état. Un double clic sur cette icône vous per-
met de voir le certificat. Plusieurs signatures peuvent être ajoutées à un document.

Signer plusieurs fois avec la même signature

Auparavant, LibreOffice interdisait la création de signatures multiples d’un document par le même 
auteur, car signer plusieurs fois le même document n’avait aucune signification sémantique. 
LibreOffice offre désormais une description de signature, si bien que des signatures multiples du 
même auteur sont autorisées, car chacune peut avoir une signification différente.

Quand vous sélectionnez Fichier > Signatures numériques > Signatures numériques…, la 
boîte de dialogue Signatures numériques (Figure 7.26) affiche les signatures existantes ainsi que 
leurs descriptions (le cas échéant).
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Figure 7.26 : Signatures du document.

Quand vous cliquez sur Signer le document, la boîte de dialogue Sélectionner le certificat (Figure
7.27) vous demande maintenant une description qui reste facultative.

Modifier la valeur d’une description existante invalide la signature.

Figure 7.27 : Les signatures peuvent désormais avoir une description.

Supprimer les données personnelles

Vous aurez peut-être envie d’être certain que les données personnelles, les versions, les notes, les
informations cachées ou les modifications enregistrées ont été supprimées des fichiers avant de 
les envoyer à d’autres personnes ou de vous en servir pour créer des PDF.

Dans la section Options et avertissements de sécurité de la page LibreOffice – Sécurité de la 
boîte de dialogue Options (Outils > Options), vous pouvez configurer LibreOffice pour qu’il vous 
rappelle (qu’il vous avertisse) quand les fichiers contiennent certaines informations et pour qu’il 
supprime automatiquement les informations personnelles à l’enregistrement.
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Figure 7.28 : Paramétrer les options et avertissements de sécurité.

Pour supprimer les informations personnelles et quelques autres données du fichier, sélectionnez 
Fichier > Propriétés. Dans l’onglet Général, décochez l’option Utiliser les données d’identité puis 
cliquez sur le bouton Réinitialiser les propriétés. Cette opération supprime tout nom dans les 
champs créés et modifiés, efface les dates de modification et d’impression et rétablit la durée 
d’édition à zéro, la date de création à la date en cours et le numéro de version à 1.

Pour supprimer les informations de version, vous pouvez sélectionner Fichier > Versions, sélec-
tionner les versions dans la liste et cliquer sur Supprimer, ou utiliser Fichier > Enregistrer sous 
pour enregistrer le fichier sous un nom différent.
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Qu’est-ce qu’un style ?

Un style est un ensemble de formats que vous pouvez appliquer aux pages, textes, cadres et 
autres éléments sélectionnés dans votre document pour modifier rapidement leur apparence. Ap-
pliquer un style signifie souvent appliquer tout un groupe de format à la fois.

Beaucoup de gens mettent manuellement en forme les paragraphes, les mots, les tableaux, la dis-
position des pages sans s’occuper des styles. Ils ont l’habitude d’écrire leurs documents en utili-
sant les attributs physiques. Par exemple, vous pouvez spécifier la famille et la taille de la police et
n’importe quelle mise en forme comme gras ou italique.

Les styles sont des attributs logiques. Leur utilisation signifie que vous allez cesser de penser 
« Police taille 14pt, Times New Roman, gras, centré » et vous mettre à penser « Titre » parce que 
vous avez défini le style « Titre » avec ces caractéristiques. En d’autres termes, utiliser des styles, 
c’est mettre l’accent sur ce qu’est le texte et pas sur son apparence.

Pourquoi utiliser les styles

Les styles améliorent la cohérence d’un document. Ils facilitent aussi les modifications importantes 
de mise en forme. Vous pouvez, par exemple, décider de modifier l’indentation de tous les para-
graphes ou la police de tous les titres. Pour un document long, cette simple tâche exige de faire 
des modifications individuelles à des douzaines d’emplacements. À l’opposé, en utilisant les styles,
vous n’avez besoin de faire qu’une modification unique.

En supplément, LibreOffice utilise les styles pour de nombreux processus, même si vous n’en pre-
nez pas conscience. Writer utilise les styles de titres (ou d’autres que vous précisez) pour compiler
une table des matières.

Catégories de styles

LibreOffice supporte les six types de styles suivants :

• les styles de page définissent les marges, les en-têtes et pieds de page, les bordures et les 
arrières-plans ;

• les styles de paragraphe contrôlent tous les aspects de l’apparence d’un paragraphe, comme
l’alignement du texte, les tabulations, l’espacement des lignes et les bordures et ils peuvent 
contenir une mise en forme des caractères ;

• les styles de caractère affectent le texte sélectionné dans un paragraphe par sa taille et la 
police utilisée ou par les attributs gras et italique ;

• les styles de cadre servent à formater les images et les cadres de texte, y compris le retour à
la ligne, les bordures, les arrière-plans et les colonnes ;

• les styles de liste où vous pouvez choisir le format et la position des nombres ou des puces 
dans les listes ;

• les styles de tableau définissent l’apparence des tableaux de données.

Les paragraphes sont les briques de base de tout document : les titres sont des paragraphes ; les 
en-têtes, les pieds de page et les éléments numérotés d’une liste sont des paragraphes. Les styles
de paragraphe sont donc ceux que l’on utilise le plus souvent et qui sont décrits avec le plus de 
détail dans ce chapitre.
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! Attention
La mise en forme manuelle (ou directe) l’emporte sur les styles. Vous ne pouvez pas vous 
débarrasser d’une mise en forme manuelle en appliquant un style après elle.

Pour supprimer la mise en forme manuelle, sélectionnez le texte puis choisissez Format > 
Effacer le formatage direct dans la barre de menu ou appuyez sur les touche Ctrl+M

L’onglet Styles et formatage du volet latéral

La gestion des styles est principalement accessible par l’onglet Styles et formatage (appelé Styles 
dans certaines installations), situé dans le volet latéral (Figure 8.1). C’est à partir de celui-ci que 
vous appliquerez et que vous modifierez les styles ou que vous en créerez de nouveaux.

Styles de paragraphe

Styles de caractère

Styles de cadre

Styles de page

Styles de liste

Styles de tableau

Nouveau style
Actualiser les styles
Charger les styles

Mode tout remplir

Figure 8.1 : L’onglet Styles et formatage montrant les styles de paragraphe et les filtres

Pour l’ouvrir, effectuez une des opérations suivantes :

• cliquez sur l’icône Styles et formatage ( )dans le volet latéral ;

• choisissez Styles > Styles et formatage dans la barre de menu ;

204 | Guide de LibreOffice Writer L’onglet Styles et formatage du volet latéral



 Chapitre 8 Introduction aux styles

• appuyez sur F11 ( +⌘ T sur Mac).

Les six premiers boutons en haut de l’onglet Styles et formatage permettent de choisir une catégo-
rie de styles. Cliquez sur l’un d’eux pour afficher les styles de cette catégorie, par exemple les 
styles de paragraphe ou les styles de caractère.

Cochez l’option Afficher les aperçus pour voir l’aspect des styles de la catégorie.

Filtrer les styles visibles

Utilisez la liste déroulante en bas de la fenêtre Styles et formatage pour choisir un filtre appliqué au
contenu de la liste des styles affichés dans la fenêtre. Comme, normalement, vous n’avez besoin 
que quelques styles dans un même document, il peut être utile de n’afficher que ceux-là.

Au début du processus d’écriture, vous pouvez avoir envie d’accéder à tous les styles disponibles 
(en sélectionnant Tous dans la liste déroulante) puis d’en exclure certains (Ctrl+clic sur 
chaque style à exclure, clic droit sur l’un d’eux puis choisir Masquer dans le menu contex-
tuel). Avec l’avancement du document, il peut être utile de réduire la liste affichée aux seuls styles 
utilisés (en sélectionnant Styles appliqués). Si vous travaillez sur un document où vous ne dési-
rez utiliser que des styles personnalisés, sélectionnez plutôt Styles personnalisés. La vue Hiérar-
chie est plus utile quand vous modifiez les styles, car elle révèle les styles liés les uns aux autres. 
Ce sujet est présenté dans le Chapitre 9 Travailler avec les styles, page 234.

Dans la vue Styles de paragraphe, la liste déroulante offre plusieurs options de filtrage supplémen-
taires pour vous permettre de n’afficher, par exemple, que les Styles de texte, les Styles pour 
zones spéciales, et ainsi de suite.

Appliquer des styles

Il est facile d’appliquer un style à partir de l’onglet Styles et formatage du volet latéral. Certains 
styles peuvent, en plus, être appliqués par d’autres méthodes exposées dans cette section.

Appliquer des styles de paragraphe

Au cours du premier jet d’un document, le type de style le plus utilisé est le style de paragraphe. 
LibreOffice offre quatre alternatives à l’onglet Styles et formatage du volet latéral pour appliquer ra-
pidement cette catégorie de styles ; le menu Styles (avec une petite sélection de styles couram-
ment utilisés), la liste Définir le style de paragraphe, le bouton Mode tout remplir du volet latéral 
et des raccourcis clavier.

Utiliser l’onglet Styles et formatage du volet latéral

Placez le curseur dans le paragraphe et faites un double clic sur le nom du style dans la section 
Styles de paragraphe de l’onglet Styles et formatage. Vous pouvez sélectionner plusieurs para-
graphes et leur appliquer à tous le même style en une seule fois.

Utiliser le menu Styles

Le menu Styles dans la barre de menu (Figure 8.2) propose les styles de paragraphe et de carac-
tère les plus couramment utilisés ainsi que quelques styles de liste et des moyens d’accéder aux 
outils pour créer ou modifier les styles. Pour appliquer un style de paragraphe, placez le curseur 
dans celui-ci et cliquez sur Styles > [nom du style de paragraphe] dans la barre de menu.
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Figure 8.2 : Le menu Styles.

Nouveau dans la version 6.0

Vous pouvez ajouter des styles au menu Styles  : sélectionnez Outils > Personnaliser… 
dans la barre de menu, ouvrez l’onglet Menu et choisissez le menu Styles et les com-
mandes de Styles. Voir le Chapitre 21 Personnaliser Writer page 569.

Utiliser la liste déroulante Définir le style de paragraphe

Quand un style de paragraphe est utilisé dans un document, son nom apparaît dans la liste Définir
le style de paragraphe située à l’extrémité gauche de la barre d’outils Formatage (voir Figure 8.3).

Pour appliquer un style depuis cette liste, placez le curseur dans le paragraphe à modifier puis cli-
quez sur le style voulu dans la liste ou utilisez les flèches vers le haut et vers le bas pour la par-
courir puis appuyez sur la touche Entrée pour appliquer le style mis en valeur.
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Figure 8.3 : La liste Définir le style de paragraphe dans la barre d’outils Formatage.

Conseil

Choisissez Plus de styles… à la fin de la liste pour ouvrir l’onglet Styles et formatage du vo-
let latéral.

Utiliser le mode Tout remplir

Vous pouvez utiliser le mode Tout remplir pour appliquer rapidement un style à plusieurs endroits 
sans avoir à revenir à l’onglet Styles et formatage du volet latéral pour y faire un double clic à 
chaque fois. Cette méthode est pratique pour formater avec le même style des paragraphes, mots 
ou autres éléments dispersés et elle se révèle peut-être plus simple que commencer par faire une 
sélection multiple avant de lui appliquer un style.

 1) Ouvrez l’onglet Styles et formatage du volet latéral (Figure 8.1) et sélectionnez un style.

 2) Cliquez sur l’icône du mode Tout remplir ( ).

 3) Pour appliquer un style de paragraphe, de page ou de cadre, survolez l’élément correspon-
dant au style avec la souris et cliquez. Pour appliquer un style de caractère, survolez les ca-
ractères avec le pointeur de la souris tout en appuyant sur le bouton gauche. Cliquer sur un 
mot applique le style de caractère à ce mot.

 4) Répétez l’étape précédente jusqu’à ce vous ayez effectué toutes les modifications désirées.

 5) Pour quitter le mode Tout remplir, cliquez de nouveau sur son icône ou appuyez sur la 
touche Échap.
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! Attention

Quand ce mode est actif, un clic droit n’importe où sur le document défait la dernière action 
de clonage du format. Faites attention de ne pas faire de clic droit accidentel qui déferait une
action que vous désirez conserver.

Utiliser les raccourcis clavier

Quelques raccourcis clavier prédéfinis permettent d’appliquer des styles. Par exemple, Ctrl+0 
applique le style Corps de texte, Ctrl+1 applique le style Titre 1, Ctrl+2 le style Titre 2. Vous 
pouvez modifier ces raccourcis et créer les vôtres : voir le Chapitre 21 Personnaliser Writer, page
573, pour les méthodes à employer.

Appliquer des styles de caractère

Writer offre trois méthodes décrites ici pour appliquer des styles de caractères.

Vous devrez peut-être supprimer la mise en forme directe avant d’appliquer des styles de carac-
tère. Pour cela, sélectionnez le texte puis choisissez Format > Effacer le formatage direct dans 
la barre de menu ou cliquez sur Ctrl+M

Utiliser l’onglet Styles et formatage du volet latéral

Ouvrez l’onglet Styles et formatage et cliquez sur le deuxième bouton de la barre en haut de celle-
ci. La liste des styles de caractère disponibles s’affiche. Pour appliquer un style de caractère, ef-
fectuez les actions suivantes :

 1) Sélectionnez le bloc de texte ou placez le curseur dans le mot auquel vous désirez appliquer
le style.

 2) Faites un double clic sur le style désiré dans la fenêtre Styles et formatage.

Remarque

Pour appliquer un style de caractère à plusieurs mots, il faut sélectionner tout le texte à mo-
difier. Pour l’appliquer à un seul mot, il suffit de placer le curseur dans le mot. À l’opposé, les
styles de paragraphe sont toujours appliqués à l’ensemble du paragraphe où le curseur est 
placé.

Utiliser le menu Styles

Le menu Styles dans la barre de menu (Figure 8.2) propose les styles de caractère les plus cou-
ramment utilisés (dans la deuxième section du menu). Pour appliquer un style de caractère,

• sélectionnez tous les caractères auxquels vous désirez appliquer le style,

• placez le curseur dans le mot auquel vous désirez appliquer le style,

cliquez sur Styles > [nom du style de caractère] dans la barre de menu.

Utiliser le mode Tout remplir

Vous pouvez utiliser le mode Tout remplir pour appliquer un format aux caractères comme décrit 
dans « Utiliser le mode Tout remplir », page 207.
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Appliquer des styles de cadre

Quand vous insérez un objet (par exemple une image) dans un document, il est automatiquement 
entouré d’un cadre invisible. Certains concepteurs aiment créer des styles de cadre pour introduire
un peu de variété. Vous pouvez, par exemple, avoir un style de cadre pour les photographies et un
autre pour d’autres images, telles que les dessins. Le style de cadre pour les photographies peut 
avoir une bordure avec une ombre alors que celui des dessins n’aura qu’une bordure.

Pour appliquer un style de cadre :

 1) Sélectionnez le cadre.

 2) Ouvrez l’onglet Styles et formatage du volet latéral.

 3) Cliquez sur l’icône Style de cadre (la troisième en partant de la gauche).

 4) Faites un double clic sur le style de cadre que vous désirez.

Une fois un style appliqué à un cadre, vous pouvez le modifier pour qu’il ait exactement l’appa-
rence que vous désirez. La plus grande partie de l’aspect d’un cadre peut être définie dans un 
style, mais les options suivantes doivent être déterminées manuellement :

• l’ancrage : la position du cadre par rapport aux autres éléments de la page (Format > 
Ancre) ;

• le positionnement : l’emplacement du cadre dans une pile d’objets (Format > Positionner) ;

• l’ajout d’un hyperlien : pour qu’un clic sur le cadre ouvre une page web ou un autre document
(Insertion > Hyperlien).

Quand un cadre est sélectionné, la barre d’outils Cadre remplace la barre d’outils Formatage et le 
menu contextuel (clic droit) offre des entrées pour ancrer, positionner, aligner et adapter le cadre 
au texte.

Appliquer des styles de page

Placez le curseur n’importe où dans la page. Le style appliqué est affiché dans la barre d’état.

Style de page courant

Figure 8.4 : Le style de la page où est le curseur s’affiche dans la barre d’état.

Pour appliquer un style de page différent, effectuez une des actions suivantes :

• faites un clic droit sur le nom du style dans la barre d’état et choisissez le nouveau style dans
le menu contextuel,

• ouvrez l’onglet Styles et formatage du volet latéral, cliquez sur l’icône du style de page (la 
quatrième en haut de la fenêtre) puis faites un double clic sur le style de page désiré.
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! Attention

Modifier le style d’une page peut entraîner la modification du style des pages suivantes. Le 
résultat peut ne pas être celui que vous attendiez. Pour ne changer le style que d’une seule 
page, vous devrez peut-être insérer un saut de page manuel comme cela est décrit ci-des-
sous.

Comme exposé au Chapitre 9 Travailler avec les styles, page 233, un paramétrage correct d’un 
style de page contient, le plus souvent, des informations sur le style de page de suite. Par 
exemple, quand vous appliquez un style Page gauche à une page, vous pouvez préciser quand 
les paramètres de ce style de page que la suivante devra recevoir le style Page droite ; une page 
de style Première page pourra être suivie d’une page soit de style Page gauche, soit de Style par 
défaut, et ainsi de suite.

Une autre façon de modifier le style de page consiste à insérer un saut de page manuel en préci-
sant le style de la page suivante. L’idée est simple : vous stoppez une suite de styles de page et 
vous en débutez une autre. Pour insérer un saut de page, sélectionnez Insertion > Saut manuel 
et choisissez Saut de page. Cette partie illustre deux situations où les sauts de page se révèlent 
utiles.

Premier exemple : les chapitres

Vous écrivez un livre divisé en chapitres. Chaque chapitre débute par une page de style Première 
page. Les pages suivantes utilisent le Style par défaut. À la fin de chaque chapitre (sauf le der-
nier), on revient au style Première page pour le chapitre suivant.

La Figure 8.5 illustre la suite des styles de page quand on utilise des sauts de page.

Figure 8.5 : Diviser un document en chapitres à l’aide de styles de page

Au moment où vous êtes prêt à débuter un nouveau chapitre, effectuez les actions suivantes :

 1) Placez le curseur à la fin du chapitre, seul sur une ligne blanche (paragraphe vide).

 2) Sélectionnez Insertion > Saut manuel. La boîte de dialogue Insérer un saut (Figure 8.6) 
s’ouvre.

 3) Dans la section Type, cochez Saut de page et dans la liste déroulante Style, sélectionnez 
Première page.

Conseil

Ces sauts peuvent se faire automatiquement en paramétrant le style de paragraphe du titre 
du chapitre (habituellement le style Titre 1) pour qu’il comporte un saut de page.
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Figure 8.6 : Insérer un saut de page avec le style Première page.

Deuxième exemple : page avec un formatage particulier

Vous pouvez parfois avoir besoin d’insérer une page avec un formatage particulier, par exemple 
une page orientée en mode paysage ou une page avec plusieurs colonnes. Vous pouvez aussi le 
faire grâce à des sauts de page. Supposons que la page courante soit de Style par défaut.

 1) Sélectionnez Insertion > Saut manuel.

 2) Sélectionnez le style de page désiré (par exemple, Page Spéciale) dans la boîte de dialogue 
Insérer un saut.

 3) Tapez quelque chose dans cette page puis insérez un nouveau saut de page en choisissant 
de nouveau le Style par défaut.

Cette procédure est illustrée par la figure suivante :

Figure 8.7 : Insertion d’une page de format particulier.

Troisième exemple : suites des pages dans les chapitres d’un livre

Les chapitres d’un livre débutent normalement par une page de droite dont la mise en page est lé-
gèrement différente des autres. Les autres pages du chapitre sont vis-à-vis pour une impression 
des deux côtés de la feuille. Par exemple, les numéros de page dans l’en-tête ou le pied de page 
peuvent être positionnés sur les bords extérieurs de la page alors que le bord intérieur accueille 
une marge plus large qui permet la reliure.
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Le Tableau 6 montre les propriétés de deux styles de page (Page droite et Style par défaut) à pa-
ramétrer pour obtenir une suite normale de pages dans un chapitre d’un livre.

Tableau 6 : Propriétés des styles de page personnalisés pour un chapitre d’un livre.

Style de page Effet souhaité Propriété : paramétrage

Page droite La première page est toujours à 
droite (avec un numéro impair).

Page > Paramètres de mise en page : 
Droite uniquement.

Ni en-tête ni pied de page. En-tête > Activer l’en-tête : non cochée.

Marge du haut plus grande que celle
des autres pages.

Page > Marges : Haut = 6,00 cm.

Style par défaut Marges en miroir. Page > Paramètres de mise en page : 
Pages en vis-à-vis.

En-tête avec un numéro de page du 
côté externe de la page et un titre de
chapitre au centre de la page.

En-tête > Activer l’en-tête : cochée.
En-tête > Même contenu sur les pages 
de droite et de gauche : non cochée.

La Figure 8.8 illustre les transitions entre la Page droite et les pages de Style par défaut avec le 
changement d’en-tête entre les pages de gauche et de droite indiqué par le signe #.

Figure 8.8 : Page de droite suivie de page de Style par défaut avec des en-têtes différents pour
les pages en vis-à-vis.

Première étape : paramétrer le style de Page droite.

Figure 8.9 : définir le style de suite après la première page du chapitre.
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 1) Dans la fenêtre Styles et formatage, cliquez sur l’icône Styles de page pour afficher la liste 
des styles de page.

 2) Faites un clic droit sur Page droite et sélectionnez Modifier… dans le menu contextuel.

 3) Dans l’onglet Gestionnaire de la boîte de dialogue Style de page : Page droite (Figure 8.9), 
remplacez le style de suite par le Style par défaut.

 4) Dans l’onglet Page, définissez une marge gauche plus grande pour la reliure ainsi qu’un 
marge du haut plus grande pour descendre le titre du chapitre dans la page.

Figure 8.10 : définir les marges et la mise en page du style Page droite.

 5) Dans les onglets En-tête et Pied de page, vérifiez que les options Activer l’en-tête et Activer 
le pied de page ne sont pas cochées. Cliquez sur OK pour enregistrer les modifications.

Deuxième étape : paramétrer le Style par défaut.

 1) Dans la fenêtre Styles et formatage, faites un clic droit sur Style par défaut dans la liste des 
styles de page et sélectionnez Modifier… dans le menu contextuel.

 2) Dans l’onglet Gestionnaire de la boîte de dialogue Style de page : Style par défaut, vérifiez 
que le Style de suite est bien Style par défaut.

 3) Dans l’onglet Page de cette boîte de dialogue, sélectionnez Page en vis-à-vis comme Mise 
en page et donnez aux marges Interne et Externe les mêmes largeurs respectives que les 
marges gauche et droite du style Page droite (Figure 8.11).

Figure 8.11 : définir les marges et la mise en page du Style par défaut.

 4) Dans l’onglet En-tête de la boîte de dialogue, cochez l’option Activer l’en-tête et désélection-
nez l’option Même contenu sur les pages de droite et de gauche (Figure 8.12). Cliquez sur 
OK pour enregistrer vos modifications.
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Figure 8.12 : Paramétrage de l’en-tête du Style par défaut.

Troisième étape : régler le style Titre 1 pour débuter sur une page de droite.

 1) Dans l’onglet Styles et formatage du volet latéral, ouvrez la section Style de paragraphe (pre-
mière icône à gauche), faites un clic droit sur le style Titre 1 et sélectionnez Modifier… dans 
le menu contextuel.

 2) Dans l’onglet Enchaînements de la boîte de dialogue Style de paragraphe : Titre 1, dans la 
section Saut, cochez l’option Insérer puis Avec le style de page et sélectionnez Page droite 
dans la liste déroulante. Cliquez sur OK pour enregistrer vos modifications.

Figure 8.13 : Faire débuter le paragraphe par une page du style choisi.

Quatrième étape : débuter un nouveau chapitre.

Appliquer le style de paragraphe Titre 1 au premier paragraphe qui sera le titre du chapitre.

Remarque

Par défaut, le style de paragraphe Titre 1 est affecté au niveau 1 du plan. L’affectation d’un 
style de paragraphe à un niveau de plan est gérée par Outils > Numérotation des cha-
pitres…

Cinquième étape : configurer les en-têtes des pages.

 1) Sur une page de gauche, placez le curseur dans l’en-tête et insérez un champ Numéro de 
page (Insertion > Numéro de page) à gauche.

 2) Appuyez sur la touche Tabulation pour placer le curseur au milieu de la ligne et insérer le 
nom du chapitre :

 a) Appuyez sur Ctrl+F2 (ou sélectionnez Insertion > Champs > Autres champs… dans 
la barre de menu) pour ouvrir la boîte de dialogue Champs (Figure 8.14).

 b) Dans l’onglet Document, dans la liste Type, sélectionnez Chapitre et dans la liste Format 
sélectionnez Nom du chapitre. Vérifiez que le champ Niveau à la valeur 1 puis cliquez sur 
le bouton Insérer.
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Figure 8.14 : Insérer le titre du chapitre dans l’en-tête d’une page

 3) Sur page de droite, placez le curseur dans l’en-tête, appuyez sur la touche Tabulation, in-
sérer le titre du chapitre, appuyez de nouveau sur la touche Tabulation et insérez un 
champ Numéro de page.

 4) Si vous avez besoin d’ajuster les arrêts de tabulation dans l’en-tête, modifiez le style de pa-
ragraphe En-tête. Ne déplacez pas directement des tabulations dans l’en-tête.

Appliquer des styles de liste

Les styles de liste définissent des propriétés telles que le retrait, le type de numérotation (par 
exemple 1,2,3 ; a, b, c ou des puces) et la ponctuation après le nombre, mais ils ne définissent pas
par eux-mêmes d’autres propriétés comme la police, les bordures, l’enchaînement du texte et ainsi
de suite. Ces dernières propriétés sont à la charge des styles de paragraphe.

Si vous avez besoin de listes possédant des propriétés spécifiques liées au style de paragraphe, 
incorporez-les dans des styles de paragraphe comme cela est expliqué au Chapitre 12 Travailler 
avec les listes, page 325, Vous pourrez alors créer une liste juste en appliquant un style de para-
graphe.

Writer offre deux séries de styles de liste prédéfinis, nommées Puce et Numérotation. Chaque sé-
rie contient cinq styles de liste adaptés aux différents niveaux d’une liste imbriquée. Comme pour 
tous les styles, vous pouvez redéfinir leurs propriétés, par exemple la numérotation ou le symbole 
puce ainsi que le retrait. Vous pouvez aussi en définir de nouveaux dans ces séries ou créer vos 
propres séries.

Chaque style de liste prédéfini dans Writer a quatre styles de paragraphe associés. Voir le Cha-
pitre 9 Travailler avec les styles pour plus d’informations. Vous trouverez beaucoup plus d’informa-
tions sur les styles de liste au Chapitre 12 Travailler avec les listes, page 319.

Si vous désirez seulement appliquer un style de liste (c’est-à-dire la numérotation ou une puce et 
le retrait), placez le curseur dans le paragraphe et faites un double clic sur le style de liste souhaité
dans la section Style de liste (cinquième icône en partant de la gauche) dans l’onglet Styles et for-
matage du volet latéral.
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Les styles de liste peuvent avoir jusqu’à dix niveaux utilisés pour les listes imbriquées. Pour passer
d’un niveau à un autre, utilisez les boutons Hausser d’un niveau ( ) ou Abaisser d’un niveau (

) de la barre d’outils Puces et numérotation, appuyez sur la touche Tabulation (pour abaisser
d’un niveau) ou Maj+Tabulation (pour hausser d’un niveau) ou faites un clic droit sur un élé-
ment de la liste et sélectionnez Hausser d’un niveau ou Abaisser d’un niveau dans le menu 
contextuel.

Recommencer ou continuer la numérotation

Quand on crée plusieurs listes numérotées du même type à l’intérieur du même chapitre, Writer 
applique la numérotation à toutes les listes les unes après les autres. C’est parfois ce que l’on dé-
sire (par exemple quand on place des illustrations entre les paragraphes numérotés), mais, 
d’autres fois, on désire recommencer la numérotation.

Pour recommencer la numérotation à partir de 1, vous pouvez effectuer une des actions sui-
vantes :

• Cliquer sur l’icône Recommencer la numérotation ( ) dans la barre d’outils Puces et nu-
mérotation.

• Faire un clic droit sur le premier élément de la liste et sélectionner Recommencer la numé-
rotation dans le menu contextuel.

• Faire un clic droit sur le premier élément de la liste, sélectionner Paragraphe dans le menu 
contextuel et ouvrir l’onglet Plan & numérotation de la boîte de dialogue Paragraphe. Dans la
section Numérotation, cochez les options Recommencer avec ce paragraphe et Démarrer 
avec et définir le numéro de départ dans la boîte de saisie en face de cette dernière option.

Figure 8.15 : Recommencer une numérotation.

Si la numérotation ne recommence pas comme prévu avec l’une des deux premières méthodes, 
ou si vous désirez qu’elle débute à une valeur supérieure à 1, utilisez la troisième méthode.

Quand vous modifiez un document, si vous souhaitez que la numérotation d’une liste continue 
celle de la précédente au lieu de recommencer à 1, faites un clic droit sur l’élément de la liste et 
sélectionnez Continuer la numérotation précédente dans le menu contextuel.

Appliquer des styles de tableau

Les styles de tableau définissent des propriétés comme la police, l’espacement des paragraphes, 
le nombre de colonnes, les bordures et la couleur d’arrière-plan.

Pour appliquer un style de tableau, placez le curseur quelque part dans celui-ci, ouvrez la fenêtre 
Styles et formatage dans le volet latéral, choisissez Styles de tableau (dernière icône à droite) puis
faites un double clic sur le nom du style dans la liste.
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Voir le Chapitre 13 Travailler avec les tableaux de données, page 363, pour plus d’information sur 
la création de styles de tableau.

Créer et modifier des styles

Writer offre de nombreux styles prédéfinis qui peuvent être utiles quand on partage un document 
sur une autre machine, spécialement si on y trouve une version de LibreOffice avec une langue 
différente, mais ils peuvent ne pas convenir à vos préférences. Vous pouvez construire votre 
propre bibliothèque de styles personnalisés que vous utiliserez à la place de ceux qui sont prédéfi-
nis ou modifier ceux qui existent.

Writer propose cinq mécanismes pour modifier les styles tant prédéfinis que personnalisés :

• mettre un style à jour à partir d’une sélection ;

• charger ou copier des styles d’un autre document ou d’un modèle ;

• modifier un style en utilisant sa boîte de dialogue ;

• utiliser l’actualisation automatique (seulement pour les styles de paragraphe et de cadre) ;

• utiliser l’AutoFormat (seulement pour les styles de tableau). Voir le Chapitre 13 Travailler 
avec les tableaux de données, page 363.

Conseil

Toute modification d’un style ne s’applique qu’au document actuellement ouvert. Si vous dé-
sirez utiliser les styles nouveaux ou modifiés dans d’autres documents, vous devez soit les 
enregistrer dans un modèle (voir le Chapitre 10 Travailler avec les modèles, page 266), soit 
les copier dans l’autre document comme cela est décrit dans « Charger des styles (depuis
un modèle ou un document) » page 219.

Utiliser les menus Nouveau style, Actualiser le style et Charger les 
styles

Les styles font partie des propriétés du document donc les changements que vous y apportez ou 
les nouveaux styles que vous créez ne sont disponibles que dans le document auquel ils appar-
tiennent. Les styles restent toujours attachés à un document : par exemple, si vous envoyez un do-
cument à quelqu’un d’autre par courriel, les styles suivront le document.

Si vous désirez réutiliser des styles nouveaux ou modifiés dans d’autres documents, vous devez 
soit les enregistrer dans un modèle (voir le Chapitre 10 Travailler avec les modèles, page 266) soit 
les copier dans le document où vous voulez vous en servir.

Le dernier bouton de la barre d’outils de l’onglet Styles et formatage du volet latéral ( ) déroule 
un menu qui donne accès à trois fonctions : Nouveau style, Actualiser le style et Charger les styles
(Figure 8.16).

Nouveau style à partir de la sélection

Utilisez la première fonction du bouton pour créer un nouveau style à partir de la mise en forme 
d’un objet du document en cours d’édition. Vous pouvez, par exemple, modifier le formatage d’un 
paragraphe ou d’un cadre jusqu’à obtenir l’aspect désiré puis transformer ce formatage en nou-
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veau style. Ce procédé peut vous faire gagner du temps, car vous n’avez pas à vous souvenir de 
tous les paramètres de la mise en forme comme cela est nécessaire pour créer un nouveau style 
avec la boîte de dialogue Style. En supplément, contrairement au choix des paramètres de forma-
tage dans les pages de la boîte de dialogue, que nous verrons plus tard, vous pouvez immédiate-
ment observer le résultat de vos choix sur l’objet que vous formatez pendant que vous créez le 
style.

Pour créer un nouveau style à partir d’une sélection, effectuez les actions suivantes :

 1) Modifiez le formatage de l’objet (paragraphe, cadre, etc.) à votre convenance.

 2) À l’aide des boutons au sommet de la fenêtre, choisissez la catégorie de style à créer (para-
graphe, caractère, etc.).

 3) Dans le document, sélectionnez la partie dont vous allez enregistrer le style.

 4) Revenez dans l’onglet Styles et formatage, cliquez sur le bouton Nouveau style à partir de 
la sélection ( ) puis choisissez Nouveau style dans le menu déroulant.

 5) La boîte de dialogue Créer un style s’affiche, tapez-y le nom du nouveau style. La liste 
montre les noms des styles personnalisés du type choisi qui existent déjà. Cliquez sur OK 
pour enregistrer le nouveau style.

Actualiser un style à partir de la sélection

Pour actualiser, par exemple, un style de paragraphe à partir d’une sélection :

 1) Ouvrez l’onglet Styles et formatage du volet latéral.

 2) Dans le document, sélectionnez ou créez un paragraphe qui a le format que vous voulez 
donner au style à actualiser.

! Attention

Quand vous actualisez un style de paragraphe, assurez-vous que le paragraphe sélectionné
ne contient que des propriétés uniques. S’il mélange des tailles ou des styles de police, ces 
propriétés mélangées resteront comme elles étaient.

Figure 8.16 : Actualiser un style depuis une sélection

 3) Dans l’onglet Style et formatage, choisissez le style à actualiser (par un clic simple, pas par 
un double) puis cliquez sur le bouton Nouveau style à partir de la sélection ( ) puis sur 
Actualiser le style.
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La procédure est la même pour actualiser n’importe quelle autre catégorie de style (caractère, 
page ou cadre) : sélectionner l’élément choisi, le modifier, sélectionner le style à actualiser puis 
choisir Actualiser le style…

Charger des styles (depuis un modèle ou un document)

La dernière option du menu déroulant ouvert par le bouton Nouveau style à partir de la sélection
( ) sert à copier des styles dans le document en cours d’édition en les chargeant depuis un mo-
dèle ou un autre document. Grâce à cette méthode, vous pouvez copier tous les styles, ou 
groupes de styles, en une seule fois.

 1) Ouvrez le document dans lequel vous désirez copier des styles.

 2) Dans l’onglet Styles et formatage du volet latéral, cliquez sur le bouton Nouveau style à 
partir de la sélection ( ) et cliquez sur Charger les styles… (Figure 8.16).

 3) Dans la boîte de dialogue Charger les styles (Figure 8.17), recherchez et sélectionnez le mo-
dèle où le document dont vous allez copier les styles.

Cliquez sur le bouton À partir d’un fichier… si les styles que vous recherchez sont conte-
nus dans un document plutôt que dans un modèle. Dans ce cas, une boîte de dialogue stan-
dard de sélection de fichiers s’ouvre pour vous permettre de choisir le document voulu.

Figure 8.17 : Charger des styles depuis un modèle

 4) Sélectionnez les types de styles à copier : Texte (styles de paragraphe et de caractère), 
Cadre, Pages et Numérotation (styles de liste). Si vous cochez l’option Écraser, les styles 
copiés remplaceront les styles de même nom dans le document cible.

 5) Cliquez sur OK pour copier les styles.

Glisser-déposer une sélection pour créer un style

Une autre façon pour créer un nouveau style consiste à glisser-déposer un texte dans l’onglet 
Styles et formatage du volet latéral.

 1) Ouvrez l’onglet Styles et formatage.
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 2) Sélectionnez le type de style que vous désirez créer (par exemple, style de caractère) en cli-
quant sur une des icônes en haut à gauche de la fenêtre.

 3) Sélectionnez l’objet qui va servir de base au nouveau style et faites le glisser dans la fenêtre 
Styles et formatage avant de l’y déposer. Le curseur change pour vous indiquer si l’opération
est possible.

 4) Dans la boîte de dialogue Créer un style, tapez le nom du nouveau style et cliquez sur OK 
pour l’enregistrer.

Remarque

Il n’est pas possible de créer un nouveau style de page ou de tableau de cette façon.

Modifier un style grâce à la boîte de dialogue Style

Pour modifier un style existant (sauf un style de tableau) en utilisant la boîte de dialogue Style, 
faites un clic droit sur le style dans l’onglet Styles et formatage du volet latéral et sélectionnez Mo-
difier… dans le menu contextuel.

La boîte de dialogue qui s’ouvre dépend du type de style choisi. Chacune possède plusieurs on-
glets. Leurs propriétés sont décrites au Chapitre 9 Travailler avec les styles, page 231.

Vous pouvez cliquer à tout instant sur le bouton Aide pour ouvrir l’aide en ligne où toutes les op-
tions de l’onglet ouvert sont brièvement décrites. Quand vous avez terminé, cliquez sur OK pour 
refermer la boîte de dialogue.

Utiliser l’actualisation automatique

Les onglets Gestionnaire des boîtes de dialogue Style de paragraphe et Style de cadre proposent 
une option Actualisation automatique. Si elle est cochée, LibreOffice appliquera au style toute mo-
dification manuelle de la mise en forme d’un paragraphe (ou d’un cadre) de ce style.

Figure 8.18 : L’option Actualisation automatique dans l’onglet Gestionnaire de la boîte de dialogue
Style de paragraphe.

! Attention

Si vous avez l’habitude d’imposer des modifications manuelles dans vos documents par-
dessus les styles, vérifiez bien que l’option Actualisation automatique n’est pas cochée sous
peine de voir des parties entières de votre document reformatées de manière inattendue.
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Supprimer des styles

Il n’est pas possible de supprimer d’un document ou d’un modèle les styles prédéfinis de 
LibreOffice, même s’ils ne sont pas utilisés. Seuls les styles personnalisés peuvent être supprimés.

Pour supprimer les styles non désirés, sélectionnez chacun d’eux dans l’onglet Styles et forma-
tage du volet latéral (appuyez sur Ctrl pour sélectionner plusieurs styles) puis faites un clic droit 
sur l’un d’entre eux et choisissez Effacer… dans le menu contextuel. Si le style est utilisé, un mes-
sage vous en prévient et vous demande si vous désirez vraiment le supprimer. S’il n’est pas utilisé,
il est immédiatement effacé sans confirmation.

! Attention

Si vous supprimez un style utilisé dans le document, tous les objets qui l’utilisent reprennent 
le style sur lequel il était basé (celui dont il a hérité) mais conservent une partie du forma-
tage du style effacé comme mise en forme manuelle.

Conseil

Si un style de paragraphe que vous désirez effacer est toujours utilisé, vous pouvez utiliser 
la fonction Rechercher & remplacer pour le remplacer par un autre avant de le supprimer. 
Voir le  Chapitre 3 Travailler avec le texte : Approfondissements, page 74, pour plus d’infor-
mations.

Exemple de création et de modification de styles de 
paragraphe

Cette partie propose un exemple d’utilisation typique de styles de paragraphe personnalisés. Nous
allons créer un style de paragraphe Poésie et un style de paragraphe Titre de poésie qui auront les
propriétés suivantes :

• Poésie : centré avec une police de taille 12 pt ;

• Titre de poésie : centré, caractères gras, avec une police de taille 14 pt.

En supplément, un paragraphe de style Titre de poésie devra être suivi d’un paragraphe de style 
Poésie. En d’autres termes, quand vous appuierez sur la touche Entrée, le style de paragraphe 
suivant dans le document deviendra Poésie.

Remarque

Vous avez peut-être déjà constaté ce comportement. Quand vous saisissez un titre en utili-
sant le style de paragraphe Titre 1 et que vous appuyez sur la touche Entrée, le style du 
paragraphe suivant devient Corps de texte.

Création du style de paragraphe Poésie

Nous allons utiliser le Style par défaut comme point de départ.

 1) Dans l’onglet Styles et formatage, cliquez sur le bouton Styles de paragraphe.

 2) Faites un clic droit sur Style par défaut et choisissez Nouveau… dans le menu contextuel.
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La boîte de dialogue Style de paragraphe s’ouvre à l’onglet Gestionnaire. Pour créer un style per-
sonnalisé, vous devez configurer les trois premiers paramètres.

Champs Description

Nom Le nom du style lui-même, comme Titre 1 ou Corps de texte.
Tapez Poésie comme nom.

Style de suite Le style d’un paragraphe qui suivra le paragraphe de style Poésie. Quand vous 
appuierez sur Entrée en tapant le texte avec le style Poésie, c’est ce style-là 
qui sera appliqué au nouveau paragraphe.
Donnez-lui la valeur Poésie. Quand vous appuierez sur Entrée, le nouveau pa-
ragraphe conservera le style Poésie.

Hérité de Si les propriétés du style Poésie sont héritées d’un autre style, par exemple le 
Style par défaut, toute modification de ce style affectera le style Poésie.
Pour notre exemple, ce n’est pas le comportement que nous souhaitons. Choi-
sissez - Aucun(e) - pour ce paramètre, ce qui veut dire que ce style n’est hérité 
d’aucun autre.

Sélectionnez Styles personnalisés comme Catégorie. Ne cochez pas l’option Actualisation auto-
matique.

Ces changements une fois réalisés, la boîte de dialogue devrait ressembler à ceci (Figure 8.19) :

Figure 8.19 : Configuration initiale du style Poésie. Définissez les trois premiers paramètres
comme on le voit ici.

L’étape suivante consiste à configurer l’alignement et la police pour ce style.

• Dans l’onglet Alignement, cochez l’option Centrer.

• Dans l’onglet Police, sélectionnez 12 pt comme taille de police.

Cliquez sur OK pour enregistrer le nouveau style Poésie.

Création du style Titre de poésie

Pour créer le style Titre de poésie, utilisez la procédure précédente avec ces modifications :

• Style de suite : choisissez Poésie et non Titre de poésie. Quand vous appuierez sur Entrée 
après avoir tapé le texte dans le style Titre de poésie, le style Poésie sera automatiquement 
appliqué au nouveau paragraphe.

• Hérité de : Titre
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La boîte de dialogue devrait avoir l’apparence suivante (Figure 8.20) :

Figure 8.20 : Paramètres du style Titre de poésie.

Définissez maintenant la mise en forme du nouveau style :

 1) Dans l’onglet Alignement, cochez Centrer.

 2) Dans l’onglet Police, sélectionnez Gras et une taille de 14 pt.

Cliquez sur OK pour enregistrer le nouveau style Titre de poésie.

Exemple de poème

Le moment est venu de tester vos nouveaux styles pour voir si vous en êtes satisfaits. Taper un 
poème en utilisant les styles que nous venons de définir devrait donner un résultat semblable à ce-
lui-ci (Figure 8.21) :

Figure 8.21 : Exemple de poème.

Modifier la mise en forme de nos styles

Un des principaux avantages des styles est qu’ils permettent de modifier la mise en forme d’un do-
cument quand son contenu a été écrit. Supposons, par exemple, que vous ayez écrit 100 pages 
de poésie, après quoi vous (ou votre éditeur) jugiez que l’aspect des poèmes ne vous plaît pas.

Pour apprendre à reconfigurer des styles, nous allons ajouter un retrait au style Poésie au lieu de 
le centrer.

Commencez par aligner à gauche le style Poésie :
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 1) Dans l’onglet Styles et formatage, faites un clic droit sur le style Poésie et sélectionnez Mo-
difier… dans le menu contextuel.

 2) Dans l’onglet Alignement, cochez l’option À gauche.

Définissez ensuite le retrait :

 1) Ouvrez l’onglet Retraits et espacement.

 2) Dans la section Retrait, paramétrez le retrait avant le texte à 5 cm.

Cliquez sur OK. Vous devriez voir le texte changer. Le poème devrait prendre l’aspect qu’il a sur la
Figure 8.22. Notez que celle-ci utilise un troisième style personnalisé pour l’auteur du poème.

Figure 8.22 : Le résultat final qui utilise trois styles personnalisés.

Utilisation des styles de paragraphe pour définir une hiérarchie
de titres

Les styles de paragraphe sont la clé de la fonction de numérotation du plan dans LibreOffice. La 
boîte de dialogue Numérotation des chapitres (Outils > Numérotation des chapitres…) permet 
de définir la hiérarchie des titres d’un document. Les styles de paragraphe affectés par défaut aux 
niveaux de plan sont les styles de titre prédéfinis par LibreOffice : Titre 1, Titre 2, et ainsi de suite. 
Vous pouvez cependant leur substituer n’importe quel style que vous voulez, y compris ceux que 
vous avez définis.

Les titres définis en utilisant la fonction de numérotation des chapitres peuvent servir à bien 
d’autres choses qu’à faire la table des matières (décrite au Chapitre 15 Tables des matières, index 
et bibliographies, page 411). Par exemple, des champs sont couramment utilisés pour afficher des 
titres dans les en-têtes et pieds de page (voir le Chapitre 17 Travailler avec les champs, page 483)
et Writer peut envoyer le plan à Impress pour qu’il l’utilise comme base d’une présentation (voir le 
Guide Impress pour les détails).

Choix des styles de paragraphe pour les niveaux de plan

Si vous utilisez les styles de titre par défaut pour les niveaux de votre plan, et que vous ne désirez 
pas utiliser la numérotation des titres, vous n’avez pas besoin de faire quoi que ce soit dans la 
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boîte de dialogue Numérotation des chapitres. Le schéma de numérotation par défaut du plan uti-
lise les styles de titre par défaut (Titre 1, Titre 2, etc.).

Pour utiliser des styles personnalisés à la place d’un ou plusieurs styles de titre par défaut :

 1) Sélectionnez Outils > Numérotation des chapitres… pour ouvrir la boîte de dialogue Nu-
mérotation des chapitres (Figure 8.23).

 2) Dans la liste Niveau, cliquez sur le niveau de titre dont vous désirez changer le style de pa-
ragraphe.

 3) Dans la liste déroulante Style de paragraphe de la section Numérotation, choisissez le style
de paragraphe que vous désirez affecter à ce niveau de titre. Dans l’exemple proposé, Titre 
1 Personnalisé a été choisi pour remplacer Titre 1 au niveau 1 et Titre 2 Personnalisé est en 
cours de sélection pour remplacer Titre 2 au niveau 2.

 4) Effectuez la même opération pour chaque niveau de plan dont vous voulez changer le style 
puis cliquez sur OK.

Figure 8.23 : Choix des styles de paragraphes pour les niveaux de plan.

Affecter des niveaux de plan à d’autres styles

Dans Writer, on peut affecter un niveau de plan à n’importe quel style de paragraphe. Cette fonc-
tion permet de créer une table des matières qui inclut ces titres en plus de ceux qui utilisent les 
styles définis dans la boîte de dialogue Numérotation des chapitres. Vous pouvez, par exemple, 
utiliser une suite de styles différente pour les annexes tout en souhaitant que les titres et sous-
titres de ces annexes apparaissent dans la table des matières aux mêmes niveaux que les titres et
sous-titres des chapitres.

Pour affecter un niveau de plan à un style de paragraphe, ouvrez l’onglet Plan & numérotation de 
la boîte de dialogue du style et choisissez le niveau de plan voulu dans la liste déroulante puis cli-
quez sur OK pour enregistrer la modification.
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Figure 8.24 : Spécification d’un niveau de plan pour un style de paragraphe.

Définir une numérotation des titres

Si vous désirez qu’un ou plusieurs niveaux de titre soient numérotés, de nombreux choix s’offrent 
à vous ; cet exemple définit un schéma de numérotation de titres qui ressemble à celui de la Fi-
gure 8.25.

Figure 8.25 : Le type de numérotation à réaliser.

Utilisez l’onglet Numérotation de la boîte de dialogue Numérotation des chapitres pour définir le 
schéma de numérotation et son apparence. La Figure 8.26 montre le paramétrage par défaut.
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Figure 8.26 : Paramètres par défaut dans la boîte de dialogue Numérotation des chapitres.

 1) Dans la liste Niveau, sélectionnez 1. Dans la liste Nombre, choisissez 1, 2, 3,… Le résultat 
s’affiche dans la zone d’aperçu à droite de la Figure 8.27

Figure 8.27 : Définir la numérotation des titres de niveau 1.

 2) Sélectionnez maintenant 2 dans la liste des niveaux. Dans la liste Nombre, choisissez de 
nouveau 1, 2, 3,… Le champ Afficher les sous-niveaux est maintenant accessible et devrait 
afficher 2 (si ce n’est pas le cas, sélectionnez 2). Le résultat est visible sur la Figure 8.28

Figure 8.28 : Définir la numérotation des titres de niveau 2.
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 3) Sélectionnez le niveau 3. Dans la liste Nombre, sélectionnez encore 1, 2, 3,… Si le champ 
Afficher les sous-niveaux ne contient pas 3, choisissez-le dans la liste. La Figure 8.29 
montre le résultat.

Figure 8.29 : Définir la numérotation des titres de niveau 3.

Ces choix produisent la disposition visible sur la Figure 8.30

Figure 8.30 : Titres numérotés selon les choix précédents.

Régler l’indentation des titres

Que les titres soient numérotés ou non, vous voudrez peut-être modifier un peu leur présentation, 
par exemple en mettant les niveaux 2 et 3 en retrait par rapport à la marge. S’ils sont numérotés, 
vous désirerez aussi que la deuxième ligne d’un titre long s’aligne à gauche avec le premier mot 
du titre et non sur le numéro. Pour ces modifications, ouvrez l’onglet Position de la boîte de dia-
logue Numérotation des chapitres.

À titre d’exemple, nous allons modifier le retrait et le retour à la ligne d’un titre de niveau 2.

 1) Dans la liste Niveau, sélectionnez 2. Changer les valeurs des champs Numérotation suivie 
par, Tabulation à et Aligné à pour les valeurs visibles sur la Figure 8.31. Vous pouvez utiliser 
d’autres valeurs. Tout le titre est mis en retrait mais cela n’a pas d’effet sur le retour à la ligne
du titre long (Figure 8.32).
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Figure 8.31 : Mise en retrait des titres de niveau 2.

Figure 8.32 : Résultat de la mise en retrait des titres de niveau 2.

 2) Pour modifier le retour à la ligne des titres longs, donnez une plus grande valeur au champ 
Retrait à comme sur la Figure 8.33. Le résultat apparaît sur la Figure 8.34.

Figure 8.33 : Réglage du retour à la ligne des titres longs.

Figure 8.34 : Résultat obtenu en modifiant le retrait.
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Chapitre 9
Travailler avec les styles





Introduction

Le Chapitre 8 Introduction aux styles, décrit les bases de l’utilisation, de l’application et de la ges-
tion des styles. Celui-ci donne une description plus détaillée de la façon de créer ou de modifier 
des styles grâce aux nombreuses options disponibles dans les diverses pages des boîtes de dia-
logue de style. Il explique comment celles-ci affectent l’apparence du style et comment les utiliser 
efficacement.

Comme les boîtes de dialogue de style partagent de nombreuses pages avec les boîtes de dia-
logue de mise en forme manuelle, ce chapitre peut aussi vous aider à appliquer ce type de forma-
tage (bien que vous n’en ayez pas besoin si vous utilisez des styles).

Création de styles personnalisés

En plus des styles prédéfinis dans LibreOffice, vous pouvez ajouter des styles personnalisés. Dans
le chapitre 8, deux méthodes sont proposées pour cela : la méthode par glisser-déposer et l’utilisa-
tion de l’icône Nouveau style à partir de la sélection de l’onglet Styles et formatage du volet laté-
ral.

Ces méthodes sont pratiques, car vous pouvez observer l’effet visuel produit par le style avant de 
la créer. Vous disposez cependant d’un contrôle un peu réduit sur le style (en particulier en ce qui 
concerne l’organisation). La méthode décrite dans ce chapitre aborde donc l’utilisation des boîtes 
de dialogue de styles.

Remarque

Les styles de tableau sont créés d’une manière différente qui est décrite au Chapitre 13 Tra-
vailler avec les tableaux de données, page 363.

Les boîtes de dialogue de styles

Ouvrez l’onglet Styles et formatage, sélectionnez la catégorie de style que vous désirez créer en 
cliquant sur le bouton approprié en haut de la fenêtre. Par exemple, cliquez sur le troisième bouton
à partir de la gauche pour créer un nouveau style de cadre.

Faites un clic droit dans la fenêtre et choisissez Nouveau… dans le menu contextuel. La boîte de 
dialogue qui s’ouvre dépend du type de style que vous avez choisi. De nombreuses pages sont 
identiques à celles qui sont utilisées pour la mise en forme manuelle. Si vous avez l’habitude de ce
genre de formatage, vous connaissez donc déjà peut-être l’utilisation de la plupart des options.

Conseil

Les boîtes de dialogue utilisées pour créer un nouveau style et pour modifier un style exis-
tant sont essentiellement les mêmes, à une exception près : les styles conditionnels dis-
posent d’une boîte de dialogue différente. Voir « Travailler avec les styles conditionnels 
de paragraphe » à la page 247.

L’onglet Gestionnaire

L’onglet Gestionnaire, visible sur la Figure 9.1 est commun à toutes les catégories de styles (sauf 
les styles Tableau), à quelques petites différences près. Il ne sera donc décrit qu’une seule fois.
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Figure 9.1 : L’onglet Gestionnaire qui s’affiche à la création d’un nouveau style de paragraphe.

Selon le style que vous créez, vous trouverez, sur cette page, les champs suivants :

• Nom : présent pour tous les styles. Utilisez ce champ pour donner un nom au style que vous 
êtes en train de créer.

• Actualisation automatique : présent uniquement pour les styles de paragraphe et de cadre.
Si cette option est cochée, Writer appliquera toute modification manuelle d’un paragraphe ou
d’un cadre de ce style au style lui-même.

! Attention

Si vous avez l’habitude d’imposer des modifications manuelles dans vos documents par-
dessus les styles, vérifiez bien que l’option Actualisation automatique n’est pas cochée sous
peine de voir des parties entières de votre document reformatées de manière inattendue.

• Style de suite : présent uniquement pour les styles de paragraphe et de page. Utilisez cette 
option pour définir le style qui sera appliqué à l’élément suivant du même type. Par exemple, 
un style Page gauche est habituellement suivi d’un style Page droite, un style Première page
est suivi d’un style Page gauche, un style de titre est suivi d’un style Corps de texte, et ainsi 
de suite.

• Hérité de : présent pour les styles de paragraphe, de caractère et de cadre. Cette option dé-
finit la position du style dans la hiérarchie. Toutes les propriétés initiales du nouveau style 
sont héritées (copiées) du style spécifié ici.

• Catégorie : présent pour tous les styles. Elle permet d’associer le nouveau style à une des 
catégories qui permettent de filtrer le contenu de l’onglet Styles et formatage. Notez que 
vous ne pouvez pas modifier la catégorie des styles prédéfinis.

• Contient : ce champ affiche un résumé des propriétés du style.

Hiérarchie des styles

Quand on crée un nouveau style de paragraphe ou de caractère, il est possible de prendre un 
style existant comme point de départ de ses paramètres. En ce sens, LibreOffice lie les styles les 
uns aux autres.
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Quand des paramètres d’un style sont hérités, une modification
du style parent affecte tous les styles qui en héritent. Pour voir
les relations entre les styles, passez à la vue Hiérarchie dans le
filtre de l’onglet Styles et formatage. Par exemple, tous les styles
de titre (tels que Titre 1, Titre 2…) sont hérités d’un style appelé 
Titre. Cette relation est illustrée par la Figure 9.2.

L’héritage permet de créer des « familles » de styles où vous
pouvez changer en une seule fois une propriété pour tous les
styles. Si vous décidez, par exemple, que tous les titres de-
vraient être en vert (comme dans ce guide), il vous suffit de
changer la couleur de la police du style parent pour obtenir le ré-
sultat souhaité.

Ce changement n’affectera cependant pas les styles enfants
dont le même paramètre a été modifié auparavant. Par exemple, si vous avez déjà changé la cou-
leur de police du style Titre 2 en rouge, changer la couleur de police du style Titre (son style pa-
rent) en vert ne modifiera pas la couleur de police du style Titre 2.

Il est facile de voir quelles propriétés sont propres à un style en regardant dans la section Contient
de l’onglet Gestionnaire. Si vous voulez qu’un style enfant reprenne les propriétés de son style pa-
rent, cliquez sur le bouton Standard situé en bas des boîtes de dialogue Style de paragraphe et 
Style de caractère.

Exemple : modifier une propriété du style parent

Supposons que vous vouliez changer la police non seulement des paragraphes de style Titre 1 ou 
Titre 2, mais de tous les titres.

Ouvrez l’onglet Styles et formatage, sélectionnez le panneau Style de paragraphe, faites un clic 
droit sur Titre puis cliquez sur Modifier… pour ouvrir la boîte de dialogue du Style de paragraphe :
Titre.

Ouvrez l’onglet Police, sélectionnez une police puis cliquez sur OK.

Figure 9.3 : choix de la police des titres.
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Les polices de tous les styles de titre (de Titre 1 à Titre 10) sont changées en une seule opération. 
La Figure 9.4 montre, à gauche, un document qui utilise les styles Titre 1, Titre 2 et Titre 3 et, à 
droite, le même document après modification du style Titre.

Figure 9.4 : Effet d’un changement de police du style Titre.

Travailler avec des styles de paragraphe

Bien que cette section décrive la plupart des paramètres éparpillés dans les onglets de la boîte de 
dialogue visible sur la Figure 9.3, il n’est pas nécessaire de les configurer tous. Dans la plupart des
cas, quelques modifications seront suffisantes, surtout si vous liez les styles ou si vous construisez
les nouveaux styles à partir de styles semblables.

L’onglet Retraits et espacement

L’onglet Retraits et espacement (Figure 9.5) vous permet de définir les paramètres qui affectent la 
position du paragraphe sur la page ainsi que l’espace entre les lignes et entre ce paragraphe et 
ceux qui sont au-dessus ou en dessous.

Utilisez la section Retraits pour définir ceux-ci grâce aux champs suivants :

• Avant le texte : contrôle l’espace, exprimé dans l’unité de mesure choisie, entre la marge 
gauche de la page et l’extrémité gauche de la zone du paragraphe. Une valeur négative fait 
commencer le texte à l’intérieur de la marge, ce qui peut se révéler utile, avec une marge de 
gauche assez large, si vous désirez centrer les titres dans la page.

• Après le texte : contrôle l’espace, exprimé dans l’unité de mesure choisie, entre la marge 
droite de la page et l’extrémité droite de la zone du paragraphe. Une valeur négative fait dé-
border le texte dans la marge droite de la page.

• Première ligne : contrôle le retrait supplémentaire (positif ou négatif) de la première ligne 
par rapport à la zone du paragraphe. Une valeur positive augmente le retrait de la première 
ligne, alors qu’une valeur négative fait commencer la première ligne plus à gauche que les 
autres lignes du paragraphe.

• Automatique : cocher cette option autorise Writer à contrôler automatiquement le retrait de 
la première ligne. Sa valeur est calculée par Writer en tenant compte de la taille de la police 
et d’autres paramètres.
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Figure 9.5 : Réglages dans l’onglet Retraits et espacement d’une boîte de dialogue Style de
paragraphe.

La section Espacement vous permet de déterminer l’espace vertical au-dessus et en dessous du 
paragraphe. On laisse habituellement un espace au-dessus des styles de titre pour les séparer du 
corps du texte de la section précédente sans qu’il soit nécessaire d’insérer de paragraphes vides. 
L’espace entre les paragraphes est aussi normal dans certains types de documents. Le style 
Corps de texte de ce guide est configuré pour laisser un espace entre les paragraphes consécu-
tifs.

Vous pouvez aussi cocher l’option pour supprimer l’espace entre des paragraphes de même style.

Remarque

Une option dans la page LibreOffice Writer – Compatibilité de la boîte de dialogue Options 
(Outils > Options) contrôle si l’espace avant et l’espace après le texte sont ajoutés l’un à 
l’autre (comportement par défaut) ou seul le plus grand des deux est appliqué. Voir le Cha-
pitre 20 Paramétrer Writer, page 560, pour plus d’informations.

L’espace entre les paragraphes n’affecte pas l’espace entre les lignes, l’interligne, qui est contrôlé 
par une liste déroulante dans la section Interligne. Vous avez le choix entre les valeurs suivantes :

• Simple : choix par défaut qui applique au paragraphe un interligne simple calculé automati-
quement d’après la taille de la police ;

• 1,15 ligne : règle l’interligne à 1,15 ligne. Ce petit accroissement améliore souvent l’aspect 
du texte sans occuper trop d’espace vertical ;

• 1,5 ligne : règle l’interligne à 1,5 ligne ;

• Double : règle l’interligne à 2 lignes. ;
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• Proportionnel : ce choix active la boîte de saisie à côté de la liste déroulante, où vous pou-
vez saisir un pourcentage. 100 % représente un interligne simple, 200 % un interligne double
et ainsi de suite ;

• Au moins : ce choix active la boîte de saisie à côté de la liste déroulante, où vous pouvez 
saisir la valeur minimum de l’interligne (dans l’unité de mesure sélectionnée) ;

• Interligne : ce choix vous permet de contrôler la hauteur de l’espace vertical entre les lignes 
de base de deux lignes de texte successives en entrant, dans la boîte de saisie, une valeur 
qui s’ajoute à celle de l’interligne simple ;

• Fixe : ce choix active la boîte de saisie à côté de la liste déroulante, où vous pouvez saisir la 
valeur exacte de l’interligne.

Conseil

Quand on utilise des tailles de police différentes dans le même paragraphe, l’interligne est ir-
régulier car Writer calcule automatiquement la valeur optimale. Pour obtenir des lignes régu-
lièrement espacées, choisissez Fixe ou Au moins dans la liste déroulante et saisissez une 
valeur assez élevée pour que l’interligne soit suffisant pour prendre en compte la plus 
grande taille de police utilisée.

Le dernier paramètre de l’onglet est le Contrôle de repérage. Il s’agit d’un terme typographique 
utilisé en impression qui concerne le positionnement harmonieux des lignes dans la zone imprimée
des pages avant et arrière d’un livre, d’un journal ou d’un magazine. Cette option facilite la lecture 
de ces pages en évitant de laisser apparaître le contour gris du texte de l’autre page entre les 
lignes de celle que vous lisez. Le terme contrôle de repérage concerne aussi les lignes des co-
lonnes de texte adjacentes qui sont à la même hauteur.

Quand vous cochez l’option Contrôle de repérage en définissant un paragraphe, un style de pa-
ragraphe ou de page, les lignes de base des caractères concernés sont alignés sur une grille verti-
cale invisible sur la page, indépendamment de la taille de police ou de la présence d’objets gra-
phiques. Cela aligne les lignes de base de chaque ligne de texte sur une grille verticale dans le do-
cument de façon qu’elles aient toutes la même hauteur.

Pour utiliser cette fonctionnalité, vous devez activer l’option Contrôle de repérage du style de 
page courant et choisir un Style de référence ; l’option Contrôle de repérage sera activé pour ce-
lui-ci et tous les styles qui en dépendent dans la hiérarchie. Si vous désirez aussi activer la grille 
verticale pour d’autres styles (ou la désactiver pour des styles descendants du style de référence), 
vous pouvez le faire ici.

L’onglet Alignement

Utilisez l’onglet Alignement pour modifier l’alignement horizontal du texte parmi les choix suivants :
À gauche, À droite, Centrer et Justifié. Le résultat de votre choix apparaît dans la boîte d’aperçu à 
droite de l’onglet.

Si vous choisissez l’alignement justifié, vous pouvez aussi décider de la façon dont Writer va traiter
la dernière ligne du paragraphe. Par défaut, elle est alignée à gauche, mais vous pouvez préférer 
de la centrer ou de la justifier (dans ce cas, les mots de la dernière ligne seront espacés pour la 
remplir entièrement). Si vous avez choisi de justifier la dernière ligne et que vous cochez l’option 
Étirer un seul mot, quand la dernière ligne ne comportera qu’un mot unique, l’espace entre ses ca-
ractères augmentera de sorte qu’il occupe la totalité de la ligne.
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Figure 9.6 : Exemples des choix pour la dernière ligne d’un paragraphe justifié.

Cet onglet permet aussi de contrôler l’alignement vertical Texte-à-texte, ce qui est utile quand plu-
sieurs tailles de police cohabitent sur la même ligne. La liste déroulante Alignement vous offre le 
choix entre Automatique, Ligne de base, Haut, Milieu, Bas. La Figure 9.7 vous offre une représen-
tation visuelle de ces différents choix.

Figure 9.7 : Alignement vertical du texte. De haut en bas : Ligne de base, Haut, Milieu, Bas.

Options d’enchaînement des styles de paragraphe

L’onglet Enchaînements (Figure 9.8) est divisé en trois parties : Coupure de mots, Sauts et Op-
tions.

Si vous préférez que Writer gère automatiquement la césure, cochez l’option Automatiquement.

Si la coupure de mots est activée, vous disposez de trois paramètres :

• le champ Caractères en fin de ligne contrôle le nombre minimum de caractères à laisser sur 
une ligne avant d’insérer une césure ;

• le champ Caractères en début de ligne contrôle le nombre minimum de caractères qui 
peuvent être placés en début d’une nouvelle ligne à la suite d’une césure.

Le champ Nombre maximum de coupures consécutives contrôle le nombre de lignes consécutives
qui se terminent par un trait d’union.

Dans la section Sauts, vous pouvez obliger un paragraphe à commencer sur une nouvelle page 
ou une nouvelle colonne et préciser la position du saut, le style de la nouvelle page et son numéro.
Une utilisation classique de cette option consiste à faire en sorte qu’un nouveau chapitre com-
mence toujours par une nouvelle page, normalement une page droite.
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Figure 9.8 : Les paramètres de l’onglet Enchaînements de la boîte de dialogue Style de
paragraphe.

Pour toujours commencer une nouvelle page avec un style donné, choisissez les paramètres sui-
vants :

 1) Dans la section Sauts, cochez l’option Insérer. Vérifiez que le champ Type contient Page et 
que le champ Position contient Avant.

 2) Cochez l’option Avec le style de page et choisissez celui-ci dans la liste déroulante.

 3) Pour continuer la numérotation à la suite de celle du chapitre précédent, laissez l’option Nu-
méro de page non cochée. Pour redémarrer la numérotation de chaque chapitre à 1, cochez 
cette option et mettez 1 dans le champ numéro de page. Cliquez sur OK.

Remarque

Si vous désirez qu’un nouveau chapitre commence toujours par une page de droite, assu-
rez-vous que le style de la première page du chapitre soit paramétré comme page Droite 
uniquement en faisant ce choix dans le champ Mise en page de l’onglet Page de la boîte de 
dialogue Style de page.

La section Options de l’onglet offre le moyen de contrôler ce qui arrive quand un paragraphe ne 
tient pas dans le bas d’une page :

• Ne pas scinder le paragraphe : si le paragraphe est trop long pour tenir en bas d’une page, il 
est entièrement placé en haut de la page suivante.

• Conserver avec le paragraphe suivant : assure qu’un titre ou la première phrase d’une liste 
ne sera pas le dernier paragraphe d’une page.
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• Traitement des orphelines et Traitement des veuves : veuves et orphelines sont des termes 
typographiques. Une orpheline est la première ligne d’un paragraphe isolée en bas d’une 
page ou d’une colonne. Une veuve est la dernière ligne d’un paragraphe qui apparaît seule 
en haut de la page ou de la colonne suivante. Utilisez ces options pour permettre à un para-
graphe de se partager entre deux pages ou deux colonnes mais en conservant au moins 
deux lignes, ou plus, ensemble en bas de la page ou de la colonne et en haut de la suivante.
Vous pouvez préciser le nombre de lignes à conserver ensemble.

Options de police pour le style de paragraphe

Trois onglets de la boîte de dialogue Style de paragraphe sont consacrés aux paramètres qui 
contrôlent l’apparence des caractères : les onglets Police, Effets de caractère et Position. L’usage 
des deux premiers ne pose pas vraiment de problème. Nombres d’options utilisées ici le sont aussi
pour créer un style de caractère et sont présentées dans le paragraphe « Créer un nouveau style
de caractère » à la page 250. Celles qui peuvent être utilisées pour créer un style de paragraphe 
sont décrites ici.

Spécifier une taille de police relative

Si vous créez un style qui hérite d’un autre (styles liés), vous pouvez définir une taille de police par
rapport à celle du style parent, soit en pourcentage, soit en variation du nombre de points (–2 pt ou
+5 pt). Des tailles de police relatives sont couramment utilisées dans les pages Web.

Par exemple, le style de paragraphe Titre 1 est fondé sur le style Titre dont la taille de police est 
14 pt ; celle du style Titre 1 est définie comme 130 %. En conséquence, la taille de la police d’un 
paragraphe formaté avec le style Titre 1 sera 14 pt × 130 / 100 = 18,2 pt.

Pour définir une taille de police en pourcentage : dans la boîte de dialogue Style de paragraphe, 
ouvrez l’onglet Police et saisissez la valeur dans la boîte de saisie Taille, suivie du signe % (voir Fi-
gure 9.9). De la même manière, vous pouvez saisir un signe plus ou moins suivi du nombre de 
points à ajouter ou à soustraire de la taille de police de base.

Pour revenir à une taille absolue à partir d’une taille relative, saisissez la taille de police désirée, en
points, suivie des lettres pt.

Il est aussi possible d’utiliser une taille de police en pourcentage pour les styles de caractère.

Figure 9.9 : Définir la taille d’une police en pourcentage de celle de la police parent.

Sélectionner une langue associée à un style de paragraphe

La langue choisie pour un document (dans la page Paramètres linguistiques – Langues de la boîte
de dialogue Options : Outils > Options) détermine le dictionnaire utilisé pour la vérification ortho-
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graphique, les synonymes, la césure, les séparateurs de la partie décimale et des milliers, ainsi 
que l’unité monétaire par défaut. Vous ne pouvez utiliser qu’une langue dont le dictionnaire est ins-
tallé.

Vous pouvez appliquer une autre langue à n’importe quel style de paragraphe à l’intérieur du docu-
ment. Celle-ci prend alors le pas sur la langue définie pour l’ensemble du document. Dans l’onglet 
Police de la boîte de dialogue Style de paragraphe, les langues dont les dictionnaires sont installés
sont marquées dans la liste Langue par une petite icône  (Figure 9.10). Pour vérifier l’ortho-
graphe, Writer va utiliser le dictionnaire adapté aux paragraphes de ce style. Si vous écrivez un 
document en plusieurs langues, vous pouvez utiliser des styles liés pour créer deux styles de para-
graphe qui ne diffèrent que par le choix de la langue. Si vous désirez par la suite modifier d’autres 
propriétés du style, il suffit de changer le style parent.

Pour insérer des mots isolés dans une langue différente sans qu’ils soient soulignés par erreur par 
la fonction de vérification orthographique, il est plus pratique d’utiliser des styles de caractère 
comme décrit au paragraphe « Créer un nouveau style de caractère » à la page 250.

Figure 9.10 : Choix d’une langue pour un style de paragraphe

Option de positionnement du texte

L’onglet Position de la boîte de dialogue Style de paragraphe rassemble toutes les options qui af-
fectent la position du texte à l’écran ou sur la page imprimée.

La section Position vous permet de contrôler l’apparence des exposants et des indices. Cepen-
dant, ceux-ci s’appliquent normalement à des groupes de caractères plutôt qu’à des phrases en-
tières. Il est donc fortement recommandé de ne modifier ces paramètres qu’en définissant un style 
de caractère et de laisser les valeurs par défaut pour les styles de paragraphe.

La deuxième section de l’onglet contrôle l’orientation de la zone du paragraphe. Deux utilisations 
courantes du changement d’orientation d’un paragraphe sont :

• placer des en-têtes et pieds de page en mode portrait sur une page en mode paysage,

• adapter les titres au-dessus des colonnes étroites d’un tableau (comme sur la Figure 9.12).
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Figure 9.11 : L’onglet Position de la boîte de dialogue Style de paragraphe.

Conseil

Les titres de tableaux orientés verticalement sont souvent plus lisibles s’ils sont inclinés plu-
tôt que verticaux. Pour cela, vous devrez créer un objet texte grâce à la barre d’outils Des-
sin puis le faire pivoter de l’angle voulu. Voir le Chapitre 11 Images et objets graphiques, 
page 290.
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Figure 9.12 : Tableau avec des titres orientés verticalement.

Le champ Échelle de largeur contrôle la compression ou l’étirement du texte qui est pivoté, en 
pourcentage de la largeur de la police, du premier caractère au dernier.

Le Chapitre 5 Mise en page : les bases, page 123, décrit la façon de créer des en-têtes et des 
pieds de page en orientation portrait sur une page en orientation paysage en faisant pivoter les ca-
ractères. Vous pouvez obtenir le même résultat en définissant des styles de paragraphe spécifi-
quement réservés aux en-têtes et aux pieds des pages en mode paysage.

Exemple : faire pivoter le texte dans un style de paragraphe

À titre d’exemple, nous allons faire pivoter les titres d’un tableau existant.

 1) Créez un nouveau style de paragraphe appelé Titre de tableau vertical.

 2) Dans l’onglet Position de la boîte de dialogue Style de paragraphe, dans la section 
Rotation / Échelle, cochez 90 degrés. Cliquez sur OK pour enregistrer le nouveau style.
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 3) Sélectionnez la ligne de titre du tableau et appliquez le nouveau style. Tout le texte contenu 
dans les cellules de cette ligne prend l’orientation verticale.

 4) Si les titres sont alignés en haut des cellules, vous préférerez peut-être que l’alignement se 
fasse en bas des cellules comme dans la Figure 9.12. Pour cela, cliquez sur le bouton Ali-
gner en bas ( ) dans la barre d’outils Tableau ou sélectionnez Format > Alignement > 
Aligner > En bas dans le menu principal.

Options d’espacement

La section Espacement de l’onglet Position vous permet de contrôler l’espacement entre les ca-
ractères du paragraphe. Utilisez le champ de saisie pour définir la valeur (exprimée en points) dont
vous voulez resserrer ou éloigner les caractères les uns des autres.

L’option Paire de crénage (cochée par dé-
faut) augmente ou diminue l’espace entre
certaines paires de lettres pour améliorer
l’apparence globale du texte. Le crénage
ajuste automatiquement l’espacement de
certaines combinaisons de lettres.

Il n’est disponible que pour certains types de
polices et il ne fonctionne à l’impression que si votre imprimante le gère.

Contrôle des arrêts de tabulation

Bien que les tableaux sans bordures soient généralement considérés comme une bien meilleure 
solution pour répartir des éléments de texte sur une page, les tabulations suffisent, dans certaines 
situations, pour atteindre vos objectifs et disposent des avantages supplémentaires d’être plus 
simples à gérer et plus rapides à appliquer.

! Attention

Si vous avez besoin d’utiliser des tabulations et que vous devez envoyer un document à 
d’autres personnes, n’utilisez pas les arrêts par défaut. Si le destinataire du document a dé-
fini des arrêts de tabulation par défaut différents des vôtres, le paragraphe peut avoir un as-
pect très différent sur sa machine. Définissez plutôt les arrêts de tabulation explicitement 
dans le paragraphe ou dans le style de paragraphe ; de cette façon, vous serez certain que 
tout le monde verra la même mise en page que vous.

Pour définir les arrêts de tabulation dans votre style de paragraphe, utilisez l’onglet Tabulations vi-
sible à la Figure 9.14. C’est là que vous pouvez choisir le type de tabulation (à gauche, à droite, 
centré ou décimal), le caractère qui servira de séparateur décimal et le caractère de remplissage 
qui apparaît entre la fin du texte qui précède la tabulation et le début du texte qui la suit. Vous pou-
vez aussi utiliser un caractère de remplissage personnel en le saisissant dans le champ corres-
pondant. Les points sont couramment utilisés comme caractères de remplissage entre un titre et 
son numéro de page dans une table des matières et les caractères de soulignement le sont quand 
on crée un formulaire à compléter.
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Figure 9.14 : Définir les arrêts de tabulation pour un style de paragraphe.

Pour créer un nouvel arrêt de tabulation, précisez sa position par rapport à la marge de gauche, le 
type de tabulation et le caractère de remplissage puis cliquez sur le bouton Nouveau. Il apparaît 
alors dans la liste sous le champ Position à gauche de la boîte de dialogue. Il n’existe malheureu-
sement pas de moyen direct pour modifier un arrêt de tabulation : la seule solution consiste à le 
supprimer en le sélectionnant dans la liste et en cliquant sur le bouton Supprimer puis à en créer 
un nouveau.

On ne peut pas définir de tabulations au-delà des marges de la page. Dans les rares cas où cela 
s’avérerait nécessaire, utilisez plutôt un tableau sans bordures.

Page Plan & numérotation

Utilisez l’onglet Plan & numérotation pour affecter un niveau de plan à n’importe quel style de para-
graphe comme cela est décrit dans « Affecter des niveaux de plan à d’autres styles » au Cha-
pitre 8 Introduction aux styles, page 225. Cette fonction vous permet de créer une table des ma-
tières qui inclut ces paragraphes avec les titres qui utilisent les styles définis dans Outils > Numé-
rotation des chapitres.

Dans cette page, vous pouvez aussi associer un style de paragraphe à un style de liste. Reportez-
vous au Chapitre 12 Travailler avec les listes, page 325, pour toute information supplémentaire 
ainsi qu’un exemple.

Paramétrer une lettrine

Si vous souhaitez que votre paragraphe affiche une lettrine (normalement, pour le premier para-
graphe d’un chapitre), vous pouvez en prédéfinir les propriétés dans l’onglet Lettrines de la boîte 
de dialogue Style de paragraphe (Figure 9.15) Cochez l’option Afficher les lettrines pour activer les
autres choix : le nombre de lignes occupées, le nombre de caractères à agrandir (si vous préférez 
le premier mot entier, cochez l’option correspondante), et l’espacement entre la lettrine et le texte.

Les lettrines utilisent la même police et ont les mêmes propriétés que le reste du paragraphe, mais
vous pouvez facilement modifier leur apparence en créant un style particulier de caractère et en le 
sélectionnant dans la liste déroulante prévue à cet effet. Vous pouvez, par exemple, avoir des let-
trines de couleur différente ou leur donner un effet de contour.
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Figure 9.15 : Options qui permettent d’ajouter une lettrine à un style de paragraphe.

Arrière-plan, mise en valeur et transparence

L’ajout d’une couleur ou d’une image d’arrière-plan à un paragraphe est un bon moyen pour le 
faire ressortir sans avoir à insérer un cadre. Vous pouvez personnaliser l’arrière-plan grâce à l’on-
glet de même nom de la boîte de dialogue Style de paragraphe.

Figure 9.16 : Types de remplissage de l’arrière-plan d’un paragraphe.

Les points suivants devraient retenir votre attention quand vous utiliserez l’onglet Arrière-plan :

• Si vous ne trouvez pas la couleur qui vous convient parmi celles qui sont prédéfinies dans 
les différentes palettes, vous pouvez définir les vôtres de la manière décrite au Chapitre 21 
Personnaliser Writer, page 577.

• À la place d’une couleur en aplat, vous pouvez utiliser une image, des hachures, un motif ou 
un dégradé en arrière-plan.

• Des arrière-plans différents peuvent être choisis pour le paragraphe et pour le texte qu’il 
contient. Utilisez l’onglet Surlignage pour l’arrière-plan des caractères. La Figure 9.17 montre
la différence.
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Figure 9.17 : Arrière-plans différents pour le paragraphe et les caractères

• L’arrière-plan ne s’applique qu’à la surface occupée par le paragraphe. Si vous avez défini 
un retrait pour le paragraphe, l’espace entre celui-ci et la marge ne reçoit pas la couleur d’ar-
rière-plan.

Dans l’onglet Transparence, vous pouvez régler la transparence de l’arrière-plan sélectionné. Les 
valeurs s’étendent de 0 % (totalement opaque) à +100 % (totalement transparent).

Les bordures

Les bordures sont souvent utilisées pour faire ressortir des paragraphes du texte sans utiliser de 
cadre, pour séparer les en-têtes et les pieds de page du corps principal de texte (comme dans ce 
guide) ou pour apporter un élément décoratif à certains styles de titre. Prenez en compte les points
suivants :

• Faites attention aux effets que l’espace entre la bordure et le texte du paragraphe produit sur
les retraits et les tabulations.

• Si vous désirez que la bordure soit tracée autour de plusieurs paragraphes, laissez cochée 
l’option Fusionner avec le paragraphe suivant en bas de la page.

• Un espace blanc peut souvent produire le même effet.

Voyez le Chapitre 4 Mettre le texte en forme, page 100, pour plus d’information sur l’onglet Bor-
dures.

Travailler avec les styles conditionnels de paragraphe

Un style conditionnel de paragraphe est une autre manière de mettre un texte en forme de façons 
différentes dans différentes parties du document. Dans certains cas, utiliser les styles condition-
nels, au lieu de passer d’un style à l’autre en cours de frappe, peut faire gagner du temps.

Un style conditionnel de paragraphe change son formatage selon l’endroit où il est utilisé. Vous 
pouvez, par exemple, souhaiter que le style Mon corps de texte soit noir par défaut mais devienne 
blanc à l’intérieur d’un cadre dont l’arrière-plan est bleu.

L’utilisation la plus courante du formatage conditionnel est probablement la création de plan avec 
un style unique. Il s’agit d’un type de numérotation des chapitres effectuée avec un style de numé-
rotation au lieu de la boîte de dialogue Outils > Numérotation des chapitres. Au lieu d’utiliser 
des styles différents, c’est le formatage de la numérotation qui change chaque fois que l’on appuie 
sur la touche Tabulation pour créer un titre enfant.

Le seul problème posé par la création de plan à style unique est que tous les niveaux ont la même 
apparence. C’est là qu’un style conditionnel de paragraphe montre son intérêt. Affectez le style de 
paragraphe à un style de numérotation hiérarchique dans l’onglet Plan & numérotation puis ouvrez
l’onglet Condition. Vous pourrez y affecter les niveaux du style de numérotation utilisé à d’autres 
styles de paragraphe. Ensuite, quand vous appuierez sur la touche Tabulation en utilisant le 
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style de paragraphe, chaque niveau de plan prendra une mise en forme différente, ce qui rend le 
chapitrage à style unique encore plus pratique qu’il ne l’est naturellement.

Remarque

Les styles prédéfinis (autres que le style Corps de texte), comme le Style par défaut, les 
styles Titre 1 et Titre 2, ne possèdent pas de page Condition.

! Attention

Si vous créez un nouveau style dont vous voulez faire un style conditionnel, vous devez le 
faire tant que la boîte de dialogue Style est ouverte pour la première fois. Quand elle aura 
été refermée, l’onglet Condition n’apparaîtra plus à sa réouverture.

Créer un style conditionnel, c’est dire « dans telle situation, donner au style l’apparence de cet 
autre style ». Par exemple, « quand je saisis du texte dans un pied de page, donner au style l’ap-
parence du style de paragraphe Pied de page ; quand je tape dans un tableau, donnez au style 
l’apparence du style Contenu de tableau ».

En plus du paramétrage des propriétés normales (inconditionnelles) du style, vous devez définir, 
dans l’onglet Condition, de quel autre style il prendra l’apparence dans différentes situations.

Pour paramétrer un style conditionnel de paragraphe :

 1) Créez un nouveau style de paragraphe.

 2) Choisissez toutes les propriétés du style de paragraphe.

! Attention

Ne cliquez pas sur OK !

 3) Cliquez sur l’onglet Condition.

 4) Cochez l’option Style conditionnel.

 5) Sélectionnez la première condition dans la liste Contexte (à gauche de la boîte de dialogue) 
puis, dans la liste Styles de paragraphe (du côté droit), le style que vous désirez appliquer 
quand cette condition est vérifiée.

 6) Cliquez sur Appliquer. Le nom du style de paragraphe apparaît dans la liste centrale Styles 
appliqués.

 7) Répétez les étapes 5 et 6 pour chaque condition que vous voulez lier à un style différent.

 8) Cliquez sur OK.

Quand vous appliquerez le style, vous verrez que la mise en forme du texte dépend de son 
contexte.
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Figure 9.18 : L’onglet Condition de la boîte de dialogue Style de paragraphe.

Travailler avec les styles de caractère

Les styles de caractère complètent les styles de paragraphe en s’appliquant à des groupes de ca-
ractères plutôt qu’au paragraphe tout entier. Ils sont surtout utilisés quand on désire modifier l’as-
pect ou les attributs de parties d’un paragraphe sans affecter les autres. Des exemples d’effets 
qu’il est possible d’obtenir grâce à des styles de caractères sont des mots en italique, en gras ou 
colorés.

Voici deux des styles de caractère utilisés dans ce document :

• Les touches et combinaisons de touches utilisent le style personnalisé Clavier. Par 
exemple :

Pour afficher Writer en plein écran, appuyez sur Ctrl+Maj+J.

• Les suites d’entrées des menus qui permettent d’accéder à une fonction donnée utilisent le 
style personnalisé Entrée de menu. Par exemple :

Pour activer ou désactiver la trame de fond des champs, sélectionnez Affichage > Trame
de fond des champs.
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D’autres utilisations des styles de caractère sont décrites ailleurs dans ce livre. Parmi celles-ci, la 
création des numéros de chapitres, les numéros de pages ou de listes plus grands que le texte 
voisin ainsi que la mise en forme des hyperliens. Quand on insère des mots dans une autre langue
ou dont on ne veut pas faire vérifier l’orthographe (par exemple, des noms de fonctions dans un 
langage de programmation), il est possible de définir la langue à utiliser dans les propriétés du 
style de caractère.

Créer un nouveau style de caractère

Cette section décrit l’utilisation de la boîte de dialogue Style de caractère. Les onglets utilisés pour 
configurer le style ont déjà été décrits dans la section précédente sur les styles de paragraphe.

• Utilisez l’onglet Gestionnaire (voir page 233) pour définir la position hiérarchique du nouveau 
style (si besoin est) et pour lui donner un nom.

• Utilisez l’onglet Police (voir page 241) pour déterminer la police, le style et la taille du nou-
veau style de caractère. Comme pour les styles de paragraphe, vous pouvez spécifier la 
taille de la police en pourcentage ou en valeur absolue. Vous pouvez aussi préciser la langue
utilisée dans le texte mis en forme avec ce style de caractère, ce qui vous permet d’insérer 
des mots dans une autre langue et de faire vérifier leur orthographe par le bon dictionnaire.

• Utilisez l’onglet Effets de caractère (voir le Chapitre 4 Mettre le texte en forme, le paragraphe
Police et effets de caractère page 106) pour paramétrer des attributs tels que la couleur de 
la police, le soulignement, les effets de relief ou autres. Si vous utilisez fréquemment des 
textes cachés, par exemple, il est pratique de définir un style de caractère où l’option Mas-
qué est cochée. Des effets de relief peuvent convenir à une lettrine ou donner plus d’impor-
tance au numéro du chapitre ou toute autre partie du titre.

• Utiliser l’onglet Surlignage (voir le Chapitre 4 Mettre le texte en forme, page 109) pour appli-
quer un arrière-plan de couleur aux caractères. On obtient le même effet grâce à l’outil Cou-
leur de mise en évidence ( ) de la barre d’outils Standard.

• Utiliser l’onglet Bordures (voir page 247) pour appliquer une bordure et une ombre au texte si
vous le désirez.

• Utiliser l’onglet Position (voir page 242) pour créer un exposant ou un indice personnalisé au 
cas où le réglage par défaut ne vous conviendrait pas. Il est même possible de créer des 
sous-indices qui peuvent être utiles dans les publications scientifiques. Dans la même page, 
vous pouvez créer un texte pivoté, condensé ou étendu.

Remarque

Quand vous faites tourner des caractères, vous devez aussi préciser si le texte pivoté doit 
tenir dans la ligne ou s’il peut, au contraire, s’étendre au-dessus et en dessous de la ligne. 
Cette propriété n’est active que pour les styles de caractères.

Travailler avec les styles de cadre

Les cadres servent souvent à contenir du texte ou des objets graphiques. C’est une bonne idée de
définir des styles de cadres pour donner une cohérence à l’utilisation des cadres qui servent dans 
des situations identiques. Il est, par exemple, possible de placer les photographies dans un cadre 
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avec une bordure ombrée, les dessins dans un cadre avec une bordure simple et les notes en 
marge dans un autre sans bordure mais avec un fond coloré, et ainsi de suite.

Writer offre plusieurs styles de cadre prédéfinis que vous pouvez modifier à votre convenance et 
vous pouvez en définir de nouveau. Les techniques pour définir ou appliquer un style de cadre 
sont semblables à celles des autres styles.

Conseil

Les utilisations des cadres et des sections pour la mise en page présentent de nombreux 
points communs. Il peut vous être utile de parcourir le Chapitre 6 Mise en page : approfon-
dissements, page 148 et suivantes (pour les cadres) et page 156 et suivantes (pour les sec-
tions), pour plus d’informations sur leur utilisation.

Comment fonctionnent les cadres

Quand on ajoute un objet à Writer, il le place automatiquement dans un cadre de type prédéfini. 
Celui-ci détermine la façon dont l’objet est placé dans la page ainsi que la manière dont il interagit 
avec les autres éléments du document. Vous pouvez modifier le cadre en éditant son style ou ma-
nuellement quand il est ajouté au document.

Comme les cadres et les objets sont utilisés ensemble, il est parfois facile d’oublier que ce sont 
des éléments séparés. Dans certains cas, comme les diagrammes, il est possible d’éditer le cadre 
et l’objet séparément.

Contrairement à d’autres éléments qui utilisent les styles, les cadres ne peuvent être définis qu’en 
partie par leur style car leur utilisation peut beaucoup varier. Plusieurs propriétés des cadres, 
comme l’ancrage et la protection des éléments doivent être définis manuellement pour chaque 
cadre.

Vous pouvez formater manuellement un cadre quand vous sélectionnez Insertion > Cadre. La 
boîte de dialogue qui s’ouvre contient tous les réglages disponibles quand on définit un style de 
cadre, ainsi que certains qui ne sont accessibles qu’au moment où le cadre est inséré.

Organisation des styles

Si vous utilisez plusieurs types d’objets graphiques, vous pouvez définir deux styles qui s’y rap-
portent, l’un avec une bordure pour les images sur un fond blanc et un autre sans bordure pour 
tous les autres arrière-plans.

Sinon les styles de cadre par défaut (voir le Tableau 7) couvrent les besoins de la plupart des utili-
sateurs. Le seul supplément important dont vous pouvez avoir besoin est un ou plusieurs cadres 
pour les textes.

Tableau 7: Les divers types de cadres et leurs utilisations

Style Commentaires et utilisation

Cadre Le style de cadre par défaut.

Étiquettes Style utilisé par défaut par Fichier > Nouveau > Étiquettes. Il semble être utili-
sé automatiquement par LibreOffice et n’être pas du tout prévu à l’intention des 
utilisateurs.

Filigrane Style par défaut pour un filigrane, image placée en arrière-plan du corps de 
texte. L’adaptation est, par défaut, continue, c’est-à-dire que le texte traverse le 
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Style Commentaires et utilisation

cadre et ce qu’il contient. L’image doit être suffisamment claire pour que le texte 
reste lisible au-dessus d’elle.

Formule Style de cadre utilisé pour les formules. Sa taille est, par défaut, automatique et 
s’ajuste à celle de la formule.

Images Style par défaut pour les images. La taille s’adapte automatiquement à celle de 
l’image ; le texte ne se place pas à côté du cadre mais est rejeté en dessous ; le
cadre est entouré d’une bordure fine. Ces paramètres sont convenables sauf en
ce qui concerne les bordures. Sauf si l’arrière-plan de l’image et celui du texte 
sont blancs, la bordure n’est normalement pas nécessaire.

Note en marge Style de cadre destiné à placer des notes dans la marge gauche. Comme le 
nom l’indique, il est conçu pour ajouter des commentaires dans la marge du 
texte, mais il est aussi utile pour créer des titres en marge qui sont souvent utili-
sés dans la documentation technique. Voir le Chapitre 6 Mise en page : appro-
fondissements, page 153.

OLE Style par défaut les objets liés et incorporés (Object Linking and Embedding). 
L’emplacement par défaut du cadre est en haut et au centre d’un corps de texte.

Créer de nouveaux styles de cadre

Vous pouvez accéder au paramétrage du cadre en sélectionnant Nouveau… ou Modifier… dans 
le menu contextuel de l’onglet Styles et formatage ouverte pour un style de cadre.

• L’onglet Type définit la taille et la position du cadre. Une des options les plus utiles est Taille 
automatique qui ajuste automatique le cadre aux objets qu’il contient. Si le style de cadre doit
être utilisé automatiquement, cette option devrait être cochée.

• L’onglet Options définit si le contenu du cadre est imprimé et s’il peut être modifié dans un 
document en lecture seule. Il définit aussi la direction du texte, ce qui est utile si le contenu 
est dans une langue qui s’écrit de droite à gauche.

• L’onglet Adapter définit la façon dont le texte se place par rapport au cadre et à quelle dis-
tance. Si vous désirez que le contenu du cadre ressorte face au paragraphe qui l’environne, 
choisissez Aucun(e) dans la section Paramètres. Il s’agit probablement de l’onglet le plus 
important pour les cadres.

• L’onglet Zone définit la couleur, l’image, les hachures, le dégradé ou le motif de l’arrière-plan.
Cette page est surtout utile pour les cadres de texte dans des mises en page complexes où 
ils ont une apparence différente de l’arrière-plan général de la page.

• L’onglet Transparence contient les options de transparence de l’arrière-plan choisi. Les va-
leurs s’étendent de 0 % (totalement opaque) à +100 % (totalement transparent).

• L’onglet Bordures définit, le cas échéant, les attributs de la ligne qui entoure le cadre.

• L’onglet Colonnes peut être ignoré si le cadre n’est pas utilisé pour contenir du texte. Il est 
identique à celui qui est utilisé pour paramétrer les colonnes dans le style de page ; voir page
255.

• L’onglet Macro définit une macro qui déclenche une action quand l’utilisateur interagit avec 
le cadre. Cette option est utile pour un document en ligne ou au format HTML.
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Travailler avec les styles de page

Les styles de page contrôlent les propriétés des pages (marges, taille, en-tête et pied de page, 
entre autres choses). Cependant, contrairement aux paragraphes auxquels ont peut appliquer des 
propriétés directement, les pages sont uniquement régies par un style, sans propriété applicable 
directement.

Cette section décrit la façon de créer un nouveau style de page, explique la signification de cer-
taines options de la boîte de dialogue Style de page et illustre leur utilisation.

Créer un nouveau style de page

Pour créer un nouveau style de page, ouvrez l’onglet Styles et formatage du volet latéral et cliquez
sur l’icône Styles de page (la quatrième en partant de la gauche). Faites un clic droit n’importe où 
dans la fenêtre et choisissez Nouveau…

La boîte de dialogue Style de page possède neuf onglets.

L’onglet Gestionnaire

L’onglet Gestionnaire est décrit à la page 233.

Paramètres généraux du style de page

L’onglet Page de la boîte de dialogue Style de page est l’endroit où vous pouvez régler les para-
mètres généraux de la page. Il est constitué de trois sections accompagnées d’une zone d’aperçu 
en haut à droite.

Dans la section Format de papier, vous pouvez choisir la taille de la feuille parmi les nombreux 
formats prédéfinis. Choisissez Utilisateur pour définir une taille de papier personnalisée grâce aux 
champs Largeur et Hauteur. Sélectionnez l’orientation de la feuille, Portrait ou Paysage. Si votre 
imprimante possède plusieurs bacs à feuilles, vous pouvez préciser celui qui contiendra le papier 
servant à imprimer les pages du nouveau style.

Dans la section Marges, spécifiez la largeur des marges dans l’unité que vous avez définie dans le
champ Unité de mesure de la boîte de dialogue Outils > Options > LibreOffice Writer > Général.
Si vous choisissez des Pages en vis-à-vis dans le champ Mise en page, les noms des marges À 
gauche et À droite deviennent Interne et Externe.

Dans la section Paramètres de mise en page, choisissez celle que vous souhaitez parmi les 
quatre options proposées en décidant si le style de page va s’appliquer à la fois à des pages 
droites et gauches (ce qui est le choix par défaut) ou à des pages uniquement de droite ou de 
gauche.
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Figure 9.19 : L’onglet Page de la boîte de dialogue Style de page.

Quelques remarques :

• Si vous prévoyez de relier les pages de ce style, imprimées comme pour faire un livre, choi-
sissez une mise en page en Vis-à-vis. Utilisez la liste déroulante Numéros de page pour défi-
nir la numérotation à appliquer au style de page.

• Une pratique courante dans la mise en page consiste à créer des marges asymétriques, tant 
à gauche et à droite qu’en haut et bas. La disposition la plus courante suit ces deux règles 
générales pour les pages imprimées : (a) la marge externe (celle de droite sur une page 
droite) doit être plus large que la marge interne (à gauche sur une page droite) ; (b) la marge 
du bas doit être plus grande que la marge du haut. La logique de cette mise en page asymé-
trique est de laisser plus de place au lecteur pour placer ses mains pendant qu’il tient le livre 
ou le document imprimé.

• Si vous désirez que la première page d’un nouveau chapitre soit toujours à droite, assurez-
vous que le style de cette page soit paramétré comme de Droite uniquement dans le champ 
Mise en page. Pour le reste du chapitre, la procédure classique consiste à définir un style de 
Pages en vis-à-vis qui comprendra les pages gauches et droites qui pourront avoir des en-
têtes et des pieds de page différents. En procédant de cette façon, les chapitres n’utiliseront 
que deux styles de page.

• Vous pouvez choisir de définir des styles de page différents pour les pages gauches et 
droites, si vous désirez leur donner une apparence très différente (par exemple, des marges 
différentes ou un en-tête et un pied de page uniquement sur les pages de droite mais pas sur
celles de gauche ; imaginez un livre comportant uniquement des photographies sur les 
pages de gauche et seulement du texte sur les pages de droite). Dans ce cas, faites en sorte
que le champ Style de suite du style de la première page fasse référence à un style de page 
de gauche uniquement, lui-même suivi d’une page de droite uniquement. En procédant ainsi,
un chapitre utilisera trois styles de page. Dans cette hypothèse, les trois styles de page pour-
raient être Première page, Page gauche et Page droite.
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Si vous cochez l’option Contrôle de repérage, Writer créera une grille verticale invisible sur la page
dont l’espacement entre les points dépendra du Style de référence choisi. Cette grille verticale as-
sure que le texte imprimé, sur des colonnes adjacentes, des pages en vis-à-vis ou même sur les 
deux faces d’une même feuille de papier, est aligné, ce qui le rend plus facile à lire et plus 
agréable à voir.

Les onglets Arrière-plan et Bordures

Les onglets Arrière-plan et Bordures sont décrits en détail au Chapitre 5 Mise en page : les bases, 
page 135. L’onglet Arrière-plan vous permet d’appliquer un fond à la page et l’onglet Bordures de 
tracer un contour autour de la zone de texte (entre les marges). Vous pouvez aussi ajouter une 
ombre à la zone de texte. Vous avez le choix entre une couleur en aplat et une image pour l’ar-
rière-plan et plusieurs sortes de lignes pour les bordures. La partie de la page concernée par ces 
choix ne comprend pas la surface hors des marges.

Si vous prévoyez d’imprimer sur du papier de couleur et que vous souhaitez avoir une idée du ré-
sultat final, ou si vous voulez utiliser une couleur claire pour la police, plutôt que de changer l’ar-
rière-plan, sélectionnez Outils > Options > LibreOffice > Couleurs de l’interface et, dans la sec-
tion Général, changer la couleur de l’Arrière-plan du document. Toute la surface de la page est 
modifiée, y compris la zone à l’extérieur des marges, mais cette couleur de fond n’est ni imprimée 
ni exportée au format PDF.

Les onglets En-tête et Pied de page

Vous pouvez associer un en-tête et un pied de page différent à chaque style de page. Grâce à 
cela, il est facile d’avoir des en-têtes différents sur les pages de gauche et de droite, de ne pas 
mettre d’en-tête sur la première page d’un nouveau chapitre, et ainsi de suite. L’en-tête et le pied 
de page peuvent aussi être différents pour la première page d’un document quand elle utilise ce 
style.

Vous pouvez définir un en-tête différent pour les pages de gauche et de droite même si vous utili-
sez un style unique pour les deux. Ce choix n’est pas proposé pour les styles de page prédéfinis 
Page droite et Page gauche ni pour les styles dont la mise en page est Droite uniquement ou 
Gauche uniquement.

Les en-têtes et pieds de page sont décrits au Chapitre 5 Mise en page : les bases, page 123.

Figure 9.20 : En-têtes différents sur les pages gauches et droites.

L’onglet Colonnes

Utilisez cet onglet pour créer la disposition en colonnes que vous souhaitez. Elle est décrite en dé-
tail au Chapitre 6 Mise en page : approfondissements, page 146.

Elle est partagée en trois sections : Paramètres, Largeur et espacement et Trait de séparation. 
Choisissez le nombre de colonnes souhaité. S’il est supérieur à un, les deux autres sections sont 
activées. Vous pouvez utiliser les paramètres prédéfinis (colonnes régulièrement espacées) ou dé-
cocher l’option Largeur automatique et saisir les valeurs manuellement. Quand vous travaillez 
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avec plusieurs colonnes par page, vous pouvez aussi ajuster la position et la taille de la ligne de 
séparation entre celles-ci.

L’onglet Note de bas de page

Cette page vous permet d’ajuster l’apparence des notes de bas de page. Voir le Chapitre 5 Mise 
en page : les bases, page 134, pour plus de détails.

Travailler avec les styles de liste

Les styles de liste (ou styles de numérotation) travaillent en association avec les styles de para-
graphe. Ils définissent le retrait, l’alignement et les caractères de numérotation ou les puces des 
éléments de la liste. Vous pouvez définir de nombreux styles de liste, de la simple liste à puces 
aux listes imbriquées à plusieurs niveaux.

Comme pour les autres styles, les principales raisons de l’utilisation des styles de liste sont la co-
hérence et la plus grande vitesse de travail. Bien que vous puissiez créer rapidement des listes 
simples en cliquant sur les boutons (Dés)activer les puces ( ) et (Dés)activer la numérotation 
( ) de la barre d’outils Formatage et réaliser des listes imbriquées assez complexes grâce aux 
boutons de la barre d’outils Puces et numérotation, le résultat peut ne pas avoir l’aspect souhaité, 
et il se peut que vous désiriez plus d’un style de liste. Vous pouvez utiliser l’entrée Puces et nu-
mérotation… du menu Format pour mettre en forme l’apparence de quelques listes, voire de 
toutes, mais, si vous devez changer par la suite leur aspect, vous aurez beaucoup de travail pour 
les reprendre une par une.

Reportez-vous au Chapitre 12 Travailler avec les listes, page 325, pour tout détail sur la façon dont
les styles de liste et de paragraphe fonctionnent ensemble.

Remarque

LibreOffice utilise les termes « style de numérotation » et « style de liste » de manière inco-
hérente, mais il s’agit de la même chose. Par exemple, l’infobulle de l’onglet Style et forma-
tage dit Styles de liste, mais sa boîte de dialogue dit Style de numérotation.

Créer un nouveau style de liste

La boîte de dialogue de création d’un nouveau style de liste possède six onglets en supplément de
l’habituel onglet Gestionnaire présenté à la page 233.

Les onglets Puces, Style de numérotation et Image

Ces onglets proposent des formats prédéfinis pour les symboles (puces ou numéros) des élé-
ments de la liste. Pour utiliser l’un d’entre eux dans votre style, cliquez sur l’image. Une bordure 
plus épaisse indiquera votre choix. Les puces de l’onglet Puces sont des caractères d’une police, 
celles de l’onglet Image sont… des images de la galerie.

L’onglet Plan

Cette page vous offre le choix entre huit listes imbriquées prédéfinies. Vous pouvez aussi en choi-
sir une qui servira de point de départ pour votre style personnel en la modifiant grâce aux para-
mètres des pages Position et Personnaliser décrites ci-dessous.
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L’onglet Position

Utilisez l’onglet Position (Figure 9.21) pour ajuster le retrait et l’espace entre le symbole et le texte 
de l’élément de la liste. Cette page prend toute son efficacité en association avec l’onglet Person-
naliser.

Figure 9.21 : Les paramètres de position d’un style de liste.

Vous pouvez ajuster les paramètres suivants pour chaque niveau individuellement ou pour tous les
niveaux à la fois (pour qu’ils soient tous identiques). Il est généralement plus simple de le faire 
dans l’ordre donné ci-dessous plutôt que dans l’ordre proposé par la boîte de dialogue. Il com-
mence par le retrait global des éléments de la liste puis règle la position des symboles pour finir 
par ajuster leur alignement.

• Le champ Numérotation suivie par définit le caractère qui suit le symbole de numérotation 
(plus tout caractère, un point par exemple, choisi dans l’onglet Personnaliser pour suivre le 
nombre). Vous avez le choix entre une tabulation, une espace ou rien. Si vous choisissez 
une tabulation, vous pouvez précisez sa position dans le champ suivant.

• Le champ Retrait à définit l’espace réservé au symbole de numérotation, mesuré à partir de 
la marge gauche de la page. L’alignement de la première ligne est aussi affecté par toute ta-
bulation que vous pourriez avoir définie à la suite de la numérotation.

• Le champ Aligné à définit la position du symbole de numérotation mesurée à partir de la 
marge gauche de la page.

• Le champ Alignement de la numérotation définit la façon dont la numérotation (y compris 
le texte avant et après défini dans l’onglet Personnaliser) est aligné.
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Conseil

Dans les circonstances normales, le choix d’une numérotation suivie d’une tabulation à la 
même distance que le retrait fonctionne bien. Voir la Figure 9.22 pour une représentation vi-
suelle de l’effet des paramètres ci-dessus.

Figure 9.22 : Liste numérotée présentant les divers paramètres.

Conseil

Pour apprécier pleinement si l’Alignement de la numérotation fonctionne, essayez de créer 
une liste numérotée comportant plus de dix éléments et assurez-vous d’avoir assez de place
pour les numéros qui ont deux chiffres ou plus. Il est aussi possible d’aligner la numérotation
à droite si elle comporte plus de neuf éléments, comme sur la Figure 9.22.

L’onglet Personnaliser

L’onglet Personnaliser (Figure 9.23) vous offre le moyen de définir le style des niveaux de la liste. 
Les options disponibles sur cette page dépendent du type de marqueur sélectionné pour la liste. 
En premier lieu, sélectionnez dans la liste de droite le niveau que vous désirez modifier. Pour mo-
difier l’ensemble des dix niveaux en une seule fois, choisissez 1-10. Si vous partez d’une liste hié-
rarchique prédéfinie, certains niveaux seront déjà paramétrés.
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Figure 9.23 : L’onglet Personnaliser de la boîte de dialogue Style de liste.

Selon le style de numérotation choisi dans le champ Nombre (puces, image ou nombres), cer-
taines des options suivantes deviennent utilisables (elles ne sont pas toutes visibles sur l’illustra-
tion) :

• Afficher les sous-niveaux : les numéros des niveaux précédents sont inclus dans le style 
de numérotation. Par exemple, si vous saisissez « 2 » et que le niveau précédent utilise « A, 
B, C… » comme style de numérotation, le schéma de numérotation du niveau courant de-
vient « A.1 » ;

• Avant : le texte qui apparaîtra avant le numéro (par exemple, le mot « Niveau ») ;

• Après : le texte qui apparaîtra après le numéro (par exemple, un point) ;

• Commencer avec : le premier numéro de la liste (par exemple, pour commencer une liste 
au numéro 4 au lieu de 1) ;

• Style de caractères : le style à utiliser pour les numéros ou les puces ;

• bouton Caractère Sélectionner… : cliquez pour choisir le caractère de la puce ;

• bouton Image Sélectionner… : ouvre une liste d’images disponibles dans la Galerie ou per-
met la sélection d’un fichier sur le disque dur qui sera utilisé comme marqueur de la liste ;

• Largeur et Hauteur : saisissez-y les dimensions de l’image qui servira de puce ;

• l’option Proportionnel permet de conserver un rapport largeur sur hauteur fixe pour l’image ;

• Alignement définit l’alignement vertical de l’image par rapport au texte.

La zone d’aperçu à droite de la boîte de dialogue montre le résultat des choix effectués.

Si vous choisissez l’option Images liées dans la liste déroulante Nombre, l’image est liée au docu-
ment au lieu d’y être incorporée. La puce ne s’affichera donc pas quand le document sera ouvert 
sur un ordinateur différent (à moins que le fichier de l’image ne soit situé au même emplacement 
sur les deux machines) ni si le fichier de l’image est déplacé à un emplacement différent sur votre 
ordinateur.
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Pour revenir aux valeurs par défaut, cliquez sur le bouton Réinitialiser dans le coin en bas à 
droite. Pour finir, si vous souhaitez utiliser des numéros consécutifs indépendamment du niveau 
hiérarchique, cochez l’option Numérotation continue en bas de la page.

Exemple : création d’un style de liste simple

Dans cet exemple, nous allons créer une liste numérotée utilisée pour énumérer les fables de Jean
de la Fontaine. Les numéros sont alignés à droite et un certain espace est laissé libre entre le nu-
méro et le titre de la fable.

Comme nous avons l’intention de réutiliser la même liste pour d’autres auteurs, nous allons définir 
un nouveau style de liste puis l’appliquer à notre suite de titres.

Créer la liste numérotée des fables

Comme dans l’exemple précédent, commencez par cliquer sur l’icône Styles de liste (la cin-
quième en partant de la gauche) dans l’onglet Styles et formatage du volet latéral, faites un clic 
droit n’importe où dans la liste et sélectionnez Nouveau…

La boîte de dialogue Style de numérotation s’affiche. Pour notre liste de fables, nous devons per-
sonnaliser certains champs dans les onglets Gestionnaire, Position et Personnaliser.

Dans l’onglet Gestionnaire,

• dans le champ Nom, saisissez Fables,

• dans le champ Catégorie, Styles personnalisés nous convient très bien.

Modifiez les options de l’onglet Personnaliser de la façon suivante :

 1) Dans la liste Niveau, sélectionnez 1.

 2) Dans la liste Nombre, sélectionnez 1, 2, 3…

 3) Laissez le champ Avant vide et saisissez un point dans le champ Après.

 4) Laissez le champ Style de caractères sur Aucun.

 5) Le champ Afficher les sous-niveaux devrait être grisé (inaccessible).

 6) Vérifiez que le champ Commencer avec contient 1

 7) Ne cochez pas l’option Numérotation continue.

Comme indiqué précédemment, la liste numérotée adoptera les réglages du style de paragraphe 
sous-jacent. Si vous désirez utiliser une police, une taille ou une couleur particulière pour la numé-
rotation, vous pouvez créer un style de caractère et l’appliquer dans le champ Style de caractère 
de l’onglet Personnaliser.

Si vous désirez que le mot Fable apparaisse avant le numéro, ajoutez-le dans le champ Avant en 
n’oubliant pas un caractère espace pour le séparer du numéro.

Réglez les derniers paramètres de la liste dans l’onglet Position.

 1) Sélectionnez 1 dans la liste Niveau.

 2) Pour le champ Numérotation suivie par, choisissez une tabulation et positionnez-la à 4 cm.

 3) Pour le champ Alignement de la numérotation, choisissez À droite.

 4) Pour le champ Aligné à, choisissez 1,5 cm (cela concerne l’alignement des numéros).
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 5) Dans le champ Retrait à, saisissez 4 cm (ce qui règle le retrait global de la liste).

 6) Cliquez sur OK pour terminer.

Appliquer le style de liste

Maintenant que vous disposez du style de liste, vous pouvez facilement l’appliquer à n’importe 
quelle liste dans le document :

• si vous commencez une nouvelle liste, avant d’appuyer sur Entrée pour débuter une nou-
velle ligne, faites un double-clic sur le nom du style souhaité dans l’onglet Styles et forma-
tage ;

• si vous avez déjà une liste, sélectionnez-la et faites un double-clic sur le nom du style sou-
haité dans l’onglet Styles et formatage.

Remarque

N’oubliez pas qu’appliquer un style de liste ne change rien aux caractéristiques du para-
graphe sous-jacent ; en conséquence, il peut être bon de vérifier que le style de paragraphe 
vous convient avant d’appliquer le style de liste.

Si votre document contient plusieurs listes, la deuxième liste de même style et les suivantes conti-
nuent la numérotation après la liste précédente. Pour redémarrer à 1, placez le curseur n’importe 
où dans le paragraphe où vous voulez voir la numérotation recommencer à 1, faites un clic droit et 
sélectionnez Recommencer la numérotation ( ).

Pour cesser d’utiliser la numérotation, cliquez sur le bouton (Dés)activer la numérotation ( ) de
la barre d’outils Standard. Le résultat final est illustré sur la Figure 9.22.
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Chapitre 10
Travailler avec les modèles





Introduction

Un modèle est un document préformaté. Par exemple, vous pouvez créer un modèle pour vos rap-
ports professionnels qui contiendrait le logo de votre entreprise sur la première page. Tous les nou-
veaux documents créés à partir de ce modèle auraient donc le logo de votre entreprise sur la pre-
mière page.

Les modèles peuvent contenir tout ce que les documents habituels contiennent, comme du texte, 
des images, un ensemble de styles et des informations personnalisées telles que l’unité de me-
sure, la langue, l’imprimante par défaut ainsi que les paramètres personnalisés des barres d’outils 
et des menus.

Tous les documents dans LibreOffice sont basés sur des modèles. Si vous ne choisissez pas un 
modèle en particulier lorsque vous ouvrez un document Writer, le document est basé sur le modèle
par défaut des documents texte. Si vous n’avez pas spécifié un modèle par défaut, Writer utilise le 
modèle vide installé avec LibreOffice. Pour plus d’informations, référez-vous à la section Définir 
un modèle par défaut en page 270.

LibreOffice n’offre que quelques modèles à l’utilisateur. Vous pouvez en ajouter à partir d’autres 
sources (voir page 269) ou créer vos modèles personnels (voir page 266).

Utiliser un modèle pour créer un document

Pour utiliser un modèle afin de créer un document :

 1) Cliquez sur le menu Fichier > Nouveau > Modèles pour ouvrir la boîte de dialogue Modèles
ou cliquez sur la petite flèche à droite de l’icône Nouveau ( ) dans la barre d’outils Stan-
dard et choisissez Modèles (voir Figure 10.1).

 2) Dans la liste déroulante Filtre en haut de la boîte de dialogue, sélectionnez Documents. 
Vous pouvez aussi choisir une catégorie. Les modèles correspondants apparaissent dans la 
page.

 3) Faites un double clic sur le modèle souhaité. Un nouveau document basé sur le modèle 
choisi s’ouvre dans Writer. Vous pouvez éditer et enregistrer le nouveau document comme 
vous le feriez avec n’importe quel autre document.

Le modèle qui a servi de base à la création du document est indiqué dans Fichier > Propriétés > 
Général.

Remarque
La connexion entre le modèle et le document persiste jusqu’à ce que le modèle soit modifié 
et que vous choisissiez, à l’ouverture suivante du document, de ne pas le mettre à jour à la 
suite du modèle.

Si vous copiez ou déplacez le document sur un autre ordinateur qui ne possède pas de co-
pie installée du modèle, la liaison est rompue, même si le nom du modèle apparaît toujours 
dans les propriétés du document. Voir « Associer un document à un modèle différent » 
page 272 la méthode pour reconnecter un modèle à un document si nécessaire.
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Figure 10.1 : La boîte de dialogue Modèles

Créer un document depuis un modèle dans le centre de démarrage

Vous pouvez créer un document depuis la vue Modèles du centre de démarrage qui est visible 
quand aucun autre document n’est ouvert.

Pour ouvrir la boîte de dialogue Modèles depuis le centre de démarrage, cliquez sur le bouton Mo-
dèles dans le panneau de gauche. Ce bouton déroule aussi une liste où vous pouvez sélectionner 
les modèles pour un type donné de document. L’option Gérer les modèles à la fin de la liste ouvre
la boîte de dialogue Modèles.

Créer un modèle

Vous pouvez créer vos propres modèles de deux manières : depuis un document ou en utilisant un
assistant.

Créer un modèle depuis un document

En plus de la mise en forme, tous les paramètres qui peuvent être ajoutés ou modifiés dans un do-
cument peuvent être enregistrés dans un modèle. Vous pouvez aussi, par exemple, enregistrer les
paramètres de l’imprimante et les réglages généraux configurés dans la boîte de dialogue Options 
(Outils > Options), comme les chemins et les couleurs.

Les modèles peuvent aussi contenir du texte prédéfini qui vous évite d’avoir à le taper à chaque 
fois que vous créez un nouveau document. Par exemple, un modèle de lettre peut contenir votre 
nom, votre adresse et les salutations.

Vous pouvez aussi y enregistrer des personnalisations de menus ou de barres d’outils ; voyez le  
Chapitre 21 Personnaliser Writer, page 575.
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Conseil

Il est possible d’enregistrer un modèle à partir de la boîte de dialogue d’enregistrement habi-
tuelle, mais il ne sera pas listé parmi les autres modèles. Cela peut cependant être utile pour
le partager facilement avec d’autres.

Pour créer un modèle à partir d’un document dans la catégorie Mes modèles :

 1) Ouvrez un document texte nouveau ou existant.

 2) Ajoutez-y le contenu que vous désirez voir apparaître dans tous les documents que vous 
créerez à partir de ce nouveau modèle, par exemple le logo de votre société, une déclaration
de droits d’auteur, etc.

 3) Créez ou modifiez tous les styles et autres formatages (comme des AutoTextes) que vous 
avez l’intention d’utiliser dans le nouveau modèle.

 4) Dans la barre de menu, sélectionnez Fichier > Modèles > Enregistrer comme modèle… 
La boîte de dialogue Enregistrer comme modèle (Figure 10.2) affiche les catégories exis-
tantes et offre un champ de saisie pour taper le nom du nouveau modèle.

 5) Sélectionnez la catégorie Mes modèles.

 6) Cliquez sur Enregistrer. Le modèle est enregistré et la boîte de dialogue se referme.

Figure 10.2 : La boîte de dialogue Enregistrer comme modèle.

Créer un modèle à l’aide d’un assistant

Vous pouvez utiliser un assistant pour créer des modèles de lettres, de fax et d’agendas, ainsi que 
des présentations et des pages Web.

Par exemple, l’assistant Fax vous guide parmi les choix suivants :

• le type de fax (professionnel ou personnel) ;

• les éléments du document tels que la date, l’objet (pour un fax professionnel), les salutations 
et la formule finale ;

• les informations sur l’expéditeur et le destinataire (pour un fax professionnel) ;
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• le texte à inclure dans le pied de page (pour un fax professionnel).

Pour créer un modèle à l’aide d’un assistant :

 1) Dans la barre de menu, sélectionnez Fichier > Assistants > [type de modèle désiré].

 2) Suivez les instructions données par l’assistant. Le processus est légèrement différent pour 
chacun mais le format reste très similaire.

 3) Dans la dernière section de l’assistant, vous pouvez spécifier le nom du modèle tel qu’il ap-
paraîtra dans la boîte de dialogue Modèles ainsi que le nom et l’emplacement où l’enregis-
trer. Les deux noms peuvent être différents mais cela est source de confusion pour plus tard.
L’emplacement par défaut est votre dossier par défaut des modèles mais vous pouvez choi-
sir un autre endroit.

 4) Pour définir le nom du fichier ou modifier le dossier, cliquez sur le bouton marqué de trois 
points qui ouvre une boîte de dialogue Enregistrer sous. Faites-y votre choix puis cliquez sur 
Enregistrer.

 5) Pour terminer, vous avez le choix de créer immédiatement un document à partir du modèle 
ou de modifier manuellement celui-ci avant de cliquer sur le bouton Terminer pour enregis-
trer le modèle. Par la suite, vous pourrez utiliser, pour produire de nouveaux documents, le 
modèle créé par l’assistant comme tout autre modèle.

Vous devrez peut-être ouvrir la boîte de dialogue Modèles et cliquer sur Actualiser dans le menu 
déroulant du bouton Action (  encadré en vert sur la Figure 10.4) pour que les nouveaux mo-
dèles apparaissent dans la liste.

Modifier un modèle

Vous pouvez modifier les styles et le contenu d’un modèle, puis, si vous le désirez, en réappliquer 
les styles aux documents qui ont été créés à partir de celui-ci. Vous ne pouvez pas réappliquer le 
contenu.

Pour modifier un modèle :

 1) Dans la barre de menu, sélectionnez Fichier > Modèles > Gérer les modèles ou appuyez 
sur Ctrl + Maj + N. La boîte de dialogue Modèles s’ouvre. Il est aussi possible de l’ouvrir 
depuis le centre de démarrage.

 2) Recherchez le modèle que vous désirez modifier. Faites un clic droit sur celui-ci et sélection-
nez Éditer dans le menu contextuel. Le modèle s’ouvre dans LibreOffice.

 3) Modifiez le modèle comme vous le feriez pour n’importe quel autre document. Pour enregis-
trer les modifications, sélectionnez Fichier > Enregistrer dans la barre de menu.

Actualiser un document dont le modèle a été modifié

Si vous apportez des modifications à un modèle et à ses styles, la prochaine fois que vous ouvri-
rez un document que vous avez créé avec ce modèle avant de le modifier, un message de confir-
mation s’affiche.

Pour actualiser le document :

• cliquez sur Actualiser les styles pour appliquer au document les styles modifiés dans le 
modèle ;
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• cliquez sur Conserver les anciens styles si vous ne désirez pas appliquer au document les 
styles modifiés dans le modèle, mais, dans ce cas, tenez compte de l’avertissement suivant.

Figure 10.3 : Message de confirmation de l’actualisation des styles.

! Attention

Si vous choisissez de conserver les anciens styles, le document ne sera plus relié au mo-
dèle, même si celui-ci apparaît encore dans Fichier > Propriétés > Général. Vous pourrez 
toujours importer les styles depuis le modèle, mais pour le reconnecter à celui-ci, vous de-
vrez copier son contenu dans un nouveau document vide basé sur le modèle en question, 
comme cela est décrit à la page 272, section « Associer un document à un modèle diffé-
rent ».

Ajouter des modèles obtenus par d’autres sources

Dans LibreOffice, les sources de modèles s’appellent des dépôts. Un dépôt peut être local (un 
dossier dans votre ordinateur dans lequel vous avez placé des modèles) ou distant (une URL où 
vous pouvez en télécharger).

Vous pouvez atteindre le dépôt officiel des modèles à l’aide du bouton Parcourir les modèles en 
ligne (encadré en rouge sur la Figure 10.4) en bas à gauche de la boîte de dialogue Modèles ou 
en tapant https://extensions.libreoffice.org/templates dans la barre d’adresse de votre navigateur.

Sur d’autres sites Web, vous pourrez trouver des collections de modèles qui ont été regroupés 
sous forme d’extension (fichier.oxt). On les installe d’une manière un peu différente décrite plus 
bas.

Figure 10.4 : Obtenir des modèles en ligne pour LibreOffice.

Installer des modèles isolés

Pour installer des modèles un par un :

 1) Téléchargez le modèle et enregistrez-le n’importe où sur votre ordinateur.

 2) Importez le modèle dans un dossier de modèles en suivant les instructions de la section 
« Importer un modèle » en page 274.
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Astuce

(Pour les utilisateurs avancés) Si vous connaissez l’emplacement des dossiers de modèles 
de LibreOffice, vous pouvez y copier manuellement les nouveaux modèles. L’emplacement 
varie en fonction du système d’exploitation de votre ordinateur. Pour savoir où sont stockés 
les dossiers de modèles sur votre ordinateur, ouvrez la page LibreOffice – Chemins de la 
boîte de dialogue Options en cliquant sur le menu Outils > Options.

Installer des collections de modèles

Le Gestionnaire des extensions fournit un excellent moyen pour installer des collections de mo-
dèles qui ont été réunis dans une extension. Suivez ces étapes :

 1) Téléchargez une extension (fichier.oxt) et enregistrez-la n’importe où sur votre ordinateur. Si 
l’extension est contenue dans un fichier.zip, extrayez l’archive portant l’extension .oxt.

 2) Dans Writer, cliquez sur le menu Outils > Gestionnaire des extensions. Dans la boîte de 
dialogue Gestionnaire des extensions, cliquez sur le bouton Ajouter afin d’ouvrir le naviga-
teur de fichier de votre système d’exploitation.

 3) Recherchez et sélectionnez la collection de modèles que vous souhaitez installer. Cliquez 
ensuite sur le bouton Ouvrir. La collection commence à être installée. Il se peut que vous 
deviez accepter la licence d’utilisation.

 4) Lorsque l’installation de l’extension sera terminée, relancez LibreOffice, après quoi les mo-
dèles seront disponibles via la boîte de dialogue Modèles.

Vous pouvez également installer des extensions en double-cliquant sur le fichier et en acceptant 
ensuite l’installation (ainsi qu’une éventuelle licence d’utilisation).

Pour plus d’informations sur le Gestionnaire des extensions, référez-vous au Chapitre 21 Person-
naliser Writer, page 575.

Définir un modèle par défaut

Si vous créez un nouveau document via le menu Fichier > Nouveau > Document texte, Writer 
crée le document en se basant sur le modèle par défaut pour les documents texte. Cependant, 
vous pouvez choisir un modèle personnalisé afin qu’il devienne le modèle par défaut. Vous pourrez
toujours rétablir le modèle de Writer ultérieurement.

Note pour les utilisateurs de Microsoft Word
Vous savez peut-être que Microsoft Word utilise un fichier normal.dot ou normal.dotx comme 
modèle par défaut et vous savez peut-être aussi comment le régénérer.

LibreOffice ne possède pas de tel fichier de modèle par défaut : les « réglages d’usine » par 
défaut sont incorporés au logiciel. Vous avez cependant la possibilité d’importer un modèle 
normal.dot(x), ou tout autre modèle utilisé par Microsoft Word, grâce au menu Fichier > Ou-
vrir un modèle… ou via la boîte de dialogue AutoTexte (Outils > AutoTexte) en cliquant 
sur le bouton Importer puis en sélectionnant l’extension adaptée.
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Définir un modèle personnalisé comme modèle par défaut

Vous pouvez définir n’importe quel modèle comme étant celui par défaut, pour autant que ce soit 
l’un des modèles présents dans le Gestionnaire de modèles. Vous pouvez ajouter, si nécessaire, 
un modèle dans un dossier comme décrit dans la section « Importer un modèle » en page 274.

Pour définir un modèle personnalisé comme le modèle par défaut :

 1) Cliquez sur le menu Fichier > Modèles > Gérer les modèles pour ouvrir la boîte de dia-
logue Modèles.

 2) Dans celle-ci, ouvrez la catégorie contenant le modèle que vous souhaitez définir par défaut.
Faites un simple clic sur le modèle afin de le sélectionner.

 3) Faites un clic droit sur le modèle choisi et sélectionnez Définir par défaut dans le menu 
contextuel (voir Figure 10.5).

Figure 10.5 : Définir un modèle de document par défaut.

La prochaine fois que vous créerez un nouveau document via le menu Fichier > Nouveau > Do-
cument texte, le document sera basé sur le modèle que vous venez de définir.

Bien que de nombreux paramètres principaux (par exemple : la police par défaut) puissent être 
modifiés via le menu Outils > Options (pour plus d’informations, référez-vous au Chapitre 20 Pa-
ramétrer Writer, page 545), certains d’entre eux (par exemple : les marges de la page) ne peuvent 
être changés qu’en remplaçant le modèle par défaut.

Rétablir le modèle initial de Writer comme modèle par défaut

Pour rétablir le modèle initial de Writer comme modèle par défaut :

 1) Dans la boîte de dialogue Modèles, cliquez sur le bouton Action sur la gauche (voir Figure 
10.6).

 2) Placez le curseur de la souris sur Rétablir le modèle par défaut dans le menu déroulant et 
cliquez sur Texte (voir Figure 10.6).

Cette option apparaît dans le menu Action uniquement si un modèle personnalisé a remplacé le 
modèle initial de Writer.

La prochaine fois que vous créerez un nouveau document (par exemple, via le menu Fichier > 
Nouveau > Document texte), ce dernier sera basé sur le modèle initial de Writer.
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Figure 10.6 : Rétablir le modèle par défaut initial des documents texte.

Associer un document à un modèle différent

Si vous travaillez sur un document que vous n’avez pas créé à partir d’un modèle ou que vous 
l’avez basé sur un modèle différent, il vous est toujours possible d’associer ce document à un 
(autre) modèle.

L’un des avantages majeurs dans l’utilisation des modèles est le fait de pouvoir mettre à jour facile-
ment les styles dans plus d’un document, comme cela est décrit au Chapitre 9 Travailler avec les 
styles, page 231. Si vous mettez à jour les styles dans un document en chargeant un nouvel en-
semble de styles depuis un modèle différent, le document ne sera pas associé au modèle depuis 
lequel les styles ont été chargés. Par conséquent, il est important que vous associiez à un modèle 
le document sur lequel vous travaillez.

Pour de meilleurs résultats, il est préférable que les noms des styles soient les mêmes dans le do-
cument existant et dans le nouveau modèle. Si ce n’est pas le cas, vous devez utiliser la boîte de 
dialogue Rechercher & remplacer (menu Édition > Rechercher & remplacer) afin de remplacer 
les anciens styles de paragraphes par les nouveaux. Pour plus d’informations au sujet de la fonc-
tion Rechercher & remplacer, référez-vous au Chapitre 2 Travailler avec le texte : les bases, page
46.

 1) Cliquez sur le menu Fichier > Nouveau > Modèles. Dans la boîte de dialogue Modèles, 
faites un double clic sur le modèle que vous souhaitez utiliser. Un nouveau document s’ouvre
avec le texte et les images contenus dans le modèle.

 2) Supprimez les éventuels éléments (texte, tableau, dessin, etc.) de ce nouveau document.

 3) Ouvrez le document que vous souhaitez modifier (il s’affichera dans une nouvelle fenêtre).

 4) Cliquez sur Édition > Tout sélectionner ou appuyez sur les touches Ctrl+A pour sélection-
ner l’intégralité du document.

 5) Cliquez sur Édition > Copier ou appuyez sur les touches Ctrl+C pour copier le document 
dans le presse-papier.

 6) Cliquez ensuite dans le document vierge créé à l’étape 1. Cliquez sur Édition > Coller ou 
appuyez sur les touches Ctrl+V pour coller le contenu de l’ancien document dans le nou-
veau.
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 7) Mettez à jour la table des matières, s’il y en a une. Fermez l’ancien document sans enregis-
trer les modifications. Enregistrez le nouveau document en écrasant l’ancien ou enregistrez-
le sous un nouveau nom pour préserver l’original.

! Attention

Toutes les modifications enregistrées (suivies) dans le document seront perdues par cette 
opération. Le document finalement obtenu ne contiendra que le texte modifié.

Organiser les modèles

Dans votre travail avec LibreOffice, il est important que vous puissiez organiser vos dossiers de 
modèles afin, par exemple, de disposer d’un dossier contenant uniquement vos modèles de rap-
ports ou vos modèles de lettres. Il est également possible d’importer et d’exporter vos modèles.

Pour commencer, cliquez sur le menu Fichier > Nouveau > Gérer les modèles pour ouvrir la 
boîte de dialogue Modèles.

Créer une catégorie de modèles

Pour créer une catégorie de modèles :

 1) Dans la boîte de dialogue Modèles, cliquez sur le bouton Action.

 2) Cliquez sur Nouvelle catégorie dans le menu déroulant (Figure 10.7).

 3) Une nouvelle boîte de dialogue s’ouvre et vous invite à saisir le nom de la nouvelle catégo-
rie. Cliquez ensuite sur OK.

Figure 10.7 : Créer une nouvelle catégorie de modèles

Remarque

LibreOffice ne vous permet pas de créer de sous-catégorie à l’intérieur d’une catégorie de 
modèles.

Supprimer une catégorie de modèles

Pour supprimer une catégorie de modèles :

 1) Dans la boîte de dialogue Modèles, sélectionnez la catégorie que vous souhaitez supprimer.
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 2) Cliquez sur le bouton Action puis sur Supprimer la catégorie dans le menu déroulant (voir
Figure 10.7). Confirmez la suppression dans la boîte de message qui apparaît.

Déplacer un modèle

Pour déplacer un modèle d’une catégorie à une autre, sélectionnez-le dans la boîte de dialogue 
Modèles, cliquez sur le bouton Déplacer en bas à droite de la boîte de dialogue (voir Figure 10.8). 
Dans le dialogue qui s’ouvre alors, choisissez la catégorie souhaitée puis cliquez sur OK.

Figure 10.8 : Déplacer un modèle dans une autre catégorie

Supprimer un modèle

Pour supprimer un modèle :

 1) Dans la boîte de dialogue Modèles, sélectionnez la catégorie qui contient le modèle à suppri-
mer.

 2) Faites un simple clic sur le modèle à supprimer pour le sélectionner.

 3) Faites un clic droit pour ouvrir le menu contextuel du modèle et choisissez Supprimer. 
Confirmez la suppression dans la boîte de message qui apparaît.

Importer un modèle

Si le modèle que vous souhaitez utiliser se trouve dans un autre emplacement, vous devez l’impor-
ter dans un dossier de modèles de LibreOffice dont vous trouverez la liste à la page LibreOffice – 
Chemins de la boîte de dialogue Options (cliquez sur Outils > Options dans la barre de menu).

Pour importer un modèle dans une catégorie :
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 1) Dans la boîte de dialogue Modèles, cliquez sur le bouton Importer en bas à droite. La boîte 
de dialogue Choisir une catégorie s’ouvre.

 2) Sélectionnez la catégorie dans laquelle vous désirez importer le modèle et cliquez sur OK. 
Une boîte de dialogue standard d’ouverture de fichier apparaît.

 3) Recherchez et sélectionnez le modèle que vous voulez importer et cliquez sur Ouvrir. La fe-
nêtre se referme et le modèle apparaît dans la catégorie sélectionnée.

Exporter un modèle

Pour exporter un modèle d’une catégorie de modèles à un autre emplacement :

 1) Dans la boîte de dialogue Modèles, sélectionnez la catégorie qui contient le modèle que 
vous souhaitez exporter.

 2) Recherchez le modèle à exporter et faites un simple clic dessus pour le sélectionner.

 3) Cliquez sur le bouton Exporter en bas à droite de la fenêtre. La boîte de dialogue Enregis-
trer sous s’affiche.

 4) Recherchez le dossier où vous voulez exporter le modèle et cliquez sur Enregistrer.
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Images et graphismes dans Writer

Vous pouvez ajouter dans les documents de Writer des fichiers d’images contenant, par exemple, 
des photos, des dessins ou des images scannées. Writer sait importer de nombreux formats de fi-
chiers d’images vectorielles (dessins au trait) ou tramées (bitmap).

Les types fondamentaux d’image dans Writer sont les suivants :

• des fichiers d’images tels que des photos, des dessins ou des images scannées ;

• des schémas créés grâce aux outils de dessin de LibreOffice ;

• des illustrations créées grâce à la galerie de clip-art ou à Fontwork ;

• des graphiques créés grâce à la fonction Diagramme de LibreOffice.

Ce chapitre présente les images, les schémas et les illustrations. Les instructions pour la création 
de diagrammes sont données au Chapitre 19 Classeurs, diagrammes et autres objets, page 535 et
suivantes. Pour une description plus détaillée du travail avec les outils de dessin, voyez le Guide 
Draw.

Créer et éditer des images

Vous pouvez créer des images grâce à un programme de dessin, les scanner, les télécharger sur 
Internet (n’oubliez pas de vérifier que vous avez le droit de les utiliser) ou utiliser des photos prises
avec un appareil numérique. Writer sait importer diverses images vectorielles (dessins au trait) 
qu’il peut faire pivoter ou retourner. Writer admet aussi des formats de fichier d’images tramées 
(bitmap) dont les plus courants sont GIF, JPG, PNG et BMP. Voyez la liste complète dans l’aide.

Writer sait aussi importer des images SmartArt des fichiers de Microsoft Office. Il peut, par 
exemple, ouvrir un fichier de Microsoft Word qui contient des images SmartArt que vous pouvez 
éditer dans Writer.

Parmi les choses à prendre en compte pendant le choix ou la création d’images, pensez à la quali-
té de l’image et si elle doit être imprimée en couleur ou en noir et blanc (en niveaux de gris).

Pour modifier les photos et autres images tramées, utilisez un éditeur d’images. Pour modifier les 
dessins au trait, utilisez un programme de dessin vectoriel. Il est inutile d’acheter des programmes 
coûteux. Dans de nombreux cas, LibreOffice Draw suffit ; néanmoins il existe d’excellents outils 
libres (et normalement gratuits) tels que GIMP (un éditeur d’images tramées) et Inkscape (un pro-
gramme de dessin vectoriel). Ils fonctionnent, ainsi que beaucoup d’autres, sous Windows, MacOS
et Linux.

Pour obtenir les meilleurs résultats :

• créez les images aux dimensions exactes qu’elles occuperont dans le document ou utilisez 
un programme graphique adapté pour donner aux photographies et aux grands dessins les 
dimensions voulues. Ne le faites pas dans Writer, même s’il possède les outils basiques pour
le faire, car les résultats pourraient ne pas être à la hauteur de vos attentes ;

• effectuez toutes les autres manipulations nécessaires des images (luminosité et contraste, 
balance des couleurs, recadrage, conversion en niveaux de gris, etc.) dans un logiciel de 
dessin, pas dans Writer même si celui-ci possède aussi les outils pour effectuer de nombreux
réglages ;
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• si le document est conçu pour être exclusivement vu à l’écran, une résolution d’image élevée
(300 dpi4 ou plus) n’est pas nécessaire. La plupart des écrans d’ordinateur ont une résolution
de 72 ou 96 dpi ; réduire la résolution des images (et donc la taille du fichier) n’a aucune inci-
dence sur ce qui sera affiché mais rendra Writer bien plus réactif.

Préparer les images pour l’impression en noir et blanc

Si des images en couleur doivent être imprimées en niveaux de gris, vérifiez que les couleurs adja-
centes présentent un contraste suffisant et s’impriment dans un gris suffisamment foncé. Faites un
test sur une imprimante en noir et blanc réglée pour imprimer en niveaux de gris. Mieux encore, 
changez le « mode » de l’image pour niveaux de gris, soit dans un logiciel d’édition de photos, soit 
dans Writer lui-même (voir « Mode d’image » page 286).

Par exemple, la figure suivante est correcte en couleur. Le cercle est rouge foncé et le carré bleu 
foncé. En niveaux de gris, la différence entre les deux n’est pas aussi évidente. Le troisième élé-
ment de la figure, une flèche jaune, est presque invisible en niveaux de gris.

En modifiant les couleurs du cercle et de la flèche, vous améliorerez le contraste et la visibilité de 
l’image obtenue en niveaux de gris.

Si le document n’est destiné qu’à être imprimé en noir et blanc, un meilleur résultat est souvent ob-
tenu en choisissant des aplats en niveaux de gris plutôt qu’en couleur.

Ajouter des images à un document

On peut ajouter des images à un document de plusieurs manières : en insérant un fichier image, 
directement à partir d’un programme graphique ou d’un scanner, en les tirant depuis la galerie de 
clip-arts interne ou en les copiant/collant depuis une source ouverte sur votre ordinateur.

Insérer un fichier d’image

Quand une image est stockée dans un fichier sur l’ordinateur, vous pouvez l’insérer dans un docu-
ment de LibreOffice en utilisant l’une ou l’autre des méthodes suivantes.

4 dpi : dot per inch = point par pouce (2,54 cm)
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Par glisser-déposer

 1) Ouvrez le navigateur de fichiers et recherchez l’image que vous voulez insérer.

 2) Faites glisser cette image dans le document de LibreOffice et déposez-la où vous voulez la 
voir apparaître. Une fine ligne verticale marque l’endroit où l’image sera déposée.

Cette méthode incorpore le (enregistre une copie du) fichier image dans le document. Pour lier le 
fichier au lieu de l’incorporer, maintenez appuyées les touches Ctrl+Maj pendant que vous faites
glisser l’image.

Avec la boîte de dialogue Insérer une image

 1) Cliquez dans le document de LibreOffice là où vous désirez que l’image apparaisse.

 2) Choisissez Insertion > Image dans la barre de menu.

 3) Dans la boîte de dialogue Insérer une image (Figure 11.1), recherchez l’image à insérer et 
sélectionnez-la.

Une ou deux options se trouvent en bas de la boîte de dialogue, Lier et Aperçu. Cochez 
Aperçu pour avoir une vue réduite de l’image dans le panneau de droite (Figure 11.1) qui 
vous permet de vérifier que vous avez choisi le bon fichier. Voir « Lier un fichier d’image » 
ci-dessous pour l’utilisation de l’option Lier.

 4) Cliquez sur Ouvrir.

Figure 11.1 : La boîte de dialogue Insérer une image.
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Remarque

Si vous avez coché l’option Lier, une boîte de message apparaît quand vous cliquez sur Ou-
vrir pour vous demander si vous ne préférez pas incorporer l’image. Cliquez sur Conserver 
le lien si vous désirez la lier ou sinon sur Incorporer l’image. Pour éviter que ce message 
ne réapparaisse, vous pouvez décocher l’option Demander lors de l’ajout d’un lien à une 
image en bas de la boîte de message.

Insérer une image du presse-papier

Grâce au presse-papier, vous pouvez copier, dans un document de LibreOffice, des images prove-
nant d’un autre document de LibreOffice ou d’autres programmes. Pour cela :

 1) Ouvrez à la fois le document source et le document cible.

 2) Dans le document source, sélectionnez l’image à copier.

 3) Appuyez sur Ctrl+C (ou faites un clic droit et choisissez Copier dans le menu contextuel) 
pour copier l’image dans le presse-papier.

 4) Passez au document cible.

 5) Cliquez pour positionner le curseur à l’endroit où l’image doit être insérée.

 6) Appuyez sur Ctrl+V (ou faites un clic droit et choisissez Coller dans le menu contextuel) 
pour insérer l’image.

! Attention

Si l’application à partir de laquelle l’image est copiée est fermée avant que l’image soit col-
lée dans la cible, il se peut que l’image stockée dans le presse-papier soit perdue.

Lier un fichier d’image

Si l’option Lier est cochée dans la boîte de dialogue Insérer une image, LibreOffice crée un lien 
vers le fichier qui contient l’image au lieu d’en enregistrer une copie dans le document. Il en résulte
que l’image s’affiche dans le document mais, quand on enregistre celui-ci, il ne contient qu’une ré-
férence au fichier image et non l’image elle-même. Le document et l’image restent deux fichiers 
séparés qui ne sont fusionnés qu’au moment où vous ouvrez le document.

Lier une image présente deux avantages et un inconvénient.

• Avantage  : la liaison peut réduire la taille du document enregistré, car le fichier image n’est 
pas lui-même inclus. La taille du fichier n’est normalement plus un problème sur les ordina-
teurs modernes qui possèdent une quantité raisonnable de mémoire, à moins que le docu-
ment ne comporte beaucoup de grands fichiers images : LibreOffice sait en gérer d’assez 
grande taille.

• Avantage  : vous pouvez modifier le fichier image séparément sans changer le document, 
car le lien vers le fichier reste valide et l’image modifiée apparaîtra la prochaine fois que vous
ouvrirez le document. Cela peut constituer un gros avantage si vous (ou quelqu’un d’autre, 
peut-être un artiste en graphisme) mettez à jour les images.

• Inconvénient : Si vous envoyez le document à quelqu’un d’autre, ou si vous le déplacez 
vers un autre ordinateur, vous devez aussi envoyer les fichiers d’images ou celui qui recevra 
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le document ne pourra pas voir les images liées. Vous devez garder la trace de l’emplace-
ment des images et vous assurez que celui qui les recevra sait où les mettre sur sa machine 
pour que le document les retrouve. Par exemple, vous devez placer les images dans un 
sous-dossier appelé Images (dans le dossier qui contient le document) ; le destinataire du fi-
chier devra mettre les images dans un sous-dossier de même nom et au même emplace-
ment par rapport au document.

Remarque

Quand vous insérez plusieurs fois la même image dans un document, LibreOffice n’incor-
pore qu’une seule copie du fichier d’image dans le document.

Incorporer des images liées

Si vous avez initialement lié des images, vous pouvez facilement en incorporer une ou plusieurs 
par la suite si vous le désirez. Pour cela :

 1) Ouvrez le document dans LibreOffice et sélectionnez Édition > Liens…

 2) La boîte de dialogue Éditer les liens (Figure 11.2) montre tous les fichiers liés. Dans la liste 
Fichier source, sélectionnez ceux que vous voulez faire passer de l’état lié à l’état incorporé.

 3) Cliquez sur le bouton Déconnecter, puis sur OK dans le message de confirmation

Remarque

La transformation dans l’autre sens, de l’état incorporé à l’état lié, n’est pas aussi simple : 
vous devez effacer et réinsérer chaque image, une par une, en cochant l’option Lier pour 
chacune.

Figure 11.2 : La boîte de dialogue Éditer les liens.
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Insérer une image avec un scanner

Si un scanner est connecté à votre ordinateur, LibreOffice peut appeler l’application du scanner et 
insérer l’élément scanné dans le document en tant qu’image. Pour commencer, placez le curseur à
l’endroit où vous désirez insérer l’image et sélectionnez le menu Insertion > Média > Scanner > 
Sélectionner la source. Sélectionnez le scanner dans la liste qui présente tous les appareils dis-
ponibles. Après ce choix, sélectionnez le menu Insertion > Média > Scanner > Acquérir… Cette 
action ouvre le logiciel d’acquisition d’image qui vous permet d’ajuster les réglages de qualité, de 
taille et autres paramètres de votre image. Quand vous quittez ce logiciel, l’image scannée est 
transmise à LibreOffice qui la colle à l’emplacement choisi.

Bien que cette méthode soit simple et rapide, il est peu probable qu’elle produise une image de 
haute qualité et de la taille correcte. Vous pouvez obtenir de meilleurs résultats en transmettant 
l’image scannée à un programme de retouche d’image pour l’améliorer avant d’insérer le résultat 
dans Writer.

Insérer une image de la Galerie

La Galerie (Figure 11.3) offre une façon pratique de grouper des objets réutilisables tels que des 
images et des sons que vous pouvez insérer dans vos documents. Elle est disponible dans tous 
les modules de LibreOffice. Voir « Gérer la Galerie de LibreOffice » page 311. Vous pouvez co-
pier ou lier un objet de la Galerie dans votre document.

Figure 11.3 : La Galerie dans le volet latéral.

Pour insérer un objet :

 1) Ouvrez la Galerie dans le volet latéral, soit en cliquant sur son icône ( ), soit en sélection-
nant le menu Insertion > Média > Galerie.

 2) Choisissez un thème.

 3) Choisissez un objet par un clic unique.

 4) Pour incorporer l’objet dans le document : faites glissez et déposez l’image dans le docu-
ment. Vous pouvez aussi faire un clic droit sur l’objet et sélectionner Insérer dans le menu 
contextuel.
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 5) Pour lier l’objet au document : faites glisser et déposez l’objet dans le document, tout en ap-
puyant sur les touches Maj et Ctrl.

Insérer une image de la Galerie comme arrière-plan

Pour insérer une image comme arrière-plan d’une page ou d’un paragraphe, faites un clic droit sur 
une image de la Galerie et sélectionnez Insérer comme arrière-plan > Page ou Paragraphe.

Modifier, manipuler et positionner des images

Quand vous insérez une image, vous pouvez avoir besoin de la modifier pour l’adapter au docu-
ment. Le placement de l’image par rapport au texte est présenté à la section « Positionner les 
images à l’intérieur du texte » à la page 297. Celle-ci décrit l’utilisation de la barre d’outils Image,
du recadrage ainsi qu’une méthode pour faire pivoter une image.

Writer offre de nombreux outils de travail sur les images. Ils suffisent pour les nécessités quoti-
diennes de la plupart des utilisateurs. Mais, pour des résultats professionnels, il vaut généralement
mieux utiliser un programme de traitement d’image tel que GIMP pour les modifier (par exemple, 
pour recadrer, changer la taille, faire tourner l’image ou en modifier la couleur) puis insérer le résul-
tat dans Writer. GIMP est un programme de traitement d’image open source qui peut être téléchar-
gé à l’adresse https://www.gimp.org/downloads/.

Utiliser la barre d’outils Image

Quand vous insérez une image ou que vous en sélectionnez une déjà présente dans le document, 
la barre d’outils Image apparaît. Vous pouvez la faire afficher constamment (Affichage > Barres 
d’outils > Image) et choisir si elle doit être flottante ou ancrée. Il est aussi possible d’ajouter les 
boutons de manipulation des images de la barre d’outils Image à la barre d’outils Standard. Voir le 
Chapitre 21 Personnaliser Writer, page 571, pour plus d’informations.

Palette Filtre d’image Mode d’image Rogner l’image

Refléter verticalement Refléter horizontalement Pivoter de 90° à gauche

Pivoter de 90° à droite Pivoter Transparence

Barre d’outils Couleur

Inversion Adoucir Augmenter la netteté

Supprimer les interférences Solariser Vieillissement

Poster Pop Art Dessin au fusain

Relief Mosaïque
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Rouge Vert Bleu

Luminosité Contraste Gamma

Figure 11.4 : Les barres d’outils Image, Couleur et Filtre d’image

Deux autres barres d’outils s’ouvrent à partir de celle-ci : la palette d’outils Filtre d’image, qui peut 
être détachée et placée ailleurs dans la fenêtre, et la barre d’outils Couleur qui s’ouvre sous forme 
de barre d’outils flottante.

Grâce à ces trois barres d’outils, vous pouvez appliquer de légères corrections à l’image ou obtenir
des effets spéciaux.

Mode d’image

Vous pouvez transformer une image en couleur en image en niveaux de
gris, en noir et blanc ou en filigrane en sélectionnant l’option voulue dans la
liste déroulante du mode d’image.

Transparence

Modifiez le pourcentage dans le champ Transparence de la barre d’outils 
Image pour rendre l’image plus ou moins transparente. Cela est particulièrement utile quand on 
crée un filigrane ou qu’on place l’image en arrière-plan.

Couleur

Utilisez cette barre d’outils pour modifier individuellement les composantes de couleur RVB (rouge,
vert, bleu) ainsi que la luminosité, le contraste et le gamma de l’image. Si vous n’êtes pas satisfait 
du résultat, vous pouvez appuyer sur Ctrl+Z (ou cliquez sur Édition > Annuler dans la barre de 
menu) pour rétablir les valeurs par défaut.

Filtres d’image

Le Tableau 8 donne une description des filtres disponibles. Le meilleur moyen pour comprendre 
leur action est de les voir agir. Faites des essais avec les différents filtres et divers réglages, en 
n’oubliant pas que vous pouvez annuler les changements en appuyant sur Ctrl+Z ou en sélec-
tionnant Édition > Annuler dans la barre de menu.

Tableau 8 : Les filtres d’image et leurs effets

Icône Nom Effet

Inversion
Inverse les valeurs des couleurs d’une image en couleur et les va-
leurs de luminosité d’une image en niveaux de gris.

Adoucir
Adoucit ou estompe l’image par l’application d’un filtre de basse fré-
quence.

Augmenter la netteté
Augmente la netteté de l’image par l’application d’un filtre de haute 
fréquence.

Supprimer les inter-
férences

Élimine le bruit en appliquant un filtre médian.

Solarisation Ouvre une boîte de dialogue permettant de définir la solarisation, ef-
fet qui donne l’impression d’une lumière trop élevée pendant le dé-
veloppement d’une photo. Les couleurs sont partiellement inver-
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Icône Nom Effet

sées.

Vieillissement
Simule les effets du temps sur l’image. Le filtre peut être appliqué 
plusieurs fois. Une boîte de dialogue permet de moduler l’effet.

Poster Donne à l’image l’apparence d’une peinture en réduisant le nombre 
de couleurs utilisées qui peut être choisi dans une boîte de dia-
logue.

Pop Art Applique un effet Pop Art à l’image.

Dessin au fusain Affiche l’image comme un croquis au fusain. Les contours de 
l’image sont tracés en noir et les couleurs d’origine sont suppri-
mées.

Relief

Affiche une boîte de dialogue permettant de créer des effets de re-
lief. Vous pouvez choisir la position de la source de lumière imagi-
naire qui détermine le type d’ombre créée et l’apparence de l’image 
en relief.

Mosaïque Rassemble de petits groupes de pixels en zones rectangulaires de 
la même couleur. Plus les rectangles sont grands, moins les images
comporteront de détails.

Utilisation de la barre d’outils Formatage et de la boîte de dialogue 
Image

Quand une image est sélectionnée, certains aspects de son apparence peuvent être personnalisés
grâce aux outils de la barre d’outils Formatage et dans la boîte de dialogue qui s’ouvre par un clic 
droit sur l’image en choisissant Propriétés dans le menu contextuel. Il est, par exemple, possible 
de créer une bordure autour de l’image dont vous pouvez choisir le style et la couleur ; vous pou-
vez aussi lui ajouter une ombre (dans l’onglet Bordures de la boîte de dialogue).

Recadrer une image

Si seule une partie de l’image vous intéresse pour illustrer votre document, vous pouvez en rogner 
(couper) certaines parties.

Remarque

Si vous rognez une image dans Writer, celle-ci n’est pas modifiée. Writer se contente de 
masquer certaines parties de l’image sans les couper réellement. Si vous exportez le docu-
ment en HTML, c’est l’image d’origine qui est exportée, pas celle qui a été recadrée.

Avec l’outil Rogner

Nouveau dans LibreOffice 6.0

En plus du recadrage grâce à l’onglet Rogner de la boîte de dialogue Image, il est mainte-
nant possible de recadrer une image de manière interactive.

Pour utiliser cet outil, faites un clic droit sur l’image et choisissez Rogner dans le menu contextuel 
ou cliquez sur le bouton Rogner ( ) de la barre d’outils Image. Des poignées de rognage appa-
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raissent aux coins et au milieu des côtés de l’image (voir Figure 11.5). Tirez une poignée pour éli-
miner une partie de l’image. Cliquez hors de l’image pour faire cesser le mode rognage.

Figure 11.5 : Poignées de rognages sur une image.

Avec l’onglet Rogner de la boîte de dialogue Image

Pour recadrer une image, faites un clic droit sur celle-ci et choisissez Propriétés dans le menu 
contextuel. Dans la boîte de dialogue Image, ouvrez l’onglet Rogner.

Les unités qui s’affichent dans l’onglet Rogner sont celles qui sont définies dans la page 
LibreOffice Writer – Général de la boîte de dialogue Options (Outils > Options).

Deux options sont disponibles dans la section Rogner pour recadrer une image : Conserver 
l’échelle et Conserver la taille de l’image.

Figure 11.6 : Taille de l’image résultant d’un rognage conservant l’échelle.
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La Figure 11.6 montre que, à mesure que les champs Gauche, Droite, Haut et Bas sont modifiés, 
les limites de l’image dans la boîte d’aperçu changent pour refléter la surface de l’image qui sera 
recadrée.

Si l’option Conserver l’échelle est cochée, comme sur la Figure 11.6, il en résulte un changement 
de taille qui est reflété par les champs Largeur et Hauteur de la section Taille de l’image mais les 
proportions sont conservées.

Si l’option Conserver la taille de l’image est cochée, comme sur la Figure 11.7, c’est l’échelle qui 
change, ce qui modifie les champs Largeur et Hauteur de la section Échelle.

! Attention

Dans ce cas, l’image peut être déformée.

La taille de l’image d’origine est indiquée au-dessus du bouton Taille d’origine.

Figure 11.7 : Changement d’échelle de l’image résultant d’un rognage préservant la taille.

Changer les dimensions d’une image

Vous devrez peut-être changer les dimensions de l’image pour qu’elle s’adapte parfaitement à 
votre document. Writer offre de nombreuses méthodes pour faire cela.

Une manière rapide et facile pour modifier les dimensions consiste à faire glisser les poignées de 
redimensionnement de l’image :

 1) Cliquez sur l’image, si nécessaire, pour faire apparaître les poignées vertes de redimension-
nement.

 2) Placer le pointeur de la souris au-dessus d’une des poignées. Il change de forme et offre une
représentation imagée de la direction du changement de dimension.

 3) Cliquez et tirez pour modifier la taille de l’image.

 4) Relâchez le bouton de la souris quand vous êtes satisfait de la nouvelle dimension.
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Conseil
Les poignées de coin permettent de modifier simultanément la largeur et la hauteur de 
l’image en conservant les proportions initiales ; pour ne pas les conserver, appuyez sur la 
touche Maj en tirant la poignée.

Les poignées de côté ne changent qu’une dimension à la fois. Pour conserver les propor-
tions initiales de l’image, maintenez la touche Maj appuyée en tirant une de ces poignées.

Pour une plus grande précision dans les dimensions des images, utilisez soit l’onglet Rogner (Fi-
gure 11.6 et Figure 11.7) ou l’onglet Type de la boîte de dialogue Image.

Dans l’onglet Rogner, vous pouvez effectuer les réglages suivants :

• section Échelle Largeur et Hauteur : précisez le pourcentage d’agrandissement (> 100 %) 
ou de réduction (< 100 %) de l’image. La taille de l’image est modifiée en conséquence. Pour
que l’image ne soit pas déformée, les deux valeurs doivent être identiques ;

• section Taille de l’image : précisez la taille de l’image dans les unités de mesure que vous 
avez paramétrées. L’image grandit ou se réduit en conséquence ;

• bouton Taille d’origine : rétablit l’image à ses dimensions initiales quand vous cliquez sur 
lui. Les dimensions seront celles après prise en compte du rognage.

Dans l’onglet Type, cochez ou décochez l’option Relatif à pour alterner entre les pourcentages et 
les dimensions effectives. Pour une image non déformée, cochez l’option Conserver le ratio. Cli-
quez sur le bouton Taille d’origine rétablit les dimensions initiales de l’image mais les dimensions 
relatives sont modifiées si l’image a été rognée.

Faire pivoter une image

Pour faire tourner une image de 90 ou 180 degrés ou la retourner verticalement ou horizontale-
ment, faites un clic droit sur celle-ci et choisissez Pivoter, Tourner ou Refléter dans le menu 
contextuel.

Vous pouvez aussi utiliser les boutons de la barre d’outils Image :  pour faire pivoter l’image de 
90° vers la droite,  pour la faire pivoter de 90° vers la gauche,  pour la refléter horizontale-
ment et  pour la refléter verticalement.

Figure 11.8 : Faire pivoter ou retourner rapidement une image.
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De manière interactive

Nouveau dans LibreOffice 6.0

Les versions précédentes de Writer n’offraient aucun moyen direct d’utiliser d’autres angles 
de rotation. Depuis la version 6, il est possible de faire tourner l’image d’un angle quel-
conque soit de manière interactive, soit grâce à l’onglet Image de la boîte de dialogue 
Image.

Sélectionnez l’image et cliquez sur le bouton Pivoter ( ) de la barre d’outils Image. Les poignées
de rotation apparaissent autour de l’objet. Approchez le pointeur de la souris d’une poignée ; 
quand il change de forme, cliquez et tirez pour faire pivoter la figure à l’angle désiré.

Figure 11.9 : Rotation interactive d’une image.

Remarque

La rotation s’effectue par paliers de 15°. Pour faire tourner la figure d’un angle quelconque, 
appuyez sur la touche Maj en tirant la souris.

Conseil

 

Figure 11.10 : Image immédiatement après la rotation et après agrandissement du cadre
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Après rotation, l’image est coupée, car les dimensions du cadre ne sont pas modifiées. Si 
vous voulez retrouver l’image entière, utilisez la fonction Rogner (!) avec des valeurs néga-
tives pour agrandir les dimensions du cadre et retrouver l’image dans sa totalité.

Avec la boîte de dialogue Image

Faites un clic droit sur l’image et choisissez Propriétés… dans le menu contextuel. Ouvrez l’onglet
Image. Dans le champ Angle de rotation, spécifiez l’angle désiré.

Autres paramètres

La boîte de dialogue Image possède dix onglets. L’onglet Rogner a été décrit à la page 287 ; les 
onglets Type et Adapter sont expliqués dans « Positionner les images à l’intérieur du texte » à 
la page 297. Les autres ont les fonctions suivantes :

• l’onglet Options permet de donner un nom significatif à l’image (qui apparaîtra dans le Navi-
gateur), d’afficher un texte alternatif quand la souris survole l’image dans un navigateur web, 
de protéger certains paramètres de l’image contre les modifications accidentelles et d’éviter 
qu’elle soit imprimée ;

• l’onglet Bordures offre la possibilité de créer des bordures autour de l’image. L’onglet est le 
même que celui utilisé pour les bordures des tableaux ou des paragraphes. Vous pouvez 
aussi ajouter une ombre à l’image si vous le souhaitez ;

• dans l’onglet Arrière-plan vous pouvez changer la couleur de fond de l’image. Ce paramètre
ne produit le résultat désiré qu’avec des images qui possèdent une couleur transparente ;

• l’onglet Hyperlien vous permet d’associer un hyperlien à l’image ou créer une image map 
(voir page 309) ;

• l’onglet Image vous donne le moyen de retourner l’image, de la faire pivoter et d’afficher 
l’emplacement du fichier dans le cas où elle est liée plutôt qu’incorporée.

• Dans l’onglet Transparence vous définirez les options de transparence de l’image ;

• l’onglet Macro donne l’occasion d’associer une macro à l’image. Vous pouvez choisir parmi 
les macros prédéfinies ou écrire les vôtres.

Supprimer une image

Pour supprimer une image, cliquez sur celle-ci pour faire apparaître les poignées vertes puis ap-
puyez sur la touche Suppr.

Exporter des images

Si vous devez faire des ajustements complexes à l’image ou si vous désirez l’enregistrer pour l’uti-
liser dans un autre document, vous pouvez l’exporter directement depuis celui où elle se trouve. 
Faites un clic droit sur l’image pour la sélectionner et ouvrir le menu contextuel, puis choisissez 
Enregistrer… dans celui-ci pour ouvrir la boîte de dialogue Export d’image. Selon le format initial 
de l’image, Writer vous propose de nombreux formats différents pour l’enregistrer. Donnez un nom 
à votre image, choisissez le format qui vous convient dans la liste Type de fichier puis cliquez sur 
Enregistrer.
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Enregistrer les images modifiées

Nouveau dans LibreOffice 6.0

Il est désormais possible d’enregistrer l’image d’origine ou la version que vous avez modi-
fiée.

Dans les versions précédentes de LibreOffice, si vous enregistriez une image incorporée (en choi-
sissant Enregistrer… dans le menu contextuel après un clic droit), l’image sauvegardée était celle
d’origine : les modifications telles que les rotations, rognages et effets de couleur n’étaient pas in-
corporées à l’image enregistrée.

Depuis LibreOffice 6, vous pouvez choisir d’enregistrer soit l’image d’origine, soit l’image modifiée 
grâce à une boîte de dialogue qui s’ouvre quand vous sélectionnez Enregistrer…

Figure 11.11 : boîte de dialogue qui permet de choisir la version de l’image à enregistrer

Compresser des images

Si vous insérez une image de grande taille dans votre document avant d’en modifier les dimen-
sions pour l’adapter à la disposition de la page, la totalité de l’image est stockée dans le fichier du 
document pour préserver son contenu. Il en résulte un gros fichier à stocker ou à envoyer par 
courriel.

Figure 11.12 : La boîte de dialogue Compresser l’image.
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Si vous pouvez accepter une certaine perte de qualité dans le rendu de l’image, vous pouvez com-
presser ou modifier les dimensions de l’objet image pour en réduire le volume de données tout en 
préservant sa position dans la disposition de la page.

Faites un clic droit sur l’image pour ouvrir le menu contextuel, puis choisissez Compresser… pour
ouvrir la boîte de dialogue Compresser l’image (Figure 11.12). Remarquez que le bouton Calculer 
actualise les informations sur l’image après chaque modification des paramètres. Cliquez sur OK 
pour appliquer les paramètres de compression. Si le résultat ne vous convient pas, appuyez sur 
Ctrl+Z pour annuler l’opération et choisir d’autres réglages. Voir l’Aide pour plus d’informations.

Utiliser les outils de dessin de Writer

Writer possède des outils de dessin qui vous permettent de créer des illustrations comme des dia-
grammes simples constitués de rectangles, de lignes, de texte et d’autres formes prédéfinies. Vous
pouvez aussi grouper plusieurs figures pour qu’ils conservent leurs emplacements et leurs propor-
tions relatives.

Vous pouvez placer les objets dessinés directement sur une page de votre document ou les insé-
rer dans un cadre.

Vous pouvez aussi vous en servir pour annoter des photographies, des captures d’écran ou 
d’autres illustrations produites par d’autres programmes mais cela n’est pas recommandé, car :

• comme il n’est pas possible d’inclure des images dans un groupe d’objets de dessin, elles 
peuvent ne pas rester alignées dans votre document ;

• si un document est converti dans un autre format, comme HTML, les objets de dessin et les 
images ne resteront pas associés : ils seront enregistrés séparément.

D’une manière générale, si vous devez créer des figures complexes, il est recommandé d’utiliser 
LibreOffice Draw qui possède plus de fonctions telles que les couches, les styles, etc.

Créer des objets de dessin

Pour commencer à utiliser les outils de dessin, affichez la barre d’outils Dessin (Figure 11.13) en 
cliquant sur Affichage > Barres d’outils > Dessin. Si vous envisagez d’utiliser régulièrement les 
outils de dessin, vous pouvez détacher la barre d’outils et la placer à un emplacement pratique sur 
la fenêtre.

Sélectionner Insérer une ligne Lignes et flèches Courbes à main levée

Courbe Polygone Rectangle Rectangle coins arrondis

Carré Ellipse Cercle Triangle isocèle

Triangle rectangle Formes de base Symboles Flèches

Étoiles Bulles Organigrammes Légende

Zone de texte Fontwork Éditer points Extrusion

Figure 11.13 : La barre d’outils Dessin

Pour utiliser un outil de dessin :
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 1) Cliquez dans le document à l’endroit où vous voulez ancrer le dessin. Vous pouvez modifier 
l’ancrage plus tard si nécessaire.

 2) Choisissez un outil dans la barre d’outils Dessin (Figure 11.13). Le pointeur de la souris 
change selon la fonction de dessin choisie pour ressembler à celui-ci pour l’outil rectangle :

. La barre d’outils Propriétés de l’objet de dessin (Figure 11.14) s’ouvre (par défaut à la 
place de la barre d’outils Formatage).

 3) Déplacer la mire du pointeur à l’endroit du document où vous voulez voir apparaître le dessin
puis cliquez et tirez pour créer l’objet. Relâchez le bouton de la souris. La fonction sélection-
née reste active pour que vous puissiez dessiner un autre objet du même type.

 4) Pour désélectionner l’outil, appuyez sur la touche Échap ou cliquez sur l’icône Sélectionner 
( ) de la barre d’outils Dessin.

 5) Vous pouvez alors modifier les propriétés (couleur de remplissage, type et épaisseur de 
ligne, ancrage, etc.) de l’objet de dessin en utilisant : soit la barre d’outils Propriétés de l’ob-
jet de dessin (Figure 11.14), soit les choix et les boîtes de dialogue auxquels vous accédez 
par un clic droit sur cet objet, soit par l’onglet Propriétés du volet latéral.

Définir ou modifier les propriétés des objets de dessin

Pour définir les propriétés d’un dessin avant de le tracer :

 1) Dans la barre d’outils Dessin (Figure 11.13), cliquez sur l’outil Sélectionner ( ).

 2) Dans la barre d’outils Propriétés de l’objet de dessin (Figure 11.14), cliquez sur les icônes 
des propriétés et choisissez les valeurs que vous désirez pour celles-ci.

 3) Pour un meilleur contrôle, ou pour définir de nouveaux attributs, vous pouvez cliquer sur les 
icônes Remplissage et Ligne pour ouvrir des boîtes de dialogue détaillées.

Couleur de ligne Style d’extrémités Style de ligne

Largeur de ligne Style de remplissage Couleur de remplissage

Ancrage Renvoi total Adapter deux côtés Renvoi dynamique

Adapter à gauche Adapter à droite Adapter en fond Pivoter

Aligner À l’avant Vers l’avant Vers l’arrière

À l’arrière Au premier plan À l’arrière-plan Grouper

Entrer dans le groupe Quitter le groupe Dissocier Insérer une légende

Figure 11.14 : Barre d’outils Propriétés de l’objet de dessin.

Les valeurs par défaut que vous définissez s’appliquent au document et à la session en cours. 
Elles ne sont pas enregistrées quand vous fermez le document ou Writer et elles ne s’appliquent 
pas à un autre document que vous ouvrez. Elles s’appliquent à tous les objets de dessin sauf les 
objets de texte.

Pour modifier les propriétés d’un objet de dessin existant, sélectionnez l’objet puis continuez 
comme décrit ci-dessus.
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Vous pouvez aussi spécifier la position et la taille, la rotation et l’inclinaison ainsi que le rayon des 
sommets de l’objet de dessin : faites un clic droit sur l’objet et choisissez Position et taille dans le 
menu contextuel. Modifiez les propriétés comme vous le désirez.

Modifier les dimensions d’un objet de dessin

On modifie les dimensions d’un objet de la même manière que celles d’une image. Sélectionnez 
l’objet, cliquez sur l’une des huit poignées qui l’entourent et faites-la glisser jusqu’à sa nouvelle 
taille.

Les proportions de l’objet ne sont pas préservées. Pour les préserver, maintenez la touche Maj 
appuyée pendant le changement de dimensions.

Pour un contrôle plus précis de la taille de l’objet, sélectionnez Position et taille dans le menu 
contextuel ou Format > Zone de texte et forme > Position et taille dans le menu principal. Si 
l’option Conserver le ratio est cochée, les deux dimensions changent mais la proportion est main-
tenue ce qui produit un changement d’échelle.

Grouper des objets de dessin

Le groupement d’objets de dessin facilite la manipulation de plusieurs objets sous forme d’une en-
tité unique tout en préservant leurs tailles et positions relatives. Quand des objets sont groupés, 
toute opération d’édition appliquée au groupe s’applique à tous ses membres. Si vous cliquez sur 
un de ceux-ci, tout le groupe est sélectionné.

Pour grouper des objets de dessin :

 1) Sélectionnez un objet puis maintenez la touche Maj appuyée en sélectionnant les autres ob-
jets que vous désirez inclure dans le groupe. La boîte de délimitation s’agrandit pour incorpo-
rer tous les objets sélectionnés.

 2) Quand les objets sont sélectionnés, sélectionnez le menu Format > Groupe > Grouper 
dans la barre de Menu, cliquez sur le bouton Grouper ( ) de la barre d’outils Propriétés de 
l’objet de dessin ou faites un clic droit sur un objet sélectionné et choisissez Groupe > Grou-
per dans le menu contextuel.

Remarque

On ne peut pas inclure une image incorporée ou liée dans un groupe avec des objets de 
dessin.

Il est possible de modifier un membre particulier d’un groupe sans défaire celui-ci. Sélectionnez le 
groupe puis choisissez Format > Groupe > Entrer dans le groupe dans la barre de menu ou cli-
quez sur le bouton Entrer dans le groupe ( ) de la barre d’outils Propriétés de l’objet de dessin 
ou faites un clic droit sur le groupe et choisissez Groupe > Entrer dans le groupe dans le menu 
contextuel. Quand vous avez terminé les modifications de l’objet, sélectionnez Format > Groupe >
Quitter le groupe dans la barre de menu, cliquez sur le bouton Quitter le groupe ( ) de la barre
d’outils Propriétés de l’objet de dessin ou choisissez Groupe > Quitter le groupe dans le menu 
contextuel.

Pour défaire un groupe d’objets, sélectionnez-le puis choisissez Format > Groupe > Dissocier 
dans la barre de menu, cliquez sur le bouton Dissocier ( ) dans la barre d’outils Propriétés de 
l’objet de dessin ou faites un clic droit et choisissez Groupe > Dissocier dans le menu contextuel.
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Conseil

Il est recommandé de préparer son dessin dans Draw avant de le copier puis de le coller 
dans Writer, ou de l’enregistrer dans la Galerie. Cela permet de bénéficier d’outils plus nom-
breux.

Faire pivoter des objets de dessin

Vous pouvez faire pivoter un objet de dessin d’une façon semblable à celle employée pour les 
images (page 290). Pour faire tourner un objet de dessin de l’angle souhaité, utilisez une des mé-
thodes suivantes :

De manière interactive

Sélectionnez l’objet et cliquez sur l’icône Pivoter ( ) dans la barre d’outils Propriétés de l’objet 
de dessin. Des poignées de rotation apparaissent autour de l’objet. Approchez le pointeur de la 
souris de l’une d’elles, quand il change de forme, cliquez et tirez-le jusqu’à l’angle désiré.

Remarque
L’angle de rotation est quelconque. Pour faire tourner le dessin par paliers de 15°, appuyez 
sur la touche Maj en tirant la souris.

Le centre de rotation apparaît initialement au centre géométrique des poignées mais vous 
pouvez le déplacer à votre guise, même hors de la figure.

Avec la boîte de dialogue Position et taille.

Faites un clic droit sur l’objet et choisissez Position et taille dans le menu contextuel. Dans la 
boîte de dialogue, ouvrez l’onglet Rotation. Dans la section Angle de rotation, saisissez l’angle 
voulu. Par défaut, la rotation s’effectue autour du centre de l’objet, mais vous pouvez spécifier un 
centre de rotation différent dans la section Point de pivot.

Conseil

L’objet de dessin Zone de texte présente un intérêt particulier dans Writer. Le texte ordinaire 
ne peut être pivoté que de 90, 180 ou 270 degrés, comme cela est décrit au Chapitre 9 Tra-
vailler avec les styles, page 243. Mais un objet Zone de texte peut être tourné d’un angle 
quelconque.

Positionner les images à l’intérieur du texte

Quand vous ajoutez une image à un document texte, vous devez choisir sa position par rapport au
texte et aux autres images. Le placement des images prend souvent du temps et peut se révéler 
très frustrant tant pour les utilisateurs expérimentés que pour les débutants. Comme Writer est un 
traitement de texte plutôt qu’un logiciel de publication assistée par ordinateur, la souplesse du po-
sitionnement des images présente quelques limitations et il faut un peu de temps pour obtenir 
exactement ce que l’on veut.

Le placement des images est contrôlé par quatre réglages.
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• La disposition se rapporte au positionnement de l’image sur un axe imaginaire perpendicu-
laire à la page sur lequel les images sont empilées les unes au-dessus des autres et au-des-
sus du texte.

• L’alignement se rapporte au positionnement vertical et horizontal de l’image sur la page en 
liaison avec le point d’ancrage choisi.

• L’ancrage désigne la position de référence de l’image. Elle peut être la page ou le cadre où 
se trouve l’objet, un paragraphe ou même un caractère. Une image possède toujours un 
point d’ancrage.

• L’adaptation au texte concerne la relation entre l’image et le texte qui l’entoure qui peut être
disposé d’un ou des deux côtés de l’image, apparaître sous l’image texte ou au-dessus de 
celle-ci. L’image peut aussi être traitée comme un paragraphe ou un caractère à part entière.

Ces réglages sont accessibles de nombreuses façons selon la nature de l’image.

• Depuis le menu Format, où vous trouverez Ancre, Adaptation du texte et Positionner (à la
fois pour les images et les objets de dessin).

• Depuis le menu contextuel qui s’ouvre par un clic droit sur la figure ; celui-ci offre aussi une 
entrée Alignement.

• Pour les images, dans les onglets Type et Adapter de la boîte de dialogue Image. Notez que 
vous ne pouvez pas contrôler la disposition avec cette boîte de dialogue. Pour l’ouvrir, cli-
quez sur l’image pour la sélectionner et choisissez Format > Images > Propriétés ou faites 
un clic droit ssur l’image et choisissez Propriétés dans le menu contextuel.

• Pour les objets de dessin, dans la page Position et taille de la boîte de dialogue de même 
nom. Pour ouvrir celle-ci, faites un clic droit sur l’objet dessiné et choisissez Position et 
taille dans le menu contextuel.

• Pour un objet incorporé (comme un classeur de Calc ou un document de Draw), depuis la 
barre d’outils Objet OLE.

Remarque

Bien que toutes les techniques de placement présentées dans cette section s’appliquent 
également aux cadres, l’adaptation au contour n’est pas possible pour ceux-ci.

Disposer les images

Disposer (ou positionner) une image signifie déterminer sa position par rapport aux autres images 
et au texte dans la pile des objets déposés sur la page. La disposition n’intéresse que les objets 
qui se chevauchent. Vous avez le choix entre quatre réglages communs à toutes les figures plus 
un cinquième particulier aux objets de dessin.

Envoyer à l’avant

Place l’image au-dessus des autres images et du texte.

Vers l’avant

Fait monter l’image d’un niveau sur la pile (l’axe z). Selon le nombre d’objets qui se che-
vauchent, il faudra peut-être appliquer cette fonction plusieurs fois pour obtenir le résultat 
souhaité.
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Vers l’arrière

Fait descendre l’image d’un niveau sur la pile.

Envoyer à l’arrière

Place l’image à la base de la pile.

Au premier plan / À l’arrière-plan

Uniquement pour les objets de dessin : place l’objet de dessin respectivement devant et der-
rière le texte.

Conseil

Pour sélectionner un objet qui est recouvert par d’autres, appuyez sur la touche 
Tabulation pour parcourir les objets jusqu’à ce que vous ayez atteint celui que vous vou-
lez (Alt+clic peut aussi fonctionner sous Windows).

Ancrer des images

Vous pouvez ancrer une figure comme un caractère ou à une page, un paragraphe ou un carac-
tère. Vous pouvez aussi la placer dans un cadre et ancrer celui-ci à une page, un paragraphe ou 
un caractère. La méthode choisie dépend du résultat que l’on désire obtenir.

À la page

La figure conserve la même position par rapport aux marges de la page. Elle ne bouge pas 
quand vous ajoutez ou supprimez du texte. Cette méthode est pratique quand la figure n’a 
pas à être visuellement associée à un élément de texte particulier. Elle est souvent utilisée 
pour produire des lettres d’information ou d’autres documents qui ont une mise en page com-
plexe ou pour positionner le logo dans l’en-tête d’une lettre.

! Attention

Si vous avez l’intention d’utiliser un document comme document maître, n’ancrez pas les 
images à la page, car elles disparaîtraient du document maître. Voir le Chapitre 16 Les do-
cuments maîtres, page 466, pour plus d’informations.

Au paragraphe

La figure est associée à un paragraphe et suit ses déplacements. Elle peut être placée en 
marge ou à un autre endroit. Cette méthode est une alternative utile à un tableau pour placer
une icône à côté d’un paragraphe.

Au caractère

La figure est associée à un caractère, mais elle n’est pas placée dans la suite de texte. Elle 
suit les déplacements du caractère mais peut être placée en marge ou à un autre endroit. 
Cette méthode est semblable à l’ancrage au paragraphe.

Comme caractère

La figure est placée dans le document comme un caractère quelconque et elle affecte donc 
la hauteur de la ligne de texte et les retours à la ligne. Elle se déplace avec le paragraphe 
quand vous ajoutez ou supprimez du texte avant celui-ci. Cette méthode est utile pour 
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conserver une capture d’écran dans une procédure (en l’ancrant comme caractère dans un 
paragraphe vide) ou pour insérer une petite icône dans une phrase.

Au cadre

Si la figure a été placée dans un cadre, il est possible de l’ancrer à une position fixe à l’inté-
rieur de celui-ci. Le cadre lui-même peut être ancré à la page, au paragraphe ou au carac-
tère selon nécessité.

Aligner les images

Quand vous avez défini le point d’ancrage de la figure, vous pouvez choisir sa position par rapport 
à celle-ci : on appelle cela aligner les images. Vous avez le choix parmi six options : trois pour ali-
gner la figure horizontalement (gauche, centre, droite) et trois pour l’aligner verticalement (haut, 
centre, bas). L’alignement horizontal n’est pas disponible pour les images ancrées Comme carac-
tère.

Pour un contrôle plus précis de l’alignement, utilisez les options de la section Position de la page 
Type de la boîte de dialogue Image, visible sur la Figure 11.15

Figure 11.15 : Positionnement précis d’une image.

Tant pour la position horizontale que pour la verticale, commencez sélectionnez le point de réfé-
rence dans la liste déroulante de droite, puis choisissez Gauche, Droite ou Centre dans celle de 
gauche. Si vous choisissez la valeur De gauche (ou Du bas pour la position verticale), vous pou-
vez préciser la distance dans l’unité de mesure que vous avez définie pour Writer. Dans l’exemple 
de la Figure 11.15 ; le coin supérieur gauche de l’image est placé à 3 cm de la marge de gauche et
en haut de la page, déduction faite de la marge et de l’en-tête.

Une représentation visuelle de la zone où l’image est ancrée, indiquée par une bordure rouge, est 
donnée dans le panneau d’aperçu en haut à droite de l’onglet. La position de la figure est un rec-
tangle bordé de vert.

Disposer le texte autour de l’image

Le paramétrage de l’adaptation du texte détermine la relation entre le texte et la figure. Plusieurs 
choix sont possibles à partir du sous-menu contextuel Adaptation du texte :

Pas d’adaptation

Avec ce choix, le texte est placé au-dessus et en dessous de l’image mais pas sur les côtés. 
C’est le paramètre utilisé pour la plupart des figures de ce guide.

Renvoi relatif à la page ou Renvoi dynamique à la page

Le texte est disposé autour de l’image. Si on déplace l’image dans la page, le texte est redis-
posé pour remplir l’espace à sa gauche et à sa droite. Le renvoi dynamique à la page évite 
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que le texte soit placé à côté de l’image si l’espace entre celle-ci et la marge est inférieur à 
2 cm.

Adapter à gauche ou Adapter à droite

Le texte est disposé respectivement à gauche ou à droite de l’image, l’autre côté restant 
vide.

Adaptation continue

Superpose l’image au texte. L’image est donc devant le texte. Cette option doit être utilisée 
en conjonction avec le paramétrage de la transparence pour que le texte soit visible à travers
l’image.

À l’arrière-plan

Option semblable à la précédente mais l’image est placée derrière le texte si bien qu’il n’est 
pas forcément nécessaire de changer la transparence pour le rendre visible.

L’adaptation du texte est normalement choisie après l’ancrage et l’alignement de l’image. Pour 
adapter le texte de la manière souhaitée à une image, effectuez les actions suivantes :

 1) Sélectionnez l’image en cliquant sur elle.

 2) Faites un clic droit pour afficher le menu contextuel et survolez Adaptation du texte pour 
faire apparaître les choix disponibles. Vous pouvez aussi sélectionner Format > Adaptation 
du texte dans la barre de menu.

 3) Choisissez l’adaptation du texte qui convient à vos besoins.

Remarque

Quand une image est ancrée comme caractère, le seul choix disponible est d’éditer le 
contour de l’image (voir page 302).

Figure 11.16 : Les options étendues d’adaptation du texte dans la boîte de dialogue Image
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Pour contrôler avec précision les options d’adaptation du texte, ouvrez la boîte de dialogue Image 
à l’onglet Adapter.

Pour les images, cette boîte de dialogue s’ouvre en sélectionnant Format > Image > Propriétés 
dans la barre de menu, ou, après un clic droit, en choisissant Propriétés dans le menu contextuel.
Pour les objets de dessin, une boîte de dialogue Adapter offrant les mêmes fonctions s’ouvre en 
sélectionnant Format > Adaptation du texte > Éditer… dans la barre de menu ou en choisissant 
Adaptation du texte > Éditer… dans le menu contextuel qui s’ouvre par un clic droit.

Cette page est partagée en trois sections. Dans la partie supérieure, vous pouvez choisir les types 
d’adaptation du texte mentionnés plus haut. 

Remarque

Pas d’adaptation dans le sous-menu Adaptation du texte correspond à Aucun(e) dans la 
boîte de dialogue Image. Adapter à gauche correspond à Avant, Adapter à droite à Après,
Renvoi relatif à la page à Parallèle, Renvoi dynamique à la page à Optimal et Adapta-
tion continue à Continu. Pour obtenir l’effet de l’élément de menu À l’arrière-plan, il faut 
sélectionner Continu et cocher À l’arrière-plan dans la boîte de dialogue.

Utilisez la section Espacement pour ajuster l’espace entre l’image et le texte. Le contenu de la 
section Options peut changer selon le format d’adaptation du texte sélectionné.

Premier paragraphe

Cochez cette option si vous désirez que LibreOffice débute un nouveau paragraphe après 
l’image même s’il a encore la place pour le positionner autour de l’image.

À l’arrière-plan

Cette option est accessible si Continu est sélectionné comme paramètre d’adaptation du 
texte et elle place l’image derrière le texte.

Contour

Positionne le texte selon un contour personnalisé au lieu des limites de la figure. Cette option
n’est pas disponible si le paramètre d’adaptation du texte est Aucun(e) ou Continu.

Uniquement à l’extérieur

Oblige le texte à rester positionné à l’extérieur de l’image même si le contour contient une 
surface ouverte à l’intérieur de la forme.

Éditer le contour

Si vous choisissez de disposer le texte autour d’un objet de dessin, LibreOffice crée automatique-
ment un contour. L’option d’édition du contour n’est disponible que pour l’adaptation du texte au-
tour des images. Pour créer un contour, faites un clic droit sur l’image et sélectionnez Adaptation 
du texte > Éditer le contour dans le menu contextuel ou choisissez directement Format > Adap-
tation du texte > Éditer le contour dans la barre de menu.

La boîte de dialogue visible sur la Figure 11.17 s’ouvre sur l’image chargée dans la fenêtre princi-
pale. Les outils vous permettent de dessiner la région de l’image que vous ne voulez pas voir oc-
cupée par le texte : cette zone est ombrée.
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Figure 11.17 : L’éditeur de contour en action avec l’AutoContour

La fenêtre vous propose quatre outils pour éditer le contour de l’image : rectangle, ellipse, poly-
gone et AutoContour. Une certaine expérience des outils de dessin est nécessaire pour créer des 
contours complexes, mais, dans la plupart des cas, une grande précision n’est pas nécessaire. La
Figure 11.17 montre le contour effectivement utilisé pour « Exemple 2 : Disposer le texte selon 
les contours d’une image » à la page 304 en utilisant l’option AutoContour ; la forme de la ligne 
qui entoure la pomme est tout à fait acceptable.

Quand vous avez terminé, cliquez sur le bouton Appliquer ( ) pour enregistrer le contour. Si vous
n’êtes pas satisfait du résultat, vous pouvez sélectionner la ligne de contour et appuyer sur la 
touche Suppr. pour recommencer ou cliquer sur le bouton Zone de travail ( ) puis à l’intérieur 
du contour. Vous pouvez aussi annuler les étapes précédentes ou cliquer sur le bouton Éditer les 
points ( ) pour ajuster la forme du contour point par point. N’oubliez pas que toute la partie de 
l’image qui se trouve hors du contour n’apparaîtra pas dans le document.

Exemple 1 : renvoi relatif à la page

La Figure 11.18 montre un exemple de renvoi relatif à la page.

Pour le réaliser :

 1) Insérez l’image dans le document puis ancrez-la au paragraphe de votre choix. Pour dépla-
cer l’ancrage, sélectionnez l’image ou l’ancre et déplacez-la jusqu’à ce que le symbole de 
l’ancre soit au début du paragraphe choisi.

 2) Alignez l’image pour que son bord gauche soit à l’endroit souhaité. Vous pouvez le faire avec
la souris ou en utilisant les paramètres de l’onglet Type de la boîte de dialogue Image.
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 3) Modifiez l’adaptation du texte pour un renvoi relatif à la page. Nous désirons maintenant aug-
menter l’espace entre le texte et l’image. Pour cela, ouvrez l’onglet Adapter de la boîte de 
dialogue Image et donnez une valeur de 0,2 cm à l’Espacement des quatre côtés.

 4) La touche finale consiste à modifier la position de l’image pour avoir, au-dessus d’elle, le 
nombre de lignes de texte voulu. Vous pouvez, ici aussi, utiliser la souris pour déplacer 
l’image ou les paramètres de l’onglet Type de la boîte de dialogue Image, ce qui demandera 
quelques essais. Le déplacement avec la souris est la méthode la plus simple.

Paramètres de base Après espacement du texte

Figure 11.18 : Exemples d’image avec renvoi du texte relatif à la page.

Exemple 2 : Disposer le texte selon les contours d’une image

Dans cet exemple, nous allons encore appliquer un renvoi relatif à la page comme dans l’exemple 
précédent, mais cette fois en activant l’option Contour. Nous allons travailler avec une image et un 
objet de dessin car cette option fonctionne de façon légèrement différente dans chaque cas.

Pour reproduire l’exemple de la Figure 11.19, effectuez les actions suivantes :

 1) Saisissez du texte.

 2) Insérez une image de votre choix et ancrez-la au premier paragraphe. Ajustez l’alignement 
comme vous le souhaitez puis changez l’adaptation du texte en Renvoi relatif à la page.

 3) Faites un clic droit sur l’image et sélectionnez Adaptation du texte > Éditer le contour 
dans le menu contextuel.

 4) Utilisez la méthode présentée dans la section « Éditer le contour », page 302, pour créer 
un contour qui vous convient puis cliquez sur le bouton Appliquer. Si nécessaire, ajustez l’es-
pacement entre le bord de l’image et le texte en utilisant les options de l’onglet Adapter de la 
boîte de dialogue Image.

 5) Insérez une forme de votre choix (par exemple, un triangle) et procédez comme à l’étape 2 
ci-dessus.

 6) Activez le renvoi suivant le contour en sélectionnant Format > Adaptation du texte > 
Contour dans la barre de menu. Comme indiqué précédemment, LibreOffice génère le 
contour automatiquement. Vous aurez peut-être besoin de régler la distance entre l’objet et 
le texte grâce à Format > Adaptation du texte > Éditer.
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Figure 11.19 : Renvoi du texte suivant le contour d’une image et d’un objet

Exemple 3 : Adaptation continue et en arrière-plan

Cet exemple montre comment utiliser une image comme filigrane en laissant le texte se superpo-
ser à elle et en ajustant sa transparence. Ce n’est pas la meilleure manière pour créer un filigrane 
et elle n’est présentée ici qu’à titre d’illustration. Si vous avez besoin de créer un filigrane, mieux 
vaut utiliser un objet de Fontworks disposé en arrière-plan et, si possible, incorporé à un style de 
page.

Quand vous sélectionnez l’option Adaptation continue pour l’image insérée, elle se superpose au 
texte et le masque. Pour le faire apparaître, changez la transparence de l’image ; bien que les 
mots sous l’image réapparaissent, ils peuvent être difficiles à lire et apparaître plus clairs que le 
reste du texte.

Pour reproduire l’exemple de la Figure 11.20, créez un texte quelconque, insérez l’image de votre 
choix, ancrez-la (par exemple à la page) et sélectionnez l’adaptation du texte en continu dans le 
menu Format > Adaptation du texte ou, après un clic droit sur l’image, en sélectionnant Adapta-
tion du texte > Adaptation continue dans le menu contextuel. Déplacez l’image à la position dé-
sirée. La barre d’outils Image devrait être affichée quand l’image est sélectionnée. Changez la 
transparence pour une valeur convenable (50 % dans l’exemple) pour que le texte puisse être lu.

Figure 11.20 : À gauche, image transparente ajoutée sur un texte. À droite, l’image est en arrière-
plan.
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Vous pouvez obtenir un meilleur résultat en cochant l’option À l’arrière-plan, comme dans l’image 
de droite de la Figure 11.20. Le texte gagne en lisibilité et les caractères au-dessus de l’image 
conservent leur intensité tant que l’arrière-plan n’est pas trop foncé. La transparence de l’image 
devra peut-être quand même être ajustée.

Ajouter des légendes aux images

Il existe trois façons d’ajouter des légendes aux images : automatiquement, grâce à la boîte de 
dialogue Insérer une légende ou manuellement.

Ajout automatique de légendes

Vous pouvez paramétrer LibreOffice pour qu’il ajoute automatiquement des légendes quand vous 
insérez une image, un tableau ou d’autres objets dans un document. Vous pouvez choisir les ob-
jets qui recevront automatiquement une légende, le nom de catégorie qui sera attribué aux objets 
de la série (par exemple, « Tableau » ou « Illustration ») et la position de la légende.

Pour paramétrer les légendes automatiques :

 1) Ouvrez la page LibreOffice Writer – Légendes automatiques de la boîte de dialogue Options 
en cliquant sur Outils > Options.

 2) Plusieurs choix s’offrent à vous pour les objets qui doivent recevoir automatiquement une lé-
gende (à gauche) et pour les caractéristiques de cette légende (à droite).

Quand vous insérez une image, si la légende automatique est activée, la figure est placée dans un
cadre avec une légende constituée du nom de catégorie par défaut des images (« Illustration »). 
Placez le curseur dans la ligne du titre et tapez le texte de la légende. Vous pouvez modifier le 
nom de la catégorie en le sélectionnant dans la liste déroulante Catégorie ou en tapant celui qui 
vous convient dans la zone de saisie.

Un nom courant de catégorie, « Figure », n’est pas parmi ceux qui sont proposés : <Aucun>, Illus-
tration, Tableau, Texte et Dessin. Si vous désirez utiliser le mot « Figure », ou tout autre choix per-
sonnel, pour désigner les images, faites ceci :

 1) Ouvrez l’onglet Légendes automatiques de la boîte de dialogue Options.

 2) Dans la section Ajouter des légendes automatiquement lors de l’insertion de, cochez 
Image LibreOffice Writer. Cela active la zone de saisie et la liste déroulante Catégorie.

 3) Dans la zone de saisie, tapez le nom que vous désirez ajouter (par exemple, « Figure ») en 
remplaçant celui qui s’y trouve. Celui-ci ne sera pas supprimé de la liste. Vous pouvez aussi 
en profiter pour paramétrer quelques options concernant le style des numéros et la sépara-
tion entre le nom et ceux-ci. Cliquez sur OK pour enregistrer les modifications.

Ajout de légendes grâce à la boîte de dialogue

Pour ajouter des légendes grâce à la boîte de dialogue :

 1) Insérez la figure puis faites un clic droit sur celle-ci et sélectionnez Insérer une légende… 
dans le menu contextuel, ou sélectionnez la figure et choisissez Insertion > Légende… 
dans la barre de menu.

 2) Dans la boîte de dialogue Insérer une légende (Figure 11.21), choisissez votre catégorie, 
votre type de numérotation et le séparateur (ici respectivement Illustration, Arabe (1 2 3) et 
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deux-points (:)) puis tapez le texte de la légende dans la zone de saisie prévue à cet effet. 
Tout ce que vous y saisirez apparaîtra dans la zone d’aperçu en bas de la boîte de dialogue 
précédé du nom de la catégorie, d’un numéro et du séparateur.

 3) Cliquez sur OK. La figure et sa légende sont placées dans un cadre.

Figure 11.21 : Définir la légende d’une illustration

Conseil

Dans la boîte de saisie Catégorie, vous pouvez taper le nom que vous voulez, par exemple 
« Figure », s’il n’apparaît pas dans la liste déroulante. Writer créera une série numérotée uti-
lisant ce nom comme il le fait quand on utilise la fonction de légende automatique.

Numérotation des images par chapitre

Des options supplémentaires sont accessibles en cliquant sur le bouton Options… dans la boîte 
de dialogue Insérer une légende (Figure 11.22). Certaines d’entre elles, qui font référence aux ni-
veaux de plan, ne prendront effet que si vous utilisez des styles de paragraphe pour ceux-ci dans 
les titres des chapitres de votre document.

Quand la numérotation des chapitres sera définie, Writer fera recommencer à 1 la numérotation 
des légendes dans chaque chapitre qu’il rencontrera. Par exemple, si la dernière légende que 
vous avez créée dans le chapitre 1 est « Figure 1.15 » et que la suivante est créée dans le cha-
pitre 2, la numérotation reprendra à « Figure 2.1 ».

Les options disponibles pour la numérotation par chapitre des légendes sont les suivantes :

• utiliser le champ Niveau pour définir le niveau de plan qui provoquera le redémarrage de la 
numérotation ainsi que le nombre de niveaux dont le numéro apparaîtra avant celui de la fi-
gure. Supposons par exemple que le document utilise le style Titre 1 pour les chapitres et le 
style Titre 2 pour les sections ; si vous souhaitez que toutes les figures d’un chapitre (entre 
deux paragraphes de style Titre 1) soient numérotées les unes à la suite des autres indépen-
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damment des sections rencontrées en chemin, sélectionnez le niveau 1 ; si vous désirez plu-
tôt recommencer la numérotation à chaque section, sélectionnez le niveau 2 ;

• utiliser le champ Séparateur pour définir le caractère qui séparera le numéro de chapitre du 
numéro de la figure ;

Figure 11.22 : Options de numérotation des images

• utiliser le champ Style de caractères pour définir un style de caractère pour la légende. Cela 
est utile si le séparateur que vous avez choisi n’est pas un symbole inclus dans la police par 
défaut de votre document ou si vous voulez que la catégorie et le numéro de la figure aient 
une couleur ou une taille particulière ;

• cocher l’option Appliquer des bordures et des ombres si vous désirez que la bordure et 
l’ombre de la figure soient transférées au cadre qui contiendra la figure et la légende plutôt 
que conservées sur la figure elle-même. Cette option ne s’applique pas aux légendes des ta-
bleaux qui ne sont pas insérées dans un cadre comme celles des autres objets ;

• utiliser le champ Ordre des légendes pour choisir si la catégorie doit apparaître dans la lé-
gende avant le numéro ou le contraire.

Ajout manuel de légendes

Si vous devez enregistrer le document comme fichier *.docx ou l’exporter dans d’autres formats, 
vous vous apercevrez peut-être que les légendes créées des façons décrites précédemment (au-
tomatiquement ou avec la boîte de dialogue Insérer une légende) sont perdues pendant l’opéra-
tion.

Pour éviter les problèmes d’exportation, ou comme autre façon de placer les légendes au-dessus 
des images ou sous elles comme c’est habituellement le cas, vous pouvez ajouter une légende 
manuellement d’une des deux manières suivantes :

• en plaçant la figure et sa légende dans des paragraphes séparés ;

• en utilisant un tableau.
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Placer la figure et sa légende dans des paragraphes séparés

Insérez la figure et ancrez-la comme caractère à son paragraphe. Appuyez sur la touche Entrée 
pour créer un nouveau paragraphe pour la légende.

 1) Dans le paragraphe de la légende, tapez par exemple « Figure » suivi d’une espace.

 2) Pour insérer automatiquement le numéro de l’image, cliquez sur Insertion > Champ > 
Autres champs… dans la barre de menu (Ctrl+F2) et ouvrez l’onglet Variables.

 3) Choisissez Séquence dans la liste Type, puis Figure dans la liste Sélectionner et, par 
exemple, Arabe (1 2 3) dans la liste Format. Cliquez sur le bouton Insérer.

 4) Un numéro apparaît à la suite du mot « Figure » dans la légende. Vous pouvez ensuite taper
le texte proprement dit de la légende.

Conseils
Si vous ajoutez manuellement des légendes à de nombreuses figures par cette méthode, 
vous pouvez créer un AutoTexte contenant, par exemple, le mot Figure, une espace, le 
champ Séquence Figure et un séparateur suivi d’une espace.

Pour être certain que l’image et sa légende restent ensemble sur la page, créez un nouveau
style de paragraphe nommé par exemple Figure. Si vous prévoyez de placer l’image au-
dessus de la légende, cochez l’option Conserver avec le paragraphe suivant dans l’onglet 
Enchaînements de la boîte de dialogue Style de paragraphe et sélectionnez le style Lé-
gende dans le champ Style de suite l’onglet Gestionnaire. Inversement, si c’est la légende 
qui est au-dessus, c’est dans le style Légende que vous cocherez l’option Conserver avec 
le paragraphe suivant et c’est à lui que vous donnerez Figure comme Style de suite.

Utiliser un tableau

Créez un tableau à une colonne et deux lignes. Placez la figure dans une des lignes et tapez la lé-
gende dans l’autre, ou utilisez deux lignes ou plus pour la légende et d’autres textes. Cette mé-
thode est particulièrement utile pour des images offrant des légendes numérotées, comme la Fi-
gure 11.13 à la page 294.

Créer une image cliquable

Une image cliquable possède des zones (appelées zones sensibles) reliées à des adresses web, 
d’autres fichiers sur l’ordinateur ou d’autres parties du même document. Les zones sensibles sont 
l’équivalent graphique des hyperliens textuels. Quand on clique sur une zone sensible, LibreOffice 
ouvre la page liée dans le programme approprié (par exemple, le navigateur par défaut pour une 
page HTML, LibreOffice Calc pour un fichier ODS, un lecteur de PDF pour un fichier PDF). Vous 
pouvez créer plusieurs zones sensibles de formes variées et en inclure plusieurs dans la même 
image.

Pour utiliser l’éditeur d’images cliquables :

 1) Dans votre document, cliquez sur l’image dans laquelle vous voulez créer les zones sen-
sibles.

 2) Sélectionnez le menu Édition > Image Map dans la barre de menu. L’éditeur d’Image Map 
s’ouvre (Figure 11.23).
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 3) Utilisez les outils et les champs de la boîte de dialogue (décrits ci-dessous) pour définir les 
zones sensibles et les liens nécessaires.

 4) Cliquez sur l’icône Appliquer ( ) pour appliquer les paramétrages.

 5) Quand vous avez terminé, cliquez sur l’icône Enregistrer ( ) pour enregistrer l’image cli-
quable dans un fichier puis sur le X dans le coin supérieur droit pour fermer la boîte de dia-
logue.

Figure 11.23 : L’éditeur d’Image Map qui permet de créer ou de modifier une image cliquable

La plus grande partie de la boîte de dialogue affiche l’image où sont définies les zones sensibles 
qui sont identifiées par une ligne qui montre sa forme.

La barre d’outils en haut de la boîte de dialogue contient les outils suivants :

• le bouton Appliquer  : cliquez sur celui-ci pour appliquer les modifications ;

• les icônes Ouvrir , Enregistrer  et Sélectionner  ;

• des outils pour dessiner la forme d’une zone sensible : rectangle, ellipse, polygone et poly-
gone à main levée. Ils fonctionnent exactement de la même façon que les outils correspon-
dants de la barre d’outils Dessin ;

• des outils pour éditer , déplacer , insérer  et supprimer  des points : ces outils d’édi-
tion élaborés permettent de manipuler la forme d’une zone sensible polygonale. Sélectionner
l’outil Éditer les points pour activer les autres ;

• deux outils pour annuler  et rétablir  la dernière opération ;

• l’icône Actif  alterne l’état de la zone sensible sélectionnée entre actif et inactif ;

• l’icône Macro  permet d’associer une macro à la zone sensible à la place d’un simple hy-
perlien ;
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• l’icône Propriétés  définit les propriétés de l’hyperlien et lui ajoute l’attribut Nom (Name).

Sous la barre d’outils, précisez pour la zone sensible sélectionnée :

• dans le champ Adresse, indiquez l’adresse visée par l’hyperlien. Vous pouvez aussi pointer 
vers une ancre dans un document ; pour cela, écrivez l’adresse avec ce format : 
file:///<chemin>/nom_du_document#nom_de_l_ancre ;

• dans le champ Texte, tapez le texte qui doit apparaître quand le pointeur de la souris survole
la zone sensible ;

• dans la liste Cadre, précisez l’endroit où la cible de l’hyperlien va s’ouvrir ; vous avez le choix
entre _blank (dans une nouvelle fenêtre du navigateur), _self (dans la fenêtre du navigateur 
actif), _top ou _parent.

Conseil

La valeur _self pour le cadre ciblé fonctionne normalement parfaitement. Il n’est donc pas 
recommandé d’utiliser les autres choix sauf nécessité absolue.

Gérer la Galerie de LibreOffice

Dans la Galerie, les images sont groupées par thèmes tels que Flèches, Symboles et Personne. 
Vous pouvez créer d’autres groupes ou thèmes et ajouter vos propres images ou trouver des ex-
tensions qui contiennent d’autres dessins. Cliquez sur un thème pour que son contenu s’affiche 
dans la fenêtre de la Galerie.

Vous pouvez utiliser un Affichage en icônes (Figure 11.3) ou une Liste détaillée (Figure 11.24) et 
vous pouvez masquer ou afficher la Galerie en cliquant sur le bouton Masquer du Volet latéral.

Figure 11.24 : La galerie en vue détaillée
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Remarque

Dans certaines installations, seul le thème Mon thème est personnalisable bien que de nou-
veaux thèmes puissent être ajoutés comme expliqué dans « Ajouter un nouveau thème à 
la Galerie » page 313. Les thèmes verrouillés sont faciles à reconnaître par un clic droit : la 
seule option disponible dans le menu contextuel est Propriétés.

Par défaut, la Galerie s’ouvre dans le volet latéral. Vous pouvez la détacher comme les autres pan-
neaux : voyez le Chapitre 1 Introduction à Writer, pour plus d’informations.

Ajouter des objets à la Galerie

Vous désirerez peut-être ajouter des images que vous utilisez souvent, par exemple le logo de 
votre société, au dossier Mon thème de la Galerie. Vous pourrez ensuite insérer facilement ces 
images dans un document.

 1) Faites un clic droit sur le dossier Mon thème et cliquez sur Propriétés dans le menu contex-
tuel.

 2) Dans la boîte de dialogue Propriétés de Mon thème, cliquez sur l’onglet Fichiers (Figure 
11.25)

Figure 11.25 : La boîte de dialogue Propriétés d’un thème.

Pour ajouter plusieurs fichiers en une seule fois :

 1) Cliquez sur le bouton Rechercher des fichiers.

 2) La boîte de dialogue Sélectionner un chemin s’ouvre. Vous pouvez saisir le chemin du dos-
sier des fichiers dans la zone de texte Chemin ou vous pouvez parcourir les dossiers pour le 
trouver.

 3) Cliquez sur le bouton Sélectionner pour lancer la recherche. Une liste de fichiers gra-
phiques s’affiche alors dans la boîte de dialogue Propriétés. Vous pouvez utiliser la liste dé-
roulante Type de fichier pour limiter les fichiers visibles.

 4) Pour ajouter tous les fichiers de la liste, cliquez sur Tout ajouter. Sinon, sélectionnez les fi-
chiers à ajouter puis cliquez sur Ajouter (appuyez sur la touche Maj ou la touche Ctrl en 
cliquant sur les fichiers).

Pour ajouter un fichier unique :

 1) Dans la boîte de dialogue Propriétés du thème, cliquez sur Ajouter pour ouvrir la boîte de 
dialogue Gallery.
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 2) Utilisez les contrôles de navigation pour rechercher l’image à ajouter au thème. Sélection-
nez-la et cliquez sur Ouvrir pour l’ajouter.

 3) Cliquez sur OK dans la boîte de dialogue Propriétés du thème pour la refermer.

Il est également possible d’insérer dans la Galerie un objet que vous avez créé (dans Draw par 
exemple) par simple glisser-déposer, mais cela requiert de suivre précisément la procédure sui-
vante :

 1) Cliquez avec le bouton gauche de la souris sur l’objet pour le sélectionner.

 2) Cliquez avec le bouton gauche de la souris et maintenez-le enfoncé sans bouger pendant un
temps « suffisant ». Ce temps dépend de la disponibilité du système pour mettre en mémoire
cette image, mais normalement 1 seconde doit suffire.

 3) Quand le curseur change de forme (curseur de copie), faites glisser l’objet et déposez-le 
dans la Galerie.

Si l’objet est simplement déplacé dans le document lors du déplacement de la souris, c’est que 
vous n’avez pas attendu assez longtemps ou que l’objet n’était pas sélectionné au départ.

Supprimer des images de la Galerie

Pour supprimer une image d’un thème :

 1) Faites un clic droit sur le nom du fichier image ou de sa miniature dans la Galerie.

 2) Cliquez sur Supprimer dans le menu contextuel. Un message vous demande de confirmer 
la suppression de l’objet. Cliquez sur Oui.

Remarque

Supprimer un objet dans la Galerie n’efface pas le fichier correspondant sur le disque dur ou
un autre emplacement. Par contre si l’objet a été incorporé à partir de LibreOffice par tirer-
déposer, il est alors définitivement supprimé.

Ajouter un nouveau thème à la Galerie

Pour ajouter un nouveau thème à la Galerie :

 1) Cliquez sur le bouton Nouveau thème au-dessus de la liste des thèmes (Figure 11.24).

 2) Dans la boîte de dialogue Propriétés de Nouveau thème, cliquez sur l’onglet Général et ta-
pez un nom pour le nouveau thème.

 3) Cliquez sur l’onglet Fichiers et ajoutez des images au thème comme décrit ci-dessus.

Supprimer un thème de la Galerie

Pour supprimer un thème de la Galerie :

 1) Sélectionnez le menu Insertion > Média > Galerie pour ouvrir la Galerie.

 2) Choisissez dans la liste des thèmes celui que vous désirez supprimer.

 3) Faites un clic droit sur ce thème puis cliquez sur Supprimer dans le menu contextuel.
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Emplacement de la Galerie et des objets qu’elle contient

Les images et les autres objets visibles dans la Galerie peuvent être situés n’importe où sur le 
disque dur de votre ordinateur, sur un disque réseau ou tout autre support amovible. Quand vous 
ajoutez des images à la Galerie, les fichiers ne sont ni déplacés ni copiés : l’emplacement des 
nouveaux objets est simplement ajouté en tant que référence.

Dans un groupe de travail, vous pouvez avoir accès à une Galerie partagée (dont vous ne pouvez 
pas modifier le contenu sauf autorisation) et à une Galerie personnelle où vous pouvez ajouter, 
modifier ou supprimer des objets.

L’emplacement de la Galerie personnelle est défini dans la page LibreOffice – Chemins de la boîte 
de dialogue Options (Outils > Options). Vous pouvez modifier cette localisation et copier les fi-
chiers de votre galerie (SDV) sur d’autres ordinateurs.

Le contenu de la Galerie fournie avec LibreOffice est stocké à un emplacement différent que vous 
ne pouvez pas modifier.

Remarque

Les thèmes de la Galerie sont empaquetés pour la distribution par l’intermédiaire du sys-
tème d’extensions de LibreOffice. Dans ce cas, l’emplacement des fichiers graphiques est 
déterminé par le paramétrage de l’extension. Pour obtenir d’autres thèmes pour la Galerie, 
rendez-vous sur le site web des extensions de LibreOffice à https://extensions.libreof-
fice.org.

Utiliser Fontwork

Avec Fontwork, vous pouvez créer des objets graphiques d’art textuel pour embellir votre travail. 
Comme ces objets possèdent de nombreux paramètres différents (ligne, remplissage, position, 
taille, etc.), vous avez un large choix.

Fontwork est disponible dans tous les modules de LibreOffice mais vous remarquerez de petites 
différences dans la manière dont chacun l’affiche.

Créer un objet avec Fontwork

 1) Pour ouvrir la Galerie FontWork, vous pouvez

─ cliquer sur l’icône Galerie de Fontwork  dans la barre d’outils Fontwork (Affichage > 
Barres d’outils > Fontwork) ou la barre d’outils Dessin (Affichage > Barres d’outils > 
Dessin),

─ sélectionner le menu Insertion > Fontwork dans la barre de Menu.

 2) Dans la boîte de dialogue Galerie Fontwork (Figure 11.26), choisissez un style puis cliquez 
sur OK. L’objet de Fontwork va apparaître dans votre document.

 3) Remarquez les carrés de couleur autour des bords (qui indiquent que l’objet est sélectionné) 
et le point jaune ; ils sont présentés dans « Modifier la position et la taille des objets 
Fontwork » page 317.
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 4) Modifiez les dimensions de l’objet en utilisant une des poignées de coin (appuyez sur la 
touche Maj pendant le mouvement pour conserver les proportions) ou faites un clic droit et 
sélectionnez Position et taille dans le menu contextuel pour un réglage plus précis.

Figure 11.26 : La galerie Fontwork

 5) Faites un double clic sur l’objet pour en modifier le texte (voir Figure 11.27). Sélectionnez le 
texte et tapez le vôtre à la place du mot Fontwork qui apparaît en noir par-dessus l’objet.

Figure 11.27 : Éditer le texte d’un objet Fontwork.

 6) Cliquez dans un espace vide ou appuyez sur la touche Échap pour appliquer les modifica-
tions.

Modifier un objet de Fontwork

Maintenant que l’objet de Fontwork est créé, vous pouvez modifier certains de ses attributs. Pour 
cela, vous pouvez utiliser la barre d’outils Fontwork, la barre d’outils Formatage ou les options du 
menu comme il est décrit dans cette section. Si l’objet de Fontwork sélectionné est un objet 3D, 
vous pouvez aussi utiliser la barre d’outils Paramètres 3D.
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Avec la barre d’outils Fontwork

Vérifiez que la barre d’outils Fontwork, visible sur la Figure 11.28, est affichée. Si ce n’est pas le 
cas, sélectionnez le menu Affichage > Barres d’outils > Fontwork. Cliquez sur les différentes 
icônes pour modifier les objets de Fontwork.

Icône Effet Résultat

Forme Fontwork : permet de modifier la forme 
de l’objet sélectionné. Vous pouvez choisir 
dans une palette de formes.

Figure 11.28 : La barre d’outils Fontwork
avec la palette de forme

Hauteur identique pour les lettres Fontwork : modifie la hauteur des caractères de l’ob-
jet. Bascule entre la hauteur normale (certains caractères plus hauts que les autres, par 
exemple les majuscules, d, h, l, etc.) et toutes les lettres de la même hauteur.

Figure 11.29 : à gauche, lettres normales ; à droite, lettres de même hauteur

Alignement Fontwork : modifie l’alignement des carac-
tères. Vous avez le choix entre Aligner à gauche, Centrer, 
Aligner à droite, Mots justifiés et Étirement justifié. Les ef-
fets ne sont visibles que si le texte s’étend sur deux lignes 
ou plus. Dans le mode Étirement justifié, toutes les lignes 
sont complètement remplies.

Espacement des caractères Fontwork : modifie l’espa-
cement et le crénage des caractères dans l’objet. Faites 
votre choix dans la liste déroulante.

Activer ou désactiver l’extrusion pour obtenir un objet en 2D ou en 3D.
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Avec la barre d’outils Formatage

Maintenant pour aller plus loin, il est possible de personnaliser l’objet de Fontwork avec plusieurs 
attributs supplémentaires.

Cliquez sur l’objet de Fontwork. La barre d’outils Formatage est remplacée par la barre d’outils 
Propriétés de l’objet de dessin (Figure 11.14 page 295) pour afficher les options qui permettent de 
modifier l’objet. (Si elle n’apparaît pas spontanément, sélectionnez Affichage > Barres d’outils > 
Propriétés de l’objet de dessin.) Ces options ont été décrites plus haut dans ce chapitre (voir 
« Définir ou modifier les propriétés des objets de dessin » page 295). Voir aussi le Guide 
Draw pour plus de détails.

Avec les options du menu

Vous pouvez utiliser les choix du menu Format pour ancrer, aligner, positionner et grouper les ob-
jets de Fontwork sélectionnés, adapter le texte autour d’eux et les retourner horizontalement et 
verticalement.

Vous pouvez aussi faire un clic droit sur l’objet de Fontwork et choisir beaucoup de ces options 
dans le menu contextuel. Celui-ci propose aussi un accès rapide aux boîtes de dialogue Ligne, 
Remplissage, Texte et Position et taille. La boîte de dialogue Texte n’offre que peu d’options pour 
les objets de Fontwork et elle n’est pas présentée ici. Dans le dialogue Position et taille, vous pou-
vez saisir des valeurs précises pour la taille et la position. Pour plus d’informations sur ces options 
de menu, voyez le Guide Draw.

Avec la barre d’outils Paramètres 3D

Si l’objet de Fontwork sélectionné est un objet 3D, vous pouvez aussi utiliser les options de la 
barre d’outils Paramètres 3D (Figure 11.30). Vous pouvez aussi changer un objet de Fontwork en 
2D en objet en 3D (ou un objet en 3D en objet en 2D) en cliquant sur l’icône (Des)activer l’extru-
sion de la barre d’outils Fontwork (Figure 11.28). Pour plus d’informations, voyez le Guide Draw.

Incliner vers le bas Incliner vers le haut Incliner vers la gauche

Incliner vers la droite Profondeur Direction des fuyantes

Éclairage Surface Couleur 3D.

Figure 11.30 : La barre d’outils Paramètres 3D

Modifier la position et la taille des objets Fontwork

Quand vous sélectionnez un objet de Fontwork, huit
carrés colorés (appelés poignées) apparaissent autour
des limites de l’objet comme on le voit ci-dessous. Vous
pouvez tirer ces poignées pour modifier la taille de l’ob-
jet.

Un point jaune apparaît aussi sur l’objet. Il peut se trou-
ver sur un bord de l’objet ou n’importe où ailleurs ; dans
l’exemple, il est à droite. Si vous survolez ce carré jaune
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avec le pointeur de la souris, celui-ci se prend l’apparence d’une main. Vous pouvez tirer le carré 
dans différentes directions pour déformer l’objet.

Survoler un autre endroit de l’objet avec le pointeur de la souris redonne à celui-ci sa forme habi-
tuelle pour tirer l’objet à un autre emplacement de la page.

Pour un contrôle précis de la position et de la taille de l’objet, utilisez le menu contextuel Position 
et Taille.
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Chapitre 12
Travailler avec les listes





Introduction

Ce chapitre complète les informations données au Chapitre 9 Travailler avec les styles, page 256, 
et apporte quelques exemples supplémentaires.

Dans de nombreux traitements de texte, les options de liste font partie intégrante des styles de pa-
ragraphe, mais Writer les traite comme un type de style à part.

Le fait d’avoir des styles de liste séparés présente deux avantages majeurs :

• le même style de liste peut être utilisé avec plusieurs styles de paragraphe, ce qui évite 
d’avoir à faire plusieurs fois le travail de mise au point ;

• un style de liste associé à un paragraphe peut être modifié en une seule opération.

Conseil

Il n’est pas possible de modifier les styles de liste utilisés par les boutons de la barre d’outils.
Vous pouvez créer de nouveaux boutons qui appliqueront des styles de liste aux para-
graphes, mais une meilleure stratégie consiste à créer des styles de paragraphe utilisant 
ces listes et, si tel est votre désir, de créer des boutons dans une barre d’outils pour les ap-
pliquer. Voyez le Chapitre 21 Personnaliser Writer, page 571, pour plus d’informations sur la 
création de boutons dans une barre d’outils.

Types de listes

Avec les styles de liste, vous pouvez créer trois sortes de listes :

• des listes à puces : listes non ordonnées dont le texte est précédé d’une puce, d’un carac-
tère spécial, d’un ornement typographique ou d’un dessin ;

• des listes numérotées : listes ordonnées dont le texte est précédé d’un numéro, de lettres en 
majuscules ou en minuscules ou de chiffres romains en majuscules ou en minuscules ;

• des listes hiérarchiques : sommaires hiérarchisés d’une présentation ou texte écrit où 
chaque niveau possède son propre système de numérotation.

Tous ces types de liste sont actuellement d’usage courant, particulièrement en ligne.

Chacun dispose de son propre ensemble de conventions concernant la manière dont ils sont struc-
turés et utilisés comme cela est décrit dans cette section.

Listes à puces

Les listes à puces sont courantes dans les documents techniques, les présentations et de nom-
breux sites web ou autres documents en ligne. Writer propose plusieurs styles de listes à puces 
prédéfinies (voir Figure 12.1) et vous permet d’en choisir d’autres dans la galerie ou de créer vos 
propres puces.

Conseil

Les listes à puces peuvent être utilisées à d’autres fins que les listes ordinaires, surtout si 
vous choisissez une image pour la puce. Voir « Exemple : style des conseils, remarques 
et appels à l’attention dans ce livre » page 339.
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Figure 12.1 : Les listes à puces prédéfinies de Writer.

Conventions concernant les listes à puces

L’utilisation des listes à puces suit des conventions parfaitement définies.

Les listes à puces :

• sont utilisées uniquement quand l’ordre des points est sans importance. Vous pouvez ordon-
ner les points pour obtenir un effet rhétorique, en commençant par un point assez important 
et en terminant par le plus fort, mais le lecteur ne doit pas avoir besoin de connaître un point 
avant un autre ;

• ont trois points ou plus. S’il n’y a que deux points, ils restent dans le corps du texte ;

• sont introduites dans la dernière phrase du corps de texte qui les précède, soit sans ponctua-
tion, soit par le caractère deux-points ;

• sont constituées de points qui complètent grammaticalement la dernière phrase du para-
graphe précédent. Cela implique que chaque point doit avoir une structure grammaticale 
identique aux autres points de la liste ; par exemple, dans la présente liste, chaque point dé-
bute par un verbe au présent ;

• peuvent être constituées de morceaux de phrases qui doivent cependant être cohérents d’un
point à l’autre. Par exemple, ils peuvent tous être des noms ou des participes ;

• commencent par une puce à, ou en retrait de, la marge de gauche suivie d’un retrait pour le 
texte. S’il y a une liste à l’intérieur de la liste, ses puces ont le même retrait que le texte de ni-
veau supérieur ;

• peuvent débuter soit par une majuscule, soit par une minuscule tant que la convention est 
respectée dans toute la liste et tout le document ;

• introduites par un caractère deux-points (:) ne comportent pas de majuscule en début d’élé-
ment. Les éléments de premier niveau se terminent par un point-virgule (;), ceux de 
deuxième niveau par une virgule (,), sauf le dernier qui se termine par un point (.). Cette 
règle s’applique indépendamment de la ponctuation interne de chaque terme ou para-
graphe ;5

• composées de groupes nominaux ou verbaux, non introduites par un caractère deux-points, 
ont une majuscule en début d’élément et pas de ponctuation finale. On pourra cependant uti-
liser un point à la fin des items selon leur longueur ;5

5 Source Wikipédia : listes verticales (Wikipédia : Conventions typographiques (Listes verticales))

322 | Guide de LibreOffice Writer Types de listes

https://fr.wikipedia.org/wiki/Wikip%C3%A9dia:Conventions_typographiques#Listes_verticales


 Chapitre 12 Travailler avec les listes

• ne possèdent généralement pas plus de 6 à 8 entrées. Beaucoup plus longues, elles perdent
en lisibilité ;

• n’utilisent ni « et », ni « ou », ni tout autre mot pour introduire le dernier point, même si cela 
serait grammaticalement correct ;

• sont parfois considérées comme trop informelles pour être utilisées. Dans le doute, abste-
nez-vous.

Listes numérotées

Bien que certains numérotent toutes leurs listes, la convention veut qu’elles ne soient utilisées que 
si l’ordre des informations est important. Au cours d’un protocole décrit dans un manuel technique, 
par exemple, une étape peut être impossible, voire dangereuse, si les autres n’ont pas été fran-
chies auparavant.

Writer offre plusieurs styles de listes numérotées prédéfinies (Figure 12.2) et vous avez la possibi-
lité d’en définir d’autres.

Figure 12.2 : Listes numérotées prédéfinies de Writer

Conventions concernant les listes numérotées

Les listes numérotées respectent moins de conventions que les listes à puces, mais il en existe 
quand même quelques-unes :

• on les utilise quand l’ordre des entrées est important. Si ce n’est pas le cas, utilisez plutôt 
une liste à puces ;

• comme pour les listes à puces, on ne les utilise que si elles possèdent trois entrées ou plus. 
Jusque deux, elles restent dans le corps de texte ;

• elles sont généralement introduites dans le corps du texte par un résumé de l’ensemble de la
tâche qu’elles décrivent terminé par un caractère deux-points. « Pour installer la mise à jour 
du logiciel, effectuez ceci : » ou simplement « Pour l’installation : » ;

• chaque étape peut avoir plusieurs paragraphes, la plupart non numérotés, qui décrivent ce 
qui se passe quand on réalise ce qui est décrit ou offrent des alternatives ;

• les étapes d’une procédure devraient être moins d’une douzaine (certains suggèrent pas 
plus de 6 à 8).
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Conseil

Si chaque étape possède de nombreux paragraphes ou si vous avez plus d’une douzaine 
de points, il vaudrait peut-être mieux partager la liste en listes plus petites ou présenter les 
entrées comme un corps de texte ordinaire.

Listes hiérarchiques

Les listes hiérarchiques résument la structure d’un document beaucoup plus long, le plus souvent 
non écrit. Dans des documents légaux ou techniques terminés, elles sont utilisées dans les titres 
pour faire ressortir la structure, même si cet usage devient moins courant que dans les décennies 
passées.

Writer propose plusieurs options pour les listes hiérarchiques (voir Figure 12.3). Ces styles de liste 
offrent une méthode de création de plan qui n’utilise qu’un seul style de paragraphe. Dans ce cas, 
on change de niveau et de numérotation en appuyant sur la touche Tabulation pour descendre 
d’un niveau et sur Maj+Tabulation pour monter d’un niveau. Ce style unique de création de 
plan est de loin le plus rapide à appliquer et à apprendre.

Vous pouvez faire le choix d’utiliser les listes hiérarchiques pendant l’écriture du document puis, 
avant sa publication, de supprimer lettres et chiffres du plan en modifiant ou en enlevant le style de
numérotation associé au style de paragraphe.

Figure 12.3 : Styles de listes hiérarchiques prédéfinies de Writer

Conventions concernant les listes hiérarchiques

Ces conventions sont les suivantes :

• un système de numérotation différent est habituellement utilisé pour chaque niveau de plan 
pour pouvoir les distinguer plus facilement ;

• les niveaux peuvent être ordonnés en utilisant des chiffres arabes, des chiffres romains en 
majuscules ou en minuscules et des lettres en majuscules ou en minuscules ;

• les chiffres romains en majuscules sont normalement réservés au premier niveau et les 
lettres majuscules sont utilisées avant les minuscules. Une autre possibilité consiste à utiliser
des chiffres arabes suivis de lettres minuscules. Ces règles ne sont cependant pas fixées ;
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• l’habitude, dans les manuels techniques, était d’afficher plusieurs niveaux dans un titre (par 
exemple, I.A.2 ou 1.1.1). Ce type de numérotation est largement tombé en désuétude, sauf 
dans quelques cas spécialisés tels que les documents légaux, pour d’évidentes raisons de 
difficultés de mémorisation. De plus, si chaque titre est mis en retrait, au bout de deux ou 
trois niveaux, il ne reste presque plus de place pour le texte.

Combiner listes et styles de paragraphe

Les styles de paragraphe sont essentiels pour les listes et la création de plan. Quand on applique 
un style de liste, le style de paragraphe sous-jacent reste inchangé. Si votre liste doit aussi avoir 
une taille de police ou des retraits particuliers, par exemple, vous penserez peut-être à appliquer 
d’abord un style de paragraphe puis un style de liste (ou l’inverse). Cependant, vous pouvez ad-
joindre un style de liste à un style de paragraphe grâce à l’onglet Plan & numérotation de la boîte 
de dialogue Style de paragraphe puis n’appliquer que le style de paragraphe à la liste.

Cette section offre un exemple d’association de styles de liste et de paragraphe.

 1) Créez un style de liste que vous désirez utiliser avec le paragraphe. Par exemple, MaListe-
Numérotée.

 2) Créez un nouveau style de paragraphe.

 3) Dans l’onglet Gestionnaire de la boîte de dialogue Style de paragraphe :

 a) Donnez un nom au nouveau style de paragraphe, disons ParagrapheNuméroté.

 b) Choisissez ParagrapheNuméroté comme Style de suite (de cette façon, le paragraphe 
suivant conservera le même style jusqu’à ce que vous décidiez d’en changer).

 c) Dans le champ Hérité de, sélectionnez – Aucun(e) –.

 4) Paramétrez ce style de paragraphe à votre goût. Comme le retrait est contrôlé par le style de
liste, pour éviter les interactions indésirables, ne le modifiez pas dans l’onglet Retraits et es-
pacement, mais vous pouvez y changer l’espace au-dessus et en dessous du paragraphe.

 5) Dans l’onglet Plan & numérotation (Figure 12.4), choisissez le style MaListeNumérotée créé 
à la première étape.

 6) Cliquez sur OK pour enregistrer le style.

Pour un contrôle total, il est courant de définir trois styles de paragraphe de base pour les listes : 
Liste début pour le premier élément de la liste, Liste suite pour les éléments suivants et Liste fin 
pour le dernier. Vous pouvez aussi définir des styles de paragraphe pour les entrées non numéro-
tées de la liste (un par niveau que vous prévoyez d’utiliser) ainsi qu’un style introductif pour le pa-
ragraphe précédant le début de la liste (pour conserver celui-ci avec la première entrée de la liste 
ou pour définir un espacement avant la première entrée différent de l’espacement avec les autres 
paragraphes).
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Figure 12.4 : Associer un style de liste à un style de paragraphe

Imbriquer des listes

Une liste imbriquée – une liste à l’intérieur d’une autre liste – est une liste numérotée ou à puces 
contenant d’autres listes subordonnées (ordinairement en retrait), numérotées ou à puces. Au lieu 
d’une simple liste d’éléments numérotés (1, 2, 3…), une liste imbriquée peut avoir un élément 1 
suivi d’éléments numérotés a, b, c ou i, ii, iii ou toute autre méthode de numérotation avant l’élé-
ment 2 principal. Grâce aux styles de numérotation, vous pouvez réaliser n’importe quelle combi-
naison de formats que vous désirez. Une liste imbriquée peut même combiner des éléments nu-
mérotés à des éléments à puces.

Vous avez deux possibilités pour imbriquer une liste. La première consiste à créer un style de liste 
en définissant deux niveaux ou plus avec différents choix de mise en forme dans les onglets Posi-
tion et Personnaliser. L’avantage des niveaux de liste est que chacun peut être formaté séparé-
ment, mais que tous les niveaux demeurent connectés. On peut passer au niveau inférieur en ap-
puyant sur la touche Tabulation et au niveau supérieur en appuyant sur Maj+Tabulation.

Le panneau d’aperçu vous aide à régler chaque niveau et le style de liste personnalisé est associé
pour son utilisation à un style de paragraphe.

Dans ce cas, il faut appuyer sur la touche Tabulation (pour descendre d’un niveau) ou sur 
Maj+Tabulation (pour monter d’un niveau) avant de saisir quelque chose dans le paragraphe.

La deuxième possibilité consiste à créer deux styles de liste qui seront tous les deux associés à 
des styles de paragraphe différents.

Aucun des deux choix ne présente d’avantage sur l’autre puisque vous devez gérer les mêmes op-
tions. Cependant, dans un cas comme dans l’autre, chaque liste imbriquée possède normalement 
un retrait plus important que celle du niveau précédent et utilise un style de puces ou un système 
de numérotation différent.
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Figure 12.5 : Listes imbriquées créées grâce à deux styles de liste distincts

Des noms de styles tels que ListeAPuce et ListeAPuce2 ou ListeImbriquée vous aideront à vous 
rappeler la relation entre les deux styles de paragraphe. Par commodité, utilisez le même nom à la
fois pour le style de paragraphe et le style de liste puisqu’ils ne peuvent pas être confondus.

Création de plan à l’aide de styles de paragraphe

LibreOffice offre plusieurs méthodes pour créer un plan à l’aide de styles de paragraphe. Avec Ou-
tils > Numérotation des chapitres, vous pouvez choisir un style de numérotation pour chaque 
style de paragraphe, en l’intégrant aux niveaux de plan. Vous pouvez aussi ignorer cette possibilité
et associer à chaque style de titre un style de liste différent grâce à la fenêtre Style et formatage.

Une méthode encore plus simple pour créer un plan consiste à utiliser un style de liste unique. 
Vous pouvez paramétrer les différents niveaux du style dans l’onglet Personnaliser ou obtenir un 
résultat assez identique en choisissant un motif prédéfini dans l’onglet Plan de la boîte de dialogue
Style de liste.

Pour utiliser le style de paragraphe, appuyez sur Entrée + Tabulation pour ajouter un para-
graphe de niveau inférieur. Celui-ci utilisera automatiquement la numérotation correspondante du 
style de liste. Pour remonter d’un niveau le style de paragraphe, utilisez Entrée + Maj + 
Tabulation.

Créer un plan avec un style de paragraphe unique

Pour paramétrer un style unique de paragraphe pour la création de plan :

 1) Créez un style de liste et associez-le à un des formats prédéfinis de l’onglet Plan.

 2) Sélectionnez ou créez un style de paragraphe. Vous ne pouvez pas utiliser les styles Titre 1 
à 10. Cette restriction est probablement là pour éviter de confondre un plan avec un style de 
paragraphe unique ou avec les niveaux de plan enregistrés.

 3) Dans l’onglet Gestionnaire du style de paragraphe, paramétrez le style lui-même comme 
Style de suite.

 4) Affectez le style de liste au style de paragraphe en utilisant le champ Numérotation de sa 
page Plan & numérotation.
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Ajouter des styles de paragraphe aux niveaux de plan

Les niveaux de plan sont un concept qui est utilisé tout au long de LibreOffice pour automatiser 
des fonctions perfectionnées. Ce sont eux qui déterminent, par exemple, quels styles de para-
graphe sont affichés par défaut dans le navigateur à la rubrique Titres et repris dans la table des 
matières.

Par défaut, les niveaux de plan sont associés aux styles de paragraphe Titre 1 à 10. Le niveau 1 
est associé à Titre 1 et ainsi de suite. Il est possible de modifier ces associations ou d’ajouter un 
autre style de paragraphe à un niveau de plan dans le champ Niveau de plan de l’onglet Plan & 
numérotation (voir Figure 12.6).

Remarque

Vous pouvez affecter plusieurs styles de paragraphe à un niveau de plan, mais un seul sera 
affiché dans Outil > Numérotation des chapitres.

Figure 12.6 : Affecter un style de paragraphe à un niveau de plan

Sauter un paragraphe dans une liste

Dans de nombreux cas, chaque paragraphe est une entrée de la liste et reçoit donc un numéro ou 
une puce. Il est cependant parfois nécessaire d’interrompre une liste par un paragraphe sans nu-
méro ni puce pour donner plus de détails sur une entrée. Sans cette possibilité, un élément de la 
liste pourrait se transformer en un long paragraphe difficilement lisible, alors que la lisibilité est la 
raison d’être d’une liste.

Pour obtenir un style adapté à ce type de paragraphes, créez un style lié au style de paragraphe 
de la liste, formaté de manière identique sauf en ce qui concerne les options de l’onglet Plan & nu-
mérotation où

• vous sélectionnez Corps de texte comme Niveau de plan ;

• vous choisissez Aucun(e) comme Style de numérotation ;
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• vous décochez l’option Inclure les lignes de ce paragraphe dans Numérotation des lignes.

Si vous n’utilisez que quelques valeurs de retrait horizontal, ce style pourra être utilisable avec plu-
sieurs listes. Le style Retrait de corps de texte est prédéfini dans ce but.

Appliquer des styles de liste

Les styles de liste définissent des propriétés telles que le retrait, le style de numérotation (par 
exemple, 1, 2, 3, a, b, c ou des puces), et une ponctuation après le numéro, mais elles ne défi-
nissent pas par elles-mêmes des propriétés comme la police, les bordures, l’enchaînement du 
texte et ainsi de suite. Celles-ci sont des propriétés des styles de paragraphe.

Si votre liste doit posséder des propriétés propres aux styles de paragraphe, incorporez-la au style
de paragraphe, comme expliqué « Combiner listes et styles de paragraphe » page 325. Vous 
pourrez alors créer une liste en appliquant le seul style de paragraphe.

Writer offre deux séries de styles de liste prédéfinis, nommés Puce (pour les listes à puces) et Nu-
mérotation (pour les listes numérotées). Chaque série possède cinq styles, prévus pour les diffé-
rents niveaux d’une liste imbriquée. Comme pour tous les styles, vous pouvez en redéfinir les pro-
priétés en modifiant, par exemple, la numérotation, la puce ou le retrait. Vous pouvez aussi définir 
d’autres styles dans ces séries ou créer les vôtres.

Chaque style de liste prédéfini dans Writer est associé à quatre styles de paragraphe. Pour plus 
d’informations, voir « Nommer les styles de liste » page 330.

Si vous désirez n’appliquer que le style de liste (c’est-à-dire la numérotation ou la puce et le re-
trait), placez le curseur dans le paragraphe et faites un double clic sur le style de liste voulu dans 
la section Styles de liste de l’onglet Styles et formatage du volet latéral.

Les styles de liste peuvent posséder jusqu’à dix niveaux, utilisables pour des listes imbriquées. 
Pour passer de l’un à l’autre, utilisez les boutons Hausser d’un niveau ( ) ou Abaisser d’un ni-
veau ( ) de la barre d’outils Puces et numérotation, appuyez sur la touche Tabulation (pour 
descendre d’un niveau) ou Maj+Tabulation (pour monter d’un niveau) ou sélectionnez Hausser
d’un niveau ou Abaisser d’un niveau dans le menu contextuel après un clic droit.

Recommencer ou continuer la numérotation

Quand on crée plusieurs listes numérotées du même type à l’intérieur du même chapitre, Writer 
poursuit la numérotation d’une liste à l’autre. C’est parfois ce qui est désiré (par exemple, quand 
on place des illustrations entre les paragraphes numérotés), mais on désire d’autres fois recom-
mencer la numérotation.

Pour recommencer la numérotation à 1, vous pouvez effectuer une des actions suivantes :

• cliquer sur le bouton Recommencer la numérotation ( ) dans la barre d’outils Puces et 
numérotation ;

• faire un clic droit sur le premier élément de la liste et choisir Recommencer la numérotation
dans le menu contextuel ;

• faire un clic droit sur le premier élément de la liste, choisir Paragraphe dans le menu contex-
tuel et ouvrir l’onglet Plan & numérotation de la boîte de dialogue Paragraphe. Dans la sec-
tion Numérotation, cochez Recommencer avec ce paragraphe et Démarrer avec avant d’in-
diquer le nouveau numéro de liste (voir Figure 12.7).
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Figure 12.7 : Recommencer la numérotation des paragraphes

Remarque

Ne confondez pas cette option avec celle de même nom dans la section Numérotation de 
lignes qui ne concerne pas la numérotation des paragraphes.

Si les deux premières méthodes ne vous donnent pas satisfaction ou si vous désirez recommencer
à un numéro autre que 1, utilisez la troisième.

Quand vous modifierez un document, vous souhaiterez peut-être continuer la numérotation de la 
liste précédente au lieu d’en recommencer une nouvelle. Pour cela, faites un clic droit sur l’élément
de la liste et choisissez Continuer la numérotation précédente dans le menu contextuel.

Nommer les styles de liste

LibreOffice utilise par défaut Liste 1 à 5 pour les listes à puces et Numérotation 1 à 5 pour les listes
numérotées. Ces noms sont toutefois trop limités pour une mémorisation facile. Ajoutez plutôt vos 
propres styles en leur donnant des noms significatifs tels que Numérotation Arabe Bleue ou Minus-
cule En Retrait.

Conseil

L’utilisation du même nom à la fois pour le style de liste et pour le style de paragraphe au-
quel il est associé peut grandement faciliter le travail avec différents types de styles. Si vous 
utilisez un style de caractère pour définir les puces ou les numéros, donnez-lui aussi le 
même nom.

Avec chaque style de paragraphe de base, LibreOffice inclut aussi des styles de liste dont le nom 
se termine par Début, Fin et Suite. Vous pouvez les utiliser pour personnaliser les listes.
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Par exemple, le style de liste dont le nom se termine par Début pourra être précédé d’un espace 
supplémentaire pour séparer la liste du corps de texte et le style terminé par Fin être suivi d’un es-
pace plus grand que les autres.

Le style dont le nom se termine par Suite est parfois utilisé pour les paragraphes non numérotés 
qui ont un format différent. Ce nom suggère cependant de l’utiliser avec un style de liste dont le 
champ Nombre est réglé sur Aucun dans l’onglet Personnaliser et dont le champ Avant contient 
(suite) ou un texte équivalent. Ce texte sera automatiquement ajouté chaque fois que vous appli-
querez ce style.

Style de  liste

Liste1

Style de  
paragraphe

Liste1

Style de  
caractère

Liste1

Liste1 Début
Liste1 Fin
Liste1 Suite

Modifie
puces ou
numéros

Attachée à

Styles de
paragraphe
apparentés

Figure 12.8 : Donnez des noms semblables aux styles apparentés pour retrouver plus facilement
ceux dont vous avez besoin.

Remarque

Si le paragraphe ne contient rien d’autre que le texte du champ Avant, vous devez taper un 
espace avant d’appuyer sur la touche Entrée, sinon le paragraphe disparaît.

Si vous décidez de ne pas utiliser ces styles, vous pouvez faire un clic droit sur chacun d’eux dans 
la fenêtre Styles et formatage et les masquer. En sélectionnant Styles masqués en bas de la fe-
nêtre Styles et formatage, vous pourrez les afficher de nouveau si vous en avez finalement besoin.

Formater les styles de liste

Deux méthodes s’offrent à vous pour formater les puces et numéros dans les styles de liste.

Le moyen le plus rapide consiste à sélectionner un style dans les onglets Puces, Style de numéro-
tation, Plan ou Image de la boîte de dialogue Style de numérotation. Chacune offre de nombreux 
choix sans être exhaustive.
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Figure 12.9 : Les puces de l’onglet Image

Bien que les choix offerts par l’onglet Image puissent paraître un peu démodés, ils peuvent être 
utiles.

La deuxième méthode, la plus pratique, consiste à personnaliser vous-mêmes les listes à puces 
ou numérotées grâce aux onglets Position et Personnaliser. Chacun dispose de dix niveaux, sur-
tout utiles pour créer un style de numérotation de plan unique (voir « Listes hiérarchiques », 
page 324). Dans la plupart des autres cas, vous utiliserez le Niveau 1 ou vous conserverez la va-
leur par défaut 1-10.

Si votre mise en forme devient confuse, reprenez au début en cliquant sur le bouton Réinitialiser 
dans n’importe quelle page.

Positionner les puces, les numéros et les éléments de la liste

L’onglet Position permet de paramétrer les distances avant les puces ou les numéros et entre 
ceux-ci et le texte.

Quand un style est lié à celui d’un paragraphe, modifier les champs de l’onglet Position dans la 
boîte de dialogue Style de numérotation produit des changements des champs Avant le texte et 
Première ligne de la section Retrait de la boîte de dialogue Style de paragraphe.

L’inverse est aussi vrai, mais, pour éviter toute complication, n’effectuez les modifications que dans
l’onglet Position du style de liste. Non seulement, c’est l’emplacement logique pour modifier le style
de liste, mais aussi, ajuster les paramètres du paragraphe implique habituellement des valeurs né-
gatives pour le champ Première ligne, ce qui peut rendre l’édition très compliquée.
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Figure 12.10 : L’onglet Position est un des deux onglets de la boîte de dialogue Style de
numérotation qui permet de personnaliser les listes

Comprendre les champs de l’onglet Position

Figure 12.11 : Les champs de l’onglet Position d’un style de liste et ce qu’ils concernent.

Quand vous définissez un nouveau style, les champs importants de l’onglet Position sont :

• Aligné à  définit la position de l’alignement vertical des numéros, mesurée depuis la marge 
de gauche. Dans la plupart des cas, vous pouvez laisser ce champ à 0 (numéros au niveau 
de la marge gauche). Cependant, si vous utilisez un autre Alignement de la numérotation 
que À gauche, donnez une autre valeur à ce champ ;

• Alignement de la numérotation définit la façon dont les puces ou les numéros sont alignés. 
La plupart du temps, vous pouvez laisser ce champ à sa valeur par défaut, À gauche, mais, 
si vous avez du mal à positionner le texte, changer l’alignement pour Centré ou À droite peut 
parfois résoudre le problème, surtout pour les listes ou les niveaux qui demandent des 
nombres de deux chiffres ;
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Figure 12.12 : La ligne en tirets verts représente la marge. Si la valeur du champ Aligné à est
nulle, choisir Centré ou À droite comme Alignement de la numérotation peut placer les numéros

dans la marge.

• Numérotation suivie par définit ce qui sera placé entre le numéro ou la puce et le texte. Bien 
que Espace et Rien fasse partie des choix proposés, celui qui offre le plus de contrôle est 
Tabulation ;

• Tabulation à définit la position, depuis la marge de gauche, de l’arrêt de tabulation si vous 
avez choisi de faire suivre le numéro ou la puce par une tabulation ;

• Retrait à définit la position de début des lignes qui suivent la première dans le paragraphe. 
Cette position est mesurée à partir de la marge de gauche. Sauf effet spécial, on lui donne la
même valeur que celle du champ précédent.

Conseil

L’espace entre le numéro ou la puce et le texte ne devrait pas dépasser deux interlignes en-
viron sous peine de perdre le lien visuel entre ceux-ci.

Mettre en forme les listes ordonnées (numérotées)

Figure 12.13 : Choix d’un style de numérotation dans l’onglet Personnaliser.

Pour créer une liste numérotée, commencez par choisir un style de numérotation dans le champ 
Nombre de l’onglet Personnaliser (Figure 12.13). Les choix proposés dans la liste déroulante par 
des formats courants dans les langues de l’Europe occidentale : chiffres arabes, lettres et chiffres 
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romains en majuscules et minuscules. Plus bas, vous trouverez des choix pour le bulgare, le 
russe, le serbe et le grec.

Ajout de caractères avant et après les nombres

Vous pouvez ajouter jusqu’à 40 caractères avant et après le numéro effectif grâce aux champs 
Avant et Après. Ces caractères seront ajoutés chaque fois que le style de liste où ils ont été définis
sera appliqué.

Parmi les caractères courants après le numéro, il y a un point, une parenthèse, ou les deux. Vous 
pouvez aussi placer une parenthèse avant et après le numéro, ou un texte tel que Étape dans le 
champ Avant. Pour un style Liste suite, vous pouvez mettre (Suite) avant (avec Aucun dans le 
champ Nombre).

De façon plus élaborée, il est possible de paramétrer un style de paragraphe pour qu’il commence 
en haut de la page avant de lui attacher un style de liste avec du texte de manière que le style de 
paragraphe ajoute automatiquement le texte.

Dans une liste numérotée, vous pouvez choisir le nombre de niveaux de plan visible dans la liste 
en ajustant le champ Afficher les sous-niveaux. Si, par exemple, vous décidez d’afficher trois sous-
niveaux, la première utilisation du troisième sous-niveau sera numérotée 1.1.1.

Remarque

L’utilisation des champs Avant, Après et Afficher les sous-niveaux implique que les réglages 
de l’onglet Position devront être ajustés pour laisser suffisamment de place entre le numéro 
et le texte.

Définir le style de caractère

Le champ Style de caractères est, par défaut, réglé sur Caractères de numérotation pour les listes 
numérotées et sur Puces pour les listes à puces.

Dans la plupart des cas, vous n’aurez probablement pas de raison de changer ces réglages. Sauf 
modifications, ces styles de caractère utilisent la même police et la même taille que le Style par 
défaut. Ils s’appliquent à la fois au numéro et au texte des champs Avant et Après.

Parmi les modifications courantes, vous pouvez agrandir les numéros et les puces, leur donner 
une couleur associée à votre entreprise, les mettre en gras ou utiliser une version condensée de la
police.

Remarque

Vous devrez peut-être modifier l’écart entre les numéros et le texte (champs Tabulation à et 
Retrait à de l’onglet Position), si vous utilisez une police plus grande, en particulier avec des 
numéros de deux ou trois chiffres. La hauteur de ligne devra peut-être aussi être augmen-
tée.

Exemple : formater des grands numéros pour les listes

Si vous désirez que les numéros soient plus grands, ou dans une police ou une couleur différente 
de celle du texte de la liste, effectuez les actions suivantes :

 1) Créez un nouveau style de caractère pour les numéros ou modifiez-en un qui existe déjà. 
Dans cet exemple, le nouveau style s’appellera Grands chiffres.
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Dans l’onglet Police de la boîte de dialogue Style de caractère, augmentez la taille de la po-
lice. Si vous voulez modifier la couleur de la police, allez à l’onglet Effets de caractère. Cli-
quez sur OK pour enregistrer le style de caractère nouveau ou modifié.

 2) Créez un nouveau style de liste ou modifiez un style existant. Dans l’onglet Personnaliser de 
la boîte de dialogue Style de numérotation (Figure 12.14), choisissez le style de caractère 
que vous venez de créer ou de modifier. Dans cet exemple, choisissez Grands chiffres. Cli-
quez sur OK pour enregistrer le style.

 3) Créez un nouveau style de paragraphe ou modifiez un style existant. Dans l’onglet Plan & 
numérotation de la boîte de dialogue Style de paragraphe, sélectionnez le style de liste que 
vous venez de créer ou de modifier.

 4) Appliquez le style de paragraphe de la manière habituelle aux éléments de la liste.

! Attention

Si vous modifiez un style de caractère, de liste ou de paragraphe existant, les changements 
affecteront tous les éléments de votre document qui utilisent ces styles.

Figure 12.14 : Choix de style des caractères de numérotation d’une liste.

Le problème des numéros à deux chiffres

Figure 12.15 : À moins qu’un plus grand espace ne soit prévu, les entrées de la liste sont
repoussées quand la numérotation atteint deux chiffres.
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Les listes dont les numéros comportent deux chiffres peuvent déplacer les éléments de texte et 
bouleverser la mise en forme que vous avez soigneusement calculée en repoussant le texte.

Il existe plusieurs façons pour régler ce problème :

• ne jamais dépasser neuf éléments dans une liste. Réécrivez les listes qui en possèdent plus,
en regroupant les entrées ou en divisant la liste en deux listes plus courtes ou plus. Cette so-
lution présente l’avantage de favoriser la mémorisation de vos instructions ;

• accroître l’espace entre le numéro et le texte en augmentant la valeur du champ Tabulation à
(ou en diminuant celle du champ Aligné à s’il n’est pas nul) mais en prenant soin de ne pas 
rompre l’association visuelle entre les numéros et le texte ;

• ajuster la taille des numéros grâce au champ Style de caractères de l’onglet Personnaliser ;

• régler l’Alignement de la numérotation sur À droite (Figure 12.12) en donnant une valeur non 
nulle au champ Aligné à pour que les numéros ne s’étendent pas dans la marge.

Recommencer la numérotation d’une liste

L’onglet Personnaliser d’une boîte de dialogue Style de numérotation présente un champ Com-
mencer avec. Faites cependant attention que ce champ concerne la première utilisation du style 
de liste dans un document : ce n’est pas un outil pour recommencer la numérotation.

Pour recommencer la numérotation d’une liste, faites un clic droit sur un paragraphe de la liste et 
choisissez Recommencer la numérotation dans le menu contextuel (voir « Recommencer ou 
continuer la numérotation » page 329).

Conseil
Certains utilisateurs demandent parfois des listes numérotées qui décomptent à partir d’un 
numéro au lieu de compter, probablement pour des listes du genre Top 50 ou autres comptes
à rebours. LibreOffice n’offre malheureusement aucun moyen à part une macro personnali-
sée pour inverser l’ordre des listes.

Une liste en ordre inverse doit être saisie manuellement. Comme LibreOffice ne reconnaît 
pas les listes en ordre inverse, il ne génère pas automatiquement leur numérotation.

Concevoir des listes non ordonnées (à puces)

Le style de caractère par défaut pour les puces est Puces. Il vous donne une puce standard pour 
le style par défaut. Vous pouvez cependant modifier le symbole grâce au champ Caractère. Quand
vous cliquez sur celui-ci, une boîte de dialogue s’ouvre où vous pouvez choisir n’importe quel ca-
ractère de la police courante.

Pour choisir une puce vraiment inhabituelle, régler le style de caractère pour utiliser une police 
« dingbat ». N’oubliez cependant pas que les ornements typographiques trop détaillés ou inhabi-
tuels distraient du contenu.

! Attention

Quand vous utilisez un style de caractère inhabituel pour les puces, n’oubliez pas de joindre 
la police utilisée aux fichiers que vous partagez.
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Si votre mise en page comporte des listes imbriquées, c’est-à-dire des listes à puces à l’intérieur 
d’autres listes à puces, il vaudrait mieux créer un style de liste supplémentaire nommé, par 
exemple, Puces2.

Mais si vous utilisez vraiment plus d’un style de liste à puces, assurez-vous que leurs mises en 
forme soient compatibles. En fait, mettre les puces imbriquées en retrait, sans rien faire d’autre, 
suffit à les distinguer de celles de niveau supérieur.

Exemple : créer une liste de contrôle

Selon les caractères que vous choisissez pour les puces, vous pouvez en faire bien plus qu’une 
liste non ordonnée. Par exemple, une liste à puces peut être transformée en liste de contrôle en 
choisissant bien la police et les caractères utilisés pour les puces.

Si vous avez l’intention d’utiliser la liste de contrôle avec un crayon, configurez le style de liste de 
la manière habituelle en utilisant un style de caractère qui s’appuie sur la police OpenSymbol four-
nie avec LibreOffice et sélectionnez comme puce le caractère U+E00B (une case munie d’une 
ombre ; le code est « E zéro zéro B ») ou U+E57C (une simple case). Imprimez la liste qui est im-
médiatement utilisable. Ajoutez votre logo et un en-tête et la liste des tâches à réaliser est prête à 
un usage professionnel.

Si vous désirez utiliser la liste sur l’ordinateur, créer deux styles de listes, une qui utilisera le carac-
tère U+E57C et une autre qui utilisera le caractère U+E531 (une case cochée). Créez la liste en 
utilisant le premier style puis cochez un élément en lui appliquant le second.

Selon l’usage prévu pour la liste, vous pouvez aussi créer un troisième style utilisant le caractère 
U+E532 (une case barrée par un X) pour indiquer les éléments qui n’ont pas été accomplis.

Figure 12.16 : Avec trois styles de liste, vous pouvez créer des listes de contrôle à remplir à la
main ou avec l’ordinateur.

Utiliser des images comme puces

L’utilisation d’images comme puces ordinaires est une façon simple d’ajouter un peu d’originalité à 
un document. Mais la petite taille à laquelle les puces sont affichées est souvent une limitation. 
Des images simples avec un fort contraste sont souvent nécessaires pour se substituer à une 
puce ; une image en noir et blanc sera la plupart du temps plus efficace.

Utiliser des images comme puces est aussi un moyen de les positionner sur une page. En particu-
lier, elles peuvent être utilisées pour créer des symboles pour indiquer des conseils ou attirer l’at-
tention dans un manuel technique ou un texte informel.

Dans tous les cas, choisissez le type d’image à utiliser dans le champ Nombre de l’onglet Person-
naliser de la boîte de dialogue Style de numérotation. Si vous sélectionnez Images, celle-ci sera 
incorporée au fichier du document ; à l’opposé, le choix Images liées n’ajoute qu’un lien vers 
l’image.
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Conseil

Si l’image est coupée, il faut en ajuster la taille ou modifier le réglage de l’Interligne (boîte de
dialogue Style de paragraphe, page Retraits et espacement) sur Au moins pour que le haut 
de l’image apparaisse.

Figure 12.17 : Les champs qui permettent de paramétrer une image utilisée comme puce
apparaissent quand vous avez choisi Images ou Images liées dans le champ Nombre.

Quand vous avez sélectionné Images ou Images liées, la boîte de dialogue offre une série de 
champs qui vous permettent de paramétrer la puce :

• le bouton Sélectionner… ouvre une boîte de dialogue pour choisir l’image ;

• les champs Largeur et Hauteur définissent la taille à laquelle l’image sera affichée. Ils ne mo-
difient pas l’image originale.

N’oubliez pas qu’une hauteur trop grande demandera de modifier le réglage de l’interligne 
sur Au moins pour que le haut de l’image ne soit pas coupé ;

• cochez l’option Proportionnel pour conserver le rapport largeur/hauteur quand vous modifiez 
l’une ou l’autre ;

• le champ Alignement peut souvent être ignoré mais peut rendre service quand la hauteur de 
l’image est plus grande que celle du texte, comme dans les puces qui introduisent les 
conseils, remarques et appels à l’attention de ce livre.

Exemple : style des conseils, remarques et appels à l’attention dans ce livre

Les styles de liste peuvent avoir bien d’autres usages que les listes. Par exemple, les conseils, re-
marques et appels à l’attention de ce livre utilisent des styles de liste pour positionner les images 
et le texte. Voici comment ont été créés les paragraphes d’introduction et de texte des conseils et 
comment les utiliser. Les deux autres ont été créés de la même manière mais avec un logo et un 
texte différents.

Première étape : créer un style de paragraphe pour le corps de la note.
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Le corps d’une note (conseil, remarque ou attention) dans ce livre est en retrait sous un para-
graphe introductif et se termine par une ligne qui l’isole du texte principal.

 1) Ouvrez l’onglet Styles de paragraphe du volet latéral. Faites un clic droit et choisissez Nou-
veau… dans le menu contextuel. Nommez le nouveau style Texte Remarque.

 2) Dans l’onglet Retraits et espacement (Figure 12.18), spécifiez le retrait et l’espacement du 
corps de notes.

Figure 12.18 : Choix des retraits et espacement pour le corps des notes

Figure 12.19 : Définir la bordure inférieure du corps de note
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 3) Dans l’onglet Bordures (Figure 12.19), activez une bordure en bas du paragraphe, augmen-
tez son épaisseur et précisez l’espacement entre le texte et la bordure. Cochez l’option Fu-
sionner avec le paragraphe suivant pour que la bordure ne soit tracée que sous le dernier 
paragraphe si la note en contient plusieurs.

 4) Paramétrez le style du paragraphe (police, etc.) de la manière habituelle.

Cliquez sur OK pour enregistrer le style du paragraphe.

Deuxième étape : créer le style de liste

 1) Dans le volet latéral, ouvrez l’onglet Styles de liste, faites un clic droit et sélectionnez Nou-
veau… Nommez le nouveau style Heading Note.

 2) Dans l’onglet Image (Figure 12.20), choisissez une image appropriée. (Vous pouvez aussi 
sauter cette étape et choisir une image dans l’onglet Personnaliser.)

Figure 12.20 : Choix d’une image pour la puce

 3) Dans l’onglet Personnaliser (Figure 12.21), choisissez Images dans le champ Nombre. Si 
vous le désirez, vous pouvez cliquer sur Sélectionner… dans le champ Images pour choisir 
une image dans un fichier ou dans la galerie.

Si l’image choisie est trop grande ou trop petite pour vos besoins, précisez une largeur et 
une hauteur. Vous pouvez utiliser ces champs pour déformer l’image d’origine.
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Figure 12.21 : Paramétrer la taille et l’alignement de l’image qui servira de puce.

 4) Dans le champ Alignement, sélectionnez l’endroit où vous désirez que l’image s’aligne avec 
le texte.

 5) Dans l’onglet Position (Figure 12.22), régler la position de l’image comme décrit à la section 
« Positionner les puces, les numéros et les éléments de la liste » page 332.

Figure 12.22 : Paramétrer la position et l’espacement de l’image.

 6) Cliquez sur OK pour enregistrer le style de liste.

Troisième étape : créer un style pour l’annonce de la note et le relier au style de liste

 1) Dans le volet latéral, ouvrez l’onglet Styles de paragraphe, faites un clic droit et choisissez 
Nouveau… Nommez le nouveau style Heading Note.

 2) Dans l’onglet Gestionnaire (Figure 12.23), indiquez que le Style de suite doit être celui que 
vous avez créé pour le corps de note, dans notre cas Texte Remarque.
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Figure 12.23 : Définir le style de suite du style Heading Tip.

 3) Paramétrez le style de paragraphe de la manière habituelle puis allez à l’onglet Plan & nu-
mérotation (Figure 12.24). Dans le champ Style de numérotation, sélectionnez le style de 
liste que vous venez de créer.

Figure 12.24 : Lier le style de liste au style de paragraphe.

 4) Cliquez sur OK pour enregistrer le style de paragraphe.

Quatrième étape : appliquer les styles de paragraphe annonce et texte de note.

 1) Tapez le mot « Remarque » dans un nouveau paragraphe. (Vous devez saisir au moins un 
caractère ou un espace, sinon l’image disparaîtra quand vous appuierez sur la touche 
Entrée, en ne laissant que le retrait mais sans puce.)

 2) Appliquez le style Heading Note au paragraphe.

 3) Appuyez sur la touche Entrée. Le paragraphe suivant devrait prendre automatiquement le 
style Texte Remarque. Tapez le texte du corps de la note. (Si vous avez commencé par taper
le texte, appliquez maintenant le style.)

Exemple de note

Voici ce que vous devez obtenir.
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Chapitre 13
Travailler avec les tableaux de
données





Introduction

Les tableaux représentent un moyen pratique pour organiser et présenter de grandes quantités 
d’informations, par exemple :

• des rapports techniques, financiers ou statistiques ;

• des catalogues de produits qui offrent la description, les prix, les caractéristiques et des pho-
tographies des produits ;

• des relevés de compte et des factures ;

• des listes de noms avec adresses, âges, professions et d’autres informations.

Les tableaux représentent souvent une alternative aux feuilles de calcul (classeurs) pour organiser
les données. Un tableau bien conçu peut aider le lecteur à mieux comprendre ce que vous voulez 
dire. Même si on utilise normalement des tableaux pour les textes et les nombres, on peut mettre 
d’autres objets, comme des images, dans les cellules. Les tableaux de Writer offrent quelques 
fonctions des classeurs : voir « Utiliser les fonctions de calcul dans un tableau » page 369

Les tableaux peuvent aussi être utilisés comme outils de mise en page pour positionner du texte 
dans des zones d’un document à la place de plusieurs caractères de tabulation. Un autre exemple 
est représenté par les en-têtes et pieds de page pour réaliser un positionnement indépendant de 
différents éléments comme un numéro de page, le titre du document, etc. Cette utilisation des ta-
bleaux est décrite au Chapitre 6 Mise en page : approfondissements, page 153 et suivantes.

Créer un tableau

Avant d’insérer un tableau, il vaut la peine de réfléchir au résultat visuel que vous voulez obtenir et 
d’estimer le nombre de lignes et de colonnes nécessaires. Tous les paramètres peuvent être modi-
fiés à une étape ultérieure, mais y penser avant vous fera gagner beaucoup de temps, car les mo-
difications d’un tableau entièrement mis en forme peuvent demander des efforts significatifs.

Insérer un nouveau tableau

Pour insérer directement un tableau avec les propriétés par défaut, cliquez sur
le bouton Insérer un tableau dans la barre d’outils standard. Dans la zone de
sélection qui s’ouvre alors, choisissez la taille du tableau (jusqu’à quinze lignes
et dix colonnes). Pour créer le tableau, cliquez dans la case qui se trouve en
bas à droite.

Pour insérer un nouveau tableau grâce à la boîte de dialogue Insérer un ta-
bleau (Figure 13.1), où vous pouvez préciser ses propriétés, placez le curseur
à l’endroit où vous voulez voir apparaître le tableau, puis utilisez une des mé-
thodes suivantes pour ouvrir la boîte de dialogue :

• sélectionnez Tableau > Insérer un tableau… dans la barre de menu ;

• appuyez sur Ctrl+F12 ;

• dans la barre d’outils standard, cliquez sur le bouton Insérer un tableau ( )puis sur Plus 
d’options… en bas de la zone de sélection.
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Figure 13.1 : La boîte de dialogue Insérer un tableau.

Paramètres généraux : dans le champ Nom, vous pouvez saisir un autre nom que celui proposé 
par défaut par Writer. Cela peut être utile si vous utilisez le navigateur pour passer rapidement 
d’une table à l’autre.

Dans les champs Colonnes et Lignes, précisez leur nombre pour le nouveau tableau. Vous pour-
rez modifier plus tard les dimensions du tableau si nécessaire.

Dans la rubrique Options, paramétrez les caractéristiques initiales du tableau :

• l’option En-tête permet l’utilisation d’un titre dans le tableau et de préciser le nombre de 
lignes utilisées à cette fin ;

le style de paragraphe Titre de tableau est appliqué par défaut dans les lignes d’en-tête. 
Vous pouvez modifier ce style dans l’onglet Styles et formatage du volet latéral pour changer 
ses paramètres par défaut ;

• l’option Répéter les lignes d’en-tête sur les nouvelles pages fait répéter la ou les premières 
lignes du tableau en haut d’une nouvelle page, si le tableau se poursuit sur la page suivante ;

• l’option Lignes d’en-têtes précise le nombre de lignes utilisées pour l’en-tête du tableau. La 
valeur par défaut est 1 ;

• l’option Ne pas scinder le tableau à travers les pages empêche d’étendre le tableau sur plus 
d’une page, ce qui peut être utile s’il commence vers la fin de la page et qu’il est préférable 
qu’il soit entièrement situé sur la page suivante. Si le tableau devient si long qu’il ne tient plus
sur une seule page, vous devez soit décocher cette option, soit couper manuellement le ta-
bleau ;

• l’option Bordures détermine si chaque cellule est entourée d’une bordure. Celle-ci peut être 
modifiée ou supprimée ultérieurement.

Remarque

Les valeurs par défaut de ces options peuvent être modifiées dans la page LibreOffice 
Writer – Tableau de la boîte de dialogue Options (Outils > Options), à la rubrique Nou-
veaux paramètres par défaut pour les tableaux.
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Le bouton AutoFormat ouvre une boîte de dialogue où vous pouvez sélectionner un des formats 
de tableau prédéfinis, aussi appelés styles de tableau. Voir « Appliquer des styles de tableau » 
page 363 pour plus d’informations. Cliquez sur OK quand vous avez choisi votre format de ta-
bleau.

Quand vous avez fait vos choix, cliquez sur le bouton Insérer. Writer crée alors un tableau de la 
largeur de la zone de texte (de la marge de gauche à celle de droite), dont toutes les colonnes ont 
la même largeur et les lignes la même hauteur. Vous pourrez ajuster plus tard les colonnes et les 
lignes selon vos besoins.

Créer des tableaux imbriqués

Il est possible de créer un tableau à l’intérieur d’un autre, imbriqué jusqu’à une profondeur limitée 
uniquement par l’imagination et les contraintes pratiques. La Figure 13.2 montre un exemple 
simple de tableaux imbriqués à deux niveaux. Le tableau coloré est à l’intérieur d’une cellule du ta-
bleau plus grand. Pour réaliser cela, il suffit de cliquer dans une cellule d’un tableau existant puis 
d’utiliser n’importe quelle méthode décrite dans la section « Insérer un nouveau tableau » ci-des-
sus.

Figure 13.2 : Exemple de tableaux imbriqués.

Créer un nouveau tableau grâce à l’AutoCorrection

Il est aussi possible de créer un tableau en tapant une suite de tirets (-) ou de tabulations séparées
par des signes plus (+). Ceux-ci indiquent la limite des colonnes alors que les tirets et les tabula-
tions servent à en préciser la largeur. Quand on utilise des tabulations, la valeur de l’intervalle de 
tabulation définie dans Outils > Options > LibreOffice Writer > Général détermine la largeur.

Par exemple, cette suite de caractères :

+------------------------------+---------------------+---------+

crée un tableau comme celui-ci :

Remarque

Cette option peut être activée ou non dans la boîte de dialogue Options d’AutoCorrection 
(Outils > AutoCorrection > Options d’AutoCorrection). Dans l’onglet Options, cochez ou 
non l’option Créer des tableaux.

Créer un tableau à partir de texte mis en forme

Il est possible de créer un tableau à partir d’un texte pur en utilisant Tableau > Convertir > Texte 
en tableau dans la barre de menu. Le texte à convertir doit contenir des caractères qui indiquent 
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où passer d’une colonne à l’autre. Les marques de paragraphe indiquent la fin d’une ligne du ta-
bleau.

Commencez par taper le texte ; si nécessaire, vérifiez que le séparateur de colonnes est bien à 
l’endroit que vous voulez. Sélectionnez le texte que vous voulez convertir en tableau et choisissez 
Tableau > Convertir > Texte en tableau pour ouvrir la boîte de dialogue visible à la Figure 13.3

Figure 13.3 : boîte de dialogue pour la conversion de texte en tableau.

La section Séparer le texte à offre quatre options pour le séparateur de colonnes dans le texte. 
Cochez Autre pour choisir le point par défaut (utile si vous importez un fichier.csv) ou tapez le ca-
ractère que vous voulez dans la zone de saisie. Les autres options sont identiques à celles de la 
boîte de dialogue Insérer un tableau visible à la Figure 13.1.

Cliquez sur OK pour convertir le texte en tableau.

Exemple

Dans cet exemple, nous allons convertir le texte suivant en tableau.

Ligne 1 Colonne 1 ; Ligne 1 Colonne 2 ; Ligne 1 Colonne 3

Ligne 2 Colonne 1 ; Ligne 2 Colonne 1 ; Ligne 2 Colonne 3

Dans ce cas, le caractère qui sépare les colonnes est un point-virgule. Sélectionnez le texte et 
choisissez Tableau > Convertir > Texte en tableau. On obtient le résultat suivant.

Ligne 1 Colonne 1 Ligne 1 Colonne 2 Ligne 1 Colonne 3

Ligne 2 Colonne 1 Ligne 2 Colonne 1 Ligne 2 Colonne 3

Remarque

Contrairement aux autres méthodes de création de tableaux, la conversion de texte en ta-
bleau préserve les styles de paragraphe et de caractère appliqués au texte initial.
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L’entrée de menu Convertir permet aussi de réaliser l’opération inverse : transformer un tableau 
en texte ordinaire. Cela peut être utile pour exporter le contenu du tableau dans un autre pro-
gramme.

Pour transformer un tableau en texte, placez le curseur quelque part dans le tableau, sélectionnez 
Tableau > Convertir > Tableau en texte dans la barre de menu, sélectionnez un caractère de sé-
paration entre les colonnes et cliquez sur OK pour terminer.

Mettre en forme l’agencement du tableau

Formater un tableau demande, de manière générale, deux étapes : formater l’agencement du ta-
bleau (qui est le sujet de cette section) et formater le texte du tableau (qui sera le sujet de la pro-
chaine section).

Conseil

Si vous appliquez des formatages identiques à l’agencement et au texte de plusieurs ta-
bleaux, l’utilisation de styles de tableau vous permettra de travailler plus rapidement et ap-
portera plus de cohérence à votre mise en page. Voir « Créer des styles de tableau » page
363.

Formater l’agencement suppose normalement une ou plusieurs des opérations suivantes : ajuster 
la taille du tableau et le positionner sur la page, ajuster les tailles des lignes et des colonnes, ajou-
ter ou supprimer des lignes ou des colonnes, fusionner ou scinder des cellules, modifier les bor-
dures et l’arrière-plan.

Paramètres par défaut

Si vous créez un tableau en utilisant la boîte de dialogue Insérer un tableau ou le bouton de même
nom dans la barre d’outils standard, celui-ci reçoit les paramètres par défaut suivants :

• le texte des cellules utilise le style de paragraphe Contenu de tableau qui, dans le modèle 
par défaut, est identique au Style par défaut de paragraphe ;

• le tableau occupe tout l’espace entre les marges (zone de texte) ;

• le tableau reçoit une fine bordure noire autour de chaque cellule (grille) ;

• en plus, si vous cochez l’option En-tête, les cellules des lignes de titre utilisent le style de pa-
ragraphe Titre de tableau.

Modifier les dimensions du tableau et le positionner

Avec les paramètres par défaut, un tableau nouvellement créé occupe toute la largeur de la zone 
de texte. Cela vous conviendra parfois, parfois vous préférerez un tableau plus petit. Pour modifier 
rapidement la taille d’un tableau, commencez par placer la souris sur la bordure droite ou gauche. 
Quand le curseur prend la forme d’une double flèche, tirez la bordure à son nouvel emplacement. 
Cette opération ne change la taille que de la première ou de la dernière colonne ; elle ne modifie 
pas l’alignement du tableau sur la page.

S’il vous faut un contrôle plus précis de la taille et de la position du tableau sur la page, ouvrez la 
boîte de dialogue Propriétés du tableau en sélectionnant Tableau > Propriétés… dans la barre de
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menu ou en faisant un clic droit n’importe où dans le tableau avant de choisir Propriétés du ta-
bleau… dans le menu contextuel.

Dans l’onglet Tableau de la boîte de dialogue (Figure 13.4), vous pouvez paramétrer l’alignement 
du tableau parmi les options suivantes :

• Automatique : c’est la valeur par défaut qui occupe toute la largeur de la zone de texte ;

• À gauche : aligne le tableau sur la marge de gauche ;

• De la gauche : vous permet de préciser dans le champ À gauche de la section Espacement 
la distance exacte que vous souhaitez entre le tableau et la marge de gauche ;

• À droite  : aligne le tableau sur la marge de droite ;

• Centrer : aligne le centre du tableau à mi-distance des marges de gauche et de droite. Si le 
tableau est plus large que la zone de texte, il s’étendra au-delà des marges ;

• Manuel : vous permet de préciser la distance entre les bords du tableau et les marges de 
gauche et de droite à la fois dans les champs de la section Espacement.

Figure 13.4 : L’onglet Tableau de la boîte de dialogue Propriétés du tableau.

Si vous choisissez un alignement autre que Automatique, le champ Largeur de la section Proprié-
tés s’active pour vous permettre de saisir la largeur que vous désirez pour votre tableau. Si vous 
cochez l’option Relatif, cette largeur est exprimée en pourcentage de celle de la zone de texte.

Dans la section Espacement, les champs Au-dessus et En dessous permettent de modifier la sé-
paration entre le texte et le tableau. Si la taille du tableau est inférieure à celle de la zone de texte, 
Writer insère des valeurs dans les champs À gauche et À droite. Vous pouvez y saisir vos propres 
valeurs, dans les deux si vous avez choisi comme alignement Manuel, dans le champ À gauche si 
vous avez choisi comme alignement De la gauche, À droite ou Centrer et dans le champ À droite 
si vous avez choisi comme alignement À gauche. Dans les autres cas, les champs ne sont pas ac-
cessibles. Notez que la somme de la largeur du tableau et des valeurs des espacements à gauche
et à droite ne doit pas dépasser la largeur de la zone de texte.

Modifier la taille des lignes et des colonnes

Il est possible d’ajuster la hauteur des lignes et la largeur des colonnes d’un tableau de plusieurs 
façons :
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• déplacer la souris près de la bordure d’une cellule et, quand le curseur se transforme en 
double flèche, cliquez et maintenez le bouton gauche appuyé en tirant la bordure à la posi-
tion souhaitée puis relâchez le bouton ;

• les séparateurs de colonnes sont indiqués sur la règle horizontale par des paires de fines 
lignes grises ; les séparateurs de lignes sont marqués de la même manière sur la règle verti-
cale. Vous pouvez modifier la dimension des lignes ou des colonnes en faisant glisser une 
de ces marques avec la souris jusqu’à l’emplacement voulu ;

• utiliser le clavier comme décrit ci-dessous.

Sélectionner Tableau > Taille dans la barre de menu offre aussi quelques possibilités de modifica-
tions de taille :

• choisissez l’entrée Largeur de colonne… ou Hauteur de ligne… pour taper une dimension 
dans une boîte de saisie pour chaque colonne ou ligne sélectionnable du tableau ;

• choisissez les entrées Largeur de colonne optimale ou Hauteur de ligne optimale pour 
rendre les colonnes ou lignes sélectionnées aussi étroites que possible mais encore adap-
tées à leurs contenus. L’option n’est disponible que si le tableau est sélectionné et possède 
un contenu ;

• choisissez les entrées Répartir les colonnes régulièrement ou Répartir les lignes régu-
lièrement pour leur redonner rapidement la même largeur ou la même hauteur. Cette option 
n’est disponible que si le tableau est sélectionné.

Pour un meilleur contrôle de la largeur de chaque colonne, utilisez l’onglet Colonnes de la boîte de
dialogue Propriétés du tableau.

Figure 13.5 : La boîte de dialogue Propriétés du tableau, onglet Colonnes.

Faites un clic droit sur le tableau et choisissez Propriétés du tableau… dans le menu contextuel 
ou choisissez directement Tableau > Propriétés… dans la barre de menu. Dans la boîte de dia-
logue Propriétés du tableau, ouvrez l’onglet Colonnes.
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• Adapter la largeur du tableau : si le tableau s’étend déjà d’une marge à l’autre, il ne peut pas 
s’étirer davantage et cette option ne peut alors servir qu’à réduire la largeur des colonnes. Si 
le tableau est plus étroit, augmenter la largeur d’une colonne va augmenter celle du tableau 
tout entier. Cette option n’est pas disponible si Automatique a été coché dans la section Ali-
gnement de l’onglet Tableau.

Si le tableau s’étend déjà au-delà des marges, quand l’option Adapter la largeur du tableau 
est cochée, toute tentative pour modifier la largeur d’une colonne va automatiquement faire 
diminuer celle-ci pour que le tableau tienne entre les marges tout en conservant intacte la 
largeur des autres colonnes.

• Ajuster les colonnes proportionnellement : cette option permet de modifier la largeur des co-
lonnes du même pourcentage en en changeant une seule. Si, par exemple, vous réduisez de
moitié la taille d’une colonne, celles de toutes les colonnes sont divisées par deux. Cette op-
tion n’est pas disponible si Automatique a été coché dans la section Alignement de l’onglet 
Tableau.

• Le champ Espace restant affiche la longueur dont vous pouvez encore agrandir le tableau 
avant d’atteindre les marges. Cette valeur ne peut pas être modifiée directement ; elle ne de-
viendra pas négative même si le tableau est plus grand que l’espace entre les marges 
gauche et droite.

• La largeur de chaque colonne peut être ajustée dans les champs de la section Largeur de 
colonne. Si vous avez plus de six colonnes, utilisez les flèches à droite et à gauche de la 
liste pour les faire défiler. Si aucune option n’est cochée, la colonne qui se trouve juste à 
droite de celle dont vous modifiez la largeur est automatiquement ajustée pour conserver 
constante la largeur du tableau. Si vous modifiez la colonne la plus à droite, c’est la première
colonne qui est automatiquement ajustée.

Conseil

Au lieu de commencer par la boîte de dialogue Propriétés du tableau, il est souvent plus effi-
cace de faire des ajustements grossiers du tableau à l’aide de la souris avant d’affiner la dis-
position grâce à l’onglet Colonne en association avec l’onglet Tableau de la boîte de dia-
logue Propriétés du tableau.

Il est aussi possible de redéfinir les dimensions d’un tableau en ne se servant que du clavier, ce 
qui est parfois plus simple qu’utiliser la souris.

 1) Placez le curseur dans la cellule que vous voulez modifier.

 2) Appuyez sur la touche Alt et maintenez-la enfoncée en utilisant les touches fléchées.

─ Les flèches vers la gauche ou la droite ajustent la largeur de la colonne en déplaçant la 
bordure droite de la cellule sans dépasser la marge ;

─ Les flèches vers le haut ou le bas ajustent la hauteur de la ligne (quand cela est possible) 
en déplaçant la bordure du bas de la cellule.

 3) Appuyez sur les touches Maj+Alt et maintenez-les enfoncées en utilisant les touches flé-
chées vers la droite ou la gauche.

─ Cela vous permet d’ajuster la largeur de la colonne en déplaçant la bordure gauche de la 
cellule sans dépasser la marge.
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Pour régler les paramètres de redimensionnement et le comportement du clavier, ouvrez la page 
LibreOffice Writer – Tableau de la boîte de dialogue Options en sélectionnant Outils > Options 
dans la barre de menu.

Les champs Ligne et Colonne de la section Déplacer des cellules déterminent la valeur dont la lon-
gueur de la cellule est modifiée à chaque appui sur une touche fléchée. Dans la section Comporte-
ment des lignes/colonnes, vous pouvez choisir une des trois stratégies de redimensionnement sui-
vantes :

• Fixe : cochez cette option si vous désirez que la modification de dimension n’affecte que les 
cellules adjacentes et non le tableau entier. La largeur du tableau ne change pas quand on 
modifie ses cellules ;

• Fixe, proportionnel : quand cette option est cochée, toutes les autres cellules sont aussi redi-
mensionnées proportionnellement, mais en sens opposé de façon à conserver la largeur du 
tableau ;

• Variable : c’est l’option par défaut. Le changement de dimension affecte la taille du tableau. 
Par exemple, si vous élargissez une cellule, la largeur du tableau augmente.

Redimensionner individuellement les cellules

Placez le curseur dans la cellule que vous désirez modifier.

 1) Appuyez sur les touches Ctrl+Alt et maintenez-les enfoncées pendant que vous utilisez 
les flèches vers la gauche et la droite. La longueur de la cellule est modifiée en déplaçant la 
bordure droite sans dépasser les marges.

 2) Appuyez sur les touches Maj+Ctrl+Alt maintenez-les enfoncées pendant que vous utili-
sez les flèches vers la gauche et la droite. La longueur de la cellule est modifiée en dépla-
çant la bordure gauche sans dépasser les marges.

Voir aussi « Fusionner et scinder des cellules » à la page 357.

Insérer des lignes et des colonnes

Pour insérer rapidement une ligne ou une colonne, effectuez une des actions suivantes :

• cliquez sur le bouton Lignes au-dessus ( ) ou Lignes en dessous ( ) de la barre d’ou-
tils Tableau pour insérer une ligne au-dessus ou en dessous de celle où se trouve le curseur.
Cliquez sur Colonnes à gauche ( )ou Colonnes à droite ( ) pour insérer une colonne à 
gauche ou à droite de celle où se trouve le curseur ;
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• placez le curseur dans la ligne (ou la colonne) qui précède ou qui suit celle où vous voulez 
ajouter de nouvelles lignes (ou colonnes), faites un clic droit et choisissez Insérer > Lignes 
au-dessus ou Lignes en dessous (Insérer > Colonnes à gauche ou Colonnes à droite).

Pour insérer un nombre quelconque de lignes ou de colonnes :

 1) Placez le curseur dans la ligne (ou la colonne) où vous voulez ajouter de nouvelles lignes 
(ou colonnes) et faites un clic droit.

 2) Dans le menu contextuel, sélectionnez Insérer > Lignes… (ou Insérer > Colonnes…) pour 
ouvrir une boîte de dialogue où vous pourrez choisir le nombre de lignes (ou de colonnes) à 
ajouter et si elles doivent être placées Avant ou Après celle où se trouve le curseur.

 3) Choisissez le nombre de lignes (ou de colonnes) à insérer et leur position.

 4) Cliquez sur OK pour refermer la boîte de dialogue et insérer les lignes (ou les colonnes).

Les entrées Tableau > Insérer > Lignes et Tableau > Insérer > Colonnes de la barre de menu 
offrent les mêmes possibilités.

Remarque

Quelle que soit la méthode employée pour les insérer, les nouvelles lignes ou colonnes ont 
le même formatage que celle où était placé le curseur avant leur insertion.

Vous pouvez aussi insérer rapidement une ligne ou une colonne avec le clavier :

 1) Placez le curseur dans la ligne ou la colonne voisine de celle que vous voulez insérer.

 2) Appuyez sur Alt+Insér. pour activer le gestionnaire de curseur.

 3) Utilisez les touches fléchées selon vos souhaits pour ajouter une ligne ou une colonne :

─ flèche gauche pour insérer une nouvelle colonne à gauche de la cellule où se trouve le 
curseur,

─ flèche droite pour insérer une nouvelle colonne à droite de la cellule où se trouve le cur-
seur,

─ flèche vers le bas pour insérer une nouvelle ligne sous la cellule où se trouve le curseur,

─ flèche vers le haut pour insérer une nouvelle ligne au-dessus de la cellule où se trouve le 
curseur.

Supprimer des lignes et des colonnes

Pour supprimer rapidement une ou plusieurs lignes (ou colonnes), placez le curseur dans la ligne 
(ou la colonne) que vous voulez supprimer et effectuez une des actions suivantes :

• cliquez sur le bouton Lignes ( ) ou Colonnes ( ) de la barre d’outils Tableau ;

• faites un clic droit et choisissez Supprimer > Lignes ou Supprimer > Colonnes dans le 
menu contextuel ;

• appuyez sur les touches Alt+Suppr. puis utilisez les touches fléchées pour supprimer 
lignes ou colonnes comme décrit ci-dessus pour l’insertion.
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Fusionner et scinder des cellules

Pour fusionner un groupe de cellules en une seule :

 1) Sélectionnez les cellules à fusionner.

 2) Faites un clic droit dans le groupe et choisissez Fusionner les cellules dans le menu 
contextuel ou Tableau > Fusionner les cellules dans la barre de menu. Tout le contenu des 
cellules apparaîtra dans la cellule fusionnée.

Vous pouvez aussi cliquer sur le bouton Fusionner les cellules ( ) de la barre d’outils Ta-
bleau.

Pour fusionner une cellule unique avec une cellule adjacente, vous pouvez aussi placer le 
curseur dans la cellule (l’origine), appuyer sur Alt+Suppr, relâcher puis, en appuyant sur 
Ctrl, appuyer sur la flèche droite ou gauche. Tout le contenu de la cellule d’origine est per-
du.

Pour scinder une cellule en plusieurs cellules :

 1) Placez le curseur dans la cellule.

 2) Faites un clic droit et choisissez Scinder les cellules dans le menu contextuel ou Tableau >
Scinder les cellules… dans la barre de menu.

Vous pouvez aussi cliquer sur le bouton Scinder les cellules ( ) de la barre d’outils Ta-
bleau.

 3) Choisissez le sens du partage : la cellule peut être partagée horizontalement (en créant de 
nouvelles cellules sous elle) ou verticalement (en créant de nouvelles cellules à sa droite). 
Précisez le nombre de cellules à créer.

Pour scinder une cellule unique, vous pouvez aussi placer le curseur dans une cellule adja-
cente, appuyer sur Alt+Insér, relâcher puis, en appuyant sur Ctrl, appuyer sur la flèche 
droite ou gauche pour scinder la cellule dans la même direction.

D’une manière générale, il vaut mieux fusionner ou scinder les cellules après avoir effectué les 
autres mises en forme du tableau, parce que certaines opérations, telles que supprimer une co-
lonne ou une ligne, peuvent produire un résultat difficile à prévoir quand on les applique à un ta-
bleau comportant des cellules fusionnées ou scindées.

Définir les bordures du tableau

Dans la boîte de dialogue Propriétés du tableau, ouvrez l’onglet Bordures (Figure 13.6). Vous pou-
vez y paramétrer les bordures pour le tableau entier ou pour un groupe de cellules à l’intérieur de 
celui-ci. Vous pouvez en plus adjoindre une ombre au tableau entier.

Les bordures ont trois caractéristiques : leur emplacement, leur aspect et l’espace entre elles et le 
contenu.

• Disposition des lignes définit l’emplacement des lignes. Si un groupe de cellules est sélec-
tionné, la bordure ne sera appliquée qu’à celui-ci. Vous pouvez spécifier des styles différents 
pour la bordure des limites extérieures des cellules sélectionnées ainsi que pour les lignes 
séparatrices. Writer propose cinq dispositions par défaut mais vous pouvez cliquer sur la 
ligne que vous voulez personnaliser dans la zone d’aperçu Défini par l’utilisateur pour obtenir
ce que vous désirez. Quand plusieurs cellules sont sélectionnées, cette zone vous permet 
sélectionner aussi bien les limites de la sélection que les lignes de séparation internes.
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Remarque

Quand les cellules sélectionnées ont des styles de bordures différents, la zone d’aperçu Dé-
fini par l’utilisateur affiche la bordure sous forme d’une ligne grise. Vous pouvez cliquer sur 
cette ligne pour choisir un nouveau style de bordure (premier clic), laisser la bordure telle 
qu’elle est (deuxième clic) ou la supprimer (troisième clic).

Figure 13.6 : La boîte de dialogue Propriétés du tableau, page Bordures.

• Ligne spécifie l’aspect de la bordure : son style, sa largeur, sa couleur. De nombreux styles 
et couleurs sont proposés. Style, largeur et couleur s’appliquent aux lignes marquées par 
une paire de flèches noires dans la zone d’aperçu Défini par l’utilisateur sur la gauche de la 
boîte de dialogue.

• Remplissage précise la distance entre la bordure et le contenu de la cellule. L’espace peut 
être défini dans les quatre directions. Cochez l’option Synchroniser pour avoir la même dis-
tance des quatre côtés. Cet espace n’intervient pas dans le calcul des mesures du texte.

• Style d’ombre est une propriété qui s’applique toujours à tout le tableau. L’ombre a trois pro-
priétés : son emplacement (champ Position), la distance du tableau à laquelle elle est proje-
tée (champ Distance) et sa couleur (champ Couleur).

• Si l’option Fusionner les lignes adjacentes est cochée, deux cellules qui partagent une li-
mite commune verront leurs bordures fusionnées au lieu qu’elles soient côte à côte ou l’une 
en dessous de l’autre.
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Conseil

Pour tout réinitialiser si vous avez des difficultés avec les bordures, faites un clic droit dans 
le tableau et choisissez Propriétés… du tableau dans le menu contextuel ou sélectionnez 
Tableau > Propriétés… dans la barre de menu. Dans l’onglet Bordures, cliquez sur l’icône 
Définir sans bordures parmi les préréglages de la section Disposition des lignes (l’icône la 
plus à gauche).

Choisir les couleurs et images d’arrière-plan

Un arrière-plan peut fortement accroître la lisibilité des données d’un tableau en en mettant en va-
leur les parties importantes, telles qu’un en-tête ou une cellule particulière, ou seulement en le ren-
dant plus attractif. Vous avez le choix entre deux types d’arrière-plan : une couleur unie ou une 
image. L’arrière-plan peut s’appliquer à tout le tableau, à une cellule unique ou à une ligne.

Conseil
Il faut prendre en compte le contraste de couleur entre l’arrière-plan et le premier plan (habi-
tuellement le texte).

Le choix d’un arrière-plan de ligne se révèle assez pratique si vous désirez créer des lignes 
de couleurs alternées ou affecter un arrière-plan différent à l’en-tête du tableau.

Pour paramétrer l’arrière-plan d’une cellule, d’une ligne ou d’un tableau :

 1) Placez le curseur quelque part dans la cellule, la ligne ou le tableau que vous voulez para-
métrer. Si vous désirez travailler avec un groupe de cellules, commencez par le sélectionner.

 2) Faites un clic droit et choisissez Propriétés du tableau… dans le menu contextuel ou sélec-
tionnez Tableau > Propriétés… dans la barre de menu.

 3) Dans la boîte de dialogue Propriétés du tableau, ouvrez l’onglet Arrière-plan (Figure 13.7).

 4) Dans le champ Pour, choisissez si l’arrière-plan va s’appliquer à la cellule, à la ligne ou au 
tableau.

─ Cellule : l’arrière-plan ne s’applique qu’aux cellules sélectionnées ou à la cellule où se 
trouve le curseur. Même quand un groupe de cellules est sélectionné, l’arrière-plan est ap-
pliqué séparément à chacune d’elles,

─ Ligne : l’arrière-plan affecte toute la ligne où se trouve le curseur,

─ Tableau : l’arrière s’applique à la totalité du tableau, indépendamment de la position du 
curseur ou les cellules sélectionnées.
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Figure 13.7 : Insérer une image d’arrière-plan

Remarque
L’arrière-plan choisi pour une cellule masquera celui de la ligne qui cachera lui-même celui 
du tableau.

L’arrière-plan du tableau est 
vert pâle

L’arrière-plan de cette ligne 
est bleu clair

L’arrière-plan de cette cellule 
est jaune

L’arrière-plan de cette cellule 
est jaune

 5) Dans le champ Comme, choisissez si l’arrière-plan sera une couleur ou une image.

Pour appliquer une couleur, choisissez-la puis cliquez sur OK.

Pour appliquer une image :

 a) Cliquez sur le bouton Parcourir… pour choisir une image dans le système de fichiers de 
votre ordinateur.

 b) Si vous cochez l’option Lier, les modifications de l’image (par exemple, avec un logiciel 
d’édition d’images) se refléteront dans votre document, mais vous devrez maintenir le fi-
chier de l’image liée avec le fichier du document. Par exemple, si vous envoyez le docu-
ment par courriel sans le fichier de l’image, celle-ci ne sera plus visible.

 c) Dans la section Type, choisissez le type de mise en place de l’image.
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─ Position : choisissez la position où l’image sera affichée en cliquant sur un des neuf em-
placements du panneau central adjacent,

─ Remplissage : l’image sera étendue pour remplir toute la zone,

─ Mosaïque : l’image sera répétée horizontalement et verticalement pour remplir la zone,

 d) Cochez l’option Aperçu pour afficher l’image dans le panneau de droite.

 e) Cliquez sur OK pour appliquer l’image en arrière-plan.

Nouveau dans la version 6.1

L’onglet Arrière-plan de la boîte de dialogue a été modifié pour avoir le même aspect que les
autres onglets du même nom, ce qui permet l’utilisation des palettes de couleurs.

Aspect de l’onglet Arrière-plan pour le choix d’une couleur de fond dans Writer 6.1
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Aspect de l’onglet Arrière-plan pour le choix d’une image de fond dans Writer 6.1

La Figure 13.8 montre un exemple de tableau possédant une image d’arrière-plan et une première 
ligne dont le fond est coloré. Comme vous pouvez le voir, le fond de la ligne recouvre celui du ta-
bleau.

Figure 13.8 : Exemple d’arrière-plans différents pour le tableau et sa première ligne

Afficher ou masquer les limites du tableau

Les limites d’un tableau sont de fines lignes claires (normalement, grises) autour des cellules et qui
sont visibles sur l’écran dans LibreOffice quand aucune bordure n’est définie. Elles ne sont pas im-
primées, leur seule fonction étant de vous aider à visualiser la position des cellules.

Pour afficher les tableaux de la même manière sur l’écran et sur la page imprimée, sans ces li-
mites, ouvrez la page LibreOffice – Couleurs de l’interface de la boîte de dialogue Options (Outils 
> Options). Vous pourrez y décocher l’option Délimitations du tableau pour masquer les limites 
(ou la cocher pour les afficher) et choisir la couleur des lignes. C’est aussi là que vous pouvez faire

362 | Guide de LibreOffice Writer Mettre en forme l’agencement du tableau



 Chapitre 13 Travailler avec les tableaux de données

le choix d’afficher ou masquer les limites du texte, des en-têtes et pieds de page, des figures et 
d’autres parties du document.

Remarque

Masquer les limites n’a aucun effet sur les bordures que le tableau peut posséder.

Créer et appliquer des styles de tableau

Grâce aux styles de tableau, il est possible d’appliquer une mise en forme élaborée aux tableaux 
en à peine quelques clics. Comme les autres styles, les styles de tableau permettent de donner un
aspect visuel cohérent aux tableaux d’un document.

Appliquer des styles de tableau

Pour appliquer un style à un tableau, ouvrez le panneau Styles de tableau de l’onglet Styles et for-
matage du volet latéral (dernier bouton à droite), placez le curseur dans le tableau et faites un 
double clic sur le nom d’un style.

Créer des styles de tableau

Avant la version 5.3, LibreOffice n’offrait pas de styles de tableau, mais il possédait des AutoFor-
mats pour ceux-ci. Désormais, bien que la fenêtre Styles et formatage offre un moyen rapide et 
simple pour appliquer des styles de tableau, ceux-ci sont toujours créés grâce à la fonction Auto-
Format. Procédez de la manière suivante :

 1) Créez un tableau. Mettez-le en forme à votre convenance : police, alignements, bordures, ar-
rière-plan, formats numériques.

 2) Placez le curseur quelque part dans le tableau et sélectionnez Tableau > Styles d’AutoFor-
mat… dans la barre de menu.

 3) Dans la boîte de dialogue AutoFormat (Figure 13.9), choisissez les formats que vous voulez 
inclure dans le nouveau style de tableau puis cliquez sur Ajouter.

Figure 13.9 : La boîte de dialogue AutoFormat de tableau.
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 4) Dans la boîte de dialogue qui s’ouvre alors, tapez le nom du nouveau style puis cliquez sur 
OK. Le nouveau style est ajouté à la liste des formats dans la boîte de dialogue AutoFormat 
et à celle des styles de tableau dans la fenêtre Styles et formatage.

Vous pouvez renommer le format de tableau sélectionné et décider quelles parties de la mise en 
forme prédéfinie vous désirez appliquer à votre tableau. Vous pouvez, au choix, appliquer le format
numérique, la police, l’alignement, la bordure ou le motif.

Remarque

Il n’est pas possible de renommer ni de supprimer le Style par défaut. Sur la Figure 13.9, 
vous constatez que, si ce style est sélectionné, les boutons Supprimer et Renommer sont 
désactivés.

Les styles de tableau (styles d’AutoFormats…) incluent aussi les propriétés de tableau suivantes :

• Saut

• Conserver avec le paragraphe suivant

• Répéter le titre

• Autoriser le fractionnement du tableau sur plusieurs pages

• Autoriser le fractionnement des lignes sur plusieurs pages

• Fusionner les styles de ligne adjacents

• Ombre du tableau

Conseil

Ces styles ne comportent pas les largeurs du tableau et des colonnes. Pour insérer un ta-
bleau avec un formatage entièrement prédéfini, enregistrez-le comme AutoTexte. Voir « Uti-
liser l’AutoTexte » dans le Chapitre 2 Travailler avec le texte : les bases, page 62, pour la 
méthode à utiliser.

Mettre en forme le texte d’un tableau

Une fois satisfait de l’apparence du tableau, vous pouvez passer au formatage du texte dans 
chaque cellule. Vous pouvez y appliquer une mise en forme manuelle comme pour tout autre para-
graphe de texte, mais il est hautement recommandé, pour des raisons de cohérence et de facilité 
de maintenance, d’utiliser des styles de paragraphe et de caractère.

En plus des styles de paragraphe et de caractères, d’autres aspects sont à prendre en considéra-
tion avant de placer du texte dans une cellule d’un tableau ; parmi ceux-ci, l’enchaînement, l’ali-
gnement et l’orientation du texte.

Vous pouvez formater chaque cellule individuellement ou le faire en une seule fois pour un groupe 
de cellules que vous aurez sélectionnées au préalable.
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Conseil

Vous pouvez appliquer un formatage de base au texte du tableau en choisissant un style de 
tableau puis modifier la mise en forme du texte uniquement dans les cellules auxquelles 
vous souhaitez donner une apparence différente.

Définir l’enchaînement

Figure 13.10 : L’onglet Enchaînements de la boîte de dialogue Propriétés du tableau.

Dans l’onglet Enchaînements de la boîte de dialogue Propriétés du tableau (Figure 13.10), vous 
pouvez :

• insérer un saut de page ou de colonne avant ou après le tableau. Cochez l’option Saut de la 
section Enchaînements, associée aux options Page ou Colonne et Avant ou Après. Si vous 
insérez un saut de page avant le tableau (la nouvelle page commencera donc par le ta-
bleau), vous pouvez aussi modifier le style de page qui suivra le saut en cochant l’option 
Avec le style de page et en choisissant celui-ci dans la liste déroulante. Comme pour n’im-
porte quel saut de page, vous pouvez aussi faire recommencer la numérotation en cochant 
l’option Numéro de page et en choisissant le premier numéro dans le champ voisin ;

• conserver un tableau sur une seule page en décochant l’option Autoriser le fractionnement 
des tableaux sur plusieurs pages et colonnes. Dans ce cas, l’option suivante est désactivée ;

• conserver chaque ligne sur une seule page en décochant l’option Autoriser le fractionnement
des lignes sur plusieurs pages et colonnes ;

• conserver ensemble le tableau et le paragraphe qui le suit si vous insérez un saut de page 
en cochant l’option Conserver avec le paragraphe suivant ;

• répéter le titre du tableau sur chaque page en cochant l’option Répéter le titre et en sélec-
tionnant dans le champ voisin le nombre de lignes dont il est constitué. Un tableau complexe 
peut nécessiter deux ou trois lignes de titre pour être facilement lu et compris ;
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• choisir l’orientation du texte dans les cellules grâce à l’option Orientation du texte. Vous avez 
le choix entre Horizontal, Vertical et Utiliser les paramètres de l’objet supérieur (c’est-à-dire 
utiliser l’orientation par défaut de la page) ;

• choisir l’alignement vertical du texte dans le tableau ou les cellules sélectionnées parmi les 
choix suivants : en haut, au milieu ou en bas de la cellule.

Remarque

Une ligne d’en-tête d’un tableau ne peut pas se partager sur deux pages, contrairement aux 
autres lignes. Un tableau à ligne unique (souvent utilisé pour la mise en page) ne permettra 
pas les sauts de page s’il est configuré par défaut avec une ligne de titre. La solution 
consiste à vérifier que l’option Répéter le titre est décochée pour ce tableau.

Alignement vertical

Le texte saisi dans un tableau est, par défaut, aligné en haut à gauche de la cellule. Il est possible 
de modifier ce comportement par défaut du tableau comme décrit ci-dessus ou pour des cellules 
choisies individuellement.

Pour aligner verticalement le texte dans des cellules particulières :

 1) Placez le curseur dans la cellule que vous désirez modifier ou sélectionnez plusieurs cel-
lules.

 2) La barre d’outils Tableau devrait être affichée (sinon sélectionnez Affichage > Barres d’ou-
tils > Tableau dans la barre de menu) et cliquez sur un des boutons Aligner en haut ( ), 
Centrer verticalement ( ), Aligner en bas ( ).

Formats des nombres

Le format numérique peut être défini pour l’ensemble du tableau ou pour un groupe de cellules. 
Par exemple, vous pouvez paramétrer des cellules pour afficher une monnaie particulière, quatre 
chiffres décimaux ou une date dans un format particulier.

Pour activer la reconnaissance des nombres, ouvrez la page LibreOffice Writer – Tableau de la 
boîte de dialogue Options en sélectionnant Outils > Options dans la barre de menu et cochez 
l’option dans la section Saisie dans les tableaux.

Si l’option est cochée, les nombres d’un tableau sont reconnus et formatés en tant que nombres, 
sinon ils sont enregistrés au format texte et automatiquement alignés à gauche.

Pour définir le format des nombres d’une ou plusieurs cellules, sélectionnez-les puis cliquez sur 
l’icône d’un des formats courants dans la barre d’outils Tableau (  : standard ;  : monnaie ;  
: pourcentage ;  : décimal ;  : date) ou faites un clic droit et choisissez Format numérique… 
dans le menu contextuel. Dans la boîte de dialogue Formater le nombre (Figure 13.11), vous trou-
verez un choix d’options pour diverses catégories de données numériques.
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Figure 13.11 : La boîte de dialogue Formater le nombre

• Dans la liste Catégorie, choisissez le type de données qui vous concerne : monnaie, date, 
texte…

• Dans la liste Format, choisissez un format pour le type de données que vous venez de sé-
lectionner.

• Pour certaines catégories, comme une date par exemple, vous désirerez peut-être changer 
la langue grâce à la liste Langue, alors que pour d’autres types de données numériques 
vous pourrez utiliser la section Options pour personnaliser leur apparence.

Astuce

Writer affiche le code de formatage pour la catégorie et le format sélectionnés dans la sec-
tion Description de format en bas de la boîte de dialogue. Par exemple, si vous sélection-
nez 31 déc. 1999 comme format de date, le code correspondant est J MMM AAAA. Les utili-
sateurs expérimentés peuvent facilement personnaliser celui-ci pour créer de nouveaux for-
mats.

Orienter verticalement le texte dans une cellule d’un tableau

Il est possible de faire pivoter le texte dans une cellule de 90° ou 270°. Cette manœuvre peut être 
utile si vous avez des titres longs dans des colonnes étroites.

• Sélectionnez le texte à incliner puis choisissez Format > Caractère… dans la barre de menu
ou faites un clic droit et choisissez Caractère… dans le menu contextuel.

• Dans la section Rotation / Échelle de l’onglet Position, cochez l’angle de rotation souhaité 
puis cliquez sur OK.

La Figure 13.12 montre un exemple de tableau dont les titres ont été orientés verticalement.
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Figure 13.12 : Tableau avec des titres orientés verticalement.

Remarque

La rotation du texte peut aussi être réalisée au moyen de styles de paragraphe comme pré-
senté en détail au Chapitre 9 Travailler avec les styles, page 243.

Saisie et manipulation de données dans les tableaux

Déplacement parmi les cellules

À l’intérieur d’un tableau, vous pouvez utiliser la souris, les touches fléchées et la touche 
Tabulation pour vous déplacer de cellule en cellule.

Les touches fléchées déplacent le curseur d’un caractère vers la droite ou la gauche à la fois. 
Dans une cellule vide, appuyer sur une touche fléchée déplace le curseur dans la cellule voisine.

La touche Tabulation fait directement passer à la cellule suivante et, si le curseur se trouve 
dans la dernière cellule du tableau, crée une nouvelle ligne. Appuyer sur Maj+Tabulation fait re-
culer le curseur d’une cellule.

Conseil

Pour saisir un caractère de tabulation comme élément du texte de la cellule, appuyez en 
même temps sur les touches Ctrl+Tabulation.

Pour atteindre le début du tableau, appuyez sur Ctrl+Début. Si la cellule active est vide, le dé-
placement se fait au début du tableau. Si elle possède un contenu, le premier appui déplace le cur-
seur au début de la cellule et le suivant au début du tableau (un troisième l’envoie au début du do-
cument).

Pour atteindre la fin du tableau, appuyez sur Ctrl+Fin. Si la cellule active est vide, le déplace-
ment se fait à la fin du tableau. Si elle possède un contenu, le premier appui déplace le curseur à 
la fin de la cellule et le suivant à la fin du tableau (un troisième l’envoie à la fin du document).

Trier les données d’un tableau

Writer permet de trier les données d’un tableau comme on peut le faire dans un tableur. Au maxi-
mum trois niveaux de tri peuvent être définis (par exemple, d’abord numériquement par âge, puis 
alphabétiquement par nom pour chaque âge).
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Pour trier les données d’un tableau :

 1) Sélectionnez le tableau (ou la partie du tableau) à trier.

 2) Choisissez Tableau > Trier… dans la barre de menu ou cliquez sur le bouton Trier ( ) 
dans la barre d’outils Tableau.

 3) Dans la boîte de dialogue Trier (Figure 13.13) :

 a) Dans la section Direction, choisissez si vous désirez trier les Lignes ou les Colonnes. Par
défaut le tri se fait par lignes et ce sont donc les données d’une colonne qui sont triées.

 b) Cochez jusqu’à trois critères de tri dans l’ordre adéquat.

 c) Pour chaque critère, choisissez le numéro de la ligne ou de la colonne à trier, si le tri doit 
être numérique ou alphanumérique et s’il doit être effectué dans l’ordre Croissant ou Dé-
croissant.

 d) Cliquez sur OK pour réaliser le tri.

Figure 13.13 : Choix des critères de tri

! Attention

Il est indispensable de sélectionner toutes les cellules qui peuvent être affectées par le tri. 
Si, par exemple, vous ne sélectionnez que les cellules d’une seule colonne, seules ces cel-
lules seront triées alors que les autres colonnes resteront inchangées et les données de 
chaque ligne seront mélangées.

Utiliser les fonctions de calcul dans un tableau

Dans un tableau d’un document de Writer, il est possible d’utiliser certaines fonctions mathéma-
tiques normalement implémentées par LibreOffice Calc. Pour de nombreuses fonctions simples, 
les tableaux de Writer peuvent servir de feuilles de calcul simples.
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Tout comme dans une feuille de calcul, chaque cellule du tableau est identifiée par une lettre (pour 
la colonne) et un nombre (pour la ligne). La cellule C4 est, par exemple, à l’intersection de la troi-
sième colonne en partant de la gauche et de la quatrième ligne en partant du haut. Quand le cur-
seur est dans une cellule, le nom du tableau et la référence de la cellule sont affichés dans la barre
d’état.

Figure 13.14 : Nom du tableau et coordonnées de la cellule dans la barre d’état

Conseil

Les fonctions de calcul de base sont pratiquement les mêmes que dans LibreOffice Calc. La
principale différence est que les références de cellule sont formatées de manières diffé-
rentes. La cellule A2 (première colonne, deuxième ligne) est notée A2 (ou $A$2 en réfé-
rence absolue) dans Calc et elle se note <A2> dans Writer.

Supposons, par exemple, que vous ayez deux nombres dans les cellules <B1> et <C2> dont vous 
voulez afficher la somme dans la cellule <A1> comme sur la Figure 13.15.

Figure 13.15 : Utilisation des fonctions de calcul dans un tableau

Procédez comme ceci :

 1) Cliquez dans la cellule <A1> et appuyez sur la touche =, choisissez Tableau > Formule 
dans la barre de menu ou appuyez sur la touche F2. La barre de formule apparaît automati-
quement vers le haut de l’écran. À l’extrémité gauche de la barre, vous pouvez voir les coor-
données de la cellule sélectionnée.

 2) Cliquez dans la cellule <B1>. La référence de cette cellule s’affiche automatiquement dans la
barre de formule et dans la cellule <A1>.

 3) Appuyez sur la touche +.

 4) Cliquez dans la cellule <C2>. La formule est automatiquement complétée, à la fois dans la 
barre de formule et dans la cellule <A1>.

 5) Appuyez sur la touche Entrée ou cliquez sur le bouton vert ( ) de la barre de formule pour 
remplacer la formule dans la cellule par le résultat du calcul.
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Conseils
Pour afficher la formule d’une cellule et pouvoir la modifier, sélectionnez Tableau > Formule 
dans la barre de menu ou appuyez sur F2.

Pour afficher la liste des fonctions mathématiques que vous pouvez utiliser dans un tableau,
affichez la barre de formule en appuyant sur F2 ou en sélectionnant une cellule vide et en 
appuyant sur = puis cliquez sur l’icône Fonctions ( ).

Dans notre exemple, le résultat est 9 dans la cellule en haut
à gauche. Pour additionner des cellules contiguës, vous
pouvez vous contenter de sélectionner les cellules en ligne,
en colonne ou en rectangle. Pour faire la somme d’une co-
lonne de nombres, procédez comme suit :

 1) Tapez le signe = dans une cellule vide.

 2) Sélectionnez les cellules dont vous voulez calculer la
somme (de A2 à A5 dans notre cas). La formule de-
vrait ressembler à =<A2:A5>.

 3) Appuyez sur la touche Entrée ou cliquez sur le bou-
ton vert ( ) dans la barre de formule.

 4) Le résultat apparaît dans la cellule que vous avez sé-
lectionnée au départ.

Pour utiliser une fonction, vous pouvez saisir les cel-
lules manuellement ou les sélectionner. Ainsi, pour
additionner les quatre nombres précédents (A2, A3,
A4 et A5), procédez comme suit :

 1) Tapez un signe = dans une cellule vide.

 2) Tapez sum ou sélectionnez la fonction Somme
dans la liste des fonctions.

 3) Sélectionnez les cellules contiguës à addition-
ner les unes aux autres. La formule devrait res-
sembler à =sum <A2:A5>.

 4) Appuyez sur la touche Entrée ou cliquez sur
le bouton vert ( ) dans la barre de formule.

 5) Le résultat apparaît dans la cellule que vous avez sélectionnée au départ.

! Attention

Contrairement à ce qui se passe dans Calc, les formules ne sont pas automatiquement 
mises à jour quand on insère ou qu’on supprime des lignes ou des colonnes. Si vous pré-
voyez d’utiliser des formules complexes, envisagez d’incorporer une feuille de calcul de Calc
dans votre document Writer. Voyez le Chapitre 19 Classeurs, diagrammes et autres objets, 
page 529.
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Opérations supplémentaires sur les tableaux

Protéger les cellules d’un tableau

Il est possible de protéger le contenu des cellules individuelles d’un tableau de texte contre les mo-
difications.

Remarque

Cette protection ne vise pas la sécurité. Elle ne constitue qu’un moyen de protéger les cel-
lules contre les modifications accidentelles.

Pour activer la protection des cellules :

• placez le curseur dans la cellule ou sélectionnez les cellules à protéger, cliquez sur le bouton
Protéger les cellules ( ) dans la barre d’outils Tableau ou choisissez Tableau > Protéger 
les cellules dans la barre de menu.

Pour désactiver la protection des cellules :

• si ce n’est déjà fait, commencez par choisir Outils > Options > LibreOffice Writer > Aides 
au formatage et cocher Activer le curseur dans la section Zones protégées. Placez ensuite 
le curseur dans la cellule ou sélectionnez les cellules à déprotéger puis cliquez sur le bouton 
Annuler la protection des cellules ( ) dans la barre d’outils Tableau ou choisissez Ta-
bleau > Annuler la protection des cellules dans la barre de menu.

Pour supprimer la protection du tableau courant tout entier ou de tous les tableaux sélectionnés, 
appuyez sur Maj+Ctrl+T.

Ajouter une légende

Il est facile d’ajouter une légende à n’importe quel tableau. Writer garde trace de tous les tableaux 
munis d’une légende, les numérote automatiquement et met à jour les liens vers eux. La procédure
est identique à celle utilisée pour donner une légende à une image décrite au Chapitre 11 Images 
et objets graphiques, page 306.

Créer un renvoi vers un tableau

Il est possible d’insérer un renvoi vers un tableau possédant une légende. En cliquant sur le lien, le
lecteur atteint directement le tableau. Pour les détails, voir « Utiliser les renvois automatiques » 
dans le Chapitre 17 Travailler avec les champs, page 479.

Créer une ligne d’en-tête dans un tableau existant

Pour créer une ligne d’en-tête dans un tableau existant qui n’en possède pas :

 1) Sélectionnez la première ligne du tableau puis choisissez Tableau > Insérer > Ligne au-
dessus ou cliquez sur le bouton Ligne au-dessus ( ) de la barre d’outils Tableau.

 2) Sélectionnez la première ligne nouvellement créée puis appliquez à ses cellules le style Titre
de tableau en faisant un double clic sur celui-ci dans l’onglet Styles et formatage du volet la-
téral.

Vous pouvez aussi appliquer un style de tableau qui possède une ligne d’en-tête prédéfinie. (C’est 
là que des styles de tableau personnalisés peuvent se révéler très pratiques.) Placez le curseur 
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n’importe où dans le tableau, ouvrez l’onglet Style de tableau du volet latéral et choisissez le style 
voulu.

Fusionner et scinder des tableaux

Un tableau peut être scindé en deux et deux tableaux fusionnés en un seul. Les tableaux ne sont 
scindés que dans le sens horizontal (les lignes au-dessus du point de séparation sont placées 
dans un tableau, celles en dessous dans un autre).

Pour scinder un tableau :

 1) Placer le curseur dans une cellule qui fera partie de la ligne supérieure du deuxième tableau 
après la séparation (le tableau se scinde juste au-dessus du curseur).

 2) Choisissez Tableau > Scinder le tableau… dans la barre de menu.

 3) Dans la boîte de dialogue Scinder le tableau qui s’ouvre alors, vous pouvez choisir d’attri-
buer ou non un en-tête au deuxième tableau et, le cas échéant, de lui donner le même style 
que dans le tableau initial.

 4) Cliquez sur OK pour scinder le tableau en deux tableaux séparés par un paragraphe vide.

Remarque

Si des cellules d’un tableau comportent des formules qui utilisent des données de l’autre ta-
bleau, ces cellules contiendront un message d’erreur : ** Expression erronée **.

Pour fusionner deux tableaux :

 1) Supprimez le paragraphe vide entre les tableaux. Pour cela, il faut utiliser la touche Suppr. 
et non la touche Retour arrière.

 2) Sélectionnez n’importe quelle cellule dans l’un des tableaux.

 3) Faites un clic droit et choisissez Fusionner les tableaux dans le menu contextuel. Vous 
pouvez aussi utiliser Tableau > Fusionner le tableau dans la barre de menu.

Conseil

Pour voir clairement où se trouvent les paragraphes et pouvoir les supprimer facilement, affi-
chez les marques de formatages : Affichage > Marques de formatage, Ctrl+F10 ou bou-
ton (Dés)activer les marques de formatage  dans la barre d’outils standard.

Supprimer un tableau

Pour supprimer un tableau :

 1) Cliquez quelque part dans le tableau.

 2) Choisissez Tableau > Supprimer > Tableau dans la barre de menu.

Ou :

 1) Sélectionnez depuis la fin du paragraphe qui précède le tableau jusqu’au début du para-
graphe qui le suit.

 2) Appuyez sur la touche Suppr ou Retour arrière.

Guide de LibreOffice Writer Opérations supplémentaires sur les tableaux | 373



 Chapitre 13 Travailler avec les tableaux de données

Remarque

La deuxième méthode fusionne aussi le paragraphe qui suit le tableau avec celui qui le pré-
cède, ce qui n’est peut-être pas un effet que vous souhaitez.

Copier un tableau

Pour copier un tableau depuis un point du document et le coller à un autre endroit :

 1) Cliquez quelque part dans le tableau.

 2) Sélectionnez Tableau > Sélectionner > Tableau dans la barre de menu.

 3) Appuyez sur Ctrl+C ou cliquez sur le bouton Copier ( ) dans la barre d’outils standard.

 4) Déplacez le curseur à l’emplacement ciblé pour la copie et cliquez pour fixer le point d’inser-
tion.

 5) Appuyez sur Ctrl+V ou cliquez sur le bouton Coller ( ) dans la barre d’outils standard.

Déplacer un tableau

Pour déplacer un tableau d’un point à un autre du document :

 1) Cliquez quelque part dans le tableau.

 2) Sélectionnez Tableau > Sélectionner > Tableau dans la barre de menu.

 3) Appuyez sur Ctrl+X ou cliquez sur le bouton Couper ( ) dans la barre d’outils standard. 
Cette opération supprime le contenu des cellules mais laisse les cellules vides en place ; 
elles seront supprimées à l’étape 6.

 4) Déplacez le curseur à l’emplacement ciblé pour la copie et cliquez pour fixer le point d’inser-
tion.

 5) Appuyez sur Ctrl+V ou cliquez sur le bouton Coller ( ) dans la barre d’outils standard. 
Cette opération colle les cellules et leur contenu formaté.

 6) Revenez au tableau initial, cliquez quelque part à l’intérieur puis sélectionnez Tableau > 
Supprimer > Tableau dans la barre de menu.

Insérer un paragraphe avant ou après un tableau

Pour insérer un paragraphe avant un tableau, placez le curseur avant tout texte ou tout autre 
contenu dans la première cellule (en haut, à gauche) et appuyez sur Entrée ou Alt+Entrée.

Pour insérer un paragraphe après un tableau, placez le curseur après tout texte dans la dernière 
cellule (en bas, à droite) et appuyez sur Alt+Entrée.

Remarque

Les légendes sont dans des paragraphes séparés du tableau lui-même. S’il y a, par 
exemple, une légende sous un tableau, il suffit de placer le curseur à la fin de celle-ci et 
d’appuyer sur Entrée.
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Utiliser des tableaux comme outils de mise en page

Il est possible d’utiliser des tableaux comme outils de mise en page pour positionner le texte dans 
un document au lieu d’employer des tabulations et des espaces. Pour plus d’informations et des 
conseils sur l’utilisation des tableaux dans la mise en page, voyez le Chapitre 6 Mise en page : ap-
profondissements, page 153.

Conseils
Si vous insérez un tableau à des fins de mise en page, il vaudra peut-être mieux décocher 
les options En-tête et Bordures dans la boîte de dialogue Insérer un tableau (voir « Insérer 
un nouveau tableau » page 347).

Pour supprimer les bordures d’un tableau existant, faites un clic droit sur celui-ci, choisissez 
Propriétés du tableau… dans le menu contextuel, ouvrez l’onglet Bordures et cliquez sur 
l’icône Définir sans bordures.

Le menu et la barre d’outils Tableau

Toutes les commandes concernant les tableaux décrites dans ce chapitre, sont très à propos si-
tuées dans l’entrée Tableau de la barre de menu et dans la barre d’outils Tableau. Quand vous 
créez un tableau ou que vous en sélectionnez un qui existe, la barre d’outils Tableau s’affiche au-
tomatiquement. Vous pouvez l’afficher manuellement à tout moment en sélectionnant Affichage > 
Barres d’outils > Tableau. Elle peut flotter au-dessus de la fenêtre principale de Writer ou être an-
crée le long d’un de ses bords. Voyez le Chapitre 1 Introduction à Writer, page 19, pour plus d’in-
formation sur les barres d’outils flottantes ou ancrées et sur la façon de masquer ou d’afficher des 
outils particuliers dans une barre d’outils.

Figure 13.16 : la barre d’outils Tableau
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Chapitre 14
Le publipostage
Lettres type, étiquettes et enveloppes





Qu’est-ce qu’un publipostage ?

LibreOffice Writer offre des fonctionnalités très utiles pour créer et imprimer des copies multiples 
d’un même document (étiquettes de retour, autocollants promotionnels ou transferts pour t-shirt) 
ou qui comportent des informations variables (comme des noms, des adresses, des montants 
dus) :

• des lettres types à envoyer à une liste de destinataires différents ;

• des étiquettes d’adresse, des étiquettes pour dossiers cartonnés et autres du même genre ;

• des enveloppes.

Toutes ces fonctions, bien que d’applications différentes, sont fondées sur le concept d’une source 
de données enregistrées d’où sont tirées les informations nécessairement variables sur les 
adresses.

Ce chapitre décrit le processus. Il comporte les étapes suivantes :

 1) Comment créer et enregistrer une source de données.

 2) Comment créer et imprimer des lettres types, des étiquettes d’adresse et des enveloppes.

 3) De manière facultative, comment enregistrer le résultat dans un fichier modifiable au lieu de 
l’imprimer directement.

Créer et enregistrer la source de données

Une source de données est une base de données qui contient le nom et l’adresse (et éventuelle-
ment d’autres informations) à partir desquels la liste de postage peut être établie. Bien qu’il soit 
possible de créer et d’imprimer des étiquettes d’adresses et des enveloppes sans utiliser de 
source de données, son utilisation est, dans la plupart des cas, une meilleure solution. Ce chapitre 
suppose que vous utilisiez une source de données.

LibreOffice peut utiliser une grande variété de formats pour créer la source de données, parmi les-
quels des feuilles de calcul, des fichiers texte et des bases de données comme MySQL, Adabas et
ODBC. Si les informations à utiliser dans le publipostage sont dans un format auquel LibreOffice 
ne peut pas accéder directement, vous devez les convertir, par exemple en les exportant dans un 
fichier au format « valeurs séparées par des virgules » (Comma-Separated Values : CSV).

Pour l’exemple qui va suivre, nous commencerons par une feuille de calcul avec les en-têtes de 
colonnes (ou champs) suivants : Civilité, Prénom, Nom, Adresse, Code postal, Département, 
Genre et Points. La Figure 14.1 propose un exemple de données.

Quand elle a été créée selon la méthode décrite ci-dessous, la source de données doit être enre-
gistrée pour être accessible depuis un document de Writer. Cela n’a besoin d’être fait qu’une seule
fois, après quoi la source de données est disponible dans tous les modules de LibreOffice.

 1) Depuis n’importe quel document de Writer ou depuis le centre de démarrage de LibreOffice, 
sélectionnez Fichier > Assistants > Source de données des adresses.
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Figure 14.1 : Exemple de feuille de données

 2) Les choix proposés sur la première page de l’assistant dépendent de votre système d’exploi-
tation. Sélectionnez le type convenable de carnet d’adresses externe. Dans notre exemple, 
ce sera Autre source de données externe. Cliquez sur Suivant >>.

Figure 14.2 : Choix d’un carnet d’adresses externe.

 3) Sur la page suivante de l’assistant, cliquez sur le bouton Paramètres…

Figure 14.3 : Début du paramétrage dans l’assistant.

 4) Dans la boîte de dialogue Propriétés de la source de données, choisissez le type de base de
données. Dans notre exemple, ce sera Classeur. Cliquez sur Suivant>>.
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Figure 14.4 : Choix du type de base de données.

 5) Dans la boîte de dialogue suivante, cliquez sur le bouton Parcourir… et recherchez le clas-
seur qui contient les informations d’adresse. Sélectionnez-le et cliquez sur Ouvrir pour reve-
nir à cette boîte de dialogue. À ce moment-là, vous pouvez, si vous le désirez, vérifier que la 
liaison a bien été établie en cliquant sur le bouton Tester la connexion (non représenté sur 
la figure).

Figure 14.5 : Choix du document Classeur

 6) Cliquez sur le bouton Terminer.

 7) Dans la page suivante, cliquez sur le bouton Suivant>>. Parce que notre source de données
est un classeur, ne cliquez pas sur le bouton Assignation de champ.

Figure 14.6 : Parce que nous utilisons un classeur, il ne faut pas cliquer sur le bouton
Assignation de champ.

 8) Un fichier de base de données va être créé. Donnez un nom au fichier dans le champ Em-
placement. Le nom par défaut est Adresse1.odb mais vous pouvez le remplacer par un autre
si vous le désirez. Vous pouvez aussi changer le nom dans le champ Nom du carnet 
d’adresses. Le nom qui est dans ce champ est celui qui sera enregistré et que LibreOffice af-
fichera dans les listes de sources de données. Dans notre exemple, « Points » est utilisé 
dans les deux cas.
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 9) Cliquez sur Terminer. La source de données est désormais enregistrée.

Figure 14.7 : Nommer le fichier odb et le carnet d’adresses.

Supprimer l’enregistrement d’une source de données

Pour supprimer l’enregistrement d’une source de données qui ne sera plus utilisable par 
LibreOffice, comme une liste d’adresses obsolètes, par exemple, faites ce qui suit :

 1) Ouvrez la fenêtre des sources de données en choisissant Affichage > Sources de données
dans la barre de menu, en appuyant sur Ctrl+Maj+F4 ou en cliquant sur le bouton 
Sources de données ( ) dans la barre d’outils standard.

 2) Dans le volet gauche, le navigateur de sources de données, faites un clic droit sur une des 
sources de données.

 3) Sélectionnez Bases de données enregistrées… dans le menu contextuel.

 4) Dans la boîte de dialogue Bases de données enregistrées, sélectionnez la base de données 
que vous ne souhaitez plus utiliser.

 5) Cliquez sur le bouton Supprimer puis sur Oui dans la boîte de confirmation qui s’ouvre 
alors.

 6) Répétez les étapes 4) et 5) autant de fois que nécessaire.

 7) Cliquez sur OK pour refermer la boîte de dialogue Bases de données enregistrées.

Cette opération ne supprime pas physiquement la base de données de votre système. Elle pourra 
être enregistrée de nouveau grâce aux méthodes décrites ci-dessous.

Réenregistrer une source de données existante

Pour (ré)enregistrer un fichier de base de données (.odb) d’adresses existant, faites ce qui suit :

 1) Ouvrez la fenêtre des sources de données en choisissant Affichage > Sources de données
dans la barre de menu, en appuyant sur Ctrl+Maj+F4 ou en cliquant sur le bouton 
Sources de données ( ) dans la barre d’outils standard.

 2) Dans le volet gauche, le navigateur de sources de données, faites un clic droit sur une des 
sources de données.

 3) Sélectionnez Bases de données enregistrées… dans le menu contextuel.
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 4) Dans la boîte de dialogue Bases de données enregistrées, cliquez sur le bouton Nouveau…

 5) Dans la boîte de dialogue Créer un lien de base de données, cliquez sur le bouton Parcou-
rir…, recherchez l’emplacement du fichier de base de données et sélectionnez-le. Cliquez 
sur Ouvrir pour revenir à la boîte de dialogue Créer un lien de base de données.

 6) Modifiez, si nécessaire, le Nom enregistré de la source de données.

 7) Cliquez sur OK pour refermer cette boîte de dialogue.

 8) Cliquez sur OK pour refermer la boîte de dialogue Bases de données enregistrées.

Créer une lettre type

Vous pouvez créer une lettre type manuellement, ce qui est la méthode la plus simple et la plus 
générale, et qui est celle décrite ici ; vous pouvez aussi utiliser l’Assistant Mailing comme décrit à 
la section « Utiliser l’Assistant Mailing pour créer une lettre type » page 397. Si vous choisis-
sez cette solution, portez une grande attention à ses limitations actuelles comme indiqué dans sa 
description.

 1) Créez un nouveau document texte (Fichier > Nouveau > Document texte) ou ouvrez une 
lettre type existante (Fichier > Ouvrir).

 2) Affichez les sources de données enregistrées (Affichage > Sources de données ou 
Ctrl+Maj+F4).

 3) Recherchez la source de données que vous souhaitez utiliser avec la lettre type, dans notre 
cas ce sera Points. Dépliez les nœuds Points puis Tables et sélectionnez Feuille1. Les don-
nées du fichier d’adresse s’affichent.

Figure 14.8 : Choix de la source de données

 4) Créez ou modifiez maintenant la lettre type en saisissant le texte, la ponctuation, les retours 
à la ligne, etc. qui seront présents dans toutes les lettres.

Pour ajouter les champs de publipostage aux endroits nécessaires (noms et adresses, par 
exemple), cliquez sur l’en-tête d’un champ et faites-le glisser à l’emplacement voulu dans la 
lettre.

Notez qu’il vaut mieux que les lignes d’adresse se trouvent dans des paragraphes différents 
et ne soient pas séparées par des sauts de ligne comme cela semblerait préférable. La rai-
son de ce choix apparaîtra à la prochaine étape.
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Cliquez ici sur les
en-têtes des champs

Et glissez-les ici 
pour déposer les 
champs dans la 
lettre-type

Figure 14.9 : Faites glisser les champs à leur place dans le corps de la lettre type.

 5) Continuez jusqu’à avoir composé le document tout entier. Arrivé là, vous pouvez envisager 
de supprimer toutes les lignes vides qui peuvent se trouver dans les lettres produites. Si ce 
n’est pas le cas, passez à l’étape 7.

Figure 14.10 : La lettre type achevée

 6) Pour supprimer les lignes blanches :

 a) Cliquez à la fin du premier paragraphe à supprimer s’il est vide puis choisissez Insertion 
> Champ > Autres champs… dans la barre de menu pour ouvrir la boîte de dialogue 
Champs.

 b) Ouvrez l’onglet Fonctions et cliquez sur Paragraphe masqué dans la colonne Type.
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Figure 14.11 : Insertion d’un paragraphe masqué.

 c) Dans la boîte de saisie Condition, tapez les détails de la condition qui définit un champ 
d’adresse vide. La forme générale est :

![BaseDeDonnées.Table.Champ]

où le caractère « ! » (NOT) indique une négation et les crochets délimitent une condition.

Dans notre exemple, pour tester si le champ Commune est vide, la condition sera :

![Points.Feuille1.Commune] comme on le voit sur la Figure 14.11.

Pour tester des conditions multiples, utilisez les opérateurs AND (ET) et OR (OU) entre 
les instructions conditionnelles ; par exemple :

![Points.Feuille1.Commune] AND ![Points.Feuille1.Code postal]

 d) Cliquez sur le bouton Insérer mais ne refermez pas la boîte de dialogue avant d’avoir trai-
té toutes les lignes qui devront être supprimées.

 7) Le document est maintenant prêt à être imprimé.

 a) Sélectionnez Fichier > Imprimer… dans la barre de menu et répondez Oui au message 
de confirmation.

Figure 14.12 : Message de confirmation de l’impression du publipostage.

 b) Dans la boîte de dialogue Mailing (Figure 14.13), vous pouvez choisir d’imprimer tous les 
enregistrements ou seulement ceux que vous sélectionnez. Pour cela, cliquez en ap-
puyant sur la touche Ctrl (Ctrl+clic) sur les enregistrements individuels. Pour sélec-
tionner un bloc d’enregistrements, sélectionnez le premier puis cliquez en appuyant sur la 
touche Maj (Maj+clic) sur le dernier du bloc.
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Figure 14.13 : La boîte de dialogue Mailing.

 c) Cliquez sur OK pour envoyer directement les lettres à l’imprimante. Vous pouvez aussi les
enregistrer dans un fichier pour une modification ou une mise en forme ultérieure ; voir 
« Modifier les documents fusionnés » ci-dessous.

 d) Si vous n’avez pas encore enregistré la lettre type comme modèle de document, c’est le 
moment de le faire. Un modèle de lettre type peut grandement simplifier la création 
d’autres lettres types dans le futur, il est donc recommandé d’en créer un modèle.

Modifier les documents fusionnés

Vous préférerez peut-être enregistrer les lettres dans un fichier pour pouvoir les relire ou y apporter
une mise en forme supplémentaire. Pour cela :

 1) Dans la boîte de dialogue Mailing (Figure 14.13), cochez Fichier dans la section Sortie à la 
place du choix par défaut Imprimante.

 2) La section Enregistrer le document fusionné s’active alors pour vous permettre de choisir 
l’enregistrement dans un document unique (par défaut) ou dans un document différent pour 
chaque lettre.

Si vous cochez l’option Générer le nom de fichier à partir de la base de données, choisissez 
le champ qui servira à créer le nom du fichier (assorti d’un numéro en cas de doublon), le 
dossier où les documents seront enregistrés et le format du fichier. Si vous ne le faites pas, 
un nom et un emplacement seront demandés à l’étape suivante.

 3) Cliquez sur OK. Dans la boîte de dialogue d’enregistrement, saisissez un nom de fichier 
pour les lettres et choisissez un dossier où les placer. Les lettres seront enregistrées l’une à 
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la suite de l’autre dans des pages séparées si vous avez choisi un document unique ou dans
des fichiers individuels numérotés dans l’autre cas.

Vous pouvez alors ouvrir les lettres et les modifier individuellement comme pour tout autre docu-
ment.

Imprimer des étiquettes d’adresse

Avant tout, notez la marque et le type d’étiquettes que vous avez l’intention d’utiliser.

Préparer l’impression

Pour préparer les étiquettes d’adresse à imprimer :

 1) Sélectionnez Fichier > Nouveau > Étiquettes dans la barre de menu.

 2) Dans l’onglet Options de la boîte de dialogue Étiquettes, vérifiez que l’option Synchroniser le
contenu est cochée.

 3) Dans l’onglet Étiquettes (Figure 14.14), choisissez la base de données et la table. Choisis-
sez aussi la marque et le type d’étiquettes à utiliser.

Figure 14.14 : Choix de la base de données, de la table, de la marque et du type d’étiquettes

 4) Si vous n’arrivez pas à retrouver votre type d’étiquette dans la liste, vous pouvez paramétrer 
les étiquettes en votre possession.

 a) Sélectionnez le choix [Utilisateur] dans la liste déroulante Type. Ouvrez l’onglet Format de
la boîte de dialogue Étiquettes. Reportez dans les boîtes de saisie les dimensions que 
vous avez mesurées sur vos étiquettes ou qui sont indiquées sur leur emballage (Figure 
14.15).

 b) Vous pouvez alors enregistrer votre modèle d’étiquettes si vous prévoyez de l’utiliser plu-
sieurs fois. Cliquez sur le bouton Enregistrer…
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Figure 14.15 : Format personnalisé d’étiquettes

 c) Dans la boîte de dialogue Enregistrer le format d’étiquettes (Figure 14.16), saisissez un 
nom de marque et de type pour vos étiquettes puis cliquez sur OK.

Figure 14.16 : Nommer et enregistrer un format personnalisé d’étiquettes.

 5) Revenez à l’onglet Étiquettes. 

Figure 14.17 : Placer les champs de la base de données sur l’étiquette.
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Déroulez la liste Champ de base de données. Sélectionnez le premier champ à placer sur 
l’étiquette (Civilité dans notre exemple). Cliquez sur le bouton en forme de flèche vers la 
gauche pour déplacer ce champ dans la zone de texte de l’étiquette comme le montre la Fi-
gure 14.17.

 6) Ajoutez les champs suivants en insérant la ponctuation, les espaces et les sauts de ligne né-
cessaires pour composer votre étiquette. La Figure 14.18 montre l’étiquette terminée.

Figure 14.18 : L’étiquette terminée.

 7) Cliquez sur le bouton Nouveau document. Vous disposez alors d’un nouveau document 
d’une seule page qui contient une série de cadres, un par étiquette du type choisi, remplis 
avec les données du champ d’adresse que vous avez choisi. Il arrive assez souvent que cer-
tains champs de votre source de données d’adresse ne soient pas utilisés, ce qui produit des
lignes vides dans vos étiquettes. Si cela n’a pas d’importance, passez à « Impression » 
page 391, sinon continuer avec la section « Supprimer les lignes vides des étiquettes » 
ci-dessous.

Supprimer les lignes vides des étiquettes

 1) Commencez par vous assurer que les cadres des étiquettes affichent le contenu des champs
(les en-têtes de la source de donnée) et pas leurs noms sous-jacents. Si ce n’est pas le cas, 
appuyez sur Ctrl+F9 ou sélectionnez Affichage > Noms des champs pour changer l’affi-
chage.

 2) Vérifiez ensuite que vous voyez bien les caractères non imprimables, comme les marques 
de paragraphe, les sauts de ligne, etc. Si ce n’est pas le cas, sélectionnez Affichage > 
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Marques de formatage dans la barre de menu, appuyez sur Ctrl+F10 ou cliquez sur le 
bouton (Dés)activer les marques de formatage  dans la barre d’outils standard.

Vous pourrez alors voir que les séparations des champs d’adresse sont réalisées par des 
sauts de ligne ( ) et non par des paragraphes ( ). Comme la suppression des lignes 
vides est réalisée en masquant des paragraphes et pas des lignes, il faut d’abord remplacer 
les sauts de lignes par des marques de paragraphe comme indiqué ci-dessous.

 3) Cliquez dans la première étiquette, à la fin du dernier champ d’adresse de la première ligne. 
Appuyez sur Suppr pour supprimer le caractère de saut de ligne puis sur Entrée pour insé-
rer une marque de paragraphe. Répétez cette action à chaque ligne de l’adresse du premier 
cadre.

Conseil

Vous pouvez aussi placer le curseur avant le premier saut de ligne, ouvrir la boîte de dia-
logue Rechercher & remplacer (Édition > Rechercher & remplacer dans la barre de menu,
Ctrl+H sur le clavier ou bouton Rechercher & remplacer ( ) de la barre d’outils stan-
dard). Saisissez \n dans les deux champs Rechercher et Remplacer. Cliquez sur Autres 
options et cochez l’option Expressions régulières puis cliquez sur le bouton Tout remplacer.

! Attention

Le but de cette opération est de remplacer tous les sauts de ligne dans l’étiquette par des 
marques de paragraphe. Il peut arriver qu’un champ de données soit plus long que la lar-
geur de l’étiquette et se poursuive sur la ligne physique suivante : assurez-vous que cela ne 
vous induise pas en erreur et ne vous amène pas à remplacer autre chose que des sauts de
ligne.

 4) Si l’interligne de cette première étiquette ne vous convient pas, c’est le moment de le corriger
en modifiant le style de paragraphe associé à l’adresse. Sauf modification de votre part, les 
adresses utilisent le Style par défaut.

 5) Cliquez de nouveau à la fin du premier paragraphe à supprimer sous condition puis sélec-
tionnez Insertion > Champ > Autres champs… Ouvrez l’onglet Fonctions et cliquez sur 
Paragraphe masqué dans la colonne Type. Dans la boîte de saisie Condition, tapez les dé-
tails de la condition qui définit un champ d’adresse vide. La forme générale est :

![BaseDeDonnées.Table.Champ]

où le caractère « ! » (NOT) indique une négation et les crochets délimitent une condition.

Dans notre exemple, pour tester si le champ Commune est vide, la condition sera :

![Points.Feuille1.Commune] comme on le voit sur la Figure 14.11.
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Pour tester des conditions multiples, utilisez les opérateurs AND (ET) et OR (OU) entre les 
instructions conditionnelles ; par exemple :

![Points.Feuille1.Commune] AND ![Points.Feuille1.Code postal]

Cliquez sur le bouton Insérer mais ne refermez pas la boîte de dialogue avant d’avoir traité 
toutes les lignes qui devront être supprimées.

 6) Répétez l’opération pour chaque paragraphe qui doit être supprimé sous condition, en n’ou-
bliant pas d’avancer le curseur à la fin de la ligne en question avant de modifier le dernier 
élément de la condition et d’insérer le résultat.

! Attention
Le dernier paragraphe du cadre d’adresse de l’étiquette se termine par un champ particulier, 
Next record:BaseDeDonnées.Table (Next record:Points.Feuille1 dans notre 
cas), et le champ Paragraphe masqué doit être inséré avant celui-ci. On y arrive en général 
en cliquant à la fin du paragraphe et en appuyant une fois sur la flèche vers la gauche du cla-
vier pour sauter ce champ.

Si des enregistrements ont été sautés et manquent dans le résultat final, c’est un bon indice 
que vous avez oublié de le faire.

 7) Comme nous avons coché l’option Synchroniser le contenu (page
387), vous devriez voir une petite fenêtre qui contient un bouton 
Synchroniser les étiquettes. Cliquez sur celui-ci et les champs 
Paragraphe masqué sont propagés à toutes les étiquettes de votre document.

Vous disposez à ce moment-là d’un modèle utilisable à l’avenir pour imprimer de nouvelles 
étiquettes du même type avec la même base de données. Si vous désirez l’enregistrer, utili-
sez Fichier > Modèles > Enregistrer comme modèle… pour l’enregistrer comme modèle 
de texte Open Document (.ott).

Impression

 1) Sélectionnez Fichier > Imprimer dans la barre de menu. Le message visible dans la Figure 
14.12. Cliquez sur Oui pour imprimer.

 2) Dans la boîte de dialogue Mailing (Figure 14.13), vous pouvez choisir d’imprimer tous les en-
registrements ou seulement une partie. Pour sélectionner les enregistrements à imprimer, cli-
quez en appuyant sur la touche Ctrl (Ctrl+clic) sur les enregistrements individuels. 
Pour sélectionner un bloc d’enregistrement, sélectionnez le premier puis cliquez en appuyant
sur la touche Maj (Maj+clic) sur le dernier du bloc.

 3) Cliquez sur OK pour envoyer les étiquettes directement à l’imprimante.

Remarques

Si vous préférez enregistrer les étiquettes dans un fichier, par exemple pour y apporter plus 
tard des modifications comme celle de la police ou du format de paragraphe, cochez Fichier 
dans la section Sortie de la boîte de dialogue Mailing. La section Enregistrer le document 
fusionné s’active alors avec l’option Enregistrer dans un document unique cochée par dé-
faut.
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Dans ces conditions, cliquer sur OK ouvre une boîte de dialogue Enregistrer où vous pou-
vez saisir un nom de fichier pour les étiquettes enregistrées.

Si vous n’avez pas enregistré le modèle de document à l’étape 7 de la section Supprimer 
les lignes vides des étiquettes, vous y êtes invité par une autre boîte de dialogue d’enre-
gistrement.

Dans un cas comme dans l’autre, que vous imprimiez ou enregistriez un fichier, bien qu’il n’y
ait apparemment qu’une seule page d’étiquettes, le résultat imprimé ou enregistré sera éten-
du à tous les enregistrements sélectionnés dans la source de données.

Éditer un fichier d’étiquettes enregistré

Pour éditer un fichier enregistré d’étiquettes, ouvrez-le comme tout autre document de Writer. Il 
vous sera demandé si les liens doivent être mis à jour. Répondez Non pour la raison suivante : la 
première étiquette de la page est appelée « Étiquette maîtresse » et toutes les autres lui sont re-
liées. Si vous mettez les liens à jour, toutes les étiquettes finiront par contenir les mêmes données,
ce qui n’est probablement pas ce que vous souhaitez.

Vous pouvez modifier individuellement chaque enregistrement de la manière habituelle, en sélec-
tionnant et en modifiant le nom de la police, par exemple.

Il est toutefois impossible de modifier globalement toutes les étiquettes (par exemple pour changer
la police de tous les enregistrements) en sélectionnant le document en entier. Pour obtenir le résul-
tat souhaité, il faut modifier le style de paragraphe associé aux enregistrements de la manière sui-
vante :

 1) Faites un clic droit sur n’importe quel mot correctement orthographié dans un cadre d’éti-
quette. Sélectionnez Styles > Éditer le style dans le menu contextuel. (Remarque : si vous 
cliquez sur un mot mal orthographié, un menu différent apparaît.)

 2) Dans la boîte de dialogue Style de paragraphe, vous pouvez effectuer les modifications habi-
tuelles, nom et taille de la police, retraits et autres attributs.

Imprimer des enveloppes

À la place d’étiquettes, vous pouvez imprimer directement des enveloppes. En sélectionnant In-
sertion > Enveloppe… dans la barre de menu, vous pouvez choisir une des deux méthodes pour 
les réaliser. La première consiste à incorporer l’enveloppe dans la lettre, généralement à la pre-
mière page (bouton Insérer en bas de la boîte de dialogue) et la seconde à en faire un document 
indépendant (bouton Nouveau document en bas de la boîte de dialogue). Dans les deux cas, 
vous pouvez saisir manuellement les données d’adresse, par exemple en les copiant depuis la 
lettre qui est associée à l’enveloppe, ou utiliser celles d’une source de données d’adresses.

Cette section suppose que vous utilisez une source de données d’adresses et, par commodité, 
une enveloppe indépendante. La réalisation d’enveloppes se fait en deux temps : paramétrage et 
impression.

Paramétrer des enveloppes pour l’impression

 1) Sélectionnez Insertion > Enveloppe… dans la barre de menu.
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 2) Dans la boîte de dialogue Enveloppe, ouvrez l’onglet Format (Figure 14.19) pour y choisir le 
format d’enveloppe à utiliser. Vous pouvez ensuite arranger la disposition de l’enveloppe 
pour qu’elle convienne à vos besoins, et y paramétrer les styles de caractères et de para-
graphes utilisés pour l’adresse du destinataire et de l’expéditeur. Vous accédez à ces ré-
glages grâce aux boutons Éditer à droite des deux sections concernées.

Remarque

Si la liste déroulante des formats de la section Taille ne propose pas celui qui vous convient,
choisissez Personnalisé (en bas de la liste) et précisez les dimensions dans les boîtes de 
saisie Largeur et Hauteur.

Conseil

À ce niveau, il n’est possible d’ajuster que la position de l’origine (coin supérieur gauche) 
des cadres qui contiendront les adresses de l’expéditeur et du destinataire, mais, quand 
l’enveloppe aura été créée, vous pourrez régler à votre gré leur taille et leur position si vous 
désirez quelques ajustements cosmétiques.

Figure 14.19 : boîte de dialogue de choix du format de l’enveloppe.

 3) Ouvrez ensuite l’onglet Imprimante (Figure 14.20) où vous pourrez choisir l’imprimante que 
vous avez l’intention d’utiliser, la paramétrer, par exemple en indiquant le bac contenant les 
enveloppes, et régler d’autres options comme l’orientation et le décalage de l’enveloppe. Il 
faudra peut-être quelques essais pour trouver les meilleurs réglages pour votre imprimante.

Guide de LibreOffice Writer Imprimer des enveloppes | 393



 Chapitre 14 Le publipostage

Figure 14.20 : Choix des options d’impression d’une enveloppe.

 4) Ouvrez l’onglet Enveloppe

Figure 14.21 : Choix de l’adresse du destinataire et l’expéditeur.

 5) Décidez d’inclure ou non l’adresse de l’expéditeur sur l’enveloppe en cochant ou pas l’option 
Expéditeur. Modifiez éventuellement les informations de la zone de saisie correspondante.
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 6) Vous avez maintenant le choix de compléter l’adresse du destinataire en tirant les champs 
depuis les en-têtes de la source de données (voir « Créer une lettre type » page 383 et en 
particulier la Figure 14.9) ou d’utiliser les fonctionnalités de l’onglet Enveloppe.

 7) Si vous préférez utiliser la souris, cliquez sur le bouton Nouveau document, tirez les en-
têtes de votre source de données dans le cadre d’adresse de votre nouvelle enveloppe et 
passez à l’étape 10, sinon continuez ci-dessous.

 8) Vérifiez, complétez et modifiez les informations dans la zone Destinataire. Vous pouvez utili-
ser les listes déroulantes de droite pour choisir une base de données et une table d’où vous 
pourrez extraire les informations sur le destinataire de la même façon qui a été décrite pour 
« Imprimer des étiquettes d’adresse » aux étapes 3 et 5 (voir Figure 14.17 et Figure 
14.18).

 9) Quand vous avez terminé la mise en forme, cliquez soit sur le bouton Insérer soit sur le bou-
ton Nouveau document. Comme on peut s’y attendre, Nouveau document ne crée que le 
modèle d’enveloppe dans un nouveau document alors que Insérer insère l’enveloppe à la 
page 1 du document en cours.

Si vous ne désirez pas continuer avec cette enveloppe, cliquez sur le bouton Annuler ou ap-
puyez sur la touche Échap. Vous pouvez aussi cliquer sur le bouton Réinitialiser pour annu-
ler vos modifications et revenir à l’état qu’avait la boîte de dialogue à son ouverture.

Vous pouvez maintenant modifier la position des cadres contenant les informations sur le 
destinataire et l’expéditeur ou y apporter d’autres changements aux formats de caractères et 
de paragraphes (modifier la police par exemple) ou encore ajouter un logo ou une image à 
l’enveloppe.

Conseil

Si vous imprimez régulièrement des enveloppes du même format à partir de la même base 
de données, c’est le bon moment pour créer un modèle. Voir « Créer un modèle d’enve-
loppe » page 397.

 10) Il arrive assez souvent que certains champs de votre source de données d’adresse ne soient
pas utilisés, ce qui produit des lignes vides dans le cadre réservé à l’adresse du destinataire 
de vos enveloppes. Si cela n’a pas d’importance, passez à « Fusionner et imprimer les en-
veloppes » à la page 396, sinon continuez de la manière décrite ci-dessous.

Remarque

La procédure décrite ici est très semblable à celle qui est utilisée dans le même but pour 
l’impression d’étiquettes. Elle est reproduite ici pour faciliter votre lecture.

 a) Commencez par vous assurer que l’enveloppe affiche le contenu des champs (les en-
têtes de la source de donnée) et nom leurs noms sous-jacents. Si ce n’est pas le cas, ap-
puyez sur Ctrl+F9 ou sélectionnez Affichage > Noms des champs pour changer l’affi-
chage.

 b) Vérifiez ensuite que vous voyez bien les caractères non imprimables, comme les marques
de paragraphe, les sauts de ligne, etc. Si ce n’est pas le cas, sélectionnez Affichage > 
Marques de formatage dans la barre de menu, appuyez sur Ctrl+F10 ou cliquez sur le 
bouton (Dés)activer les marques de formatage  dans la barre d’outils standard.
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Vous pourrez alors voir que les séparations des champs d’adresse sont réalisées par des 
sauts de ligne ( ) en non des paragraphes ( ). Comme la suppression des lignes vides
est réalisée en masquant des paragraphes et pas des lignes, il faut d’abord remplacer les 
sauts de lignes par des marques de paragraphe comme indiqué ci-dessous.

 c) Cliquez à la fin du dernier champ d’adresse de la première ligne dans le cadre d’adresse 
du destinataire de l’enveloppe. Appuyez sur Suppr pour supprimer le caractère de saut 
de ligne puis sur Entrée pour insérer une marque de paragraphe. Répétez cette action à
chaque ligne de l’adresse de l’enveloppe.

 d) Si l’interligne du cadre d’adresse de l’enveloppe ne vous convient pas, c’est le moment de
le corriger en modifiant le style de paragraphe associé à l’adresse. Sauf modification de 
votre part, les adresses utilisent le Style par défaut.

 e) Cliquez de nouveau à la fin du premier paragraphe à supprimer sous condition puis sélec-
tionnez Insertion > Champ > Autres champs… Ouvrez l’onglet Fonctions et cliquez sur 
Paragraphe masqué dans la colonne Type. Dans la boîte de saisie Condition, tapez les 
détails de la condition qui définit un champ d’adresse vide. La forme générale est :

![BaseDeDonnées.Table.Champ]

où le caractère « ! » (NOT) indique une négation et les crochets délimitent une condition.

Dans notre exemple, pour tester si le champ Commune est vide, la condition sera :

![Points.Feuille1.Commune] comme on le voit sur la Figure 14.11.

Pour tester des conditions multiples, utilisez les opérateurs AND (ET) et OR (OU) entre 
les instructions conditionnelles ; par exemple :

![Points.Feuille1.Commune] AND ![Points.Feuille1.Code postal]

Cliquez sur le bouton Insérer mais ne refermez pas la boîte de dialogue avant d’avoir trai-
té toutes les lignes qui devront être supprimées.

 f) Répétez l’opération pour chaque paragraphe qui doit être supprimé sous condition en 
n’oubliant pas d’avant le curseur à la fin de la ligne en question avant de modifier le der-
nier élément de la condition et d’insérer le résultat.

Fusionner et imprimer les enveloppes

Pour fusionner les adresses et imprimer les enveloppes :

 1) Sélectionnez Fichier > Imprimer dans la barre de menu. Une boîte de message (Figure 
14.12) s’ouvre. Cliquez sur Oui.

 2) La boîte de dialogue Mailing (Figure 14.13) apparaît. Comme pour les lettres type et les éti-
quettes d’adresse, elle vous permet de choisir si vous désirez imprimer des enveloppes pour
une, plusieurs ou tous les enregistrements de la base de données.

 3) Une fois ce choix fait, cliquez sur OK pour imprimer directement les enveloppes. Si vous 
voulez les modifier avant l’impression, voyez comment faire au paragraphe « Modifier les 
documents fusionnés » page 386.
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Créer un modèle d’enveloppe

Quand la disposition et les champs d’adresse de votre enveloppe vous conviennent, vous pouvez 
enregistrer le résultat comme modèle.

 1) Sélectionnez Fichier > Modèles > Enregistrer comme modèle dans la barre de menu.

 2) Dans la boîte de dialogue Enregistrer comme modèle, donnez un nom à votre modèle, sélec-
tionnez une catégorie et cliquez sur Enregistrer.

 3) Saisissez un nom et cliquez sur OK pour enregistrer le modèle.

Utiliser l’Assistant Mailing pour créer une lettre type

La méthode manuelle pour créer une lettre type, qui est décrite dans la section « Créer une lettre 
type » à la page 383, est celle qui offre le plus de contrôle sur le résultat et qui est donc recom-
mandée. Si vous préférez cependant utiliser l’assistant Mailing, la méthode est décrite ci-dessous.

Ouvrez un nouveau document et démarrez l’assistant Mailing en sélectionnant Outils > Assistant 
Mailing dans la barre de menu. L’assistant, visible sur la Figure 14.22, s’ouvre alors.

1ʳᵉ étape : choix du document de base

L’assistant vous offre plusieurs choix pour votre document de base :

• utiliser le document en cours d’édition ;

• créer un nouveau document ;

• débuter avec un document existant ;

• débuter avec un modèle.

Figure 14.22 : Choix du document de base

Dans notre exemple, nous allons supposer que vous avez ouvert un nouveau document texte. Co-
chez Utiliser le document actif puis cliquez sur Suivant >.

2e étape : choix du type de document

L’assistant peut créer des lettres ou des messages électroniques. Dans notre exemple, nous allons
créer une lettre. Cochez Lettre puis cliquez sur Suivant >.
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Figure 14.23 : Choix du type de document

3e étape : insertion du bloc d’adresses

C’est l’étape la plus compliquée de l’assistant. Vous allez y faire trois choses (Figure 14.24) :

 1) Indiquer à l’assistant quelle source de données utiliser. Celle-ci doit être un fichier existant ; 
dans notre exemple, ce sera le classeur « Points » créé plus tôt.

 2) Sélectionner le bloc d’adresses à utiliser dans le document, c’est-à-dire choisir les champs 
qui apparaîtront (si le département doit apparaître, par exemple) et leur disposition.

Figure 14.24 : Insertion du bloc d’adresses
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 3) Vous assurer que les champs s’accordent comme il faut. Cela est très important. Par 
exemple, l’assistant propose les champs <Titre>, <Ligne d’adresse 1> et <Ville> qui sont in-
connus de notre base d’adresses. Il faut donc lui indiquer leur équivalent comme décrit au 
paragraphe « Faire correspondre les champs » page 401.

Sélectionner la source de données (liste d’adresses)

 1) Si la liste d’adresses courantes, indiquées sous le bouton Sélectionner une liste d’adresse
différente…, n’est pas celle que vous désirez utiliser, cliquez sur ce bouton pour ouvrir la 
boîte de dialogue Sélectionner une liste d’adresses (Figure 14.25) pour y choisir une source 
de données.

 2) Si vous n’avez pas encore créé de liste d’adresses, vous pouvez cliquer sur le bouton 
Créer… pour le faire à ce moment-là. Vous pourrez créer un fichier à valeurs séparées par 
des virgules (Comma Separated Values : CSV) avec une nouvelle liste d’enregistrements 
d’adresses.

Si vous possédez une liste d’adresses qui n’est pas enregistrée dans LibreOffice, mais que 
vous désirez néanmoins utiliser, cliquez sur le bouton Ajouter… et sélectionnez le fichier qui
la contient.

Dans chacun des cas précédents, une nouvelle source de données (un fichier .odb) sera 
créée et enregistrée.

 3) Sélectionnez la liste d’adresses et cliquez sur OK pour revenir à l’étape 3 de l’assistant. 
Nous conserverons « Points » comme notre liste d’adresses pour cet exemple. L’assistant 
peut aussi exclure certains enregistrements : cliquez sur le bouton Filtrer… pour les choisir.

Figure 14.25 : La boîte de dialogue qui vous permet de choisir une liste d’adresses.
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Sélectionner le bloc d’adresses

 1) Dans la section de la boîte de dialogue (voir Figure 14.24), sélectionnez le bloc d’adresses 
qui doit apparaître sur la lettre, définissez son apparence et choisissez les champs qu’il doit 
contenir. La boîte de dialogue vous offre deux choix. Cliquez sur le bouton Plus… pour ouvrir
la boîte de dialogue Sélectionner un bloc d’adresses (Figure 14.26) qui offre d’autres choix.

Figure 14.26 : Sélection du bloc d’adresses

 2) Elle propose les deux blocs précédents plus d’autres choix de formats du bloc d’adresses (il 
faudra peut-être faire défiler la vue pour les voir tous). Elle vous offre aussi la possibilité d’in-
clure ou non le pays (par exemple, seulement si ce n’est pas la France) dans les paramètres
du bloc d’adresses.

Les formats proposés sont relativement courants, mais ils peuvent ne pas convenir exacte-
ment à vos besoins. Dans ce cas, sélectionnez le bloc d’adresse le plus proche de ce que 
vous désirez puis cliquez sur le bouton Éditer… pour ouvrir la boîte de dialogue Éditer le 
bloc d’adresse. (Figure 14.27).

 3) Dans celle-ci, vous pouvez ajouter ou supprimer des éléments de l’adresse grâce aux bou-
tons fléchés de gauche. Pour les déplacer, utiliser ceux de droite. Par exemple, pour décaler 
le champ <Ville> vers la droite, sélectionnez-le puis cliquez sur la flèche vers la droite.
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Figure 14.27 : Éditer un bloc d’adresses.

Faire correspondre les champs

Pour finir, il est temps de faire correspondre les champs de l’assistant à ceux de la source de don-
nées pour qu’il puisse en assurer la correspondance.

 1) Dans la section 4 de l’assistant en bas de la boîte de dialogue (voir Figure 14.24 page 398), 
la zone d’aperçu montre un enregistrement à la fois avec le bloc d’adresses que vous avez 
défini. Utilisez les boutons fléchés vers la droite et la gauche pour parcourir les adresses et 
vérifier qu’elles s’affichent correctement. Il vaut mieux ne pas supposer que ce sera le cas 
pour tous parce que le premier est correctement affiché, vérifiez-les tous ou, au minimum, 
une bonne partie.

 2) Si les adresses ne s’affichent pas comme vous les attendez (et ce ne sera probablement pas
immédiatement le cas), cliquez sur le bouton Correspondance des champs…

La boîte de dialogue Faire correspondre les champs (Figure 14.28) possède quatre co-
lonnes :

─ La colonne Éléments d’adresse contient les termes utilisés par l’assistant pour chaque 
champ, comme <Titre> ou <Prénom>,

─ utilisez la colonne Correspond au champ pour choisir le champ de votre source de don-
nées celui qui correspond à chaque élément d’adresse,

─ la colonne Aperçu montre ce qui apparaîtra dans le bloc d’adresses choisi pour chaque 
champ pour vous permettre de vérifier deux fois si la correspondance est correcte.

 3) Quand vous avez fait correspondre tous les champs, cliquez sur OK pour revenir à la troi-
sième étape de l’assistant. À ce moment-là, quand vous utilisez les touches fléchées pour 
parcourir les adresses, elles devraient toutes être correctes, sinon, revenez en arrière pour 
modifier tout ce qui ne vous convient pas avant de cliquer sur le bouton Suivant >> pour 
passer à la quatrième étape.

 4) Notez l’option Supprimer les lignes vides en bas de la section 2 sur la Figure 14.24. Grâce à 
elle, vous n’avez plus à créer à la main les champs de suppression conditionnelle.
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Figure 14.28 : Établir la correspondance entre les éléments d’adresse et les champs.

4e étape : création des salutations

Cette étape vous permet de créer pratiquement toutes les salutations que vous souhaitez.

Figure 14.29 : Création d’une salutation
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Cochez l’option Ce document devrait contenir des salutations pour activer la liste déroulante Salu-
tations générales. Quelques-unes sont disponibles dans la liste, mais vous pouvez saisir votre 
propre texte. Un panneau d’aperçu affiche votre choix.

Cochez Insérer des salutations personnalisées pour accéder à d’autres possibilités.

Vous pouvez, par exemple, utiliser des salutations différentes pour les hommes et les femmes. 
Pour cela, Writer doit avoir un moyen de savoir si une personne est un homme ou une femme. 
Dans une feuille de calcul, vous pouvez avoir une colonne Sexe ou Genre. Sous Champ de la liste
d’adresses indiquant un destinataire féminin, choisissez le champ contenant l’information et sa va-
leur. LibreOffice n’offre malheureusement pas de choix pour les autres genres.

Remarque

Il est inutile de préciser à LibreOffice qui est un homme, car il suppose que tous les enregis-
trements ne concernant pas les femmes concernent les hommes.

Si vous n’avez pas de champ convenable dans votre source de données, ou si vous ne souhaitez 
pas faire de distinction entre les hommes et les femmes dans vos salutations, laissez les zones de 
saisies Nom de champ et Valeur de champ vides et utilisez le contenu personnalisé de la boîte 
Homme pour tous les destinataires.

À titre d’exemple :

 1) Cliquez sur le bouton Nouveau… à côté de la liste déroulante Homme. La boîte de dialogue 
Salutations personnalisées (destinataires masculins) s’ouvre (Figure 14.30).

 2) Sélectionnez Salutations dans la liste des Éléments de salutations puis cliquez sur le bouton 
en forme de flèche vers la droite pour l’ajouter à la boîte 1. Faites glisser les éléments de sa-
lutations dans la zone ci-dessous.

 3) Dans la liste déroulante 2. Personnalisez les salutations, choisissez celle qui vous convient 
ou tapez votre propre texte.

 4) Sélectionnez Prénom et placez-le dans la boîte 1. Décalez-le d’un espace vers la droite en 
utilisant la touche fléchée tout à droite de la boîte de dialogue.

 5) Pour finir, déplacez le Signe de ponctuation dans la boîte 1. et choisissez la virgule dans la 
liste 2.

 6) Le résultat de votre construction est visible dans la zone Aperçu.

 7) Cliquez sur OK quand vous êtes satisfait du résultat.

Cette méthode vous permet d’utiliser des titres neutres du point de vue du genre comme Docteur 
(Dr) ou Maître (Me) ou de ne pas en mettre.
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Figure 14.30 : Personnaliser les salutations

5e étape : réglage de la mise en page

Cette étape vous offre la possibilité d’ajuster la position du bloc d’adresses et des salutations sur la
page. Le bloc d’adresses peut être placé à n’importe quelle position sur la page. Les salutations 
sont toujours à gauche, mais vous pouvez les monter ou les descendre en utilisant les boutons 
Haut et Bas visibles sur la Figure 14.31.

Figure 14.31 : Réglage de la mise en page

Quand vous cliquez sur Terminer, vous revenez à votre document où sont positionnés le cadre 
d’adresse et les civilités.

La barre d’outils Mailing est affichée pour vous permettre de procéder aux étapes suivantes.
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Figure 14.32 : La barre d’outils Mailing.

6e étape : Modification du document et insertion de champs 
supplémentaires

Vous avez maintenant une autre occasion d’ex-
clure certains destinataires du publipostage en
parcourant les enregistrements et en cochant l’option Exclure un destinataire.

C’est aussi le moment de modifier le corps du document. Si vous avez débuté avec un nouveau 
document vide, vous pouvez écrire toute la lettre.

Une autre tâche importante doit être effectuée à cette étape. L’assistant n’insère que des informa-
tions issues des champs de nom et d’adresse, mais vous aurez peut-être besoin d’en ajouter 
d’autres. Dans notre exemple, nous désirons informer chaque personne du nombre de points 
qu’elle a accumulés au cours de l’année, information qui se trouve dans la base de données. Pour 
cela :

 1) Sélectionnez Insertions > Champs > Autres champs… dans la barre de menu.

 2) Dans la boîte de dialogue Champs, ouvrez l’onglet Base de données.

Figure 14.33 : Insertion d’autres champs dans le document.

 3) Dans la colonne Type, sélectionnez Champs de mailing.
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 4) Dans la colonne Sélection d’une base de données, sélectionnez la vôtre (Points dans notre 
exemple). Déployez-la pour voir les champs.

 5) Sélectionnez le champ que vous voulez insérer (Points) puis cliquez sur le bouton Insérer.

 6) Vous pouvez insérer autant de champs que vous le désirez de cette manière.

 7) Cliquer sur Fermer quand vous avez fini.

Remarque

La liste Sélection d’une base de données propose la source de données que vous avez 
choisie à l’étape 3. Toutes les informations qui vous sont nécessaires pour la lettre doivent y 
être contenues.

7e étape : personnalisation des documents

Quand vous cliquez sur le bouton Éditer les documents individuels
dans la barre d’outils Mailing (Figure 14.32), toutes les lettres sont
créées, à raison d’une par destinataire que vous n’avez pas exclu à l’étape précédente, en un do-
cument unique. Vous pouvez alors apporter, par exemple, des modifications réservées à un seul 
destinataire.

8e étape : sauvegarde, impression, envoi

Le processus de création du publipostage est maintenant achevé. Il reste à en faire quelque 
chose. Vous pouvez enregistrer la lettre type, enregistrer le document fusionné, imprimer immédia-
tement les lettres ou envoyer par courriel les messages que vous avez créés.

Pour enregistrer la lettre type, procédez comme pour tout autre document (Fichier > Enregistrer 
sous…, Maj+Ctrl+S ou le bouton Enregistrer  de la barre d’outil standard).

Le document fusionné peut être enregistré en cliquant sur le bouton
Enregistrer les documents fusionnés de la barre d’outils Mailing.
Dans la boîte de dialogue Enregistrer le document fusionné, vous avez le choix d’enregistrer un 
document unique contenant toutes les lettres, d’enregistrer chaque lettre dans un document diffé-
rent ou seulement une plage d’enregistrements dans des documents différents.

Figure 14.34 : La boîte de dialogue Enregistrer un document fusionné.

Dans les deux derniers cas, vous êtes invité à donner un nom générique à tous les documents qui 
recevront un numéro en complément de ce nom.
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! Attention

Le premier enregistrement reçoit le numéro 0 et non le numéro 1.

Quand vous avez enregistré le document fusionné, vous pouvez im-
primer les lettres immédiatement en cliquant sur le bouton Imprimer
les documents fusionnés de la barre d’outils Mailing. La boîte de dialogue Imprimer le document
fusionné vous permet d’imprimer tous les documents obtenus ou seulement une plage sur l’impri-
mante de votre choix.

Figure 14.35 : Impression du document fusionné.

Si vous avez créé un message, vous avez aussi la possibilité de l’en-
voyer en cliquant sur le bouton Envoyer les messages par e-mail de la
barre d’outils Mailing. Dans la boîte de dialogue Envoyer le document fusionné par courriel, vous 
êtes invité à indiquer le champ qui contient l’adresse mail du destinataire, à saisir un sujet, à indi-
quer le format du message et l’emplacement d’une éventuelle pièce jointe. Vous pouvez envoyer 
tous les documents ou seulement une plage.

Figure 14.36 : Envoi du document fusionné par courriel.
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Chapitre 15
Tables des matières, index et 
bibliographies





Introduction

Ce chapitre décrit la façon de créer et de maintenir à jour une table des matières, un index et une 
bibliographie pour un document texte grâce à LibreOffice Writer. Pour comprendre les instructions, 
vous devez posséder des connaissances de base sur Writer et les styles (voir les chapitres 8 et 9).
Quelques exemples d’usage courant sont proposés.

Tables des matières

La fonction Table des matières de Writer permet de créer une table des matières automatisée à 
partir des titres d’un document, qui sont automatiquement repris sous forme d’hyperliens dans la 
table. À chaque modification du texte d’un titre dans le corps du document ou dans la page où il 
apparaît, celle-ci est retranscrite dans la table des matières dès sa mise à jour suivante.

Avant de commencer, vérifiez que les titres ont des styles cohérents. Vous pouvez, par exemple, 
utiliser le style Titre 1 pour les titres de chapitres et Titre 2 et Titre 3 pour les sous-titres.

Cette section vous montre comment :

• créer rapidement une table des matières avec les réglages par défaut ;

• personnaliser une table des matières.

Remarque

Vous pouvez utiliser les styles que vous voulez pour les différents niveaux qui apparaîtront 
dans la table des matières ; pour des raisons de simplicité, ce chapitre utilise toutefois sur-
tout les styles par défaut Titre n (n de 1 à 10).

Créer rapidement une table des matières

La plupart du temps, vous trouverez probablement que la table des matières par défaut est exacte-
ment celle qui vous convient. En créer une est simple.

 1) Quand vous créez un document, utilisez les styles de paragraphe suivants pour les différents
niveaux de titre (titre de chapitres, de sections…) : Titre 1, Titre 2 et Titre 3. Ce sont eux qui 
apparaîtront dans votre table des matières. Writer peut prendre en compte jusqu’à dix ni-
veaux de titres.

 2) Cliquez dans le document à l’emplacement souhaité pour la table des matières.

 3) Sélectionnez Insertion > Table des matières et index > Table des matières, index ou bi-
bliographie…

 4) Cliquez sur OK. Le résultat sera une table des matières type dont les entrées sont créées 
comme des hyperliens.

Quelques conseils qui peuvent se révéler utiles :

• si certains titres n’apparaissent pas dans la table des matières, vérifiez qu’ils possèdent bien 
un style de paragraphe convenable. Si tout un niveau de titre n’apparaît pas, vérifiez les ré-
glages dans Outils > Numérotation des chapitres. Voir « Utilisation des styles de para-
graphe pour définir une hiérarchie de titres » dans le Chapitre 8 Introduction aux styles, 
page 224, pour plus d’informations ;
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• la table des matières apparaît sur un arrière-plan gris qui vous permet de vous souvenir 
qu’elle est générée automatiquement, mais celui-ci n’est pas imprimé et n’apparaît pas si le 
document est converti au format PDF. Pour le désactiver, ouvrez la page LibreOffice – Cou-
leurs de l’interface de la boîte de dialogue Options (en sélectionnant Outils > Options dans 
la barre de menu) et décochez l’option Trame de fond des index et tables dans la section Do-
cument texte.

Cette modification peut laisser un fond gris derrière les points entre les titres et les numéros 
de page car ceux-ci font partie d’une tabulation. Pour les désactiver, ouvrez la page 
LibreOffice Writer – Aides au formatage de la boîte de dialogue Options (Outils > Options) 
et décochez l’option concernant les tabulations ;

• si vous n’arrivez pas à placer le curseur dans la table des matières, ouvrez la page 
LibreOffice Writer – Aides au formatage de la boîte de dialogue Options (Outils > Options) 
et cochez l’option Activer le curseur dans la section Zones protégées.

Si vous ajoutez ou supprimer du texte, de telle manière que certains titres passent à une autre 
page) ou si vous ajoutez, supprimez ou modifiez des titres, vous devez mettre à jour la table des 
matières. Pour cela, faites un clic droit n’importe où dans la table et sélectionnez Mettre à jour 
l’index dans le menu contextuel.

! Attention

Si l’option Édition > Suivi des modifications > Afficher est activée quand vous modifiez 
un document dont vous mettez la table des matières à jour, des erreurs peuvent survenir 
parce que celle-ci inclura encore les titres supprimés et que le texte que vous avez supprimé
peut produire une mauvaise numérotation des pages. Pour éviter le problème, assurez-vous
que cette option est désactivée avant de mettre la table des matières à jour.

Personnaliser une table des matières

Pratiquement tous les aspects de la table des matières peuvent être adaptés au style et aux né-
cessités de votre document. Mais comme cette souplesse implique une certaine complexité, il est 
bon de garder à l’esprit le résultat final souhaité.

Commencez par cliquer dans le document à l’emplacement souhaité pour la table des matières 
puis sélectionnez Insertion > Table des matières et index > Table des matières, index ou bi-
bliographie… pour ouvrir la boîte de dialogue présentée dans la Figure 15.1.

Vous pouvez aussi ouvrir cette boîte de dialogue à tout moment en faisant un clic droit n’importe 
où dans une table existante et en choisissant Éditer l’index dans le menu contextuel.

La boîte de dialogue Table des matières, index ou bibliographie possède cinq onglets, qui couvrent
chacun un aspect différent de la structure ou de l’apparence d’une table.

• L’onglet Type vous permet de définir les attributs de la table.

• Les onglets Entrées et Styles vous permettent de mettre en forme les entrées de la table.

• L’onglet Colonnes permet de disposer la table sur plusieurs colonnes.

• L’onglet Arrière-plan permet d’ajouter une couleur ou une image à l’arrière-plan de la table.
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Il est possible d’afficher une zone d’aperçu, située à gauche de chaque page, pour voir l’aspect de 
la table après modification : cochez l’option Aperçu en bas à gauche de la boîte de dialogue Les 
illustrations de ce chapitre montrent la boîte de dialogue avec la zone d’aperçu masquée.

Figure 15.1 : L’onglet Type de la boîte de dialogue Table des matières, index ou bibliographie.

Remarque

La zone d’aperçu ne montre que la mise en forme définie par les réglages des onglets Type,
Entrées et Styles. Les autres onglets ont leur propre panneau d’aperçu.

Une fois toutes les modifications effectuées, cliquez sur OK pour les appliquer. Pour revenir aux 
paramètres par défaut des onglets Colonnes et Arrière-plan, ouvrez-les l’une après l’autre et cli-
quez sur le bouton Réinitialiser. Les réglages des onglets Entrées et Styles doivent être rétablis 
manuellement, le bouton n’a aucun effet sur eux.

L’onglet Type

Cet onglet, visible sur la Figure 15.1, vous permet de définir les attributs de la table des matières.

Changer le titre

Pour donner un titre différent à la table, tapez-le dans le champ Titre. Pour supprimer le titre, 
videz ce champ.

Définir le type de table

Vérifiez que le Type de table est bien Table des matières. Voir « Index lexicaux » page 422 
et « Autres types d’index » page 431 pour plus d’informations sur les autres types d’index.

Remarque

Le type d’index ou de table ne peut être modifié qu’au moment de sa création. Une fois ce-
lui-ci défini (par exemple, Table des matières), il n’est plus possible de le modifier.
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Protéger la table contre les modifications manuelles

L’option Protégé contre toute modification manuelle est cochée par défaut pour éviter les 
changements accidentels de la table ; elle ne peut alors être modifiée qu’en faisant un clic 
droit ou en utilisant la boîte de dialogue. Si cette option est décochée, la table pourra être 
modifiée directement comme tout autre texte du document, mais les changements effectués 
de cette façon seront perdus dès la mise à jour suivante.

Choisir la portée de la table des matières

Dans la liste déroulante Pour de la section Créer un index ou une table des matières, vous
pouvez choisir si la table va couvrir tous les titres du document (Document entier) ou seule-
ment ceux du chapitre où elle est insérée (Chapitre). Writer identifie comme « chapitre » tout 
ce qui est contenu entre deux titres de style de premier niveau (normalement le style Titre 1, 
mais le style utilisé peut être modifié).

Changer le nombre de niveaux à inclure

Writer peut construire une table des matières comportant jusqu’à dix niveaux de titre au 
maximum. Pour modifier le nombre de niveaux à prendre en compte, saisissez celui-ci dans 
le champ Évaluer jusqu’au niveau. La table de ce livret ne comporte que les trois premiers ni-
veaux de titre.

Créer une table des matières à partir du plan

La troisième section de l’onglet Type définit ce que Writer doit utiliser pour créer la table des 
matières. Vous pouvez cocher tout ou partie des options :

─ Plan

─ Styles supplémentaires

─ Marques d’index

Par défaut, Writer utilise les niveaux de plan, c’est-à-dire les paragraphes formatés avec les 
styles associés aux niveaux de plan dans Outils > Numérotation des chapitres.

Vous pouvez modifier les styles de paragraphe associés au plan comme cela est décrit dans 
« Utilisation des styles de paragraphe pour définir une hiérarchie de titres » au Cha-
pitre 8 Introduction aux styles, page 224, et vous pouvez inclure d’autres styles de para-
graphe dans la table en leur affectant un niveau de plan. Pour cela, modifiez le style de para-
graphe : ouvrez l’onglet Plan & numérotation de la boîte de dialogue Style de paragraphe et 
choisissez le niveau de plan qui vous convient puis cliquez sur OK pour enregistrer la modifi-
cation.

Figure 15.2 : Définir un niveau de plan pour un style de paragraphe dans l’onglet Plan &
numérotation de la boîte de dialogue Style de paragraphe.

Créer une table des matières à partir de styles supplémentaires

En cochant l’option Styles supplémentaires de l’onglet Type, vous pouvez ajouter d’autres 
styles de paragraphes à la table, par exemple pour y incorporer le titre d’une annexe. Si l’op-
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tion Plan est aussi cochée, les styles supplémentaires s’ajouteront à ceux définis dans la nu-
mérotation des chapitres.

Créer une table des matières à partir des marques d’index

Ce choix permet d’ajouter toutes les entrées d’index que vous avez insérées dans le docu-
ment avec Insertion > Table des matières et index > Entrée d’index… Ce choix n’est nor-
malement pas prévu pour une table des matières. Si vous désirez néanmoins l’utiliser, faites 
bien attention de sélectionner Table des matières dans la liste déroulante Index de la boîte 
de dialogue Insertion d’une entrée d’index (Figure 15.8) quand vous insérez une entrée d’in-
dex prévue pour être utilisée dans la table des matières de façon à ce que Writer puisse la 
distinguer de celles destinées à être incluses dans un index alphabétique.

L’onglet Entrées

L’onglet Entrées (Figure 15.3) vous permet de définir et de formater les entrées de la table des ma-
tières. Chaque niveau de plan peut recevoir un style différent de celui des autres en ajoutant ou en
supprimant des éléments.

Figure 15.3 : L’onglet Entrées de la boîte de dialogue Table des matières, index ou bibliographie.

Sélectionnez dans la liste Niveau celui dont vous voulez mettre en forme l’apparence dans la 
table. La ligne Structure contient les éléments qui font partie du format des entrées de ce niveau. 
Ceux qui peuvent y être ajoutés, s’ils ne sont pas grisés, sont affichés juste en dessous :

• l’icône E# représente le « numéro de chapitre », c’est-à-dire le numéro affecté dans Outils > 
Numérotation des chapitres au style de titre de n’importe quel niveau et pas uniquement 
celui des chapitres. Voir « Définir une numérotation des titres » au Chapitre 8 Introduction 
aux styles, page 226 ;

• l’icône E représente le texte du titre tel qu’il a été saisi pour ce niveau ;

• l’icône T représente un caractère de tabulation ;

• l’icône # représente le numéro de la page où se situe le titre ;

• l’icône DH représente le début d’un hyperlien ;

• l’icône FH représente la fin d’un hyperlien ;
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• les zones blanches de la ligne Structure représentent des espaces où vous pouvez insérer 
un texte personnalisé ou un autre élément.

! Attention

Dans la boîte de dialogue de numérotation des chapitres (présentée au chapitre 8, page
208), si vous avez saisi un texte dans les champs Séparateur Avant et Après à un quel-
conque niveau, ce texte fera partie du champ E# de ce niveau. Pensez-y en créant la struc-
ture de l’entrée dans la table de matières pour ne pas provoquer d’effet inattendu dans celle-
ci.

Ajouter des éléments

Pour ajouter un élément à la ligne Structure :

 1) Cliquez dans le champ vide où vous désirez insérer l’élément.

 2) Cliquez sur un bouton actif juste sous la ligne Structure. Par exemple, pour ajouter une tabu-
lation, cliquez sur le bouton Tabulation. Une icône représentant le nouvel élément apparaît 
dans la ligne Structure.

 3) Pour ajouter un texte personnel, le mot « Chapitre » par exemple, tapez-le dans la zone 
blanche. N’oubliez pas de terminer par un espace.

Modifier les éléments

Pour modifier un élément de la ligne Structure, cliquez sur l’icône qui le représente puis sur un 
bouton non grisé parmi ceux situés sous cette ligne. Par exemple, pour changer un numéro de 
chapitre en caractère de tabulation, cliquez sur l’icône E# dans la ligne Structure (elle prend l’as-
pect d’un bouton enfoncé) puis sur le bouton Tabulation situé en dessous. Si vous changez d’avis 
en cours d’opération, cliquez dans un des espaces vides.

Appliquer les changements à tous les niveaux de plan

Pour appliquer la structure et la mise en forme à tous les niveaux de plan, cliquez sur le bouton 
Tout situé à l’extrémité droite de la ligne Structure.

Supprimer des éléments

Pour supprimer un élément de la ligne Structure, cliquez sur l’icône qui le représente puis appuyez
sur la touche Suppr. de votre clavier. Par exemple, pour supprimer le paramétrage d’hyperlien par
défaut, cliquez sur l’icône DH puis appuyez sur Suppr Répétez l’opération avec l’icône FH.

Appliquer des styles de caractère

Vous voudrez, peut-être, qu’un élément apparaisse de façon un peu différente du reste de la ligne. 
Par exemple, vous pouvez avoir envie que le numéro de page soit en caractères gras. Pour appli-
quer un style de caractère à un élément :

 1) Assurez-vous d’avoir défini au préalable un style de caractère qui vous convienne.

 2) Cliquez sur l’icône de la ligne Structure qui représente l’élément auquel vous désirez appli-
quer le style.

 3) Sélectionnez le style souhaité dans la liste déroulante Style de caractères.

Pour voir ou modifier les attributs d’un style de caractère, sélectionnez-le dans la liste Style de ca-
ractères puis cliquez sur le bouton Éditer…
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Conseil
Le style de caractère par défaut des hyperliens est le style Lien Internet qui est utilisé quand 
vous sélectionnez Insertion > Hyperlien… dans la barre de menu. Les caractères sont sou-
lignés et de couleur bleue.

Le style de caractère par défaut des hyperliens d’une table des matières est le style Saut 
d’index qui peut avoir une apparence différente de celle du style Lien Internet. Si vous dési-
rez qu’ils apparaissent de la même façon que les liens internet, vous pouvez sélectionner 
l’icône DH dans la ligne Structure et modifier le style de caractère de Saut d’index en Lien In-
ternet.

Vous pouvez aussi modifier les attributs du style Saut d’index pour donner à ce style l’appa-
rence que vous souhaitez.

Paramètres de tabulation

Cliquez sur l’icône T dans la ligne Structure pour faire apparaître deux contrôles :

• caractère de remplissage : faites votre choix dans la liste déroulante ou tapez un caractère 
dans le champ de saisie :

• position de tabulation : saisissez la distance à laisser entre la marge gauche de la page et 
l’arrêt de tabulation ou cochez l’option Aligner à droite pour aligner les numéros de page sur 
la marge de droite.

Position relative au retrait de style de paragraphe

Quand cette option est cochée, les entrées sont indentées selon le paramétrage de leurs formats 
propres. Quand un style de paragraphe spécifie un retrait à gauche, les arrêts de tabulation sont 
positionnés par rapport à celui-ci. Si l’option n’est pas cochée, les arrêts de tabulation sont placés 
par rapport à la marge gauche.

L’onglet Styles

L’onglet Styles (Figure 15.4) vous permet de modifier les styles des paragraphes utilisés pour affi-
cher le texte de chaque niveau de la table. La meilleure solution est, le plus souvent, de conserver 
les styles affectés par défaut en modifiant leurs paramétrages pour donner à la table des matières 
l’aspect que vous souhaitez.

Pour appliquer un style de paragraphe personnalisé à un niveau de titre dans la table des ma-
tières :

 1) Sélectionnez un niveau de titre de la table des matières dans la liste de gauche.

 2) Sélectionnez le style de paragraphe souhaité dans la liste de droite.

 3) Cliquez sur le bouton < pour appliquer le style choisi au niveau sélectionné.

Les styles affectés à chaque niveau apparaissent entre crochets dans la liste de gauche.

Pour supprimer l’affectation d’un style de paragraphe à un niveau de titre de la table des matières, 
sélectionnez celui-ci dans la liste de gauche et cliquez sur le bouton Par défaut.

Pour voir ou modifier les attributs d’un style de paragraphe, sélectionnez-le dans la liste de droite 
puis cliquez sur le bouton Éditer.
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Figure 15.4 : L’onglet Styles de la boîte de dialogue Table des matières, index ou bibliographie.

Remarque

Toute modification d’un style de paragraphe affectera tout texte qui est mis en forme grâce à
celui-ci dans le document, pas seulement le contenu de la table des matières.

L’onglet Colonnes

L’onglet Colonnes permet de modifier le nombre de colonnes de la table des matières. Comme il 
est plus courant d’utiliser plusieurs colonnes pour un index que pour une table des matières, cet 
onglet est décrit dans la section des index, page 429.

L’onglet Arrière-plan

Vous pouvez utiliser l’onglet Arrière-plan (Figure 15.5) pour ajouter une couleur ou une image dans
le fond de la table des matières.

Ajouter une couleur

Pour ajouter une couleur à l’arrière-plan de la table, sélectionnez-la dans la grille proposée.

Remarque

Par défaut, l’arrière-plan de la table des matières apparaît sur un fond gris qui vous rappelle 
qu’elle est générée automatiquement, mais qui n’est pas imprimé et qui n’apparaît pas si le 
document est converti au format PDF. Pour le désactiver, ouvrez la page LibreOffice – Cou-
leurs de l’interface de la boîte de dialogue Options (en sélectionnant Outils > Options dans 
la barre de menu) et décochez l’option Trame de fond des index et tables dans la section 
Document texte.
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Figure 15.5 : L’onglet Arrière-plan proposant un choix de couleurs

Ajouter une image

Pour ajouter une image à l’arrière-plan d’une table des matières :

Figure 15.6 : Les options de l’image de fond dans l’onglet Arrière-plan.
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 1) Sélectionnez Image dans la liste déroulante Comme. L’onglet Arrière-plan affiche alors les 
options de l’image, visibles sur la Figure 15.6.

 2) Cliquez sur le bouton Parcourir… pour ouvrir la boîte de dialogue Chercher des images.

 3) Recherchez l’image qui vous intéresse et cliquez sur le bouton Ouvrir. L’image apparaît 
dans la zone d’aperçu. (Sinon, cochez l’option Aperçu juste sous celle-ci).

 4) Pour incorporer l’image au document, décochez l’option Lier. Cochez-la pour lier l’image au 
document sans l’incorporer.

 5) Dans la section Type, choisissez la manière dont vous voulez voir apparaître l’image :

─ pour placer l’image à un endroit précis, cochez Position puis l’emplacement voulu dans la 
grille de positionnement ;

─ pour étendre l’image de façon qu’elle remplisse toute la zone d’arrière-plan, cochez Rem-
plissage,

─ pour répéter l’image dans toute la zone d’arrière-plan, cochez Mosaïque.

Supprimer une couleur ou une image d’arrière-plan

Pour supprimer la couleur ou l’image d’arrière-plan d’une table :

 1) Sélectionnez Couleur dans la liste déroulante Comme.

 2) Cliquez sur Aucun remplissage en haut de la grille de couleurs.

Gérer une table des matières

Cette section vous montre comment :

• éditer une table existante. ;

• mettre à jour une table quand le document a été modifié ;

• supprimer une table des matières.

Éditer une table des matières

Pour éditer une table existante :

 1) Faites un clic droit n’importe où dans la table.

 2) Choisissez Éditer l’index dans le menu contextuel. La boîte de dialogue Table des matières,
index ou bibliographie (Figure 15.1 page 413) s’ouvre et vous pouvez modifier et enregistrer 
la table comme décrit ci-dessus.

Conseil

Si vous n’arrivez pas à cliquer dans la table, elle est probablement protégée. Pour désacti-
ver cette protection, ouvrez la page LibreOffice Writer – Aides au formatage de la boîte de 
dialogue Options (Outils > Options) et cochez l’option Activer le curseur dans la section 
Zones protégées. Si vous ne désirez pas activer le curseur dans les zones protégées, vous
pouvez accéder à la boîte de dialogue via le navigateur.

Il est aussi possible d’accéder à la boîte de dialogue Table des matières, index ou bibliographie 
depuis le navigateur :
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 1) Ouvrez le navigateur (F5).

 2) Cliquez sur le symbole de dépliement (signe + ou triangle) à côté du mot Index.

 3) Faites un clic droit sur Table des matières1 et sélectionnez Index > Éditer.

Figure 15.7 : Accéder à la table des matières depuis le navigateur.

Mettre une table des matières à jour

Comme Writer ne met pas automatiquement à jour la table des matières, après toute modification 
des titres vous devez le faire manuellement :

 1) Faites un clic droit n’importe où dans la table.

 2) Sélectionnez Mettre à jour l’index dans le menu contextuel. Writer actualise la table pour 
refléter les modifications du document.

Il est aussi possible de mettre la table à jour à partir du navigateur en faisant un clic droit sur son 
nom puis en choisissant Index > Actualiser dans le menu contextuel.

Supprimer une table des matières

Pour supprimer la table des matières d’un document :

 1) Faites un clic droit n’importe où dans la table.

 2) Sélectionnez Supprimer l’index dans le menu contextuel. Writer efface la table des ma-
tières.
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! Attention

Aucune confirmation n’est demandée avant la suppression.

Il est aussi possible de supprimer la table à partir du navigateur en faisant un clic droit sur son nom
puis en choisissant Index > Supprimer dans le menu contextuel.

Index lexicaux

Un index lexical ou alphabétique (ou simplement index) est une liste de mots-clefs ou de phrases 
utilisés dans un document ; s’ils sont placés en ordre avec les numéros de page, ils peuvent aider 
le lecteur à retrouver rapidement une information. Un index se trouve généralement à la fin d’un 
livre ou d’un document.

Cette section décrit comment :

• ajouter une entrée d’index ;

• créer rapidement un index alphabétique ;

• personnaliser l’affichage des entrées d’index ;

• personnaliser l’apparence de l’index ;

• afficher et modifier des entrées d’index existantes.

Ajouter des entrées d’index

Avant de pouvoir créer un index, vous devez créer des entrées pour cet index.

 1) Pour ajouter un mot à l’index, placez le curseur n’importe où dans le mot. Si vous souhaitez 
ajouter plusieurs mots comme une entrée unique, sélectionnez la phrase entière.

 2) Sélectionnez Insertion > Table des matières et index > Entrée d’index… pour ouvrir la 
boîte de dialogue Insertion d’une entrée d’index (Figure 15.8). Quand la boîte de dialogue 
apparaît, le texte sélectionné se trouve dans le champ Entrée. Vous pouvez l’accepter ou le 
remplacer par ce que vous voulez.

 3) Cliquez sur Insérer pour créer l’entrée.

Figure 15.8 : Insérer une entrée d’index
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Vous pouvez bien sûr ouvrir la boîte de dialogue avant de sélectionner le texte. Dans ce cas, après
sélection, cliquez sur le bouton Actualiser l’entrée à partir de la sélection ( ) pour placer la sé-
lection dans le champ Entrée.

Remarque

Si le curseur est placé immédiatement avant le premier caractère d’un mot ou immédiate-
ment après son dernier caractère suivi d’un espace, le mot est sélectionné à l’ouverture de 
la boîte de dialogue et placé dans le champ Entrée.

Voir « Personnaliser les entrées d’index » ci-dessous pour une explication des champs de cette 
boîte de dialogue.

Vous pouvez créer plusieurs entrées sans avoir à refermer la boîte de dialogue. Pour chacune 
d’elles :

 1) Cliquez à l’emplacement que vous voulez indexer dans le document.

 2) Cliquez de nouveau dans la boîte de dialogue.

 3) Modifiez l’entrée si nécessaire puis cliquez sur Insérer.

 4) Répétez les étapes 1 à 3 jusqu’à avoir parcouru toutes les entrées et cliquez sur Fermer.

Remarque

Si le tramage des champs est actif (Affichage > Trame de fond des champs ou Ctrl+F8),
un mot ou une phrase ajoutés à l’index apparaissent sur un fond gris. Si le texte sélectionné 
pour l’entrée d’index a été remplacé par un autre, le fond gris se réduit à un petit rectangle 
au début du mot.

Astuce

Vous pouvez aussi ouvrir la boîte de dialogue Insertion d’une entrée d’index en cliquant sur 
le bouton Insérer une entrée d’index dans la barre d’outils Insérer.

Figure 15.9 : Le bouton Entrée d’index dans la barre d’outils Insérer

Personnaliser les entrées d’index

Voici une présentation rapide des champs de la boîte de dialogue Insertion d’une entrée d’index et 
de leur utilisation.

Index

Le type d’index auquel cette entrée est destinée. C’est, par défaut, l’index lexical, mais vous 
pouvez utiliser ce champ pour créer une entrée supplémentaire dans une table des matières,
un index personnalisé ou une liste de pratiquement tout ce que vous voulez. Par exemple, 
vous pouvez établir un index ne contenant que les noms scientifiques des espèces mention-
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nées dans le texte et un autre ne contenant que les noms communs de ces espèces. Voir 
« Autres types d’index » page 431.

Entrée

Le mot ou la phrase à ajouter à l’index sélectionné. Celui-ci ne doit pas obligatoirement se 
trouver dans le document lui-même, vous pouvez ajouter des synonymes ou d’autres termes 
que vous désirez voir figurer dans l’index.

Clé 1

Une clé d’index est une entrée qui n’est pas associée à un numéro de page et qui possède 
plusieurs entrées secondaires qui en sont dotées. L’utilisation de clés est un moyen pratique 
pour grouper des sujets reliés l’un à l’autre (voir « Exemple d’utilisation d’une clé d’in-
dex » ci-dessous).

Clé 2

Un index peut avoir jusqu’à trois niveaux, ceux du premier niveau possédant des entrées de 
niveau 2 qui sont aussi des clés (sans numéro de page). Ce degré de complexité est rare-
ment nécessaire pour un index.

Entrée principale

Quand le même terme est indexé sur plusieurs pages, une de celles-ci renferme souvent des
informations plus importantes ou plus détaillées ; vous pouvez en faire l’entrée principale. 
Pour faire ressortir le numéro de page de l’entrée principale ou des entrées les plus impor-
tantes, cochez cette option puis paramétrez le style de caractère du numéro de page d’une 
entrée principale d’index en gras, par exemple.

Appliquer à tous les textes similaires

Cochez cette option pour que Writer identifie et marque automatiquement tout autre mot ou 
phrase qui correspond à la sélection actuelle. Les options Respecter la casse et Uniquement
les mots entiers deviennent accessibles quand celle-ci est cochée. Utilisez-la avec précau-
tion, car il peut en résulter l’incorporation dans l’index d’un grand nombre de pages non dési-
rées (pour des utilisations mineures d’un mot).

Exemple d’utilisation d’une clé d’index

Une clé d’index est une entrée primaire sous laquelle sont groupées des entrées secondaires. 
Vous pouvez, par exemple, créer un groupement semblable à celui-ci :

LibreOffice
Calc, 10
Impress, 15
Writer, 5

Dans cet exemple, LibreOffice est la Clé 1. Les entrées secondaires (avec les numéros de page) 
sont les entrées indexées. Pour insérer une entrée d’index pour le sujet Writer, tapez Writer dans 
le champ Entrée de la boîte de dialogue Insertion d’une entrée d’index (Figure 15.8, page 422) et 
LibreOffice dans le champ Clé 1.

Créer rapidement un index lexical

Maintenant que vous disposez de quelques entrées d’index, vous pouvez créer celui-ci.
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Bien que les index puissent largement être personnalisés dans Writer, vous n’avez, la plupart du 
temps, que quelques choix à faire.

Pour créer rapidement un index :

 1) Cliquez dans le document à l’emplacement où vous désirez ajouter l’index et sélectionnez 
Insertion > Table des matières et index > Table des matières, index ou bibliographie… 
pour ouvrir la boîte de dialogue Table des matières, index ou bibliographie.

 2) Dans la liste déroulante Type de l’onglet Type, choisissez Index lexical (Figure 15.10).

 3) Dans la section Options, vous pouvez décocher l’option Respecter la casse (pour que les 
mots en majuscules ou en minuscules soient considérés comme identiques) et Avec sv sous 
l’option Regrouper les entrées identiques.

 4) Cliquez sur OK pour obtenir un index classique.

Writer ne met pas automatiquement l’index à jour. Si vous ajoutez, supprimez ou modifiez le texte 
des entrées d’index, vous devez l’actualiser. Pour cela, suivez la méthode proposée dans « Mettre
une table des matières à jour » page 421.

Personnaliser l’apparence d’un index

Pour personnaliser un index existant, faites un clic droit n’importe où dans l’index et sélectionnez 
Éditer l’index dans le menu contextuel.

La boîte de dialogue Table des matières, index ou bibliographie (Figure 15.10) possède cinq on-
glets qui permettent tous de personnaliser l’apparence de l’index.

• L’onglet Type permet de paramétrer les attributs de l’index.

• Les onglets Entrées et Styles permettent de formater les entrées de l’index.

• L’onglet Colonnes permet de faire apparaître l’index sur plusieurs colonnes.

• L’onglet Arrière-plan permet d’ajouter une couleur ou une image comme fond de l’index.

Figure 15.10 : L’onglet Type de la boîte de dialogue Index lexical.
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La zone d’aperçu située à gauche de la boîte de dialogue reflète l’aspect de l’index suite aux choix 
effectués. Si elle n’est pas visible, cochez l’option Aperçu, dans le coin inférieur droit de la boîte de
dialogue.

Une fois les modifications effectuées, cliquez sur OK pour enregistrer l’index et appliquer les chan-
gements au document.

Remarque

La zone d’aperçu ne montre que la mise en forme définie par les réglages des onglets Type,
Entrées et Styles. Les autres onglets ont leur propre panneau d’aperçu.

Onglet Type

Utilisez l’onglet Type pour définir les attributs de base de l’index.

 1) Pour donner à l’index un autre titre, tapez-le dans le champ Titre. Pour supprimer le titre, vi-
dez ce champ.

 2) Assurez-vous que le Type d’index est bien Index lexical.

 3) Pour éviter que l’index soit accidentellement modifié, cochez l’option Protégé contre toute 
modification manuelle. L’index ne pourra plus être modifié que par le menu contextuel après 
un clic droit ou par la boîte de dialogue Table des matières, index ou bibliographie. Si l’option
n’est pas cochée, l’index peut être directement modifié dans le document tout comme un 
autre texte mais toutes les modifications manuelles seront perdues à la mise à jour suivante.

 4) Dans la liste déroulante Pour de la section Créer un index ou une table des matières, sé-
lectionnez Document entier. Vous pouvez aussi choisir de créer un index uniquement pour le
chapitre courant.

 5) Diverses autres options déterminent comment l’index gère les entrées :

─ l’option Regrouper les entrées identiques définit la façon dont les entrées identiques sont 
gérées. Normalement (option non cochée), chaque numéro de page d’un mot ou d’une 
phrase indexé apparaît sur une ligne différente de l’index. Quand elle est cochée, les nu-
méros de page des entrées identiques sont regroupés sur la même ligne, séparés par des
virgules,

En cochant l’option Avec sv, si une entrée apparaît dans plusieurs pages consécutives, 
seul le numéro de la première page est indiqué suivi de la mention sv.

En cochant l’option Avec –, si une entrée apparaît dans plusieurs pages consécutives, le 
numéro de la première et de la dernière seront seuls indiqués, séparés par un tiret.

Si vous cochez l’option Respecter la casse, Writer placera des entrées qui se distinguent 
uniquement par l’emploi des majuscules et des minuscules sur des lignes différentes,

─ si l’option Entrées en majuscules (autom.) est cochée la première lettre de chaque entrée 
sera en majuscule quelle que soit la casse employée pour celle-ci dans le document lui-
même, 

─ cochez l’option Clés comme entrées séparées pour que les clés possèdent leur propre 
numéro de page, 

─ l’option Fichier de concordance autorise l’importation d’un fichier externe (sélectionné en 
cliquant sur le bouton Fichier) qui sera utilisé dans l’index. Il s’agit d’un fichier de format 
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particulier ; pour plus d’informations, reportez-vous à la page « Éditer le fichier de 
concordance » de l’aide de LibreOffice (Aide > Aide de LibreOffice). L’utilisation d’un fi-
chier de concordance peut accélérer la production d’un index, mais, à moins de choisir les
mots avec soin et d’éditer l’index après coup, le résultat peut être rempli d’entrées corres-
pondantes à des mentions mineures d’un terme, ce qui le rendra moins utile qu’un index 
plus sélectif,

─ l’option Trier définit l’ordre de tri des entrées. La seule option est Alphanumérique, mais 
vous pouvez choisir la langue à utiliser.

L’onglet Entrées

Utilisez l’onglet Entrées pour définir exactement ce qui sera affiché pour chaque entrée et com-
ment. L’onglet est présenté à la Figure 15.11. Remarquez qu’il n’est pas possible d’établir un hy-
perlien de l’index à l’emplacement de l’entrée correspondante dans le texte.

Figure 15.11 : L’onglet Entrées de la boîte de dialogue Index lexical.

Commencez par sélectionner, dans la colonne Niveau, le niveau d’index que vous voulez formater.
Le niveau « S » concerne la lettre qui sert de titre et sépare les entrées dans l’ordre alphabétique 
quand l’option Séparateur alphabétique est cochée dans la section Format. La ligne Structure af-
fiche les éléments des entrées de ce niveau. Chaque icône de cette ligne représente un élément :

• l’icône E représente le texte de l’entrée ;

• l’icône T représente un caractère de tabulation ;

• l’icône # représente le numéro de la page où se situe l’entrée ;

• l’icône IC représente des informations sur le chapitre (voir « Info chapitre » $1-$2). Elle 
n’est pas présente par défaut, mais vous pouvez l’ajouter en cliquant sur le bouton Info cha-
pitre ;

• les zones blanches de la ligne Structure représentent des espaces où vous pouvez insérer 
un texte personnalisé.
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Ajouter des éléments

Pour ajouter un élément à la ligne Structure :

 1) Cliquez dans le champ vide où vous désirez insérer l’élément.

 2) Cliquez sur un bouton actif juste sous la ligne Structure. Par exemple, pour ajouter une tabu-
lation, cliquez sur le bouton Tabulation. Une icône représentant le nouvel élément apparaît 
dans la ligne Structure.

 3) Pour ajouter un texte personnel, tapez-le dans la zone blanche. N’oubliez pas de terminer 
par un espace.

Modifier les éléments

Pour modifier un élément de la ligne Structure, cliquez sur l’icône qui le représente puis sur un 
bouton non grisé parmi ceux situés sous cette ligne. Par exemple, pour remplacer le texte de l’en-
trée par un caractère de tabulation, cliquez sur l’icône E dans la ligne Structure (elle prend l’aspect
d’un bouton enfoncé) puis sur le bouton Tabulation situé en dessous. Si vous changez d’avis en 
cours d’opération, cliquez dans un des espaces vides.

Supprimer des éléments

Pour supprimer un élément de la ligne Structure, cliquez sur l’icône qui le représente puis appuyez
sur la touche Suppr. de votre clavier. Par exemple, pour supprimer le caractère de tabulation, cli-
quez sur l’icône T puis appuyez sur Suppr.

Info chapitre

Ce bouton insère des informations sur le chapitre : le titre, le numéro ou les deux selon le choix ef-
fectué dans la liste déroulante Entrée de chapitre. Ces données sont définies dans la boîte de dia-
logue Numérotation de chapitres (Outils > Numérotation de chapitres).

Appliquer des styles de caractère

Chaque élément qui peut être ajouté à la ligne Structure peut recevoir une mise en forme supplé-
mentaire. Par exemple, vous pouvez avoir envie que le numéro de page ait une taille différente du 
reste du texte. Pour appliquer un style de caractère à un élément :

 1) Assurez-vous d’avoir défini au préalable un style de caractère qui vous convienne.

 2) Cliquez sur l’icône de la ligne Structure qui représente l’élément auquel vous désirez appli-
quer le style.

 3) Sélectionnez le style souhaité dans la liste déroulante Style de caractères.

Pour voir ou modifier les attributs d’un style de caractère, sélectionnez-le dans la liste Style de ca-
ractères puis cliquez sur le bouton Éditer…

Formater les entrées

Appliquez une mise en forme supplémentaire grâce aux options de la section Format.

• l’option Séparateur alphabétique permet le regroupement des entrées de l’index en blocs de 
même initiale qui sert de titre à chaque bloc. Par exemple, si votre index commence :

alignement, 4
auteur, 10
bloc, 6
bordure, 8
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Quand cette option est cochée, vous obtenez :

A

alignement, 4
auteur, 10

B

bloc, 6
bordure, 8

• l’option Clés séparées par des virgules dispose les entrées de l’index sur la même ligne mais
séparées par des virgules.

• Si l’option Position relative au retrait de style de paragraphe est cochée, les entrées sont in-
dentées selon le paramétrage de leurs formats propres. Quand un style de paragraphe spé-
cifie un retrait à gauche, les arrêts de tabulation sont positionnés par rapport à celui-ci. Si 
l’option n’est pas cochée, les arrêts de tabulation sont placés par rapport à la marge gauche.

Les onglets Styles et Arrière-plan

Voyez « L’onglet Styles » page 417 et « L’onglet Arrière-plan » page 418 pour toute information 
détaillée sur ces onglets.

L’onglet Colonnes

Utilisez l’onglet Colonnes (Figure 15.12) pour modifier le nombre de colonnes de l’index.

Figure 15.12 : L’onglet Colonnes de la boîte de dialogue Index lexical

Ajouter plusieurs colonnes

Pour que l’index s’affiche sur plusieurs colonnes :

 1) Saisissez le nombre de colonnes dans le champ Colonnes ou cliquez sur l’icône qui repré-
sente le nombre de colonnes souhaitées.
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 2) Pour répartir également les colonnes sur la largeur de la page, cochez l’option Largeur auto-
matique. Si elle n’est pas cochée, vous pouvez définir manuellement :

─ la largeur de chaque colonne,

─ l’espace entre celles-ci.

 3) Vous pouvez décider de tracer une ligne de séparation entre les colonnes :

─ Style : la valeur par défaut est – aucun(e) –, sinon vous avez le choix entre trois styles de 
lignes,

─ Largeur : la valeur de ce champ représente l’épaisseur de la ligne, 0,25 pt par défaut,

─ Hauteur : la valeur de ce champ représente la hauteur de la ligne en pourcentage de celle
de la colonne. La valeur par défaut est 100 %,

─ Position : cette liste déroulante vous permet de choisir la position relative de la ligne dans 
la colonne (Haut, Centré ou Bas) si la hauteur est inférieure à 100 %,

─ Couleur : permet de choisir la couleur de la ligne de séparation.

Gérer un index

Pour éditer une table existante :

 1) Faites un clic droit n’importe où dans la table.

 2) Choisissez Éditer l’index dans le menu contextuel. La boîte de dialogue Table des matières,
index ou bibliographie (Figure 15.10 page 425) s’ouvre et vous pouvez modifier et enregis-
trer la table comme décrit ci-dessus.

Pour actualiser ou supprimer un index, faites un clic droit n’importe où dans celui-ci et sélectionnez
Mettre à jour l’index ou Supprimer l’index dans le menu contextuel.

Voir et modifier les entrées d’index existantes

Une fois que vous avez ajouté les premières entrées, vous pouvez y apporter quelques modifica-
tions. Vous pouvez les visualiser et les éditer de la façon suivante :

 1) Assurez-vous que la trame de fond des champs est visible (Affichage > Trame de fond des
champs ou Ctrl+F8) pour pouvoir plus facilement repérer les entrées d’index.

 2) Placez le curseur dans la trame de fond d’une entrée existante du corps du document, faites 
un clic droit et sélectionnez Entrée d’index… dans le menu contextuel. Si le texte de l’entrée
a été modifié, la trame est un rectangle situé immédiatement avant le mot. Placer le curseur 
immédiatement avant un mot marqué comme entrée satisfera les deux critères de sélection.

 3) La boîte de dialogue Édition d’une entrée d’index s’ouvre (Figure 15.13). Vous pouvez par-
courir les différentes entrées grâce aux boutons fléchés. Si plusieurs entrées existent pour 
un mot ou une phrase, une deuxième ligne de bouton, dont la flèche se termine par une 
barre verticale, vous permet de parcourir ces entrées.

 4) Effectuez les modifications et additions voulues aux entrées de l’index puis cliquez sur OK.

430 | Guide de LibreOffice Writer Index lexicaux



 Chapitre 15 Tables des matières, index et bibliographies

Figure 15.13 : Voir et éditer les entrées d’index.

Autres types d’index

L’index lexical n’est pas le seul type d’index que l’on peut construire avec Writer. Parmi les autres 
types proposés par Writer on trouve des index pour les illustrations, les tableaux et les objets et il 
est même possible de créer des index propres à l’utilisateur. Ce chapitre ne donnera pas 
d’exemples de toutes les possibilités.

Pour créer un autre type d’index :

 1) Placez le curseur à l’emplacement du futur index.

 2) Sélectionnez Insertion > Table des matières et index > Table des matières, index ou bi-
bliographie… dans la barre de menu.

 3) Dans la boîte de dialogue Table des matières, index ou bibliographie, choisissez le type d’in-
dex désiré dans la liste déroulante Type.

 4) Paramétrez l’index en utilisant les onglets semblables à celles présentées dans les sections 
précédentes.

 5) Cliquez sur OK quand tout est réglé.

Exemple : création d’une table des illustrations

Créer un index des illustrations ou des tableaux est simple si leurs légendes ont été créées par le 
menu Insertion > Légende… ou en utilisant une variable Séquence comme décrit au Chapitre 17 
Travailler avec les champs, page 477.

 1) Dans la boîte de dialogue Table des matières, index ou bibliographie, choisissez Index des 
illustrations dans la liste déroulante Type (Figure 15.14).

 2) Assurez-vous que l’option Légendes est cochée dans la section Créer à partir de et choisis-
sez une catégorie de légende. Le choix par défaut est Illustration ; l’exemple utilise la catégo-
rie Figure qui n’existe pas par défaut dans LibreOffice mais qui apparaît dans la liste dès que
vous l’avez définie en créant une légende de cette catégorie dans votre document. Voir le 
Chapitre 11 Images et objets graphiques, page 306, pour plus d’information sur la création 
de légendes.

 3) Dans la liste déroulante Afficher, vous pouvez choisir Références (pour afficher la catégorie, 
le numéro et le texte de la légende), Catégorie et numéro ou Texte de légende. Dans 
l’exemple, Références a été choisi.
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Figure 15.14 : Créer une table des illustrations

 4) Les autres onglets de la boîte de dialogue sont semblables à celles qui ont été décrites pour 
les tables des matières.

 5) Cliquez sur OK pour obtenir un résultat comme celui-ci :

Figure 15.15 : Exemple de table des illustrations

Bibliographies

Une bibliographie est une liste des références des ouvrages utilisés dans un document. Ces réfé-
rences sont stockées dans une base de données bibliographiques ou dans le document lui-même.

Cette section vous explique comment :

• créer une base de données bibliographique, y ajouter et en gérer les entrées ;

• ajouter une référence à un document ;

• formater la bibliographie ;
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• actualiser et éditer une bibliographie existante.

Créer une base de données bibliographiques

Dans la plus grande partie de cette section, la table de base de données utilisée est l’exemple 
fourni avec Writer. Pour plus d’information sur la création d’une nouvelle table dans la base de 
données bibliographiques, voir le chapitre 8, Débuter avec Base du Guide du Débutant.

Bien qu’il soit possible de créer les références dans le document lui-même, une base de données 
bibliographiques permet de les réutiliser dans d’autres documents et fait gagner beaucoup de 
temps.

Sélectionnez Outils > Base de données bibliographique dans la barre de menu pour ouvrir la 
fenêtre de la base de données visible sur la Figure 15.16. La partie supérieure montre tous les en-
registrements disposés comme dans une feuille de calcul ; la partie inférieure affiche les champs 
de l’enregistrement sélectionné.

Figure 15.16 : La fenêtre principale de la base de données bibliographique.

Filtrer les enregistrements

Pour filtrer des enregistrements particuliers dans la base de données bibliographiques, sélection-
nez Outils > Filtrer… dans la barre de menu de la base de données ou cliquez sur le bouton Fil-
trage standard ( ) dans la barre d’outils en dessous de la barre de menu. Dans la boîte de dia-
logue Filtre standard (Figure 15.17), choisissez les champs, les conditions et les valeurs pour le 
filtre puis cliquez sur OK.
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Figure 15.17 : Définir un filtre pour la base de données bibliographiques.

Modifier les détails des colonnes

Pour modifier les détails des colonnes dans la base de données bibliographiques, sélectionnez 
Édition > Disposition des colonnes… dans la barre de menu ou cliquez sur le bouton Disposi-
tion des colonnes dans la barre d’outils sous la barre de menu (voir Figure 15.16). Dans la boîte 
de dialogue Mise en page de colonnes pour la table biblio (Figure 15.18), vous pouvez changer les
champs affectés aux colonnes. Par exemple, vous pouvez décider de placer les données 
Auteur(s) dans la colonne Identifier en sélectionnant cette colonne dans la liste déroulante. La co-
lonne de destination des données Abrégé passe automatiquement à <aucun> car une colonne ne 
peut contenir qu’une seule sorte de données.

Figure 15.18 : Modifier la disposition des colonnes de la base de données bibliographiques.

Changer de source de données

Pour modifier la source de données utilisée (par exemple, si vous avez plusieurs bases de don-
nées bibliographiques pour différents usages), sélectionnez Édition > Sélectionner la source de 
données… dans la barre de menu ou cliquez sur le bouton Source de données dans la barre 
d’outils. Choisissez une source de données dans la boîte de dialogue Sélectionner la source de 
données puis cliquez sur OK.

Modifier les détails des champs

Vous pouvez effectuer des modifications dans la base de données bibliographiques (par exemple, 
renommer les champs ou changer leur longueur) de la manière suivante :
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Figure 15.19 : Vue Source de données de la base de données bibliographiques

 1) Dans le document principal (pas dans la fenêtre de la base de données bibliographiques), 
appuyez sur Ctrl+Maj+F4 ou sélectionnez Affichage > Sources de données pour ouvrir 
la fenêtre des sources de données (Figure 15.19).

 2) Vérifiez que la base de données Bibliography est sélectionnée ainsi que la table correcte. Il 
faudra peut-être déployer certains niveaux pour pouvoir y arriver.

 3) Faites un clic droit sur une table (biblio dans notre exemple) et sélectionnez Éditer un fi-
chier de base de données… dans le menu contextuel. Une fenêtre de Base, le module de 
base de données de LibreOffice, s’ouvre comme sur la Figure 15.20.

Figure 15.20 : Fenêtre principale de Base pour le travail sur les bases de données

 4) Si Tables n’est pas encore sélectionné dans la partie gauche, Base de données, faites-le 
maintenant.

 5) Faites un clic droit sur le nom de la table (biblio) dans la section Tables et sélectionnez Édi-
ter… dans le menu contextuel pour ouvrir la fenêtre visible à la Figure 15.21.

 6) Vous pouvez maintenant sélectionner chaque champ puis le texte dans la colonne Nom de 
champ et le modifier à votre guise, cliquer dans la cellule Type de champ pour activer une 
liste déroulante qui vous permettra de modifier le type de données. Dans la section Proprié-
tés du champ, vous pouvez effectuer les modifications souhaitées. Une explication apparaît 
dans la zone à droite de la section quand un champ est sélectionné.

 7) Quand vous aurez fini, une confirmation vous sera demandée avant d’enregistrer les modifi-
cations.

Guide de LibreOffice Writer Bibliographies | 435



 Chapitre 15 Tables des matières, index et bibliographies

Figure 15.21 : Fenêtre de modification des propriétés de la table

Remarque

Vous trouverez plus d’explication sur l’utilisation des fonctions de base de données de 
LibreOffice dans le chapitre 8, Débuter avec Base du Guide du Débutant.

Ajouter des entrées à la base de données

Utilisez la boîte de dialogue Base de données bibliographique (Outils > Base de données biblio-
graphique) pour ajouter des entrées à la base de données.

 1) Vous pouvez ajouter directement des enregistrements dans la base de données en utilisant 
les champs dans la partie basse de la boîte de dialogue visible sur la Figure 15.16 page 433.

 2) Sélectionnez Insertion > Enregistrer dans la barre de menu de la boîte de dialogue ou cli-
quez sur le bouton Insérer un enregistrement ( ) à la gauche de la barre de défilement ho-
rizontale.

 3) Saisissez un nom pour l’entrée dans le champ Abrégé. Complétez les autres champs selon 
nécessité. Utilisez la touche Tabulation pour vous déplacer d’un champ à l’autre.

Il vaut mieux utiliser un nom unique dans le champ Abrégé car c’est le champ utilisé quand 
on insère une entrée dans le document.
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 4) Pour terminer la saisie, allez au dernier champ et appuyez une fois encore sur Tabulation.

Si votre document nécessite des citations du style [Auteur, date], utilisez le champ Abrégé de la 
base de données pour enregistrer les informations au format voulu.

Gérer les entrées de la base de données

Utilisez la boîte de dialogue Base de données bibliographique (Outils > Base de données biblio-
graphique) pour gérer les entrées dans la base de données. Cliquez dans l’enregistrement conve-
nable et modifiez les champs à votre convenance.

Les entrées modifiées sont automatiquement enregistrées dans la base de données quand le cur-
seur qui l’enregistrement.

Ajouter des références (citations) à un document

Writer propose deux méthodes pour ajouter des références à un document :

• depuis une base de données bibliographiques comme celle installée avec Writer ;

• directement depuis le clavier.

Entrer les références depuis une base de données

Pour ajouter des références à un document depuis une base de données bibliographiques :

 1) Placez le curseur à l’endroit où la référence doit apparaître.

 2) Sélectionnez Insertion > Table des matières et index > Entrée de bibliographie…

Figure 15.22 : Insérer une entrée de bibliographie dans un document.

 3) Dans la boîte de dialogue Insérer une entrée de bibliographie (Figure 15.22), cochez l’option 
À partir de la base de données bibliographique.

 4) Sélectionnez la référence dans la liste déroulante Abrégé en bas de la boîte de dialogue. 
L’auteur et le titre de la référence choisie apparaissent au milieu de la fenêtre pour vous per-
mettre de vérifier que vous avez choisi la bonne référence.

 5) Cliquez sur Insérer pour insérer la référence dans le document.

 6) Vous pouvez laisser la boîte de dialogue ouverte pour insérer d’autres références dans le do-
cument ; il est inutile de la fermer et de la rouvrir à chaque fois.
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 7) Quand vous avez inséré toutes les références, cliquez sur Fermer.

Entrer des références depuis le document

Vous avez aussi le choix d’entrer vos références bibliographiques directement dans le document 
plutôt qu’à partir d’une base de données externe, par exemple si vous ne travaillez pas sur votre 
ordinateur.

 1) Placez le curseur à l’endroit où la référence doit apparaître.

 2) Sélectionnez Insertion > Table des matières et index > Entrée de bibliographie…

 a) Cliquez sur Nouveau.

 b) Dans la boîte de dialogue Définir une entrée de bibliographie, complétez les champs qui 
concernent votre référence. Saisissez un nom unique dans le champ Abrégé car c’est le 
champ utilisé par la boîte de dialogue Insérer une entrée de bibliographie pour la citation.

 c) Faites un choix dans la liste déroulante Type pour activer le bouton OK puis cliquez sur 
celui-ci quand tous les champs nécessaires sont remplis.

 d) Cliquez sur Insérer pour placer le champ Abrégé dans le document.

 e) Cliquez à chaque emplacement où vous désirez ajouter une entrée et répétez cette suite 
d’opérations.

 3) Cliquez sur Fermer.

Pour réutiliser une entrée dans votre document, reprenez la suite d’opérations précédentes mais 
sélectionnez l’Abrégé voulu dans la liste déroulante au lieu d’ajouter une nouvelle entrée.

Éditer une référence

Pour éditer une référence :

 1) Faites un clic droit sur l’entrée.

 2) Sélectionnez Entrée de bibliographie… dans le menu contextuel. La boîte de dialogue Édi-
ter une entrée de bibliographie s’ouvre (Figure 15.23).

Figure 15.23 : Éditer une entrée de bibliographie.

 3) Si vous ne voulez modifier que l’abrégé, cliquez dans la boîte de saisie, effectuez la modifi-
cation puis cliquez sur Appliquer.
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 4) Pour modifier davantage l’entrée, cliquez sur Éditer pour ouvrir la boîte de dialogue Définir 
une entrée de bibliographie. Effectuez-y les modifications nécessaires puis cliquez sur OK 
pour revenir à la boîte de dialogue de la Figure 15.23.

 5) Quand vous êtes satisfait des modifications apportées, cliquez sur Appliquer pour les ac-
cepter et fermer la boîte de dialogue.

Quelle que soit la source de la citation, les références modifiées sont stockées dans le document. 
Si la source était une base de données bibliographiques, celle-ci demeure inchangée.

Créer la bibliographie

Pour créer la bibliographie :

 1) Placez le curseur à l’emplacement de la future bibliographie.

 2) Sélectionnez Insertion > Table des matières et index > Table des matières, index ou bi-
bliographie… dans la barre de menu.

 3) Dans la boîte de dialogue Table des matières, index ou bibliographie, sélectionnez Bibliogra-
phie dans la liste déroulante Type (Figure 15.24).

La boîte de dialogue Table des matières, index ou bibliographie possède cinq onglets.

L’onglet Type

Writer propose deux façons d’afficher les références (citations) dans le texte d’un document :

• utiliser le texte enregistré dans le champ Abrégé de chaque entrée bibliographique, par 
exemple [ARJ00] ;

• numéroter les documents référencés à mesure de leur apparition dans le texte, par exemple 
[1].

Conseil

Pour préciser le style de citation utilisé dans le document, utilisez l’onglet Type de la boîte 
de dialogue Table des matières, index ou bibliographie (Figure 15.24).

La mise en forme de la bibliographie demande de faire deux choix à des endroits différents :

• la boîte de dialogue Table des matières, index ou bibliographie décrite ici ;

• le style de paragraphe Bibliographie 1 (voir page 441).

Les réglages de base sont effectués sur cette page.

 1) Pour donner un titre à la bibliographie, saisissez-le dans le champ Titre. (Le titre n’est pas 
obligatoire.)

 2) Vous pouvez protéger la bibliographie contre les modifications accidentelles en cochant l’op-
tion Protégé contre toute modification manuelle. Dans ce cas, la bibliographie ne peut être 
modifiée qu’en utilisant le menu contextuel ou la boîte de dialogue Table des matières, index
ou bibliographie. Sinon, elle peut être modifiée directement dans le document comme tout 
autre texte, mais les modifications manuelles seront perdues quand la bibliographie sera ac-
tualisée.
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 3) Pour que les entrées de la bibliographie (citations) soient numérotées dans le corps du docu-
ment (par exemple [1], [2]…) cochez Entrées numériques. Si vous préférez voir le contenu 
du champ Abrégé de la base de données dans le document, ne la cochez pas.

 4) Sélectionnez le type de crochets que vous désirez pour les entrées référencées dans le 
corps du document.

 5) Choisissez le tri dont vous avez besoin. Pour l’instant, le seul choix possible est le tri alpha-
numérique. Le tri selon l’emplacement des entrées dans le document s’effectue à l’onglet 
Entrées.

Figure 15.24 : La boîte de dialogue Insérer une bibliographie

L’onglet Entrées

La structure de cet onglet (Figure 15.25) est semblable à celles des onglets correspondants pour 
les tables des matières et les index.

Figure 15.25 : L’onglet Entrées pour les bibliographies.
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Chaque type de source que vous utilisez lors de la création de votre document aura son propre 
format unique d’œuvres citées. Vous pouvez définir l’apparence que prendra l’entrée, selon sa 
source, en sélectionnant celle-ci dans la liste Type, ou simplement appliquer le même format à 
toutes les entrées en cliquant sur le bouton Tout.

Chaque entrée de la liste Type possède un format de structure par défaut.

La structure de l’entrée est basée sur les champs disponibles dans la base de données bibliogra-
phiques. Ceux qui s’affichent par défaut pour le type Article de la liste sont :

Ab : Abrégé
Au : Auteur(s)
Ti : Titre
An : Année

Pour supprimer un élément de la ligne Structure, cliquez sur celui-ci puis sur le bouton Retirer.

Pour ajouter un élément, cliquez à l’emplacement où il doit être inséré dans la ligne Structure. Sé-
lectionnez soit Tabulation, soit un élément de la liste déroulante située à gauche du bouton Insé-
rer puis cliquez sur ce bouton. Les éléments de la liste déroulante sont les champs que l’on trouve 
dans la base de données Bibliography.

Tous les éléments de la ligne Structure peuvent être mis en forme en sélectionnant un style de ca-
ractère dans la liste déroulante prévue à cet effet.

Pour définir l’ordre de tri des entrées, changez l’option dans la section Trier par. Le choix Empla-
cement dans le document place les entrées dans l’ordre de leur apparition dans le document. Le 
choix Contenu trie les entrées dans l’ordre alphanumérique. Dans le cas, les clés de la section Cri-
tères de tri permettent de regrouper des références semblables.

Les onglets Styles, Colonnes et Arrière-plan

Reportez-vous aux paragraphes « L’onglet Styles » page 417, « L’onglet Colonnes » page 429 
et « L’onglet Arrière-plan » page 418 pour toute information sur ces onglets.

Générer la bibliographie

Pour générer la bibliographie dans votre document, cliquez sur OK. La boîte de dialogue se ferme 
et la bibliographie apparaît dans votre document.

Définir le style de paragraphe pour la bibliographie

Vous pouvez modifier le style de paragraphe Bibliographie 1 pour l’adapter à vos besoins. Par 
exemple, pour numéroter les entrées de la liste bibliographique, vous devez définir un style de nu-
mérotation et le lier au style de paragraphe Bibliographie 1. Pour cela :

 1) Dans la fenêtre Styles et formatage, cliquez sur l’icône Styles de liste.

Vous pouvez définir un nouveau style ou en modifier un existant. Dans cet exemple, nous al-
lons modifier le style Numérotation 5.

Faites un clic droit sur Numérotation 5 et choisissez Modifier… dans le menu contextuel.

 2) Dans la boîte de dialogue Style de numérotation, ouvrez l’onglet Personnaliser.

Dans notre exemple, nous voulons placer les numéros entre crochets. Pour cela, tapez « [ » 
dans le champ Avant et « ] » dans le champ Après comme sur la Figure 15.26.
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Figure 15.26 : Placer les numéros d’une liste entre crochets

 3) Ouvrez maintenant l’onglet Position (Figure 15.27).

Dans le champ Retrait à, indiquez le retrait par rapport à la marge appliqué à la deuxième 
ligne (et les suivantes) de chaque élément de la liste. Pour l’alignement vertical, placez la ta-
bulation à la même distance. Il faudra souvent faire quelques essais pour trouver le meilleur 
réglage. Dans l’exemple, nous avons choisi 1 cm.

Figure 15.27 : Paramétrer l’espace entre la marge et le texte

 4) Cliquez sur OK pour enregistrer ces réglages et refermer la boîte de dialogue Style de nu-
mérotation.

De retour à la fenêtre Styles et formatage, cliquez sur l’icône Styles de paragraphe, sélec-
tionnez Tous les styles dans la liste déroulante en bas de la fenêtre, faites un clic droit sur Bi-
bliographie 1 et choisissez Modifier… dans le menu contextuel.

 5) Dans la boîte de dialogue Style de paragraphe, ouvrez l’onglet Plan & numérotation et choi-
sissez Numérotation 5 dans la liste déroulante Style de numérotation (Figure 15.28).

Cliquez sur OK pour enregistrer la modification du style de paragraphe Bibliographie 1.
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Figure 15.28 : Appliquer un style de numérotation à un style de paragraphe.

Maintenant, quand vous générerez la bibliographie, la liste ressemblera à celle qui est présentée 
ci-dessous, pour un livre après suppression d’éléments de la ligne Structure (le nom Abrégé et les 
deux-points par exemple).

Figure 15.29 : Exemple de bibliographie obtenue après modification du style de paragraphe
Bibliographie 1.

Actualiser, éditer et supprimer une bibliographie existante

Faites un clic droit n’importe où dans la bibliographie. Dans le menu contextuel, sélectionnez :

• l’entrée Mettre à jour l’index pour actualiser la bibliographie ;

• l’entrée Éditer l’index pour ouvrir la boîte de dialogue Table des matières, index ou biblio-
graphie où vous pourrez modifier la table et sauvegarder les changements ;

• l’entrée Supprimer l’index pour effacer la bibliographie sans demande de confirmation.

Conseil

Si vous estimez que la fonction bibliographique de Writer est trop limitée, vous pouvez es-
sayer Zotero qui est libre et open source, et disponible pour Mac, Windows et Linux. Il est 
connu pour bien fonctionner avec Writer (https://www.zotero.org/).
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Pourquoi utiliser un document maître ?

Un document maître (.odm) est un conteneur qui réunit des documents texte séparés (.odt) en un 
document unique plus grand et qui en unifie la mise en forme, la table des matières, la bibliogra-
phie, l’index et d’autres éléments. Les documents maîtres trouvent un usage typique dans la pro-
duction de documents longs, tels qu’un livre, une thèse ou un long rapport.

Un document maître se révèle particulièrement utile dans les situations suivantes :

• quand la taille ou le nombre de pages deviennent importants : il peut être plus facile d’écrire, 
de relire ou de modifier un sous-ensemble du document complet ;

• quand différentes personnes écrivent des chapitres ou d’autres parties différentes du docu-
ment complet ;

• quand les fichiers sont destinés à être publiés individuellement mais aussi comme parties 
d’un document plus important. Les chapitres du Guide de Writer représentent un exemple de
cette utilisation ;

• quand les sous-documents sont utilisés dans plus d’un document final ;

• pour changer le modèle d’un document : ajoutez-le à un document maître dont le modèle est 
différent. Pour que cette méthode fonctionne, il faut que le document initial et le document 
maître possèdent tous les deux des styles de même nom.

Plusieurs méthodes permettent de créer des documents maîtres. Chacune a ses avantages et ses 
inconvénients. La méthode que vous choisirez dépendra de ce que vous avez l’intention de faire. 
Ces différentes méthodes sont décrites dans ce chapitre, accompagnées de suggestions sur les 
circonstances où il faut les utiliser.

Conseil

Un document maître n’est pas toujours la meilleure méthode à utiliser dans toutes les situa-
tions précédentes. Il peut arriver qu’un document ordinaire (.odt) contenant des sections 
liées aux autres fichiers fasse aussi l’affaire. Pour plus d’informations sur l’utilisation de sec-
tions pour combiner des fichiers, reportez-vous au Chapitre 6 Mise en page : approfondisse-
ments, pages 157 et 165.

Utiliser le navigateur

Le navigateur est un outil très utile qui vous permet de vous déplacer très rapidement vers des en-
droits précis de votre document. Il offre aussi des informations sur son contenu et vous permet de 
réorganiser celui-ci. Par exemple, si les chapitres de votre livre sont dans des documents séparés,
ils peuvent être réordonnés dans le document maître, les références sont automatiquement renu-
mérotées et la table des matières et l’index peuvent être actualisés.

Dans Writer, le navigateur présente deux formes distinctes, l’une est utilisée dans les documents 
texte ordinaires, l’autre dans les documents maîtres.

Dans un document texte ordinaire, le navigateur affiche les listes des images, des tableaux, des 
entrées d’index, des hyperliens, des références et autres éléments du document, comme le montre
l’image de gauche de la Figure 16.1. Cliquez sur l’icône de déploiement (un signe + ou un triangle 
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selon votre système) à côté d’une liste pour en afficher le contenu. Par un double clic sur une en-
trée dans le navigateur, vous sautez immédiatement à son emplacement dans le document.

Figure 16.1 : Le navigateur dans un document texte (à gauche) et dans un document maître (à
droite).

Dans un document maître, vous pouvez passer d’une vue à l’autre en cliquant sur le bouton dans 
le coin supérieur gauche. En vue document maître, le navigateur affiche la liste des sous-docu-
ments et sections de texte, comme sur l’image à droite de la Figure 16.1. L’utilisation du navigateur
dans un document maître est décrite plus en détail par ailleurs dans ce chapitre (voir « 6e étape : 
insérer les sous-documents dans le document maître » page 453 et « Renvois entre sous-
documents » page 461).

Les styles dans les documents maîtres et les sous-documents

Un document isolé devient un sous-document quand il est lié dans un document maître. Un même 
document peut être utilisé comme sous-document dans plusieurs documents maîtres. Chacun de 
ceux-ci peut avoir des définitions de style différentes (police, taille, couleur, dimensions des pages,
marges, etc.), qui affectent l’apparence du document final, mais les documents individuels 
conservent leurs caractéristiques initiales.

La relation entre les styles d’un document maître et ceux de ses sous-documents s’établit comme 
suit :

• les styles personnalisés utilisés dans les sous-documents, tels que les styles de paragraphe,
sont automatiquement importés dans le document maître ;

• si plusieurs sous-documents utilisent un style personnalisé avec le même nom dans chaque 
sous-document (par exemple, MonCorpsDeTexte), seul celui du premier sous-document lié 
est importé dans le document maître ;

• si deux styles de même nom existent dans le document maître et un sous-document (par 
exemple, Style par défaut), le style appliqué est celui qui est défini dans le document maître ;
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• les styles importés des sous-documents ne sont modifiés que dans le document maître, si 
bien que, si vous ouvrez un sous-document pour en modifier les styles, ceux-ci n’auront pas 
été affectés.

Conseil

Si vous utilisez le même modèle pour le document maître et ses sous-documents, ceux-ci 
auront le même aspect quand ils sont vus individuellement et dans le document maître. Si 
vous modifiez ou créez un style, faites-le dans le modèle (pas dans le document maître ni 
un des sous-documents). Quand vous rouvrirez le document maître ou un sous-document, 
les styles seront actualisés à partir du modèle.

Créer un document maître : scénarios

La méthode que vous choisirez parmi les trois plus courantes pour créer un document maître dé-
pend de l’état actuel de votre document :

• vous possédez un document (un livre) que vous désirez fractionner en plusieurs sous-docu-
ments (chapitres) qui seront contrôlés par le document maître ;

• vous possédez plusieurs documents (chapitres) écrits par un ou plusieurs auteurs que vous 
désirez combiner en un livre unique, contrôlé par le document maître ;

• vous ne possédez encore aucun document, mais vous avez l’intention d’écrire un long livre 
formé de plusieurs chapitres, éventuellement écrits par plusieurs auteurs.

Nous allons étudier ces scénarios tour à tour.

Commencer sans documents préexistants

Quand on commence sans documents préexistants, on peut tout paramétrer depuis le début de la 
manière qui nous plaît. Voici les étapes à suivre dans l’ordre indiqué. Chacune est décrite en détail
dans les sections qui suivent.

1re étape : planifier le projet

2e étape : créer un modèle

3e étape : créer le document maître

4e étape : créer les sous-documents

5e étape : ajouter des pages au document maître

6e étape : insérer les sous-documents dans le document maître

7e étape : ajouter la table des matières, la bibliographie et l’index

1re étape : planifier le projet

Bien qu’il soit possible d’apporter des modifications presque à chaque étape de ce processus, plus
les choses seront planifiées avant de commencer, moins le travail de correction sera important par 
la suite. Voici quelques choses qu’il est nécessaire de prévoir.
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Quelles sont les parties nécessaires au livre ou au rapport. Quelles pages iront dans le document 
maître et quelles pages dans les sous-documents ?

Considérons un exemple de livre dont les parties sont données dans la table ci-dessous :

Parties Emplacement

Page de Titre (couverture) Dans le document maître

Page de droits d’auteur Dans le document maître

Table des matières Dans le document maître

Préface (Avant-propos) Sous-document

Chapitres 1 à 7 Sous-documents

Index Dans le document maître

Styles de page, de paragraphe, de caractère, de cadre et de numérotation. Définissez les 
styles que vous souhaitez utiliser. Reportez-vous au Chapitre 8 Introduction aux styles, page 201, 
et au Chapitre 9 Travailler avec les styles, page 231, pour voir la façon de créer ou de modifier des
styles ainsi que des exemples de l’utilisation de styles dans la mise en page d’un livre. Apportez 
une attention particulière au paramétrage des styles de titres comme cela est décrit dans « Utilisa-
tion des styles de paragraphe pour définir une hiérarchie de titres » au chapitre 8, page 224.

Champs et AutoTexte selon nécessité. Voir le Chapitre 2 Travailler avec le texte : les bases, 
page 41, et le Chapitre 17 Travailler avec les champs, page 469, pour des idées.

Un ou plusieurs modèles pour le document maître et les sous-documents. Si vous débutez 
un nouveau projet, créez le document maître et tous les sous-documents à partir du même mo-
dèle. Ne pas le faire peut conduire à des incohérences dans le style qui empêcheront votre docu-
ment d’avoir l’aspect attendu. Par exemple, si deux sous-documents ont des styles de même nom 
avec un formatage différent dans chaque document, le document maître utilisera le formatage du 
premier des deux qui a été ajouté.

Numérotation des pages. Dans notre exemple, les pages sont numérotées à la suite les unes 
des autres à partir de la page de titre. (Celle-ci peut être paramétrée pour ne pas afficher de numé-
ro de page, elle n’en recevra pas moins le numéro 1.) Le premier chapitre débute donc par un nu-
méro de page plus élevé, par exemple la page 5. Pour que la numérotation du livre recommence à
1 avec le premier chapitre, vous aurez un peu de travail supplémentaire à faire. Voir « Recom-
mencer la numérotation des pages » à la page 458.

2e étape : créer un modèle

Un modèle peut être créé à partir d’un document ou d’un modèle existant qui contient tout ou par-
tie des styles de page, de paragraphe, de caractère ou autres que vous souhaitez utiliser dans le 
document ; vous pouvez aussi le créer à partir d’un nouveau document vierge. Pour plus d’infor-
mations sur les modèles, voir le Chapitre 10 Travailler avec les modèles, page 263.

Faites bien attention d’utiliser Fichier > Modèles > Enregistrer comme modèle… pour sauvegar-
der le modèle que vous venez de créer.

Conseil

Vous pouvez aussi créer un modèle de document maître (voir page 465).
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3e étape : créer le document maître

Peu importe l’ordre dans lequel vous créez le document maître et les sous-documents ; il n’est pas
nécessaire de créer tous les sous-documents en même temps quand vous débutez le projet, vous 
pourrez en ajouter de nouveaux à n’importe quel moment, quand le besoin s’en fera sentir.

Procédez de la façon suivante pour créer le document maître :

 1) Ouvrez un nouveau document à partir du modèle que vous avez créé à la 2e étape en choi-
sissant Fichier > Nouveau > Modèles dans la barre de menu puis en sélectionnant le mo-
dèle que vous avez créé. Assurez-vous que la première page de ce nouveau document a 
bien le style que vous souhaitez pour le document final ; si ce n’est pas le cas, changez-le. 
Dans notre exemple, le style de la première page est Page de titre.

 2) Si du texte ou des sauts de page provenant du modèle se trouvent dans le document, effa-
cez-les. (La table des matières, l’index et les champs dans les en-têtes ou pieds de page 
peuvent rester.)

 3) Sélectionnez Fichier > Envoyer > Créer un document maître. Enregistrer le document 
maître dans le dossier du projet. Nous y reviendrons plus tard, pour le moment, vous pouvez
le laisser ouvert ou le fermer.

Remarque

Utiliser Fichier > Nouveau > Document maître crée un fichier de document maître (.odm) 
associé au modèle par défaut. Si votre document est, ou va être, basé sur un modèle per-
sonnel, utilisez la méthode décrite ci-dessus.

Conseil

Vous pouvez aussi créer un document maître directement à partir d’un modèle de document
maître.

4e étape : créer les sous-documents

Il n’y a pas de différence entre un sous-document et tout autre document texte. Il ne devient un 
sous-document qu’au moment où il est lié à un document maître et ouvert depuis celui-ci. Certains 
paramétrages du document maître écraseront ceux du sous-document, mais seulement quand il 
est visualisé, manipulé ou imprimé à partir du document maître.

Créez un sous-document de la même manière que n’importe quel document ordinaire :

 1) Ouvrez un document vierge basé sur le modèle du projet (très important) en sélectionnant 
Fichier > Nouveau > Modèles dans la barre de menu puis en choisissant le modèle voulu.

 2) Effacez tout texte ou autres éléments non désirés contenus dans le modèle et donnez à la 
première page le style prévu pour la première page d’un chapitre.

 3) Sélectionnez Fichier > Enregistrer sous… dans la barre de menu. Donnez au document un
nom significatif et enregistrez-le dans le dossier du projet.

Si certains chapitres sont déjà écrits, les fichiers peuvent ne pas avoir été créés à partir du modèle
conçu pour le projet. Si vous désirez modifier le modèle attaché aux fichiers existants, utilisez la 
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technique décrite à la section « Associer un document à un modèle différent », dans le Cha-
pitre 10 Travailler avec les modèles, page 272.

5e étape : ajouter des pages au document maître

Pour vous aider, commencez par ceci :

• assurez-vous que les marques de paragraphes soient visibles. Vous pouvez les faire appa-
raître ou disparaître en sélectionnant Affichage > Marques de formatage dans la barre de 
menu, en cliquant sur l’icône Marques de formatage ( ) de la barre d’outils standard ou en
appuyant sur Ctrl+F10. Si elles n’apparaissent pas, vérifiez dans la page LibreOffice Writer
– Aides au formatage de la boîte de dialogue Options (Outils > Options) que l’option Fin de 
paragraphe est bien cochée dans la section Affichage de ;

• affichez les limites du texte (Affichage > Délimitations du texte), des tableaux (Affichage >
Délimitations des tableaux) et des sections (option Délimitations de la section dans la page
LibreOffice – Couleurs de l’interface de la boîte de dialogue Options).

Si votre document maître ne présente pas certaines pages liminaires, comme une page de titre, 
une page pour les droits d’auteur ou pour la table des matières, c’est le moment de les ajouter. 
L’exemple proposé dans cette section utilise la suite de styles de page présentée au paragraphe 
« 1re étape : planifier le projet » à la page 449.

 1) Tapez le contenu de la page de titre (ou laissez des emplacements à remplir plus tard). 
Après avoir placé le point d’insertion dans le dernier paragraphe vide de la page, sélection-
nez Insertion > Saut manuel… Dans la boîte de dialogue Insérer un saut, cochez Saut de 
page, sélectionnez le style de la page suivante (Droits d’auteur dans notre exemple) et lais-
sez l’option Modifier le numéro de page non cochée. Cliquez sur OK.

Figure 16.2 : Insérer un saut de page entre la page de titre et celle des droits d’auteur.

 2) Saisissez le contenu de la page de droits d’auteur (ou réservez les emplacements). Placez le
point d’insertion dans le dernier paragraphe vide de la page, insérez un nouveau saut de 
page manuel en sélectionnant Table des matières comme style de page suivante.

 3) Dans la page de la table des matières, laissez un ou deux paragraphes vides puis insérez 
une table des matières (Insertion > Table des matières et index > Table des matières, in-
dex ou bibliographie). La table n’aura aucun contenu jusqu’à ce que vous ajoutiez les 
sous-documents, mais vous devriez voir une marque grise ou une boîte qui indique sa posi-
tion et son titre. Pour plus d’informations sur l’insertion et le formatage des tables des ma-
tières, voyez le Chapitre 15 Tables des matières, index et bibliographies, page 411.
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Remarque

Selon la définition du style du premier paragraphe (qui est normalement un titre), vous n’au-
rez peut-être pas besoin d’insérer de saut de page manuel pour les pages de droits d’auteur
et de table des matières.

6e étape : insérer les sous-documents dans le document maître

Nous sommes maintenant prêts à ajouter les sous-documents.

Conseil

Les sous-documents sont insérés dans le document maître avant l’élément souligné dans le 
navigateur. Si vous commencez par insérer le dernier sous-document puis les autres sous-
documents dans le bon ordre (le dernier reste mis en valeur dans le navigateur), vous ob-
tiendrez la disposition correcte sans la nécessité de les faire monter et descendre dans la 
liste.

 1) Affichez le navigateur (Affichage > Navigateur dans la barre de menu, F5 sur le clavier ou 
icône Navigateur ( ) dans le volet latéral).

 2) Assurez-vous que le navigateur offre la vue Document maître (voir « Utiliser le navigateur »
page 447). Si nécessaire, cliquez sur l’icône Basculer sur la vue document maître dans le 
coin supérieur gauche pour passer du navigateur ordinaire à la vue document maître.

Figure 16.3 : Bouton Basculer sur la vue document maître du navigateur.

 3) Dans le navigateur, sélectionnez Texte puis cliquez sur le bouton Insérer avant de sélection-
ner Fichier dans le menu déroulant.

Figure 16.4 : Insérer un sous-document dans le document maître grâce au navigateur.

Une boîte de dialogue standard de recherche de fichier s’ouvre. Sélectionnez le fichier voulu 
(que vous avez créé à la 4e étape) puis cliquez sur Insérer. Cet exemple utilise 7 chapitres ; 
nous allons charger le chapitre 7 en premier comme suggéré dans le conseil ci-dessus.

Le fichier inséré apparaît dans le navigateur avant l’élément Texte comme on le voit sur la Fi-
gure 16.5.
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Figure 16.5 : Le navigateur après insertion d’un sous-document

 4) Comme la section Texte contient la page de titre et d’autres éléments, sélectionnez-la et cli-
quez sur le bouton Déplacer vers le haut pour qu’elle passe en début de liste.

 5) Sélectionnez le sous-document que vous venez d’insérer (Chapitre 7) puis cliquez le bouton 
Insérer puis sur fichier pour insérer le premier sous-document (Chapitre 1 dans notre 
exemple). Chapitre 7 reste sélectionné. Recommencez l’opération avec Chapitre 2, Chapitre 
3 et ainsi de suite jusqu’à avoir ajouté tous les sous-documents à la liste.

Figure 16.6 : Le navigateur après insertion de quelques sous-documents dans le document maître

 6) Enregistrez de nouveau le document maître.

7e étape : ajouter la table des matières, la bibliographie et l’index

Vous pouvez générer une table des matières, un index ou une bibliographie pour le livre grâce au 
document maître. Vous devez insérer ces éléments dans une section Texte de celui-ci. Pour plus 
d’informations sur ces éléments du document, voyez le Chapitre 15 Tables des matières, index et 
bibliographies, page 409.

Placez le point d’insertion dans la page de la première section Texte où doit se trouver la table des 
matières et sélectionnez Insertion > Table des matières et index > Table des matières, index 
ou bibliographie dans la barre de menu pour la créer.

Si le document maître ne se termine pas par une section Texte, insérez-en une avant le dernier 
sous-document puis faites-la descendre après celui-ci. Si vous avez inséré des entrées bibliogra-
phiques dans vos sous-documents, vous pouvez mettre le point d’insertion dans la page de la der-
nière section Texte pour créer la bibliographie au bon endroit.

Si vous avez inséré des entrées d’index dans vos sous-documents, placez le point d’insertion dans
la page de la dernière section Texte pour insérer l’index lexical à l’emplacement qui lui revient.

La Figure 16.7 montre le navigateur après ajout d’une table des matières et d’un index lexical.
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Astuce

Le menu déroulant du bouton Insérer du navigateur possède une entrée Index qui permet 
d’ouvrir la boîte de dialogue Table des matières, index ou bibliographie et d’insérer l’index 
choisi, et éventuellement une section Texte, avant la section sélectionnée.

Figure 16.7 : Le navigateur après l’ajout d’une table des matières et d’un index lexical au
document maître.

Combiner plusieurs documents dans un document maître

Si vous possédez plusieurs documents, vous pouvez les combiner en un seul document contrôlé 
par un document maître.

Cette méthode fonctionne mieux quand tous les documents ont été créés à partir du même mo-
dèle, mais cela n’est pas obligatoire. Elle est particulièrement utile quand les sous-documents ont 
été créés et sont gérés par plusieurs auteurs. Par exemple, vous pourriez créer une anthologie de 
nouvelles, une compilation des documents d’un colloque ou un ensemble de résultats de tests de 
fabrication sous une page de titre standard dans votre entreprise.

Nous allons prendre pour exemple un livret de résultats de test de fabrication.

Conseil

Il est possible de créer un modèle de document maître (voir page 465) et de l’utiliser comme
point de départ de cette méthode. Dans ce cas, passez les étapes 1 et 2 et commencez à 
l’étape 3.

 1) Ouvrez le document qui contient la page de titre que vous envisagez d’utiliser comme docu-
ment maître. Pour éviter de créer trop de sous-documents quand celui-ci sera converti en 
document maître, ne conservez qu’un titre de niveau 1. S’il y en a davantage, transformez-
les temporairement en niveaux de titre inférieurs et marquez-les (par exemple, en ajoutant 
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un astérisque à la fin de chaque titre pour vous rappeler qu’ils doivent être remontés par la 
suite au niveau 1).

 2) Sélectionnez Fichier > Envoyer > Créer un document maître dans la barre de menu, nom-
mez et enregistrez ce document maître (voir « Comment procéder » page 457).

Supposons que notre document original soit nommé PageDeCouverture, avec un seul titre 
de niveau 1 et que nous allons créer un document maître (fichier.odm) appelé FichierTest.

Dans ce cas, le document maître est un fichier vide qui ne contient qu’une section. Un docu-
ment nommé FichierTest1 est créé en même temps ; c’est un fichier.odt qui contient le texte 
du fichier PageDeCouverture. Quand on ouvre le fichier.odm et qu’on clique sur Oui pour 
mettre à jour tous les liens, ce fichier est lié au document maître auquel il apporte le contenu 
d’origine.

Le fichier PageDeCouverture initial reste intact dans son propre dossier.

Figure 16.8 : Document maître FichierTest créé depuis PageDeCouverture

 3) Ouvrez le document maître et cliquez sur Oui pour actualiser les liens. Le document maître 
s’ouvre, par défaut, avec le navigateur ouvert (voir « Utiliser le navigateur » page 447 et 
« 6e étape : insérer les sous-documents dans le document maître » page 453 pour des 
informations plus détaillées).

 4) Cliquez sur le bouton Insérer, sélectionnez Fichier dans le menu et relâchez le bouton (Fi-
gure 16.9).

Figure 16.9 : Ajouter des fichiers au document maître.

 5) Recherchez les fichiers qui contiennent les résultats des tests (ici RésultatsTest1.odt, Résul-
tatsTest2.odt, etc.). Sélectionnez le premier à insérer, pour nous RésultatsTest1.odt, et cli-
quez sur Insérer. Le fichier est inséré au-dessus de l’entrée existante.

 6) Cliquez sur l’icône Déplacer vers le haut pour placer FichierTest1.odt au-dessus de Résul-
tatsTest1, odt (les fichiers de contenu sont insérés dans le document maître au-dessus du fi-
chier sélectionné).
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 7) Recommencez à partir du point 4) aussi souvent que nécessaire. Peu importe le fichier surli-
gné dans le document maître quand vous insérez un nouveau document. Contentez-vous de
choisir le fichier à insérer puis d’utiliser les boutons Déplacer vers le haut et Déplacer vers 
le bas pour le placer à l’endroit voulu.

Figure 16.10 : Déplacer les sous-documents.

 8) Pour éditer le document maître, par exemple pour y ajouter un numéro de série et le nom du 
client, faites un clic droit sur FichierTest1 dans le navigateur et sélectionnez Éditer dans le 
menu contextuel. Ajoutez le contenu voulu au fichier qui s’ouvre, enregistrez-le et fermez-le 
(voir « Éditer un document maître » page 460 pour des informations plus détaillées).

 9) Sélectionnez Outils > Actualiser > Liens dans la barre de menu ou cliquez sur le bouton 
Actualiser puis sur Liens dans le menu déroulant. Toutes les modifications apportées au do-
cument maître sont alors visibles.

Partager un document en document maître et sous-documents

Si vous possédez un document que vous souhaitez partager en un document maître et plusieurs 
sous-documents, Writer peut le faire automatiquement en effectuant la coupure aux titres d’un ni-
veau de plan de votre choix.

Bien que cette méthode soit simple et rapide, un peu de nettoyage peut s’avérer nécessaire :

• les noms de fichiers générés automatiquement pour les sous-documents sont nomdocprinci-
palX.odt, où X vaut 1, 2, 3 et ainsi de suite. Si vous avez une préface ou d’autres « cha-
pitres » commençant par un paragraphe de style Titre 1 avant le chapitre 1 proprement dit, 
les noms des fichiers ne correspondront pas directement aux numéros des chapitres. Vous 
devrez peut-être renommer les sous-documents ; reportez-vous à « Ajouter, supprimer ou 
renommer des sous-documents » à la page 460 ;

• si le document d’origine est associé à un modèle, le fichier.odm lui sera aussi associé, mais 
pas les sous-documents. Ceux-ci hériteront des styles du document de départ mais leur lien 
avec le modèle sera perdu.

Comment procéder

 1) Ouvrez le document et sélectionnez Fichier > Envoyer > Créer un document maître dans 
la barre de menu.

 2) Dans la boîte de dialogue Nom et chemin du document maître (Figure 16.11) :

 a) Sélectionnez le dossier où vous désirez enregistrer le document maître et ses sous-docu-
ments (créez-le si nécessaire).

 b) Tapez le nom du document maître dans le champ Nom de fichier.
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 c) Dans la liste déroulante Séparé par, choisissez le niveau de plan où le fichier doit être 
fractionné en sous-documents. Le choix habituel pour un titre de chapitre est Plan : ni-
veau 1, mais votre document peut être structuré différemment. Pour plus d’informations 
sur les niveaux de plan, reportez-vous à « Utilisation des styles de paragraphe pour 
définir une hiérarchie de titres » dans le Chapitre 8 Introduction aux styles, page 224.

 d) Laissez cochée l’option Extension automatique du nom de fichier et cliquez sur Enregis-
trer pour créer le document maître et fractionnez votre document en sous-documents.

Figure 16.11 : Fractionner un document en un document maître et des sous-documents

Si vous sélectionnez Plan : niveau 1 et que le style de paragraphe pour ce niveau est Titre 1, les 
sous-documents commenceront tous par un paragraphe de style Titre 1.

Recommencer la numérotation des pages

Les exemples des sections précédentes ont utilisé des collections très basiques de fichiers dont 
les pages sont numérotées les unes à la suite des autres. Cela est utile pour de nombreux docu-
ments, e-books compris, mais la séquence typique des numéros de page d’un livre imprimée est :

• aucun numéro sur les pages de couverture et de droits d’auteur ;

• numéros en chiffres romains minuscules, à partir de i, sur les pages préliminaires ;

• numéros en chiffres arabes, à partir de 1, dans le corps du document ;

• numérotation des pages les unes à la suite des autres dans le reste du livre.

Pour qu’un document maître produise un livre tel que celui-ci, il faut définir un style de paragraphe 
différent pour le titre du premier chapitre en lui assignant deux caractéristiques particulières.

Exemple

Chaque chapitre commence par un paragraphe de style Titre 1, paramétré dans l’onglet Enchaîne-
ments de la boîte de dialogue Style de paragraphe pour débuter sur une nouvelle page (Figure 
16.12). L’option Numéro de page n’est pas cochée pour que la numérotation continue celle de la 
page précédente.
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Figure 16.12 : Enchaînements du style de paragraphe Titre 1.

Regardons dans l’onglet Plan & numérotation de cette boîte de dialogue (Figure 16.13) à quel ni-
veau de plan le style Titre 1 est affecté. C’est normalement le Niveau 1. Il ne peut pas être modifié 
ici parce qu’il a été défini dans Outils > Numérotation des chapitres.

Figure 16.13 : Niveau de plan et numérotation du style de paragraphe Titre 1.

Un seul style de paragraphe peut être affecté au niveau de plan 1 à cet endroit, mais vous pouvez 
affecter des styles supplémentaires à n’importe quel niveau grâce à l’onglet Plan & numérotation 
de la boîte de dialogue Style de paragraphe.

Ce que nous voulons donc faire, c’est définir un style de paragraphe appelé, par exemple, Titre 1 
Chapitre 1 dont l’apparence est identique à celle du style Titre 1 mais qui présente une différence 
essentielle :

 1) Faites un clic droit sur Titre 1 dans le panneau Styles de paragraphe de l’onglet Styles et for-
matage du volet latéral et choisissez Nouveau dans le menu contextuel. Dans l’onglet Ges-
tionnaire de la boîte de dialogue Style de paragraphe, donnez un nom au nouveau style, 
choisissez le style de suite et vérifiez bien qu’il soit Hérité de Titre 1.

Figure 16.14 : Création du style Titre 1 Chapitre 1-Page Gestionnaire.

 2) Dans l’onglet Enchaînements, dans la section Sauts, cochez l’option Insérer, dans la liste 
déroulante Type, sélectionnez page et cochez l’option Numéro de page en mettant le numé-
ro de départ à 1.

Figure 16.15 : Faire recommencer la numérotation avec ce style de titre.
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 3) Dans l’onglet Plan & numérotation, paramétrez le Niveau de plan à Niveau 1 pour que le titre
apparaisse dans la table des matières à côté des autres titres de chapitres (Le style de nu-
mérotation de ce titre est Aucun(e) car il n’a pas été affecté à ce niveau de plan par la boîte 
de dialogue Numérotation des chapitres).

Figure 16.16 : Affecter au style un niveau de plan.

 4) Il ne reste plus qu’à affecter ce style au premier paragraphe du chapitre 1 pour que tout soit 
fini.

Éditer un document maître

Une fois le document maître créé, on peut avoir envie de modifier son apparence ou son contenu.

Modifier l’apparence du document maître

Vous pouvez modifier les styles dans le modèle au cours du développement de votre projet. Ne 
faites pas de changement de styles dans le document maître ni dans un des sous-documents : 
faites-les dans le modèle.

Pour que les modifications du modèle soient prises en compte par le document maître (et tous les 
sous-documents), fermez et rouvrez le document maître. Vous recevrez deux messages : le pre-
mier pour vous demander si vous désirez mettre à jour tous les liens, le second pour vous deman-
der si vous désirez appliquer les changements de style. Répondez oui aux deux.

Éditer les sous-documents

Il n’est pas possible de modifier un sous-document à partir du document maître. Il faut ouvrir le 
sous-document, soit par un double clic sur celui-ci dans le navigateur du document maître ou en 
l’ouvrant à l’extérieur. Vous pouvez alors lui apporter les mêmes modifications qu’à tout document.

Si, au cours de l’édition d’un sous-document, vous désirez apporter des modifications aux styles 
qui s’appliquent au document maître, suivez les recommandations de la section « Modifier l’appa-
rence du document maître » ci-dessus.

Si vous effectuez des changements dans le contenu d’un sous-document, vous devez actualiser 
manuellement la table des matières, la bibliographie et l’index lexical dans le document maître.

Ajouter, supprimer ou renommer des sous-documents

Pour ajouter un sous-document, suivez la méthode décrite dans la section « 6e étape : insérer les
sous-documents dans le document maître » à la page 453.

Pour supprimer un sous-document, faites un clic droit sur le nom du fichier correspondant dans le 
navigateur et choisissez Supprimer dans le menu contextuel.
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Si vous renommez un sous-document en modifiant le nom de son fichier, la mise à jour suivante 
des liens dans le document maître fera apparaître un lien brisé pour ce sous-document (en rouge).
Pour régler le problème :

 1) Faites un clic droit sur le lien brisé dans le navigateur et choisissez Éditer le lien dans le 
menu contextuel.

 2) Dans la boîte de dialogue Éditer les sections (Figure 16.17), sélectionnez le fichier renommé 
puis modifiez le nom de la section (qui est celui qui apparaît dans le navigateur).

Figure 16.17 : Modifier un lien dans le document maître

 3) Cliquez sur OK pour enregistrer les modifications.

Renvois entre sous-documents

Les méthodes précédemment décrites dans ce chapitre suffiront à la plupart des auteurs qui utili-
seront des documents maîtres. Vous pouvez, cependant, avoir besoin d’incorporer des renvois au-
tomatiquement mis à jour entre sous-documents. Cette section présente la méthode à utiliser.

Le processus de création de renvois entre sous-documents prend du temps, mais il fonctionne.

! Attention

Cette méthode ne marche pas correctement si les sous-documents sont utilisés à la fois 
seuls et dans un document maître. Comme indiqué page 464, le renvoi indiquera une erreur 
dans le document isolé mais s’affichera correctement dans le document maître.

Préparer les cibles des renvois

Avant de pouvoir insérer un renvoi vers un objet qui n’apparaît pas automatiquement dans l’onglet 
Renvois de la boîte de dialogue Champs, comme un titre dans un autre sous-document, vous de-
vez préparer celui-ci comme objet à référencer. Vous pouvez utiliser pour cela soit des repères de 
texte soit des références.

Utiliser des repères de texte

La liste des repères de texte apparaît dans le navigateur où on peut y accéder directement.

Pour insérer un repère de texte :

 1) Sélectionnez le texte dont vous voulez faire un repère puis choisissez Insertion > Repère 
de texte… dans la barre de menu.
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 2) Dans la boîte de dialogue Repères de texte (Figure 16.18), la zone centrale propose la liste 
des repères déjà définis. Tapez le nom du nouveau repère de texte dans le champ du haut 
puis cliquez sur Insérer.

Figure 16.18 : Insérer un repère de texte.

Définir des références

Quand vous définissez des références, faites bien attention de sélectionner la totalité du texte que 
vous désirez utiliser comme référence, comme un titre ou un numéro de figure. Tenez une liste des
noms de vos champs de référence en vous assurant qu’ils sont uniques. Une manière de garder la
trace de ces informations consiste à les enregistrer dans un fichier séparé.

Les noms des champs distinguent les majuscules des minuscules. Vous pouvez vérifier ce nom en
maintenant le curseur au-dessus de l’élément référencé. Dans l’exemple présenté à la Figure 
16.19, le titre correspond au champ nommé « système d’aide » (sans majuscule).

Figure 16.19 : Nom du champ référence en infobulle

Ouvrez le sous-document dans lequel vous désirez définir des références.

 1) Sélectionnez Insertion > Renvoi… dans la barre de menu.

 2) Dans l’onglet Renvois de la boîte de dialogue Champs (Figure 16.20), cliquez sur Définir une
référence dans la liste Type. La liste Sélection affiche alors toutes les références déjà défi-
nies. Vous pouvez laisser la page ouverte tant que vous avez des références à définir.

 3) Dans le document, sélectionnez le texte de la première référence utilisée comme cible du 
renvoi. Cliquez dans la boîte de dialogue Champs. Le texte sélectionné apparaît dans le 
champ Valeur en bas à droite de la boîte. Tapez un nom significatif pour la référence dans le 
champ Nom.

 4) Cliquez sur le bouton Insérer. Le nom que vous avez donné à la référence apparaît dans la 
liste Sélection.
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 5) Répétez les étapes 3 et 4 autant que nécessaire en prenant note des références que vous 
créez.

 6) Répétez l’opération avec les autres sous-documents si nécessaire. Enregistrez et fermez.

Figure 16.20 : Définir le nom de la cible d’une référence

Insérer un renvoi

 1) Ouvrez le document maître. Dans le navigateur, choisissez un sous-document, faites un clic 
droit puis sélectionnez Éditer dans le menu contextuel. Ce sous-document s’ouvre en édi-
tion.

 2) Dans celui-ci, placer le curseur à l’endroit où vous voulez faire apparaître le renvoi. Cliquez 
sur Insertion > Renvoi… dans la barre de menu.

 3) Dans l’onglet Renvois de la boîte de dialogue Champs, sélectionnez Insérer une référence 
dans la liste Type (Figure 16.21). La liste Sélection, sur la droite, ne montre que les noms 
de champs des références créées dans le sous-document sur lequel vous travaillez ; igno-
rez-la et reportez-vous à celle que vous avez créée manuellement dans la section « Définir 
des références » ci-dessus. Dans la liste Insérer une référence à, choisissez Référence.

 4) Dans le champ Nom, en bas à droite, saisissez le nom de la référence que vous avez définie
dans le sous-document auquel vous voulez renvoyer. Dans notre exemple, c’est « Para-
mètres d’impression ».
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Figure 16.21 : Insérer une référence dans la boîte de dialogue Champs

 5) Cliquez sur Insérer, tapez le texte que vous voulez entre la référence et le numéro de page 
puis insérer une nouvelle référence en choisissant Page dans la liste Insérer une référence 
à. Le renvoi affiche une erreur comme le montre la Figure 16.22. En survolant l’un des 
champs avec la souris, le nom du champ apparaît dans une infobulle.

Figure 16.22 : Erreur de renvoi dans le sous-document

(Si vous avez activé l’affichage du nom des champs en sélectionnant Affichage > Noms de 
champ dans la barre de menu, les deux champs en erreur apparaissent comme sur la Fi-
gure 16.23.)

Figure 16.23 : Nom des champs en erreur visibles

 6) Quand vous avez inséré tous les renvois souhaités dans le sous-document, enregistrez-le, 
fermez-le et revenez au document maître.

Sélectionnez Outils > Actualiser > Liens dans la barre de menu ou cliquez sur le bouton 
Actualiser dans le navigateur pour sélectionner Liens dans le menu déroulant. Toutes les 
modifications apparaissent maintenant dans le document maître. Dans le document maître, 
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accédez à la page du sous-document où vous avez inséré le champ de renvoi. Vous devriez 
maintenant voir le texte correspondant au bon endroit. Si cela ne fonctionne pas, enregistrez 
le document maître, fermez-le, rouvrez-le et actualisez les liens.

Figure 16.24 : Contenu du champ visible dans le document maître

Cette technique fonctionne aussi si vous ouvrez directement le sous-document à l’étape 2 (c’est-à-
dire sans passer par le document maître) pour créer le renvoi.

Créer un modèle de document maître

La création d’un modèle de document maître est pratiquement la même que celle des autres mo-
dèles :

 1) Commencez par créer le document maître par Fichier > Envoyer > Créer un document 
maître, comme décrit dans les sections précédentes de ce chapitre.

 2) Utilisez ensuite Fichier > Modèles > Enregistrer comme modèle… pour créer le modèle 
(.otm) qui apparaîtra avec les autres dans la boîte de dialogue Modèles.

Conseil

Insérez dans le nom du fichier du modèle de document maître une indication qui vous rap-
pelle qu’il ne s’agit pas d’un modèle ordinaire.

Créer un fichier unique à partir d’un document maître et de ses
sous-documents

Les documents maîtres sont des fichiers d’extension .odm qui contiennent des liens vers les sous-
documents qui sont des fichiers d’extension .odt. Bien que les fichiers liés soient très utiles pour 
écrire ou modifier un grand document, comme un livre, vous pouvez avoir parfois besoin d’une co-
pie du livre entier en un seul fichier, par exemple pour l’envoyer à un éditeur.

Pour exporter un document maître sous forme de fichier d’extension .odt (sans affecter le 
fichier .odm) :

 1) Ouvrez le document maître et actualisez les liens. Sélectionnez Fichier > Exporter… dans 
la barre de menu.

 2) Dans la boîte de dialogue Exporter (Figure 16.25), saisissez un nom pour le fichier.odt expor-
té et sélectionnez Texte ODF (.odt) dans la liste déroulante Format de fichier (c’est normale-
ment le choix par défaut). Cliquez sur le bouton Exporter. Cette étape crée un fichier.odt 
protégé en écriture où chaque sous-document est placé dans une section distincte.

 3) Refermez le document maître et ouvrez le document.odt qui vient d’être créé en actualisant 
tous les liens.
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Figure 16.25 : Exportation d’un document maître en fichier texte Open Document (.odt)

 4) Pour briser les liens et supprimer la protection en écriture, choisissez Format > Sections 
dans la barre de menu, sélectionnez le premier élément de la liste Section puis cliquez sur 
le dernier élément en appuyant sur la touche Maj pour sélectionner toute la liste. Décochez 
les options Lier dans la section Lien et Protégé dans la section Protection en écriture.

 5) Cliquez sur OK.

 6) Si vous souhaitez éliminer tout ou partie des sections pour obtenir un document texte simple,
sélectionnez ces sections et cliquez sur le bouton Supprimer. Leur contenu reste dans le 
document, seules les marques de sections sont enlevées.

Ancrer des images à une page

Une image (objet graphique) ancrée « à la page » dans un sous-document n’est pas affichée dans 
le document maître bien qu’elle apparaisse toujours correctement dans le sous-document.

Comme le document maître réorganise l’enchaînement et les numéros des pages, ainsi que les 
renvois quand il rassemble les sous-documents, la référence absolue à une page déterminée dans
le sous-document est perdue dans le document maître. L’image perd la référence de son ancrage 
et disparaît tout simplement.

Pour éviter ce problème tout en maintenant des images positionnées précisément sur une page 
déterminée, ancrez-les de la manière suivante :

 1) Faites un clic droit sur l’image et sélectionnez Propriétés dans le menu contextuel.

 2) Dans l’onglet Type de la boîte de dialogue Image (Figure 16.26), paramétrez l’ancrage Au 
caractère ou Au paragraphe.

 3) Dans la section Position, sélectionnez un positionnement horizontal et vertical sur la page 
qui convienne. Cliquez sur OK pour enregistrer les modifications.
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Figure 16.26 : Ancrage et positionnement d’une image sur la page
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Chapitre 17
Travailler avec les champs





Introductions aux champs

Les champs sont extrêmement utiles dans Writer. Ils sont utilisés dans de nombreuses situations :

• pour des données qui changent (la date du jour ou le nombre de pages) ;

• pour des données qui pourraient être modifiées (le nom d’un produit ou d’un livre en cours de
rédaction) ;

• pour des séquences de numérotation définies par l’utilisateur ;

• pour des renvois automatiques ;

• pour du contenu conditionnel (mots ou paragraphes qui sont rendus visibles et imprimés 
sous certaines conditions) ;

• les entrées d’index sont aussi des champs.

Ce chapitre décrit quelques applications courantes des champs. Une présentation complète des 
champs et de leur utilisation sort du cadre de ce livre. L’utilisateur intéressé trouvera plus de dé-
tails dans l’aide de l’application.

Conseil

À l’écran, les champs apparaissent sur un fond gris, à moins que vous n’ayez désactivé l’op-
tion Trame de fond des champs ou modifié sa couleur dans la page LibreOffice – Couleurs 
de l’interface de la boîte de dialogue Options (Outils > Options). Ce fond gris n’apparaît 
pas quand vous imprimez le document ou que vous l’exportez en PDF.
Pour activer/désactiver rapidement la trame de fond des champs, utilisez Affichage > 
Trame de fond des champs dans la barre de menu ou Ctrl+F8 sur le clavier.

Raccourci clavier concernant les champs

Voici quelques raccourcis clavier qui se révéleront pratiques si vous travaillez avec les champs :

Ctrl+F2 Ouvre la boîte de dialogue Champs.

Ctrl+F8 Affiche ou masque la trame de fond des champs.

Ctrl+F9 Affiche ou masque les noms des champs.

F9 Met les champs à jour.

Insertion simple et rapide d’un champ

Vous pouvez insérer rapidement des champs courants dans votre document en sélectionnant dans
la barre de menu Insertion > Numéro de page ou Insertion > Champ suivi du champ désiré.
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Figure 17.1 : Insérer un champ courant.

Utiliser les propriétés du document pour gérer les informations
modifiables

La boîte de dialogue Propriétés d’un document (Fichier > Propriétés) possède sept onglets. Les 
informations des onglets Général et Statistiques sont générées par le programme. Certaines infor-
mations (le nom des personnes sur les lignes Créé et Modifié de l’onglet Général) proviennent des 
renseignements saisis dans la page LibreOffice – Données d’identité de la boîte de dialogue Op-
tions (Outils > Options). Les options des onglets Police et Sécurité sont présentées ailleurs dans 
ce livre. Ce qui concerne l’onglet Propriétés CMIS sort du cadre de cet ouvrage.

Utilisez les onglets Description et Propriétés personnalisées pour conserver :

• des métadonnées qui vous aideront à classer, trier, stocker et récupérer des documents. 
Certaines d’entre elles sont exportées dans leurs équivalents les plus proches en HTML ou 
en PDF ; certains champs n’ont pas d’équivalent et ne sont pas exportés ;

• des informations qui peuvent changer. Vous pouvez stocker des données à utiliser dans des 
champs de votre document : par exemple, le titre du document, des informations de contact 
sur les participants à un projet ou le nom d’un produit qui peut changer en cours de projet.

Cette boîte de dialogue peut être utilisée dans un modèle, où les noms des champs peuvent servir 
de pense-bête pour auteurs en précisant les informations qu’ils doivent inclure. (Des champs sub-
stituants peuvent avoir une fonction similaire à l’intérieur du texte : voir page 492.)

Vous pouvez revenir à tout instant à cette boîte de dialogue pour y modifier les informations que 
vous avez saisies. Quand vous le faites, toutes les références à ces informations seront modifiées 
partout où elles apparaissent dans le document. Par exemple, dans l’onglet Description (Figure 
17.2), vous pouvez remplacer, dans le champ Titre, celui qui a été donné au brouillon par le titre fi-
nal.
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Figure 17.2 : L’onglet Description de la boîte de dialogue Propriétés du document.

Utilisez l’onglet Propriétés personnalisées (Figure 17.3) pour stocker des informations qui n’entrent
pas dans les champs proposés par les autres pages de la boîte de dialogue.

Figure 17.3 : Page des Propriétés personnalisées avec des listes déroulantes pour les noms et les
types.

Lors de l’ouverture de l’onglet Propriétés personnalisées d’un nouveau document, il peut être vide. 
Si le nouveau document est basé sur un modèle, il peut contenir des champs.

Cliquez sur le bouton Ajouter une propriété pour faire apparaître une ligne de champs dans les-
quels vous pouvez saisir votre propriété personnalisée.

• La colonne Nom comporte une liste déroulante de choix courants ; faites-la défiler pour voir 
tous ceux-ci. Si aucun ne convient à vous besoins, vous pouvez taper un nouveau nom dans
le champ.

• La colonne Type vous offre le choix entre Texte, Date et heure, Date, Durée, Numéro et Oui 
ou non pour chaque champ. Il n’est pas possible de créer de nouveaux types.

• Dans la colonne Valeur, tapez ou sélectionnez ce que vous voulez voir apparaître dans le 
document à l’endroit où ce champ sera utilisé. Les choix peuvent être limités à certains types
de données précis selon la sélection faite dans la colonne Type : par exemple, si vous avez 
choisi Date comme Type, la Valeur de la propriété ne peut être qu’une date.

• Pour supprimer une propriété personnalisée, cliquez sur le bouton à l’extrémité droite de la 
ligne.
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Conseil

Pour modifier le format des valeurs de date, ouvrez la page Paramètres linguistiques – 
Langues de la boîte de dialogue Options (Outils > Options) et changez les Paramètres lo-
caux. Attention ! Ces modifications affecteront tous les documents, pas seulement le docu-
ment actif.

Conserver des informations modifiables dans d’autres champs

Une utilisation courante des champs consiste à conserver une information qui a des chances de 
changer en cours de projet. Par exemple, le nom d’un responsable ou d’un produit, ou même celui 
de la société peuvent changer juste avant l’impression du document. Si ces informations y ont été 
placées sous forme de champs, il suffira de les changer à un seul endroit pour qu’elles soient mo-
difiées partout où le champ correspondant est utilisé.

Writer offre plusieurs emplacements où il est possible de stocker des informations représentées 
par un champ. Nous allons en étudier quelques-uns ici.

Sept propriétés du document (Numéro de page, Nombre de pages, Date, Heure, Titre, Auteur et 
Sujet) sont accessibles par le menu Insertion > Champ (Figure 17.1). Pour insérer un de ceux-ci, 
cliquez sur l’entrée correspondante dans le menu. Certains d’entre eux tirent leurs informations de 
la boîte de dialogue Propriétés du document (Figure 17.2).

D’autres propriétés du document se trouvent dans les pages Info document et Document de la 
boîte de dialogue Champs (Figure 17.4 et Figure 17.5) que l’on ouvre en sélectionnant Insertion >
Champs > Autres champs… dans la barre de menu ou en appuyant sur Ctrl+F2 sur le clavier. 
L’entrée Personnaliser de la liste Type dans l’onglet Info document est dérivée des Propriétés per-
sonnalisées de la boîte de dialogue Propriétés du document (Figure 17.3) ; il n’apparaît pas dans 
la liste si aucune de ces propriétés n’a été définie.

Comme certains éléments sont repris de la page LibreOffice – Données d’identité de la boîte de 
dialogue Options, assurez-vous que celles-ci sont à jour.

474 | Guide de LibreOffice Writer Conserver des informations modifiables dans d’autres champs



 Chapitre 17 Travailler avec les champs

Figure 17.4 : Insérer le champ contenant la date de modification grâce à l’onglet Info document de
la boîte de dialogue Champs.

Pour insérer un de ces champs, sélectionnez-le dans la liste Type puis choisissez éventuellement 
le format dans les listes Sélectionner et Format. Terminez en cliquant sur Insérer.

Figure 17.5 : Insérer le nom du fichier grâce à l’onglet Document de la boîte de dialogue Champs.
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Astuce

Bien que ces champs soient souvent utilisés pour contenir une information changeante, 
vous pouvez en rendre le contenu fixe en cochant l’option Contenu fixe (en bas de la co-
lonne Format voir Figure 17.4 et Figure 17.5) quand vous insérez le champ. En cas de né-
cessité, vous pouvez revenir à cette boîte de dialogue pour décocher cette option et rendre 
de nouveau le champ variable.

Utiliser l’AutoTexte pour insérer des champs souvent utilisés

Si vous utilisez régulièrement les mêmes champs, vous apprécierez peut-être une méthode simple
et rapide pour les insérer. Utilisez pour cela l’AutoTexte. Pour définir une entrée pour un champ 
dans l’AutoTexte :

 1) Insérez le champ dans le document comme décrit ci-dessus.

 2) Sélectionnez le champ que vous venez d’insérer puis choisissez Outils > AutoTexte… dans 
la barre de menu ou appuyez sur Ctrl+F3.

 3) Dans la boîte de dialogue AutoTexte (Figure 17.6), choisissez le groupe où sera stockée la 
nouvelle entrée (Mes AutoTextes dans l’exemple), saisissez un nom pour celle-ci et modifiez 
si nécessaire le raccourci proposé.

 4) Cliquez sur le bouton AutoTexte puis sur Nouveau dans le menu déroulant pour créer l’en-
trée qui insérera le champ. Ne choisissez pas Nouveau (texte seulement) car un texte 
simple serait inséré à la place d’un champ. (Les choix Nouveau et Nouveau (texte seule-
ment) n’apparaissent pas avant que vous ayez sélectionné un groupe et saisi un nom pour 
la nouvelle entrée.) Cliquez sur Fermer pour refermer la boîte de dialogue AutoTexte.

Quand vous voudrez insérer ce champ à l’emplacement du curseur, il suffira de taper le raccourci 
puis s’appuyer sur F3.

Figure 17.6 : Création d’un nouvel AutoTexte
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Définir des séquences de numérotation personnalisées

Vous aurez peut-être envie de définir votre propre séquence de numérotation que vous utiliserez 
dans des situations où vous ne désirez pas forcément de numéro en début du paragraphe ou bien 
où vous voulez avoir un plus grand contrôle que celui qui est offert par les choix de numérotations 
prédéfinies.

Cette section décrit la façon de créer et d’utiliser une séquence de numérotation utilisant un champ
Séquence.

Créer une séquence de numérotation variable

Pour créer une séquence de numérotation variable qui utilise les chiffres arabes (1 2 3) :

 1) Placez le point d’insertion dans un paragraphe vide de votre document.

 2) Sélectionnez Insertion > Champ > Autres champs… dans la barre de menu ou appuyez 
sur Ctrl+F2 puis ouvrez l’onglet Variables (Figure 17.7).

 3) Dans la liste Type, sélectionnez Séquence. Dans la liste Format, sélectionnez Arabe 
(1 2 3). Tapez ce que vous voulez dans le champ Nom. (Ce sera Étape dans cet exemple).

 4) Cliquez sur Insérer. Le nom de la variable (Étape) apparaît maintenant dans la liste Sélec-
tion et un champ numérique (qui affiche 1) est visible au point d’insertion dans le document. 
La boîte de dialogue Champs reste ouverte, vous pouvez donc avoir besoin de la déplacer 
afin de visualiser le champ dans le document.

 5) Si vous cliquez encore plusieurs fois sur le bouton Insérer dans la boîte de dialogue 
Champs, les nombres 2, 3, 4 et ainsi de suite apparaîtront dans le document.

Figure 17.7 : Définir une séquence de numérotation variable.
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Après cela, vous pouvez avoir besoin de recommencer la séquence de numérotation Étape à un 
autre nombre, plus grand ou plus petit que la valeur courante, pour pouvoir utiliser le même nom 
de suite plus d’une fois dans votre document (par exemple, pour commencer chaque série d’ins-
tructions). Pour cela, vous devez insérer un nouveau champ du même tout en indiquant à 
LibreOffice d’imposer le nouveau choix comme valeur.

 1) Ouvrez la boîte de dialogue Champs à l’onglet Variables. Vérifiez que le champ Nom 
contient bien Étape.

 2) Tapez 1 dans le champ Valeur (nous allons ici illustrer une réinitialisation de la numérotation, 
mais n’importe quel nombre fait l’affaire), comme sur la Figure 17.8. Cliquez sur Insérer. La 
numérotation redémarre mais les autres séquences restent inchangées.

 3) Pour continuer avec la séquence normale (c’est-à-dire, pour passer à 2 à l’étape suivante), il 
faut effacer le contenu du champ Valeur après l’insertion de l’étape 2.

Figure 17.8 : Définir un champ pour recommencer une séquence de numérotation variable

Utiliser l’AutoTexte pour insérer une séquence de numérotation

Vous n’avez probablement pas envie de recommencer tout cela à chaque fois que vous devrez in-
sérer un numéro d’étape. Il vaut mieux créer deux entrées dans l’AutoTexte :

• une pour le champ Étape (Valeur=1) (appelée PremièreÉtape, par exemple),

• une pour le champ Étape = Étape+1 (ÉtapeSuivante) sans Valeur définie

Insérer ces champs de la même manière que tout autre AutoTexte. Voyez « Utiliser l’AutoTexte 
pour insérer des champs souvent utilisés » page 476. Pour recommencer la numérotation à 1, 
insérez l’AutoTexte PremièreÉtape, puis continuez avec l’AutoTexte ÉtapeSuivante.
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Vous pouvez créer des champs semblables pour des sous-étapes ou d’autres suites que vous dé-
sirez numéroter avec des lettres (a, b, c), des chiffres romains (i, ii, iii) ou n’importe quelle autre sé-
rie. Choisissez le format voulu dans la liste Format de la boîte de dialogue Champs quand vous 
créez les codes du champ.

Conseil

Si une variable que vous avez définie n’est pas utilisée dans le document, l’icône  située à
côté du champ Valeur est active (colorée). Vous pouvez effacer la variable en cliquant sur 
cette icône. Pour supprimer une variable utilisée dans le document courant, commencez par
effacer tous les champs qui l’utilisent puis enlevez la variable de la liste.

Utiliser les renvois automatiques

Si vous saisissez des renvois vers d’autres parties du document, ceux-ci peuvent facilement deve-
nir obsolètes si vous reformuler un titre, ajoutez ou supprimer des figures ou réorganiser le conte-
nu. Remplacez tous les renvois saisis manuellement par des renvois automatiques et toutes les ré-
férences seront automatiquement mises à jour quand vous actualiserez les champs pour refléter 
les modifications effectuées et les bons numéros de page.

Conseil

Certains utilisateurs se servent de la fonction d’hyperlien de Writer pour les renvois, mais 
cela a l’inconvénient majeur que le texte visible de l’hyperlien ne reflète pas les modifica-
tions du texte auquel il est lié. C’est la raison pour laquelle il est conseillé d’utiliser les ren-
vois dans la plupart des cas.
La création d’un document prévu pour être enregistré en HTML fait exception, car les ren-
vois ne sont pas transformés en hyperlien dans ce format de document.
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Figure 17.9 : L’onglet Renvois de la boîte de dialogue Champs.

L’onglet Renvois de la boîte de dialogue Champs (Figure 17.9) propose quelques types d’éléments
tels que les titres, les paragraphes numérotés et les repères de texte. Si les titres des figures ou 
des tableaux, des séquences personnelles numérotées ou quelques autres éléments encore ont 
été définis dans un document, ces types apparaissent aussi dans la liste.

Insérer des renvois

Pour insérer un renvoi vers un titre, une figure ou tout autre élément affiché dans l’onglet Renvois :

 1) Placez le curseur à l’endroit du document où vous voulez voir apparaître le renvoi.

 2) Si la boîte de dialogue Champs n’est pas encore ouverte, sélectionnez Insertion > Ren-
vois… dans la barre de menu ou appuyez sur Ctrl+F2. Dans la liste Type de l’onglet Ren-
vois (Figure 17.9), cliquez sur le type d’élément que vous voulez référencer (Titre ou Figure 
par exemple).

 3) Cliquez sur l’élément voulu de la liste Sélection qui affiche tant les entrées créées automati-
quement (les titres, par exemple) que les références que vous avez définies (par exemple, 
les repères de texte).

 4) Dans la liste Insérer une référence à, choisissez le type de référence que vous souhaitez. 
Les choix dépendent de l’élément sélectionné.
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Pour les titres, vous choisirez le plus souvent Référence (qui insère le texte entier du titre) ou
Page (qui insère le numéro de la page où le titre se trouve).

Pour les figures, les choix courants sont Catégorie et numéro (qui insère le mot « Figure » et 
son numéro), Référence (qui insère en plus le texte complet de la légende), Page (pour insé-
rer le numéro de la page où se trouve la figure) ou Numéro (pour insérer uniquement son nu-
méro).

 5) Cliquez sur Insérer.

 6) Vous pouvez laisser la boîte de dialogue ouverte pendant que vous insérez plusieurs ren-
vois.

Si vous désirez une liste complète des formats de références possibles accompagnés de leurs uti-
lisations, consultez l’aide.

Formats disponibles

Pour tous les types de références, vous pouvez sélectionner un des formats suivants :

• Page : le numéro de page de la cible.

• Chapitre : le numéro du chapitre où est située la cible visée.

• Référence : le texte complet défini en référence.

• Supra/Infra : le mot « Supra » ou « Infra » selon que la cible se trouve au-dessus ou en des-
sous du champ.

• D’après le style de page : le numéro de page de la cible, mais avec le formatage spécifié 
pour cette page. Cela est très utile pour mettre une référence vers une des pages prélimi-
naires où la numérotation est normalement en chiffres romains.

Deux options supplémentaires sont disponibles pour les titres et les paragraphes numérotés :

• Numéro (sans contexte) : n’insère que le numéro du titre ou du paragraphe. Par exemple, 
pour un titre numéroté 2.4, seul 4 sera inséré.

• Numéro (contexte complet) : insère le numéro entier, y compris les niveaux supérieurs. Par
exemple, pour un titre numéroté 2.4, le numéro entier (2.4) est inséré.

Pour les objets insérés avec une légende, comme les tableaux ou les figures, vous avez en plus 
les choix suivants :

• Catégorie et numéro : insère la catégorie et le numéro de l’objet référencé (par exemple, Fi-
gure 6). C’est l’option la plus utilisée pour les figures et les tableaux.

• Texte de légende : insère toute la légende de l’objet référencé. Par exemple, « Figure 9 : 
L’onglet Renvois de la boîte de dialogue Champs. »

• Numérotation : insère le numéro de l’objet référencé, sans la catégorie (par exemple, si l’ob-
jet référencé est le Tableau 2, le champ ne contiendra que le nombre 2).

Préparer les cibles des renvois

Vous pouvez, de temps en temps, avoir besoin d’insérer un renvoi vers quelque chose qui n’appa-
raît pas automatiquement dans l’onglet Renvois : une illustration sans légende ou un élément 
d’une liste à puce par exemple. Avant d’insérer un renvoi vers un élément de ce genre, vous devez
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le préparer à être référencé comme cible. Pour cela, vous pouvez soit utiliser des repères de texte,
soit définir des références.

Quand la cible a été définie, vous pouvez créer un renvoi vers celle-ci comme décrit page 480.

Utiliser les repères de texte

La liste des repères de texte apparaît dans le navigateur où vous pouvez y accéder directement. 
Dans les documents HTML, les repères de texte sont convertis en ancres vers lesquelles vous 
pouvez sauter par des hyperliens.

 1) Sélectionnez le texte que vous voulez repérer ou cliquez à l’emplacement voulu dans le texte
puis choisissez Insertion > Repère de texte… dans la barre de menu.

 2) Dans la boîte de dialogue Repères de texte, la plus grande partie indique les repères de 
texte déjà définis. Saisissez le nom du nouveau repère dans le champ juste au-dessus de 
ceux-ci puis cliquez sur Insérer.

Définir des références

 1) Sélectionnez Insertion > Renvoi… dans la barre de menu ou appuyez sur Ctrl+F2.

 2) Dans l’onglet Renvois de la boîte de dialogue Champs (Figure 17.10), cliquez sur Définir une
référence dans la liste Type. La liste Sélection affiche alors toutes les références déjà défi-
nies. Vous pouvez laisser l’onglet ouvert tant que vous avez des références à définir.

 3) Dans le document, sélectionnez le texte de la première référence utilisée comme cible du 
renvoi. Cliquez dans la boîte de dialogue Champs. Le texte sélectionné apparaît dans le 
champ Valeur en bas à droite de la boîte. Tapez un nom significatif pour la référence dans le 
champ Nom.

 4) Cliquez sur le bouton Insérer. Le nom que vous avez donné à la référence apparaît dans la 
liste Sélection.

 5) Répétez les étapes 3 et 4 autant de fois que nécessaire.

Conseil

Voyez le Chapitre 16 Les documents maîtres, page 445, pour plus d’information sur la façon
de créer des renvois vers d’autres sous-documents d’un document maître.
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Figure 17.10 : Définir le nom de la cible d’une référence

Utiliser des champs dans les en-têtes et pieds de page

Vous pouvez insérer des champs dans les en-têtes et les pieds de page en utilisant les techniques
déjà décrites dans ce chapitre.

• Pour insérer les champs numéro de page, titre du document, auteur, date et heure de la 
création, date et heure actuelles ou nombre total de pages, utilisez les Propriétés du docu-
ment (voir «Utiliser les propriétés du document pour gérer les informations modi-
fiables » page 472) ou sélectionnez Insertion > Champ > [Élément à insérer] dans la 
barre de menu.

• Pour insérer un renvoi vers un repère de texte, un titre ou un autre élément, choisissez In-
sertion > Champ > Autres champs… puis sélectionnez Renvois dans la boîte de dialogue 
Champs puis Repère de texte, Titres ou autre dans la liste Type.

• Si vous avez utilisé le style Titre 1 pour vos titres de chapitre, vous pouvez utiliser un champ 
de l’onglet Document de la boîte de dialogue Champs pour insérer le titre du chapitre courant
de manière que le contenu de l’en-tête ou du pied de page change d’un chapitre à l’autre. 
Voyez la Figure 17.11. (Writer appelle noms les titres des chapitres). Si vous avez utilisé la 
numérotation des chapitres pour votre style Titre 1, vous pouvez choisir de l’inclure (Numéro 
et nom de chapitre) ou non (Nom de chapitre) dans le champ.

• Vous pouvez insérer des renvois vers d’autres niveaux de titre en précisant celui-ci dans le 
champ Niveau en bas à droite de l’onglet Document de la boîte de dialogue Champs (Figure 
17.11). Le niveau 1 correspond au style Titre 1, le niveau 2 à Titre 2 et ainsi de suite.
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Figure 17.11 : Insérer le nom et le numéro du chapitre courant dans le document.

Remarque

Un champ de renvoi dans l’en-tête de la page affiche le premier titre de son niveau sur la 
page et, dans le pied de page, il affiche le dernier titre de son niveau.

• Pour inclure le numéro de chapitre avec le numéro de page, placez le curseur juste avant le 
champ Page que vous avez inséré. Dans l’onglet Document de la boîte de dialogue Champs,
sélectionnez Chapitre dans la colonne Type et Numéro de chapitre sans séparateur dans la 
colonne Format puis cliquez sur Insérer.

Allez dans l’en-tête ou le pied de page où vous avez inséré ce champ puis tapez le caractère
que vous voulez pour séparer le numéro de chapitre du numéro de page, par exemple un 
point ou un tiret.

Comme la table des matières n’utilisera pas automatiquement ces numéros de chapitre, 
vous devrez aussi faire une modification dans l’onglet Entrées de la boîte de dialogue Table 
des matières, index ou bibliographie comme celle décrite dans le Chapitre 15 Tables des ma-
tières, index et bibliographies, page 415.

• Vous pouvez ajouter le nombre de pages au pied de page ; par exemple, Page 9 sur 12. Ta-
pez le mot « Page » suivi d’un espace devant le champ Page. Tapez un espace, le mot 
« sur » suivi d’un espace après le champ Page puis sélectionnez Insertion > Champ > 
Nombre de pages dans la barre de menu.

Créer un contenu conditionnel

Un contenu conditionnel est un texte ou un objet (image, diagramme, dessin…) qui peut être inclus
ou exclu d’un document selon une condition que vous spécifiez.

Une lettre de rappel pour une facture impayée constitue un exemple simple : le premier et le 
deuxième rappels peuvent avoir comme sujet « Rappel de facture impayée » tandis que le troi-
sième aura pour sujet « Dernier avertissement » et un paragraphe final différent.
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Un exemple plus complexe est offert par le manuel d’un logiciel qui existe en deux versions, Pro-
fessionnelle et Standard. Les deux versions du produit ont beaucoup en commun, mais la version 
Professionnelle comporte quelques fonctionnalités que la version Standard n’offre pas. Si vous uti-
lisez du contenu conditionnel, vous pouvez maintenir à jour un seul fichier contenant les informa-
tions pour les deux versions et imprimer le manuel ou créer une aide en ligne pour chaque version.
Comme vous n’avez pas besoin de gérer deux ensembles d’informations qui sont identiques dans 
les deux cas, vous ne risquez pas d’oublier d’actualiser les deux versions quand une modification 
se présente.

Conseil

Dans certains cas, un effet identique peut être obtenu en masquant les caractères dans un 
style de paragraphe ou de caractère ; reportez-vous au Chapitre 9 Travailler avec les styles, 
pages 241 et 249.

Choix du type de contenu conditionnel à utiliser

Cette section décrit plusieurs fonctionnalités de Writer qui peuvent vous aider à concevoir et à gé-
rer un contenu conditionnel. Vous pouvez utiliser une ou plusieurs de ces fonctionnalités dans le 
même document.

Texte conditionnel

Avec un texte conditionnel, vous disposez de deux textes possibles (mot, expression, 
phrase). L’un d’eux sera affiché et imprimé si la condition que vous spécifiez est remplie, si-
non ce sera l’autre texte. Vous ne pouvez pas y inclure d’objets ni éditer le texte hors de la 
boîte de dialogue Champs (pas dans le corps du texte), mais vous pouvez mettre en forme 
tout le contenu du champ (par exemple, tous les mots en caractères gras). Vous ne pouvez 
pas non plus inclure de renvoi ni d’autre champ dans le texte.

Texte masqué

Avec un texte masqué (mot, expression, phrase), vous n’avez que deux possibilités : visible 
ou caché. Si la condition que vous spécifiez est remplie, le texte est caché, sinon il est affi-
ché. Les inconvénients sont les mêmes que pour le texte conditionnel : vous ne pouvez pas 
y inclure d’objets, éditer le texte dans le corps du document, en formater une partie ni y in-
clure des champs.

Paragraphes masqués

Les paragraphes masqués sont des paragraphes comme les autres sauf que vous pouvez 
spécifier une condition sous laquelle ils ne sont ni affichés ni imprimés. Un paragraphe vide 
peut aussi être masqué – par exemple, si un champ d’une base de données ne contient rien 
pour l’enregistrement en cours. Cela est très pratique quand vous fusionnez l’adresse dans 
une lettre : si vous prévoyez deux lignes pour l’adresse et que la base de données n’en 
contient qu’une, vous pouvez éviter l’apparition d’une ligne blanche dans le document. Vous 
pouvez y inclure des images, modifier le texte dans le corps du document, formater n’importe
quelle partie du texte et y insérer des champs.

Sections masquées

Les sections masquées ressemblent aux paragraphes masqués, mais elles peuvent compor-
ter plusieurs paragraphes – par exemple, un titre suivi d’un ou deux paragraphes. Mais 
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comme une section ne peut pas comporter moins d’un paragraphe, cette méthode n’est pas 
utilisable pour des mots ou des phrases isolés. Le contenu d’une section masquée se com-
porte exactement comme celui de toute autre partie du document, mais vous pouvez préci-
ser une condition sous laquelle elle n’est ni affichée ni imprimée. En supplément, une section
peut être protégée par un mot de passe.

Planifier le contenu conditionnel

Les programmeurs appellent expressions logiques les conditions. Vous devez formuler une ex-
pression logique pour chaque condition car celles-ci sont toujours vraies (remplies) ou fausses 
(non remplies). Il est possible d’utiliser la même condition en de nombreux emplacements du docu-
ment, pour différents types de contenus conditionnels.

Pour que le contenu conditionnel fonctionne, il faut :

 1) choisir ou définir une variable,

 2) définir une expression logique (condition) impliquant la variable sélectionnée.

Choisir ou définir une variable

Vous pouvez utiliser les types de variables suivants pour vos propres conditions :

• les variables définies par l’utilisateur ;

• les variables prédéfinies par LibreOffice qui utilisent les valeurs statistiques des propriétés du
document ;

• les données d’identité ;

• le contenu des champs de base de données (par exemple, votre carnet d’adresses).

Vous ne pouvez pas utiliser des variables internes (par exemple, un numéro de page ou le nom 
d’un chapitre) pour formuler des conditions.

Les exemples de ce chapitre utilisent des variables définies par l’utilisateur.

Définir une expression logique (condition) impliquant la variable sélectionnée

La condition compare une valeur fixe spécifiée avec le contenu d’une variable ou d’un champ de 
base de données.

Pour formuler une condition, utilisez les mêmes éléments que vous auriez utilisés pour créer une 
formule : des opérateurs, des fonctions statistiques ou mathématiques, des formats de nombre, 
des variables et des constantes. Les opérateurs possibles sont donnés dans l’aide du logiciel, 
faites une recherche sur « Opérateurs -- dans les formules ». Vous pouvez définir des expressions 
assez complexes, mais dans la plupart des cas, une condition simple suffira.

Créer la variable

Pour créer votre variable, cliquez sur le menu Insertion > Champs > Autres champs… ou ap-
puyez sur les touches Ctrl+F2 de votre clavier. Utilisez les options disponibles dans les onglets 
Info document, Variables et Base de données.

Champs de l’onglet Info document

La section « Utiliser les propriétés du document pour gérer les informations modifiables » en
page 472 explique comment définir une propriété de document personnalisée. Vous pouvez utiliser
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une propriété de document comme variable de base pour votre condition, ou vous pouvez créer un
autre champ de propriété de document spécifique pour votre condition.

Champ de variable définie par l’utilisateur

Pour définir un champ de variable personnalisée :

 1) Placez le curseur à l’endroit où vous souhaitez insérer le champ.

 2) Dans la boîte de dialogue Champs, sélectionnez l’onglet Variables (voir Figure 17.12).

Figure 17.12 : Définir une variable à utiliser avec un contenu conditionnel.

 3) Sélectionnez Définir une variable dans la liste Type et Texte dans la liste Format. Dans le 
champ Nom, saisissez par exemple ProStandard (pour vous rappeler que la variable est re-
lative aux deux versions du produit). Dans le champ Valeur, saisissez par exemple Standard 
(pour vous rappeler qu’il s’agit de la version standard du produit et que le texte doit de ce fait
être masqué).

 4) Cochez l’option Invisible de façon à ce que le champ n’apparaisse pas dans le document. 
Cliquez ensuite sur le bouton Insérer puis sur le bouton Fermer.

 5) Une petite marque grise devrait être visible à l’endroit où vous avez inséré le champ. Survo-
lez cette marque avec la souris et la formule de champ ProStandard = Standard s’affichera.
Nous reviendrons à ce champ plus tard.

Conseil

Dans la mesure où la marque grise est toute petite, vous aurez peut-être du mal à la retrou-
ver, surtout si vous avez d’autres champs dans le document. Vous choisirez sans doute de 
laisser visible le champ de variable pendant la durée de votre travail et le rendre invisible 
juste avant de créer la copie finale.
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À tout moment, vous pouvez placer le point d’insertion juste avant le champ et cliquer sur le 
menu Édition > Champs (voir Figure 17.17) ou faire un clic avec le bouton droit sur le 
champ et cliquer ensuite sur Champs… dans le menu contextuel. Dans la boîte de dialogue
Éditer les champs, cochez ou décochez l’option Invisible.

Appliquer la condition au contenu

Maintenant que vous avez défini la variable, vous pouvez l’utiliser dans une instruction de condi-
tion. Cette section décrit certaines possibilités.

Texte conditionnel

Commencez par définir un texte conditionnel qui permettra d’insérer dans le manuel les mots « Su-
per Produit Standard » dans la version standard et « Super Produit Pro » dans la version profes-
sionnelle. Vous pouvez utiliser ces champs à n’importe quel moment pour mentionner le nom du 
produit.

 1) Placez le curseur où vous souhaitez que l’une de ces phrases apparaisse (vous pourrez la 
déplacer ou la supprimer ultérieurement, si vous le souhaitez).

 2) Ouvrez la boîte de dialogue Champs en cliquant sur le menu Insertion > Champs > Autres 
champs… Ouvrez l’onglet Fonctions et sélectionnez Texte conditionnel dans la liste Type.

 3) Comme on le voit sur la Figure 17.13, saisissez ProStandard EQ “Standard” dans le 
champ Condition, Super Produit Standard dans le champ Alors et Super Produit 
Pro dans le champ Sinon.

Figure 17.13 : Insérer un texte conditionnel.

Remarque

Ces champs font la distinction entre les majuscules et les minuscules, en outre les guille-
mets sont nécessaires autour des valeurs de texte comme Standard.

 4) Cliquez sur le bouton Insérer pour insérer le champ, puis sur le bouton Fermer. Super Pro-
duit Standard doit normalement apparaître dans le texte.
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Conseil

Si vous souhaitez insérer ce champ à plusieurs endroits du document (ce qui est souvent le 
cas pour le nom d’un produit), il est conseillé de créer une entrée d’AutoTexte (voir « Utiliser
l’AutoTexte pour insérer des champs souvent utilisés » page 476).

Texte masqué

Vous utiliserez du texte masqué pour les mots ou les phrases courtes qui décrivent des fonctions 
de Super Produit Pro que l’on ne retrouve pas dans la version Standard. Vous pouvez réutiliser le 
même champ à divers endroits du document (par exemple, en le copiant et le collant).

Pour créer un champ de texte masqué :

 1) Cliquez sur le menu Insertion > Champs > Autres champs… pour ouvrir la boîte de dia-
logue Champs puis sur l’onglet Fonctions.

 2) Dans la liste Type, sélectionnez Texte masqué (voir Figure 17.14).

Figure 17.14 : Créer une condition pour un texte masqué.

 3) Comme on le voit sur la Figure 17.14, saisissez ProStandard EQ “Standard” dans le 
champ Condition, puis saisissez le texte requis dans le champ Texte masqué. Pour rappel, il 
s’agit du texte masqué si la condition est vraie.

 4) Cliquez sur le bouton Insérer pour insérer le champ, puis sur le bouton Fermer.

Paragraphe masqué

Un paragraphe est masqué si la condition est vraie. Pour masquer un paragraphe :

 1) Cliquez dans le paragraphe à masquer.

 2) Cliquez sur le menu Insertion > Champs > Autres champs… pour ouvrir la boîte de dia-
logue Champs, puis sur l’onglet Fonctions (voir Figure 17.15).

 3) Dans la liste Type, sélectionnez Paragraphe masqué.

 4) Dans cet exemple, saisissez ProStandard EQ “Standard” dans le champ Condition.

 5) Cliquez sur le bouton Insérer pour créer et insérer le champ dans le document. Si une 
marque de paragraphe supplémentaire apparaît, supprimez-la.
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Figure 17.15 : Créer une condition pour un paragraphe masqué.

Pour afficher les paragraphes masqués dans le but de les éditer, effectuer l’une des actions sui-
vantes :

• cliquez sur le menu Affichage > Paragraphes masqués afin de vérifier si l’option Para-
graphes masqués est bien cochée. Si tel n’est pas le cas, cochez-la ;

• cliquez sur le menu Outils > Options pour ouvrir la boîte de dialogue Options. Cliquez dans 
la sous-section LibreOffice Writer > Aides au formatage. Cochez l’option Champs : para-
graphes masqués ;

• double-cliquez en face de la variable que vous avez utilisée pour définir la condition afin de 
masquer le texte, et saisissez une valeur de variables différente (cela permet d’afficher tous 
les paragraphes masqués) ;

• double-cliquez en face du champ de texte masqué ou du champ de paragraphe masqué, et 
modifiez l’instruction de condition (cela permet de modifier uniquement le paragraphe mas-
qué sélectionné).

Section masquée

Une section conditionnelle est masquée si la condition est vraie. Pour créer une section condition-
nelle :

 1) Sélectionnez le texte que vous souhaitez inclure dans une section conditionnelle. (Vous 
pourrez éditer le texte plus tard, exactement comme vous pouvez éditer tout autre texte.)

 2) Cliquez sur le menu Insertion > Section pour ouvrir la boîte de dialogue Insérer une section 
(voir Figure 17.16). Cliquez sur l’onglet Section. Cochez l’option Masquer puis saisissez la 
condition dans le champ Sous condition. Si vous le souhaitez, vous pouvez donner un nom à
la section (ce qui est vivement recommandé, car vous retrouverez plus facilement une sec-
tion si votre document en contient plusieurs).

 3) Cliquez sur le bouton Insérer pour insérer la section dans le document.
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Figure 17.16 : Créer une section à masquer quand une condition définie est remplie.

Pour afficher une section masquée afin de l’éditer :

 1) Cliquez sur le menu Format > Sections.

 2) Dans la boîte de dialogue Éditer les sections (elle ressemble à la boîte de dialogue Insérer 
une section), sélectionnez la section à éditer dans la liste.

 3) Décochez l’option Masquer, puis cliquez sur le bouton OK. Vous pouvez désormais éditer le 
contenu de la section. Une fois les modifications effectuées, vous pouvez cliquer sur le menu
Format > Sections et cochez l’option Masquer afin de masquer à nouveau la section.

Pour afficher toutes les sections masquées afin de les éditer, donnez à la variable une valeur qui 
ne remplira pas la condition.

Pour transformer la section masquée en une partie normale du document (c’est-à-dire pour suppri-
mer les marqueurs de la section, mais pas son contenu) :

 1) Affichez la section masquée comme décrit ci-dessus.

 2) Dans la boîte de dialogue Éditer les sections, sélectionnez la section à transformer dans la 
liste.

 3) Cliquez sur le bouton Supprimer. Le contenu de la section apparaît maintenant comme une 
partie normale du document.

Modifier la valeur d’une variable

 1) Recherchez le champ de variable créé (voir la section « Choisir ou définir une variable » 
en page 486).

 2) Cliquez une fois juste devant le champ puis faites un clic droit afin d’ouvrir le menu contex-
tuel, et choisissez sur Champs.
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 3) Dans la boîte de dialogue Éditer les champs : variables (voir Figure 17.17), modifiez la valeur
de la variable en Pro.

 4) Si vous avez défini des champs à mettre à jour automatiquement, tout le texte conditionnel et
masqué qui utilise cette variable comme condition sera modifié.

Remarque

Les textes conditionnels et masqués ne peuvent être édités que dans la boîte de dialogue 
Éditer les champs.

Figure 17.17 : Modifier la valeur de la variable

Conseil

Pour désactiver l’actualisation automatique des champs, cliquez sur le menu Outils > Op-
tions. Dans la boîte de dialogue Options, ouvrez la page LibreOffice Writer – Général. Dans
la section Actualiser automatiquement, décochez l’option Champs.

Utiliser des champs substituants

Un champ substituant vous invite à saisir quelque chose (du texte, un tableau, un cadre, une 
image, un objet, etc.).

Pour insérer un champ substituant dans un document :

 1) Dans l’onglet Fonctions de la boîte de dialogue Champs, sélectionnez Substituant dans la 
liste Type. Dans la liste Format, choisissez à quoi est destiné le substituant.

 2) Dans le champ Substituant, saisissez le texte que vous souhaitez voir apparaître dans ce 
champ.

 3) Dans le champ Annotation, saisissez le texte que vous souhaitez voir apparaître en infobulle 
lorsque vous survolerez le champ avec la souris.

La Figure 17.18 montre un exemple d’insertion d’un champ substituant pour une image.
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Figure 17.18 : Insérer un champ substituant.

Étant donné que le champ <Logo> est un substituant d’image, lorsque vous cliquerez dessus, la 
boîte de dialogue Insérer une image s’ouvrira. Lorsque vous sélectionnerez l’image et cliquerez 
sur le bouton Ouvrir, l’image choisie remplacera le champ substituant dans le document.

De la même manière, cliquer sur un substituant de tableau ouvre la boîte de dialogue Insérer un 
tableau, cliquer sur un substituant de cadre ouvre la boîte de dialogue Cadre, et cliquer sur un sub-
stituant d’objet ouvre la boîte de dialogue Insérer un objet OLE.

Le substituant de texte est toutefois différent. Vous devez simplement cliquer dessus afin de le 
mettre en surbrillance et saisir n’importe quel texte qui remplacera le champ.

Utiliser les champs de saisie et les listes de saisie

Champ de saisie

Un champ de saisie est une variable sur laquelle vous pouvez cliquer dans un document afin d’ou-
vrir une boîte de dialogue qui vous permet d’éditer le texte affiché dans ledit champ. Pour insérer 
un champ de saisie :

 1) Cliquez sur le menu Insertion > Champs > Autres champs… pour ouvrir la boîte de dia-
logue Champs. Cliquez sur l’onglet Fonctions.

 2) Dans la liste Type, sélectionnez Champ de saisie (voir Figure 17.19).

 3) (Optionnel.) Saisissez du texte dans le champ Annotation. Ce texte apparaîtra comme une 
infobulle lorsque vous survolerez le champ de saisie avec votre souris.

 4) Dans la petite boîte de dialogue qui s’ouvre, saisissez le texte de la variable (il s’agit d’une 
brève explication destinée à l’utilisateur concernant l’utilisation du champ). Si vous le souhai-
tez, ce texte peut être le même que celui saisi dans le champ Annotation à l’étape précé-
dente.

 5) Cliquez sur le bouton OK.

Pour éditer un champ de saisie, cliquez sur celui-ci dans le document puis modifiez le texte du 
champ dans la petite boîte de dialogue qui s’ouvre.
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Figure 17.19 : Insérer un champ de saisie.

Pour éditer l’annotation du champ (voir étape 3 ci-avant), faites un clic droit sur le champ et cliquez
sur Champs dans le menu contextuel afin d’ouvrir la boîte de dialogue Éditer les champs (Figure 
17.20).

Figure 17.20 : Éditer un champ de saisie

Liste de saisie

Une liste de saisie est un champ de texte qui affiche un élément d’une liste. Pour insérer une liste 
de saisie dans un document :
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 1) Cliquez sur le menu Insertion > Champs > Autres champs… pour ouvrir la boîte de dia-
logue Champs. Cliquez sur l’onglet Fonctions. Dans la liste Type, sélectionnez Liste de sai-
sie (Figure 17.21).

 2) Dans le champ Élément, saisissez le nom d’un élément de la liste, puis cliquez sur le bouton 
Ajouter pour l’ajouter à la liste. Recommencez autant de fois que nécessaire. Pour modifier 
l’ordre des éléments, sélectionnez un élément dans la liste Éléments de la liste, puis utilisez 
les boutons Déplacer vers le haut et Déplacer vers le bas.

 3) Dans le champ Nom, saisissez le nom de la liste.

 4) Cliquez sur le bouton Insérer.

Figure 17.21 : Définir une liste de saisie.

Pour afficher la boîte de dialogue Choisir un élément (voir Figure 17.22), cliquez sur le champ de 
la liste de saisie dans le document.

Figure 17.22 : Choix d’un élément dans une liste de saisie.
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Pour ajouter, éditer, supprimer des éléments de la liste, ou modifier leur ordre d’apparition dans la 
liste, cliquez sur le bouton Éditer dans la boîte de dialogue Choisir un élément. La boîte de dia-
logue Éditer les champs s’affichera.

Pour éditer rapidement tous les champs et les listes de saisie dans un document, appuyez sur les 
touches Ctrl+Maj+F9 de votre clavier. Le premier champ de saisie ou de liste du document 
s’ouvre. Cliquez sur le bouton OK ou sur le bouton Suivant pour déplacer le curseur au champ ou 
à la liste de saisie suivant. Après le dernier champ de saisie ou de liste, cliquez sur le bouton Sui-
vant ou le bouton OK pour retourner au contenu du document.

Méthode alternative

Pour une utilisation plus confortable de ce type de document, enregistrez-le au format ott. 
(modèle de texte). Ainsi, l’utilisateur travaillera sur une copie et sera invité à saisir les infor-
mations à l’ouverture automatisée des dialogues de saisie.
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Introduction aux formulaires

Ce chapitre aborde l’utilisation des formulaires dans les documents Writer. La plupart des informa-
tions exposées dans ce chapitre s’appliquent également aux autres modules de LibreOffice, il y a 
cependant quelques différences.

Les formulaires peuvent être utilisés lorsqu’un document texte standard affiche des informations 
comme une lettre, un rapport ou une brochure. Habituellement, le lecteur peut modifier tout ou rien
dans le document. Un formulaire est composé de sections qui ne sont pas éditables ainsi que 
d’autres sections qui sont destinées aux modifications apportées par le lecteur. Par exemple, un 
questionnaire comporte une introduction et des questions (qui ne changent pas) et des espaces 
réservés aux réponses du lecteur.

LibreOffice propose plusieurs façons de compléter des informations dans un formulaire, que ce 
soit via des cases à cocher, des boutons d’option, des zones de texte, des listes déroulantes, des 
compteurs, etc. Tous ces éléments sont appelés des contrôles de formulaire.

Le chapitre présente l’utilisation des formulaires à travers quatre sections principales :

• création d’un formulaire simple,

• exemple d’un formulaire simple,

• accès aux sources de données,

• personnalisation avancée d’un formulaire.

Les formulaires LibreOffice permettent une utilisation avancée et tout n’est pas décrit dans ce cha-
pitre, notamment l’utilisation des formulaires dans les documents HTML ainsi que l’écriture de ma-
cros pour lier des contrôles de formulaire.

Quand utiliser des formulaires ?

Les formulaires sont utilisés de trois manières :

• pour créer un document simple que le destinataire doit compléter, comme un questionnaire 
envoyé à un groupe de personnes qui le complète et le retourne à l’expéditeur ;

• pour permettre à l’utilisateur de saisir des informations contenues dans une base de don-
nées. Par exemple, quelqu’un qui s’occupe des commandes de clients saisira des informa-
tions pour chaque commande dans une base de données à l’aide d’un formulaire ;

• pour visualiser des informations gérées par une base ou une source de données. Par 
exemple, un bibliothécaire peut obtenir des informations à propos d’un livre grâce à cette 
base de données.

Utiliser des formulaires pour accéder à une base de données offre un moyen facile et rapide de 
construire des documents complexes mais d’abord simples. Le formulaire peut non seulement in-
clure des champs qui sont liés à la source de données, mais également du texte, des images, des 
tableaux, des dessins, etc.

Voici une façon typique d’utiliser un formulaire :

 1) Vous concevez le formulaire et vous l’enregistrez dès que sa mise en page vous convient.

 2) Vous l’envoyez à d’autres personnes (par exemple, par courriel).
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 3) Ils complètent le formulaire, enregistrent leurs réponses et vous le retournent.

 4) Vous ouvrez alors le formulaire et voyez quelles sont leurs réponses.

Astuce

En utilisant une source de données ou en paramétrant un formulaire à mettre à jour via in-
ternet, vous pouvez recueillir des données automatiquement. Cependant, ces deux mé-
thodes sont plus difficiles à maîtriser et ne sont pas abordées dans ce livre.

Alternative à l’utilisation des formulaires dans Writer

Dans LibreOffice, le module Base offre une autre méthode pour accéder à une source de données.
Il existe de nombreuses ressemblances entre les formulaires du module Base et ceux du module 
Writer, mais l’un peut s’avérer plus approprié que l’autre pour une tâche donnée. Ainsi, Base ne 
peut être utilisé pour des formulaires simples, car il ne crée des formulaires que s’il accède à une 
base de données.

D’autres modules de LibreOffice (Calc, Impress et Draw) utilisent les formulaires de la même façon
que le module Writer.

Création d’un formulaire simple

Cette section explique comment créer un formulaire simple sans lien à une source de données ou 
une base de données et sans configuration avancée.

Créer un document

Aucune manipulation particulière n’est à effectuer lors de la création d’un document utilisé comme 
formulaire. Créez simplement un nouveau document Writer en cliquant sur le menu Fichier > Nou-
veau > Document texte.

Ouvrir les barres d’outils de formulaire

Deux barres d’outils contrôlent la création de formulaire : la barre d’outils Contrôle de formulaire et 
la barre d’outils Ébauche de formulaire. Pour les afficher, cliquez sur le menu Affichage > Barres 
d’outils > Contrôle de formulaire puis sur Affichage > Barres d’outils > Ébauche de formu-
laire.

Il est également possible d’ouvrir la barre d’outils Ébauche de formulaire depuis la barre d’outils 
Contrôles de formulaire (en cliquant sur l’icône ). Certains contrôles, moins utilisés, se trouvent 
dans une troisième barre d’outils, appelée Contrôles supplémentaires, qui peut également être ou-
verte depuis la barre d’outils Contrôles de formulaire (icône ).

Nouveau dans la version 6.0

Il existe maintenant une entrée de menu dédiée aux formulaires à partir de laquelle de nom-
breux contrôles sont aussi accessibles.

Si vous le souhaitez, vous pouvez ancrer les barres d’outils à différents endroits de l’espace de tra-
vail. La Figure 18.1 représente les trois barres d’outils flottantes. Lorsque ces barres sont flot-
tantes, vous pouvez modifier leur orientation (de barre verticale à barre horizontale) ou changer le 
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nombre d’outils présents sur une rangée. Pour effectuer ces modifications, il vous suffit de faire 
glisser un coin de la barre d’outils flottante à l’aide de la souris.

Pour plus de détails sur les outils disponibles dans ces deux barres d’outils, référez-vous à la sec-
tion « Contrôle de formulaire – Barres d’outils » en page 503.

Figure 18.1 : Les trois barres d’outils permettant la création de formulaire.

Activer le mode ébauche

Cliquez sur l’icône Mode conception ( ) dans la barre d’outils Contrôles de formulaire afin d’ac-
tiver (ou de désactiver) les boutons (case à cocher, zone de texte…) qui permettent l’édition du for-
mulaire.

Lorsque le mode ébauche est désactivé, le formulaire se comporte comme il le fera pour le desti-
nataire du formulaire : les cases peuvent être cochées, les éléments de liste peuvent être sélec-
tionnés, etc.

Insérer un contrôle de formulaire

 1) Pour insérer un contrôle de formulaire dans le document, cliquez sur l’icône du contrôle pour 
la sélectionner. Le pointeur de la souris se modifie pour ressembler à ceci :

 2) Cliquez dans le document à l’endroit où vous souhaitez que le contrôle apparaisse (vous 
pourrez le déplacer ultérieurement).

 3) Tout en maintenant le bouton gauche de la souris enfoncé, glissez le pointeur de la souris 
pour en dessiner le contour. À noter que certains contrôles ont un symbole de taille fixe suivi 
du nom dudit contrôle (par exemple : le bouton Case à cocher ou le contrôle Bouton radio).

 4) Le bouton du contrôle demeure actif, vous pouvez donc insérer plusieurs contrôles du même
type sans avoir à revenir à la barre d’outils.

 5) Pour sélectionner un autre contrôle, cliquez sur son icône dans la barre d’outils.

 6) Pour arrêter d’insérer des contrôles, cliquez sur le bouton Sélectionner ( ) dans la barre 
d’outils Contrôles de formulaire ou cliquez sur l’un (n’importe lequel) des contrôles que vous 
venez d’insérer. Le pointeur de la souris reprend son apparence normale.

Astuce

Le fait de maintenir la touche Maj enfoncée permet de dessiner une forme carrée. Si vous 
appuyez sur Maj lors du redimensionnement d’un contrôle existant, ses proportions seront 
conservées.
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Remarque

Lorsque vous insérez une Zone de groupe ou une Boîte combinée, un assistant se lance 
pour vous guider dans leur paramétrage. Si vous préférez ne pas démarrer cet assistant, cli-
quez sur le bouton (Dés)Activation des assistants ( ) dans la barre d’outils.

Configurer les contrôles

Une fois les contrôles insérés, vous devez les configurer afin qu’ils se comportent comme vous le 
souhaitez. Faites un clic droit sur un contrôle de formulaire dans le document pour afficher un 
menu contextuel. Cliquez sur l’option Contrôle… pour ouvrir la boîte de dialogue Propriétés du 
contrôle. Vous pouvez également ouvrir cette boîte de dialogue en faisant un double clic sur le 
contrôle.

Remarque

Dès que la boîte de dialogue Propriétés est fermée (même à l’aide du bouton X situé dans la
barre de titre de ladite boîte de dialogue ou de la touche Échap de votre clavier), les modifi-
cations apportées sont validées et, par conséquent, effectives.

La boîte de dialogue Propriétés (voir Figure 18.2) comporte généralement trois onglets : Général, 
Données et Événements. À noter que certains contrôles, notamment Bouton et Champ d’étiquette,
n’en comportent que deux (Général et Événements). Pour les formulaires simples, seule la page 
Général a un intérêt. Dans cette boîte de dialogue, vous pourrez définir l’apparence du contrôle. 
Pour plus d’informations, référez-vous aux sections « Configurer les contrôles de formulaire » 
en page 510 et « Options de formatage d’un contrôle de formulaire » en page 522. La configu-
ration d’un formulaire destiné à être utilisé avec une base de données est abordée à la section 
« Créer un formulaire pour la saisie de données » en page 517.

Figure 18.2 : Boîte de dialogue Propriétés d’un contrôle
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Les options présentes dans la boîte de dialogue Propriétés (voir Figure 18.2) varient en fonction du
type de contrôle :

• certains contrôles ont des étiquettes visibles, comme les Boutons ou les Boutons radio. Le 
texte de l’étiquette peut être défini ;

• le contrôle Zone de liste contient une liste d’options à choisir. Définissez ces options dans la 
zone d’entrées de la liste.

Il est à noter que cette boîte de dialogue présente une barre de défilement que vous pouvez utili-
ser pour visualiser les autres champs. Il vous est également possible de l’agrandir.

Utiliser le formulaire

Pour utiliser le formulaire, quittez le mode Ébauche en cliquant sur le bouton Mode Conception. 
Enregistrez ensuite le formulaire.

Contrôle de formulaire – Barres d’outils

Nouveau dans la version 6.0

La répartition des contrôles a été modifiée ce qui rend moins nécessaire l’utilisation de la 
barre d’outils Contrôles supplémentaires.

Barre d’outils Contrôle de formulaire

Sélectionner Bouton qui permet de sélectionner un contrôle du formulaire pour réa-
liser des actions.

Mode conception Bouton qui active le mode ébauche (pour éditer le formulaire) ou le 
désactive (pour utiliser le formulaire).

Contrôle6 Bouton qui ouvre la boîte de dialogue Propriétés des contrôles de for-
mulaire. Cette boîte de dialogue peut rester ouverte quand on passe 
d’un contrôle à l’autre.

Formulaire6 Bouton qui ouvre la boîte de dialogue Propriétés du formulaire. Cette 
boîte de dialogue contrôle les propriétés du formulaire dans son en-
semble, comme la source de données qui lui est connectée.

Étiquette Contrôle étiquette. À la différence d’un texte saisi dans le document, 
ce contrôle peut être lié à une macro pour qu’un événement se pro-
duise lorsque, par exemple, la souris le survole ou que l’utilisateur 
clique sur lui.

6 Ce bouton est masqué dans l’installation par défaut.
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Zone de texte Contrôle qui permet de créer une zone de saisie dans laquelle l’utili-
sateur du formulaire peut taper du texte.

Case à cocher Contrôle qui permet de sélectionner une option en cochant une case. 
Vous pouvez lui ajouter une étiquette.

Bouton radio Contrôle qui permet de sélectionner une option en enfonçant un bou-
ton. Lorsque plusieurs boutons sont groupés, un seul d’entre eux 
peut être sélectionné à la fois. La façon la plus simple de grouper plu-
sieurs boutons est d’utiliser le contrôle Zone de groupe, avec les as-
sistants actifs.

Zone de liste Contrôle qui crée une liste déroulante d’options parmi lesquelles l’uti-
lisateur peut faire un choix. Si les assistants sont activés, la création 
d’une zone de liste lance l’assistant Zone de liste. Cet assistant n’est 
utile que si le formulaire est lié à une source de données.

Si le contrôle n’est pas lié à une source de données, désactivez les 
assistants et créez une zone de liste vide. Puis cliquez sur le bouton 
Contrôle… et, dans le champ Entrées de liste de l’onglet Général, 
saisissez les items que vous souhaitez voir apparaître dans la liste.

Lors de la saisie, séparez chacun d’entre eux à l’aide de la combinai-
son de touches Maj + Entrée. À la fermeture de la boîte de dialogue 
(à l’enregistrement, donc), Writer entourera automatiquement chaque 
terme de la liste d’apostrophes et les séparera avec des points-vir-
gules (voir la Figure 18.6).

Boîte combinée Contrôle semblable à une Zone de liste qui dispose d’une zone de 
saisie au-dessus de la liste. Il affiche le choix réalisé et permet à l’uti-
lisateur du formulaire de saisir une option qui n’est pas dans la liste

Bouton Contrôle qui crée un bouton qui peut être lié à une macro. L’étiquette 
est le nom qui apparaît sur le bouton.

Bouton picto Ce contrôle se comporte exactement comme un bouton, mais affiche 
une image. Choisissez l’image dans le champ Images de l’onglet Gé-
néral de la boîte de dialogue Propriétés du contrôle.

Champ formaté Contrôle qui offre des options de formatage numérique. Par exemple, 
vous pouvez définir des valeurs maximum, minimum et par défaut 
ainsi qu’un formatage du nombre saisi (nombre de décimales, écri-
ture scientifique, ou valeur monétaire).

Champ de date Contrôle qui affiche et permet de saisir une date. Configurez la date 
la plus ancienne et la plus récente que le champ doit accepter, la date
par défaut et son format. Vous pouvez ajouter un compteur.

Champ numérique Contrôle qui affiche et permet de saisir un nombre. Vous devez définir
les valeurs maximum, minimum et par défaut. Vous pouvez ajouter un
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compteur.

Zone de groupe Le contrôle de Zone de groupe a deux usages différents selon que 
les assistants sont activés ou non.

Si les assistants sont actifs, créer une Zone de groupe lance l’assis-
tant Élément du groupe qui crée un groupe de boutons radio (dans le-
quel un seul bouton à la fois peut être sélectionné). Dans la plupart 
des cas, l’utilisation d’une zone de groupe est le meilleur moyen d’uti-
liser un ensemble de boutons.

Si les assistants sont désactivés, une zone de groupe est simplement
une zone visuelle permettant de grouper différents contrôles. Elle n’a 
pas d’effet sur la façon dont les contrôles opèrent.

Contrôles supplé-
mentaires

Bouton qui ouvre la barre d’outils Contrôles supplémentaires.

Ébauche de formu-
laire

Bouton qui ouvre la barre d’outils Ébauche de formulaire (qui peut 
être également ouverte par le menu Affichage > Barre d’outils > 
Ébauche de formulaire).

(Dés)Activation des 
assistants

Boutons qui activent ou désactivent les assistants facultatifs dont dis-
posent certains contrôles (Zone de liste ou Boîte combinée). Si vous 
ne souhaitez pas que l’assistant se lance lorsque vous créez l’un de 
ces contrôles, ce bouton ne doit pas être activé (cadre ou fond colo-
ré).

Barre d’outils Contrôles supplémentaires

Champ horaire Ce contrôle fonctionne comme le champ de date mais permet d’affi-
cher ou de saisir une heure.

Champ monétaire Ce contrôle fonctionne comme un champ numérique auquel vous pou-
vez ajouter un symbole monétaire.

Champ de motif Ce contrôle est utile lorsque le formulaire est lié à une source de don-
nées. Définissez un masque de saisie pour restreindre ce qu’un utili-
sateur peut saisir et un masque littéral pour restreindre les données 
de la source de données à afficher.

Barre de navigation Ce contrôle est une barre de navigation identique à la barre d’outils de
navigation du formulaire (Affichage > Barre d’outils > Navigation 
pour formulaire), mais qui peut être placée n’importe où dans le do-
cument et redimensionnée.
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Contrôle picto Contrôle uniquement utile lorsque le formulaire est connecté à une 
source de données et qu’un champ pouvant contenir une image existe
dans la table. Vous pouvez ajouter des nouvelles images à la base de 
données ou récupérer et afficher des images de cette base.

Sélection de fichiers Ce contrôle permet à l’utilisateur de sélectionner un fichier, soit en sai-
sissant son chemin et son nom, soit en cliquant sur un bouton de re-
cherche et de sélection du fichier à travers une boîte de dialogue.

Compteur Contrôle qui permet à l’utilisateur de choisir un nombre en les faisant 
défiler. Spécifiez les valeurs maximum, minimum et par défaut ainsi 
que le pas entre les nombres (incrément/décrément). Ce contrôle 
n’est pas souvent utilisé dans Writer dans la mesure où le nombre 
n’est pas affiché.

Barre de défile-
ment7

Ce contrôle crée une barre de défilement avec un certain nombre 
d’options qui permettent d’en définir l’apparence exacte. Ce contrôle 
n’est pas souvent utilisé dans Writer.

Contrôle de table8 Un contrôle de table n’est utile qu’avec une source de données. Si au-
cune source de donnée n’est spécifiée, il vous sera demandé d’en 
choisir une à travers l’assistant Élément de la table.

Vous choisissez alors les champs à afficher et, lorsque le mode 
Ébauche est désactivé, les données apparaissent dans la table. La 
table inclut également des contrôles pour se déplacer dans les enre-
gistrements.

Les enregistrements peuvent être ajoutés, supprimés et modifiés dans
la table.

Barre d’outils Ébauche de formulaire

Sélectionner Bouton qui permet de sélectionner un contrôle du formulaire pour réa-
liser des actions.

Mode conception Bouton qui active le mode ébauche (pour éditer le formulaire) ou le 
désactive (pour utiliser le formulaire).

Contrôle Bouton qui ouvre la boîte de dialogue Propriétés des contrôles de for-
mulaire. Cette boîte de dialogue peut rester ouverte quand on passe 

7 Ce bouton est masqué dans l’installation par défaut.
8 Ce bouton n’est pas installé par défaut. Vous pouvez l’ajouter en sélectionnant Personnaliser la 

barre d’outils… dans le menu contextuel.
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Barre d’outils Ébauche de formulaire

d’un contrôle à l’autre.

Formulaire Bouton qui ouvre la boîte de dialogue Propriétés du formulaire. Cette 
boîte de dialogue contrôle les propriétés du formulaire dans son en-
semble, comme la source de données qui lui est connectée.

Navigateur de for-
mulaire

Bouton qui ouvre un utilitaire qui affiche tous les formulaires et les 
contrôles présents dans le document actif et permet de les éditer ou 
de les supprimer facilement.

Si vous utilisez le Navigateur de formulaire, donnez des noms aux 
contrôles (dans la boîte de dialogue des propriétés). Le nom apparaît 
dans le navigateur, ainsi, si vous avez plusieurs zones de texte vous 
savez laquelle correspond à celle recherchée.

Ajouter un champ Ce bouton n’est utile que si vous avez spécifié une source de don-
nées pour le formulaire. Si aucune source de données n’est spécifiée, 
une zone vide s’ouvre.

Si vous avez spécifié une source de données, Ajouter un champ 
ouvre une liste de tous les champs présents dans la table spécifiée. 
Vous pouvez les glisser-déposer dans la page où ils seront précédés 
de leur nom.

C’est une façon simple et rapide pour créer un formulaire à partir 
d’une source de données.

Ordre d’activation Ce bouton permet de définir l’ordre dans lequel les contrôles sont acti-
vés quand on appuie sur la touche Tabulation. Vous pouvez tester 
l’ordre en quittant le mode ébauche et en utilisant alors la touche 
Tabulation pour déplacer le curseur d’un contrôle à l’autre.

Ouvrir en mode 
Ébauche

Quand ce bouton est activé (cadre ou fond coloré), le formulaire actif 
est ouvert en mode ébauche (pour éditer le formulaire plutôt que d’y 
saisir des données).

Focalisation auto-
matique sur le 
contrôle

Quand ce bouton est activé, le premier contrôle de formulaire est le 
contrôle actif.

Position et taille Ce bouton ouvre la boîte de dialogue Position et taille qui permet de 
spécifier des valeurs précises, plutôt que de faire les réglages avec la 
souris. Vous pouvez également protéger la taille ou la position, de fa-
çon à ce qu’elles ne soient pas modifiées accidentellement. Pour cer-
tains contrôles, vous pouvez les orienter et régler l’angle de rotation.

Modifier l’ancrage Bouton qui permet d’ancrer le contrôle à la page, au paragraphe, au 
caractère ou comme caractère (c’est-à-dire qu’il se comporte comme 
n’importe quel autre caractère de la page).
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Barre d’outils Ébauche de formulaire

Alignement Le bouton Alignement est désactivé à moins que le contrôle ne soit 
ancré comme un caractère. Vous pouvez aligner le contrôle de diffé-
rentes manières, par exemple de façon à ce que le haut du contrôle 
s’aligne avec le haut du texte, ou que le bas s’aligne avec le bas du 
texte.

Il est aussi activé si plusieurs contrôles sont sélectionnés pour les ali-
gner collectivement d’un même côté.

Afficher la grille Ce bouton affiche une grille de points sur la page pour aider à posi-
tionner les contrôles.

Aligner sur la grille Si ce bouton est activé (cadre ou fond coloré), les contrôles sont atti-
rés par un point ou une ligne de la grille dont ils sont proches et ils 
s’alignent sur celle-ci. L’alignement des contrôles s’en trouve facilité.

Lignes d’aide lors 
du déplacement

Ce bouton affiche des lignes verticales et horizontales du contrôle jus-
qu’aux bords de la fenêtre pour vous aider à le positionner précisé-
ment.

Exemple : un formulaire simple

Créer le document

Figure 18.3 : Questionnaire initial sans les contrôles de formulaire.
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Ouvrez un nouveau document (cliquez sur le menu Fichier > Nouveau > Document texte). Le 
mieux est de commencer par créer l’esquisse du questionnaire, sans y insérer les contrôles de for-
mulaire (voir Figure 18.3). Le questionnaire pourra être modifié plus tard.

Ajouter les contrôles de formulaire

L’étape suivante consiste à ajouter quatre contrôles de formulaire dans le document :

• Nom est une zone de texte.

• Genre correspond à trois boutons (masculin, féminin, autre).

• Forme préférée est une liste d’options.

• Toutes les formes sont représentées par une série de cases à cocher.

Figure 18.4 : Le questionnaire avec les contrôles.

Pour ajouter ces contrôles :

 1) Cliquez sur le menu Affichage > Barres d’outils > Contrôles de formulaire pour afficher la
barre d’outils Contrôles de formulaire.

 2) Si les outils de la barre ne sont pas actifs, cliquez sur le bouton Mode conception ( ) pour 
les activer.

 3) Vous devez créer le champ Nom. Cliquez sur le bouton Zone de texte ( ). Vous allez tra-
cer la forme de la zone de texte dans votre document. Pour ce faire, maintenez appuyé le 
bouton gauche de la souris tout en dessinant la forme. Une fois qu’elle a atteint la taille sou-
haitée, relâchez le bouton gauche de la souris. Alignez-la avec la ligne « NOM ».

 4) Assurez-vous que le bouton (Dés)Activation des Assistants ( ) est désactivé (si ce bou-
ton est activé, il est entouré d’une bordure ou a un fond coloré). Cliquez sur le contrôle Bou-
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ton radio et dessinez-en trois exemplaires à côté de la ligne « GENRE ». Ils seront configu-
rés dans la section suivante.

 5) Cliquez sur le contrôle Zone de liste et dessinez-la dans le formulaire en face de « FORME 
PRÉFÉRÉE ». La boîte restera vide pour le moment.

 6) Pour finir, cliquez sur le bouton Case à cocher ( ) et dessinez quatre cases à cocher, côte 
à côte sur la page, sous la ligne « TOUTES LES FORMES ».

Votre document devrait ressembler à la Figure 18.4.

Configurer les contrôles de formulaire

Aucun paramétrage supplémentaire n’est nécessaire pour le champ Nom. Si vous le souhaitez, 
vous pouvez évidemment donner un nom à chaque contrôle et modifier leur apparence.

Pour les boutons radio, effectuez les réglages suivants :

 1) Vérifiez que le mode conception est actif. Faites un clic droit sur le premier bouton et sélec-
tionnez Contrôle… dans le menu contextuel. Dans l’onglet Général de la boîte de dialogue 
Propriétés (Figure 18.5), tapez Masculin dans le champ Étiquette et Genre dans le champ 
Nom du groupe.

 2) Pour les deux autres boutons radio, tapez Féminin et Autre dans les champs Étiquette et 
Genre dans Nom du groupe. (En donnant le même nom de groupe aux trois boutons, on 
n’autorise l’utilisateur à en sélectionner qu’un seul à la fois.)

Figure 18.5 : Définir l’étiquette et le groupe des boutons radio.

Pour ajouter les choix à la Zone de liste, effectuez ce qui suit :

 1) Assurez-vous que le mode conception est activé et les assistants désactivés. Faites un 
double clic sur la zone de liste afin d’ouvrir la boîte de dialogue Propriétés. Sélectionnez l’on-
glet Général.

 2) Faites défiler les options jusqu’au champ Entrées de liste et saisissez les noms des formes 
(Cercle, Triangle, Carré et Pentagone) l’un après l’autre. Après avoir inscrit le nom d’une 
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forme, appuyez sur les touches Maj+Entrée de votre clavier pour pouvoir inscrire la sui-
vante. Appuyez sur la touche Entrée de votre clavier une fois que vous aurez terminé de 
saisir toutes les formes. La Figure 18.6 illustre le résultat que vous obtiendrez.

Figure 18.6 : Saisie des choix dans une zone de liste

Pour donner une étiquette différente aux cases à cocher :

 1) Faites un double clic sur la première case à cocher. La boîte de dialogue Propriétés reste ou-
verte, mais affiche maintenant les propriétés des cases à cocher. 

 2) Modifiez l’entrée du champ Étiquette en tapant Cercle à la place de Case à cocher, puis ap-
puyez sur la touche Entrée de votre clavier. Le curseur s’est déplacé dans le champ 
Champ d’étiquette et, dans le document, le nouveau libellé de la case à cocher est affiché.

Figure 18.7 : La boîte de dialogue Propriétés d’une case à cocher.

 3) De la même manière, modifiez l’étiquette des trois autres cases à cocher (Triangle, Carré et 
Pentagone).

 4) Fermez la boîte de dialogue Propriétés.

 5) Désactivez le mode conception ( ) et fermez les deux barres d’outils Contrôles de formu-
laire et Contrôles supplémentaires.

 6) Votre questionnaire est terminé. Il devrait ressembler à la Figure 18.8.
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Figure 18.8 : Le questionnaire complet et terminé.

Touches de finition

Le questionnaire est terminé, mais vous pouvez encore le modifier. Par exemple, si vous envoyez 
ce questionnaire à d’autres personnes afin qu’elles le complètent, vous voudrez probablement qu’il
soit en lecture seule. Le destinataire pourra ainsi le remplir sans pouvoir y apporter d’autres chan-
gements.

Pour enregistrer le document en lecture seule, cliquez sur le menu Fichier > Propriétés, dans 
l’onglet Sécurité, cochez l’option Ouvrir le fichier en lecture seule.

Remarque

Si le document est en lecture seule, toute personne répondant au questionnaire devra l’en-
registrer en cliquant sur le menu Fichier > Enregistrer sous.

Accès aux sources de données

Les formulaires sont couramment utilisés comme interface d’une base de données. Vous pouvez 
réaliser un formulaire qui permet à l’utilisateur de saisir des informations dans une base de don-
nées de contacts et, parce que c’est un document Writer, le formulaire peut contenir des images, 
des formatages, des tableaux et d’autres éléments afin qu’il soit exactement comme vous le sou-
haitez. De cette façon, modifier un formulaire est aussi simple que d’éditer un document.

LibreOffice peut accéder à de nombreuses bases de données, notamment ODBC, MySQL, Oracle 
JDBC, les feuilles de calcul et les fichiers textes. En général, il est possible d’accéder aux bases 
de données en lecture et en écriture ; les autres sources de données (comme des feuilles de cal-
cul) sont en lecture seule.
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Conseil

Pour consulter la liste des bases de données prises en charge par votre système d’exploita-
tion, cliquez sur le menu Fichier > Nouveau > Base de données. À la première étape de 
l’assistant Bases de données (voir Figure 18.9), sélectionnez l’option Se connecter à une 
base de données existante et déroulez la liste. Un exemple est montré en Figure 18.13.

Créer une base de données

Pour obtenir plus d’informations sur comment créer une base de données, référez-vous au cha-
pitre 8, Débuter avec Base, du Guide du débutant. Cette section vous donnera un bref aperçu sur 
la création d’une base de données avec LibreOffice Base.

 1) Cliquez sur le menu Fichier > Nouveau > Base de données pour ouvrir l’Assistant Base de 
données (voir Figure 18.9).

 2) Cochez l’option Créer une nouvelle base de données et cliquez sur le bouton Suivant >>.

 3) À l’étape suivante, cochez les options Oui, je souhaite que la base de données soit référen-
cée et Ouvrir la base de données pour édition. Référencer la base de données signifie 
qu’elle sera accessible à partir des autres modules de LibreOffice, notamment Writer et Calc.
Il est impératif que vous cochiez cette option si vous voulez lui lier un formulaire.

 4) Cliquez sur le bouton Terminer et enregistrez la nouvelle base de données en lui donnant un
nom. À la différence des autres documents LibreOffice, les bases de données doivent 
d’abord être enregistrées lorsque vous les créez.

Figure 18.9 : L’assistant Bases de données.

Quand vous avez enregistré la base de données, la fenêtre principale de Base s’affiche (voir Fi-
gure 18.10). Elle comporte trois volets. Le volet de gauche correspond à la base de données et 
comporte les icônes Tables, Requêtes, Formulaires et Rapports.
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L’étape suivante correspond à la création de la table. À nouveau, pour obtenir plus d’informations, 
référez-vous au chapitre 8, Débuter avec Base, du Guide du débutant. Nous allons créer une table
simple pour exemple.

Figure 18.10 : La fenêtre principale de Base.

 1) Dans le volet de gauche, cliquez sur le bouton Tables. Dans les Tâches, faites ensuite un 
double clic sur l’option Créer une table en mode Ébauche…

 2) La fenêtre Ébauche de table s’affiche afin que vous précisiez à Base quels champs vous 
souhaitez créer. Dans cet exemple, nous allons créer trois champs : Nom, Adresse et Télé-
phone.

 3) Sur la première ligne, dans la colonne Nom de champ, saisissez ID. À côté, dans la colonne 
Type de champ, choisissez Integer [INTEGER]. Dans la partie grisée au début de la ligne 
(voir Figure 18.11), faites un clic droit pour ouvrir un menu contextuel. Sélectionnez Clé pri-
maire. Le dessin d’une clé apparaîtra ensuite dans la partie grisée. Dans la partie Propriétés
du champ en bas de la fenêtre, modifiez l’option AutoValeur en Oui. Dans la colonne Des-
cription, saisissez Clé primaire.

! Attention

Configurer la Clé primaire avec une AutoValeur définie sur Oui est primordial. Si ce n’est 
pas le cas, le formulaire que vous créerez plus tard sera plus difficile à utiliser et pourrait 
même générer des erreurs pour l’utilisateur. Assurez-vous de bien configurer la clé primaire !

514 | Guide de LibreOffice Writer Accès aux sources de données



 Chapitre 18 Utiliser les formulaires

Figure 18.11 : Définir une clé primaire.

 4) Sur les trois lignes suivantes, saisissez Nom, Adresse et Téléphone dans la colonne Nom de
champ. Dans la colonne Type de champ, acceptez la valeur par défaut Texte [VARCHAR] et 
laissez la colonne Description vide (Figure 18.12).

 5) Enregistrez la table (via le menu Fichier > Enregistrer). Nommez la table comme vous le 
souhaitez et cliquez sur le bouton OK.

 6) Pour finir, fermez la fenêtre Ébauche de table pour retourner à la fenêtre principale du mo-
dule Base. Si l’option Fichier > Enregistrer est disponible, cliquez dessus pour enregistrer 
toute la base de données.

Figure 18.12 : Ébauche de la table de données.

Accéder à une source de données existante

Si une source de données (que ce soit une base de données ou une feuille de calcul) existe sur 
votre ordinateur, il suffit de le préciser à LibreOffice. Cette procédure s’appelle référencer une 
source de données. Un exemple d’enregistrement d’une feuille de calcul comme source de don-
nées est proposé au Chapitre 14 Le publipostage, page 379. En résumé :
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 1) Cliquez sur le menu Fichier > Nouveau > Base de données pour lancer l’assistant Base de
données.

 2) Sélectionnez l’option Se connecter à une base de données existante et choisissez le type de
base de données dans la liste déroulante (voir Figure 18.13).

 3) Cliquez sur le bouton Suivant >> et suivez les instructions pour sélectionner la base de don-
nées à référencer (la procédure varie en fonction du type de la source de données).

À l’étape trois, enregistrez la base de données et continuez. Veillez à bien cocher l’option Oui, je 
souhaite que la base de données soit référencée. Décochez l’option Ouvrir la base de données 
pour édition ; vous avez juste besoin de référencer la base de données et non l’éditer.

Figure 18.13 : Se connecter à une source de données existantes grâce à l’assistant Bases de
données.

Couper la liaison avec une source de données

Pour enlever une source de données de la liste de celles enregistrées dans LibreOffice de manière
qu’elle ne soit plus disponible, par exemple si elle est obsolète, procédez de la manière suivante :
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 1) Ouvrez la fenêtre des sources de données (Affichage > Sources de données dans la barre
de menu, Ctrl+Maj+F4 sur le clavier ou icône Sources de données ( ) dans la barre 
d’outils Standard).

 2) Faites un clic droit sur la source de données dans le volet gauche, l’explorateur de sources 
de données.

 3) Sélectionnez Bases de données enregistrées… dans le menu contextuel.

 4) Dans la boîte de dialogue Bases de données enregistrées, sélectionnez la source de don-
nées à supprimer de la liste.

 5) Cliquez sur Supprimer et confirmez par Oui dans la boîte de confirmation qui s’ouvre alors.

 6) Répétez les étapes 4 et 5 autant de fois que nécessaire.

 7) Cliquez sur OK pour refermer la boîte de dialogue Bases de données enregistrées.

Le fichier qui contient la base de données n’est pas effacé de votre système et il peut être référen-
cé de nouveau comme indiqué ci-dessous.

Référencer de nouveau une source de données existante

Pour référencer de nouveau un fichier de base de données existant (*.odt), effectuez les actions 
suivantes :

 1) Ouvrez la fenêtre des sources de données (Affichage > Sources de données dans la barre
de menu, Ctrl+Maj+F4 sur le clavier ou icône Sources de données ( ) dans la barre 
d’outils Standard).

 2) Faites un clic droit sur une source de données dans le volet gauche, l’explorateur de sources
de données.

 3) Sélectionnez Bases de données enregistrées… dans le menu contextuel.

 4) Dans la boîte de dialogue Bases de données enregistrées, cliquez sur le bouton Nouveau…

 5) Dans la boîte de dialogue Créer un lien de base de données, cliquez sur Parcourir…, re-
chercher l’emplacement du fichier de base de données et sélectionnez celui-ci. Cliquez sur 
Ouvrir pour revenir à la boîte de dialogue Créer un lien de base de données.

 6) Modifiez éventuellement le Nom enregistré.

 7) Cliquez sur OK pour refermer cette boîte de dialogue puis de nouveau sur OK pour refermer 
la boîte de dialogue Bases de données enregistrées.

Créer un formulaire pour la saisie de données

Une fois votre source de données référencée, la lier à votre formulaire est simple. Suivez la procé-
dure ci-dessous.

 1) Créer un nouveau document texte (Fichier > Nouveau > Document texte).

 2) Concevez votre formulaire sans pour autant y mettre les champs. Vous pourrez bien entendu
le modifier par la suite.

 3) Affichez la barre d’outils Contrôles de formulaire (via le menu Affichage > Barres d’outils > 
Contrôles de formulaire).
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 4) Si nécessaire, cliquez sur le bouton Mode conception ( ) pour activer ce mode sur le do-
cument. S’il est désactivé, la plupart des boutons de la barre d’outils Contrôles de formulaire 
sont grisés, c’est-à-dire inactifs. Si le bouton Mode conception est également grisé, cliquez 
sur le bouton Sélectionner ( ) pour l’activer.

 5) Ajoutez les contrôles à votre formulaire et configurez-les comme décrit précédemment, no-
tamment dans les sections « Insérer un contrôle de formulaire » et « Configurer les 
contrôles ». Ajoutez, par exemple, trois Zones de texte si votre formulaire est destiné à être 
lié à la source de données crée précédemment (page 513).

Maintenant, vous allez lier votre formulaire à une source de données référencée.

 1) Cliquez sur le bouton Formulaire ( ) dans la barre d’outils Contrôles de formulaire, pour 
ouvrir la boîte de dialogue Propriétés du formulaire. Vous pouvez également faire un 
clic droit sur n’importe quel champ inséré dans votre formulaire et sélectionner Formulaire…
dans le menu contextuel.

 2) Dans la boîte de dialogue Propriétés du formulaire, cliquez sur l’onglet Données (Figure 
18.14).

─ Définissez la Source de données : choisissez la source de données dans la liste des 
sources de données référencées.

─ Définissez le Type de contenu : choisissez Table.

─ Définissez le Contenu : choisissez la table à laquelle vous souhaitez accéder.

─ Fermez la boîte de dialogue.

Figure 18.14 : Propriétés du formulaire – Connexion à une source de données

 3) Pour chaque contrôle de formulaire, affichez la boîte de dialogue Propriétés : cliquez sur le 
contrôle pour le sélectionner (de façon à ce que des poignées colorées apparaissent autour),
puis faites un clic droit et sélectionnez Contrôle… dans le menu contextuel ou cliquez sur le 
bouton Contrôle ( ) dans la barre d’outils Contrôles de formulaire.
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 4) Dans la boîte de dialogue Propriétés, cliquez sur l’onglet Données (voir Figure 18.15). Si 
vous avez défini correctement la source de données du formulaire, l’option Champ de don-
nées contiendra une liste des différents champs de la source de données (par exemple : 
Nom, Adresse et Téléphone). Sélectionnez le champ souhaité.

 5) Répétez cette opération pour chaque contrôle jusqu’à ce qu’ils soient tous affectés à un 
champ.

Figure 18.15 : Propriétés d’un contrôle de formulaire – Page données.

Conseil

Si vous avez créé une base de données dans LibreOffice Base et que l’AutoValeur de votre 
clé primaire est définie sur Oui, ce champ n’aura pas besoin de faire partie de votre formu-
laire. Par contre, si elle est définie sur Non, vous devez inclure ce champ dans votre formu-
laire et les utilisateurs devront saisir une valeur unique dans ce champ lorsqu’ils feront une 
nouvelle saisie, ce qui n’est pas recommandé.

Saisir des données dans un formulaire

Une fois que vous avez créé votre formulaire et qu’il a été lié à une base de données, vous pouvez
l’utiliser pour saisir de nouvelles données dans votre source de données ou pour modifier des don-
nées déjà présentes.

 1) Assurez-vous que le mode conception est désactivé. Cliquez sur le bouton Mode concep-
tion ( ) pour désactiver ce mode. S’il est désactivé, la plupart des boutons de la barre 
d’outils Contrôles de formulaire sont grisés, c’est-à-dire inactifs.

 2) Assurez-vous également que la barre d’outils Navigation pour formulaire (voir Figure 18.16) 
est affichée (Affichage > Barres d’outils > Navigation pour formulaire). Par défaut, cette 
barre d’outils apparaît en bas de l’espace de travail.

Figure 18.16 : Barre d’outils Navigation pour formulaire.

 3) Si des données existent dans la source de données, utilisez les boutons de contrôle dans la 
barre d’outils Navigation pour formulaire pour vous déplacer dans les différents enregistre-
ments. Vous pouvez modifier ces enregistrements en éditant les données dans le formulaire.
Pour enregistrer les éventuelles modifications, appuyez sur la touche Entrée de votre cla-
vier lorsque le curseur se trouve dans le dernier champ. Une fois les données enregistrées, 
l’enregistrement suivant s’affiche.
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 4) Si aucune donnée n’existe dans la source de données, vous pouvez commencer à saisir des
informations dans les champs du formulaire. Pour enregistrer des données, appuyez sur la 
touche Entrée de votre clavier lorsque le curseur se trouve dans le dernier champ.

 5) D’autres fonctions peuvent être exécutées à partir de la barre d’outils Navigation pour formu-
laire, y compris la suppression ou l’ajout d’un enregistrement.

Remarque

Si un utilisateur complète le formulaire et que le message d’erreur “Attempt to insert null into
a non-nullable column” s’affiche, le concepteur du formulaire doit vérifier que l’AutoValeur de
la Clé primaire soit bien définie sur Oui. Ce message d’erreur empêche l’utilisateur d’enre-
gistrer des données sujettes aux doublons.

Personnalisation avancée d’un formulaire

Lier une macro à un contrôle de formulaire

Vous pouvez configurer n’importe quel contrôle de formulaire (par exemple une zone de texte ou 
un bouton radio) pour qu’il exécute une action qui sera déclenchée par un événement. Pour visua-
liser la liste complète des événements, double-cliquez sur le contrôle de formulaire lorsque le 
mode conception est activé. La boîte de dialogue Propriétés s’affiche. Cliquez sur l’onglet Événe-
ments.

Figure 18.17 : La boîte de dialogue Propriétés d’un contrôle – Page Événements
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Pour affecter une macro à un événement :

 1) Créez la macro. Pour plus de détails sur la création de macros, référez-vous au chapitre 13, 
Débuter avec les macros, du Guide du débutant.

 2) Assurez-vous que le mode conception est activé. Faites un double clic sur le contrôle de for-
mulaire pour afficher la boîte de dialogue Propriétés. Cliquez sur l’onglet Événements (Figure
18.17).

 3) Cliquez sur le bouton de navigation pour afficher la boîte de dialogue Assigner une action 
(voir Figure 18.18).

 4) Cliquez sur le bouton Macro et sélectionnez la macro dans la boîte de dialogue Sélecteur de
macro. Vous revenez à la boîte de dialogue Assigner une action. Répétez l’opération autant 
de fois que nécessaire, puis cliquez sur le bouton OK pour fermer cette boîte de dialogue.

Figure 18.18 : La boîte de dialogue Assigner une action.

Les macros peuvent également être affectées à des événements relatifs au formulaire dans son 
ensemble. Pour cela, faites un clic droit dans le document, sélectionnez Formulaire… dans le 
menu contextuel et cliquez sur l’onglet Événements.

Documents en lecture seule

Une fois le formulaire créé, il est nécessaire que la personne qui l’utilise puisse accéder aux infor-
mations stockées dans la base de données et/ou qu’elle complète le formulaire sans modifier la 
mise en page. Le document doit donc être en lecture seule. Pour enregistrer le document en lec-
ture seule, cliquez sur le menu Fichier > Propriétés > Sécurité, puis cochez l’option Ouvrir le fi-
chier en lecture seule.

Affiner les permissions d’accès à la base de données

Par défaut, lorsqu’un utilisateur accède à une base de données depuis un formulaire, il peut y ap-
porter n’importe quel changement : des informations peuvent être ajoutées, supprimées ou modi-
fiées. Ce comportement peut ne pas vous convenir : vous pouvez donc faire en sorte que, par 
exemple, l’utilisateur soit uniquement autorisé à ajouter de nouveaux enregistrements et qu’il lui 
soit interdit de supprimer des enregistrements existants.

En mode conception, faites un clic droit sur un contrôle et cliquez sur Formulaire… dans le menu 
contextuel. Différentes options sont disponibles dans la page Données de la boîte de dialogue 
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Propriétés du formulaire (voir Figure 18.19) : autoriser les ajouts, autoriser les suppressions, auto-
riser les modifications et n’ajouter que des données. Choisissez Oui ou Non pour ces options pour 
contrôler les accès que l’utilisateur aura sur la base de données.

Les champs individuels peuvent également être protégés. Cette fonction s’avère utile si vous vou-
lez qu’un utilisateur puisse seulement modifier une partie d’un enregistrement et que le reste lui 
soit présenté en lecture seule (par exemple : une liste de stock où la description des éléments est 
fixe et seule la quantité peut être changée).

Pour mettre un champ individuel en lecture seule, faites un clic droit sur le contrôle de formulaire 
lorsque le document est en mode Ébauche. Cliquez ensuite sur Contrôle… dans le menu contex-
tuel. Cliquez sur l’onglet Général dans la boîte de dialogue et définissez l’option Lecture seule sur 
Oui.

Figure 18.19 : La boîte de dialogue Propriétés du formulaire-Page Données.

Options de formatage d’un contrôle de formulaire

Vous pouvez personnaliser de plusieurs manières, toutes disponibles via le mode conception, l’ap-
parence d’un contrôle de formulaire et la façon dont il se comporte. Faites un clic droit sur un 
contrôle de formulaire, puis cliquez sur Contrôle… dans le menu contextuel. Dans la boîte de dia-
logue Propriétés, choisissez l’onglet Général.

• Définissez une étiquette pour le contrôle dans le champ Étiquettes (à ne pas confondre avec 
le contrôle Champ d’étiquette). Certains contrôles de formulaire, comme les boutons ou les 
boutons radio, ont une étiquette visible qui peut être définie. D’autres contrôles de formulaire,
comme les zones de texte, n’en ont pas.

• Dans le champ Imprimable, définissez si le document est destiné à l’impression.

• Dans le champ Police, définissez la police d’écriture et sa taille pour un champ d’étiquette. 
Cette option n’affecte pas la taille des cases à cocher et des boutons radio.
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• Pour une zone de texte, vous pouvez définir la longueur maximale du texte. Cette fonction 
est très utile lors de l’ajout d’un enregistrement dans une base de données. En effet, chaque 
champ de texte d’une base de données est limité. Si le texte saisi est trop long, LibreOffice 
affiche un message d’erreur. En calquant la longueur maximale d’un contrôle de formulaire 
sur celle d’un champ de texte d’une base de données, vous êtes sûr de ne jamais générer un
message d’erreur.

• Vous pouvez définir les paramètres par défaut d’un contrôle de formulaire. Par défaut, un 
contrôle apparaît vide ou aucune option n’est sélectionnée. Vous pouvez faire en sorte que le
contrôle affiche une option particulière ou qu’un élément de liste soit sélectionné.

• Dans les contrôles de formulaire où un mot de passe doit être saisi, définissez le champ Ca-
ractères pour mot de passe (par exemple sur *) afin que, lorsque l’utilisateur saisira son mot 
de passe, ce sont les caractères choisis qui s’afficheront, mais son mot de passe sera bien 
enregistré.

• Vous pouvez ajouter, dans les champs Complément d’information et Texte d’aide, des infor-
mations supplémentaires ainsi qu’un texte d’aide à un contrôle de formulaire.

• D’autres formatages (comme la couleur d’arrière-plan, l’affichage 3D, le formatage du texte, 
les barres de défilements, les bordures, etc.) permettent d’améliorer l’apparence du contrôle.
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Introduction : Objets OLE

La liaison et incorporation d’objets (Object Linking and Embedding) est une façon d’utiliser les in-
formations d’une application (par exemple Calc) dans une autre (Writer dans notre cas).

La liaison et l’incorporation insèrent toutes les deux des informations d’un document dans un autre,
mais elles les stockent différemment. En supplément, elles différent du copier-coller direct des in-
formations, car il est possible d’ouvrir les objets pour les modifier dans les applications qui les ont 
créées.

Un objet OLE incorporé est une copie des informations provenant d’un autre document. Quand 
des objets sont incorporés, il n’existe pas de lien avec le document source et les modifications ef-
fectuées dans celui-ci ne sont pas reflétées dans le document de destination. Incorporez des ob-
jets si vous désirez pouvoir utiliser l’application qui les a créés pour les modifier mais qu’ils ne 
soient pas mis à jour quand vous éditez les informations dans le document source.

Un objet lié est une référence aux informations contenues dans un autre document. Liez des ob-
jets si vous désirez utiliser les mêmes informations dans plusieurs documents. Ainsi, si vous modi-
fiez l’information d’origine, il vous suffit de mettre à jour les liens pour actualiser les documents qui 
contiennent les objets OLE. Vous pouvez aussi paramétrer les liens pour qu’ils soient actualisés 
automatiquement. Quand vous liez un objet, vous devez assurer l’accès à l’application source et 
au document lié. Si vous renommez ou déplacez l’un des deux, vous devrez peut-être rétablir le la 
liaison.

Les types de fichiers ou de documents peuvent être insérés dans un document Writer en tant 
qu’objets OLE : classeurs, diagrammes, dessins, formules (équations) et présentations.

Insérer un nouvel objet OLE

Quand vous insérez un nouvel objet OLE dans un document, il est incorporé : l’objet n’est dispo-
nible que dans ce document et ne peut être modifié que dans Writer.

Pour insérer un nouvel objet OLE dans un document :

 1) Cliquez où vous souhaitez insérer l’objet.

 2) Sélectionnez Insertion > Objet > Objet OLE… dans la barre de menu.

 3) Dans la boîte de dialogue Insérer un objet OLE (Figure 19.1), cochez l’option Créer un nou-
vel objet.

 4) Choisissez le type d’objet que vous voulez créer et cliquez sur OK.

 5) Un nouvel objet OLE est inséré dans le document en mode d’édition. Les barres d’outils affi-
chées dans Writer changent pour vous offrir les outils dont vous avez besoin pour créer le 
nouvel objet OLE.

Remarque

Les ordinateurs sous le système d’exploitation Windows de Microsoft proposent une option 
supplémentaire, Autres objets, dans la liste Type d’objet. Cette option ouvre une autre boîte
de dialogue où vous pouvez créer un objet OLE en utilisant un autre logiciel qui est compa-
tible avec la norme OLE et LibreOffice. Cette option permet de créer un nouvel objet OLE ou
de le créer à partir d’un fichier.
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Figure 19.1 : Insérer un nouvel objet OLE.

Insérer un objet OLE à partir d’un fichier

Quand vous insérez un fichier existant (par exemple, un classeur) dans un document Writer en 
tant qu’objet OLE, vous pouvez choisir soit de l’incorporer, soit de le lier.

 1) Cliquez où vous souhaitez insérer l’objet et sélectionnez Insertion > Objet > Objet OLE… 
dans la barre de menu.

 2) Dans la boîte de dialogue Insérer un objet OLE, cochez l’option Créer à partir d’un fichier. La
boîte de dialogue change pour offrir les outils nécessaires à la recherche du fichier (Figure 
19.2).

Figure 19.2 : Insérer un objet OLE à partir d’un fichier.

 3) Cliquez sur Rechercher… pour afficher une boîte de dialogue Ouvrir un fichier.

 4) Recherchez le fichier que vous voulez insérer et cliquez sur Ouvrir.

 5) Cochez l’option Lier au fichier si vous souhaitez insérer le fichier en tant que lien actif pour 
que toute modification soit synchronisée à la fois dans le fichier d’origine et votre document.

 6) Cochez l’option Afficher en icône pour voir une icône de l’application qui a créé le fichier (par
exemple, Calc) à la place du contenu du fichier.

 7) Cliquez sur OK pour insérer le fichier en tant qu’objet OLE.

528 | Guide de LibreOffice Writer Introduction : Objets OLE



 Chapitre 19 Classeurs, diagrammes et autres objets

Éditer les objets OLE

Pour éditer un objet OLE après sa création ou son insertion à partir d’un fichier :

 1) Faites un double clic sur l’objet pour le placer en mode édition. Les barres d’outils affichées 
dans Writer changent pour vous offrir les outils dont vous avez besoin pour modifier l’objet 
OLE.

 2) Quand vous avez terminé l’édition, cliquez n’importe où hors de l’objet pour terminer le mode
édition.

 3) Enregistrez le document Writer. Toutes les modifications apportées à l’objet OLE sont enre-
gistrées en même temps.

Classeurs

Pour inclure un classeur dans un document Writer, vous pouvez insérer soit un classeur existant, 
soit un nouveau classeur en tant qu’objet OLE. Voir la section précédente pour plus d’informations.
Vous pouvez aussi copier une partie d’un classeur en tant qu’objet OLE dans un document Writer ;
voir ci-dessous.

Incorporer un classeur dans Writer offre la plupart des fonctionnalités de Calc dans Writer. Vous 
pourrez y réaliser des calculs complexes et des analyses de données. Cependant, si vous pré-
voyez d’utiliser des données ou des formules complexes, il est recommandé de les réaliser dans 
un classeur Calc séparé et de n’utiliser Writer que pour afficher le classeur incorporé avec les ré-
sultats.

Vous pouvez avoir la tentation d’utiliser des classeurs dans Writer pour créer des tableaux com-
plexes ou présenter des données sous forme de tableaux. La fonction tableau de Writer est cepen-
dant souvent préférable et plus rapide à utiliser, selon la complexité de vos données ; voir le Cha-
pitre 13 Travailler avec les tableaux de données, page 345.

Pour copier une zone d’un classeur dans un document Writer :

 1) Ouvrez à la fois le document Writer et le classeur.

 2) Sélectionnez la zone de feuille (les cellules) que vous désirez copier.

 3) Faites un clic droit sur la zone sélectionnée dans le classeur puis choisissez Copier dans le 
menu contextuel ou appuyez sur Ctrl+C. Dans le document Writer, faites un clic droit et 
choisissez Coller dans le menu contextuel ou appuyez sur Ctrl+V. Vous pouvez aussi faire 
glisser la zone sélectionnée du classeur au-dessus du document Writer et l’y déposer.

La zone sélectionnée du classeur est insérée en tant qu’objet OLE dans le document Writer.

Quand un classeur tout entier est inséré dans un document, s’il contient plusieurs feuilles et que 
celle que vous voulez n’est pas visible, faites un double clic sur le classeur puis sélectionnez une 
feuille différente parmi les onglets des feuilles en bas de la zone.

Figure 19.3 : Choix de la feuille visible.
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Déplacer et redimensionner un objet classeur

Quand vous modifiez les dimensions d’un objet classeur ou que vous le déplacez dans Writer, 
ignorez la première ligne et la première colonne (que l’on reconnaît facilement à la légère teinte de
leur arrière-plan) ainsi que les barres de défilement horizontale et verticale. Elles ne sont utilisées 
que pour éditer le classeur et ne sont pas incluses dans celui-ci quand il apparaît dans le docu-
ment.

Changement de dimensions

Quand un objet classeur est sélectionné, il est traité comme n’importe quel autre objet, mais modi-
fier les dimensions d’un classeur incorporé change aussi la zone du classeur qui est visible dans le
document.

Pour changer les dimensions de la zone occupée par le classeur :

 1) Faites un double clic sur l’objet pour entrer en mode d’édition si celui-ci n’est pas déjà actif. 
Notez les poignées de sélection visibles dans la bordure qui entoure l’objet classeur.

 2) Placez le pointeur de la souris sur une de ces poignées. Le pointeur change de forme pour 
donner une représentation visuelle de la modification appliquée à la zone.

 3) Cliquez sur le bouton gauche et maintenez-le enfoncé en tirant la poignée. Les poignées de 
coin déplacent simultanément les deux côtés adjacents tandis que celles situées au milieu 
des côtés ne modifient qu’une dimension à la fois.

Déplacement

Déplacer un objet classeur à l’intérieur du document s’effectue de la même manière que pour tout 
autre objet dans Writer :

 1) Sélectionnez l’objet pour faire apparaître les poignées de sélection.

 2) Placez le pointeur de la souris au-dessus de l’objet jusqu’à ce que ce pointeur change de 
forme (normalement pour une main, mais cela dépend du paramétrage de votre ordinateur). 
Faites bien attention de ne pas faire de double clic sur l’objet classeur qui entrerait alors en 
mode d’édition.

 3) Cliquez et tirez l’objet à la position désirée puis relâchez le bouton de la souris.

Éditer un objet classeur

Pour éditer un objet classeur, faites un double clic sur celui-ci, faites un clic simple sur celui-ci puis 
sélectionnez Édition > Objet > Éditer dans la barre de menu ou faites un clic droit et choisissez 
Éditer dans le menu contextuel.

L’objet est édité dans son propre cadre à l’intérieur du document Writer, mais certaines barres 
d’outils de Writer changent pour faciliter l’édition du classeur. Un des changements les plus impor-
tants est la présence de la barre d’outils Formule qui contient (de gauche à droite) :

Figure 19.4 : la barre de Formule

• La référence de la cellule active ou le nom d’une plage de cellules sélectionnée.

• Le bouton de l’Assistant fonction ( ).
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• Les boutons Somme ( ) et Formule ( ) ou les boutons Annuler ( ) et Accepter ( ), 
selon les actions d’édition effectuées dans le classeur.

• Une longue zone d’édition qui permet de saisir et visualiser le contenu de la cellule active.

Si vous utilisez régulièrement Calc, vous reconnaîtrez immédiatement les outils et les entrées de 
menu. Voyez le chapitre 5, Débuter avec Calc, du Guide du débutant pour plus d’informations.

Organisation du classeur

Un classeur est constitué de pages appelées feuilles. Dans Writer, une seule page peut cependant
être affichée à la fois quand un classeur qui en contient plusieurs est incorporé dans un document 
Writer. Les noms par défaut des feuilles sont Feuille1, Feuille2, Feuille3, et ainsi de suite, sauf si 
elles ont été renommées, et ces noms sont visibles en bas de la zone du classeur (Figure 19.3).

Les feuilles sont organisées en cellules qui sont les unités de base du classeur. Elles sont identi-
fiées par un numéro de ligne (visible sur le bord gauche) et une lettre pour la colonne (visible sur la
ligne du haut). La cellule en haut à gauche est, par exemple, identifiée par A1, tandis que la troi-
sième cellule de la deuxième ligne est C2. Toutes les données élémentaires, qu’elles soient du 
texte, des nombres ou des formules, sont entrées dans une cellule.

Remarque

Si le classeur incorporé comporte plusieurs feuilles, seule la feuille active reste visible quand
vous quittez le mode d’édition.

Travailler avec les feuilles

Il est possible d’insérer, de renommer, de supprimer et d’éditer les feuilles d’un classeur incorporé. 
Commencez par faire un double clic sur celui-ci pour l’ouvrir en mode d’édition. Une fois l’édition 
terminée, cliquez quelque part hors de la bordure du classeur pour achever le mode d’édition et 
enregistrer les modifications.

Insérer des feuilles

• Cliquez sur le signe + à la gauche des noms des feuilles. La nouvelle feuille est insérée en 
fin de liste.

• Utilisez la boîte de dialogue Insérer une feuille :

 a) Faites un clic droit sur le nom d’une feuille et choisissez Insérer une feuille… dans le 
menu contextuel ou sélectionnez Feuille > Insérer une feuille… dans la barre de menu.

 b) Dans la boîte de dialogue Insérer une feuille, choisissez la position et le nom de la nou-
velle feuille ainsi que le nombre de feuilles à insérer. Vous pouvez aussi sélectionner un 
classeur existant et y choisir les feuilles à importer.

 c) Cliquez sur OK pour fermer la boîte de dialogue et insérer les feuilles.

Renommer des feuilles

 1) Faites un clic droit sur l’onglet de la feuille que vous voulez renommer et sélectionnez Re-
nommer la feuille… dans le menu contextuel ou choisissez Feuille > Renommer la 
feuille… dans la barre de menu.

 2) Saisissez le nouveau nom dans la boîte de dialogue Renommer la feuille puis cliquez sur 
OK.
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Déplacer et copier des feuilles

• Cliquez sur l’onglet de la feuille et tirez-le à sa nouvelle position dans le classeur incorporé.

• Utilisez la boîte de dialogue Déplacer/Copier la feuille :

 a) Faites un clic droit sur le nom de la feuille et choisissez Déplacer/Copier la feuille… 
dans le menu contextuel ou sélectionnez Feuille > Déplacer/Copier la feuille… dans la 
barre de menu.

 b) Dans la boîte de dialogue Déplacer/copier la feuille, choisissez si vous désirez déplacer 
ou copier la feuille, l’emplacement de la feuille et sa position ainsi que son nouveau nom 
éventuel.

 c) Cliquez sur OK pour fermer la boîte de dialogue et effectuer le déplacement ou la copie.

Supprimer des feuilles

 1) Faites un clic droit sur l’onglet de la feuille que vous voulez supprimer et sélectionnez Sup-
primer des feuilles… dans le menu contextuel ou choisissez Feuille > Supprimer des 
feuilles… dans la barre de menu.

 2) Cliquez sur Oui pour confirmer.

Naviguer dans les cellules

Pour vous déplacer dans le classeur pour sélectionner une cellule à activer, vous pouvez :

• utiliser les touches fléchées du clavier ;

• placer le pointeur de la souris dans une cellule et faire un clic gauche ;

• utiliser la touche Entrée pour descendre d’une cellule et Maj+Entrée pour monter d’une 
cellule ;

• utiliser la touche Tabulation pour vous déplacer d’une cellule vers la droite et 
Maj+Tabulation pour vous déplacer d’une cellule vers la gauche ;

• utiliser d’autres raccourcis au clavier.

Saisir des données

La saisie de données dans une cellule n’est possible que si celle-ci est active, ce qu’indique une 
bordure noire plus épaisse. La référence (ou les coordonnées) de la cellule active est affichée à 
l’extrémité gauche de la barre d’outils Formule (Figure 19.4).

 1) Sélectionnez la cellule pour la rendre active et commencez la saisie. Ce que vous tapez s’af-
fiche aussi dans le long champ de saisie de la barre d’outils Formule ce qui en rend la lec-
ture plus facile.

 2) Utilisez les boutons Assistant fonction ( ), Somme ( ) et Formule ( ) pour saisir des 
données, formules ou fonctions dans la cellule. Si ce que vous tapez n’est pas une formule 
(par exemple, un texte ou une date), les boutons Somme et Fonction sont remplacés par les 
boutons Annuler ( ) et Accepter ( ).

 3) Pour confirmer la saisie dans la cellule, vous pouvez sélectionner une autre cellule, appuyer 
sur la touche Entrée ou cliquer sur le bouton Accepter.
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Formater les données d’une cellule

Normalement, Writer reconnaît le type de contenu (texte, nombre, date, heure, etc.) saisi dans une
cellule et lui applique un formatage par défaut. Si Writer reconnaît mal le type de données que 
vous avez tapées dans une cellule :

 1) Sélectionnez les cellules à formater et faites un clic droit dans celles-ci (un clic droit suffit s’il 
n’y a qu’une cellule) et choisissez Formater des cellules… dans le menu contextuel ou For-
mat > Cellules… dans la barre de menu. Vous pouvez aussi utiliser le raccourci clavier 
Ctrl+1.

 2) Dans la boîte de dialogue Formatage des cellules, ouvrez l’onglet approprié dont vous utili-
serez les options pour mettre en forme les données de la cellule.

 3) Cliquez sur OK pour fermer la boîte de dialogue et enregistrer vos modifications.

Conseil

Pour obliger Writer à traiter des nombres comme du texte (un numéro de téléphone, par 
exemple) et éviter qu’il supprime les zéros de tête ou aligne le nombre à droite dans la cel-
lule, tapez une apostrophe (‘) avant de saisir le nombre.

Formater les classeurs

Il peut s’avérer nécessaire de modifier le formatage d’un classeur pour le faire correspondre au 
style utilisé dans le document.

Pendant le travail sur un classeur incorporé, vous avez accès à tous les styles de cellule créés 
dans Calc et vous pouvez les utiliser. Cependant, si vous prévoyez d’utiliser des styles, il est re-
commandé de créer des styles spécifiques aux classeurs incorporés, car ceux de Calc peuvent ne 
pas convenir au travail dans Writer.

Mise en forme manuelle

Pour formater manuellement un classeur incorporé :

 1) Sélectionnez une cellule ou une plage de cellules. Voir le chapitre 5, Débuter avec Calc du 
Guide du débutant, pour plus d’information sur la sélection d’une plage de cellules.

─ Pour sélectionner toute la feuille, cliquez sur la cellule vide dans le coin supérieur gauche,
entre la ligne et la colonne numérotées, ou appuyez sur les touches Ctrl+A.

─ Pour sélectionner une colonne, cliquez sur l’en-tête de la colonne en haut du classeur.

─ Pour sélectionner une ligne, cliquez sur l’en-tête de la ligne à l’extrémité gauche du clas-
seur.

 2) Faites un clic droit dans une cellule et choisissez Formater des cellules… dans le menu 
contextuel ou Format > Cellules… dans la barre de menu. Vous pouvez aussi utiliser le rac-
courci clavier Ctrl+1.

 3) Dans la boîte de dialogue Formatage des cellules, utilisez les diverses pages pour mettre en 
forme les données de la cellule et les adapter au style de votre document.

 4) Cliquez sur OK pour fermer la boîte de dialogue et enregistrer vos modifications.
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 5) Si nécessaire, ajustez la largeur de la colonne en plaçant le pointeur de la souris au-dessus 
de la ligne de séparation entre les colonnes dans la ligne d’en-tête (il se change en double 
flèche horizontale quand vous êtes au bon endroit), enfoncez le bouton gauche et tirez la 
ligne de séparation à son nouvel emplacement.

 6) Quand vous avez terminé les changements de mise en forme, cliquez hors de la zone du 
classeur pour enregistrer les modifications et quitter le mode d’édition.

Utiliser les styles de formatage

Quand un classeur incorporé est en mode d’édition, Writer affiche les styles disponibles pour un 
classeur dans l’onglet Styles et formatage.

Si le style que vous désirez utiliser ne s’y trouve pas, reportez-vous au Chapitre 8 Introduction aux 
styles, page 201, pour voir comment créer un style. Les styles utilisés dans un classeur incorporé 
sont semblables aux styles de paragraphe utilisés dans Writer.

Pour utiliser des styles dans votre classeur incorporé :

 1) Ouvrez l’onglet Styles et formatage dans le volet latéral (menu Affichage > Styles et forma-
tage ou touche F11).

 2) Sélectionnez les données d’une cellule et faites un double clic sur un style dans la fenêtre 
Styles et formatage pour appliquer ce style.

Insérer ou supprimer des lignes, des colonnes ou des cellules

Pour insérer des lignes, des colonnes ou des cellules dans un classeur incorporé :

 1) Sélectionnez autant de lignes, de colonnes ou de cellules que vous désirez en insérer.

 2) Choisissez Feuille > Insérer des lignes > Lignes au-dessus ou Lignes en dessous, 
Feuille > Insérer des colonnes > Colonnes à gauche ou Colonnes à droite ou Feuille > 
Insérer des cellules… dans la barre de menu. Vous pouvez aussi faire un clic droit sur la 
sélection et choisir Insérer… dans le menu contextuel.

 3) Pour insérer des cellules, faites votre choix parmi les options de la boîte de dialogue Insérer 
des cellules puis cliquez sur OK.

Pour supprimer des lignes, des colonnes ou des cellules d’un classeur incorporé :

 1) Sélectionnez les lignes, colonnes ou cellules que vous désirez supprimer.

 2) Choisissez Feuille > Supprimer des lignes, Feuille > Supprimer des colonnes ou Feuille
> Supprimer des cellules… dans la barre de menu. Vous pouvez aussi faire un clic droit sur
la sélection et choisir Supprimer… dans le menu contextuel.

 3) Pour supprimer des cellules, faites votre choix parmi les options de la boîte de dialogue Sup-
primer des cellules puis cliquez sur OK.

Fusionner et scinder des cellules

Pour fusionner plusieurs cellules en une cellule unique :

 1) Sélectionnez les cellules à fusionner.

 2) Choisissez Format > Fusionner les cellules dans la barre de menu, puis Fusionner et 
centrer les cellules ou Fusionner les cellules.
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Vous pouvez aussi faire un clic droit sur les cellules sélectionnées et choisir Fusionner les 
cellules dans le menu contextuel.

Pour scinder un groupe de cellules qui ont été fusionnées en une cellule unique :

 1) Sélectionnez la cellule qui contient les cellules fusionnées.

 2) Choisissez Format > Fusionner les cellules > Scinder les cellules dans la barre de menu.
Vous pouvez aussi faire un clic droit sur les cellules sélectionnées et choisir Scinder les cel-
lules dans le menu contextuel.

Diagrammes

Un diagramme est une représentation graphique des informations contenues dans un classeur. 
Plus d’informations sur les diagrammes et leur utilisation sont données dans le Guide Calc.

Insérer un diagramme

Vous pouvez insérer un diagramme en tant qu’objet OLE dans votre document (voir page 527) ou 
utiliser les outils fournis par Writer.

Pour ajouter un diagramme en utilisant les outils de Writer, sélectionnez Insertion > Dia-
gramme… dans la barre de menu pour insérer un diagramme générique (Figure 19.5) à l’empla-
cement du curseur. Le diagramme est sélectionné et la barre de menu et les barres d’outils sont 
remplacées par celles qui conviennent aux diagrammes.

Figure 19.5 : Diagramme sélectionné avec des données d’exemple.

Sélectionner le type de diagramme

Vos données peuvent être représentées par une grande variété de diagrammes. Writer offre plu-
sieurs types de diagrammes qui vous aideront à faire passer votre message auprès de vos lec-
teurs. Voir « Types de diagrammes » ci-dessous.

 1) Assurez-vous que le diagramme est sélectionné : dans ce cas, il possède une bordure et des
poignées de sélection (Figure 19.5).
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 2) Cliquez sur le bouton Type de diagramme ( ) dans la barre d’outils Formatage ou sélec-
tionnez Format > Type de diagramme… dans la barre de menu ou Type de diagramme… 
dans le menu contextuel pour ouvrir la boîte de dialogue Type de diagramme (Figure 19.6).

Figure 19.6 : La boîte de dialogue Type de diagramme montrant un diagramme à deux
dimensions.

 3) Quand vous modifiez votre choix dans la liste de gauche, les exemples de diagrammes 
changent du côté droit. Déplacez la boîte de dialogue sur le côté pour voir l’effet dans le dia-
gramme.

 4) Quand vous changez de type de diagramme, de nouvelles options deviennent disponibles du
côté droit. Certains diagrammes, par exemple, possèdent des variantes en 2 et en 3 dimen-
sions. Quand le diagramme 3D est sélectionné, des options supplémentaires deviennent ac-
cessibles pour choisir la forme des colonnes ou des barres.

 5) Définissez les caractéristiques de votre diagramme puis cliquez sur OK pour revenir à la fe-
nêtre d’édition.

Poursuivez la mise en forme du diagramme et l’ajout de données ou cliquez hors de celui-ci pour 
retrouver la vue normale.

Types de diagrammes

Voici un résumé des types de diagrammes disponibles pour vous aider à choisir celui qui convien-
dra à vos données. Les diagrammes en colonnes, barres, secteurs et zones existent en 2 et 3 di-
mensions.

Diagrammes en colonnes

Les diagrammes en colonnes montrent les tendances, en particulier chronologiques, dans 
les variations des données qu’ils affichent. C’est le type de diagramme par défaut. Il est re-
commandé de les utiliser lorsqu’il y a un nombre relativement faible de points de données. Si
vous disposez de grandes séries de données, il est recommandé d’utiliser un diagramme en 
ligne.
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Diagrammes en barres

Les diagrammes en barres offrent un impact visuel immédiat pour comparer des données où 
le temps n’intervient pas, par exemple la popularité de produits sur un marché.

Diagrammes en secteurs

Les diagrammes en secteurs permettent de comparer les proportions, par exemple les dé-
penses consacrées par différents services à différents sujets ou leurs dépenses effectives to-
tales. Ils sont plus efficaces si le nombre de valeurs reste faible, six ou moins, par exemple. 
Au-delà, l’impact visuel d’un diagramme en secteur tend à s’estomper.

Diagrammes en zones

Les diagrammes en zones sont des variantes des diagrammes en lignes ou en colonnes. Ils 
sont utiles pour mettre l’accent sur la quantité de variation. Les diagrammes en zones ont un 
impact visuel plus grand que les diagrammes en lignes, mais c’est le type de données utili-
sées qui fait la vraie différence dans celui-ci.

Diagrammes en lignes

Les diagrammes en lignes permettent de représenter des suites chronologiques de données 
avec leur progression. Ils sont parfaits pour les données brutes et utiles pour montrer les ten-
dances et les changements dans le temps quand vous voulez mettre l’accent sur la continui-
té. Dans les diagrammes en lignes, l’axe des X est idéal pour représenter les suites de don-
nées temporelles. Évitez les lignes en 3D qui rendent le diagramme confus et préférez des 
lignes plus épaisses pour améliorer l’impact visuel.

Diagrammes XY (dispersion)

Les diagrammes de dispersion sont parfaits pour visualiser des données que vous n’avez 
pas eu le temps d’analyser et peuvent être les meilleurs si vous avez une valeur de compa-
raison constante, par exemple les données météorologiques, des réactions à différents pH, 
des mesures selon l’altitude ou toutes données qui font correspondre deux suites numé-
riques. L’axe des X correspond normalement à la variable indépendante ou au paramètre de 
contrôle (souvent une série temporelle).

Diagrammes en bulles

Les diagrammes en bulles permettent de représenter trois variables. Deux d’entre elles défi-
nissent la position du centre de la bulle dans un repère cartésien, tandis que la troisième est 
représentée par son rayon.

Diagrammes en toile d’araignée

Les diagrammes en toile sont semblables aux diagrammes polaires ou en radar. Ils sont 
utiles pour comparer des données qui ne sont pas en suites chronologiques mais qui font 
état de circonstances différentes, telles que des variables dans une expérience scientifique. 
Les rayons de la toile sont les axes Y des autres diagrammes. Ils donnent leur meilleur effet 
avec de trois à huit axes, et deviennent confus au-delà de huit.

Diagrammes de cours

Les diagrammes de cours sont des diagrammes en colonnes utilisés spécifiquement pour les
actions cotées en bourse. Vous avez le choix entre des lignes traditionnelles, des bâtons et 
des diagrammes à deux colonnes. Les données nécessaires à ces diagrammes sont une 
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suite de valeur d’ouverture, de valeur de clôture et de valeur au plus haut et au plus bas. 
L’axe des X représente une série chronologique.

Diagrammes en colonnes et en lignes

Il s’agit d’une combinaison de deux autres types de diagrammes, utile pour représenter deux 
suites de données distinctes mais reliées, par exemple les ventes au cours du temps (en co-
lonnes) et le taux marginal de profit (en lignes).

Saisir les données d’un diagramme

 1) Assurez-vous que le diagramme est sélectionné et que vous avez choisi le type de dia-
gramme.

 2) Cliquez sur le bouton Table de données ( ), sélectionnez Affichage > Table de don-
nées… dans la barre de menu ou faites un clic droit sur le diagramme et sélectionnez 
Tables de données… dans le menu contextuel pour ouvrir la boîte de dialogue Table de 
données.

 3) Saisissez ou collez les informations dans les cellules des colonnes et lignes voulues de la 
boîte de dialogue. Vous pouvez utiliser les boutons situés en haut à gauche de celle-ci pour 
insérer, supprimer ou déplacer les données.

Figure 19.7 : La boîte de dialogue Table de données des diagrammes.

Ajouter ou supprimer des éléments au diagramme

Le diagramme inséré dans un document comporte deux éléments : le diagramme proprement dit 
et la légende. Vous pouvez ajouter des éléments à un diagramme ou en enlever de la manière sui-
vante :

 1) Assurez-vous que le diagramme est sélectionné et en mode d’édition.

 2) Cliquez sur Insertion dans la barre de menu et choisissez dans la liste déroulante l’élément 
que vous désirez ajouter au diagramme. Vous pouvez aussi faire un clic droit sur le fond ou 
un élément du diagramme et choisir ce que vous voulez ajouter dans le menu contextuel. Le 
choix d’un élément ouvre une boîte de dialogue où vous pouvez en préciser les options.
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Remarque

Un clic droit sur le diagramme vous offrira plus de choix pour lui ajouter des éléments. Le 
nombre de possibilités d’insertion disponibles dans le menu contextuel dépend du type 
d’élément sur lequel vous avez cliqué.

 3) Pour supprimer un élément du diagramme,

─ faites un clic droit sur l’élément à supprimer et choisissez Supprimer dans le menu 
contextuel ; les possibilités de suppression dépendent de l’élément sur lequel vous avez 
cliqué,

─ sélectionnez l’élément à supprimer puis appuyez sur la touche Suppr ou Retour 
arrière pour l’enlever du diagramme.

Formater le diagramme

Pour modifier la mise en forme d’un diagramme :

 1) Assurez-vous que le diagramme est sélectionné et en mode d’édition.

 2) Cliquez sur Format dans la barre de menu et choisissez l’élément que vous désirez formater
dans la liste déroulante. Vous pouvez aussi faire un clic droit sur un élément du diagramme 
et choisir ce que vous voulez formater dans le menu contextuel. Le choix d’un élément ouvre
une boîte de dialogue où vous pouvez préciser les options de mise en forme.

Les options de formatage disponibles varient avec la sélection du diagramme entier ou de l’élé-
ment choisi.

Redimensionner et déplacer les diagrammes

Vous pouvez modifier les dimensions ou l’emplacement d’un diagramme de manière interactive, de
la même manière que pour tout objet inséré dans un document Writer :

 1) Cliquez une seule fois sur le diagramme pour le sélectionner. Des poignées de sélection co-
lorées apparaissent autour de celui-ci.

 2) Procédez de la façon suivante.

─ Pour augmenter ou diminuer la hauteur du diagramme, cliquez et tirez une poignée de sé-
lection au milieu des côtés horizontaux.

─ Pour augmenter ou diminuer la largeur du diagramme, cliquez et tirez une poignée de sé-
lection au milieu des côtés verticaux.

─ Pour modifier simultanément les deux dimensions, cliquez et tirez une poignée de sélec-
tion dans un coin du diagramme. Pour conserver le rapport d’aspect (rapport hauteur/lar-
geur), maintenez la touche Maj enfoncée pendant le mouvement.

─ Pour déplacer le diagramme, placez le pointeur de la souris sur le diagramme, hors des 
poignées de sélection. Quand le pointeur change de forme, cliquez et tirez le diagramme 
à son nouvel emplacement, puis relâchez le bouton quand celui-ci est atteint.

Comme pour les autres objets, vous pouvez utiliser la boîte de dialogue Propriétés du diagramme 
(Format > Cadre et objet > Propriétés… dans la barre de menu ou Propriétés… dans le menu 
contextuel) pour modifier l’emplacement, l’ancrage et les dimensions du diagramme. Veuillez vous 
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reporter à la section Changer la position, la taille et les attributs d’un cadre au Chapitre 6 Mise
en page : approfondissements, page 149, pour plus d’information sur cette boîte de dialogue.

Remarque

Si le diagramme est en mode d’édition (bordure noire épaisse), ne cliquez que sur la bor-
dure pour déplacer le diagramme. Si vous cliquez sur un de ses éléments, c’est celui-ci qui 
sera déplacé.

Éléments du diagramme

Vous pouvez déplacer et redimensionner les éléments d’un diagramme indépendamment les uns 
des autres. Il est, par exemple, possible de déplacer la légende à une position différente. Les dia-
grammes en secteur permettent de déplacer chaque secteur mais aussi de faire « exploser » l’en-
semble du graphique.

 1) Faites un double clic sur le diagramme pour le mettre en mode d’édition.

 2) Cliquez sur un élément du diagramme pour le sélectionner. Des poignées de sélection appa-
raissent.

 3) Procédez avec l’élément comme pour redimensionner ou déplacer le diagramme entier (voir 
ci-dessus).

Remarque

Si le diagramme est en 3D, des poignées en forme de losanges rouges peuvent apparaître 
autour de la paroi du diagramme pour en contrôler l’aspect tridimensionnel. On ne peut pas 
redimensionner ni déplacer le diagramme avec celles-ci. Pour faire cela, cliquez de nouveau
sur le diagramme pour obtenir les poignées carrées vertes et opérez comme indiqué ci-des-
sus.

Vous pouvez aussi utiliser la boîte de dialogue Position et taille ( Format > Position et taille dans 
la barre de menu ou Position et taille dans le menu contextuel après un clic droit). Pour plus d’in-
formations sur l’utilisation de la boîte de dialogue Position et taille, veuillez vous reporter au Cha-
pitre 11 Images et objets graphiques, page 285 et suivantes.

Remarque

Il n’est pas possible de modifier les dimensions d’un titre qui dépendent de la taille de la po-
lice utilisée pour l’afficher. La méthode interactive comme la boîte de dialogue Position et 
taille ne permettent que d’en changer la position.

Modifier l’arrière-plan de la zone du diagramme

La zone du diagramme est la zone qui entoure le diagramme proprement dit et contient aussi le 
titre et la légende.

 1) Faites un double clic sur le diagramme pour le mettre en mode d’édition.

 2) Ouvrez la boîte de dialogue Zone du diagramme par l’un des moyens suivants :

─ choisissez Format > Arrière-plan du diagramme… dans la barre de menu ;
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─ faites un clic droit dans la zone du diagramme et choisissez Formater la zone du dia-
gramme… dans le menu contextuel ;

─ faites un double clic dans la zone du diagramme.

 3) Ouvrez l’onglet Zone et choisissez le type de remplissage de l’arrière-plan que vous souhai-
tez. Les options disponibles dépendent du choix que vous avez fait.

 4) Quand vous avez terminé, cliquez sur OK pour fermer la boîte de dialogue et enregistrer les 
modifications.

Remarque

Vous pouvez aussi modifier l’arrière-plan du cadre qui contient le diagramme dans la boîte 
de dialogue Propriétés. Sauf effets spéciaux, il vaut mieux éviter de le faire.

Modifier l’arrière-plan de la paroi du diagramme

La paroi du diagramme est la zone qui contient le diagramme proprement dit.

 1) Faites un double clic sur le diagramme pour le mettre en mode d’édition.

 2) Ouvrez la boîte de dialogue Paroi du diagramme par l’un des moyens suivants :

─ sélectionnez la paroi du diagramme puis choisissez Format > Formater la sélection… 
dans la barre de menu ;

─ faites un clic droit dans la zone du diagramme et choisissez Formater la paroi… dans le 
menu contextuel ;

─ faites un double clic dans la paroi du diagramme.

 3) Ouvrez l’onglet Zone et choisissez le type de remplissage de l’arrière-plan que vous souhai-
tez. Les options disponibles dépendent du choix que vous avez fait.

 4) Quand vous avez terminé, cliquez sur OK pour fermer la boîte de dialogue et enregistrer les 
modifications.

Audio et vidéo

Bien que lier des fichiers audio ou vidéo à un document Writer ne présente pas d’intérêt si celui-ci 
est imprimé, s’il est ouvert sur un ordinateur ou exporté en PDF ou en HTML, vous pouvez exécu-
ter ces fichiers en cliquant sur leurs liens.

Utiliser des fichiers multimédias

Pour insérer un fichier multimédia dans votre document :

 1) Sélectionnez Insertion > Média > Son ou vidéo… dans la barre de menu pour ouvrir la 
boîte de dialogue Insérer un son ou une vidéo.

 2) Choisissez le fichier à insérer et cliquez sur Ouvrir pour placer l’objet dans le document.
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Conseil

Pour voir une liste des types de fichiers audio et vidéo admis par Writer, déroulez la liste des
types de fichiers (à droite du champ de saisie du nom de fichier) qui indique par défaut Tous
les fichiers son et vidéo ce qui vous permet de choisir aussi un type de fichier non soutenu 
tel que .mov.

Writer ne fait que lier les fichiers multimédias sans les incorporer dans le document. Donc, si le do-
cument est déplacé sur un autre ordinateur, tous les liens seront rompus et les fichiers multimédias
ne seront pas exécutés. Pour éviter cela :

 1) Placez tous les fichiers multimédias dans le même dossier que le document dans lequel ils 
sont inclus.

 2) Insérez le fichier multimédia dans le document.

 3) Envoyez en même temps le document et tous les fichiers multimédias à l’ordinateur qui va 
être utilisé pour le document et placez-les dans le même dossier sur cet ordinateur.

Utiliser la Galerie

Pour insérer des clips multimédia directement depuis la galerie :

 1) Ouvrez la galerie dans le volet latéral ( ).

 2) Recherchez un thème qui contient des fichiers multimédias (par exemple, Sons).

 3) Cliquez sur le film ou le son à insérer, faites-le glisser et déposez-le sur le document.

Lecture de fichiers multimédias

La barre d’outils Lecture de média s’ouvre automatiquement quand un fichier son ou vidéo est sé-
lectionné. Par défaut, elle se place en bas de l’espace de travail, juste au-dessus de la barre d’ou-
tils Dessin, mais elle peut être rendue flottante et placée à n’importe quel endroit. Si elle ne s’ouvre
pas, sélectionnez Affichage > Barres d’outils > Lecture de média dans la barre de menu.

La barre d’outils Lecture de média contient les outils suivants.

• Insérer un son ou une vidéo qui ouvre la boîte de dialogue de même nom.

• Lire, pause, arrêter qui contrôlent la lecture du fichier multimédia.

• Répéter qui fait continuellement répéter la lecture du fichier jusqu’à ce que l’option soit déco-
chée.

• Le curseur de lecture qui sélectionne la position de début de lecture à l’intérieur du fichier 
multimédia.

• Le chronomètre qui affiche la position courante dans le fichier multimédia et sa durée totale.

• Le bouton Silencieux qui coupe le son quand il est sélectionné.

• Le curseur de volume qui permet d’ajuster le niveau de son du média.

• Le chemin du média qui précise l’emplacement du fichier dans l’ordinateur.

• Le menu déroulant de redimensionnement, uniquement pour les vidéos, qui permet de modi-
fier les dimensions du film.

542 | Guide de LibreOffice Writer Audio et vidéo



 Chapitre 19 Classeurs, diagrammes et autres objets

Formules

Sélectionnez Insertion > Objet > Formule dans la barre de menu pour créer une formule (une 
équation). Une formule peut aussi être insérée en tant qu’objet OLE, voir page 527 pour plus d’in-
formations.

Pendant la création ou l’édition d’une formule, le menu Math devient accessible.

Quand vous créez une formule, faites attention aux tailles des polices utilisées et vérifiez qu’elles 
correspondent à celle de la police utilisée pour le texte du document. Pour modifier un attribut 
d’une police d’un objet Math, sélectionnez Format > Taille de police… dans la barre de menu ; 
pour modifier le type de police, choisissez Format > Polices…

Pour toute information sur la création de formules, veuillez vous reporter au Guide Math ou au cha-
pitre 9, Débuter avec Math du Guide du débutant.
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Chapitre 20
Paramétrer Writer
Choisir les options adaptées à votre façon de travailler





Introduction

Ce chapitre présente brièvement certaines options de paramétrage accessibles en sélectionnant 
Outils > Options dans la barre de menu. D’autres options ainsi que des détails supplémentaires 
sur celles présentées ici se trouvent dans l’Aide et dans le chapitre 2, Configurer LibreOffice du 
Guide du débutant.

Plusieurs options parmi les plus importantes sont présentées dans d’autres chapitres de ce livre, 
dans le contexte des tâches où elles s’appliquent.

Conseil

De nombreuses options concernent les utilisateurs avertis et les programmeurs. Si vous ne 
comprenez pas l’effet qu’une option produit, conservez les paramètres par défaut sauf si ce 
livre vous recommande de les modifier.

Choix des options qui affectent tous les modules de 
LibreOffice

Cette section reprend certains des paramètres qui s’appliquent à tous les modules de LibreOffice 
(Writer, Calc, Impress, Draw, Math et Base). Ils sont particulièrement importants dans l’utilisation 
de Writer.

Cliquez sur le menu Outils > Options. Une boîte de dialogue s’affiche. La liste à gauche de la 
boîte de dialogue Options – LibreOffice varie en fonction du module de LibreOffice ouvert.

Faites un double clic sur la section LibreOffice ou cliquez sur le symbole (un signe + ou un tri-
angle) à gauche de celle-ci. Une liste de pages se déroule. Cliquez sur l’une de ces pages pour af-
ficher les options correspondantes dans la partie droite de la boîte de dialogue.

Remarque

Le bouton Rétablir (situé en bas à droite de la boîte de dialogue Options) a le même effet 
sur toutes les pages de la boîte de dialogue Options. Il restaure les valeurs par défaut.

Données d’identité

Writer utilise les renseignements stockés dans la page LibreOffice – Données d’identité pour plu-
sieurs usages : les propriétés du document (les informations « créé par » et « édité par »), le nom 
de l’auteur des notes et des modifications, etc. Vous souhaiterez donc vous assurer que les don-
nées encodées à cet endroit sont correctes.

Affichage

Les options de la page LibreOffice – Affichage affectent l’apparence de la fenêtre du document et 
la façon dont elle se comporte. Configurez-les afin qu’elles correspondent à vos préférences. Vous
trouverez des détails supplémentaires dans l’Aide et dans le chapitre 2, Configurer LibreOffice du 
Guide du débutant.
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Impression

Dans la page LibreOffice – Impression (voir Figure 20.1), définissez les options d’impression qui 
correspondent à votre imprimante par défaut et à vos habitudes d’impression.

Figure 20.1 : Options générales d’impression applicables à tous les modules de LibreOffice.

Dans la section Avertissements d’impression située en bas de la fenêtre, choisissez si vous 
souhaitez être averti lorsque la taille et l’orientation spécifiées dans votre document ne corres-
pondent pas à la taille ou à l’orientation disponible pour votre imprimante. Le fait d’activer ces aver-
tissements peut s’avérer pratique si vous travaillez avec des documents créés par des personnes 
d’autres pays où les standards de taille sont différents des vôtres.

Conseil

Si vos impressions sont mal placées sur la page ou coupées en haut, en bas, sur les côtés, 
ou encore si l’imprimante refuse d’imprimer, la cause la plus probable est une incompatibilité
de taille de la page.

Chemins

Dans la page LibreOffice – Chemins, vous pouvez modifier les emplacements des fichiers asso-
ciés à LibreOffice ou utilisés par celui-ci afin qu’ils correspondent à votre façon de travailler. Par 
exemple, sous un système d’exploitation Windows, vous pouvez souhaiter stocker par défaut les 
documents ailleurs que dans Mes documents.

Certains éléments peuvent avoir au moins deux chemins de listes : l’un vers un répertoire partagé 
(qui peut être sur un réseau) et un vers le répertoire de l’utilisateur (normalement sur l’ordinateur 
de l’utilisateur).

Astuce

Vous pouvez utiliser les entrées de la boîte de dialogue LibreOffice – Chemins pour compiler
une liste de fichiers, tels que ceux contenant les AutoTextes que vous devez sauvegarder ou
copier vers un autre ordinateur.
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Polices

Si vous recevez un document qui contient des polices qui ne sont pas installées sur votre ordina-
teur, LibreOffice utilisera des polices de substitution à la place de celles qu’il ne trouve pas. Dans 
la page LibreOffice – Polices, vous pouvez spécifier une police différente de celle choisie par le 
programme.

Conseil

Les polices de la famille Liberation (Serif, Sans et Mono) peuvent souvent remplacer conve-
nablement les polices Times, Arial et Courier.

Remarque

Ces choix n’affectent pas la police par défaut de vos documents. Pour cela, vous devez 
créer un nouveau modèle de document Writer comme décrit au Chapitre 10 Travailler avec 
les modèles, page 266.

Sécurité

La page LibreOffice – Sécurité permet de choisir les options de sécurité lors de l’enregistrement 
des documents ou lors de l’ouverture de documents qui contiennent des macros. Si vous avec be-
soin d’informations sur les options qui ne sont pas présentées ici, veuillez vous reporter à l’Aide ou
au Guide du débutant.

Options et avertissements de sécurité

Si vous enregistrez des modifications, enregistrez de multiples versions ou incluez des infor-
mations masquées ou encore des notes dans vos documents, et que vous ne souhaitez pas 
que certains des destinataires voient ces informations, vous pouvez déterminer des avertis-
sements pour vous rappeler de les supprimer ou demander à LibreOffice de les supprimer 
automatiquement. Notez que, sauf si les informations sont supprimées, la plus grande partie 
est conservée, même quand le fichier a été enregistré sous d’autres formats, y compris PDF.

Cliquez sur le bouton Options pour ouvrir une boîte de dialogue séparée contenant des choix spé-
cifiques. Hormis les deux fonctions abordées ci-après, les autres options de la boîte de dialogue 
Options et avertissements de sécurité s’expliquent d’elles-mêmes.

Supprimer les informations personnelles lors de l’enregistrement.

Cochez cette option pour supprimer systématiquement les données d’identité des propriétés 
du fichier lors de l’enregistrement du document. Pour supprimer manuellement des données 
d’identité d’un document spécifique, décochez cette option et utilisez le bouton Supprimer 
dans la boîte de dialogue Fichier > Propriétés > Général.

Cliquer + touche Ctrl pour activer les hyperliens.

Le comportement par défaut de LibreOffice est d’effectuer un Ctrl+clic sur un hyperlien 
pour ouvrir le document lié ou un site web. De nombreux utilisateurs trouvent la création et 
l’édition de documents plus faciles quand un clic accidentel sur le lien ne l’active pas. Pour 
paramétrer LibreOffice afin qu’il active les hyperliens par simple clic, décochez cette option.
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Couleurs de l’interface

L’écriture, l’édition et (surtout) la mise en page sont souvent plus faciles quand on voit les marges 
de la page (les limites du texte), les délimitations des tableaux et des sections, les lignes de la 
grille ainsi que d’autres aides visuelles. En supplément, il se peut que vous préfériez des couleurs 
différentes de celles proposées par défaut par LibreOffice.

Dans la page LibreOffice – Couleurs de l’interface (Figure 20.2), vous pouvez spécifier les élé-
ments de l’interface utilisateur qui sont visibles ainsi que les couleurs utilisées pour les afficher.

Figure 20.2 : Afficher ou masquer les limites du texte, des objets et des tableaux

• Pour afficher ou masquer des éléments tels que les limites du texte, cochez ou décochez la 
case située à gauche du nom de l’élément concerné.

• Pour changer la couleur par défaut d’un élément donné, cliquez sur la flèche vers le bas 
dans la colonne Paramètre de couleur située à gauche du nom de l’élément, puis sélection-
nez une couleur dans la liste déroulante.

• Pour enregistrer les modifications dans un jeu de couleurs, cliquez sur le bouton Enregis-
trer, saisissez un nom dans la boîte Enregistrer le jeu puis cliquez sur OK.
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Remarque

Pour changer les couleurs utilisées dans le mode Suivi des modifications, ouvrez la page 
LibreOffice Writer – Modifications dans la boîte de dialogue Options.

Choix des options pour charger et enregistrer les documents

Vous pouvez paramétrer les options Chargement/enregistrement afin qu’elles correspondent au 
mieux à votre façon de travailler.

Si la boîte de dialogue Options n’est pas déjà ouverte, cliquez sur le menu Outils > Options. 
Faites ensuite un double clic sur la section Chargement/Enregistrement ou cliquez sur le sym-
bole (un signe + ou un triangle) à gauche de la section pour afficher les pages.

Général

Les utilisateurs des autres suites bureautiques connaissent la plupart des choix dans la page 
Chargement/enregistrement – Général (voir Figure 20.3). Certaines options importantes sont dé-
crites ci-après.

Charger les paramètres utilisateur avec le document

Lorsque vous enregistrez un document, certains paramètres sont enregistrés avec celui-ci. 
Si l’option est cochée, quand ce document sera ouvert sur un autre système, il utilisera les 
réglages enregistrés avec lui. Si vous décochez cette option, les réglages du système où le 
document sera ouvert remplaceront ceux qui ont été enregistrés avec le document. Certains 
de ces paramètres (nom de l’imprimante, source de données liée au document) sont toujours
chargés avec le document, que cette option soit cochée ou non.

Même si vous décochez cette option, les paramètres utilisateur suivants s’appliquent :

─ les paramètres disponibles dans Fichier > Imprimer > Options,

─ le nom du fax,

─ les options d’espacement des paragraphes avant les tableaux,

─ les informations sur la mise à jour automatique des liens, des fonctions de champ et des 
diagrammes,

─ les informations sur l’emploi des formats de caractères asiatiques.

Remarque

Les paramètres concernant les sources de données liées à un document et ceux concernant
son affichage sont toujours chargées avec celui-ci, que l’option Charger les paramètres utili-
sateur avec le document soit cochée ou non.
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Figure 20.3 : Options de chargement et d’enregistrement.

Charger les paramètres d’impression avec le document

Si cette option est cochée, les paramètres d’impression stockés avec le document sont char-
gés avec le document. Dans un environnement d’entreprise, cela peut provoquer l’impres-
sion sur une imprimante distante à moins que l’imprimante à utiliser soit modifiée directement
dans la boîte de dialogue Imprimer. Si elle est décochée, l’imprimante par défaut de l’utilisa-
teur qui a ouvert le document sera utilisée. Les paramètres de l’imprimante courante seront 
stockés avec le document que l’option soit cochée ou non.

Enregistrer les informations de récupération automatique toutes les… minutes

Choisissez si la récupération automatique doit être activée et la fréquence à laquelle enregis-
trer les informations utilisées par le processus de récupération automatique.

Dans LibreOffice, la récupération automatique enregistre les informations nécessaires pour 
pouvoir restaurer tous les documents ouverts en cas de plantage du système. En cochant 
cette option, récupérer votre document après un plantage sera plus facile.

Éditer les propriétés du document avant l’enregistrement

Si vous cochez cette option, la boîte de dialogue Propriétés du document s’ouvrira pour vous
demander de saisir les informations correspondantes la première fois que vous enregistrerez
un nouveau document (ou lorsque vous utiliserez la fonction Enregistrer sous).

Toujours créer une copie de sauvegarde

Cette fonction permet d’enregistrer, dans un autre dossier et comme copie de sauvegarde, la
version précédente d’un document à chaque fois que l’utilisateur enregistre son document. 
Chaque fois que LibreOffice crée une copie de sauvegarde, la copie de sauvegarde précé-
dente est remplacée. La copie de sauvegarde a l’extension .BAK. Quand vous ouvrirez une 
copie de sauvegarde, il vous sera demandé avec quel programme l’ouvrir : choisissez 
LibreOffice.

Pour voir dans quel dossier la copie de sauvegarde est enregistrée ou pour le modifier, ou-
vrez la page LibreOffice – Chemins.
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Conseil

Les utilisateurs qui s’engagent dans un travail de longue haleine devraient toujours activer la
copie de sauvegarde.

Enregistrer les URL relatifs au système de fichiers / à internet

Cette option permet de choisir la valeur par défaut de l’adressage relatif des URL dans le 
système de fichiers et sur Internet. L’adressage relatif à un système de fichiers est unique-
ment possible si la source du document et le document de référence sont tous les deux sur 
le même disque.

Pour plus de détails, veuillez vous reporter au chapitre 2, Configurer LibreOffice du Guide du
débutant.

Format de fichier par défaut et paramètres ODF

• Version de format ODF : par défaut, LibreOffice enregistre les documents au format 
OpenDocument Format (ODF) version 1.2 étendu. Bien que celle-ci offre des fonctionnalités 
améliorées, il peut y avoir des problèmes de rétrocompatibilité. Lorsqu’un fichier enregistré 
en ODF 1.2 étendu est ouvert dans un éditeur qui utilise des versions antérieures de ODF 
(1.0 / 1.1), certaines fonctions avancées peuvent être perdues. Deux exemples connus sont 
les références croisées aux titres et le formatage des listes numérotées. Si vous envisagez 
de partager les documents avec des personnes qui utilisent des versions plus anciennes de 
ODF, enregistrez le document en utilisant ODF version 1.0 / 1.1.

• Type de document : si vous partagez habituellement vos documents avec des utilisateurs 
de Microsoft Word, vous voudrez peut-être modifier l’attribut Enregistrer systématiquement 
sous pour l’un des formats Microsoft Word. Vous pouvez cependant toujours choisir un for-
mat Word, si cela est vraiment nécessaire, quand vous enregistrez le fichier.

! Attention

Si vous devez enregistrer un document au format de Microsoft Word, il est conseillé d’enre-
gistrer d’abord votre document au format LibreOffice Writer (OpenDocument Format -.odt), 
puis de cliquer sur le menu Fichier > Enregistrer une copie… afin de créer une copie de 
votre document finalisé au format Microsoft Word. Pour de meilleurs résultats, privilégiez le 
format .doc au .docx. Enregistrer d’abord votre document au format .odt vous laisse la possi-
bilité de recréer votre document dans le cas où le destinataire dudit document rencontrerait 
des problèmes avec le format Microsoft Word.

Par ailleurs, en utilisant la fonction Enregistrer une copie… plutôt que la fonction Enregis-
trer sous… votre document reste ouvert au format .odt pour vous permettre d’en poursuivre
l’édition.

Microsoft Office

Dans la page Chargement/enregistrement – Microsoft Office, vous pouvez choisir ce qu’il faut faire
lors de l’import ou l’export des objets Microsoft Office (liés ou incorporés, ou des documents tels 
que les classeurs ou les équations).
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Cochez l’option [C] pour convertir les objets OLE Microsoft Office en objets OLE LibreOffice cor-
respondants lorsqu’un document Microsoft Office est chargé dans LibreOffice (mnémonique : “C” 
pour “Charger”).

Cochez l’option [E] pour convertir les objets OLE LibreOffice en objets OLE Microsoft Office cor-
respondants lorsqu’un document est enregistré au format Microsoft Office (mnémonique : “E” pour 
“Enregistrer”).

Compatibilité HTML

Les choix faits dans la page Chargement/enregistrement – Compatibilité HTML affectent les pages
HTML importées dans LibreOffice et celles exportées à partir de LibreOffice. Pour plus d’informa-
tions, consultez la section Documents HTML : import et export dans l’aide (accessible via le menu 
Aide > Aide de LibreOffice ou en appuyant sur la touche F1 de votre clavier) et le chapitre 2 du 
Guide du débutant.

Choix des options propres à Writer

Les paramètres choisis dans la section LibreOffice Writer de la boîte de dialogue Options déter-
minent comment les documents Writer apparaissent et se comportent lorsque vous travaillez sur 
eux.

Si la boîte de dialogue Options n’est pas déjà ouverte, cliquez sur le menu Outils > Options. 
Faites un double clic sur la section LibreOffice Writer ou cliquez sur le symbole (un signe + ou un 
triangle) à gauche de celle-ci pour afficher les pages.

Général

Les options de la page LibreOffice Writer – Général (voir Figure 20.4) affectent l’actualisation des 
liens et des champs, l’unité pour les règles et autres mesures, ainsi que la position par défaut des 
tabulations.

Figure 20.4 : Choix des options générales de Writer.
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Actualiser les liens lors du chargement

En fonction de votre façon de travailler, vous pouvez ne pas souhaiter que les liens soient 
actualisés lors du chargement du document. Par exemple, si vos fichiers sont liés à d’autres 
sur un réseau, vous n’actualiserez pas les liens lorsque vous n’êtes pas connecté au réseau.

Actualiser les champs et les diagrammes automatiquement

Vous pouvez ne pas souhaiter que les champs et les diagrammes s’actualisent automatique-
ment lorsque vous travaillez, car cela pourrait diminuer les performances. Réciproquement, 
vous voudrez peut-être que les mises à jour se fassent automatiquement si vous devez vous 
rapporter au contenu des champs et des diagrammes.

Paramètre – Unité de mesure

Il est recommandé d’utiliser le point comme unité par défaut car il permet de facilement 
mettre en relation, par exemple, la taille de la police avec les indentations et les tabulations.

Paramètres – Tabulations

L’option Tabulations spécifie la distance que parcourt le curseur à chaque pression sur la 
touche Tab. Ce paramètre est également utilisé pour la distance de retrait appliquée par les 
boutons Augmenter le retrait et Diminuer le retrait dans la barre de Formatage, ce qui af-
fecte le retrait de tout le paragraphe.

Conseil

Il n’est pas conseillé d’utiliser les tabulations par défaut afin d’espacer et/ou d’aligner du 
texte sur une page. En effet, si vous employez cette méthode et que vous envoyez le docu-
ment à une personne qui n’utilise pas les mêmes dimensions de tabulations que vous, votre 
document s’affichera avec les paramètres du destinataire, ce qui changera la mise en page. 
Pour éviter ces désagréments, définissez plutôt vos propres tabulations dans les styles de 
paragraphe. Voir « Définir des arrêts de tabulation et des retraits » au Chapitre 4 Mettre 
le texte en forme, page 103.

Nombre de mots – Séparateurs supplémentaires

Pour le décompte des mots, cette option spécifie les caractères considérés comme sépara-
teurs de mots, en plus des espaces, tabulations, sauts de lignes et de paragraphes.

Nombres de mots – Afficher un nombre de pages standardisées

Les rédacteurs en chef et les éditeurs définissent souvent une page « standard » contenant 
un nombre défini de caractères ou de mots ; ce champ permet un calcul rapide du nombre 
de telles pages.

Affichage

Deux pages définissent les paramètres par défaut de l’affichage des documents Writer : 
LibreOffice Writer – Affichage (décrit dans cette partie) et LibreOffice Writer – Aides au formatage 
(voir ci-dessous).
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Figure 20.5 : Choix des options d’affichage dans Writer.

Les Lignes d’aide lors du déplacement vous aident à positionner de façon précise un objet de des-
sin dans un document grâce à des lignes parallèles horizontales et verticales correspondantes à la
hauteur et la largeur de l’objet.

Si les options de la sous-section LibreOffice Writer – Affichage (voir Figure 20.5) ne sont pas expli-
cites, vous pouvez facilement tester leurs effets avec un document vierge.

C’est le bon endroit pour vérifier si, par exemple, vous ne pouvez pas voir les images à l’écran ou 
voir les codes de champs à la place du texte ou des nombres attendus.

Conseil

Si vous avez inséré un champ mais que vous ne voyez pas le texte ou le nombre attendu, 
décochez Noms des champs ici. Exemple : Date (Fixe) s’affiche à l’écran quand l’option 
Noms des champs est cochée, tandis que 30/06/18 s’affiche quand elle est décochée. Vous 
pouvez toujours cocher Affichage > Noms des champs ou appuyer sur Ctrl+F9 pour affi-
cher provisoirement le nom des champs si le besoin s’en fait sentir.

Aides au formatage

Dans la page LibreOffice Writer – Aides au formatage, cochez les options requises (voir Figure 
20.6).

L’affichage des symboles (Affichage > Marques de formatage dans la barre de menu ou bouton 
(Dés)activer les marques de formatage ( ) dans la barre d’outil Standard), tels la marque de 
fin d’un paragraphe et les tabulations, vous aide lors de l’écriture, l’édition et la réalisation de la 
mise en page. Par exemple, vous voudrez peut-être savoir si des paragraphes vides ou des tabu-
lations sont inclus ou si des tableaux ou des images sont trop larges et débordent dans les marges
de la page.

Remarque

Le curseur direct vous permet de saisir du texte, des images, des tableaux, des cadres et 
autres objets dans n’importe quel espace vide du document. LibreOffice insère un para-
graphe vide ou une tabulation à la position du texte ou de l’objet. Cependant, cette fonction 
peut conduire à de nombreuses bizarreries dans la mise en forme et est incompatible avec 
une utilisation rigoureuse des styles : il vaut donc mieux l’éviter.
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Figure 20.6 : Choix des options d’aide au formatage.

Grille

L’option Capturer à la grille peut être très utile lorsque vous essayez d’aligner plusieurs objets tels 
que des images ou des tableaux en les déplaçant jusqu’à la ligne de la grille la plus proche.

Dans la page LibreOffice Writer – Grille, vous pouvez activer cette fonction et choisir quel intervalle
utiliser pour la grille. Si l’intervalle de la grille (subdivisions) est trop large, vous n’aurez peut-être 
pas suffisamment de point de contrôle pour aligner les objets.

Impression

Dans la page LibreOffice Writer – Impression (voir Figure 20.7), vous choisissez quels éléments 
sont imprimés par défaut avec le document. Ces options s’ajoutent à celles disponibles dans la 
sous-section LibreOffice – Impression (voir page 548).

Figure 20.7 : Choix des options d’impression pour Writer.

Quelques éléments à prendre en considération :

• lorsque vous travaillez sur un brouillon et que vous souhaitez économiser l’encre de l’impri-
mante ou du toner, décochez certains des éléments de la partie Contenu ;
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• l’option imprimer le Texte en noir provoque l’impression du texte en noir (et pas des images) 
sur une imprimante couleur ; sur une imprimante noir et blanc, cette option provoque l’im-
pression en noir au lieu de niveaux de gris ;

• l’option imprimer le Texte en noir est différente de l’option Convertir les couleurs en niveaux 
de gris de la page LibreOffice – Impression (Figure 20.1) qui imprime toutes les images en 
niveaux de gris sur les imprimantes couleurs (sur les imprimantes noir et blanc, les couleurs 
des images sont normalement imprimées en niveaux de gris) ;

• si vous imprimez recto/verso sur une imprimante qui n’imprime qu’une face à la fois, vous 
choisirez d’imprimer uniquement les pages de gauche ou de droite, puis de retourner la pile 
et d’imprimer le verso.

Conseil

D’autres options sont également disponibles via le menu Fichier > Imprimer où les diverses
pages de la boîte de dialogue Imprimer vous permettent d’outrepasser les options définies 
ici.

Tableau

Dans la page LibreOffice Writer – Tableau, vous pouvez spécifier le comportement par défaut des 
tableaux (voir Figure 20.8). Veuillez vous reporter à l’Aide ou au Chapitre 13 Travailler avec les ta-
bleaux de données, page 345, pour plus d’informations.

Figure 20.8 : Choix des options par défaut pour les tableaux

Quelques éléments à prendre en considération :

• si la plupart de vos tableaux nécessitent des bordures ou des titres, cochez les options pro-
posées dans la section Nouveaux paramètres par défaut pour les tableaux. Si la plupart 
de vos tableaux sont utilisés pour de la mise en page, décochez les options Titre et Bor-
dure ;

558 | Guide de LibreOffice Writer Choix des options propres à Writer



 Chapitre 20 Paramétrer Writer

• dans la même section, cochez Ne pas scinder pour que le tableau ne soit pas scindé sur plu-
sieurs pages ;

• l’option Reconnaissance des nombres peut être très utile si la plupart de vos tableaux 
contiennent des données numériques ; Writer reconnaîtra, par exemple, les dates ou les 
monnaies et formatera les nombres de façon appropriée. Cependant, si vous désirez que les
nombres soient reconnus comme du texte ordinaire, décochez cette option ;

• les options de la section Utilisation du clavier – Déplacer des cellules indiquent les dis-
tances de déplacement des cellules lorsque vous utilisez les raccourcis clavier pour les dé-
placer ;

• les options de la partie Utilisation du clavier – Insérer une cellule indiquent la taille des 
lignes et des colonnes lorsque vous utilisez les raccourcis clavier pour les insérer ;

• les options de la section Comportement des lignes/colonnes déterminent les effets que les
modifications des colonnes et des lignes ont sur les colonnes et les lignes adjacentes et le 
tableau entier. Vous devrez sans doute tester les sélections pour pleinement en appréhender
les différents effets.

Modifications

Si vous envisagez d’utiliser la fonction de suivi des modifications de Writer (décrites au Chapitre 3 
Travailler avec le texte : Approfondissements, page 76), choisissez dans la page LibreOffice Writer
– Modifications (voir Figure 20.9) la façon dont les éléments insérés ou supprimés ainsi que les 
modifications d’attribut sont signalés et comment les barres de modifications sont positionnées 
dans les marges.

Figure 20.9 : Choix des options de suivi des modifications.
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Comparaison

Les options de la page LibreOffice Writer – Comparaison (Figure 20.10) déterminent le niveau de 
détail utilisé par la fonction Comparer le document (Édition > Suivi des modifications > Compa-
rer le document…) décrite au Chapitre 3 Travailler avec le texte : Approfondissements, page 80.

Figure 20.10 : Options de comparaison des documents.

Compatibilité

Avez-vous besoin d’importer des documents Microsoft Word dans LibreOffice Writer ? Si oui, vous 
souhaiterez alors cocher certains paramètres de la page LibreOffice – Compatibilité (Figure 20.11).
Si vous n’êtes pas sûr des effets de ces paramètres, laissez ceux par défaut. Pour obtenir des in-
formations sur les paramètres non décrits ci-après, référez-vous à l’Aide du logiciel. Tous les ré-
glages sélectionnés ne s’appliqueront qu’au document courant sauf si vous cliquez sur le bouton 
Utiliser par défaut en bas de la page.

Figure 20.11 : Choix des options de compatibilité.

Utiliser les mesures de l’imprimante pour le formatage des documents

Si cette option est cochée, l’imprimante spécifiée pour le document détermine comment le 
document est formaté pour l’affichage à l’écran. Les retours à la ligne et les sauts de para-
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graphes que vous voyez à l’écran correspondent à ceux qui sont appliqués lorsque le docu-
ment est imprimé sur cette imprimante.

Ce paramétrage peut être utile quand plusieurs personnes revoient un document qui sera 
éventuellement imprimé sur une imprimante spécifique ou lorsque le document est exporté 
au format PDF (un processus qui utilise Adobe PDF comme imprimante).

Si cette option n’est pas cochée, une mise en page indépendante de l’imprimante sera utili-
sée pour l’affichage à l’écran et l’impression.

Ajouter un espacement entre paragraphes et tableaux (document actif)

Dans LibreOffice Writer, l’espacement des paragraphes est défini de façon différente par rap-
port aux documents Microsoft Word. Si vous avez défini un espacement entre deux para-
graphes ou tableaux, l’espacement est également ajouté aux documents Microsoft Word cor-
respondants.

Si cette option est cochée, un espacement compatible à Microsoft Word est ajouté entre les 
paragraphes et les tableaux dans les documents LibreOffice Writer.

Ajouter un espacement de paragraphe et tableau en début de page (document actif)

Vous pouvez définir un espace avant (au-dessus) des paragraphes. Si cette option est co-
chée, tout espace au-dessus du paragraphe apparaîtra également si le paragraphe est au 
début d’une page ou d’une colonne, si le paragraphe est positionné sur la première page 
d’un document ou après un saut de page manuel.

Si vous importez un document Microsoft Word, les espaces sont ajoutés automatiquement 
pendant la conversion.

Ajouter un espacement de paragraphe et tableau en bas des cellules

Indique que l’espacement bas est ajouté au paragraphe, même si c’est le dernier paragraphe
dans une cellule de tableau.

Utiliser par défaut

Cliquez sur ce bouton pour utiliser les paramètres actuels sur cette page comme ceux par 
défaut pour Writer.

Légende automatique

Souhaitez-vous que LibreOffice insère automatiquement des légendes pour les tableaux, les 
images, les cadres et les objets OLE insérés dans un document Writer ?

Remarque

Vous ne souhaitez peut-être pas des légendes pour tous les tableaux si, par exemple, vous 
utilisez des tableaux pour de la mise en page ou pour des tableaux de données. Vous pou-
vez toujours ajouter des légendes pour des tableaux individuels, des images ou tout autre 
objet en effectuant un clic-droit sur l’objet puis en choisissant Légende dans le menu 
contextuel de l’objet.

Si vous souhaitez des légendes automatiques pour un ou plusieurs types d’objet, paramétrez les 
options de la page LibreOffice Writer – Légende automatique (Figure 20.12) :
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Cochez le type d’objet pour lequel une légende automatique sera générée. L’objet Tableau Writer 
est utilisé dans l’exemple de la Figure 20.12. Une fois l’élément coché, vous pourrez spécifier les 
caractéristiques de la légende.

Figure 20.12 : Paramétrage des légendes automatiques.

Les catégories disponibles pour les légendes sont Dessin, Illustration, Tableau et Texte. Toutefois, 
vous n’êtes pas limités aux catégories présentes d’origine. Si vous désirez utiliser un autre nom 
pour l’étiquette de la légende, saisissez le terme dans le champ Catégorie.

Des informations supplémentaires à propos de la numérotation des légendes par chapitre, les 
styles de caractère et les autres éléments de la page LibreOffice Writer – Légende automatique 
sont données dans d’autres chapitres du Guide Writer.

E-mail de publipostage

Vous pouvez produire des lettres types à partir de Writer et utiliser la fonction de mailing pour per-
sonnaliser ces lettres et les envoyer à un certain nombre d’adresses prises dans une source de 
données, telle qu’un carnet d’adresses. Les documents de publipostage peuvent être imprimés et 
postés ou envoyés par e-mail. Pour plus de détails, référez-vous au Chapitre 14 Le publipostage, 
page 377.

Dans la page LibreOffice Writer – E-mail de publipostage (Figure 20.13), vous pouvez définir les 
informations sur l’expéditeur et le serveur afin d’envoyer les lettres par e-mail. Si vous n’êtes pas 
sûr des informations à ajouter dans les champs, consultez votre client de messagerie ou votre 
fournisseur d’accès à internet.
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Figure 20.13 : Saisie des informations nécessaires à l’envoi de lettres par publipostage par
courriel.

Choix des paramètres linguistiques

Vous devrez peut-être faire plusieurs choses pour définir vos paramètres linguistiques :

• installer les dictionnaires nécessaires,

• modifier les paramètres locaux et linguistiques,

• choisir les options de correction orthographique.

Installer les dictionnaires nécessaires

L’installation de LibreOffice inclut automatiquement plusieurs modules de langue qui contiennent 
chacun jusque trois éléments : un dictionnaire orthographique, un dictionnaire de césure et un dic-
tionnaire des synonymes. Ces modules sont habituellement appelés « dictionnaires » dans Writer.

Pour ajouter d’autres dictionnaires, assurez-vous d’être connecté à Internet et sélectionnez Outils 
> Langue > Dictionnaires supplémentaires en ligne… dans la barre de menu. LibreOffice ouvri-
ra le navigateur web par défaut de votre ordinateur à une page contenant des liens de diction-
naires supplémentaires à installer en suivant les instructions de la boîte de dialogue.

Modifier les paramètres locaux et linguistiques

Vous pouvez modifier certains paramètres locaux et linguistiques utilisés par LibreOffice pour tous 
les documents ou pour un document spécifique. Dans la boîte de dialogue Options, ouvrez la page
Paramètres linguistiques – Langues.

Dans la partie droite de cette page (Figure 20.14), modifiez les options Interface utilisateur, Para-
mètres locaux, Monnaie par défaut, Langues par défaut pour les documents, etc. comme vous le 
souhaitez. Dans l’exemple montré en Figure 20.14, Français (France) a été choisi pour toutes les 
options.

Si vous souhaitez que les paramètres de langue par défaut ne s’appliquent qu’au document actif, 
au lieu d’être définis par défaut pour tout nouveau document, cochez l’option Uniquement pour le 
document actif.
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Les changements de la langue d’entrée/de clavier du système affectent normalement le texte saisi 
dans un document après les modifications. Si vous ne désirez pas que cela se produise, cochez 
l’option Ignorer la langue d’entrée du système : le nouveau texte continuera alors à suivre la 
langue du document ou du paragraphe, non celle du système.

Figure 20.14 : Choix des options de langue.

Si nécessaire, cochez les options pour activer le support des langues asiatiques (le chinois, le ja-
ponais, le coréen) et le support pour les langues à script complexe (CTL) (l’hindi, le thaï, l’hébreu, 
l’arabe). Si vous cochez l’une de ces options, la prochaine fois que vous ouvrirez la boîte de dia-
logue Options, de nouvelles pages apparaîtront dans la section Paramètres linguistiques (Figure 
20.15). Ces pages (Recherche en japonais, Mise en page asiatique et Scripts complexes) ne sont 
pas abordées dans ce guide.

Figure 20.15 : Options linguistiques standard (à gauche) et avec la prise en charge des langues
asiatiques et des mises en page complexes (à droite).
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Choisir les options de correction orthographique

Pour choisir les options de correction orthographique, ouvrez la page Paramètres linguistiques – 
Linguistique. Dans la partie Options de cette sous-section, choisissez les paramètres qui vous se-
ront utiles (Figure 20.16).

Figure 20.16 : Choix des langues, des dictionnaires et des options de correction orthographique.

Quelques éléments à prendre en considération :

• si vous ne souhaitez pas que l’orthographe soit vérifiée lorsque vous saisissez du texte, dé-
cochez l’option Vérifier l’orthographe au cours de la frappe. Cette option peut également être 
désactivée en cliquant sur le bouton Vérification automatique ( ) de la barre d’outils 
Standard, en sélectionnant Outils > Correction orthographique automatique dans la barre
d’outils ou en appuyant sur les touches Maj+F7 du clavier ;

• si vous souhaitez que la grammaire soit vérifiée lorsque vous saisissez du texte, veillez à ce 
que l’option Vérifier la grammaire au cours de la frappe soit cochée ;

• si vous utilisez un dictionnaire personnalisé qui inclut des mots tout en majuscules et des 
mots avec des chiffres (par exemple AS/400) cochez les options Vérifier les mots en majus-
cule et Vérifier les mots comportant des chiffres ;

• l’option Vérifier les zones spéciales inclut les en-têtes, pieds de page, cadres et tableaux lors
de la vérification orthographique.

Dans la page Paramètres linguistiques – Linguistique, vous pouvez également vérifier quels sont 
les dictionnaires (personnalisés) de l’utilisateur qui sont actifs par défaut et ajouter ou supprimer 
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des dictionnaires en cliquant sur le bouton Nouveau ou sur le bouton Supprimer. Les diction-
naires installés par le système ne peuvent pas être supprimés.

Remarque
LibreOffice dispose également d’un vérificateur de grammaire auquel vous pouvez accéder à
partir du menu Outils > Orthographe et grammaire ou via le raccourci clavier F7.

L’extension Grammalecte (https://extensions.libreoffice.org/extensions/grammalecte) est un
correcteur grammatical pour le français qui essaie d’apporter une aide à l’écriture du fran-
çais sans parasiter l’attention des utilisateurs avec de fausses alertes.

Conseil

Si vous cliquez sur l’entrée de menu contextuel Ajouter au dictionnaire d’un mot marqué 
pendant la vérification orthographique, celui-ci est ajouté par défaut au dictionnaire stan-
dard. Si vous cliquez sur l’entrée Tout ignorer dans ce même menu contextuel, le mot est 
ajouté au dictionnaire IgnoreAllList. Voir le Chapitre 2 Travailler avec le texte : les bases, 
page 51.
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Chapitre 21
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Introduction

Ce chapitre explique comment personnaliser Writer.

Dans LibreOffice, vous pouvez personnaliser les menus, les barres d’outils et les raccourcis cla-
vier, ajouter de nouveaux menus et barres d’outils, et assigner des macros à des événements. 

Il est également possible de personnaliser Writer à l’aide d’extensions qui peuvent être installées 
depuis le site de LibreOffice (https://extensions.libreoffice.org/extensions) ou d’autres fournisseurs.

Remarque

Une fois les menus et les barres d’outils personnalisés, vos préférences peuvent être sauve-
gardées dans un modèle. Pour ce faire, enregistrez-les d’abord dans un document et enre-
gistrez ensuite ce document en tant que modèle (voir le Chapitre 10 Travailler avec les mo-
dèles, page 266).

Personnaliser les menus

Modifier un menu existant

Vous pouvez ajouter ou réorganiser les éléments de la barre des menus, ajouter des commandes 
aux menus ou réaliser d’autres changements. Vous pouvez aussi modifier les menus contextuels 
(clic droit) de la même façon.

Pour personnaliser un menu :

 1) Sélectionnez Outils > Personnaliser dans la barre de menu.

 2) Dans la boîte de dialogue Personnaliser (Figure 21.1), cliquez sur l’onglet Menus ou sur l’on-
glet Menus contextuels.

Nouveau dans la version 6,0

La boîte de dialogue a été remaniée pour faciliter la personnalisation des menus et barres 
d’outils.

 3) Du côté droit, Choisissez dans la liste déroulante A si le menu sera personnalisé dans 
LibreOffice Writer ou seulement dans un document particulier.

 4) Sélectionnez dans la liste déroulante en dessous de la précédente (B) le menu que vous dé-
sirez personnaliser. Cette liste contient les menus principaux et leurs sous-menus. Les com-
mandes qui font partie du menu choisi apparaissent dans la zone située juste en dessous 
(C).

 5) Pour ajouter une commande au menu choisi :

 a) Vous pouvez, de manière facultative, sélectionner dans la zone C la commande sous la-
quelle la nouvelle sera placée.

 b) Vous pouvez, de manière facultative, filtrer la liste des commandes en choisissant une ca-
tégorie dans la liste déroulante D dans la partie gauche.

Personnaliser les menus | 569

https://extensions.libreoffice.org/extensions


 Chapitre 21 Personnaliser Writer

 c) Sélectionnez la commande à ajouter dans la liste Fonction (E) et cliquez sur la flèche (F) 
vers la droite, située entre les listes.

 d) Si nécessaire, déplacez la nouvelle entrée vers le haut ou vers le bas grâce aux flèches G
situées au bord droit de la boîte de dialogue.

A
B

C

D

E

F G

Figure 21.1 : La page Menus de la boîte de dialogue Personnaliser.

 6) Pour supprimer une entrée dans la liste de droite, sélectionnez-la et cliquez sur la flèche (F) 
vers la gauche qui se trouve entre les listes.

 7) Pour ajouter une ligne de séparation après l’entrée mise en valeur, cliquez sur le bouton In-
sérer et choisissez Insérer un séparateur.

 8) Pour ajouter un sous-menu après l’entrée mise en valeur, cliquez sur le bouton Insérer et 
choisissez Insérer un sous-menu.

 9) Quand vous avez terminé vos modifications, cliquez sur OK pour les enregistrer et fermer la 
boîte de dialogue.

Créer un nouveau menu

Pour créer un nouveau menu (qui rassemble, par exemple, les outils pour un projet précis) :

 1) Dans l’onglet Menus de la boîte de dialogue Personnaliser, cliquez sur le bouton + à droite 
de la liste des menus (B) pour ouvrir la boîte de dialogue Nouveau menu (Figure 21.2). Ce 
bouton n’existe pas pour les menus contextuels.
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 2) Saisissez un nom pour le nouveau menu dans le champ Nom du menu.

 3) Placez-le à la position que vous souhaitez en utilisant les flèches situées à droite de la boîte 
de dialogue.

 4) Cliquez sur le bouton OK pour enregistrer.

Figure 21.2 : Ajouter un nouveau menu.

Le nouveau menu apparaît maintenant dans la liste déroulante des menus de la boîte de dialogue 
Personnaliser. Il apparaîtra dans la barre des menus dès que vous aurez enregistré vos personna-
lisations.

Après avoir créé un nouveau menu, vous devez lui ajouter des commandes. Pour connaître la pro-
cédure, référez-vous à la section « Modifier un menu existant » en page 569.

Remarque

Les modifications apportées aux menus ne s’affichent pas immédiatement. Celles qui sont 
enregistrées dans le menu de LibreOffice Writer seront affichées à l’ouverture suivante de 
l’application. Celles qui sont enregistrées dans le menu d’un document seront affichées à 
l’ouverture suivante de celui-ci.

Personnaliser les barres d’outils

Vous pouvez personnaliser les barres d’outils de plusieurs manières, notamment en choisissant 
les boutons visibles, en verrouillant la position d’une barre d’outils ancrée (pour plus d’informa-
tions, référez-vous au Chapitre 1 Introduction à Writer, page 19), en ajoutant ou supprimant des 
icônes (commandes). Vous pouvez également créer de nouvelles barres d’outils. Les contrôles de 
l’onglet Barres d’outils de la boîte de dialogue Personnaliser (Figure 21.3) sont semblables à ceux 
de la page Menus.
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A

Figure 21.3 : La page Barres d’outils de la boîte de dialogue Personnaliser.

Pour ouvrir la boîte de dialogue Personnaliser (voir Figure 21.3), effectuez l’une des actions sui-
vantes :

• faites un clic droit sur un bouton de la barre d’outils à personnaliser, puis choisissez Person-
naliser la barre d’outils… dans le menu contextuel ;

• Cliquez sur le menu Affichage > Barres d’outils > Personnaliser…

• cliquez sur le menu Outils > Personnaliser… puis choisissez l’onglet Barres d’outils.

Choix des icônes pour les commandes d’une barre d’outils

Les commandes de barre d’outils sont habituellement représentées par des icônes, mais toutes les
commandes n’ont pas d’icône associée. Dans ce cas, vous pouvez en choisir une.

Pour définir une icône pour une commande, sélectionnez la commande dans la liste de droite 
(marquée A sur la Figure 21.3) dans la boîte de dialogue Personnaliser, cliquez sur le bouton Mo-
difier et sélectionnez Modifier l’icône… Dans la boîte de dialogue Modifier l’icône, (Figure 21.4) 
faites défiler les icônes disponibles, sélectionnez-en une et cliquez sur le bouton OK pour l’assi-
gner à la commande.

Pour utiliser une icône personnalisée, créez-la à l’aide d’un programme graphique et importez-la 
ensuite dans LibreOffice en cliquant sur le bouton Importer dans la boîte de dialogue Modifier 
l’icône. Les icônes personnalisées doivent avoir une taille de 16 x 16, 26 x 26 ou 32 x 32 pixels se-
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lon la taille sélectionnée dans la page LibreOffice – Affichage de la boîte de dialogue Options (Ou-
tils > Options) ; elles doivent avoir été enregistrées au format PNG.

Figure 21.4 : la boîte de dialogue Modifier l’icône.

Affecter des raccourcis clavier

En plus de l’utilisation des raccourcis clavier par défaut (répertoriés dans l’Annexe A du Guide du 
débutant), vous pouvez définir les vôtres. Vous pouvez affecter des raccourcis aux fonctions stan-
dards de LibreOffice ou à vos propres macros et les enregistrer pour pouvoir les utiliser avec 
Writer ou avec toute la suite LibreOffice.

! Attention

Soyez prudent lorsque vous réaffectez les raccourcis de votre système d’exploitation ou les 
raccourcis par défaut de LibreOffice. Plusieurs affectations sont “universelles”, comme la 
touche F1 pour ouvrir l’aide d’un logiciel. Même si vous pouvez toujours redéfinir les rac-
courcis clavier par défaut dans LibreOffice, modifier certains raccourcis “universels” peut 
prêter à confusion, entraîner la corruption ou la perte de données, surtout si vous partagez 
votre ordinateur avec d’autres utilisateurs.

Pour adapter les raccourcis clavier à vos besoins, utilisez la page Clavier de la boîte de dialogue 
Personnaliser (Figure 21.5) :

 1) Si vous souhaitez que les modifications soient apportées dans tous les modules de 
LibreOffice, veillez à cocher l’option LibreOffice. Si les modifications ne concernent que le 
module Writer, cochez l’option Writer.

 2) Sélectionnez le raccourci dans la liste Raccourcis clavier.

 3) Sélectionnez la fonction requise à partir des listes Catégorie et Fonction.

 4) Cliquez sur le bouton Modifier. La sélection apparaît maintenant dans la liste Touches tout à
droite de la boîte de dialogue.
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 5) Cliquez sur le bouton OK pour enregistrer les modifications. Le raccourci clavier exécutera 
désormais la fonction choisie.

Figure 21.5 : Affecter un raccourci clavier à un style.

Remarques

Tous les raccourcis clavier existants pour la fonction sélectionnée sont répertoriés dans la 
liste Touches. Si cette liste est vide, cela indique que la combinaison choisie est libre d’utili-
sation. Si elle ne l’est pas et que vous souhaitez réaffecter une combinaison de touches qui 
est déjà utilisée, vous devez d’abord supprimer le raccourci existant dans la liste Touches.

Les raccourcis clavier qui sont grisés dans la liste de la boîte de dialogue Personnaliser, 
comme F1 et F10, ne peuvent pas recevoir une nouvelle affectation.

Rétablir les raccourcis par défaut

Pour réinitialiser tous les raccourcis claviers à leur valeur par défaut, cliquez sur le bouton Réta-
blir, situé dans la partie supérieure droite de la boîte de dialogue Personnaliser (page Clavier). Uti-
lisez cette fonction avec précaution, car aucune boîte de dialogue de confirmation ne s’affichera ; 
les valeurs par défaut seront rétablies sans aucun avertissement.
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Enregistrer les modifications dans un fichier

Les modifications des raccourcis clavier peuvent être enregistrées dans un fichier de configuration 
pour une utilisation ultérieure, permettant ainsi de créer et d’appliquer différentes configurations 
suivant les besoins. Pour enregistrer les raccourcis dans un fichier :

 1) Après avoir affecté les raccourcis, cliquez sur le bouton Enregistrer dans la partie supé-
rieure droite de l’onglet Clavier de la boîte de dialogue Personnaliser (voir Figure 21.5).

 2) La boîte de dialogue Enregistrer la configuration du clavier s’ouvre. Saisissez le nom du fi-
chier de configuration du clavier dans le champ Nom de fichier, ou sélectionnez un fichier 
existant dans la liste. Si besoin, naviguez jusqu’à un autre emplacement pour trouver le fi-
chier.

 3) Cliquez sur le bouton Enregistrer. Une boîte de dialogue de confirmation apparaît si vous 
écrasez un fichier existant. Si tel n’est pas le cas, le fichier est enregistré directement.

Charger un fichier de configuration de clavier

Pour charger un fichier de configuration de clavier et remplacer la configuration existante, cliquez 
sur le bouton Charger, situé dans la partie supérieure droite de l’onglet Clavier de la boîte de dia-
logue Personnaliser (voir Figure 21.5), et sélectionnez le fichier de configuration enregistré sur 
votre ordinateur depuis la boîte de dialogue Charger la configuration du clavier.

Affecter des macros à des événements

Dans LibreOffice, lorsque quelque chose se passe, on dit qu’un événement est survenu. Par 
exemple, un document a été ouvert, une touche a été pressée ou la souris a bougé. Vous pouvez 
associer une macro à ces événements de façon à ce qu’elle soit exécutée, lorsque l’événement 
survient. Par exemple, un usage courant est d’affecter à l’événement Ouvrir un document une ma-
cro qui va réaliser certaines tâches de paramétrage du document.

Pour associer une macro à un événement, utilisez l’onglet Événements de la boîte de dialogue 
Personnaliser. Pour plus d’informations sur les macros, référez-vous au chapitre 13, Débuter avec 
les macros, du Guide du débutant.

Ajouter des fonctionnalités à l’aide d’extensions

Une extension est un ensemble de fichiers qui peuvent être installés dans LibreOffice afin de lui 
ajouter des fonctionnalités. Ils peuvent, par exemple, ajouter de nouveaux menus et sous-menus 
ou des icônes pour les barres d’outils. Elles peuvent aussi avoir leurs propres paramètres à confi-
gurer depuis le gestionnaire d’extensions.

Plusieurs extensions populaires sont couplées avec LibreOffice et sont donc installées avec le pro-
gramme. D’autres peuvent être téléchargées à partir de divers sites internet. Le site de référence 
pour les extensions est https://extensions.libreoffice.org/extensions. Les extensions de ce site sont
gratuites.

Certaines extensions provenant d’autres sources sont gratuites, d’autres sont disponibles moyen-
nant un supplément. Vérifiez bien les descriptions de chaque extension, notamment les frais appli-
cables et la licence d’utilisation.
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Installer des extensions

Vous pouvez installer des extensions de trois manières différentes :

• depuis un fichier *.oxt que vous pourrez retrouver à l’aide du navigateur de fichiers de votre 
système d’exploitation. Faites un double clic sur le fichier ;

• à partir de votre navigateur web, si ce dernier est configuré pour ouvrir ce type de fichier en 
cliquant sur un hyperlien dans une page web ;  cliquez sur l’hyperlien et en acceptez l’ouver-
ture du fichier ;

• via le Gestionnaire des extensions, de la façon suivante :

 a) Dans LibreOffice, sélectionnez Outils > Gestionnaire des extensions dans la barre de 
menu. Vous pouvez cocher ou non les options qui permettent de visualiser les extensions 
installées par défaut avec LibreOffice et celles ajoutées par un utilisateur.

 b) Dans le Gestionnaire des extensions (voir Figure 21.6), cliquez sur le bouton Ajouter.

Figure 21.6 : Le gestionnaire des extensions.

 c) Une fenêtre d’explorateur de fichiers s’ouvre. Recherchez et sélectionnez l’extension, té-
léchargée au préalable, que vous souhaitez installer et cliquez ensuite sur le bouton Ou-
vrir.

 d) Les utilisateurs disposant des droits d’administration sur leur ordinateur verront s’afficher 
un message proposant d’installer les extensions pour Tous les utilisateurs (extension Par-
tagée) ou Seulement pour moi (extension Utilisateur). Les utilisateurs ne disposant pas de
ces privilèges peuvent installer, supprimer ou modifier les extensions uniquement pour 
leur propre utilisation (extension Utilisateur).
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 e) L’installation de l’extension commence.

 f) Dans les trois cas évoqués à l’étape 4, il vous sera demandé d’accepter la licence d’utili-
sation. Lorsque l’installation sera terminée, l’extension sera répertoriée dans le Gestion-
naire des extensions.

Astuce

Pour obtenir des extensions disponibles sur le dépôt, vous pouvez ouvrir le Gestionnaire 
des extensions et cliquez sur le lien Obtenir des extensions supplémentaires en ligne. 
Vous n’avez pas besoin de les télécharger séparément.

Ajouter des couleurs personnalisées

Nouveau dans la version 5.4

LibreOffice, avant la version 5.3, offrait une page Couleurs dans la boîte de dialogue Op-
tions (Outils > Options), qui vous permettait d’ajouter des couleurs personnalisées à une 
palette de couleurs. Cette page a été supprimée.

Depuis la version 5.4, la gestion des couleurs a été décentralisée aux onglets Remplissage 
des objets de dessin, Arrière-plan des images et des paragraphes9 et Zone des cadres 
quand une couleur de fond est choisie.

La méthode pour définir une couleur personnalisée est la suivante :

 1) Ouvrez la boîte de dialogue Propriétés (par exemple, clic droit et Propriétés… ou Para-
graphe… dans le menu contextuel) d’un objet de dessin, d’une image, d’un paragraphe ou 
d’un cadre et sélectionnez l’onglet qui permet le remplissage de l’arrière-plan (voir ci-des-
sus).

 2) Sélectionnez le choix Couleur. Dans la liste déroulante Palette, choisissez la palette à la-
quelle vous souhaitez ajouter la couleur.

 3) Dans la section Nouveau, définissez la nouvelle couleur les valeurs de rouge, de vert et de 
bleu grâce aux boîtes de saisie et aux compteurs R, V et B ou saisissez son code hexadéci-
mal dans la boîte de saisie Hexa. Vous pouvez aussi cliquez sur le bouton Choisir une cou-
leur pour ouvrir la boîte de dialogue de même nom (Figure 21.8) qui vous offrira d’autres mé-
thodes pour la définir.

 4) Cliquez sur le bouton Ajouter dans le coin inférieur gauche pour saisir le nom de la nouvelle 
couleur dans la boîte de dialogue qui s’ouvre alors, puis sur OK pour l’enregistrer.

9 Ainsi que des tableaux depuis la version 6.1.
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Figure 21.7 : Définition d’une nouvelle couleur.

Figure 21.8 : Quatre moyens pour définir une couleur.
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Ajouter des polices de caractères

LibreOffice peut utiliser les formats de polices PostScript (*.pbf), TrueType (*.ttf) et OpenType 
(*.otf). Il en existe d’autres qui peuvent être utilisées par votre système d’exploitation, mais ils 
peuvent être limités en choix et en qualité.

Si vous disposez des privilèges d’administrateur, vous pouvez installer des polices supplémen-
taires grâce à votre système d’exploitation ; elles seront utilisables dans LibreOffice et apparaîtront
dans les listes de polices qu’il propose.

Trouver des polices à licence libre

En plus des polices déposées provenant de sources telles qu’Adobe, des centaines de polices 
libres et gratuites sont disponibles. Vous pouvez utiliser, partager et modifier à votre guise les po-
lices dont la licence est libre. La plupart sont gratuites. Beaucoup sont des clones, ou des va-
riantes proches, des polices classiques, mais certaines sont originales.

De nombreuses distributions de Linux offrent quelques polices à licence libre dans leurs dépôts. 
Parmi les autres endroits où vous pouvez en trouver, il y a The League of Moveable Type (https://
www.theleagueofmoveabletype.com/), Open Font Library (http://openfontlibrary.org/).
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Une suite bureautique libre, un projet passionnant, des gens fantastiques

Guide Writer
Traiter vos textes avec style

À propos de ce livre :

Si vous n’avez encore jamais utilisé LibreOffice, ou si vous désirez une présentation de tous ses 
composants, ce livre est fait pour vous. Quiconque désire progresser rapidement dans l’utilisation 
de LibreOffice trouvera une aide précieuse dans ce livre, qu’il débute dans l’utilisation d’une suite 
bureautique ou qu’il soit habitué à une autre.

Ce livre présente LibreOffice et ses composants :
Writer (traitement de texte) - Calc (classeur) - Impress (présentations)
Draw (dessin vectoriel) - Math (éditeur d’équation) - Base (base de données)

Il décrit aussi les fonctions communes à tous les composants, dont les styles, les modèles, la 
galerie d’images, les macros et l’impression.

À propos des auteurs :

Ce livre a été écrit par des bénévoles de la communauté de LibreOffice. Les profits provenant de la 
vente de l’édition imprimée seront utilisés au bénéfice de cette communauté.

Une version de ce livre au format PDF peut être téléchargée à :
https://wiki.documentfoundation.org/Documentation/Publications/fr

À propos de LibreOffice :

LibreOffice est la suite bureautique gratuite, libre et open source de The Document Foundation. 
Elle fonctionne sous Windows, Macintosh et GNU/Linux. Le soutien et la documentation gratuits 
sont offerts par notre grande communauté d’utilisateurs, de contributeurs et de développeurs.
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